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Up & Running 
Getting DataCAD up and running is a simple matter with its 
flexible and interactive setup program. Use the "System 
Requirements" and "Pre-Installation Checklist" in this chapter 
to make sure you're ready to begin installing the program. The 
setup instructions that follow take you step-by-step through the 
installation process.  

To get the most from this manual, please refer to “How to Use 
This Manual” in this chapter. Please note that the online help 
included with DataCAD contains all the information included 
in this manual, along with some updated material that became 
available after this manual went to press. 

DATACAD LLC offers 30 days of free installation support 
when you purchase DataCAD. If you have any questions about 
installing DataCAD, you can contact DATACAD LLC Technical 
Support Monday through Friday, 8:00 a.m. – 5:00 p.m. eastern 
time, except during normally observed holidays, via phone at 
(860) 677-2829, via fax at (860) 677-2883, or via e-mail at 
techsupport@datacad.com. 

 

1 
In this chapter: 

 How to use this manual 

 System requirements 

 Pre-installation checklist 

 Installing DataCAD 
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How to Use This Manual 
This manual begins with two chapters introducing DataCAD to you. “The 
Drawing Board” chapter covers such topics as opening and saving drawings, 
using coordinate entry, and common menus in the program. 

Following this introduction, four additional chapters guide you through a basic 
tutorial, designed to quickly teach you how to use DataCAD’s basic functions to 
produce a plan drawing. All of these exercises focus on a single project. 

The remainder of the manual gives detailed explanations as well as step-by-step 
instructions on how to use each DataCAD function and menu to complete 
drawing tasks. These instructions may include typing words or characters, using 
keyboard shortcuts, selecting entities, and choosing menu options. 

Words or characters to be typed are printed in bold; type them exactly as they 
appear. Keys to be pressed are shown just as they appear on your keyboard, with 
parentheses around the character(s), as shown below: 

Press (Enter). 

Press (Ctrl) + (M). 

Combinations like the second example above should be executed by pressing 
and holding down the first key, pressing the second key, then releasing both 
simultaneously. 

Some instructions ask you to "click" or "right-click" on a button or icon. To click 
on a button, move your mouse until your cursor arrow is over the button and 
then press the left mouse button once. To right-click, press the right mouse 
button once. Right-clicking generally doesn't require specific placement of the 
cursor arrow; however, it must be somewhere over the DataCAD window.  

Getting Help in DataCAD 
DataCAD includes online help, accessible by pressing (Ctrl) + (F1) or using the 
Help Menu in DataCAD. The online help closely follows this Reference Manual 
and includes a table of contents, an index, searching capabilities, and an 
annotation feature to let you make your own notes directly in the online help. 
The online help may also include information that became available after this 
manual went to press. 

You can also access the online help from outside of DataCAD. Use Windows 
Explorer to open the DATACAD\HELP folder and then double-click on 
DCADWIN.HLP. 

Installing DataCAD 
To install DataCAD on your computer, first review the "System Requirements" 
and "Pre-Installation Checklist" sections below to make sure you have everything 
you need to install the program. Then follow the instructions in "Running the 
Setup Program" on the next page. 

Information in this section requires you to be familiar with your computer 
hardware and your computer's operating system (Microsoft Windows 95, 98, or 
ME, Windows NT 4.0 or later, or Windows 2000). 
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To check available free hard disk space prior to installation, double-click on the 
My Computer icon on your Windows desktop. Right-click on the drive you want 
to install DataCAD on and select Properties. The hard disk space already in use 
will be displayed as well as the amount that is still free. 

System Requirements 
Make sure you have the following minimum requirements to install and run 
DataCAD for Windows: 

• Personal or multimedia computer with a Pentium-based processor (Pentium 
II recommended) 

• Windows 95 or later or Windows NT 4.0 or later 

• 64MB of memory for use on Windows 95, Windows 98, or Windows ME 
(128MB recommended); 128MB for use on Windows NT workstation, 
Windows 2000, or Windows XP (256MB recommended) 

• Minimum of 100MB free hard disk space. 300MB is recommended for a 
complete installation. If you do not have enough free disk space in your 
computer when you try to run DataCAD, the message Not enough room to 
create swap files is displayed. Free up disk space and then restart DataCAD. 

To check available free hard disk space prior to installation, double-click on the My 
Computer icon on your Windows desktop. Right-click on the drive you want to install 
DataCAD on and select Properties. The hard disk space already in use will be displayed 
as well as the amount that is still free. 

• CD-ROM drive  

• VGA, or better, resolution graphics card capable of displaying 16-bit color or 
better for using the Shader 

• Microsoft-compatible mouse or digitizer (3-button mouse recommended) 

Pre-installation Checklist 
• Do you have the minimum system requirements for DataCAD? 

• Where do you want to install DataCAD? If you’re upgrading your current 
version of DataCAD, install the new version to the same drive and folder so 
that the program is properly updated. 

• If you’re upgrading your current version of DataCAD, have you made a copy 
of your DataCAD folder to back up all your files before installing the new 
version? This is simply a precaution against losing any of your drawing files 
or customized settings. 

• Remember to fill out and send in your registration card to qualify for 
technical support benefits and to receive new product information as it 
becomes available. 
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Running the Setup Program 
The DataCAD setup program guides you step-by-step through installing 
DataCAD. Please exit all Windows applications completely before running the 
DataCAD setup program. If your computer uses Windows NT or 2000, you must 
have Administrative Privileges to run this setup program. (This means you must 
be logged on as the Administrator.) 

1. Place the DataCAD CD-ROM in your CD-ROM drive; the setup program 
should start automatically. If it doesn’t, click on Run in the Start menu. In 
the Open input box, type e:\setup, where “e” is the letter of your CD-
ROM drive. Press (Enter) or click on OK. To cancel the installation at any 
time, press (Esc) or click Cancel. 

2. The setup program begins. Simply follow the instructions on the screen. 
To properly update your current version of DataCAD, install this new 
version to the same folder. 

3. Once setup is complete, you can view the ReadMe file, which contains 
important information about DataCAD that is not documented anywhere 
else. Click Finish to complete the setup program and open the ReadMe 
file. 

The setup program will ask you to enter your serial number. Your serial number 
is printed on your registration card and looks similar to DCXW12345; the five 
characters after the hyphen are always numbers. Be sure not to substitute the 
letter “O” for a zero when entering your serial number. 

 
 
 



The Drawing Board 
A user-oriented menu system makes DataCAD easy to learn 
and convenient to use. Because it was developed by architects 
for architecture, the program focuses on design, not computer 
technology. Even draftsmen and designers with no previous 
computer experience can learn DataCAD quickly. 

DataCAD’s dual menu system combines familiar Windows 
menus in the Menu Bar with a comprehensive, nested menu 
structure in the Menu Window. This unique system, along with 
toolbars and numerous keyboard shortcuts, allows constant 
access to the tools you use to draw, instead of covering your 
drawing area with menus that are only temporarily visible. 

From your initial design work, massing studies, and interior 
perspectives to your final set of construction drawings, 
DataCAD provides you with the tools you need to produce 
quality work quickly, accurately, and with greater flexibility 
than ever before. 

 

2 
In this chapter: 

 Creating drawings 

 Opening drawings 

 Importing and exporting 
drawings 

 The DataCAD screen 

 Common menus found 
throughout DataCAD 

 Planning your drawing 
project 

 Basic drawing and 
editing 

 Viewing your project 

 Referencing drawings 

 Naming and saving files 
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Opening a Drawing 
DataCAD has four options for opening a drawing: 

• opening an existing DataCAD drawing 

• creating a new DataCAD drawing 

• creating a new DataCAD drawing using a default drawing 

• importing a DWG or DXF drawing file 

If DataCAD does not start, review Chapter 1 to make sure you meet all system 
requirements. You have 30 days of free installation support; see the first page of 
Chapter 1 for details on how to contact us.  

When you open a file, you may see Attention! The drawing file ‘xxx’ is currently 
marked “In Use.” Continuing will result in data loss. Are you sure you want to 
continue? This happens if someone on your network has the file open or if the file 
was exited abnormally the last time it was used. If somebody else is currently 
working on the file, click No to cancel.  

If nobody else is working on a file and you get the Attention . . . message, what 
should you do? That depends on what happened to the file in an earlier drawing 
session. Often, there is an autosave (.ASV) copy of the drawing.  For more 
information about autosave files, see “More About Recovering Lost Work” near 
the end of this chapter. If you get the Attention . . . message but cannot find an 
autosave (.ASV) copy of the drawing, try opening the drawing and using Save 
As in the File pull-down menu to give it a new name.  

Opening an Existing Drawing 
You can open a DataCAD drawing when you first start DataCAD or while you’re 
working on another DataCAD drawing. 

 To open an existing DataCAD drawing: 

1. Start DataCAD. If DataCAD is already running, click Open in the File 
pull-down menu. A dialog box opens, listing all files in the current folder.   

2. Select the type of file you want to open from the Files of Type drop-down 
box. You can open any DataCAD, DataCAD Plus, backup, or autosave 
files.  

3. Click on the drawing you want to open to highlight it. If the Show 
Preview option is checked, this drawing will be displayed in the preview 
window on the right side of the dialog box. 

4. Click on Open or press (Enter) on your keyboard. The drawing is opened. 
If a message displays alerting you to orphaned reference files, see the 
“Referencing Drawings” section in this chapter for instructions on 
resolving these orphaned files. 
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Working with Folders in DataCAD’s Save and Open Dialog Boxes 

You’ll probably want to store your DataCAD drawings for each project in 
separate folders. If you have two projects, you might create two folders named 
PROJECT1 and PROJECT2 in DataCAD’s \DWG folder. 

 To create a new folder in DataCAD: 

1. Start DataCAD or click on New in the File pull-down menu. 

2. Click on the Create New Folder icon in the “Enter name of drawing file to 
edit” dialog box.  The Create New Folder icon is at the top of the dialog 
box. A new folder is displayed in the dialog box. 

3. Type the name of the folder and press (Enter). 

A new folder contains nothing when you create it. Only after you save drawings 
to that folder will the drawing filenames appear in the dialog box. 

You’ll also want to save files to or open files in a different folder than what’s 
displayed in the dialog box. To do this, you’ll first have to change folders. 

 To change folders in a dialog box, do one of the following: 

• Click on the arrow for the “Look in:” drop-down box and select a new 
folder; or 

• Click on the Up One Level icon and select a new folder from the list; or 

• Double-click on a folder to open it. 

Creating a New Drawing 
You must name your new drawing before DataCAD will open it. 

 To create a new drawing: 

1. Start DataCAD; if DataCAD is already running, click on New in the File 
pull-down menu. A dialog box is displayed with the title “Enter name of 
drawing file to create.” 

Shortcut: Press (Ctrl) + (N) to start a new drawing. 

 
2. Type a name for your new drawing in the Filename input box. The 

drawing name can be up to 80 characters long and consist of spaces, 
letters, numbers, and any other characters except the following: + / \ [ ] ; 
: . , 

3. Click on Create or press (Enter). The new drawing is opened. 

The minimize button in the upper-right corner of every drawing window is disabled. But 
you can minimize the DataCAD program window. 
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Creating a New Drawing Using a Default Drawing 
A default drawing is used as a template for creating a new drawing. Simply 
choose the default drawing and then create your new drawing. Or you can use 
the Default Drawing setting in Program Preferences to automatically use a 
selected default drawing every time you start a new drawing. All DataCAD 
drawings have a .DC5 file extension. 

 To create a new drawing using a default drawing: 

1. Start DataCAD; if DataCAD is already running, click on New in the File 
pull-down menu. A dialog box is displayed, prompting you to Enter name 
of drawing file to create. 

2. Click on the Default button. A dialog box is displayed, prompting you to 
Choose new default drawing name. This Default button is not available if the 
Use Default Drawing option is not checked. This option is checked (on) 
by default. 

3. Click on the default drawing you’d like to use and then click on Open. 
The dialog box closes. You’ve just told DataCAD which default drawing 
to use to create your new file. Now you must create the new drawing file. 

4. Type a name for the new drawing you’d like to create in the Filename 
input box of the “Enter name of drawing file to create” dialog box. 

5. Click on Create. Your new drawing is created, with all the settings of the 
default drawing chosen in step 3. 

If no default drawing is specified in the Program Preferences dialog box or 
through the File/New dialog box, DataCAD uses its internal default settings for 
the new drawing. To use these settings, either toggle off Use Default Drawing on 
the Misc. tab in the Program Preferences dialog box or toggle off “Use default 
drawing” in the Create New File dialog box. Also, make sure the Use Default File 
option is unchecked in the File/New dialog box. 

 To automatically use the same default drawing for every new drawing: 

1. Open any drawing file. (The Tools pull-down menu is not available 
unless a drawing is open.) 

2. Click on Program Preferences in the Tools pull-down menu. 

3. Click on the Misc. tab. 

4. Choose a default drawing from the Default Drawing File drop-down box. 

3. Click on OK to save your new settings and close the dialog box. The 
default drawing you chose will now automatically be used each time you 
start a new drawing, unless you specify a different default drawing using 
the Default button in the File/New dialog box, as described in the 
preceding instructions. 
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More About Default Drawings 

Default drawing files are really just regular DataCAD drawing files that are 
stored in your \DATACAD\DEFAULT folder and used in a different way than 
your regular drawing files. A default drawing contains predefined information 
and settings and is used much like a template for creating new drawings. You 
can create your own default drawings with system settings, layer names and 
colors, text font and size, dimension settings, display options, scale type, object 
snap settings, linetype spacing, and more already set; so using a default drawing 
can save you time in setting up each new drawing. 

Setting up a system of default drawing files at different scales and for different 
types of work can significantly reduce production time for drawings and provide 
consistency in work done by different designers in your office. 

 To create a new default drawing: 

1. Create a new drawing as described earlier in this chapter. 

2. Set whatever options you’d like your new drawings to have, including 
grid settings and layers. See the “Before You Draw” chapter for more 
information about many of these settings. 

3. Save the file in your \DATACAD\DEFAULT folder. It’s ready to use 
whenever you need to create a new drawing. 

Importing a DWG or DXF Drawing File 
DataCAD’s drawing translator can import DWG and DXF files compatible with 
AutoCAD 12, 13, and 14 as well as AutoCAD 2000. You can choose an automatic 
translation or an interactive one, where you can decide how each linetype and 
font should be translated and displayed in DataCAD. 

 To import a DWG or DXF file and open it in DataCAD: 

1. Create a new DataCAD drawing, as described in “Creating a New 
Drawing” earlier in this chapter. 

2. Click on Import in the File pull-down menu. The Import dialog box is 
displayed. 

3. Look at the options in the Files of Type drop-down box. Select Supported 
File Formats to display all DWG and DXF files, select DWG to display all 
DWG files, or select DXF to display all DXF files. 

4. Select a file to import from the list or type the name of the file to import in 
the File name input box. By default, DataCAD looks for DXF and DWG 
files in your DATACAD\XFER folder. If your DXF or DWG files are in a 
different folder, change to that folder and then click on the file you want 
to import. 

5. Click Open. The DWG Import Entity Assignments dialog box is displayed 
if the Import section of the DXF/DWG tab of the Program Preferences 
dialog shows that “Interactively assign . . .” is toggled on.  The options in 
the DWG Import Entity Assignments dialog box allow you to choose how 
DataCAD will translate linetypes and fonts. 
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6. Look at the options in the Line Type Assignments box; this lists each 
AutoCAD linetype used in the file and suggests a DataCAD equivalent. 
To change any of these assignments, click on the linetype to change. 
Immediately below the Assignment list box, your selection is reproduced, 
with the translation linetype in a drop-down box. Choose a new linetype 
from the drop-down box; your selection is changed in the linetype list 
box. 

7. Repeat step 6 for the Font Assignments. 

8. Click on OK to close the dialog box and begin importing the file. Progress 
is noted in the Message Area. Or click on Cancel or press (End) to cancel 
the import and close the dialog box. 

 
Figu

More A

The setting
box
If you c e Entity Assignments dialog box, you have 
the option to save those settings in a new .INI file to use when translating other 

 file is saved in the \SUP folder. You can affect how importing 
les and the Entity Assignments dialog box work through settings on the 

DXF/DWG tab in the Tools/Program Preferences dialog box. 

This could be useful if you normally exchange files with several different offices. 
If you change the settings and save a separate .INI file for each office, then you 
can easily switch between .INI files without having to go through entity 
assignments over and over again. 

re 2.1: The Import Entity Assignments dialog box 

bout Importing Files Into DataCAD 

s and assignments that are displayed in the Entity Assignments dialog 
 are contained in a file called TRANSFER.INI in your DATACAD\SUP folder. 

hange any of the settings in th

files. This new .INI
fi



A BRIEF TOUR  |    11 

 To save entity assignments: 

1. Change settings and assignments in the Entity Assignments dialog box as 
described in the step-by-step instructions on importing DWG files. 

2. Click on Save As. The Save Settings As dialog box is displayed. 

3. Type a filename for the new .INI file and click on Save. Or click on Cancel 
to cancel the save. When you save the .INI file, the setting for the 
Translator Settings File on the DXF/DWG tab of the Preferences/Options 
dialog box is changed to that file. 

4. Continue with step 8 in the instructions for importing a DWG or DXF file 
and opening it in DataCAD. 

A Brief Tour 
 

Icon Toolbar
Provides immediate 
access to frequently 
used functions

Menu Window
Drawing and 

modeling functions 
are selected from 

this section

Navigation & 
Projection Pads

Access to view, 
pan, identify, screen 

refresh and zoom 
window controls 

Status Area

Drawing 
Window

Displays active layer, 

n

Message Window
Coordinate read-out, 
system messages, 
menu title and 

nd prompt

Title Bar

Command Line

Menu Bar

color, linetype, 
screen scale and Menu Name
drawi g settings commaActive menu title Prompts you for each step  

Figure 2

The M
The e taCAD screen and contains the 
File, Edit, View, Insert, Create, Tools, Macros, Window, and Help pull-down 

e menus give you quick access to standard Windows functions as 

. 

e in the Menu Bar. The menu will drop down, 

.2: The DataCAD screen 

enu Bar 
 M nu Bar is located along the top of the Da

menus. Thes
well as many of DataCAD’s most used features. 

Notice that some menu options have keyboard shortcuts associated with them
For instance, the Open option in the File menu has (Ctrl)+(O). Instead of using the 
mouse to choose a menu option, you can simply press the keyboard shortcut to 
quickly do the same thing. 

 To choose an option from the Menu Bar: 

1. Click on the menu nam
displaying all the options in it. 
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2. Move your mouse down the menu to the option you want. Notice that 
each option highlights as your mouse passes over it. 

3. Click on the option you want to select. 

Toolbars 
Toolbars are displayed across the top of the DataCAD window, between the 

ting 
 

ars are anchored above the Drawing Area; you cannot move them 
to a different screen position. 

N  you click on different icons, the menu for that function is displayed 
g men  of the Menu 

Window reduces the number of steps to get to a menu and thus saves you time. 

For more information on how to turn off display of the toolbar or how to choose 
which toolbar is displayed, see “Customizing DataCAD” in this chapter. There 
are even icons in some toolbars that let you switch to a new toolbar. 

B ore icons than will fit on the screen, left and right 
far le  of the through 

the toolbar icons. The maximum number of toolbar icons is 100.  

rd DataCAD toolbars, you can also use an undo/redo 
itive viewing toolbars. You can activate the viewing 

enu. 

 

Menu Bar and Drawing Area. It gives you a quick way to access a variety of 
DataCAD functions, no matter where you are in the program. Icons, represen
various DataCAD options, make up the toolbar. If you move your cursor over an
icon, a description of that icon, called a ToolTip, pops up near the icon; the 
description is also displayed in the top line of the Message Area. DataCAD’s 
standard toolb

otice that as  
in the Menu Window. Accessin us using the toolbar instead

ecause a toolbar can contain m
arrow icons are available at the ft  toolbar for easy scrolling 

In addition to the standa
toolbar and context-sens
toolbars by choosing Viewer Toolbar from the View/Toolbars pull-down m
A different toolbar is displayed depending on the view of your model: you can 
use the orthographic view toolbar, the parallel view toolbar, or the perspective
view toolbar. 

   
Figure 2.3: Parallel views toolbar  Figure 2.4: Undo/redo toolbar 

 

     
Figure 2.5: Perspective view toolbar  Figure 2.6: Plan view toolbar 

The Menu Window 
While DataCAD’s Menu Bar has menus that contain shortcuts to many of 
DataCAD’s most frequently used functions as well as basic Window options, the 
majority of DataCAD’s menus appear in the Menu Window. The name of the 
menu shown in the Menu Window appears at the left end of the Message Area. 
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There are two main menus in the Menu Window: Edit and Utility.  To switch 
between these two menus, click on the menu option in the Menu Window or 
simply right-click anywhere in the DataCAD window. Open a drawing in 
DataCAD and try right-clicking a few times; notice the menu selection changes
between the Edit and Utility menus. 

Both 2D and 3D menus are displayed in the Menu Window, but these menus
not interchangeable. For example, the Mo

 

 are 
ve command in the Edit menu should 

submenus may, in turn, contain additional submenus and menu options. When a 
 exits the submenu and displays the 

previous menu in the Menu Window. 

 to scroll forward and backward through menu lists. This 

not be confused with the Move option in the 3D Edit menu. 

Menus in the Menu Window are nested. As you can see in Figure 2.2, there are 
many submenus available from the Edit and Utility menus. Each of these 

submenu is being displayed, right-clicking

Shortcut: Press (PgUp) and (PgDn)
only works when you’re in a menu with ScrlFwrd and
these shortcuts are used to change your drawing dis

 ScrlBack options. At all other times, 
play scale. 

The Menu Window lists the options in the currently selected menu. If a menu 
 a single list, a scroll forward option 

d) is displayed at the bottom of the menu and will be available until you 
a list, a scroll back option 

rned on or off. 
ed and the button name is green. 

and the button name is red. 

contains more items than can be shown in
(ScrlFwr
reach the end of the list. Once you scroll forward in 
(ScrlBack) will also be available. As you move through DataCAD’s menu 
structure, the selections in the Menu Window change to reflect the different 
commands associated with each option. 

Some DataCAD menu options are toggles, switches that can be tu
When a toggle is on, the button appears depress
When a toggle is off, the button appears raised 

Used to edit 
Used to organize 

your drawi
or modify 

ng

Menu title Menu title
 

Figure 2.7: The Edit menu (left) and Utility menu 

your drawing

Used to draw 
objects and text

Used to change 
system settings

Switch to 3DEdit/
3DEntity menus

DataCAD macros
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Choosing Menu Options 

There are three ways to choose a menu option: 

• click on it using your mouse 

• press the corresponding function key 

• use a keyboard shortcut or command line alias 

Many of the most productive DataCAD users use keyboard shortcuts to enter 
values and choose menu options while using the mouse to draw and enter other 
drawing information. With one hand on the keyboard and the other on the 
mouse, you can draw in DataCAD very efficiently and quickly. 

 se a menu option using the mouse: To choo

1. Mo
use

2. Clic

. Rig ed using the 
fun

Notice that  
label corres
usual y loc d and are labeled 

s ough 
 press (S

eyboard shortcuts let you access a variety essing 
one or two keys. For example, you can press  on the keyboard to open the 

oose 

be 
ess 
d to 

 be 
t 

s that will be particularly useful to you as you draw: 

r’s current position. To reposition 
a drawing, move the cursor to the new center and press (Home). 

u can also use Undo in the Edit pull-down menu 
ious 

 
edo your previous actions; it just restores the deleted 

(Esc

ve the cursor over the option in the Menu Window that you’d like to 
. The menu option highlights as the mouse cursor passes over it. 

k the left mouse button. 

3 ht-click (click the right mouse button) when you are finish
ction; this lets you exit the menu. 

 immediately to the left of each menu option in the Menu Window is a
ponding to the function keys on your keyboard. Function keys are 
ated across thl e top or on the left side of your keyboar

as “F1,” “F2,” “F3,” etc. To choose a menu option, simply press the 
corre ponding function key. If a menu option’s function key label is S1 thr
S0, hift) + (F1) through (Shift) + (F10). 

of functions quickly just by prK
(A)

Architect menu from anywhere in DataCAD instead of using the mouse to ch
the option from the icon toolbar or Menu Window. 

In this manual, all keyboard shortcuts are described exactly how they should 
executed. If a shortcut requires a lowercase letter, you will be instructed to pr
only that letter. If a shortcut requires an uppercase letter, you will be instructe
press (Shift) and that letter simultaneously. For instance, the snap grid can
toggled on and off by pressing (X) (a lowercase “x”); however, to open the Objec
Snap menu via the keyboard, you must use an uppercase “X”, so you must press 
(Shift) + (X). 

There are several shortcut

SHORTCUT FUNCTION 
(Home) Centers a drawing or view on the screen at the curso

(,) Deletes only the last entity you drew 
(<) Deletes the last group you drew; yo
(.) Restores only the last entity you deleted. This shortcut does not undo your prev

actions; it just restores the deleted entity. 
(>) Restores the last group you deleted; you can also use Redo in the Edit pull-down

menu. This shortcut does not r
group. 

) Redraws the screen to display the most recent version of the drawing 
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(End) ly. To terminate the screen refresh 
on additional layers, press (End) once for each additional layer. (End) does not affect the 

e time on large drawings. 
est 

(Delete) 
(PgUp), (PgDn) Changes the display scale in increments specified in the ToScale menu. To zoom out, 

(PgUp); to zoom in, press (PgDn). 
(P) Restores the previous view and returns to the previous scale in one keystroke. 

 previous views. 

cted results if you don’t clearly 
s. For example, there’s a difference between 
s. The results you get with the keyboard 

sho
Undo o
command you used) is (Ctrl)+(z); this pr esults as selecting 
Un  the Back button on the 
Undo/ r. The keyboard shortcut for Redo (which reinstates the last 
command undone by using Undo) is (Ctrl)+(y); this produces the same results as 
selectin it pull-down menu or clicking the Forward button on 
the Undo/Redo Toolbar. 

The Appendix has a complete list of all keyboard shortcuts in DataCAD plus 
rogram your own shortcuts. 

e Alias lets you assign a keyboard shortcut to a single or 
multi-character shortcut. You can have unlimited multi-keystroke shortcuts. 

 

(Ctrl) (Spacebar). You are prompted to enter the alias you want to 
use. 

 to use and press (Enter). 

Press  and then  to see the list of available aliases. Highlight 

Cus

The nu
[Alias]

  customiz

2. Find the Alias section, as shown below: 

[Alias] 

 Terminates the screen refresh on the active layer on

drawing file, only that portion of it which is displayed. Sav
Once the part of the drawing you want to edit is redrawn, press (End) to cancel the r
of the refresh.  
Terminates the screen refresh on all layers simultaneously 

press 

DataCAD remembers up to 25
 

Some keyboard shortcuts can yield unexpe
understand what the command doe
Undo/Redo and Restore command

rtcuts (,), (<), (.), and (>) are not the same as what happens when you use 
r Redo. The keyboard shortcut for Undo (which negates the last 

oduces the same r
do from the Edit pull-down menu or clicking

Redo Toolba

g Redo from the Ed

instructions on how to p

Using the Command Line Alias 
The Command Lin

To use a command lin

1. Press  + 

e alias: 

2. Choose an alias in either of these two ways: 

• Type the alias you want

• (?) (Enter)
the alias you want to use and press (Enter) or simply double-click on 
the alias. 

tomizing the Alias Browse Box 

mber of lines shown in the list as well as its width can be adjusted in the 
 section of the DCADWIN.INI file. 

To e the alias list box: 

1. Look in the Windows folder  (normally located on your C:\ drive) and 
locate DCADWIN.INI and open it in a text editor, such as Notepad. 
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Popup Width=300 

as 

ll take you to the Erase, Partial menu: 

1. Press (Ctrl) + (Spacebar). 

2. Click on Settings; the Alias Manager appears. 

3. Go to the Alias input box; type the shortcut you want to use, in this case 
ep. 

4. Go to the Comment box; type a hint to describe the alias: Erase Partial 

5. Go to the Sequence box; type the required keyboard sequence for the 
command: ^;^F7^F9^. Note that the format for a Command Line Alias is 
the same as a Keyboard Macro. You must separate each function with a 

lick on Add to add the new alias to the list. 

e. 

he Navigation Pad 
he Navigation Pad is displayed below the Menu Window and provides an easy 

way to view your model, recalculate extents, and access the 3DViews, Identify, 
and WindowIn menus. 

Popup Lines=4 
 
3. Change the width and lines values as necessary and then save the file. 

Making an Alias 

Aliases are stored in a text file in your SUP folder called DCADWIN.DCA.  
Aliases use the same shorthand as custom keyboard macros.  An item in the Ali
file looks like this: 

[cr] 
comment=draw circle by radius 
alias=^;^S5^S1^ 

 

 To make an alias called “ep” that wi

carat [^]. 

6. C

7. Click on OK to close the Alias Manager. Your alias is now ready to us

T
T
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Both the Navigation Pad and the Projection Pad appear under the menu buttons 

s 
ptions from the View pull-down menu in the Menu Bar. The menu 
 take up so much room that neither pad can be displayed. Or the 

ns 
x. You 

igure 2.8: Some of the Navigation Pad’s buttons can be used to change your view of your 
drawing. 

The Navigation Pad also includes arrow keys to pan, or move the observer 
around the model on the screen. 

Figure: 2.9: Click the arrow buttons on the Navigation Pad to easily change the view of your 
odel. 

ou can also use the keyboard arrow keys in the same way you use the 
avigation Pad arrows. The pan distance, or how much the display shifts each 

time you use one of the arrow keys, can be set to any value by using the ScrlDist 
 

The Projection Pad is a set of nine buttons located directly under the Navigation 
Pad. These options are also available from the View pull-down menu on the 
Menu Bar. 

if there is enough room. If the menu buttons require too much space for both 
pads to appear, only the Navigation Pad will be displayed. You can still acces
projection o
buttons may
menu buttons themselves may be cut off at the top of the DataCAD window. To 
make more room to display the pads, choose a smaller font for the menu butto
using the Interface Settings tab in the Tools/Program Preferences dialog bo
can also choose a higher screen resolution; see Windows Help for more 
information on this. 

 

 

Displays the drawing at its most recently calculated 
extents; no recalculation is done, so this is us

F

ually 
much faster than using R on this pad; however, your 
most recent changes may not be displayed 

Displays the Identify menu in the 
Menu Window 

Displays the WindowIn (zoom) 
menu in the Menu Window 

Recalculates the extents of a 
rawing; use after you’ve made a 

major change, such as deleting part 
f your drawing 

d

o

D
M

isplays the 3DViews menu in the 
enu Window 

 
 

 

 

 

Observer looks or steps up 

Observer looks or steps to the 
left of the model 

 Observer looks or steps down 

Observer looks or steps to the right 
of the model 

m

Y
N

in the Settings menu. See “Setting the Scroll Distance” in the “Settings” section of
the “Before You Draw” chapter. 

The Projection Pad 
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Both the Navigation Pad and the Projection Pad appear under the menu buttons 

u 

You can also choose a 
formation on this. 

The Status Area 
ttom left corner of the DataCAD window. 

er 

Hotspot

The Sta r, Layer, Scale, Linetype, 
 Selecti  the Status Area, just left-click on the item (text, color 

t to change. DataCAD instantly takes you to the 
appropriate menu or dialog box so you can make your new selection. For 

ox 
appears. C  has the following results: 

ctive laye

Active 

if there is enough room. If the menu buttons require too much space for both 
pads to be displayed, only the Navigation Pad will appear. You can access 
Projection options from the View pull-down menu in the Menu Bar. The men
buttons may take up so much room that neither pad appears or the menu 
buttons may be cut off at the top of the DataCAD window. To make more room 
for the pads, choose a smaller font for the menu buttons using the Interface 
Settings tab in the Tools/Program Preferences dialog box. 
higher screen resolution; see Windows Help for more in

 
 

  

 
 

 

Figure 2.10: The Projection Pad has nine options to change your view of your model. 

The Status Area is located in the bo
When you are working on a drawing, this area provides information on the 
current settings. See “Customizing Display” in the “Before You Draw” chapt
for more information on Display menu options. 

 
 

 

 

 

Figure 2.11: The Status Area lets you quickly know information about the active layer and the 
status of various other settings in DataCAD. 

SWOTHLUDFB settings affect how a drawing is plotted as well as how it 
appears on the screen. 

s 

tus Area gives you one-click access to the Colo
and on Set menus. In
swatch, or square) you wan

example, if you click on the active layer’s name, the Layer Manager dialog b
licking on a hotspot in the Status Area

A r’s color swatch – the Color Palette appears 

layer’s name – the Layer Manager appears 

Orthographic (plan) 

Perspective view Parallel 

Front elevation Back elevation 

Right elLeft elevation evation 

Zoom out on your drawing to 
display it at a smaller scale or 

Zoom in on your drawing 
(displays drawing at a larger 
scale or size) size 

Active layer (layer entities will be drawn on) Active layer’s color 

Layer search toggle 

Activity light displays 

Current display scale 

Current linetype 

Current selection set
green when DataCAD 
is ready for the next 
task; red means it is 
processing Status of display toggles 
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Cu play scale – the ToScale selection menu appears rrent dis

rrent lin u appears 

rrent se

 (Tab) changes the active layer by 
rolling th r name in the 
atus Area you press (Tab). Press (Shift) + (Tab) to scroll 
ckward ng’s layers. 

oggling Layer Search On or Off 

Area to quickly toggle layer 
he “L” is green, layer 

sea  the “L” is red, layer search is off. 
We ater in this 
chapter. 

e key (‘) to toggle the LyrSrch option on or off. 

Cu etype – the LineType men

Cu lection set – the EditSets menu appears 

Changing the Active Layer 

In a drawing with multiple layers, pressing
sc rough all the layers that are on. You’ll see the active laye
St  change each time 
ba through your drawi

T

You can click on the layer search toggle in the Status 
search on or off. If the toggle button is depressed and t

rch is on; if the toggle button is raised and
’ll discuss DataCAD’s layer search option in “Selection Menus” l

Shortcut: Press the apostroph

Using SWOTHLUDFB 

SWOTHLUDFB in the Status Area lets you know at a glance whether these 
toggles are on or off. Each letter represents a particular feature in DataCAD. 

hen the letter is in uppercase, the feature it represents is on or active. When the 
case, the feature is off or inactive. Specific SWOTHLUDFB settings 

re: 

 Snap grid is on. Your cursor will move along the X and Y axes in increments specified 
by the SetSnap option in the Utility/Grids/ GridSize menu.  
Snap grid is off. Your cursor is not restricted to incremental movement; you can draw 
entities at any point in the Drawing Area. 

Shortcut: To toggle snap grid on or off, press (X). 

W
letter is lower
a

S

s 

W Walls mode is on.  
w Walls mode is off.  

Shortcut: To toggle wall mode on or off, press (=). 

O Ortho mode is on. Your cursor will move at angle increments specified by the 
SnapAng option in the Utility/Grids menu.  

o Ortho mode is off. Snap angle settings are not used; you can draw entities at any 
angle. 

le Ortho mode on or off, press (O). Shortcut: To togg

T Text in your drawing is displayed on the screen as entered. 
t Text in your drawing is represented by appropriately sized boxes. 
H Hatch patterns are displayed. 
h Hatch patterns are not displayed. Drawings refresh faster. 
L Lines are displayed at the weight (thickness) that you drew them. 
l Lines are all displayed with a line weight (thickness) of 1. Drawings refresh faster. 
U Linetypes, or “user-defined lines”, are displayed. 
u Linetypes, or “user-defined lines”, are all displayed as solid. Drawings refr
D Associative dimensions are displayed. 

esh faster. 

d Associative dimensions are not displayed. Drawings refresh faster. 
F Fills are displayed 
f  Fills are not displayed 
B Bitmaps are displayed 
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b  Bitmaps are not displayed 
 

 To change the status of SWOTHLUDFB toggles: 

1. Click on Display in the Utility menu. 

2. Click on the appropriate menu option to toggle it on or off. 

The Message Area 
The Message Area displays information about your drawing. It includes the 
current coordinate entry mode, the cursor’s position, the menu you are using, 
program and error messages, the Z-base and Z-height, and program prompts 
and data entry area. 

 window. 

lay can be shown in architectural, engineering, 

The Drawing Area 
n the DataCAD window, displays drawing 

g at any scale. In other words, you can zoom 
nd 

chapter for more information on zooming in and out on your drawing. 

 

 

 

 

 

Figure 2.12: The Message Area is located along the bottom of the DataCAD

Current coordinate entry Coordinate display (current cursor position) 

Name of menu being displayed 

Prompts and data entry Program and error messages plus 
current Z-base and Z-height 

 

The values of the coordinate disp
or metric units. See “Setting Scale and Angle Types” in the “Customizing 
Settings” section of the “Before You Draw” chapter for more information on how 
to display values in a different unit of measure. 

The Drawing Area, the largest i
contents. Lines, arcs, walls, fixtures, and anything else you design are displayed. 
Although drawings in DataCAD are drawn at full scale in an infinite field, you 
can display any portion of a drawin
in and out on your drawing, as needed. To do this, you can use the ToScale a
WindowIn options in the Utility menu. See “Viewing Drawings” later in this 
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Figure 2.13: The Drawing Area is the largest part of the DataCAD window. 

Customizing DataCAD 
The Program Preferences dialog box, available from the Tools pull-down menu, 
lets you customize folders for each DataCAD file type, how the DataCAD screen 
looks, how the DWG/DXF translator works, and the macros available in the 
Macros pull-down menu, as well as several miscellaneous settings. 

Customizing Pathnames 
The Pathnames tab in the Program Preferences dialog box lists the default folders 
that files are stored in. 

To reset all folder names to their defaults, click Defaults in the bottom right 
corner of the Program Preferences dialog box. 

ox of the folder path you’d like to change, and type a 
new path; or, click on the folder icon at the right of the path to be changed 

.  

aCAD defaults. 

If y e ly highlight 
the

 To change a path: 

1. Choose Program Preferences from the Tools pull-down menu. 

2. Click in the input b

and browse for a new path

3. Click on OK to save your changes and close the dialog box; click on 
Defaults to reset all paths to their Dat

ou nter a folder name that doesn’t exist, clicking on OK will simp
 incorrect folder. 
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Figu

DataCAD tries to resolve invalid reference file paths. It does this by checking the 

the ad of the file designated in the 
orig

Cu m
The t
inte c
over the dif  any part of the 
ima t

Warning: CAD window is maximized before you attempt to customize 

re 2.14: The Pathnames tab on the Program Preferences dialog box 

current drawing file folder for valid references. If a valid reference file is found in 
 current drawing file folder, it will be used inste
inal path; however, the original path will be retained. 

sto izing DataCAD’s Interface 
 In erface Settings tab on the Program Preferences dialog box contains an 
ra tive copy of the DataCAD window. Using your mouse, move your cursor 

ferent areas of this image to see Tool Tips. Click on
ge o make changes to that part of the interface. 

 Make sure the Data
the rinte face, or erratic behavior may occur when using the program. 
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Figure 2.15: The Interface Settings tab on the Program Preferences dialog box 

The toolbar is anchored above the Drawing Area; you cannot move it to a 
different screen position. 

 To turn the toolbar on or off: 

1. Click on Program Preferences in the Tools pull-down menu. The Program 
Preferences dialog box is displayed. 

2. Click on the Interface Settings tab, if it’s not already showing. 

3. Position your cursor over the toolbar in the interface image or, if the 
toolbar is already off (not being displayed), above the Drawing Area 

 To change the color of the Drawing Area: 

1. Click on Program Preferences in the Tools pull-down menu. The Program 
Preferences dialog box is displayed. 

2. Click on the Interface Settings tab, if it’s not already showing. 

where the toolbar is normally displayed. 

4. Click to toggle the toolbar on or off. 

5. Click on OK to close the Program Preferences dialog box. The toolbar 
display is changed. 

You can also turn the toolbar on by checking On/Off in the Default .KEY file 
section on the Misc tab of the Program Preferences dialog box. Turn the toolbar 
off by unchecking the On/Off option. 
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3. Position your cursor anywhere over the Drawing Area in the interface
image. 

4. Click to open a Color Palette dialog box. 

 

 
Figure 2.16: The Color Palette dialog box lets you select a new background color for your
drawings 

 

play. 

ea 

ram 

Position your cursor over any part of either pad or the Status Area, or any 

e 

5. Choose a new color for the Drawing Area background and click on OK. 
The Color Palette dialog box closes, and the Drawing Area background 
color is changed in the Program Preferences Interface Settings dis

6. Click on OK to close the Program Preferences dialog box. The Drawing 
Area background color is changed. 

 To move the Menu Window, Navigation Pad, Projection Pad, and Status Ar
to the opposite side of the DataCAD window: 

1. Click on Program Preferences in the Tools pull-down menu. The Prog
Preferences dialog box is displayed. 

2. Click on the Interface Settings tab, if it’s not already showing. 

3. 
part of the Menu Window except the menu options. 

4. Click to move these parts of the interface to the opposite side of th
DataCAD window. 

5. Click on OK to close the Program Preferences dialog box. The Menu 
Window is moved to the other side of the window. 
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 To change the font used on the menu buttons in the Menu Window or the 
font used in the Message Area: 

1. Click on Program Preferences in the Tools pull-down menu. The Program 
Preferences dialog box is displayed. 

2. Click on the Interface Settings tab, if it’s not already showing. 

3. To change the font in the menu buttons, position your cursor anywhere 

ialog box. 

ences dialog box (Tools pull-down 

s 

over the menu buttons in the Menu Window of the interface image. To 
change the font in the Message Area, position your cursor anywhere over 
the Message Area of the interface image. 

4. Click to open a Fonts d

5. Choose a new font and click on OK. The Fonts dialog box closes. 

6. Click on OK to close the Program Preferences dialog box. The menu 
button font is changed. 

Customizing File Translation 
The DXF/DWG tab on the Program Prefer
menu) lets you choose an import method, translator default settings, and 3D 
entity export method. DXF/DWG supports solid fills, TrueType fonts, polyline
with voids, and complex hatch patterns (such as StoneCAD). 

 
Figure 2.17: The DXF/DWG tab on the Program Preferences dialog box 



|  CHAPTER 2: THE DRAWING BOARD  26 

You can choose between two import methods: the first method allows you to 
interactively (manually) assign linetypes and fonts, while the second makes 
assignments automatically, according to the Translator Default Settings in the 
Program Preferences dialog box. The interactive option is the default method an
uses the DWG Import Entity Assignments dialog box. Th

these 

d 
e DWG Import Entity 

change as well. Set the 

 entity in the DWG or DXF file. To 
 

WING.DWG 
and MYDRAWING.SHX. In order for the linetypes in the DWG file to display 
properly, the .SHX file must be placed in the \SUPPORT folder in the AutoCAD 
folder. The AutoCAD user may also place the .SHX file in the same folder as the 
.DWG file. A .SHX file is only created if line types other than Solid, Dashed, 
Dotted or Dot-Dash are used. 

If you’re not concerned with linetypes displaying exactly as you drew them, 
check the Export Linetypes toggle in the Tools/Program Preferences dialog box 
to convert all user-defined linetypes (any linetype except Solid, Dotted, Dashed, 
and Dot-Dash) to Continuous when exporting a DataCAD drawing to a DWG or 
DXF file. In this case, a shape file will not be created because none is needed; 
instead, all user-defined linetypes in MYDRAWING.DC5 will be permanently 
translated to the Continuous linetype. The Export Linetypes toggle is off by 
default. 

Both DataCAD and AutoCAD define colors in terms of their place in each 
program’s internal color list. For instance, in DataCAD's code, Color 1 = White, 
Color 2 = Red, Color 3 = Green, etc. While we see white, red, and green colors on 
screen, DataCAD recognizes these only as Color 1, Color 2, and Color 3, 
respectively. AutoCAD works similarly, except AutoCAD displays Color 1, Color 
2, and Color 3 as red, yellow, and green, respectively.  

So if you don’t have the Import/Export Color Translation toggle checked when 
you export a DataCAD file, the resulting DWG/DXF file will only associate 
“Color 1,” “Color 2.” etc., with each entity. When the file is displayed in 

s the entity as red, 
instead of white as it was drawn in DataCAD. With the Import/Export Color 
Translation toggle on, the table file corrects for this, so that white entities in 
DataCAD are displayed as white when exported to a DWG/DXF file and vice 
versa. 

Assignments dialog box is displayed during the import process only if the 
interactive option is checked. 

There are several Translator Default Settings you can 
default font, linetype, base unit, and translator file to use during import. These 
defaults will be used as assignment suggestions when using the interactive 
import method; with automatic translation, however, they will be used when 
DataCAD has no equivalent for an existing
change any of these settings, click on the arrow to the right of the drop-down box
and select another setting.  You can also check the “Move drawing to origin” 
option to move drawing geometry to absolute 0 during import. This option is 
unchecked (off) by default. 

During export, the line definitions and shape codes for DataCAD linetypes are 
stored in a .SHX file. If you export a DataCAD drawing named 
MYDRAWING.DC5, the translator will create two files: MYDRA

AutoCAD, the program recognizes “Color 1” and display
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The Import/Export Color Translation toggle, which is on by default, tells 
DataCAD to use a table (.TBL) file so that colors translate properly when
exported to or imported from a DWG/DXF file. An easy way to create a table fi
is to simply save DEFAULT.TBL under a new name that matches the custom R
file. You can select Generate TBL File from the Tools pull-down menu to create a 
TBL file to match the currently selected RGB file. You must create this file for 
each custom RGB file. It should be given the same filename as the currently 
selected RGB file and saved in the DATACAD\SUP folder. 

The 3D Entity Export option, located near the bottom of the DXF/DWG tab
unchecked (off) by 

 
le 

GB 

, is 
default. Any 3D entities in a DataCAD (.DC5) file will be 

ace 
 3D 

; 

tion can make translation faster and the translated 

b to export any XREFs you’ve used in your drawing 
s a 

o-

the 

 12:00 P.M.). 

os you want to be displayed in the Macros pull-down 
 macros in the Macros Available 

acros that you have installed 
hat 

the Macros pull-
down menu. Macros removed from the Macros in Menu list simply won’t be 
displayed as options in the pull-down menu. 

translated as a polyface mesh when exported to a DXF or DWG file; this polyf
mesh is a single entity. However, by checking the “Decompose 3D entities as
faces” option, each facet of a 3D entity will be turned into an individual polyface
thus, a single sphere in DataCAD can be translated into many separate entities 
arranged in a sphere shape in a DWG or DXF file. 

Checking the Decompose op
entities will look the same after a shade or hidden line removal. However, editing 
may be more difficult since these translated 3D entities are made up of many 
smaller and separate entities. 

Check the “Automatically export reference files” option in the Reference Files 
section of the DXF/DWG ta
at the same time you export the drawing itself. Each reference file is exported a
separate .DWG file. This option is checked by default; if you uncheck it, XREFs 
will not be exported along with your drawing. If you send your drawing to a c
worker or client, be sure to send all of the exported reference files as well so your 
drawing will be viewed as you intended. 

You can toggle on “Expand exported stamps to values” in the final section of 
DXF/DWG tab. When this box is unchecked, the stamp will export in its raw 
token format (i.e., @PLTTIME). When this box is checked, the stamp will export 
as it appears in DataCAD (i.e.,

Customizing the Macros Menu 
The Macros tab in the Program Preferences dialog box (Tools pull-down menu) 
lets you choose which macr
menu. To add macros to the menu, click on the
list box, then click on the Add button. To delete macros from the menu, click on 
the macros in the Macros in Menu list box and then click on the Remove button. 

The Macros Available list box contains all m
(normally found in the DATACAD\DCX folder). It is possible to add macros t
are located in other folders: click on the file folder button above the Macros 
Available list box to browse different folders and select macros to add to the list. 

You aren’t uninstalling macros when you remove them from 
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Figure 2.18: The Macros tab in the Program Preferences dialog box 

Customizing Miscellaneous Settings 
 

Y u can activate the Display List to increase display speeds in DataCAD. The 
 in your 

is 

 

The Misc tab on the Program Preferences dialog box (Tools pull-down menu) has
several settings to customize DataCAD’s functionality. You can set a default 
drawing to be used automatically when you create new drawings, select a 
default toolbar to use, and select a default font for text that you enter into your 
drawing. Simply click in the appropriate drop-down box and choose a file. 

o
display list is a sort of internal list that DataCAD keeps of all entities
drawing. The speed of redrawing the geometry in the Drawing Area when you 
pan, change views, or press (Esc) to update the drawing is increased when th
option is checked. Display List is toggled on by default. 

Shortcut: Press (U) at any time to update the Display List. Note that this is different than
pressing (Esc) in that (Esc) simply redraws the geometry in the current display list while (U) 

s theupdate  display list itself and then redraws all entities. 

To find out how many entities and line segments are in the Display List, as well 

in the Utility / Display / DispList menu. 
as how much memory is being used to maintain the Display List, choose Status 
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Although the Max Acceleration toggle next to Display List is unchecked (off) by 

r 
t 

ay shortcut. To avoid any 

default, you can check this to increase display speeds even more. To accomplish 
this, DataCAD takes a few minor shortcuts when redrawing your geometry. For 
instance, arcs may appear segmented and object snap points may appea
enlarged when you zoom in on them. Please note that your geometry has no
actually been changed in any way; it is merely a displ
display shortcuts, keep Max Acceleration toggled off. 

 
Figure 2.19: The Misc tab in the Program Preferences dialog box 

The DC Render Material Assignment section allows you to export .RAY files in 
which you can assign materials by color, by layer, or by color and layer. 
Assigning materials by color means you assign one material to all entities of a 
specified color. Similarly, assigning materials by layer means you assign one 
material to all entities on a specified layer. And assigning materials by both color 

n a 
ed 

you select a DataCAD entity to 

g. 

and layer means you assign one material to all entities of a specified color o
specified layer. For instance, all red entities on the Walls layer would be assign
one material, all white entities on the Walls layer would be assigned a different 
material, and all white entities on the Doors layer would be assigned yet a 
different material. 

The Copy to Clipboard section has three options, “Copy entity color,” “Copy 
entity line weight,” and “Expand exported stamps to values.” The first two 
options are both checked (on) by default. When 
copy, these options cause the entity’s color and line weight to be copied as well. 
Then when the entity is pasted into another document, the entity displays as it 
did in the original drawin
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The “Expand exported stamps to values” option lets you determine the format of
stamps when they are either copied to the clipboard or exported via DXF/DWG.
When this box is unchecked, the stamp will export in its raw token format (i.e., 
@PLTTIME). When this box is checked, the stamp will export as it appears in 
DataCAD (i.e., 12:00 P.M.). 

 
 

Text Menu checked on the Misc tab and TxtScale is toggled 

 text 
 in 

PgUp\PgDn rather than selecting the PltScale button in the Text menu.  The 
s and 

If you’d like Free Zooms and pans and scrolls to be included in these previous 
members Pans/Scrolls on the Misc 

Normally, pressing (Page Up) and (Page Down) changes your drawing scale. If you 
have PgUp/PgDn in 
on in the Text menu, pressing (Page Up) and (Page Down) will not only change the 
drawing scale but also the plotting scale. With TxtScale on in the Text menu,
is always inserted at a size relative to the current plot scale. If the toggle is on
Program Preferences, then you can change the current plot scale by pressing 

PltScale button only appears when the option is OFF in Program Preference
TxtScale is ON in Text menu. 

DataCAD can remember up to 25 previous views (at set scales) of your drawing. 

views, check Remembers FreeZooms and Re
tab. 

Shortcut: Press (P) to return to the previous view. 

There is also an option to display the boundary of a clip cube. Check Disp
in the Clip Cube section of the Misc tab. See the “Viewing Your Model” chapter 

lay On 

iew of selected symbols when you insert symbols using 
the Insert pull-down menu. Using the Symbol Preview setting on the Misc tab, 

 view, or 

n the Nested XREF Highlighting 
etain their highlight settings if you insert them in 

ings will 

r of Tooltips by clicking on the box in that portion of the 
 dialog box to the screen so that you can 

control the delay speed for 
sc tab. 

of the Misc tab controls how you zoom in and out 
o d. This 

 you move the mouse wheel to zoom in 
and out on your drawing. The zoom factor is +/- 25%. 

for more information on using clip cubes. 

The AndCopy Toggles option determines whether the status of the AndCopy 
toggles in such menus as Move, Rotate, Enlarge and Mirror is remembered by 
DataCAD. By unchecking Remember On/Off Status, the AndCopy option in the 
menus will always be toggled off when the menu is opened. 

DataCAD displays a prev

you can choose to display this preview in orthographic or isometric view. You 
can also change this setting on the Insert Symbol dialog box; check the Isometric 
View option below the preview window to display symbols in isometric
uncheck it to display them in plan view. Symbol previews are displayed in 
orthographic view by default. 

When “Inherits current setting” is unchecked i
section, the nested XREFs will r
another drawing file. If the box is checked, the drawing file’s current sett
be used for XREF highlighting.  

You can change the colo
Misc tab. This brings the Color Palette

dition, you can select the color you prefer. In ad
Tooltips with the slider on the Mi

The Scroll Wheel Zoom section 
using your m use wheel. As a default, “Requires Ctrl key” is checke
means that you must press (Ctrl) while
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Common Menus in DataCAD 
out 

 
refers to th ies for editing purposes. There are three 

(when mul

There are several types of menus that appear frequently as submenus through
DataCAD, including selection, value, and color menus. 

Selection Menus 
Selection menus appear frequently in submenus throughout DataCAD. Selection

e way you mark drawing entit
primary ways to select drawing entities: by Entity (one at a time), by Group 

tiple entities have been associated with one another), or by Area (an 
editing box stretched around entities). 

 
Figure 2.20: From left to right, examples of Entity, Group, and Area selection 

Along with Entity, Group, and Area, selection menus include several other 
methods for selecting parts of the drawing to edit. All of the options are not 
available in every selection menu; selection menus are tailored for each editing 

 can include: 

rband 

orary 

. A 

imensions, and 
abs, spheres, and 

ther logically but not 
y be part of the same group, 
ent groups. 

lin ed as a ays. A group of entities drawn in 
ked as one group. Similarly a 

he sa oup. You can 
titie or groups of entities usin tion in the Edit menu. 
 are oup hey ame time with the Copy 

 A dCop gg se Move, then the copies 
roup  edited, with the Change or 

ove options for example, it retains the same group associations.  

option. Selection menu options

Entity Select drawing entities one at a time; this is the default selection method 
Group Select entities that are associated as a group 
Point Select entities by a single point; available only when using Stretch 
Area Select geometry wholly contained within an area that you define with a rubbe

box 
Fence Select geometry wholly contained within a fence that you define with a temp

polygon boundary 
Crossing Select any entity that crosses an area or fence boundary 
SelSet Select entities that are associated in a selection set 
LyrSrch Editing operations search all layers that are toggled on 

More About Selection Menus 

An entity is a straight or curved geometric element defined by two end points
line, a circle, an ellipse, and an arc are all entities. A B-spline or Bezier curve or a 
line of text is also an entity, as is a symbol, associative d
associative hatching. There are also 3D entities, such as sl
cylinders. Entities can be edited alone or as a group.  

A group is a set of any number of entities, linked toge
necessarily graphically. Entities that do not touch ma
and entities that are contiguous may be part of differ

Entities are k  group in a number of w
succession without disconnecting the cursor are lin
series of lines of text entered at t me time are linked as one gr

en s oplink s g the LinkEnt
Entities  also gr ed when t are created at the s
option. If the n y option is to led on when you u
will be a single g . When an existing entity is
M
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The grouping together of entities in DataCAD allows you to edit many relate
items without affecting other enti

d 
ties in the same portion of a drawing. Because 

groups are also easily redefined, the designer can organize a drawing as a series 
elated pieces or entities. 

You n  selection uses a box, which is 
tem r nt to select. All entities and groups 
enclosed completely within this ea selection. Any 
ent  within the area box are not 
inc e

Sim r  
up to 3 orarily drawn around the entities you want to 
select. The f
com e

Crossing is a toggle available during area and fence selection that you can enable 
afte ossing, you can 
select any e he rubberband box, along with any entities fully 

orks with all editing commands except Stretch. 

A s t
provid editing by reducing the time required to 
sele ay contain any 
number of entities or groups, and up to eight different selection sets may be 

Add or remove entities from 
h the EditSets option in the Edit menu. See “Working With 

 

Press (Alt) + (1) through (Alt) + (8) to change the active selection set when editing. 
While in an edit command, such as Move or Erase, press (Alt) + (2), for example, to 
switch to selection set 2. 

Layer Search controls whether or not DataCAD scans all layers during selection 
operations. If you toggle LyrSrch on, you can select entities on all layers that are 
on (being displayed). When the LyrSrch toggle is off, you can select entities only 
on the active layer (the layer you’re currently working on). We’ll cover layers in 
more depth later in this chapter. 

Shortcut: Press the apostrophe (single quotation mark) key on your keyboard to toggle 

of elements composed of logically r

 ca  also select entities by area or fence. Area
po arily drawn around the entities you wa

area box are included in the ar
ities and groups partially enclosed or not enclosed
lud d in the area.  

ila  to an area but allowing more flexibility, fence selection uses a polygon with
6 sides, which is temp

ence polygon can be concave or convex and must be closed to 
pl te the selection process. 

r selecting the first point of the rubberband box. Using Cr
ntity that crosses t

within the box. Crossing w

elec ion set is a user-defined set of entities and/or groups. Selection sets 
e increased efficiency during 

ct entities or groups, or define areas or fences. A selection set m

defined. You can only edit active selection sets. 
selection sets wit
Selection Sets” in the “Editing Drawings” chapter for more information on using
selection sets. 

layer search on or off. 

In addition to the button in the Menu Window, a Layer Search Status Toggle is 
located in the Status Area of the DataCAD window. If the “L” on the toggle 
button is green, layer search is on; if it’s red, layer search is off. Click on the 

or off with a single mouse click. 

The green and red colors on the layer search toggle come from DataCAD’s 
ent 

” 

toggle button to turn LyrSrch on 

default screen color palette. If you change the palette DataCAD uses, differ
colors may be displayed. See “Customizing Colors” in the “Before You Draw
chapter for more information. 
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More About 3D Selection Menus 

The
Fen  
when all the end points of each displayed line segment and all displayed 
markers (such as center points for cylinders) lie within area or fence boundaries. 

, it’s possible to select some 3D entities 
by e l
your fe a 
slab an
is still c d 
point o sidered outside the fence 
and is then 

Selection by Area and Fence is independent of the current Z-base and Z-height 
settings. You can think of the region enclosed by the area or fence as going back 
into the screen infinitely. If you can see the region and it falls inside the 
boundary, the region is selected when you enclose it with an area or fence. 

The following list includes the portions of an entity that must lie within the 
boundaries of the area or fence to be selected: 

3D Lines  Entire line 
Polygons  End points of all displayed edges, including end points of void edges 
Blocks  End points of all edges which directly determine the shape of the block 
Slabs  End points of all displayed edges, including end points of void edges 
3D Arc  Entire arc 
Cylinder  Entire cylinder 
Symbol  The symbol reference point 
Cone  Entire cone 
Truncated Cone Entire truncated cone 
Sphere  Entire sphere 
Torus  Entire torus 

e surface and the control grid are ignored 
Surface of Rev. Entire surface of revolution 

Val
Some D
choose
Windo

Match o 

Add/Subtract 

Clear nd starts again (Clear does not, however, function 
like Undo); choosing Clear and then pressing (Enter) will accept a value of 0 

re currently 

 

You ious page, or type 
any
Messag

 3D selection menu options are identical, with a few exceptions for Area and 
ce. When using Area and Fence for 3D entities, most entities are selected 

When using 3D Fence selection, however
nc osing their end points but not enclosing other parts of these entities. If 

nce polygon is concave, for instance, you could enclose the end points of 
d still have the middle part of the slab lie outside the polygon. The entity 
onsidered in the fence if the end points lie within the fence. But if any en
f an entity lies outside the fence, the entity is con

not selected. 

Mesh Surface  Any control points; th

ue Menus 
ataCAD functions require you to enter a numerical value. When you 

 one of these functions from a menu, a list of values appears in the Menu 
w, followed by these options: 

Matches an existing value, entity, or angle; click on Match, then click on the entity t
match 
Adds or subtracts one or more values from a given value; click on the option and 

then the number to add or subtract 
Returns the given value to zero a

To Layer Puts an entity on more than one layer or on a different layer than you a
working on; available when you have more than one layer in the drawing 

 can select a value from the list, use the options on the prev
 value and press (Enter). The total is displayed in the prompt line in the 

e Area but is not entered until you press (Enter). 
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The decimal separator for all displayed dimensions and numbers is determined 

 
an 

atically calculate the 
value.  The online calculator supports pi; you can type pi in any equation. 

 

 
al (in degrees/minutes/seconds). 

The calculator can do the following kinds of operations: 

 =COS(35d) 0.9.27/32 (9 27/32”) 

 
hm 

Following are tw
igure sc

1. Click on 

. 

 prompt to “Enter new string for this scale.” Enter 1/32 for the 
menu button name. 

6. Respond to the prompt to “Enter new scaling value for this scale” by 
typing =(1/32)/12 and pressing (Enter) to get the result 0.002604167. 

7. Press (Enter) to accept this value as a new scale factor. 

by the value of the Windows Decimal Separator. To set this value, click on 
Control Panel in the Start/Settings menu on your Windows desktop. Double-
click on Regional Settings. On the Number tab, set the Decimal symbol value. 

DataCAD’s Online Calculator 

DataCAD’s online calculator is available anytime you need to enter a value, such
as a distance or angle. Any time DataCAD prompts you to enter a value, you c
simply type = and your equation, and DataCAD will autom

Distances must be entered in decimal units. The results, however, will be 
displayed according to the Scale Type setting. For instance, the default setting,
Architectural (Imperial) units, will display in feet/inches/fractions of inches. See 
“Customizing Settings” in the “Before You Draw” chapter for more information 
on the Scale Type and Angle Type options. 

The online calculator assumes angles are entered in radians, but you can enter an 
angle in degrees simply by typing d immediately after the value. Results for 
angle calculations will be displayed according to the Angle Type setting, with the
default being Norm

OPERATION  EXAMPLE CALCULATED VALUE 
Addition   =4.5+5  9.6 (9’-6”) 
Subtraction   =7-2.5  4.6 (4’-6”) 
Multiplication  =6*4.5  27.0 (27’) 
Division   =45/3  15.0 (15’) 
Parenthetical   =(4+3.5)*(8/2) 30.0 (30’) 
Square   =SQR(3)  9.0 (9’) 
Square Root   =SQRT(16) 4.0 (4’) 
Cosine  
Sine   =SIN(35d) 0.6.7/8 (6 7/8”) 
Tangent   =TAN(35d) 0.8.13/32 (8 13/32”) 
Arc Tangent  =ATAN(12,16) 0.6435 radians (36.87°) 
Natural Logarit =LN(9.3) 2.23      (Base 2.71828) 
 

o examples to illustrate how to use the online calculator to 
quickly f ales and angles. 

 To define a new plotting scale: 

EditDefs in the Settings menu. 

2. Click on Scales in the EditDefs menu

3. Click on Change to modify an existing scale. 

4. Select the scale to change from the menu. 

5. Look at the
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 To calculate an angle:  

1. Respond to the prompt to enter an angle by typing =ATAN(6,12), where 6 
is the rise and 12 is the run. 

2. Press (Enter) to calculate an angle of 26.33.54, or 26° 33’ 54”. 

Color Menus 
When an option requires you to assign a color, a list of colors is displayed in the 
Menu Window along with the options Custom, Match, and NoChange.  

 
Figure 2.21: A sample color menu 

Custom opens the Color Palette dialog box so you can change a color by 
adjusting its red, green, and blue (RGB) and hue, saturation, and brightness 
(HSB) values. To work properly, it requires a 256-color driver. 

Warning: When you make a change to a color menu, you must save this new color 
palette, or the colors will revert back to their original RGB values when you close 
DataCAD, even if you save the drawing. See “Customizing Colors” in the “Before Yo
Draw” chapter for more information on how to save palettes. 

u 

 To change the color of one or more entities in your drawing: 

1. Click on Custom in any color menu. The Color Palette dialog box 
appears. 
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Figure 2.22: The Color Palette dialog box 

2. Choose a color swatch, excluding the ones in the top row. (The top row 
contains the 15 standard colors DataCAD uses.) If you are satisfied wit
one of the colors in the dialog box, double-click on the swatch to activ

h 
ate 
t that color and dismiss the Color Palette. If you want a color that is no

shown on the Color Palette, continue to step 3. 

3. Click on Edit. The Color Picker dialog box appears. 

 
Figure 2.23: Color Picker dialog box 

4. Adjust the RGB and HSB values for the current color (shown in the Old
Color box) until you see the color you want in the New Color box. 
Alternatively, you can enter a new value for Red, Green, or Blue as well as 
for Hue, Saturation, or Brightness to adjust the color. You can cli

 

ck Cancel 

 

to close the Color Picker and Color Palette dialog boxes without saving 
your changes. Click OK to change the color. You return to the drawing 
where you are prompted to “Select entity to <CHANGE>.” 

5. Click on the entity whose color you want to change. DataCAD substitutes
the new color for the old one. 
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 To change the color of one entity to match that of another entity: 

Select the entity whose color you would like to change. You can select 
 

 Your Project 
Much of your work will be editing drawings under design development, and 

exible program in terms of allowing you to change what you 

ll spend making revisions. 

 
project and then  this idea into a drawing that is dimensionally 

rawing with p

This suggests th opposite 
t to know such things as 

drawing will be 
ccurate from t ze your floor plan, however, before you 

terials, you’ll have to go back and change 
to do automatic dimensioning or wall 

ections and de ess change would in turn impact the interior 
dimensions of rooms and may affect the modular grids of ceiling and floor tile, 

rt to draw can save 

ation 
pe ssible to predict the exact dimensions and 

aterials o ev e you finalize the design. A 
ealizable g al uch information as possible about the 
onstructio  o  begin the design development or 
onstructio  d oject. This keeps time-consuming 
hanges to  m and dimensioned 
ccurately.

You need to have as much information as possible on the following: 

hat information can be 

 
Sill and jamb conditions? Floor and ceiling heights? Joist sizes? 

re 

Exis an be used to create other drawings for this 
t? Which 

1. Click on Match in the color menu. 

2. Select the entity whose color you would like to match. 

3. 
multiple entities or groups without repeating steps 1 and 2. Click on
NoChange to exit the color menu without making a change. 

Planning

DataCAD is a fl
have drawn. Nevertheless, the more information you have when you first draw 
something, the less time you’

With traditional manual design development, you first do a rough sketch of the
 gradually refine

and materially specific. Computer-aided design (CAD), however, produces a 
recise dimensions the first timed  it is drawn. 

at the ideal process of CAD development might be the 
of manual design development. With CAD, it’s impor

 start to draw, so your 
tan

the exterior wall construction before you
a he beginning. If you finali
decide on exterior wall construction ma
the thickness of all exterior walls in order 
s tails. This wall thickn

lighting, etc. Some well-thought out planning before you sta
you valuable time. 

Gathering Project Inform
Practically s aking, it’s impo
m f erything in the building befor
r o , however, is to gather as m
c n f the building before you
c n ocuments phases of the pr
c  a inimum and allows the building to be drawn 
a  

Scope of Work How much do you need to draw? In what detail? W
reused for several drawings? 

Dimensions What are the basic dimensions of the structural grid, columns, and load-
bearing partitions? What size are the interior partitions? Doors and windows?

Materials What are the walls and foundation made of? What floor and roof systems a
you using? 

ting Elements Which parts of the drawing c
project? Which templates or typical details can be used for this projec
drawings from the schematic design phase can be reused? 
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Planning Layers 
The concept of layering drawings has been used in designing, drawing, and 
drafting long before computers. In the past it was referred to as overlay, or pin 

 
nd reproduce individually or in any combination. You could also use 

o overlay and quickly trace, 
nd rework drawings. This same procedure is easily accomplished using 

s. 

d use of the almost unlimited number 
elated entities, details, and text. 

 each layer according to type or 
, yo  can perform editing functions on one building component without 

re m n layeri r, it is important to devise a well 
ndards for the type of work you do. A 

nd probably should contain all 
in s f r a sin

ou dr wing o the drawings of others, what others in 
ice ea As you plan your drawing layers, 
not  of where e of the basic information needed for your 

articular task. There’s no need to redraw all those toilets for the third floor if 
u already have an 

down and make a list of all the 
t each layer will contain. 

CAD, you will find it helpful to have a 
reference list as you draw to help you prioritize and chart your drawing process. 

 chapter for more information on how to 

In DataCAD, you can toggle each layer you create on or off at any time; only 

con ay drafting, the active layer can be thought of as 
he 

ers toggled on. 
layers toggled off (not 

t general to the most specific is opposite the 
ion to prepare for drawing. You want to understand 

ible before you draw it. But once you start 

the

register, drafting. 

With overlay drafting, drawings were developed in layers on trace paper, each 
aligned with the others. Each sheet contained related information that you could
separate a
this layering of drawings during the design process, t
change, a
DataCAD, to form a highly productive drawing proces

The key to efficient CAD is the well-planne
of layers available in each drawing file to isolate r
By organizing the information displayed on
content u
affecting components on other layers. 

There a a y ng methods; howeve
thought out strategy based on office sta
drawing file with a good layer structure could a
the draw g o gle project.  

Just as y r a can contribute t
your off  have alr dy drawn can help you. 
make a e you can get som
p
they’ve already been drawn for the first floor, or if yo
appropriate toilet symbol on a plumbing template. 

Before you begin drawing, it is a good idea to sit 
layers you intend to create, noting what you expec
Although creating layers is easy with Data

See “Layers” in the “Before You Draw”
set up layers in DataCAD. 

layers toggled on will be displayed, and only one of these layers is active. To 
tinue our parallel with overl

the top piece of trace paper; it is the layer you’re currently drawing on. T
remaining layers of trace paper in the overlay stack are all the lay
Existing layers not currently in the stack are all the 
displayed). 

The process of drawing from the mos
process of gathering informat
the building in the greatest detail poss
drawing, you want to document all that information gradually, arriving at the 
most specific drawing (the detail) only after you have graphically described all 

 general conditions. 
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Figure 2.24: The image on the left is how your drawing is organized using layers. On the right 
is how you see your drawing in DataCAD. 

Prioritizing Drawing Tasks 
In addition to making a list of all your layers, make a flow chart of your drawin
process: what you will draw first, second, third, etc. In order to keep drawing
redundancy to a minimum, you will want to draw those parts of your drawing 
which are the most general first, then proceed to detail your drawing, gradually 
making it more specific. Along the way, m

g 
 

ake copies of those parts of your 
drawing that can be used for other drawings. 

A drawing will, of necessity
hav
DataCA
entities  
be add

Any entity
aut a
the orig
rooms,
using M

An
symbo mplate, then place 
tree l l the places in your 
drawing where you want the trees to appear. 

 and details can be drawn 
wn. 

just by choosing the Insul linetype and entering the two end points of the line. 

Da
draw without r ng or stretching entities, or changing 

Drawing Efficiently 
, contain many entities. The idea behind CAD is to 

e the computer automatically draw as many of those entities as possible. 
D incorporates several functions that make this automation possible; 

 may be copied or mirrored, for example, and symbols and linetypes may
ed as well. 

, group, or area in your drawing can be copied one or several times 
om tically or flipped and copied at once to produce a mirror image next to 

inal image. For example, you only need to draw one side of a corridor of 
 if you use Mirror to create the opposite side. For more information on 

irror, see “Mirroring Entities” in the “Other Ways to Draw” chapter. 

y entity, group, or area in your drawing can be stored in a template as a 
l. You can draw a tree once, save it as a symbol in a te

s a l over your site plan just by selecting with the mouse al

Many material symbols shown in sections
automatically by selecting the proper linetype, or by creating one of your o
DataCAD has linetypes for materials like insulation, brick, plywood, and roof 
shingles. You could produce, for example, a line of insulation running up a wall 

taCAD’s Edit menu provides you with many ways to modify anything you 
edrawing it, including movi

their attributes. 
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Use Stretch to select an area or point and move it to a new location, automatically 
stretching or shrinking everything attached to what you are moving. For 

a
e  on 

usi e “Stretching Entities” in the “Editing Drawings” chapter. 

 
you g connected to 
those items stays where it is. So if you have two cased openings, one of which 
contains a door, you can move the door to the other cased opening without 
moving all the wall and jamb lines attached to the door. For more information on 
using Move, see “Moving Entities” in the “Editing Drawings” chapter. 

Use Change to alter the characteristics or attributes of any entity, group, area, or 
selection set you’ve created. For example, you can change a wall from double-
weight solid lines to single-weight dashed lines, alter its height from 8 to 10 feet, 
change its color from green to blue, etc. For more information on using Change, 

hapter. 

ur DataCAD CD-

Fol ing l 
pro c

Description 

Material column grid, 25’ x 20’, lightweight 
steel floor and bar joists @ 2’-0” O.C. 

on, CMU block 
. 

 
Dimensions Plan: 100’ x 68’-8” exterior limits of building.  
Elev vel Floor @ 83.00’  
 
 
 
 
 

Sum a
PERSON
Job Capt

 
 

ex mple, you can move a window to a new place in the wall, and the wall will be 
str tched to match the new position of the window. For more information

ng Stretch, se

Move is different from Stretch in that only the entity, group, selection set, or area
 select is moved to a new location in the drawing; everythin

see “Changing Entities” in the “Editing Drawings” c

Sample Project 
This is an example of how to use DataCAD by outlining a detailed strategy for 
completing a project; it is not intended to be a tutorial or replace DataCAD 
training. The drawing files for this sample project are on yo
ROM. 

If you do a Typical installation, the files for this sample project will not be 
installed. To install them after doing a Typical installation, insert your DataCAD 
CD in your CD-ROM drive, select Custom installation, and then select Sample 
Drawings. 

Scope of Work 

low is a summary of what is known about the building for which you wil
du e working drawings: 

A 12,300 s.f. YMCA facilities building, two stories, flat roof, sloping site, with 
parking for 34 cars. 

s Structure: Clear-span metal frame with steel 

 Exterior Walls: Metal panel over metal framing with batt insulati
veneer wall with metal framing, batt insulation and GWB interior
Interior Walls: Metal studs with fire-rated GWB. 

 
ation Hgts Lower Le

Lower Level Ceiling @ 91.00’  
Upper Level Floor @ 95.00’  
Upper Level Ceiling @ 106.75’  
Top of Roof @ 107.00’ 
Top of Parapet @ 108.75’ 

m ry of Available Personnel and Drawings Needed  
NEL DRAWINGS 
ain  Site Plan 

Draftsman 1  Foundation Plan 
Draftsman 2  Lower Level Plan 

 Upper Level Plan 
 Four Exterior Elevations 
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 th Building Section 
  Lower Level Electrical Plan 
 
 Lower Level Plumbing Plan 
  Upper Level Plumbing Plan 
 
 

Planning th ime 

1. 

2. Draftsman 1 develops base plans while Draftsman 2 begins work on typical 

3. 2 begins 

4.  elevations, and sections have been developed, develop 
ls on both workstations using completed drawings as a 

5. Wh s into 

How Draftsman 1 Drew the First Floor Plan 

e with the Job Captain, learning what the project 

Upper Level Columns 
Upper Level Dimensions 
Upper Level Doors 

D undation 
H 

el Lavatories 

2-NOT   Upper Level Notes 

: 

ing layers listed above. 

 from template file. 

 North/Sou

 Upper Level Electrical Plan 
 

 Door, window, and Finish Schedules 
 Door and Window Types 

e Drawing T

Summarize drawings needed; plan final sheet layout. 

details. 

Draftsman 1 gives Draftsman 2 the plan information. Draftsman 
developing elevations and sections. 

When plans,
schedules and detai
base for detail drawings. 

en all drawings have been completed, assemble individual drawing
“sheets” for plotting. 

Draftsman 1 first spent some tim
involved and the assigned tasks. Then Draftsman 1 sat down and prepared two 
outlines: 

• an outline of the layers required and their names 

• a strategy of what to draw first, second, third, etc. 

LAYER NAME  DESCRIPTION 
A2-BLK   Lower Level Conc. Block 
A2-COL   
A2-DIM   
A2-DRS   
A2-   Upper LFN evel Fo
A2-HC   Upper Level Hatch 
A2-LA   UppeV r Lev
A2-LBL   Upper Level Labels 
A
A2-ROM   Upper Level Room Numbers 
A2-STR   Upper Level Stair 
A2-TIL   Upper Level Tile 
A2-TXT   Upper Level Text 
A2-WIN   Upper Level Windows 
A2-WLS   Upper Level Walls 
 

Draftsman 1’s drawing process outline is as follows

1. Create drawing file YMC-MSR1.DC5. 

2. Create and name draw

3. Load sheet border

4. Input all existing site information. 
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5. Draw Columns, Column Grid, Perimeter, and building elements on 

ard 

first floor plan drawing layers from layer files. 

11. 

12. Sav
wil

13. Pla

14. 

15. 

16. Dra

17. Ad

18. 
ELV

Notice that Draftsman 1’s outlines do not detail how to best draw each part of 
trategy simply gives an outline of what to do next while 

 
aces that are larger than the other parking spaces. 

Basic Drawing and Editing 

that in the 
draw with 

l li
with DataC

Drawing Using the Mouse 

 To draw

1. Mo
sele cking 
to s nt on another 
entity and begin drawing from there. See “Object Snapping” in the 
“Drawing Tools” chapter for more information. 

appropriate layers. 

6. Separate drawing layers needed for first floor by saving them out to the h
disk on separate layer files. 

7. Create a detailed elevation drawing called YMC-ELV1.DC5. 

8. Create and name the required drawing layers. 

9. Load basic 

10. Draw interior partitions. 

Place windows in perimeter wall. 

e modified plan layers to a layer file called YMC-PLN1.LYR. This layer 
l become the exterior wall for the second and third floors, which have 

identical windows to the first floor. 

ce doors and windows in perimeter wall and in interior partition walls. 

Zoom in on lobby area and draw lobby details. 

Zoom in on restroom area and draw fixture layout and details. 

w reflected ceiling plan. 

d dimensions, labels, and notes to drawing. 

Create a new detail elevation file for the Second Floor Plan called YMC-
2.DC5.  

the drawing. This s
leaving Draftsman 1 free to choose the best drawing method for each part of the 
drawing. Copy, Mirror, and Stretch will be used to produce, respectively, the 
column grid, two halves of a symmetrical parking layout, and two handicapped
parking sp

DataCAD is ready to draw lines immediately upon opening a drawing; notice 
Create pull-down menu, Line is checked by default. You can even 
custom linetypes to represent such things as insulation, telephone and 

electrica nes, and siding. And editing lines, or anything else you draw, is easy 
AD’s many editing features. 

 a line by selecting two points: 

ve the cursor anywhere in the Drawing Area and click. You’ve just 
cted the first end point of your first line. In addition to simply cli
elect a point and begin drawing, you can snap to a poi
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2. Move the cursor to the point where you want the line to end and click. 

e 

e 

u indicate the direction with the mouse 
and then enter a distance relative to the last point entered. 

The line is drawn. Notice, however, that if you move your cursor, it is still 
connected to the end of the line. This allows you to continue drawing 
lines, using the end of the previous line as the beginning of the next line. 

3. Repeat step 2 to continue drawing lines until your last end point meets 
the first end point you selected in step 1. 

4. Right-click to disconnect the cursor from the last line. 

Drawing Using Coordinate Entry 
Coordinate entry lets you draw lines more precisely by entering the exact 
coordinates of each end point of a line. In DataCAD, you have a choice of five 
coordinate entry methods, or input modes: 

• Relative polar requires that you enter a distance and an angle relative to the 
last point entered. 

• Absolute polar requires that you enter a distance and an angle from absolut
0. 

• Relative Cartesian requires that you enter an X and Y distance relative to th
last point entered. 

• Absolute Cartesian requires that you enter an X and Y distance from 
absolute 0. 

• Distance-Direction requires that yo

  
.25: Polar and Cartesian coordinate entry methods Figure 2

Once you select a coordinate entry method, it remains active until you choose a 
diff e using is always 
dis ate display. (Coordinates are 
onl i

Four ad
3DView le, 
and Z c istance, plan angle, 
and ris nt 
of coordinate entry, which may be helpful in specialized modeling applications 
like

erent entry method. The coordinate entry method you’r
played in the Message Area beside the coordin
y d splayed when your cursor is in the Drawing Area.) 

ditional coordinate entry methods are available only while in the 
s/Controls menu: relative and absolute cylindrical (enter distance, ang
oordinate) and relative and absolute spherical (enter d

e angle). These methods provide additional variables to the Z compone

 entering a 3D line that represents a solar angle. 
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• ert) until the name of the method you want appears in the 

• 
coo

 To w

1. Cli

2. Press . 

3. Typ int you entered in 

ct 

r absolute Cartesian coordinate entry: 

press 
 attached to the end point 

ct 

 d

1. 

2. n the direction you want to draw the line. 

4. 
 to the end point of the line.  

m the line 

To choose a coordinate entry method, either: 

press (Ins
Message Area at the bottom of the DataCAD window, or 

click on Input Mode in the Tools pull-down menu and select a 
rdinate entry method from the list. 

dra  a line using relative or absolute polar coordinate entry: 

ck in the Drawing Area to select the line’s first end point. 

(Spacebar)

e the length of the line (the distance from the end po
step 1 to the next end point) and press (Enter). 

4. Type the angle of the line from the X axis and press (Enter). The line is 
drawn, with your cursor still attached to the end point of the line. 

5. Continue drawing lines by repeating steps 2-4. Right-click to disconne
the cursor from the line. 

 To draw a line using relative o

1. Click in the Drawing Area to select the line’s first end point. 

2. Press (Spacebar). 

3. Type the relative or absolute X distance from the first end point and press 
(Enter). 

4. Type the relative or absolute Y distance from the first end point and 
(Enter). The line is drawn, with your cursor still
of the line. 

5. Continue drawing lines by repeating steps 2-4. Right-click to disconne
the cursor from the line. 

To raw a line using direction-distance coordinate entry: 

Click in the Drawing Area to select the line’s first end point. 

Drag the cursor i

3. Press (Spacebar). 

Type the length you want the line to be, and press (Enter). The line is 
drawn, with your cursor still attached

5. Continue drawing lines by repeating steps 2-4. Right-click to disconnect 
the cursor fro
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More A u

You can en e 
menu. See n this chapter for more information on how to 
use the  D
differen
Types” in t in 
the archite
distances a

TO ENTER: 
4’ 
6” 
3/16” 
4’-6” 
4’-6 3/16” 
 

Notice t  
and 3/16 o  
distances, ers; so you could 

Dr
Da m linetypes. You cannot 
redefine the and dot-dash -- 
alth g

lines 
User-

Defined Linetypes” in the Appendix for a list of available custom linetypes and 

weight, color, size, factor, or overshoot. 

2. Look at a preview of a linetype before you use it by moving the mouse 
cursor over the linetype option in the Menu Window. Click on ScrlFwrd 
and ScrlBack to scroll forward and backward through the list of linetypes. 

3. Click on a linetype in the Menu Window to use that linetype. 

bo t Coordinate Entry 

ter distances and angles either by typing a value or by using a valu
 “Value Menus” earlier i

m. epending on the scale type you are using, there may be several 
t methods you can use to enter coordinates. See “Setting Scale and Angle 

he “Before You Draw” chapter for more information. For instance, 
ctural scale type, which is DataCAD’s default, you must enter 
s feet.inches.fractions of inches. 

TYPE: 
4 
0.6 or .6 or (Spacebar)6 
0.0.3/16 or ..3/16 or ..3.16 or (Spacebar)(Spacebar)3(Spacebar)16 
4.6 or 4(Spacebar)6 
4.6.3/16 or 4.6.3.16 or 4(Spacebar)6(Spacebar)3(Spacebar)16 

in his example that 3/16” is entered as 0.0.3/16, indicating 0 feet, 0 inches,
f an inch. Notice also that you can leave out the zeros when you enter

as long as the decimal points remain as placehold
type ..3/16. Further, slashes, decimal points, and spaces are interchangeable, so 
you could, for instance, replace the slash with another decimal point and type 
..3.16. 

Angles are entered in a similar fashion, except the (Spacebar) method can’t be 
used. For instance, using relative polar coordinate entry, angles are entered as: 
degrees.minutes.seconds 

TO ENTER: TYPE: 
38° 38 
12’ 0.12 or .12  
30” 0.0.30 or ..30 
38°-12’-30” 38.12.30 

awing with Linetypes 
taCAD has four standard linetypes and 21 custo

four standard linetypes -- solid, dashed, dotted 
ou h you can change some of their attributes. You can, however, create your 

own linetypes, adding up to 175 custom linetypes such as special symbolic 
for site plan utilities, center lines, and highlighted lines for review. See “

their settings. 

 To draw a line using a linetype: 

1. Go to the Edit menu in the Menu Window; click on LineType. A list of 
available linetypes is displayed in the Menu Window, along with options 
to modify a chosen linetype’s 
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4. Click on the Factor, Spacing, LineWgt, Color, or OverSht options to 
change the settings for the linetype you chose. See “Linetype Settings” 
below for details on changing linetype settings. 

5. Begin drawing lines as described in “Drawing Lines By Selecting Two 
Points” or “Drawing Lines Using Coordinate Entry” earlier in this 
section. 

Linetype Settings 

All custom linetypes enter building materials at actual size, and they appear at 
the display scale you specify. You can use the following options to customize a 
linetype: 

Factor Toggle that lets you quickly switch between using the default spacing factor (Factor 
toggled off) and the spacing factor set by the Spacing option described below (Factor 
toggled on). 

Spacing Changes the size of the linetype pattern. Keep in mind that DataCAD defines units in 
absolute world coordinates. For example, to set dashed lines to repeat every 1” on a 
1/4”=1’-0” scale drawing, set the spacing to 4’-0”. To set line spacing, click on a value 
in the value menu or type a spacing value, and press (Enter). 

LineWgt Sets the thickness of a linetype. The most common line thickness is 1. To set the line 
weight, click on a line weight in the value menu or type a line weight value, and press 
(Enter). For line weights to display, ShowWgt must be toggled on in the Display menu. 

Color Changes the color of a linetype. Any new lines that you enter into the drawing appear 
in the new color.  

ctions, giving drawings an architectural 
ctual length of a line, ignoring any 

displayed overshoot. To set the overshoot, click on OverSht, and then choose or type 
ust 

rovides easy access to most editing functions, 
Copy, Rotate, Mirror, Stretch, 

e, Line Cleanup, and Wall Cleanup. Choose 
any e 
“Ed

The Edit pull-down menu also includes 
and t
drawin
Redo o n action, click on Undo in the Edit 
pul
pull-do r; 
click on .  

OverSht Displays extensions, or punch, at line interse
look. DataCAD always dimensions to the a

an overshoot distance and press (Enter). For line overshoots to display, OverSht m
be toggled on in the Display menu. You can change the overshoot distance for 
existing lines with the OverSht option in the Edit/Change menu. 

Basic Editing Tools 
DataCAD’s Edit pull-down menu p
including primary editing menus such as Move, 
Enlarge, Erase, Change, Partial Eras

 of these editing options to display that menu in the Menu Window. See th
iting Drawings” chapter for details on these options. 

unlimited, global undo/redo options 
 cu , copy, and paste. The Undo option reverses the last action, including any 

g or editing, changes made using macros, or the deletion of layers. The 
ption restores the last action.  To undo a

l-down menu or press (Ctrl) + (Z); to redo an action, click on Redo in the Edit 
wn menu or press (Ctrl) + (Y). You can also use the Undo/Redo toolba
 Undo/Redo Toolbar in the View pull-down menu to display the toolbar
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Cut, Copy, Paste, and Paste Special are four more Edit pull-down menu options 
t 

he 

c.) 
ds them to the active drawing. 

To cut or copy DataCAD entities, you must first use the Clipboard Select option 
 select the entities to be cut or copied. You can 

cho ine 
we
Prefere

 To m

1. ll-down menu. A selection menu 

you can use to edit drawings or share parts of drawings between documents. Cu
removes entities from the drawing to the clipboard, Copy copies entities in t
drawing to the clipboard, Paste adds entities previously cut or copied to the 
active drawing, and Paste Special lets you choose the format (metafile, text, et
for entities previously cut or copied and then ad

in the Edit pull-down menu to
ose whether to copy just the entity or the entity with its current color and l

ight. Check the Copy to Clipboard options on the Misc tab of the Program 
nces dialog box as appropriate. 

ove or copy entities from one drawing to another: 

Click on Clipboard Select in the Edit pu
is displayed in the Menu Window. See “Selection Menus” in this chapter 
for more information.  

Shortcut: Press (Ctrl) + (E) to access the Clipboard Select selection menu. 

2. n to enter an insertion point for the entities. This point 

elative to absolute zero. 

was toggled 
rompted to “Select reference point for clipboard 
was toggled off, skip to step 7. 

 to cut entities, or press (Ctrl) + (C) to copy entities. 

Toggle InsPoint o
can then be used to paste the entities into another drawing. Toggle 
InsPoint off to enter entities r

3. Choose a selection method by clicking on one of the selection menu 
options. 

4. Select the entities to be moved or copied. 

5. Click on Cut in the Edit pull-down menu to remove the entities from the 
drawing, or click on Copy to simply copy them. If InsPoint 
on in step 2, you are p
cut/copy”. If InsPoint 

Shortcut: Press (Ctrl) + (X)

6. Click in the Drawing Area to select a reference point. Your cursor will b
attached to this reference point when you paste the entities into another 
drawing. 

e 

Shortcut: Press (Ctrl) + (V) to paste entities. 

7.  DataCAD drawing or into a document in another 

to and click on Paste 
ities 

nts; toggle it off to paste the entities by their 

the drawing you’d like to add the entities to, click on Paste 

t that you’d like to add 
entities to and use that application’s paste function. 

Paste them into another
application: 

• Open the drawing you’d like to add the entities 
in the Edit pull-down menu. Toggle ByCenter on to paste the ent
by the center of their exte
insertion point (if InsPoint was toggle on) or at absolute zero. 

• Open 
Special in the Edit pull-down menu, and select a format for the 
entities. 

• Open the Windows application documen
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You can preserve the exact position of an entity (as measured from absolute zero) 

=16’, y=16’ (as measured from absolute zero) in the original file, then 
pasting it into a new file using AbsZero will place the marker at x=16’, y=16’ 

w file. 

Referencing Drawings 
You n  
current
your cu
current dra ur current drawing, 
allo  
moved larged just as any other entities can be, and 
refe

 To i

1. 

2. 

, attached to your cursor. The InsXREF menu is displayed in the 

3. 

 and 

5.  
ggle 

rt the referenced drawing relative to absolute zero, click 

your current drawing.  

enced drawing by its center, toggle ByCenter on in 
. Move the cursor to position the referenced 

drawing and click to insert it. If you toggled DynamRot on in the 

 into place and click to insert it. 

 toggled DynamRot on in the 

 into place and click to insert it. 

when copying it from one drawing to another. For example, if a marker was 
placed at x

from absolute zero in the ne

 ca  reference, or link, an unlimited number of DataCAD drawings to your
 drawing. These referenced drawings, also called XREFs, are displayed in 
rrent drawing and will even print as though they were part of your 

wing; however, they are not actually added to yo
wing you to keep file size as small as possible. Reference file geometry can be

, copied, mirrored, or en
rence files can be rotated into any plane in space. 

nsert a reference file: 

Click on Reference File in the Insert pull-down menu. A dialog box is 
displayed, prompting you to “Enter name of reference file to insert”. 

Select a drawing from the list box and click on Open. The dialog box 
closes and a box representing the extents of the referenced drawing is 
displayed
Menu Window. 

Enlarge the referenced drawing before inserting it by clicking on Enlarge 
in the InsXREF menu. A value menu is displayed and you are prompted 
to “Enter XREF enlargement factor.” 

4. Use the value menu to enter the enlargement factor you want to use
press (Enter).  

Decide if you’d like to dynamically rotate the reference file geometry into
place when you insert it into your drawing. If you want to do this, to
DynamRot on. The DynamRot option has no effect if you use AbsZero to 
place the reference file geometry. 

6. Select one of these ways to insert the reference file: 

• To inse
AbsZero in the Menu Window. The referenced file is inserted into 

• To place the refer
the Menu Window

previous step, you are prompted to “Position XREF on drawing”. 
Rotate the geometry

• If the ByCenter toggle is off, your cursor is attached to absolute zero 
in the referenced file. Move the cursor to position the referenced 
drawing and click to insert it. If you
previous step, you are prompted to “Position XREF on drawing”. 
Rotate the geometry
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• To use the active clip cube(s) in the referenced file, toggle on UseCl
You are prom

ip. 
pted to “Position XREF on drawing.” DataCAD inserts 

You can o select the point to position the reference file 
geo t

Self-ref REFs are supported. You can place an XREF for drawing A into 
 

Referenced files may have unique clipping boundaries. You can have multiple 
sly. You can also enter text and 

1. Select Reference File Management from the Insert pull-down menu. 

nu. 

For o
Sel

Ref
You can use the Reference File Manager to manage reference files in your current 
dra -down 
menu,  reload reference files, resolve orphaned reference files, 
or o n

the active clip cube(s) into the current drawing. 

 also use coordinate entry t
me ry. See “Using Coordinate Entry” in this chapter for more information. 

erencing X
drawing A. “Circular” XREFs are no problem since endless-loop swap files are
not created. Self-referencing XREFs are automatically redefined to reflect the new 
drawing filename when you use the Save As function.  

Clip Cube definitions active simultaneou
dimensions outside of the XREF Clip Cube. 

 To use XREFs with unique clipping boundaries: 

2. Select Clip Cube from the extended me

3. Choose the XREF for which you want to define a new Clip Cube. 

 inf rmation about using clip cubes from referenced files, see “Viewing 
ected Entities in Your Model” in the “Viewing Your Model” chapter. 

erence File Manager 

wing. When you click on Reference File Management in the Insert pull
you can refresh or

pe  the Reference File Manager.  
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Figure 2.26: The Reference File Manager dialog box 

You can also redefine loaded reference file names within the Reference File 
Manager by clicking on the Redefine button. This allows you to redefine XREF 
files that were renamed. Redefined XREFs retain the previous XREF’s position, 
scale, and rotation. 

Displaying Reference File Layers 

 To display only selected layers: 

1. Click on Reference File Management in the Insert pull-down menu. A 

 

 the list to select it. If necessary, you can use the 
ference file names that extend beyond the 
ers in the reference file are listed in the Layer 

n the reference 

5. he changes you’ve specified. The checked layers 

6. e 

submenu is displayed. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box is displayed. All the reference files in your current drawing are listed
in the Reference Files Loaded list box. 

3. Click on a reference file in
horizontal scroll bar for re
dialog window. All the lay
Control list box, with a checkmark next to the ones that are on 
(displayed). 

4. Click on the checkboxes next to the layers to turn layers i
file on or off. 

Click on Apply to apply t
are displayed, and the unchecked layers are not displayed. 

Click on OK to close the Reference File Manager dialog box when you’r
finished. 
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Refresh

You can ill incorporate any changes 
you’ve
update ou made to 
the reference file geometry as well as the reference file’s layer status, such as 

re off. 

 r

2. 

ed list box. 

3. 

arked for 

d 
e refreshed. 

 

Double  for Reload, 
Ma d  list 
and

 To r

1. 
yed. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
nce files in your current drawing are listed 

in the Reference Files Loaded list box. 

 Press (Ctrl) or (Shift) and click 

 

u’re 

Double-clicking on a file listed in the Marked for Refresh, Marked for Reload, 
ed for Delete list boxes will remove the file from the list 

ing and Reloading Reference Files 

 refresh and reload reference files. Refresh w
 made to the reference file, such as editing the drawing, but will not 
 any changes to layer status. Reload will update any changes y

which layers are toggled on and which a

To efresh reference files: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu is displayed. 

Click on Manager in the submenu. The Reference File Manager dialog 
box is displayed. All the reference files in your current drawing are listed 
in the Reference Files Load

Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and click 
to select multiple files. 

4. Click on Refresh. The reference file name is copied into the M
Refresh list box.  

5. Click on Apply to apply the changes you’ve specified. The selecte
reference files ar

7. Click on OK to close the Reference File Manager dialog box when you’re
finished. 

-clicking on a file listed in the Marked for Refresh, Marked
rke  for Bind, or Marked for Delete list boxes will remove the file from the
 return it to the Reference Files Loaded list box. 

eload reference files:  

Click on Reference File Management in the Insert pull-down menu. A 
submenu is displa

box is displayed. All the refere

3. Click on a reference file in the list to select it.
to select multiple files. 

4. Click on Reload. The reference file name is copied into the Marked for
Reload list box. 

5. Click on Apply to apply the changes you’ve specified. The selected 
reference files are reloaded. 

6. Click on OK to close the Reference File Manager dialog box when yo
finished. 

Marked for Bind, or Mark
and return it to the Reference Files Loaded list box. 
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Binding Reference Files 

Fs and nested XREFs both bind, based on the On or All toXRE ggle in the XREF 

 

ence Files Loaded list box. 

k 

4. Look beside the Bind button where there are two small toggles: All and 
yers in the reference file to the current 

se 
rol list 

d 

Manager. 

 To bind reference files: 

1. Click on Reference File Management in the Insert pull-down menu. A 
submenu is displayed. 

2. Click on Manager in the submenu. The Reference File Manager dialog
box is displayed. All the reference files in your current drawing are listed 
in the Refer

3. Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and clic
to select multiple files. 

On. Click on All to bind all la
drawing, regardless of whether they’re on or not. Click on On to bind 
only the layers in the reference file that are on (displayed). Before you u
the On toggle to bind layers of the reference file, use the Layer Cont
box to check those layers you want toggled on. 

5. Click on Bind. The reference file name is copied into the Marked for Bin
list box. 

Warning: The drawing file size may increase substantially when you bind 
referenced files. Binding too many files may cause the drawing file size to exceed
the 128MB limit. DataCAD cannot provide a warning when this occurs. Check the
Directory (available from the Tools pull-down menu) to monito

 
 

r the current 
drawing file size. 

6. Click on Apply to apply the changes you’ve specified. The selected 
reference files are bound, and their geometry is copied into the current 
drawing. Once a reference file is bound to the current drawing, it ceases 

 

e 

. 

 A 

 are listed 

 

to be a reference file. So, if you choose to bind only a few layers of a 
reference file, the entire reference file  -- even those layers you didn’t bind
-- is no longer linked to your current drawing. 

6. Click on OK to close the Reference File Manager dialog box when you’r
finished. 

Highlighting is lost when an XREF is bound because it is no longer an XREF

Deleting Reference Files 

 To delete reference files: 

1. Click on Reference File Management in the Insert pull-down menu.
submenu is displayed. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box is displayed. All the reference files in your current drawing
in the Reference Files Loaded list box. 

3. Click on a reference file in the list to select it. Press (Ctrl) or (Shift) and click
to select multiple files. 
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4. Click on Delete. The reference file name is copied into the Marked for
Delete list box. 

 

e changes you’ve specified. The selected 

 

Double
Ma d, o  
and r

Hig

You can le 
geomet  an XREF is bound because it is no longer an 

l-down menu. A 

ect 

-

s 

. 

8. x. 

Res i

Refer n
computer or if you delete the r You can resolve the broken link 

nk 

en 
e, 

 reference file is limited to 160 
characters. This allows you to use the full pathname that includes Drive + Path + 
File

5. Click on Apply to apply th
reference files are deleted. 

7. Click on OK to close the Reference File Manager dialog box when you’re
finished. 

-clicking on a file listed in the Marked for Refresh, Marked for Reload, 
rked for Bin r Marked for Delete list boxes will remove the file from the list

eturn it to the Reference Files Loaded list box. 

hlighting Reference File Geometry 

 use color, linetype, or a combination of the two to highlight reference fi
ry. Highlighting is lost when

XREF. 

 To highlight entities from a reference file: 

1. Click on Reference File Management in the Insert pul
submenu is displayed. 

2. Click on Manager in the submenu. The Reference File Manager dialog 
box is displayed.  

3. Click on the reference file in the Reference Files Loaded list box to sel
the reference file you want to highlight. 

4. Click on the On/Off checkbox in the Highlighting section to turn 
highlighting on. 

5. Choose a highlighting color and linetype/line spacing from the drop
down boxes. 

6. Click on Apply to apply the changes you’ve specified. The highlighting i
applied to the geometry for that reference file. 

7. Repeat steps 3 – 6 to highlight the geometry from other reference files

Click on OK to close the Reference File Manager dialog bo

olv ng Orphaned Reference Files 

e ce files can be orphaned if you move the file to another folder on your 
eferenced file. 

between your current drawing and the referenced file by either deleting the li
or by redefining the path to where you moved the reference file. Clicking on the 
Redefine button allows you to redefine XREF files that became orphaned wh
they were renamed. Redefined XREFs retain the previous XREF’s position, scal
and rotation. 

The path between the current drawing and the

name. 
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1. 
ayed. 

iles in your current 

3. Click on a reference file in the list to select it. 

rent 

es. Click on Done to close the Orphaned Reference 

 way you look at your drawing when you work on it. 

usly 
decide what you want to focus on and to what degree. To say this in CAD terms, 

ntire drawing, you will zoom out to the extents, 

Go-to-views, hyperview linking, and multi-view windows are three additional 

e

The WindowIn menu in DataCAD lets you zoom in on an area by displaying the 
ur 

o see more of your drawing. The 
in the Utility/ 

u, or click on the W in the 

bove and to the left of the area you want to scale. 

 

tically. 

Shortcuts: Press (/) to display the WindowIn menu in the Menu Window.  

To resolve orphaned reference files: 

Click on Reference File Management in the Insert pull-down menu. A 
submenu is displ

2. Click on Orphans in the submenu. The Orphaned Reference Files dialog 
box is displayed, listing all the orphaned reference f
drawing. 

4. Resolve the orphaned file in one of these two ways: 

• Click on Delete to delete the reference file from your current drawing. 

• Click on Redefine Path to reestablish the link between your cur
drawing and the reference file. A dialog box is displayed, allowing 
you to browse for the file; find the referenced file and click on OK. 
The dialog box clos
Files dialog box.  

Viewing Drawings 
Viewing is simply the
Compare viewing a drawing on the computer with looking at a drawing on your 
drafting board. As you draft on the board, your eyes are always moving and 
refocusing, allowing you to concentrate on small details or view the entire 
drawing sheet quickly and easily. At the computer, you need to conscio

you will zoom in on an area of your drawing when you have to focus on a detail; 
and when you want to see the e
or outermost edges of the drawing. 

viewing features that allow you to jump quickly to preset views of your drawing. 
Se  the “Viewing Your Model” chapter. 

Zooming In and Out 

drawing in a larger scale. When you zoom out, you are actually looking at yo
drawing in a smaller scale, which allows you t
scales that the WindowIn menu uses are predefined 
Settings/EditDefs/Scales menu. 

 To zoom in on your drawing: 

1. Click on WindowIn in the 
ection Pad.  

Utility men
Proj

2. Click a

3. Move the mouse down and to the right to stretch the box around the area
you want to zoom in on. 

4. Click to complete the box. The drawing rescales automa
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To return to the previous view (essentially undoing the  zoom), press (P). 
DataCAD remembers up to 25 previous views.  

Press (PgUp) and (PgDn) to quickly zoom in and out on your drawing. To use Pg
and PgDn on your numeric keypad, make sure NumLock is off first. 

Up 

 To zoom to your drawing’s extents: 

1. Click on WindowIn in the Utility menu, or click on the W in the 
Projection Pad. 

2. Click on Extents in the WindowIn menu. Your drawing is displayed at the 
. If 
tead 

 of 

ts; 

largest scale possible while still displaying the drawing in its entirety
you’ve made significant changes to your drawing, click on Recalc ins
of Extents. DataCAD will review your drawing and update the extents
the drawing accordingly. 

Shortcut: Click on the E in the Projection Pad to view the drawing at its exten
click on R to recalculate the extents. 

 To zoom in on your drawing and display the area to its extents: 

1. Click on WindowIn in the Utility menu, or click on the W in the 

onstandard 
display scale. When it is toddled off, DataCAD can only use the 

 box around this area. The area 

Projection Pad. 

2. Toggle FreeZoom on or off in the WindowIn menu, depending on your 
preference. When it is toggled on, DataCAD can show a n

predefined display scales from the Utility\ToScale menu. 

3. Click at one corner of the area you want to zoom in on and move the 
mouse diagonally to stretch a rubberband
is displayed at its extents. 

Shortcut: Press (Home) to center your drawing at the current cursor position in 
the Drawing Area.  

 
Figure 2.27: Zooming in on your drawing. 
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Ch g
In addi s 
to scro
drawin
look up
scroll d
arrow k Settings menu. See 
“Se
information on setting

Sa
It is en you walk 
awa
ways to

• Pre
to q

• Cli

Shortcu s (Ctrl)+(S) to save your drawing. 

an ing Your View Using the Keyboard 
tion to zooming in and out on your drawing, you can use the arrow key

ll, or pan, in different directions around the screen. Your view of your 
g changes each time you press an arrow key. Pressing the up arrow key lets you 
 towards the top of your drawing by moving the drawing down. The 

istance, or the distance that the drawing moves each time you press an 
ey, is defined using the ScrlDist option in the Utility/

tting the Panning Distance” in the “Before You Draw” chapter for more 
 the scroll distance. 

ving Drawings 
 a good idea to save your drawing periodically, especially wh
y from the computer or when you’ve made several changes. There are four 

 save your drawing in DataCAD. 

ss (Shift) + (F) (if Caps Lock is on, just press (F)). This shortcut is a great way 
uickly save your drawing with minimal interruption. 

ck on Save in the File pull-down menu.  

t: Pres

•  under a 
e. 

• 

Warning: If you close your drawing without saving it, any changes you’ve made since 

Click on Save As in the File pull-down menu to save your changes
different drawing filenam

Click on Save All in the File pull-down menu to save changes to all open 
drawings. 

you t saved, all 
refe c

 las  saved it will be lost. If it’s a new drawing that has not yet been 
ren es to the drawing in DataCAD will be erased. 

More A

At regu s you’ve made to 
you autosave 
file exists only until you 

essage “Automatic save in progress” in 
the user prompt line in the Message Area. See “Automatically Saving Your 
Dra mation on how to set the 
aut a

The autosave file is located in your DATACAD\TEMP\ folder and has the same 
name as your drawing file but with an .ASV extension; so if your drawing file is 
named HOUSE.DC5, your autosave file will be HOUSE.ASV.  

An autosave file is different from a backup (.BAK) file in that it is a temporary file 
that exists only during your work session in DataCAD. If you save your drawing 
or close DataCAD, the autosave file is DELETED. It does not overwrite or update 
your drawing or backup files in any way. 

bout Recovering Lost Work 

lar intervals, DataCAD automatically saves the change
r drawing to a temporary file, called an autosave (.ASV) file. The 

save the drawing. When DataCAD updates your 
drawing’s autosave file, you’ll see the m

wing” in the “Before You Draw” chapter for infor
om tic save interval.  
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If you experience a power interruption caused by an electrical failure, hardware 
problem, or other error, any changes you made to your drawing since you last 
saved it are lost. Fortunately, the temporary autosave file is not disturbed, and 
you can recover your drawing to the point of the last autosave. There is also a 
.SWP file that is a copy of the drawing you’re working on. If you exit DataCAD 
abnormally, you can simply rename the .SWP file with a .DC5 extension to 
recover your work. 

Warning: Keep in mind that SWP files can be corrupt or invalid. You should use them 
only if the ASV or BAK file is either not available or is corrupt as well. If an ASV file exists, 
it should be your first choice for recovering a file. 

It’s always a good idea to rename your old drawing file to so
HOUSE.OLD before renaming the autos

mething like 
ave file. That way you keep a copy of the 

orig

 To r ur drawing since you last saved it: 

d open your drawing (.DC5) file. The message “File 

 message “An autosave (.ASV) file for this drawing 

e. 

 of the 

ck on the new file and click on Open. Your drawing 

A swap (.SWP) file is also created when you’re working on a drawing. If you 
have a power interruption, for example, the swap file remains in the 
DATACAD\ TEMP folder and can also be renamed to recover your work. 

 To recover drawing changes without starting DataCAD: 

1. Do not start DataCAD again. Instead, in Windows Explorer, change to the 
folder, \DATACAD\TEMP\. 

2. Click on the autosave file to highlight it; you do not need to open it. 

3. Click on Rename in the File menu in Windows Explorer. 

4. Type a new name for the file, changing the extension to .DC5. So if your 
autosave file is named HOUSE.ASV, rename it to HOUSE.DC5. 

inal drawing file but have your newly renamed autosave file to work on. 

ecover changes made to yo

1. Start DataCAD an
[drawing name] is already marked in use. Continuing with this file will 
result in data loss. Are you sure you wish to continue?” is displayed. 

2. Click on Yes. The
exists. Are you sure you want to continue?” is displayed. 

3. Click on Yes to continue. 

4. Click on Yes to rename the autosave file. 

5. Type a new name for the autosave file and press (Enter). This name must 
be different from the name of the original drawing. Consider naming this 
file with a generation letter or number: DRAWING1.DC5, for instanc

6. Press (Enter) to confirm the new filename. You now have two copies
drawing; the new file is the most current. 

8. Notice that the new filename is displayed in the Enter Drawing File to 
Edit dialog box. Cli
opens in the Drawing Area. 
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 To open your drawing without recovering changes in the autosave file: 

1. Start DataCAD and open your drawing (.DC5) file. The message “File 
[drawing name] is already marked in use. Continuing with this file will 
result in data loss. Are you sure you wish to continue?” is displayed. 

2. Click on Yes. The message “An autosave (.ASV) file for this drawing 
exists. Are you sure you want to continue?” is displayed. 

3. Click on Yes to continue. 

4. Click on No; you won’t rename the autosave file. The autosave file is 
deleted and your drawing opens. 

Another way DataCAD helps guard against loss of work is by automatically 
creating a backup (.BAK) file every time you save your drawing. Suppose you’re 
unable to open your drawing because of a disk failure or file corruption. By 
replacing your drawing (.DC5) file with the backup file, you can recover your 
previous drawing version and prevent a loss of your work. 

 To recover your work using a backup file: 

1.  Start DataCAD. 

2. Go to the Enter Drawing File to Open dialog box. Change the Files of 
Type drop-down box to Backup Files (*.BAK). 

3. Click on your backup file to highlight it and click on Open. Your drawing 
is displayed in the Drawing Area, and automatically renamed with a 
.DC5 extension. 

4. Click on Save in the File pull-down menu. We recommend renaming and 
keeping your original file instead of overwriting it. 

You can run the Layer Utility to clean up the recovered file. 

More About Naming Your Files 

Naming your drawings is an important step to meaningful and efficient file 
organization. Ideally, the names of your drawings and the folders you store them 
in will reflect the contents of the file as well as the project they pertain to. 

Identifying your drawings and layers with names like “florplan” or “bricks” or 
“dmension” becomes confusing and redundant. Which floorplan? What kind of 
bricks? Dimensions of what? 

Despite the fact that everyone would rather read names than numbers, a naming 
system based on numbers can eliminate confusion between files. How you 
structure this numbering system is up to you ⎯ only you know the specific 
needs of your office. 

In the sample project outlined earlier in this chapter, we used a different naming 
system. In the filename YMC-MSR1, “YMC” is the job name abbreviation, “MSR” 
is the drawing type, and “1” is the drawing version number. A similar 
convention is used for naming layer files in that project. 

The system described below is a typical numbering system that has worked well 
in several architectural offices. 
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• The first three characters of the filename = the last three digits of the office job 
number. 

• The next two charac pe of 
drawing. (See the following drawi

• The last two characters of the filename = the chronological revision number 

s 

cation plan, 3D views) 
1 = Existing and temporary conditions, site work, demolition 
2 = Plans, detail plans, roof plan 

A3 = Exterior elevations, detail elevations 
A4 = Building sections, wall sections 
A5 = Interior elevations, toilet elevations 
A6 = Reflected ceiling plan, floor patterns, furnishings 
A7 = Schedules, door and window types 
A8 = Details 
A9 = Alternates 
 

Structural, mechanical, HVAC, and civil drawings can be identified by type in a 
similar fashion. Under the above system, for example, the drawing of the fourth 
elevation in job number 85236 would be named 236A304.DC5. 

Exporting Files 
It may often be necessary to export your DataCAD drawings to other file 
formats, so they may be used in other applications by you or other offices or 
consultants you work with. You can export both DWG and DXF files compatible 
with AutoCAD releases 12, 13, and 14 as well as AutoCAD 2000. You can also 
export a DC Render (.RAY) file or an o2c object. It’s generally a good idea to run 
your drawing file through Layer Utility before exporting it. For details, see 
“Layer Utility” in the “Drawing Tools” chapter. See “DXF/DWG Translation” in 
the “Appendix” for more information about how entities are translated during 
export. 

During export, line definitions and shape codes for DataCAD linetypes are 
stored in a .SHX file. If you export a DWG file of the DataCAD drawing 
MYDRAWING.DC5, the translator will create two files: MYDRAWING.DWG 
and MYDRAWING.SHX. For linetypes in the DWG file to display correctly, the 
.SHX file must be placed in the \SUPPORT folder in the AutoCAD directory. 

DataCAD models can be exported to web-friendly VRML 1.0 (Virtual Reality 
Markup Language). This means that any of your customers who have a VRML 
viewer can see your 3D model.   

 To export your drawing to a DXF or DWG file: 

1. Save your drawing before starting the export function. This is especially 
important if you’ve made any changes to your drawing. 

2. Click on Export in the File pull-down menu. A submenu is displayed. 

3. Click on DWG or DXF in the submenu. Two export options are displayed 
in a submenu: All Layers and On Layers. 

ters of the filename = the letter and number of the ty
ng type list.) 

of the drawing. 

A suggested system for identifying types of architectural drawing

A0 = General (index, symbols, lo

follows: 

A
A
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4. Click on All Layers to export all the layers in your drawing. Click on On 
s that are toggled on, or currently being 

6. Choose a file type from the Save As Type drop-down box. If you chose 
e 

t file type is R14-DXF file (*.dxf). 

ogress is displayed in the 
 press (End). If the filename you 

x will be displayed, giving you 
the choice to overwrite (replace) the existing file. Also if the DWG/DXF 

ting to overwrite is open, a message explaining that the 

Exp
spotlights. 

 the Misc tab in the Program Preferences dialog box. 

ent section. Select By Color to 

 
By 

 
s 

anges and close the Preferences dialog box. 

. 

g box is displayed. 

 like to export. 

AD\RAY folder by default. If you’d like to save 
your .RAY file to another folder, use the Save In drop-down box or the Up 

 to another folder. To change the default 
aved to, choose Program Preferences 

er 

 

3. o2c object that you’d like to export. 

Layers to export only those layer
displayed. The Export dialog box is displayed. 

5. Go to the File name input box and type a name for the file. 

DWG in step 3, the default file type is R14-DWG file (*.dwg); if you chos
DXF in step 3, the defaul

7. Click on Save; the export begins. The export’s pr
Message Area. To cancel the translation,
entered in step 4 already exists, a dialog bo

file you’re attemp
file is currently in use will be displayed. By default, DataCAD saves all 
exported files to the DATACAD\XFER folder. 

orted .RAY files include eight light sources: one sunlight and seven 

 To export to a DC Render (.RAY)  file: 

1. Click on Program Preferences in the Tools pull-down menu. 

2. Click on

3. Go to the DC Render Material Assignm
export a .RAY file in which you can assign a different material to all 
entities of each color; select By Layer to export a .RAY file in which you
can assign a different material to all entities on each layer; or select 
Layer and Color to export a .RAY file in which you can assign different
materials to all entities of each color on each layer. By Layer and Color i
the default selection and is the most comprehensive. 

4. Click on OK to save your ch

5. Click on Export in the File pull-down menu. A submenu is displayed

6. Click on RAY in the submenu. A dialo

7. Type the name of the .RAY file that you’d

8. Decide what folder you want to use for the .RAY file. DC Render files are 
saved to your DATAC

One Level icon button to change
folder that DC Render files are s
from the Tools pull-down menu and change the pathname for DC Rend
Files. 

9. Click on Save to export your drawing to the named .RAY file. 

 To export an o2c object: 

1. Click on Export in the File pull-down menu. A submenu is displayed.

2. Click on o2c in the submenu. A dialog box is displayed. 

Type a name for the 
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4. Decide what folder you want to use for the o2c object. By default, o2c 
ave 
or the 

t. 

 To 

2. 

objects are saved to your DATACAD\RAY folder. If you’d like to s
your o2c objects to another folder, use the Save In drop-down box 
Up One Level icon button to change to another folder. 

5. Click on Save to export your model as the named o2c objec

export a 3D model to VRML 1.0: 

1. Select Export from the File pull-down menu. 

Click on VRML in the extended menu. A dialog box appears. 

 
Figure 2.28: Save VRML file format for export 

More About o2c Objects 

You can export your DataCAD model as an o2c object. o2c, an acronym for 
Objects to See, is a highly compressed 3D format that is optimized for Internet-
based communication.  

Simply export your DataCAD model as an o2c object and then either distribute it 
to your client as an e-mail attachment or embed it into one of your web pages. 

Using the easy-to-use o2c player, your clients can freely rotate or walk through a 
lly rendered architectural model. They can view models in wire-frame, hidden-

bjects can even contain 
animated elements that can be played in conjunction with the 3D viewing 

nerate a high-resolution, photorealistic 
the o2c player, you don't need to transmit 

exc
While t s comprehensive and powerful viewing controls, 
obj

For mo l.” 

3. Supply a file name for the VRML file that you want to create. Then, click 
on Open or press (Enter). 

fu
line, flat-shaded, textured, or ray-traced modes. The o2c o

commands. And because you can ge
rendering of the model right in 

essively large images via email; your clients can simply create their own. 
he o2c player provide

ects can’t be modified. 

re information about o2c, see the chapter on “Viewing Your Mode





Tutorial: Drawing a 
Schoolhouse 

walls of the schoolhouse and add 

3 
In this chapter: 

 walls 

 Drawing windows 

 Drawing doors 

 

In this chapter, you’ll learn how to customize both DataCAD 
and your drawing before you ever draw a line. Then you’ll 
draw the exterior and interior 

 Drawing

doors and windows to it. 
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Settin
DataCA
In this nly two modifications: adding layers to a new 
dra

To begi
“The D

r the Tutorial 
First, you’ll need to change the snap grid setting. 

 To set the snap grid: 

1. Press (S) on your keyboard. Make sure Caps Lock is off. In the Message 
Area, you are prompted to “Enter X-snap grid.” 

nter). You are prompted to “Enter Y-snap grid.” 

You jus  
around
Messag

Cre
When y ing in DataCAD, it contains only one layer (called 
Lay
automa . For example, the 
snap grid setting you entered a u add to 
you

 To a

1. Right-click to return to the Utility menu from the previous exercise. 

2. Click on Layers in the Utility menu. 

4. Type 8 and press . You’ve just added eight layers to the drawing for 

Naming Layers for the Tutorial 
You e, but you should develop your 
ow y which 
menu is displayed in the Menu Window, check the Message Area. See Figure 3.1 
to l

 

2.  menu. A list of all your layers is displayed in 
the Menu Window. 

g Up a New Drawing 
D contains many options for customizing the way your system operates. 

tutorial, you will make o
wing and changing the snap grid setting.  

n this tutorial, start DataCAD and start a new drawing, as described in 
rawing Board” chapter. 

Setting the Snap Grid fo

2. Type .1 and press (E

3. Type .1 and press (Enter). 

t set the accuracy of the cursor movement to one inch. Move your cursor
 the drawing screen and look at the X and Y snap grid values in the 
e Area. 

ating New Layers for the Tutorial 
ou start a new draw

er1), which is also the active layer. Any settings in the active layer will 
tically be used in new layers when you create them

bove will be assigned to each layer yo
r drawing; so you won’t have to set the snap grid in every new layer. 

dd layers to this drawing: 

3. Click on NewLayer in the Layers menu. 

(Enter)
a total of nine layers. 

’ll be given the layer names for this exercis
n plan for naming layers based on the type of work you do. To verif

ocate the menu name display. 

To rename your layers: 

1. If you aren’t in the Layers menu, click on Layers in the Utility menu. 

Click on Name in the Layers
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3. Click on Layer1. You are prompted to “Enter new name.” 

4. Type Walls and press (Enter). Look at the list of layers in the Menu 
Window; notice that Layer1 has been changed to Walls. 

5. Click on Layer2. You are prompted to “Enter new name.” 

6. Type Doors and press (Enter). Notice that Layer2 is now named Doors in 
the layer list in the Menu Window. 

7. Rename the rest of your layers as follows:Layer3 to Windows, Layer4 to 
Plumb, Layer5 to Dim, Layer6 to Hatch, Layer7 to Notes, Layer8 to Misc, 
and Layer9 to Border. 

lity menu. 8. Right-click twice to return to the Uti
Coordinate display
System and error messages

User prompts and data entry
Menu name  

al 
No
them
change to e you begin drawing. In DataCAD terms, 
before lls layer the active 
laye

The Sta shows the active layer, or the layer that you are drawing on. As 
you tus Area is updated with the corresponding 
laye n the active layer. 

 

Figu

 

1. 

2. Keep pressing (Tab). Eventually you’ll return to the beginning of the layer 
list. Pressing (Shift) + (Tab) cycles backwards through your layers. 

Figure 3.1: The Message Area display 

Moving Between Layers in the Tutori
w that you’ve created and named your new layers, you can move among 

. To draw walls on the Walls layer and doors on the Doors layer, you have to 
the corresponding layer befor

you place a wall on your drawing you will make the Wa
r. 

tus Area 
 change active layers, the Sta
r name. You can only draw o

Displays the name of 
the active layer entities 
will be drawn on. Press 
(Tab) to change the 
active layer. 

Displays the 
tive layer’s ac

current color. 

color. Press (K) 
to change the 

re 3.2: Check the Status Area for active layer name and color. 

To change the active layer: 

Press (Tab) on your keyboard. Notice that the active layer name in the 
Status Area changes. 
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Assigning Colors to Layers in the Tutorial 
You can assign different colors to layers, so that any entities you add to a layer 
will be drawn in that layer’s color. You’ll be able to tell at a glance what layer an 
entity is on simply by its color. That color is the active color for that layer until 
you change it. 

 To assign layer colors: 

1. If you’re not in the Layers menu, click on Layers in the Utility menu. 

2. Press (Tab) until the Doors layer is the active layer. Check the Status Area 

3. Click on Color in the Layers menu. 

the active layer. Pressing (K) will cycle 

to see which layer is active. 

Shortcut:  Press (K) to change the color of 
through the colors; pressing (Shift) + (K) cycles backwards through the layers. 

4. 
. 

6. 

7. n. 

8. Use this same procedure to assign colors to the rest of your layers. Make 
the Plumb layer Lt. Grey, the Dim layer Lt. Grey, the Hatch layer Brown, 

e Misc layer Red, and the Border layer Lt. 

Drawing Walls, Windows, and Doors 
This
tool. Yo
archite ng 
Settings” in the “Before You Draw” chapter for more information on how to 
change drawing units. 

Drawing the Schoolhouse Walls 
Each wall that you draw will have two or more lines, rather than just one. In the 
following exercises, you will draw walls using both the mouse and the keyboard. 

Click on Green. The color assigned to the Doors layer is now Green, and 
you can see the layer color box in the Status Area is also displaying green

5. Press (Tab), so that the Windows layer is active. 

Click on Color in the Layers menu. 

Click on Cyan. The color assigned to the Windows layer is now Cya

the Notes layer Lt. Red, th
Green. 

9. Right-click to return to the Utility menu. 

 part of the tutorial introduces you to using DataCAD as an architectural 
u will learn how to use the wall menu options to begin drawing 

ctural plans. This tutorial uses Imperial units. See  “Customizing Drawi

   
Figure 3.3: Examples, from left to right, of 2-line walls, 3-line walls, and 4-line walls 
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The Architct menu is used for drawing walls as well as doors and windows. 

Turn walls function on

choose type of multi-line wall:
2, 3 or 4 lines

/off. Draws parallel
ines when off.

Set wall thickness (the distance between
the parallel lines).

lines when on, single l

Automatically cleans T-intersections as you draw walls.

Enters the Door Swing menu to insert doors in wa .
w menu to insert windows in walls.

Exits the

lls
Enters the Windo

Architect menu.You can also click the right
mouse button to exit.

Menu Title

 
Figu

Drawin

Before you draw the exterior walls of the schoolhouse, you should make sure 

 

2. enu Window, click on Architct. The Architct 

5. Architct menu to set the width of the wall. A value 

.” For more information on using value menus, see “Value 

6. nu and then right-click; or type 1 and press 
(Enter). 

7. Click Outside in the Architct menu; any walls you draw will be defined 
by the outside line of the wall. 

8. Right-click to return to the Edit menu. 

re 3.4: The Architct menu is used for drawing walls, windows, and doors. 

g the Schoolhouse’s Exterior Walls 

your wall settings are correct. 

To set up for drawing exterior walls: 

1. Continue with the drawing you started in the previous section of this 
tutorial. 

In the Edit menu in the M
menu is displayed. 

3. Click on Walls in the Architct menu to toggle it on; walls will be drawn 
instead of single lines. Notice that the “w” in SWOTHLUD in the Status 
Area is now uppercase. This indicates that you will draw walls instead of 
single lines. 

4. Click on 2LnWalls in the Architct menu, if it’s not already toggled on. 

Click on Width in the 
menu is displayed in the Menu Window, and you are prompted to “Enter 
wall width
Menus” in “The Drawing Board” chapter. 

Click 1’-0” in the value me
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9. Before you begin drawing the exterior walls, look at the Status Area to see 
that Walls is your active layer. If it’s not, press (Tab) until it is. 

Active layer name.

Each letter deignates a drawing setting
and indicates if it is active. The capital
"W" shows that the Wall option is on.

 
 You can check both the active layer and the status of the Walls toggle Figure 3.5: in the Status 

Area

Now you are ready to draw the exterior walls. 

pt in the 
 “Sel

f 

efine 

3.  cursor to a position anywhere above the displayed line and 

 line/wall.” 

. 

 To draw exterior walls: 

1. You’ll draw the first wall using the mouse. Notice that the prom
Message Area reads ect first end point of new line/wall.” Move the 
cursor to the lower left of the Drawing Area and click to enter the first 
end point of the new wall. You are prompted to “Select next end point o
line/wall.” 

2. Move the cursor to the right until the coordinate readout shows an X 
measurement of 28’-0” and a Y measurement of 0, and click. This defines 
the exterior line of the wall. You are prompted to “Select a point to d
the inside of the wall.” 

Move the
click. The wall is immediately drawn. You are prompted to “Select next 
end point of

 
Figure 3.6: Drawing the first wall 

Leave the cursor
connected to the wall
line.

 
Figure 3.7: The wall is drawn. 

4. Now you’ll draw a second wall using co
the Message Area reads “Current input mode = r

ordinate entry. Press (Insert) until 
elative polar (distance, 

rawing 
Using Coordinate Entry” in “The Drawing Board” chapter to review 

5. Press cebar) to activate coordinate entry. You are prompted to “Enter 

6. 
er relative angle.” 

angle).” You can also use coordinate entry to enter points. See “D

coordinate entry methods. 

(Spa
relative distance.” 

Type 40.6 and press (Enter). (40.6 means 40 feet 6 inches in architectural 
units.) You are prompted to “Ent
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7. Type 90 and press (Enter). The wall is drawn and the corner is 
automatically cleaned. If the new wall extends beyond your view of the 
Drawing Area, use the arrow keys to move your drawing into view. 

The cursor is connected to the outside
corner.

The corners automatically clean up as
you draw.

 
Figure 3.8: The second wall is drawn and the corner is cleaned. 

8. Click W on the Navigation Pad to go to the WindowIn menu. The 
WindowIn menu is displayed in the Menu Window. 

9. Click on FreeZoom in the WindowIn menu to toggle it off. 

10. Click on Extents in the WindowIn menu to zoom out to the extents of the 
drawing. 

11. Right-click to return to the Edit menu. 

12. Press (Spacebar). You are prompted to “Enter relative distance.” 

13. Type 28 and press (Enter). You are prompted to “Enter relative angle.” 

14. Type 180 and press (Enter). 

15. Move the cursor close to the inside line of the corner where you originally 
began and click. The last corner is cleaned, leaving a clean outline of the 
schoolhouse exterior walls. 

Bring cursor close to the inside wall line.

 
Figure 3.9: Ending your exterior wall 
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The final corner is automatically cleaned up.

 
Figure 3.10: The exterior walls are complete. 

Drawing the Schoolhouse’s Interior Walls 

Now you will draw the interior walls. You’ll change the wall thickness for the 
interior walls to four inches. 

or walls: 

1. In the Edit menu in the Menu Window, click on Architct. The Architct 

 To set up for drawing the interi

menu is displayed. 

Shortcut: Press (A) to access the Architct menu at any time. 

2. Click on Width in the Architct menu. You are prompted to “Enter wall 
width.” 

3. Type .4 and press (Enter). 

Click on Insi4. de in the Architct menu to define the wall by the inside line. 

d 

 d

1.  the Navigation Pad to open the WindowIn menu. You are 
prompted to “Select first corner of the Zoom window.” 

de the lower-left corner of the plan and click. 
.” 

3. Move the mouse diagonally, stretching the rubberband box until it 
encloses the lower half of the plan as in the figure below and click. Your 
drawing now appears larger. 

5. Click on Clean to toggle on automatic T intersection cleaning. Walls an
2LnWalls should still be toggled on. 

6. Right-click once to return to the Edit menu. 

To raw interior walls: 

Click W on

2. Position your cursor outsi
You are prompted to “Select second corner of the Zoom window
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2

Click the left mouse button to start the
rubberband box.

3

Click the left mouse button to close the
rubberband box.

 
Figu

4. 

-left corner of 

6. Move the cursor close to the inside left corner of the bottom wall and 
either click the middle mouse button or press (N) on the keyboard. This 

ference point to work from. Steps 6-9 are the 
ale at a corner and 

re 3.11: Zooming in on the lower half of the plan. 

Right-click to return to the Edit menu. 

5. Press (`) on the keyboard to set X and Y to 0. You are prompted to “Select 
reference point.” The accent key ( ` ) is located in the upper( ) 
your keyboard, just below (Esc) and to the left of (1) on most keyboards. 

sets this corner as the new re
equivalent of placing one end of an architect’s sc
marking a point at 10’-2”. 

6
New reference point

 
Figure 3.12: Setting a reference point 

7. Press (Spacebar). You are prompted to “Enter relative distance.” 

8. Type 10.2 (the inside dimension of t e office) and press (Enter). You are 
ive angle.” 

 
oint. This will be the first point of the interior wall. 

h
prompted to “Enter relat

9. Type 0 for the relative angle and press (Enter). Notice that your cursor is 
now attached to the wall exactly 10’-2” to the right of the corner you used
as your reference p

Cursor still attached to a point.

Referenced corner

 

10. Press (Spacebar). You are prompted to “Enter relative distance.” 

F ure 3.13: Starting your interior wall ig
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11. Type 10.8 (the inside dimension of the office) and press (Enter). You are 
prompted to “Enter relative angle.” 

12. Type 90 and press (Enter). You are prompted to “Select a point to define the 
Outside of the wall.” 

13. Move the cursor to the right of the displayed line and click to indicate the 
outside of the wall. 

You remain connected to the wall.

13
Click the left mouse button.

 
Figure 3.14: Defining the outside of the wall 

14. Move the cursor close to the inside line of the left exterior wall and click.  

14
Click the left mouse button close to the inside line
of the exterior wall.

 
Figu

15. 

 d

Select reference point.” 

ess (N) on the keyboard. 

re 3.15: Drawing the last office wall 

Right-click to disconnect from the line. The office area is complete and all 
intersections are automatically cleaned. 

To raw the remaining interior walls: 

1. Press (`) on the keyboard. You are prompted to “

2. Move the cursor close to the inside right corner of the bottom wall and 
click the middle mouse button. Remember, if you don’t have a three-
button mouse you can also pr

2    

New reference point

 
Figu

nter relative distance.” 

4. Type 10.2 and press (Enter). You are prompted to “Enter relative angle.” 

 connects to a point on the inside 

6. Pr (Spacebar)

7. Type 10.8 and press (Enter). You are prompted to “Enter relative angle.” 

re 3.16: Selecting a new reference point 

3. Press (Spacebar). You are prompted to “E

5. Type 180 and press (Enter). The cursor
line of the exterior wall. 

ess . You are prompted to “Enter relative distance.” 
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8. Type 90 and press (Enter). You are prompted to “Select a point to define th
outside of the wall.” 

e 

 side line of the exterior wall 

11.  and your 
intersections are cleaned. 

9. Move the cursor to the left of the new wall and click to define the outside 
of the wall. 

10. Move the cursor to the right just before the in
and click. 

Right-click to disconnect from the wall line. The wall is drawn

T intersection cleaned up automatically

 
Figu ntersections are cleaned. 

 

13. Move the cursor near the inside corner of the wall you just drew and click 
the middle mouse button. 

re 3.17: The wall is drawn and the i

12. Press (`). You are prompted to “Select reference point.” 

13
New reference point

 
Figure 3.18: Selecting a new reference point 

14. Press (Spacebar). You are prompted to “Enter relative distance.” 

You are prompted to “Enter relative angle.” 

e 

17. Move the cursor to the left, close to the inside line of the wall, and click. 
 point to define the Outside of the wall.” It 

is important in step 17 to select a point closer to the inside, not the 
e 

18. Move the cursor below the displayed line and click to define the outside 
of the wall. 

15. Type 5.2 and press (Enter). 

16. Type 270 and press (Enter). The cursor connects to a point on the insid
line of the exterior wall. 

You are prompted to “Select a

outside, line of the room you just drew so that the correct wall line will b
cleaned. 
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17

18
Click mouse here to define outside
of wall.

Click mouse closer to the
inside line of the room just
drawn.

 
Figure 3.19: 

ct from the wall. 

 

Drawing the dividing wall between the bathrooms 

19. Right-click to disconne

20. Click on E on the Navigation Pad to view the drawing extents. 

 
Figure 3.20: The walls of the schoolhouse floor plan 

 it 
 or make a lot of 

changes to your drawing. 

You ha use plan and saved your 
drawing. If any of the walls did not clean, and your drawing doesn’t look like the 
figu a

Cleaning the Schoolhouse’s Wall Intersections 

As you insert walls, DataCAD automatically cleans intersections. If you right-
click by accident and disconnect from a wall prematurely, or your intersections 
clean at the wrong wall line, you will need to clean them. 

21. Press (Ctrl) + (S) on the keyboard to save the drawing. This is a good hab
to get into. You should do it after you enter several items

ve now completed all the walls of the schoolho

re bove, the next section will help you straighten up your plan. 
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1
If you disconnected from a wall and
reattached to continue the remaining
walls, the corner you reattach to will not
clean.

3
If you were too close to the outside line of

the wrong line will clean.
this wall when drawing the dividing wall,

2
If you become disconnected from a wall,
when you attempt to complete the last
intersection, the “L” intersection will not
clean up properly.

 
Figu

If an L n 
you drew the walls, it may be because you disconnected your cursor from the 
end of one wall and then started drawing the next wall. In such a case, you may 
have to use 2LnTrim in the Cleanup menu so the wall lines intersect properly, 
and then use Erase to remove any unwanted lines within the intersection. 

 To fix the error shown in example 1: 

1. In the Edit menu in the Menu Window, click on Cleanup. 

2. Click on LIntSct in the Cleanup menu. You are prompted to “Select 1st 
corner around L intersection (wall lines only).” 

tretching 

re 3.21: Examples of wall intersections that were improperly drawn 

intersection doesn’t clean properly, despite Clean being toggled on whe

3. Click above and to the right of the intersection. 

4. Diagonally drag the cursor to the lower left of the intersection, s
the rubberband box, and click. 

Plac The corner is
automatically

e a rubberband box
 the corner toaround

clean. cleaned.

 
Figure 3.22: Cleaning an L intersection 
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1. 
st

3. Click above and to the right of the intersection. 

 cursor to the lower left of the intersection, stretching 
the rubberband box around the intersection, and click. 

To fix the error shown in example 2 on the previous page: 

In the Edit menu in the Menu Window, click on Cleanup. 

2. Click on LIntSct in the Cleanup menu. You are prompted to “Select 1  
corner around L intersection (wall lines only).”  

4. Diagonally drag the

Place a rubberband box
around the corner to
clean.

The corner is
automatically
cleaned.

 
Figure 3.23: Cleaning an L intersection 

 To fix the error shown in example 3 on the previous page: 

1. In the Edit menu in the Menu Window, click on Cleanup. 

2. Click on 1LnTrim in the Cleanup menu. You are prompted to “Select first 
point of line to clip to.” 

. You are prompted to “Point to line 
to trim to.” 

 select 

o 

re 

3. Click on Entity in the 1LnTrim menu

4. Click on the inside wall line, shown in Figure 3.24. The line you
becomes dashed. You are prompted to “Point to outside.” 

5. Click to the left of the dashed line. You are prompted to “Select entity t
trim.” 

6. Click on the two wall lines to select them as the lines to trim. The lines a
trimmed. 

4
Click the left mouse button
to define this line as the line
to clip to; the line becomes
dashed.

5
Click the left

mouse button to
define the outside.

6
Click the left mouse button to select
these two lines as the lines to trim.  

.24: Completing a 1-line trim Figure 3

7. Right-click once to return to the Cleanup menu. 
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The lines are trimmed to the
correct wall, but there is still a

break in the wall.

 
Figure 3.25: Trimming wall lines to the correct wall 

8. To fix the br ll, click on WeldLine in the Cleanup 
menu. You are prompted to “Select first line to weld.” 

eak in the outside wa

hed. 

10.  the other line of the broken wall to select it. The line mends and 

9. Click on one of the lines of the broken wall to select it; it becomes das
You are prompted to “Select second line to weld.” 

Click on
becomes a single entity. 

9
Click the left mouse button to
define the first line to weld. It
becomes dashed.

10
ick the left mouse button to

efine the second line to weld.
e line is mended.

Cl
d
Th

Figure 3
 

.26: Selecting lines to be welded 

11. Right-click once to return to the Cleanup menu. 

The lines are
trimmed to the

inside wall.

 

12. wall, click on TIntsct in the Cleanup 
st sect (wall 

 re 
o “Select 2nd corner around “T” intersect (Wall line ends only).” 

14. Move the cursor above and to the right of the intersection to enclose the 
corner to clean and click. You are prompted to “Point to a wall line to trim 
to.” 

Figure 3.27: The wall line is welded. 

To clean up the T intersection in the 
menu. You are prompted to “Select 1  corner around “T” inter
line ends only)”.  

13. Click at the lower left of the intersection you want to clean. You a
prompted t



|  CHAPTER 3: TUTORIAL: DRAWING A SCHOOLHOUSE  78 

15. Click on the inside line to select it as the line to trim to. 

16. Right-click twice to return to the Edit menu.  

13-14
Place a rubberband box

around  the corner to clean.

15
Click the left mouse button to
define this line as the line to

trim to.
 

Figure 3.28: Completing a T intersection 

The wall is cleaned and
the T intersection is

complete.

 
re 3.29: The wall intersection is cleaned. Figu

Dra n

While the 3-line walls function is usually  
to q

To set up to draw countertops: 

n the 3-line wall 

 

3. t the attributes of the 
centerline of the two parallel lines. This will represent the upper cabinets. 

4. Click on LineType in the CntrLine menu. All available linetypes are listed 
in the Menu Window. 

5. Click on Dashed in the LineType menu to make the centerline dashed. 

6. Right-click once to return to the Architct menu. 

itct menu. You are prompted to “Enter wall 
width.” 

 two feet. 

wi g Countertops in the Schoolhouse 

used for drawing walls, we’ll use it here
uickly draw parallel lines representing countertops.  

 

1. Click on Architct in the Edit menu. 

2. Click on 3LnWalls in the Architct menu to toggle o
option. This allows you to draw three parallel lines at once. The two outer 
lines will define the edges of the counter and the centerline will be a 
dashed line to represent the upper cabinets. Walls should still be toggled
on. 

Click on CntrLine in the Architct menu to se

7. Click on Width in the Arch

8. Type 2 and press (Enter). This sets the width of the countertop at
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9. Click on Outside in the Architct menu; the wall will be defined by the 
outside line. 

Click on Ca10. p in the Architct menu to automatically cap the end of the 
s, or in this c

1. 
No

 

1. Click W on the Navigation Pad to open the WindowIn menu. You are 
orner of the Zoom window.” 

2. Click near the lower-left corner of the bottom wall. You are prompted to 

3. 
now appears larger. 

4. Right-click once to return to the Edit menu. 

rner marked 6 in Figure 3.30 and click the 

parallel line ase countertops. 

11. Right-click to return to the Edit menu.  

 
w you are ready to draw the countertops. 

To draw countertops on the plan: 

prompted to “Select first c

“Select second corner of the Zoom window.” 

Diagonally move the mouse until the rubberband box encloses the lower 
half of the plan and click. The plan 

5. Move the cursor to the co
middle mouse button to select it as your first reference point. 

6
Click the middle mouse
button to connect to this
point.

 
Figure 3.30: Selecting the starting point of the countertop 

6. Press (Spacebar). You are prompted to “Enter relative distance”. 

7. Type 10.2 and press (Enter). You are prompted to “Enter relative angle”. 

8. Type 180 and press (Enter). 

9. Move the cursor above the displayed line and click to define the other 
side of the counter. 

9
Click the left mouse button to

 thedefine the other side of
countertop.

7-8
The length of the countertop
is defined.

 
Figure 3.31: Drawing the countertop 
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10. Right-click to disconnect from the counter. The countertop lines are 
ed. drawn and the end is capp

 
re 3.32: The first countertop is drawn. Figu

 
 relative angle for this counter will be 0. 

11. Repeat steps 5 - 10 for the counter on the opposite side. Remember that
the

 
Figure 3.33: The second countertop is drawn. 

12. Click E on the Navigation Pad to view the extents of the drawing. 

13. Press (Ctrl) + (S) to save the drawing. 

Drawing the Schoolhouse’s Doors and Windows 
No
inse

 To 

r is the 
active layer in the Status Area.  

w that you have drawn the walls for the schoolhouse plan, you are ready to 
rt doors and windows. 

set up to draw a door: 

1. Before you begin to draw doors, press (Tab) until the Doors laye

2. In the Edit menu in the Menu Window, click on Architct. 

3. Click on DoorSwng in the Architct menu. 
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Adjusts settings that determine
what doors will look like.

Door entry method. By sides (jambs) when on, by
centers when off.

Removes doors and cut-outs in walls.
Draws temporary marks to aid in door placement.
Exits the Door menu. You can also click the right
mouse button to exit.

Menu Title

 
Figure 3.34: The DoorSwng menu 

4. Click on DrwMarks in the DoorSwng menu to toggle the Draw Marks 
option on.  

5. Click on LyrSrch to toggle it on. (If LyrSrch is already toggled on, click on 
it to toggle it off; then toggle it back on again.) You are prompted to 
“Select layer to search for walls”, and a list of your layers is displayed in 
the Menu Window. 

6. Click on Walls. DataCAD now knows where to find your walls when it 
needs to cut them for doors and windows. 

There are two methods to draw a door: by defining both of its sides and by 
defining one side and its center. You’ll draw the first door by sides. To position 
and begin drawing a door, you need to reference and measure from an existing 
point on the drawing. 

 To draw a door by sides: 

1. Click W on the Navigation Pad to go to the WindowIn menu. You are 
er of the Zoom window.” 

ottom wall. You are prompted to 
.” 

3. Diagonally move the mouse until the rubberband box encloses the lower 
half of the plan and click. The plan now appears larger. 

prompted to “Select first corn

2. Click at the lower-left corner of the b
“Select second corner of the Zoom window
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2
Click the left mouse button to
start the rubberband box.

3
Click the left mouse button to close the
rubberband box.

 
Figure 3.35: Zooming in on the plan 

 
Figure 3.36: The result of zooming in on your drawing 

4. Right-click once to return to the DoorSwng menu. 

5. Press (`) on the keyboard. You are prompted to “Select reference point”. 

6. Click the middle mouse button near the upper-right corner of the first 
room you drew, as shown in Figure 3.37. Stay close to the inside of the 
corner. This will be your reference point. You are prompted to “Select 
hinge side of door”. 

6
Click the middle mouse button to set this corner
as the reference point.

 
Figure 3.37: Setting a reference point. 

7. Press (Spacebar). You are prompted to “Enter relative distance”. 

8. Type .3 and press (Enter). You are prompted to “Enter relative angle”. 
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9. Type 270 and press (Enter). You are prompted to “Select strike side of 
door”. 

ce”. 

e

ect

ll)
mpte

on-printing s
location. The door is drawn. 

10. Press (Spacebar). You are prompted to “Enter relative distan

11. Type 3 and press (Enter). You are prompted to “Enter relativ  angle”. 

12. Type 270 and press (Enter). You are prompted to “Select dir
swing”. 

13. Click anywhere inside the office (on the left side of the wa
the direction of the swing. The wall is cut,  and you are pro
“Select any point on the outside of the wall”. 

14. Click to the right of the outside wall to define the n

ion of door 

; this defines 
d to 

nap point 

7-9
The hinge side of the door.

A non-printing center
snap point.

14
Click the left mouse button to define the
outside of the wall.

10-12
The strike side of the door.

13
Click the left mouse button to define the
direction of door swing.

.

 
Figure 3.38: Drawing the door 

 To draw a second door by center: 

1. Click on Sides in the DoorSwng menu to toggle off the Sides option. Now 
you can define doors by entering their center and strike side. 

2. Move the mouse to the location shown in Figure 3.39. Click the middle 
mouse button to snap to the midpoint of the inside front wall. You are 
prompted to “Select strike side of door”. 

2
Click the middle mouse
button to connect to the
midpoint of the line.

 
Figure 3.39: Defining the center of the front door 

3. Press (Spacebar). You are prompted to “Enter relative distance”. 

4. Type 1.6 and press (Enter). You are prompted to “Enter relative angle”. 



|  CHAPTER 3: TUTORIAL: DRAWING A SCHOOLHOUSE  84 

5. Type 0 and press (Enter). You are prompted to “Select direction of door 

 the outside of the exterior wall where you want to 

swing”. 

6. Click inside the hall (above the wall) to define the direction of the door 
swing. The wall is cut. You are prompted to “Select any point on the 
outside of the wall”. 

7. Click anywhere on
locate the non-printing snap point. The door is drawn. 

6
Click the left mouse button to define the
direction of the door swing.

2
The center of the door.

3-5
The strike side of the door.

7
Click the left mouse button to define the
outside of the wall.  

.40: The front door is drawn. Figure 3

8. Click on Sides to toggle on the Sides option. 

9. Press `  to set a new r rence point. 

10. ner of Room A, 
shown in Figure 3.41. You are prompted to “Select hinge side of door”. 

( )

Click the middle mouse button near the upper-left cor

efe

Room A

Room B

10
Click the middle mouse button to
define the new reference point.

 
Figure 3.41: Locating the next door 

11. Press (Spacebar). You are prompted to “Enter relative distance”. 

12. Type .3 and press (Enter). You are prompted to “Enter relative angle”. 

13. Type 270 and press (Enter). You are prompted to “Select strike side of 
door”. 

14. Press . You are prompted to “Enter relative distance”. 

15. Type 3 and press (Enter). You are prompted to “Enter relative angle”. 

(Spacebar)
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16. Type 270 and press (Enter). You are prompted to “Select direction of d oor 

17. Click anywhere inside Room A (on the right side of the wall) to define the 
g. The wall is cut. You are prompted to “Select any 

18. the wall. This defines the 
e door is drawn. 

19. Now repeat steps 9-18 to create a door for Room B.  

 to the Edit menu. 

swing”. 

direction of the swin
point on the outside of the wall”. 

Click inside the hall to define the outside of 
non-printing snap point location. Th

20. Right-click twice to return

 
Figure 3.42: The remaining schoolhouse doors are drawn. 

21. Click R on the Navigation Pad to recalculate the extents of the drawing. 

22. Press (Ctrl) + (S) on the keyboard to save the drawing.  

You have now completed entering all the doors for this exercise and saved them 
to your drawing file. 

 To set up to draw windows: 

1. Before you begin to draw windows, press (Tab) until the Windows layer is 
the active layer in the Status Area. 

chitct. 

dows in the Architct menu. The Windows menu is 

2. In the Edit menu in the Menu Window, click on Ar

3. Click on Win
displayed. 
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Adjusts settings that determine
what windows will look like.

Window entry method. By sides (jambs) when on,

mouse button to exit.

by centers when off.

Removes windows and cut-outs in walls.
Draws temporary marks to aid in window placement.
Exits the Window menu. You can also click the right

Menu Title

 
Figure 3.43: 

 To draw the first window by sides: 

1. Click W on the Navigation Pad to open the WindowIn menu. You are 
prompted to “Select first corner of the Zoom window”. 

2. Click at the lower-left corner of the bottom wall. You are prompted to 
“Select second corner of the Zoom window”. 

3. Diagonally move the mouse until the rubberband box encloses the lower 
half of the plan, and click to zoom in on your plan. 

The Windows menu 

2
Click the left mouse button to start the rubberband box.

3
Click the left mouse button to close the
rubberband box.

 
lower half of your drawing 

 

Figure 3.44: Zooming in on the 

4. Right-click once to return to the Windows menu.
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5. Press (`) on the keyboard. You are prompted to “Select reference point”. 

 interior 
e point. You are 

6. Click the middle mouse button near the lower left corner of the
wall shown in Figure 3.45. This will be your referenc
prompted to “Select one jamb of window”. 

6
Click the middle mouse button
to set the reference point.

 
Figu

7. Pr ou are prompted to “Enter relative distance”. 

You are prompted to “Enter relative angle”. 

 (Enter)

to “Enter relative angle”. 

“Select any point on the 
outside of the wall”. 

all. The window is drawn. 

re 3.45: Setting a reference point 

ess (Spacebar). Y

8. Type 3.7 and press (Enter). 

9. Type 0 and press . You are prompted to “Select one jamb of 
window”. 

10. Press (Spacebar). You are prompted to “Enter relative distance”. 

11. Type 3 and press (Enter). You are prompted 

12. Type 0 and press (Enter). You are prompted to 

13. Click anywhere on the outside of the exterior w

7-9
First window jamb

10-12
Second window jamb

13
Click left mouse button for the outside of the wall.

Figu

14. Move the cursor to the bottom right corner of Room B and repeat steps 6 - 
14 for the window on the opposite side. Remember that the relative 
angles will now be 180. 

15. Click E on the Navigation Pad to view the extents of the drawing. 

 To draw multiple windows: 

1. Click on Sides in the Windows menu to toggle Sides off; you can now 
define windows by the center and one side or jamb. 

 
re 3.46: Drawing the first window 
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2. Click W on the Navigation Pad to open the WindowIn menu. You are 
prompted to “Select first corner of the Zoom window”. 

3. Click at the upper-right corner of the top wall. You are prompted to 
“Select second corner of the Zoom window”. 

4. Diagonally move the mouse until the rubberband box encloses the upper 
half of the plan, and click to zoom in on the plan. 

4
Click the left mouse button to close the
rubberband box.

3
Click the left mouse button to start the
rubberband box.

 
Zooming in on the upper half of your drawing Figure 3.47: 

ed to “Select reference point”. 

7. Move the cursor to the top left corner of the interior wall, as shown in 
ouse button to set the reference point. 

 

5. Right-click once to return to the Windows menu. 

6. Press (`) on the keyboard. You are prompt

Figure 3.48, and click the middle m
You are prompted to “Select center of window”.

7
Click the middle mouse button to set the
reference point.

 
.48: Setting a reference point Figure 3

9. 

10. T ompted to “Select one jamb of 
window”. 

elative distance”. 

  relative angle”. 

 

2.  is 
draw

8. Press (Spacebar). You are prompted to “Enter relative distance”. 

Type 7.8 and press (Enter). You are prompted to “Enter relative angle”. 

ype 270 and press (Enter). You are pr

11. Press (Spacebar). You are prompted to “Enter r

12. Type 1.6 and press (Enter). You are prompted to “Enter

13. Type 270 and press (Enter). You are prompted to “Select any point on the 
outside of the wall”. 

14. Click anywhere on the outside of the exterior wall. The wall is cut and the window
n. 
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8-10
The center of the window

11-13
The window jamb14

Click the left mouse button
to define the outside of the
wall

 
Figure 3.49: The wall is cut and the window is drawn. 

15. Press (`) on the keyboard. You are prompted to “Select reference point”. 

16. Move the cursor to the center snap point of the window you just drew 
and click the middle mouse button to set the reference point. ou are 

ow”. 

18. d press (Enter). You are prompted to “Enter relative angle”. 

“Select one jamb of 
window”. 

lative distance”. 

21. Type 1.6 and press (Enter). You are prompted to “Enter relative angle”. 

). You are prompted to “Select any point of the 

ll. The wall is cut and the 

Y
prompted to “Select center of wind

17. Press (Spacebar). You are prompted to “Enter relative distance”. 

Type 5.6 an

19. Type 270 and press (Enter). You are prompted to 

20. Press (Spacebar). You are prompted to “Enter re

22. Type 270 and press (Enter
outside of the wall”. 

23. Click anywhere on the outside of the exterior wa
window is drawn. 
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17-20
The center of the window

21-23
The window jamb24

Click the left mouse button to
define the outside of the wall

16
Click the middle mouse button to set this point as
the new reference point

 
Figure 3.50: The wall is cut and the window is drawn. 

24. Repeat steps 15 - 23 for the last window on this wall. 

25. Repeat these steps to create the windows on the other wall. 

26. Click E on the Navigation Pad to view the extents of the drawing. Your 
plan should look like Figure 3.51. 
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.51: The Schoolhouse floor plan. Figure 3

28. Press (Ctrl) + (S) to save the drawing. 

3.  
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Tutorial: Adding Dimensions, 
N

Thi
dra
add text notes and arrows, dimension the drawing, add a tile 
hat
bathroo . Finally, 
you

4 
chapter: 

otes and 

 Dimensioning the 

 Adding hatch to areas 
wing 

 symbols 

tle blocks 

 

otes, Symbols, and Hatching In this 

s part of the tutorial covers those functions that transform a 
wing into an architectural construction document. You will 

 Drawing n
other text 

ch to the hallway, and insert plumbing symbols in the 
ms as well as a sink in one of the countertops

drawing 

’ll draw a title block and border around the drawing. of the dra

 Inserting

 Drawing ti
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Adding Text to the Schoolhouse Drawing 
t to take shape. Depending 

 

e 

3. Click on Text in the Edit menu in the Menu Window, or click on Text in 
 The Text menu is displayed in the Menu 

As you enter text, the schoolhouse floor plan will star
on the size, placement, and font being used, your drawing can develop into
something that looks very professional. 

 To set text attributes: 

1. If you are not already working in DataCAD, open the program now. 
Open the drawing you worked on in the previous chapter. 

2. Press (Tab) until the Notes layer is the active layer, as displayed in th
Status Area. 

the Create pull-down menu.
Window. 

Adjusts settings that determine
what the text will look like.

Saves text settings for later recall.

Aligns text in paragraphs.

Menu Title

Draws arrows.

  
Figure 4.1: The Text menu 

n Size. A value menu is displayed. The 
presents the current size of the text. 

, 

8. Click on FontName to select a new font. The Set Text Parameters dialog 
box appears so that you can select CHR or TTF fonts. 

4. To set the size of the text, click o
text cursor graphically re

5. Click on 1’-0” and right-click, or type 1 and press (Enter). 

6. To set the aspect ratio of the text, click on Aspect. A value menu is 
displayed. An aspect ratio below 1.0 creates wider and fatter characters
while an aspect above 1.0 creates thinner characters. 

7. Type .75 and press (Enter). 
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Figure 4.2: The Set Text Parameters dialog box 

9. Click on ARCWY2HC.CHR. This font has a nice hand-drawn style. 

10. Click on Center to center the text within an area on the drawing. 

 To insert room names: 

1. Move the cursor to the center of the large room. You are prompted to 
“Position text using cursor, then ‘ENTER’”. 

ext. 2. Click to set the position of the t

 

2
Click the left mouse button to set
the text cursor position.

 
Figu

3. Press (CapsLock), if it isn’t already on. 

4. Type CLASSROOM. The text appears in the drawing as you type. 

5. Right-click to exit this command and return to the Text menu. 

6. Repeat steps 1 - 5 for the office, but type OFFICE in the room to the lower 
left instead of typing CLASSROOM. 

re 4.3: Positioning the text cursor 
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Figu

 To 

1. lick on Size. A value menu is displayed. 

nter). 

3. Click on Aspect. A value menu is displayed. 

(Enter) e aspect ratio to create a thinner 

5. Click on Right to align the text on the right side of the indicated 

m, between the text CLASSROOM and the 

ED FLOOR WITH 

 

8. 

re 4.4: Room labels for the classroom and office are added 

insert notes: 

To set the size of the text, c

2. Type .6 and press (E

4. Type 1.25 and press . This sets th
text. 

placement point. 

6. Click in the center of the roo
countertops. To zoom in closer to the drawing, press (PageDown). Press 
(PageUp) to zoom out. 

7. Type the following note, pressing (Enter) after each line: 

PLASTIC LAMINATE COUNTERTOP 
36” ABOVE FINISH
ADJUSTABLE SHELVES BELOW 

Right-click to exit this command and return to the Text menu. 
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6
Text cur
text just

sor location, with
ified to the right

 
F ure 4.5: The note is placed on the drawing 

Dra i

 To draw text arr

 

4. is 
he tail end of the arrow. 

6. e arrowhead location. 

ig

w ng Text Arrows in the Schoolhouse Drawing 

ows: 

1. Click on Arrows in the Text menu. 

2. Click on Size to change the arrow size. You are prompted to “Enter arrow
size”. 

3. Type .6 and press (Enter). You are prompted to “Draw arrow”. 

Click near the right side of the paragraph of text you just entered. Th
defines t

5. Click to define any bends in the tail of the arrow. 

Click to define th
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4
Click the left mouse button to define the
beginning of the tail.

5
Click the left mouse button to define
the bend of the tail.

6
Click the left mouse button to define
the point of the arrow.

 
Figure 4.6: Placing an arrow in the drawing 

7. Right-click once. The arrow is drawn. 

8. Right-click twice to return to the Edit menu. 

Editing Text in the Schoolhouse Drawing 

 To correct existing text: 

1. Click on Change in the Edit menu. 

2. Click on Text to set the text attribute you want to change. 

3. Click on Contents to change or edit the words in existing text. 

4. Click on Area to select the text with a window box. 

5. Click below and to the left of the text paragraph. 

6. Move the mouse diagonally until the rubberband box completely encloses 
the entire note and click. The first line of text is displayed in the Message 
Area. 
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6
Click the left mouse button to close the
rubberband box.

5
Click the left mouse button to start the
rubberband box.

 
.7: Changing text Figure 4

ection, pressing (Enter) when 

CER

ected and the second line of text is displayed in 

8. Press (Enter) to accept the second line as it is. The third line of text is 
pt. 

pt the third line as it is. 

 

11. extents of the drawing. 

 

Dimensioning the School
In an ar of 
dim
stan

 To set up to dimension: 

u in 

ear. The Linear menu is displayed. 

7. Type over the text to make the following corr
you’re finished: 

AMIC TILE COUNTERTOP 

 The first line of text is corr
the prompt. 

displayed in the prom

9. Press (Enter) to acce

10. Right-click twice to return to the Edit menu. 

Click on E to view the 

12. Press (Ctrl) + (S) to save your drawing. 

house Drawing 
chitectural office, there are many factors that determine the type 

ension used for a project. In this section of the tutorial, you will insert 
dard linear dimensions in the schoolhouse floor plan. 

1. Press (Tab) until the Dim layer is the active layer in the Status Area. 

2. Click on Dmension in the Utility menu to display the Dimension men
the Menu Window. 

3. To draw linear dimensions, click on Lin
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Draw horizontal, vertical, aligned,
or rotated dimensions

Set the text, line, and arrow
styles for dimensions

Menu currently displayed in
Menu Window

  
Figure 4.8: Linear dimension menu 

4. Click on TextStyl to change the current text style or settings. 

extStyl menu to change the font. 

Drawing a String o

 

2. Move the cursor to the lower left corner of the exterior wall and click the 
he 

ct second point of distance to 

th 

5. Click on FontName in the T

6. Click on ARCWY2HC.CHR to match the font style of the notes. 

7. Right-click to return to the Linear menu. 

f Dimensions: 

To draw a dimension string: 

1. Click on Vertical to draw vertical dimensions. You are prompted to 
“Select first point of distance to dimension”. 

middle mouse button or press (N) on the keyboard to object snap to t
corner. You are prompted to “Sele
dimension”. 

3. Move the cursor to the snap point of the window shown in Figure 4.9, 
and click the middle mouse button to snap to it. You are prompted wi
“Dimension which side of line?” 
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3
Click the middle mouse button to
define the second point of distance
to dimension.

2
Click the middle mouse button to set
the start of the dimension line.

.

 
Figure 4.9: Placing the first dimension on the drawing 

4. Move the cursor to the outside of the wall and click. 

5. Click on StrngLin to continue drawing dimensions in a stringline. You are 
prompted to “Select next point to dimension to”. 

6. Move to the snap point of the middle window and click the middle 
mouse button to snap to the next point to dimension to. You are 
prompted to “Select next point to dimension to”. 

7. Move to the snap point of the last window and click the middle mouse 
button to snap to the next point to dimension to. 

8. Click the middle mouse button to select the corner of the wall, which is 
also the end of the stringline. 

9. Right-click to exit the Stringline menu and return to the Linear menu. 

4
Click the left mouse button to define
the outside of the wall. The first line
is drawn.

6
Click the middle mouse button to
define the next point to dimension
to.

7
Click the middle mouse button to
define the next point to dimension
to.

8
Click the middle mouse button to
end the stringline.

 
Figure 4.10: Defining a stringline of dimensions 

10. Click on Overall in the Linear menu to place an overall dimension of the 
stringline. 
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11. Right-click twice to return to the Utility menu. 

  
Figure 4.11: The stringline and overall dimensions are drawn 

Automatic Dimensioning 
You can also use automatic dimensioning; follow the steps below to use this 
second method of adding dimensions to your drawing. 

 To use automatic dimensioning: 

1. Click on Dmension in the Utility menu. The Dmension menu is displayed 
in the Menu Window. 

2. Click on Linear. The Linear menu is displayed. 

3. Click on AutoStyl to change the current automatic dimension settings. 

4. Click on OnlyPnts to search and dimension to points only. 

5. Click on LyrSrch to enable layer searching. All of the layers will be 
searched for points to dimension. 

6. Click on MissDist to set the distance to look for snap points. 7. Click 
on 1” and right-click, or type .1 and press (Enter). 

8. Right-click to exit the Auto Style menu and return to the Linear menu. 

9. Click on Horizntl to draw horizontal dimensions. 

10. Click on AutoDim. You are prompted to “Select first endpoint of line to 
dimension along”. 

11. Move the cursor to the bottom left corner of the exterior wall and click the 
middle mouse button or press (N) on the keyboard. You are prompted to 
“Select second endpoint of line to dimension along”. 

12. Move the cursor to the bottom right corner of the exterior wall and click 
the middle mouse button. You are prompted with “Dimension which side 
of line?” 
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11
Click the middle mouse button
to define the beginning of the
dimension line.

12
Click the middle mouse button to

define the end of the dimension line.

 
Figure 4.12: Selecting the points of your automatic dimension line 

13. Move the cursor below the bottom wall and click. The dimension string is 
drawn automatically. 

14. Right-click to return to the Linear menu. 

15. Click on Overall to place an overall dimension. The front wall is 
dimensioned. (See Figure 4.13) 

16. Right-click three times to return to the Edit menu. 

  
Figure 4.13: The front wall is dimensioned 

Stretching Dimensions 

 To stretch dimensions: 

1. Click on Stretch in the Edit menu. You are prompted to “Select the first 
point of distance to stretch”. 
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2. Click anywhere on the drawing window to locate the first point of the 
lect the second point of 

4. Type 1.6 and press . You are prompted to “Enter relative angle”. 

ss (Enter). The distance and angle to stretch appear in the 
Message Area. 

6. Click on Area as the selection method. You are prompted to “Select first 

8. Click outside the upper-left corner of the plan. 

ouse until the rubberband box encloses the rear 

10.  

distance to stretch. You are prompted to “Se
distance to stretch”. 

3. Press (Spacebar). You are prompted to “Enter relative distance”. 

(Enter)

5. Type 270 and pre

corner of box to <STRETCH>”. 

7. Make sure LyrSrch is on. 

9. Diagonally move the m
wall and part of the left and right walls. (See Figure 4.14) 

Click to close the rubberband box. The walls are shortened by 1’-6” and
the dimensions are automatically adjusted. 

 

8
Click the left mouse button to
start the rubberband box.

10
Click the left mouse button to
close the rubberband box.

Figure 4

11. 

 
ses the inverse of the defined angle. 

12. Repeat steps 8 - 10 to return the wall to its previous shape. 

 
.14: Stretching the rear wall 

Click on Invert to stretch the same distance in the opposite direction. The 
new angle is displayed in the Message Area. You are prompted to “Select 
first corner of box to <STRETCH>”. You can use Invert for most editing
commands. It u
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Figure 4.15: The plan is dimensioned 

13. Right-click to return to the Edit menu.  

 

You  of a 
real  from 
many d

Ha h
Hatchin
boxes t re are 
many h

 

1. Press (Tab) until the Hatch layer is the active layer in the Status Area. 

 in the Utility menu. 

14. Press (Ctrl) + (S) to save the drawing. 

 have dimensioned the schoolhouse plan. Floor plans for construction
 building would, of course, require more dimension lines as well as lines

ifferent angles. You can use DataCAD to create them all. 

tc ing the Schoolhouse Drawing 
g is adding lines to your drawing that are in patterns, such as square 
hat represent floor tile, for example. As you will soon find out, the
atch patterns: to choose from. 

To set up to draw a tile hatch pattern: 

2. Click on Hatch
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Select the entities to be hatched

Define a boundary, point by point,
to infill with hatch

Settings that affect the appearance
of the hatch

Menu title

 
Figure 4.16: The Hatch menu 

e 
 

hatch pattern name”. A list of hatch patterns is displayed in the Menu 
yed in the Drawing Area. 

e buttons in the Menu Window. Notice that 
ttern are displayed in the preview window as your 

d to go to the WindowIn menu. You 
are prompted to “Select first corner of the Zoom window”. 

e exterior wall. You are prompted to 

3. Click on Associat to toggle associative hatching on. This creates the entir
hatch as a single entity. See “Drawing Associative Hatch” in the “Hatch”
chapter for details. 

4. Click on Pattern to select a hatch pattern. You are prompted to “Enter 

Window, and a preview window is displa

5. Move the cursor over th
examples of each pa
cursor passes over the pattern name. 

6. Click on ScrlFwrd three times to scroll to the end of the list. 

7. Click on 12x12til to select a 12”x12” tile pattern. 

8. Click on Scale to set the scale of the pattern. You are prompted to “Enter 
hatch scale (1 to 9999)”. 

9. Type 1 and press (Enter). 

10. Click on Angle to set the angle of the pattern. You are prompted to “Enter 
hatch angle”. 

11. Type 0 and press (Enter). 

 To draw a tile hatch pattern: 

1. Click on W from the Navigation Pa

2. Click below and to the left of th
“Select second corner of the Zoom window”. 
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3. Diagonally move the mouse until the rubberband box encloses the lower 

e Hatch menu. 

h. You are prompted 

ing to select points for the hatch boundary. To 
e boundary, move the cursor to the lower-left 

 
e information on 

object snapping, see “Object Snapping” in the “Drawing Tools” chapter. 

t: 

half of the plan and click. The plan now is displayed larger. 

4. Right-click to return to th

5. Click on Origin to start the hatch pattern at a defined point. You are 
prompted to “Select hatch pattern origin”. 

6. Move the cursor to the lower-left corner of the hall and click the middle 
mouse button. 

7. Click on Boundary to define a boundary for the hatc
to “Select first point on boundary to hatch to”. 

8. You will use object snapp
select the first point of th
corner in the hall and click the middle mouse button. You are prompted
to “Select next point on boundary to hatch to”. For mor

Shortcu Press (N) to object snap to a point. 

9. Move the cursor upward, and click the middle mouse button to object 
snap to the corner marked A with. (See Figure 4.17) 

10. Move the cursor close to the corner marked B and click the middle mouse 
button to object snap to that point. 

 

 

e the hatch boundary. 

11. Move the cursor close to the corner marked C and object snap to that 
point. 

12. Right-click to clos

8
Click the middle mouse button
to start the hatch boundary.

9-12
Click the middle mouse button to
select these three points. After
object snapping to the corner
marked C, click the right mouse
button to close the boundary.

A
B

C

 
Figure 4.17:

13. 
defined in the previous steps. 

the drawing. 

 to the Utility menu. 

 Selecting a hatch boundary 

Click on Begin to draw the hatch pattern. The pattern will fill the 
boundary you 

14. Click on R to recalculate the extents of 

15. Right-click to return

16. Press (Ctrl) + (S) to save the drawing. 
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Figu is drawn 

You tch pattern and saved your updated drawing file.  

Addi
Symbo of DataCAD. You can build 
sym
The sym
drawing that will be drawn repetitively. 

You  and each template usually contains 
symbols that ar
com
located

Op

 

-left corner of the exterior wall. You are prompted to 
er of the Zoom window”. 

4. 

ATACAD\TPL folder. 

 plumbing fixture templates. 

is displayed in a grid on the right 

8. Move the cursor over the template window; as you move the cursor over 
a symbol, a description of the symbol is displayed in the Message Area. 

re 4.18: The tile hatch 

 have now created a ha

ng Symbols to the Schoolhouse 
ls are one of the most powerful features 

bol libraries from the drawings you create and reuse them in other drawings. 
bols can be sections, details, notes, furniture, fixtures, or any part of a 

 usually store symbols in templates,
e in some way related to one another. For example, if you have 

mon bathroom configurations, each saved as a symbol, they can all be 
 in the same template. 

ening a Template Folder 

To open a template folder: 

1. Click on W in the Navigation Pad to open the WindowIn menu. You are 
prompted to “Select first corner of the Zoom window”. 

2. Click at the lower
“Select second corn

3. Move the mouse diagonally until the rubberband box encloses the lower 
half of the plan and click. The plan is now displayed larger. 

Right-click to return to the Utility menu. 

5. Click on Template in the Utility menu. A dialog box is displayed, listing 
the template folders in your D

6. Click on the Plumb folder to list the

7. Click on BP2COM1.TPL. The template 
side of the screen. Each box contains a symbol. 
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Menu Title

Select a new
template file to open.

Select a symbol to
place in drawing

Allows you to rotate
a symbol before it is
placed.

Symbol will be
entered into the
drawing as
individual entites,
not databased.

 
Figure 4.19: The Template menu and an open template 

Selecting and Placing Symbols 

 To select and place symbols: 

1. Press (Tab) until Plumb is the active layer in the Status Area. 

2. Click on DynamRot to toggle dynamic rotation on. This allows you to 
preview a symbol’s position before you place it in the drawing. 

3. Move the cursor over the toilet with grab bars (HC Toilet in the left 
column of the template) and click to select it. 

4. Move the cursor into the Drawing Area. A boxed outline representing the 
toilet and grab bars is now attached to your cursor. The insertion point is 
at the upper-left corner of the symbol, the point the cursor is connected 
to. Remember, you can use the arrows on the keyboard to pan around 
your drawing. 

5. Position the cursor near the upper-right corner of the room that is in the 
lower-right corner of the plan, and click the middle mouse button. This is 
the insertion point and the center of rotation for the symbol. If you move 
your cursor slightly up or down, you will see the boxed outline rotate 
around the insertion point. 

6. Position the cursor near the lower-right corner of the bathroom and click 
the middle mouse button. The toilet with grab bars is drawn. If you place 
the toilet incorrectly, click on Undo in the Edit pull-down menu to delete 
it and then place the toilet again. 
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5
Click the middle mouse button to
define the insertion point.

6
Move the cursor down and to the right away
fromthe insertion point, and click the middle

ce.

 
Figu

toilet symbol. 

mouse button to set the symbol into pla

re 4.20: Placing the toilet on your plan 

7. Right-click to cancel the 

 
Figu ing 

9. he cursor into the Drawing Area. A boxed outline representing the 
n point for this symbol is 

  hallway 

re 4.21: The toilet and grab bars are placed on the draw

8. Move the cursor over the WALL-HUNG SINK (top left symbol in the 
template) and click on it to select it. 

Move t
sink is now attached to your cursor. The insertio
in the back center of the sink. 

10. Position the cursor at the center point, between the window and
wall, as shown in Figure 4.22. Click the middle mouse button. 
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10
Click the middle mouse
button to define the
insertion point for the sink.

 
Figure 4.22: Placing the sink in your drawing  

11. t 
and clicking when it is in place. The sink is drawn. If you place the sink 
incorrectly, click on Undo in the Edit pull-down menu to delete it and 
then place the sink again. 

Rotate the symbol by dragging the cursor away from the insertion poin

 
Figure 4.23:

 

13. 

Select

  select another template file: 

1. 

2. n the KITCHEN folder to view a list of Kitchen templates. 

as shown in the 

sink. 

 The sink is drawn 

12. Right-click to cancel the sink symbol. 

Press (Ctrl) + (S) to save the drawing. 

ing Another Template File 

To

Click on NewFile in the Template menu to switch to a new template file. 

Click o

3. Click on KT2EQIP1 from the dialog box. The grid is updated with the 
new template. 

4. Select the bar sink (upper left in the template) and place it 
figure below. Refer to the previous section if you need help placing this 
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Place the kitchen sink, and
rotate into place.

 
Figure 4.24: The kitchen sink is drawn 

5. Click on TemplOff to close the Template window and return to the Utility 
menu. 

6. Right-click to go to the Edit menu. 

Copying Symbols 

 To copy symbols: 

1. Click on Copy in the Edit menu in the Menu Window. You are prompted 
 the distance to copy”. 

point to copy from. You are prompted to “Select second point of distance 

he 
use button. The distance and angle you 

just defined are displayed in the Message Area. 

to “Select first point of

2. Move the cursor to the upper-right corner of the bathroom you just 
placed fixtures in, and click the middle mouse button to define the first 

to copy”. 

3. Move the cursor to the upper-right corner of the room directly above t
bathroom and click the middle mo

2
Click the middle mouse button to
define the first point of distance to
copy from.

3
Click the middle mouse button to define
the second point of distance to copy
from.

 
Figure 4.25: 

 You are prompted to “Select first 

ft of the bathroom sink. You are prompted to “Select 
>”. 

Defining a distance to copy 

4. Click on Area if it’s not already active.
corner of area to <COPY>”. 

5. Click on LyrSrch to toggle layer searching off and search only the active 
layer for items to copy. 

6. Click at the lower le
second corner of area to <COPY
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7. Diagonally move the mouse to the upper right of the toilet and grab b
until the area box encloses all bathroom fixtures and their insertion 
points. 

ars, 

 8. Click to close the box. The sink, toilet, and grab bars are copied into the
other bathroom. 

 

8
Click the left mouse button to close the
area box.

6
Click the left mouse button to start the
area box.

 
Figure 4.26: Selecting the bathroom fixtures to copy  

9. Click on R to recalculate the extents of the drawing. 

  
F r bathroom igure 4.27: The bathroom fixtures are copied to the othe

t 

d border: 

2.  option off. Note the w in SwOTHLUD in the 

4. ngl to draw a rectangle. 

the drawing where you want 
If necessary, press (PageUp) once to zoom out 

rk around your drawing. 

10. Right-click to return to the Edit menu. 

11. Press (Ctrl) + (S) to save the drawing. 

Drawing a Title Block and Border 
To complete the schoolhouse plan, you will create a simple border that will plo
with the floor plan. The paper size will be 8 1/2” x 11”. 

 To draw a title block an

1. Press (Tab) until Border is the active layer in the Status Area. 

Press (=) to toggle the Walls
Status Area is now lowercase. 

3. Click on Polygons in the Edit menu in the Menu Window. 

Click on RectA

5. Move the cursor to the lower-left corner of 
the border to start and click. 
and give yourself more space to wo
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5
Click the left mouse button to define the first
corner of the border.

  
Figu

7. 

distance”. 

11. 

2. Click on Drag. 

k 
o 

t you can now move the border by moving the mouse. 

re 4.28: Creating a border 

6. Press (Insert) until the prompt in the Message Area reads “Current input 
mode = relative Cartesian (x, y)”. 

Press (Spacebar). You are prompted to “Enter relative X-distance”. 

8. Type 80 and press (Enter). You are prompted to “Enter relative Y-

9. Type 60 and press (Enter). The border is drawn. 

10. Right-click to return to the Edit menu. 

Click on E to view the extents of the drawing. 

Moving the Border 

 To mover the border: 

1. Click on Move in the Edit Menu. 

3. Click on Group. You are prompted to “Select group to <MOVE>”. 

4. Move the cursor to the center of the rectangle you just created and clic
the middle mouse button. The rectangle is displayed in dashed lines t
indicate its selection. You are prompted to “Select the point to drag from”. 

5. With the cursor still at the center of the rectangle, click the middle mouse 
button. Notice tha
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6. Press (O) to turn off ortho mode. This allows free movement when you 

9. k twice to return to the Edit menu. 

place the border. Note the “o” in SwoTHLUD in the Status Area is now 
lowercase. 

7. Using (PageUp) or (PageDown) for a better view if you need to, move the 
border over the floor plan so the plan is displayed centered within it. 

8. Click to set the border into place. 

Right-clic

10. Click on R to recalculate the extents of the drawing. 

PLASTIC LAMINATE COUNTERTOP
36” ABOVE FINISHED FLOOR WITH
      CALL BAM.NET (BAM RULES!)

 
Figure 4.29: 

Dr

 

1. 
ce to copy”. 

 and click the 
middle mouse button. You are prompted to “Select second point of the 

ce”. 

 angle to copy are displayed in 
the Message Area. 

. You are prompted to “Select entity 

tical line of the border by clicking on it. The line is 

The border is placed 

awing a Title Block 

To draw a title block: 

Click on Copy in the Edit menu. You are prompted to “Select first point of 
the distan

2. Move the cursor to the lower right corner of the border

distance to copy”. 

3. Press (Spacebar). You are prompted to “Enter relative X-distance”. 

4. Type -5 and press (Enter). You are prompted to “Enter relative Y-distan

5. Type 0 and press (Enter). The distance and

6. Click on Entity in the Menu Window
to <COPY>”. 

7. Select the right ver
copied. 
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8. Right-click to return to the Edit menu. 

9. Press (`) to set a new reference point. 

10. Move the cursor to the lower right outside corner of the border and click 
the middle mouse button to set a new reference point. 

 

PLASTIC LAMINATE
COUNTERTOP
36” ABOVE FINISHED FLOOR
WITH ADJUSTABLE SHELVES
BELOW

7
Click the left
mouse button to
copy this line.

10
Click the middle
mouse bu

ew
tton to

set a n
reference point.

 
Figure 4.30: Completing the title block 

11. Press (Spacebar). You are prompted to “Enter relative X-distance”. 

12. Type 0 and press . You are prompted to “E(Enter) nter relative Y-distance”. 

ss (Enter). You connect to a point on the right line of the 
border. 

cebar) ompted to “Enter relative X-distance”. 

15. Type -5 ess . You are prompted to “Enter relative Y-distance”. 

16. . 

 

18. 

20. dCopy. You are prompted to “Select entity to <MOVE>”. 

elect the point to drag from”. 

 mouse button. 

23. Press (O) to toggle ortho mode on. 

24. 

25. urn to the Edit menu. The title block is 

13. Type 5 and pre

14. Press . You are pr(Spa

 and pr (Enter)

Type 0 and press (Enter). A line is drawn

17. Right-click to disconnect from the line and return to the Edit menu. 

Click on Move in the Edit menu. 

19. Click on Drag. 

Click on An

21. Select the line you just drew by clicking on it. The line becomes dashed. 
You are prompted to “S

22. Select an end point of the dashed line with the middle

Move the cursor upwards and click to place the line in a few different 
locations to section off the title block, as in Figure 4.31. 

Right-click three times to ret
drawn. 
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PLASTIC LAMINATE COUNTERTOP
36” ABOVE FINISHED FLOOR WITH
ADJUSTABLE SHELVES BELOW

  
Figure 4.31: The drawing with title block 
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Tutorial: Printing a Drawing 
DataCAD has many options available for plotting or printing 
your drawing. This chapter will focus on printing your plan on 
an 8 1/2” x 11” sheet of paper. 

5 
In this chapter: 

 Printing the schoolhouse 
drawing 

 Setting printing options 
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Printing the Schoolhouse Drawing 
If you are not in DataCAD, start DataCAD now. Choose the drawing you worked 

evious tutorials. Before plotting the schoolhouse floor plan, make 
re: 

• a printer or plotter is either connected to your computer or available via a 
network connection 

• the printer or plotter is turned on and is online or ready to receive data 

• you have the corresponding Windows driver for your printer installed on 
your computer (see your printer’s manual for more information about 
installing a printer driver) 

 To plot the schoolhouse: 

1. Choose Print from the File pull-down menu in the Menu Bar, or choose 
Plotter from the Utility menu in the Menu Window. The following 
message is displayed: A printer has not yet been selected for this drawing. 
Please click OK to open the Print Setup dialog box and assign a printer to this 
drawing file. Since this is the first time you’ve printed this drawing, 
DataCAD requires you to choose a printer, paper size, and orientation 
before you assign pens, complete a print layout, and plot your drawing. 
To accept the default settings, click OK and skip to step 5; otherwise, 
continue with step 2 below. 

2. In the Printer/Plotter Settings dialog box, choose a printer from the 
Printer Name drop-down box. 

3. Choose a paper size. The sizes available are read from your printer driver. 
If a size you want is not displayed in the drop-down box, your printer 
may not support it. Choose the closest appropriate size or use the User-
Defined option if available, or use a different printer. 

4. Click OK to close the Settings dialog box. The Plotter menu is displayed 
in the Menu Window. You can exit DataCAD and open the printer driver 
to see what paper sizes are supported.  Many times, the default settings of 
the driver do not include all supported sizes. You must check them to 
activate them. 

on in the pr
su
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Prints the current 
drawing layout 

Accesses the pen table 
dialogue box

Calls up a multi-
scale plotting sheet

Accesses the print set up 
dialogue shown at right

Menu title
 

Figure 5.1: The Plotter menu and Printer/Plotter Settings dialog box 

5. Choose Scale to set the plotting scale. The current plotting
displayed in the Message Window.  

6. Choose 1/8” if it’s not already the current plotting scale. 

7. Choose QwkLyout from the Plotter menu. A dashed box a
representing the 8 1/2” x 11” sheet. If you move the cur

 scale is 

ppears 
sor over the 

Drawing Window, you will find a movable copy of this box. You are 
prompted: Locate sheet of paper using cursor, “ENTER” to end.  

8. With the box centered over the drawing, click the middle mouse button. 
This object snaps to the center of the title block (the centered point of the 
rectangle) and centers the title block. You can also move the box 
anywhere you want and click with the left mouse button. 

9. Choose Plot to send the drawing directly to the plotter or printer. The 
schoolhouse floor plan is plotted. 

Printing Options 
There are many printing options that help you get the plotted output you want. 
In the next set of exercises, you will use a few of the images that were created in 
this book to build a plot that contains multiple drawings. Each drawing added to 
the plot can be set to a different scale. 

Assigning Pens 

Use Pen Assignments in the Pen Table dialog box to set a hierarchy of line 
weights, which help add line definition to your drawings. For example, if your 
walls were a heavier line weight than your doors and windows, the door and 
window openings would appear clearer. This difference in line weight helps 
define the content of your drawing. 
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 To set the pens for printing the schoolhouse drawing: 

able. 

 

 white lines 
in your drawing. 

4. Type 1 in the input box. The color white is now set for pen number 1.  

5. Select Red in the Pen Assignments box or press (¥) to highlight Red. 

6. Type 3 in the input box. The color red is now set for pen number 3.  

7. Set the remainder of the colors: for Green use pen 1, for Cyan use 3, for 
Magenta use 3, for Brown use 4, for Lt. Grey use 4, for Lt. Red use 2, for 
Lt. Green use 3, and for Yellow use 2. 

8. Click OK to save the pen assignments and close the Pen Table dialog box. 

9. Right-click to return to the Utility menu. 

Using Multi-scale Plotting 

The GotoViews menu will help you automate the viewing process which, in turn, 
is used with multi-scale plotting to place differently scaled details on the same 
sheet. You can choose GotoView in the Utility menu, in the 3DViews menu, or 
from the View pull-down menu to assign an unlimited number of views. Each 
view can have its own set of assigned layers. For example, in this schoolhouse 
tutorial, there are 14 different layers. If you want to view only the Walls, Doors, 
and Windows layers, you can create a view using GotoView with only these 
three layers visible. When you choose that view, all layers except Walls, Doors 

 be toggled off. Choose another predefined view 
to turn on a different set of layers. Using GotoView, you can quickly change your 

oose Orthographic from the View pull-down menu for plan view. 

2. Recalculate the extents of the drawing. 

1. Choose Plotter. 

2. Choose PenTable to open the Pen Table dialog box. In the Pen 
Assignments section, you will assign pen numbers to match the colors 
used in the drawing. You’ll notice that the first color in the Pen 
Assignments list box is highlighted. 

The Pen Table dialog box also includes a Pen Settings section that allows 
you to choose the pen width, color, and color density for each pen you 
assigned in the Pen Assignments portion of the dialog box. See “Using 
Pen Tables” in the “Printing Your Drawing” chapter for detailed 
information on using the Pen T

3. Select White in the Pen Assignments box, if it’s not already highlighted.
Notice that just below this list box is a small box displaying the 
highlighted color, followed by an equal sign and a number in a small 
input box. This number is the pen that will be used to plot all

and Windows will automatically

view and continue working. 

The GotoView option is a helpful tool to use when you have a drawing that 
contains floor plans, elevations, sections, and 3D models. In the following steps, 
you will establish two views, which help complete the remainder of this 
schoolhouse project. 

 To create views: 

1. Ch
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3. Choose GotoView from the View pull-down menu. 

rs, 3DRoof, and 3DMisc layers off. 

yers and 2D layers, use the GotoView 
e the views you just set. 

 To 

Layers menu. 

2. menu. 

3. n 
 the View pull-down menu in 

the Menu Bar. 

the Utility menu. 

You are prompted: Locate 
 to end. 

 

ess (Enter). 

10.  

11. Choose GotoView. 

from the View pull-down menu in 

14. 

15. Choose MltLyout. 

4. Choose Add View. You are prompted: Enter name of new view? 

5. Name the view 3DPlan. 

6. Toggle the Doors, Windows, Plumb, Dim, Hatch, and Notes layers on. 

7. Toggle 3DWalls, 3DWindow, 3DDoo

8. Recalculate the extents of the drawing. 

9. Choose GotoView from the View pull-down menu. 

10. Choose Add View. You are prompted: Enter name of new view? 

11. Name the view 2DPlan. 

When you need to switch between 3D la
menu. In the next section, you will us

use multi-scale plotting: 

1. Press (L) to go to the 

Make Border the only active layer using ActvOnly from the Layer 

Recalculate the extents of the drawing by clicking on R on the Navigatio
Pad or by choosing WindowIn Recalc from

4. Right-click to return to 

5. Choose Plotter. 

6. Choose MltLyout. 

7. Choose Layout. The drawing appears as a box attached to the cursor; the 
dashed box represents the 8 1/2” x 11” sheet. 
detail on sheet of paper, “ENTER”

8. Center the drawing in the dashed box and click to set the title block in
place. You are prompted: Enter name of new detail: detail 1. 

9. Type Titleblk and pr

Right-click twice to return to the Utility menu.

12. Choose 2DPlan. Right-click once. 

13. Recalculate the extents of the drawing by clicking on R on the Navigation 
Pad or by choosing WindowIn Recalc 
the Menu Bar. 

Choose Plotter from the Utility menu. 

16. Choose Layout. The drawing appears as a box attached to the cursor; the 
dashed box represents the 8 1/2” x 11” sheet. You are prompted: Locate 
detail on sheet of paper, “ENTER” to end. 
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17. Center the drawing over the dashed box and click the left mouse button 
2. 

18. . 

 n 
u in 

 

21. 

 

24. 

 e 
te 

26.  
: Enter name of new detail: detail 

3. 

 tion 
wIn Recalc from the View pull-down menu in 

 

 

31. or. You can press (PgUp) and (PgDn) to 
. 

33. Choose MltLyout. 

appears as a box attached to the cursor and 
re 

er-right quarter of the dashed box. Click to 
set the perspective in place. 

36. Add a new detail named Perspect. 

37. menu. 

 

to position the plan. You are prompted: Enter name of new detail: detail 

Type Plan and press (Enter)

19. Recalculate the extents of the drawing by clicking on R on the Navigatio
Pad or by choosing WindowIn Recalc from the View pull-down men
the Menu Bar. 

20. Make FrntElev the only active layer. The elevation that was created earlier 
is now on the screen. 

Choose Plotter from the Utility menu. 

22. Choose Scale to change the scale factor. 

23. Choose 1/16”. 

Choose MltLyout. 

25. Choose Layout. The drawing appears as a box attached to the cursor; th
dashed box represents the 8 1/2” x 11” sheet. You are prompted: Loca
detail on sheet of paper, “ENTER” to end. 

Move the drawing into the upper-right quarter of the dashed box. Click to
set the elevation in place. You are prompted

27. Type FrntElev and press (Enter). 

28. Recalculate the extents of the drawing by clicking on R on the Naviga
Pad or by choosing Windo
the Menu Bar. 

29. Make Hide1 the only active layer. 

30. Choose Plotter from the Utility menu. 

Choose Scale to change the scale fact
change the scale of any detail on-the-fly before you place it on the sheet

32. Choose 1:20. 

34. Choose Layout. The drawing 
the dashed box that appears representing the 8 1/2” x 11” sheet. You a
prompted: Locate detail on sheet of paper, “ENTER” to end. 

35. Move the drawing into the low

Return to the Plotter main 

38. Choose Plot to send the drawing directly to the plotter.  



Tutorial: Modeling 
Thi
use
keep this exercise simple, and to help you understand a little 
abo
(plan) view and then use the 3DViews menu to view your 

6 
apter: 

ndows and 
doors 

 Adding a roof 

 Viewing the model in 

s chapter guides you through some of the more commonly In this ch
d macros to help you complete the schoolhouse. In order to 

 Adding 3D wi
ut 3D spatial relationships, you will work in orthographic 

work. 
3D 
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Mo
You wi e 
drawin
used for construction documentation, and 3D drawings, used to present your 
designs. 

 To a

1. 

3. ow, 3DRoof, and 
3DMisc. 

. 

Adding W
You ced 
in your ; they are an essential part of your drawing 
file

 

2. 

3. g component to 

nitType. You are prompted: Select type of window unit. 

s. 

9. lass menu. 

 
l direction. 

 

12. 
. You are prompted: Number of panes in the vertical direction. 

 

deling the Schoolhouse 
ll create five new layers for the 3D items that you are going to add to th
g. This enables your drawing file to contain both your plan drawings, 

dd layers to your drawing: 

If you are not in DataCAD, start DataCAD now and choose the drawing 
file that you worked on in the previous chapters. 

2. Add five new layers to your drawing file. 

Name the new layers: 3DWalls, 3DDoors, 3DWind

4. Go to the Layers menu

5. Turn off Doors, Windows, Plumb, Dim, Hatch, Notes, Misc, and Border. 

6. Press (Esc) on the keyboard to refresh the drawing display. 

7. Window in on the lower half of the plan. 

indows 
 will work with the walls, doors, and windows that you have already pla

 drawing. Do not erase them
. 

To add windows: 

1. Make the 3DWindow layer the active layer. 

Choose Toolbox from the Edit menu. 

Choose AEC_MODL. You are prompted: Select buildin
model. 

4. Choose Windows to go to the WindElev menu. 

5. Choose In Plan to draw the windows in plan view. 

6. Choose U

7. Choose DblHung to draw double-hung window

8. Return to the WindPlan menu. 

Choose Glass to go to the G

10. Choose PaneHorz to define the number of glass panes (divisions) across 
the window. You are prompted: Number of panes in the horizonta

11. Choose 3. 

Choose PaneVert to define the number of glass panes top to bottom in the 
window

13. Choose 2. 
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14. Return to the WindPlan menu. You are prompted: Enter a point on first 

ou are prompted: Enter a point on outside surface of wall.  

dle mouse button on the outside of the wall. The window is 

inside corner of window. 

15. Click the middle mouse button on an inside corner of the front window 
opening in the office. You are prompted: Enter a point on second inside 
corner of window.  

16. Click the middle mouse button the other inside corner of the window 
opening. Y

17. Click the mid
created. 

15
Click the middle mouse
button to define the first
inside corner of the
window.

16
Click the middle mouse
button to de
inside c

fine the other
orner of the window.

17
Click the middle mouse
button to define the
outside corner of the

Figure 6

18. 7 to create the remaining windows. Remember that you 
can use the arrow keys on the keyboard to move around the drawing. 

window.   
.1: Placing windows 

Repeat steps 15 - 1

  
Figure 6.2: The 3D windows are drawn. 

19. When you are finished placing windows, return to the AEC_MODL 

. 
ner of door. 

menu. 

Adding 3D Doors 

 To add doors: 

1. Make 3DDoors the active layer. 

2. Choose Doors from the AEC_MODL menu to go to the DoorPlan menu
You are prompted: Enter a point on first inside cor
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3. Move the cursor to an inside corner of the door opening in the office and 

4. Move the cursor to the other inside corner of the door and click the 
ou are prompted: Enter a point on outside surface of 

5. ide corner of the wall and click the middle 

6. u are prompted: Select door data to change. 

. 

8. 

9. 

click the middle mouse button. You are prompted: Enter a point on second 
inside corner of door.  

middle mouse button. Y
wall.  

Move the cursor to the outs
mouse button. The first door is created. 

Choose Door. Yo

7. Choose HingLft to change the hinge side of the front door to the left side

Return to the DoorPlan menu. 

Repeat steps 3 - 5 for the remaining doors. 

 

3
Click the middle mouse
button to define the first
inside corner of the door.

4
Click the middle mouse
button to define the other
inside corner of the door.

5
Click the middle mouse
button to define the
outside surface of the
wall.

 
door Figure 6.3: Placing the first 

10. Return to the Edit menu. 

11. Recalculate the extents of the drawing. 

  
Figure 6.4: The doors are drawn. 
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The

Viewi
Choose
viewing techniques later in this chapter

re are many other options you can use when placing doors and windows.  

ng the 3D Model 
 Isometric from the View menu on the Menu Bar. You will learn more 

. 

  
Figure 6.5: An isometric view of the schoolhouse walls, windows, and doors 

Adding a 3D Roof 
As mentioned throughout this book, layers allow you more control over y
drawing. Later in this section of the Tutorial you will use these different layers
switch between viewing construction plans and presentation graphics. 

 To add a roof: 

our 
 to 

portant to select the points of the roof boundary in a 
clockwise direction to ensure that the roof will be placed correctly. 

er-left corner of the exterior wall with the middle mouse 

. You are prompted: Enter second point of roof width.  

1. Change to the 3DRoof layer. 

2. Change the color of the 3DRoof layer to Magenta. 

3. Choose Toolbox from the Edit menu. 

4. Choose ROOFIT from the dialog box to go to the RoofIt menu. 

5. Choose Gable to create a gable roof. 

6. Choose Settings. 

7. Set the wall thickness to 1 foot. 

8. Return to the RoofIt menu. You are prompted: Pick the 1st point of roof 
boundary. It is im

9. Select the low
button. You are prompted: Enter second point of roof length.  

10. Select the upper-left corner of the exterior wall with the middle mouse 
button

11. Select the upper-right corner of the exterior wall with the middle mouse 
button. The roof appears on top of the walls. 

12. Return to the Edit menu. 
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13. Choose Isometric from the View menu on the Menu Bar to view the 
drawing in isometric. 

  
Figure 6.6:

Finishing the Schoolhouse Drawing 
Notice that in the isometric view, portions of the wall above and below the 

ou will fix them in the next exercise, but these wall 

 the View menu on the Menu Bar to view the 

2.  the Utility menu in the Menu Window. 

ers 

. 

6. 

 Z-height. 

 the lower half of the plan. 

 An isometric view of the schoolhouse with the new roof 

windows are missing. Y
segments are going to be put on a different layer than the existing Walls layer. 
Later in this chapter, you will see the reason for having two wall layers. 

 To finish the drawing: 

1. Choose Orthographic from
schoolhouse in plan view. 

Choose Layers from

3. Make 3DWalls the active layer, with only walls turned on. All other lay
should be off. 

4. Change the 3DWalls layer color to yellow

5. Toggle the Walls option on. 

Toggle the 2-line wall option on. 

7. Set a new wall width of 1 foot. 

8. Toggle Outside on. 

9. Toggle Cap off, if it is on. 

10. Press (Z) on the keyboard. You are prompted: Enter new Z-base. 

11. Type 0 and press (Enter). You are prompted: Enter new

12. Type 3.4 and press (Enter). You have just established a new 3D setting for 
all new items you draw. All lines will now be drawn with a Z-base of 0 
and a Z-height of 3’-4”. 

13. Window in on
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14. Return to the Edit menu. You are prompted: Select first end point of new 

15. de corner of the window opening in the office 
 

16. ner of the window and click the 

17. out 

18. Right-click to disconnect from the wall you just drew. 

5 - 18 for the remaining exterior window openings. Be sure 
ext. 

20. Press (Z) on the keyboard. You are prompted: Enter new Z-base. 

21. Type 6.8 and press . You are prompted: Enter new Z-height. 

22.  have just established a new 3D setting for all 
new items you draw. All lines will now be drawn with a Z-base of 6.8 and 

line/wall. 

Move the cursor to an outsi
and click the middle mouse button. You are prompted: Select next end
point of line/wall. 

Move the cursor to the other outside cor
middle mouse button. You are prompted: Select a point to define the Inside 
of the wall. 

Move the cursor anywhere on the inside of the plan and click. The cut
is filled. 

19. Repeat steps 1
to disconnect from each wall segment you draw, before drawing the n
Remember to use the arrow keys on the keyboard to move around the 
drawing. 

(Enter)

Type 8 and press (Enter). You

a Z-height of 8’-0”. 

 

15
Click the middle mouse
button to define the first
end point of the new wall.

16
Click the middle mouse
button to define the next end
point of the new wall.

17

he inside

 
6.7: P

Rep
hea  line/wall. 

Cli
ope

ted: Select a point to define the 

 and click. The door 
header is drawn. 

Click the first mouse
button to define t
of the wall.

Figure lacing headers and sills 

23. eat steps 15 - 18 to fill in over top of the sills to create window 
ders. You are prompted: Select first end point of new

24. ck the middle mouse button at the outside corner o f the front door 
ning. You are prompted: Select next end point of line/wall. 

25. Move the cursor to the other outside corner of the door and click the 
middle mouse button. You are promp
Inside of the wall. 

26. Move the cursor anywhere on the interior of the plan
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27. Press (=) on the keyboard. The Message Window reads Walls will NOT be 

28. mpted: Enter new wall width. 

 he 

 

31. header and the remaining interior 

32. 

ers on. 

 

35. 

Viewing Your Drawing in 3D 
Per  
draw h ation Pad opens the 
3DV

 To c

 

2. Choose Isometrc. If your drawing is not centered choose E from the 
ow appear in 3D. 

 

ric view. 

ess (Ctrl) + (S) on the keyboard to save the drawing.  

Ad n
Throug d around the drawing using a few of 
DataCAD’s 
Da
vie  3D. 

 u

1. Choose GotoView from the Utility menu. 

drawn. 

Press (=) again. You are pro

29. Type .4 and press (Enter). You are now set to draw the headers above t
interior doors. 

30. Move the cursor to an outside corner of the interior door opening in the 
office. 

Repeat steps 24 - 26 to complete this 
headers. 

Choose Isometric from the View menu on the Menu Bar to view the 
isometric view. 

33. Toggle the 3DDoors, 3DWindow, and 3DRoof lay

34. Return to the Utility menu. 

Recalculate the extents of the drawing. 

haps one of the most exciting features of DataCAD is that everything you
as 3D parameters. The V button on the Navig

iews menu. 

hange your view: 

1. Choose V from the Navigation Pad or choose DCAD 3D/3DViews from
the Edit menu to go to the 3DViews menu. 

Navigation Pad. The lines that you drew earlier n

3. Right-click twice to return to the Edit menu. 

4. Choose Orthographic from the View pull-down menu in the Menu Bar to
view your drawing in plan view. 

5. Choose Isometric to view the isomet

6. Choose Orthographic to view your drawing again in plan view. 
Switching between 2D and 3D helps you better understand what you are 
drawing. 

7. Pr

va ced 3D Viewing 
hout this tutorial you move

different viewing methods. One of the most exciting features of 
taCAD is viewing your work in 3D. This section steps you through a few 
wing exercises of 2D (orthographic) and

To se advanced viewing techniques: 
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2. Choose 3DPlan. 

3. Choose V from the Navigation Pad to go to the 3DViews menu. 

Select view type.

  
Figure 6.8:

Eac
3DView ng 
parame ch button. When you selected Isometrc when working with 
hatch earlier in the tutorial, you could choose Ortho and Parallel and view 3D 
view  

Per

 To 

2. 

3. Click at the lower left corner of the screen. You are prompted: Select 
ctive view. 

 

 The View pull-down menu 

h time you start a new drawing, the Parallel and Prspect options in the 
s menu do not do anything. They become active after you set the viewi
ters for ea

s. If you chose Prspect, nothing happened. 

spective Viewing 

create a perspective view: 

1. Press (PageUp) twice to zoom out. 

Choose SetPersp from the 3DViews menu. You are prompted: Select 
position of eye point for perspective view. 

position of center of perspe

4. Press (O) to turn ortho mode off and have more control over cursor 
movement. 

5. Click at the upper-right corner of the screen. A perspective view of the
schoolhouse appears. 
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 A perspective view of the completed schoolhouse drawing Figure 6.9:

6. 
nd the 3D model. You can also use the Viewer Toolbar in 

 a toolbar with options for walking 

stepped away from the model. 

hoose Perspective from the View pull-down menu on the Menu Bar to 

12. Choose Orthographic on the Menu Bar to view the plan view again. 

ions, all of these options display a different 

der 
nd a 3D view. The Hide option in the 3DEdit menu is used to 

hide the lines in your model that would not be visible if it were an actual 
bui

 h

1. om the Edit menu to enter DataCAD’s 3D menus: 

2. Choose Perspective from the View pull-down menu on the Menu Bar to 
display the perspective of the schoolhouse. 

3. Choose Hide. 

4. Choose Begin. The hidden line removal generates a new image without 
most of the unwanted lines. 

Choose WalkThru from the 3DViews menu. This displays a menu used 
for moving arou
the View pull-down menu to display
through perspective views. 

7. Choose WalkBack. You just 

8. Experiment with a few of the other options in this menu. 

9. Exit the 3D menu and choose Orthographic from the View pull-down 
menu on the Menu Bar to view the drawing in plan. 

10. C
view the perspective again. 

11. Choose Isometric from the View pull-down menu on the Menu Bar to 
view the isometric. 

Once you establish the viewing opt
image of the drawing. This is an easy way to change the view of a drawing 
during any stage of a project. 

Hidden Line Removal 

As you become more experienced with DataCAD, you will be adding more 
complex 3D elements to the drawing. The more you add to a drawing, the har
it can be to understa

lding. This 3D view can be saved as a layer and edited. 

To ide lines in your model: 

Choose DCAD 3D fr
3DEdit and 3DEntity. 
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5. At the completion of the hidden line removal, choose NewLyr. You are 
prompted: Enter name of new layer to be added. 

Type Hide1 and press (Enter). You are prompted: Do you want the new layer
ON or OFF? 

Choose Off. You will toggle this layer on later in the chapter. The hidden 
line removal is complete and you have added a new layer to the 

Choose Orthographic to view the schoolhouse in plan view. 

6.  

7. 
drawing. 

8. 

 

11. there are still a few lines visible that 
s 

ese lines from this view without adversely 

12. 

 

14.  

15. Return to the Utility menu. If you choose Perspective from the View pull-

the hidden line removal created a flat line drawing from the 
el. 

9. Go to Layers. 

10. Choose ActvOnly.  

Choose Hide1. You’ll notice that 
should not be there, such as the vertical lines above and below window
and doors. You can erase th
affecting your drawing. 

Choose Erase from the Edit menu. 

13. Choose Entity as the selection method for erasing lines. 

Using your mouse, select any lines on the perspective that should not be
there. 

down menu on the Menu Bar, you will see that the image is flat. This is 
because 
perspective. This drawing has no connection to the original 3D mod

  
Figure 6.10: The perspective view after a hidden line removal 

16. Choose GotoView. 

 in this chapter for more information on the 
Hide option. 

This section shows you how to create elevations from the work you have already 
completed. You will use the same procedure discussed in the Hide section for 
creating your elevations. 

17. Choose 3DPlan. 

18. Choose Orthographic to view the schoolhouse in plan view. 

See “Hidden Line Removal” later

Creating Elevations 
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 To create elevations: 

1. Choose Elevation from the View pull-down menu on the Menu Bar, and 
then select Front to display the front elevation of the schoolhouse. 

 2. Recalculate the extents of the drawing. 

  
Figure 6.11: The front elevation of the schoolhouse 

e Edit menu to go to the 3DEdit menu. 

5. 

3. Choose DCAD 3D from th

4. Choose Hide. 

Choose Begin. The hidden line removal process generates a new image 
with everything behind the front wall not shown. 

 
.12: The elevation after a hidden line removal 

At the completion of the hidden line removal, choose NewLyr. You 
prompted: Enter name of new layer to be add

Figure 6

6. are 
ed. 

7. 

8.  
d to the drawing. 

10. 

11. Choose Layers from the Utility menu. 

Type FrntElev and press (Enter). You are prompted: Do you want the new 
layer ON or OFF? 

Choose Off. You will turn this layer on later in the tutorial. The hidden
line removal is complete and a new layer has been adde

9. Choose Orthographic from the View pull-down menu on the Menu Bar 
for the plan view. 

Choose DCAD 2D to return to the Edit menu. 
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12. Choose ActvOnly. You are prompted: Select layer to be the only layer on

13. Choo

. 

se ScrlFwrd to view the end of the layer list. 

. r 

 Return to the Edit menu. 

16. 

. 

18.  as the selection method for erasing lines. 

19. Select any lines on the front elevation that should not be there. 

14 Choose Elevation/Front from the View pull-down menu on the Menu Ba
to display the schoolhouse front elevation. 

15.

Recalculate the extents of the drawing. 

17 Choose Erase from the Edit menu. 

Choose Entity

20. Return to the Utility menu. 

Experiment with a few templates, hatch patterns, etc. 

  
Figure 6.13: The schoolhouse elevation with templates and hatch 

This completes the DataCAD Tutorial. For additional instruction, please contact 
DATACAD LLC for information on training materials and support options, or 
visit us online at www.datacad.com. 
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Before You Draw 
customize how you’ll 
ent on a drawing and 

enter other administrative information directly into the drawing. The 
ptions to customize your work session, 

incl s, creating drawing passwords, 
sett he time delay for creating autosave 
files
distance

You can also set the size and angle of both the snap grid and the two 
e display grids are visible. And, 

per s r 
your dr erent 
colo o

All of 
increas
file; then change the settings, grids, and layers as you’d like 
the o
save th
Board”
drawings.) Then in the Tools/ Program Preferences dialog box, 

 default 
dra  be 
set ! 

7 
In this chapter: 

 Setting the snap grid 

 Setting the display grids 

 Creating and naming 

ween layers 

 Setting the active layer 

 Assigning colors to 
layers 

ject costing 
 

cting the scale type 
and angle type  

sswords 

 

There are many settings that you can use to 
draw in DataCAD. You can keep track of time sp

Settings menu has a variety of o
uding setting scale and angle type
ing cursor accuracy, adjusting t
, and editing the definitions of DataCAD’s scale, angle, and 

 lists. 
new layers 

 Moving bet

display grids and choose whether th
hap  most importantly, you can create and name new layers fo

awing, choose which of these will be displayed, assign diff
rs f r each, and even save them to a separate file. 

these settings can be used with default drawings to 
e efficiency and save time. First, create a new drawing 

 Entering pro
information

 Sele

m t  be set in all your new DataCAD drawings; and finally, 
e file in your default drawing folder. (See “The Drawing 
 chapter for more information about using default 

 Creating pa

set the Default Drawing File option to your new
wing. All of your customized settings will automatically
in every new drawing you create --- simply start drawing
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Mana
The Pro sis for a comprehensive management 
sys tion. You can use Directory 
to review and enter project information directly into the drawing file. You can 

oject information and time data to a text file, and even purge 
 symbol information from your drawing. Simply click on Directry in the 

own 

. 
rawing, click on Purge 

 

In the Billing Rate, Department Number
tex
input b ters; in the Employee 
text input box, you can enter up to seven alpha-numeric characters. 

ging Your Project 
ject Directory provides the ba

tem based on actual computer usage and applica

also save the pr
unused
Utility menu in the Menu Window or click on Directory in the Tools pull-d
menu in the Menu Bar to display the Directory dialog box. Even if you delete a 
symbol from your drawing, the symbol’s name will still be listed in the Directory
To purge the names of all unused symbols from your d
Symbols in the Directory dialog box.

, Phase Number, and Service Number 
t input boxes, you can enter a number from 0 to 32,000. In the Project text 

ox, you can enter up to nine alpha-numeric charac

 
Figure 7.1: The Directory dialog box 

Setting Up Your Drawing Grids 
There are three separate grids in DataCAD: a snap grid and two display grids. 

play grids, 
, are shown as a series of dots 

and help you create drawings quickly and accurately. Each layer in DataCAD has 
its own snap and display grids as well as grid origin and sizes. This lets you 
move quickly between layers without having to change grid sizes or toggle grids 
on or off. 

The snap grid controls cursor movement while drawing. The two dis
used primarily for visual reference while drawing
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Using the Snap Grid 
ou draw 

Grid Angle” later in this chapter 
for more information about the snap grid.  

Look at the X and Y coordinate display in the top line of the Message Area to see 
the a
the sna
“jumps t to the next across the snap grid.  When 
you toggle the snap grid off, the cursor advances freely across the Drawing Area, 

  

1.  Utility menu in the Menu Window and click on Grids. The 

2. SnapGrid. 

Shortcut: Press  to toggle the snap grid on or off. Note that the “S” in 

Although the snap grid doesn’t display in the Drawing Area, it helps y
more precisely. The snap grid causes the cursor to jump, or snap, from one point 
of the snap grid to the next as you move the mouse across the Drawing Area. See 
“Changing the Grid Size” and “Setting the Snap 

 ex ct coordinates of the cursor as you move it over the Drawing Area. With 
p grid toggled on, notice the coordinate display reflects the cursor’s 
” from one invisible snap poin

without snapping to grid points. 

To toggle the snap grid on or off: 

Go to the
Grids menu is displayed. 

Click on 

(X)
SWOTHLUDFB in the Status Area is displayed in lowercase when snap grid is 
toggled off and uppercase when it’s toggle on. 

Using the Display Grids 
There are two display grids in DataCAD. One is a series of white dots in the 
Drawing Area, while the second display grid is a series of small yellow crosses. 
These grids are visual aids only and can’t be printed. The display grid colors are 
white and yellow by default. However, you can change these colors; see 
“Changing Display Grid Color” later in this chapter. 

 To toggle display grid 1 on or off: 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 

2. Click on DspGrid1. 

Shortcut: Press ([) to toggle DspGrid1 on and off. 

 To toggle display grid 2 on or off: 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
u is displayed. Grids men

2. Click on DspGrid2. 

Shortcut: Press (]) to toggle DspGrid2 on and off. 

Changing Grid Size 
The snap grid’s default setting is 4”, display grid 1’s is 4’-0”, and display grid 2’s 
is 16’-0”. You can change any or all of these grid sizes for each layer in your 
drawing. To change a grid size for another layer, simply change the active layer 
before following the step-by-step instructions in the next paragraph. 
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 To set the snap grid’s size for the active layer: 

2. . 

3. Click on SetSnap in the GridSize menu. A value menu is displayed. 

snap grid value and press (Enter). 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 

Click on GridSize in the Grids menu. The GridSize menu is displayed

3. Use the value menu to select a new value or click Custom; type a new 

Shortcut: Press (S) to set the snap grid size. 

 To set display grid 1’s size for the active layer: 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 

2. Click on GridSize in the Grids menu. The GridSize menu is displayed. 

3. Click on SetGrid1 in the GridSize menu. A value menu is displayed. 

 value, type a new display grid value 

 To  grid 2’s size for the active layer: 

1. Go to the Utility menu in the Menu Window and click on Grids. The 

d. 

3. layed. 

4. Use the value menu to select a new value or click Custom; type a new 
display grid value and press (Enter). 

You can use the Custom option to enter a new value for any of these grid 
settings. For more information on how to use the Custom option, see “Value 
Menus” in “The Drawing Board” chapter. 

 
You tting is 
global, meaning the col You can’t 
set a

 To 

1. 

2. Click on GridColr in the Grids menu. The GridColr menu is displayed. 

u. A color menu is displayed. 

4. Choose a new color from the color menu in the Menu Window. For more 
information on using color menus, see “Color Menus” in “The Drawing 
Board” chapter. 

4. Use the value menu to select a new
and press (Enter). For more information on using value menus, see “Value 
Menus” in “The Drawing Board” chapter. 

set the display

Grids menu is displayed. 

2. Click on GridSize in the Grids menu. The GridSize menu is displaye

Click on SetGrid2 in the GridSize menu. A value menu is disp

Changing Display Grid Color
 can change the color of both of the display grids; however, this se

ors will change on every layer in your drawing. 
sep rate grid colors on each layer. 

change the color of display grid 1: 

Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 

3. Click on SetGrid1 in the GridColr men
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 To change the color of display grid 2: 

rids menu. The GridColr menu is displayed. 

Setting the Snap Angle 
The snap angle is the angle increment that you can draw lines at when ortho 
mode is on. When you’re drawing a line or wall, for instance, once you click to 
place the first end point, you can move the cursor around that point. Notice 
though that your cursor jumps, or snaps, in increments around that first end 
point. These increments are set with the snap angle. With the snap angle set to 4, 

0° increments. If you change the setting to 36, the cursor 
sna
freely  a

Shortcu le ortho mode on or off. The “O” in SWOTHLUDFB in the 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 

2. Click on GridColr in the G

3. Click on SetGrid2 in the GridColr menu. A color menu is displayed. 

4. Choose a new color from the color menu in the Menu Window. 

your cursor moves in 9
ps to 10° increments. If you toggle ortho mode off, your cursor will move 

, nd you’ll be able to draw at any angle. 

t: Press (O) to togg
Status A  
mode is

rea will display as lowercase when ortho mode is off and uppercase when ortho
 toggled on. 

 To s

1. Go to the Utility menu in the Menu Window and click on Grids. The 

apAng in the Grids menu. A value menu is displayed in the 

3. 

Setting the Grid Angle 
Rotating the snap grid and both display grids can make it easier to draw in some 
situations. The Angle option will rotate all three grids. You can’t rotate each grid 
separately.  

 To rotate all three grids: 

 Utility menu in the Menu Window and click on Grids. The 

e menu is displayed. 

e a new angle value, from 0° to 90°, and press (Enter). 

 

2. Click on Angle in the Grids menu. A value menu is displayed. 

et the snap angle: 

Grids menu is displayed. 

2. Click on Sn
Menu Window. 

Use the value menu to set a new snap angle or type a new value, and 
press (Enter). The maximum setting for the snap angle is 36. 

1. Go to the
Grids menu is displayed. 

2. Click on Angle in the Grids menu. A valu

3. Choose or typ

To rotate the grids to the same angle as an entity in your drawing: 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 
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3. Click on Match: in the Angle menu. 

Click on an entity to matc4. h its angle; the angle of this entity is displayed 

n 

5. To use this angle, right-click to exit the menu. To use the inverse of this 
. To use the complementary 

plmnt. To use the supplementary 

(Enter)
Angle setting. 

layer 
aneously. The grid origin is not the drawing origin, which 

is a fixed point. The grid origin is changed on all layers, whether they’re toggled 

Grids menu is displayed. 

dOrg in the Grids menu. The GridOrg menu is displayed. 

 

 To change the grid origin on the active layer only: 

 

ea or use coordinate entry to set the 
new grid origin. The display grids realign themselves based on your new 

(Tab)

in the Message Area. Check the Message Area as you choose different 
options; it will display the angle associated with each of the options i
step 5. 

angle, click on Invert in the Menu Window
angle of the original angle, click on Com
angle of the original angle, click on Suplemnt. Click on Original to go 
back to the original angle. 

6. Right-click to return to the value menu, and press  to accept the 
angle value. The grid rotates to the 

Setting the Grid Origin 
You can change the origin for the snap grid and both display grids on each 
or for all layers simult

on (and currently being displayed) or not. 

 To change the grid origin on all layers in your drawing: 

1. Go to the Utility menu in the Menu Window and click on Grids. The 

2. Click on Gri

3. Look at the GridOrg menu to make sure SetAll is toggled on.  

4. Click anywhere in the Drawing Area or use coordinate entry to set the 
new grid origin. The display grids realign themselves based on your new
origin. For more information on using coordinate entry, see “Using 
Coordinate Entry” in “The Drawing Board” chapter. 

To display the grids at their new origin, you may have to press (Esc) to refresh the 
Drawing Area. You can press (Esc) at any time while you work in DataCAD to 
refresh your drawing. Use object snapping to more precisely choose the point in 
your drawing for the new grid origin. See “Object Snapping” in the “Drawing 
Tools” chapter. 

1. Go to the Utility menu in the Menu Window and click on Grids. The 
Grids menu is displayed. 

2. Click on GridOrg in the Grids menu. The GridOrg menu is displayed.

3. Look at the GridOrg menu to make sure SetAll is toggled off.  

4. Click anywhere in the Drawing Ar

origin. 

5. If you’d like to change the grid origins on other layers in your drawing, 
press  to change the active layer and repeat steps 2 through 4. 



WORKING WITH LAYERS  |    145 

Working With Layers 
You can organize your drawing into groups, or layers, of related information to 
help increase your editing speed and pro . By organizing the information 

g to type or content, you can display only the information 
that you need for the current drawing task. See  “Planning Layers” and “Sample 

o
lay

Wh ut you 
can

Sav
con ou’d normally use. Your new drawings 

dra  in 
“Th

 To create layers in your drawing: 

 on Layers. The 
Layers menu is displayed. 

A value menu is displayed in the 

f new layers you’d like to 
create, or type a value, and press (Enter). The number of layers created is 

essage Area, along with the total number of layers now 

 
 active 

 settings most closely match those you 

Eac id 
size, grid angle, whether th on or off, whether ortho mode 
is to l
in t  

A seed l equent layers. For 
exa l  you’re 
draw s, 
the colu er. 
These layers d 
floo ted ceiling plan 
or HVAC layout for the third floor. Any layers you want to use as seed layers 
should be kept as generic and uncluttered as possible. 

ductivity
on each layer accordin

Pr ject” in “The Drawing Board” chapter for an introduction to planning your 
ering system. 

Creating Layers 
en you create a new drawing, only one layer exists, named Layer001. B
 create up to 999 layers in every drawing, either one at a time or in groups. 

e time when you create new drawings by using a default drawing that 
tains all the layer names and settings y

will automatically have all the layers in your default drawing and you can start 
wing right away. See “Creating a New Drawing Using a Default Drawing”
e Drawing Board” chapter. 

1. Go to the Utility menu in the Menu Window and click

2. Click on NewLayer in the Layers menu. 
Menu Window. 

3. Use the value menu to enter the number o

displayed in the M
in your drawing. 

More About Creating Layers 

The active layer in your drawing acts as a seed layer for any new layers you 
create. When you create a new layer, it takes on the settings of the active layer. To
save time and avoid redefining settings for each new layer, change the
layer to the layer in your drawing whose
want your new layer to have.  

h layer has several independent settings that are customizable, including gr
e snap grid is toggled 

gg ed on or off, and layer color. See “Setting Up Your Drawing Grids” earlier 
his chapter for more information on grid settings. 

ayer then is a layer that is used as a basis for subs
mp e, you might have a basic perimeter plan of a multi-story building

ing. This plan might contain the perimeter and bearing walls, the column
mn centerlines, and the common core elements, each on a different lay

 could be used as seed layers for the partitioning layout on the thir
r, which in turn could be used as the seed layer for the reflec
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Setting the Active Layer 
The active layer is the layer on which you’re currently drawing. To quickly check 
which layer is your active layer, check the Status Area. 

 To change the active layer: 

e 

e 

3.  your active layer, or type the layer 

ess (Tab) 

1. Go to the Utility menu in the Menu Window and click on Layers. Th
Layers menu is displayed. 

2. Click on SetActiv in the Layers menu. A list of layers is displayed in th
Menu Window. 

Click on a layer in the list to make it
name, and press (Enter). The active layer changes, and the active layer 
name is updated in the Status Area. 

Shortcut: You can also use the keyboard to change the active layer. Pr
to scroll through all the layers in your drawing that are toggled on. T
backward through the layers, press (Shift) + (Tab). Notice the active l

o scroll 
ayer name in 

gh the layers. the Status Area changes as you scroll throu

 c

ow and click on Layers. The 

2. 

r 
 layer name is updated in the Status 

Displaying Layers 
at you 

can view only those layers that you need to at any given time. For instance, you 
don’t need to see the site plan while you’re working on a reflected ceiling plan. In 

gle layers on to display them or off to hide them. 

can tog  

Model” ch

Go The 
Lay  to 15 layer 

 drawing, 
pt Back) 

thro

Clic
dra

To hange the active layer and simultaneously toggle all other layers off: 

1. Go to the Utility menu in the Menu Wind
Layers menu is displayed. 

Click on ActvOnly in the Layers menu. A list of layers is displayed in the 
Menu Window. 

3. Click on a layer in the list to make it your active layer, or type the laye
name, and press (Enter). The active
Area. 

One of the most useful things about using layers in your drawings is th

DataCAD, you simply tog

You gle certain layers on to view them in the Drawing Area. You can then
use go-to-views to save that view of your drawing. See the “Viewing Your 

apter. 

 To toggle a layer on or off: 

1. to the Utility menu in the Menu Window and click on Layers. 
ers menu is displayed. The Menu Window displays up

names at one time; when there are more than 15 layers in your
o ions to scroll forward (ScrlFwrd) and scroll backward (Scrl

ugh the list are available. 

2. k on On/Off in the Layers menu. A list of all the layers in your 
wing is displayed in the Menu Window. 
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3. Click on the layer you want to toggle on or off. You can’t toggle all layers 
in DataCAD. If the active layer is the only one toggled on, you can’t 
gle it off until you make a different layer active. If there’s at least one 

off 
tog

ve 
laye er. 

1. Go 

2. Clic ge Area, you are 
prompted with “Are you sure you want to turn on all layers?”. 

hen you plan and create the layers in 

refresh the matically increase refresh speed 

Shortcut: T hy you may want to refresh the display of your 

other layer toggled on besides the active layer, you can toggle the acti
r off; the next layer in the list automatically becomes the active lay

 To toggle on all the layers in your drawing simultaneously: 

to the Utility menu in the Menu Window and click on Layers. 

k on AllOn in the Layers menu. In the Messa

3. Yes. All layers are toggled on. Click on 

More About Displaying Layers 

Refresh speed should also be considered w
your drawing. While your computer’s speed determines the time it takes to 

 display of your drawing, you can dra
using some of the Layers options. 

here are many reasons w
drawing d ing your work session. Press (Esc) at any timur e to refresh your drawing. 

As you toggle each layer on, DataCAD can automatically update, or refresh, your 

(Esc)

 or change the view – two things 
you  
to refle e layers that are actually displayed are 
refr
dra
pla n

Ad o  
refr
refr
In othe  can edit ten layers containing 100 lines faster than one layer 

Loc
You can lock a layer to prevent others from editing the entities on that layer. In 
the   
lock  

You can ed 
layer, a
Area. The layer lock status is saved with the layer when SaveLyr, LoadLyr, and 
the Layer Utility macro (located in the Toolbox in the Edit menu) are used. 

drawing in the Drawing Area. To do this, toggle the layer refresh option 
(LyrRfsh) on in the Layers menu. To quickly toggle several layers on without 
waiting for your drawing to refresh after each layer, make sure LyrRfsh is 
toggled off before you begin toggling layers on. After you’ve finished toggling 
layers on, press  to refresh the display of your drawing. 

Each time you zoom in or out on your drawing
’ll be doing frequently – DataCAD must refresh the display of your drawing

ct the change. Since only thos
eshed, toggling on only those layers that are necessary for your current 
wing task will speed up refresh rates. This is one of the many reasons why 
nni g and maintaining a good layer structure is important. 

diti nally, controlling the number of entities on each layer will increase
esh rates. A drawing containing many layers with a few entities on each will 
esh faster than a drawing containing a few layers with many entities on each. 

r words, you
containing 1,000 lines.  

king Layers 

 list of layers in the Menu Window, a line appears through the layer name of a
ed layer.  

’t modify the layer in any way when it’s locked. If you try to edit a lock
 message saying that no entities are selected is displayed in the Message 
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 l

1. 

2. A list of all the layers in your drawing 
. 

3. 

x in 
the Status area. The layer can’t be edited until it’s unlocked. 

  unlo

1.  Menu Window and click on Layers. The 

me disappears; the layer 

When you cr
num i
layers w me them at some other time. 

  r

1. In the Utility menu in the Menu Window, click on Layers. The Layers 

3. 

4. t 
 in layer names: , . * + / \ [ ] ; : . 

Changing Layer Color 
ew entities you create on that layer 

app
way to tell at a glance what layer an entity is on. If you assign yellow to your 
Wa a
yellow. By default, white is th

When you change 
the ust use the Change menu. 
For
Drawin

To ock a layer: 

Go to the Utility menu in the Menu Window and click on Layers. The 
Layers menu is displayed. 

Click on Lock in the Layers menu. 
is displayed in the Menu Window

Click on the layer you want to lock in the list, or type the layer name, and 
press (Enter). A line through the layer name appears, and if you make that 
layer the active layer, a small ”X” is displayed over the layer color bo

To ck a layer: 

Go to the Utility menu in the
Layers menu is displayed. 

2. Click on Lock in the Layers menu. A list of all the layers in your drawing 
is displayed in the Menu Window. 

3. Click on the layer you want to unlock in the list, or type the layer name, 
and press (Enter). The line through the layer na
can now be edited. 

Renaming Layers 
eate new layers, DataCAD assigns generic names to the layers in 

er cal order, such as Layer001, Layer002, etc. You can either rename the 
hen you create them or rena

To ename an existing layer: 

menu is displayed. 

2. Click on Name in the Layers menu. A list of layers in your drawing is 
displayed in the Menu Window. 

Click on the layer you want to rename. 

Type a new layer name, up to 88 characters, and press (Enter). You canno
use spaces or the following characters

You can assign a color to a layer, so that all n
ear in that color. Assigning a different color to each layer gives you an easy 

lls l yer, for instance, all entities drawn on the Walls layer will display in 
e color assigned to all layers. 

a layer’s color, entities already on that layer will not change to 
 new color. To change these entities’ colors, you m
 more information, see “Changing Entity Attributes” in the “Editing 

gs” chapter. 
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 To change the color assigned to a layer: 

1. Go to the Utility menu in the Menu Window and click on Layers. The 
Layers menu is displayed. 

2. Click on Color in the Layers menu. A color menu is displayed in the 
Menu Window. See “Color Menus” in “The Drawing Board” chapter for 
more information on how to use them. 

3. Click on a color in the list, or use the color menu options Adjust, Custom, 

(K)

or Match, to assign a new color to the layer. 

Shortcut: To change the color of the active layer, press  to scroll through 
available colors; press (Shift) + (K) to scroll backwards through the color menu. 

Viewing a Layer 
There may be times when you’re working with your layers that you need to 
temporarily view a specific layer. Perhaps you need to quickly verify the c
of a layer before you toggle it on. 

ontents 

 To temporarily view a layer: 

1. Go to the Utility menu in the Menu Window and click on Layers. The 
d. 

Lyr in the Layers menu. See “ViewLyr Menu Options” 
e information on these settings. 

tents, LyrRfsh, and Border are toggled on in the ViewLyr 

 in the ViewLyr menu. A list of all the layers in your 
layed in the Menu Window. 

layer you’d like to view, or type the layer name, and press 
nts of that layer are displayed in the Drawing Area. 

 you’re finished viewing layers. This will refresh the 
d return to the original view of your drawing, before 
iewLyr menu.  

r 

t the 

rawing Area as you select each layer 
invisible border to display each layer in 
of the Drawing Area to use to display layers; only available when 
 

heir Contents 
seful to your project, you can erase only the contents 
tual layer as well as its contents. 

Layers menu is displaye

2. Click on View
below for mor

3. Make sure Ex
menu.  

4. Click on Select
drawing is disp

5. Click on the 
(Enter). The conte

6. Press (Esc) when
Drawing Area an
you entered the V

ViewLyr Menu Options 
Select Lists the layers in your drawing; click on the layer name in the list or type the laye

name, and press (Enter) 
Extents Toggle on to display the layer at its extents; toggle off to display the layer a

current scale  
LyrRfsh Toggle on to refresh the D
Border Toggle on to use an 
ImgSize Sets the percentage 

border is toggled on

Deleting Layers and T
When a layer is no longer u
of the layer or delete the ac
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 To erase the contents of a layer: 

 

all the layers in your 
drawing is displayed in the Menu Window. 

3. Click on the layer that contains the entities you want to erase, or type the 
 “Are you sure you want to erase: <layer name>” 

ssage Area. 

he layer’s contents. The layer itself is not deleted 
any other way. Click on No to exit the EraseLyr 
g the layer’s contents. 

 contents from the drawing: 

nu in the Menu Window and click on Layers.  

ution, use the SaveLyr option to save, or backup, a layer 

1. Go to the Utility menu in the Menu Window and click on Layers. The
Layers menu is displayed. 

2. Click on EraseLyr in the Layers menu. A list of 

layer name. The prompt
is displayed in the Me

4. Click on Yes to erase t
and isn’t changed in 
menu without erasin

 To delete a layer and its

1. Go to the Utility me

Warning: As a preca
before deleting it. If you find you still need the layer later, you can then use 
LoadLyr to copy it back into your drawing. 

2. Click on DelLayer in the Layers menu. A list of all the layers in your 

4. Click on Yes to delete the layer. Click on No to exit the DelLayer menu 
nnot delete the active layer. 

Select g Layer Names 
You a
Match 
having can set the active layer, move 
entities fr
wit

You can use Match with any of the following Layers menu options: On/Off, 
e, EraseLyr, DelLayer, SaveLyr, ViewLyr/Select. It 
Layer in the Move or Copy menus or when using 

 layer using Match: 

ck Match in the SetActiv menu. 

t is on. The 
active layer setting is changed to that layer. 

drawing is displayed in the Menu Window. 

3. Click on the layer that you want to delete, or type the layer name. The 
prompt “Are you sure you want to delete layer <layer name>” is 
displayed in the Message Area. 

without deleting a layer. You ca

ing Layers Without Usin
 m y have noticed the Match option in several of the Layers submenus. 

is used to select a layer by selecting an entity on that layer instead of 
 to find the correct layer name in a list. You 

om one layer to another, or point DataCAD to a specific layer, all 
hout having to remember layer names. 

SetActiv, ActvOnly, Lock, Nam
is also available when using To
LyrSrch. 

 To set the active

1. Go to the Utility menu in the Menu Window and click on Layers. The 
Layers menu is displayed. 

2. Click on SetActiv in the Layers menu. The SetActiv menu is displayed. 

3. Cli

4. Click on an entity in the Drawing Area to select the layer i
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 To move entities to another layer using Match: 

1. Go to the Edit menu and click on Move. 

Click on ToLayer in the Mov2. e menu. You are prompted to “Select layer to 

ng additional layers. 

yer 

layer from walls, you must tell DataCAD which layer your walls are on 
our active layer, and 

click on Architct in the Edit menu. See “Setting the Active Layer” earlier 
mation. 

3. already toggled on, 

4. 
t the bottom of the list of layers. 

a. Click on a wall in your drawing to select the layer that 

For 
Walls, 

Windows, and Doors” chapter. 

ilter 
ple, if you’ve put your 

u might have layers 
, 2FLELECT, and 

ing layer, you’d use Filter and enter ???plumb. 
Or you co yers by entering 1fl* or 1fl?????. 

move to” in the Message Area. The ToLayer option is only available if 
your drawing has more than one layer. See “Creating Layers” earlier in 
this chapter for more information on creati

3. Click Match in the ToLayer menu. You are prompted to “Select entity to 
match” in the Message Area. 

4. Click on an entity in the Drawing Area to select the layer to move the 
entity to. You are prompted to “Select entity to move” in the Message 
Area. 

5. Click on the entity you want to move. The entity is moved to the la
you selected in step 4. 

 To point DataCAD to a specific layer using Match: 

1. Indicate the wall layer. When drawing doors or windows on a different 

so they can be cut properly. Make the Doors layer y

in this chapter for more infor

2. Click on DoorSwng in the Architct menu.  

Toggle LyrSrch on in the DoorSwng menu. If it’s 
toggle it off and then back on again to display the list of layers in your 
drawing. 

Respond to the prompt to “Select layer to search for walls” in the 
Message Area. Click on Match a

5. Respond to the prompt to “Select entity on layer to match” in the 
Message Are
your walls are drawn on. 

6. Draw your door. The wall will be cut properly on the Walls layer. This 
same procedure can be used with the Windows or CutWall options. 
details on how to draw doors and windows, see the “Drawing 

Searching for Layers 
You may have noticed the Filter option in several of the Layers submenus. F
is used to search for layers with similar names. For exam
plumbing and electrical drawings on separate layers, yo
named 1FLPLUMB, 2FLPLUMB, 3FLPLUMB, 1FLELECT
3FLELECT. To search for a plumb

uld search for first floor la
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Use
in place ters 
followi b to search for plumbing 
laye  
wil

 To search for layers: 

indow and click on Layers. The 

 

 
entered. If your search doesn’t find the layer you want, you can scroll through 

ck and FiltFrwd 
opt s ch 
results. 

Dat
Filter t
results 

Sav
You ma  layer from one drawing to another, you 
may simply want to save a copy of a layer before you delete it in case you find 

ve a hidden line removal of your 
 drawing file size. The SaveLyr and 

s. The 
Layers menu is displayed. 

 an asterisk (*) in place of any number of characters and a question mark (?) 
 of each character you’re unsure of. The filter disregards any charac

ng an asterisk. Therefore, if you enter *plum
rs, DataCAD recognizes only * as the search parameter and all of your layers 

l be displayed. 

1. Go to the Utility menu in the Menu W
Layers menu is displayed. 

2. Click on the Layers option you want to use, On/Off, for example. 

3. Click on Filter in the Layers option submenu to toggle Filter on. 

4. Type the search parameter, including any wildcard character(s), for the 
layers you want to find. Your search results are displayed in a list in the
Menu Window. 

5. Choose the layers you want to use. 

More About Searching for Layers 

DataCAD groups layers with affixes (prefixes or suffixes) similar to what you

these groups to find the appropriate layer using the FiltBa
ion  that are displayed at the bottom of the Menu Window, below your sear

aCAD remembers the last search you did using Filter. When you next use 
, he search parameter is displayed in the Message Area and your search 

are displayed in the Menu Window. 

ing and Loading Layers 
y occasionally need to copy a

you need it again, or perhaps you’d like to sa
model to a layer file to avoid increasing your
LoadLyr options in the Layers menu can help you do all of these things. SaveLyr 
saves a layer to a layer (.LYR) file; LoadLyr pastes a layer file into a drawing. 

 To save a layer: 

1. Go to the Utility menu in the Menu Window and click on Layer

2. Click on SaveLyr in the Layers menu. A list of your layers is displayed in 
the Menu Window. 

3. Click on the layer you want to save. A dialog box is displayed. 
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4. Type the name of layer file and click on Save or press (Enter). DataCAD 
 

ds replace the old version of the file with 
e 

r. 

 To 

1. he active layer to the layer that you 

Layers menu is displayed. 

3. Click on LoadLyr in the Layers menu. You are prompted with “Delete 
active layer?” in the Message Area.  

4. Click on Yes in the Menu Window to erase anything on the active layer. 
Click on No to add the entities on the layer you will load to the entities 
already on your active layer. A dialog box is displayed, listing all your 
layer files. 

Warning: If you choose Yes to delete the active layer, ou cannot restore those 

saves the layer with a .LYR extension. If you already have a layer file by
that name, DataCAD prompts you to verify that you want to overwrite 
the existing file, or in other wor
this new one. Press (Enter) to overwrite the file. You are returned to th
Layers menu. By default, files are saved in your DATACAD\LYR folde
You can change the folder that layer files are saved to using the 
Pathnames tab in the Tools/ Program Preferences dialog box. 

load a layer into a drawing: 

Go to your drawing and change t
want to copy the layer file onto. 

2. Go to the Utility menu in the Menu Window and click on Layers. The 

 y
entities. 

5. Click on the layer file you want to load or type the filename in the 

6. Click on Open or press . The layer file is copied to the active layer in 

More A

Just as 
plan a re 
the lay
name o iles is 
to use t
example, if you saved the layer that contained a hidden line removal from the 
drawing file HOUSE.DC

Using
The La off, 
locked
each la

Filename input box. 

(Enter)
your drawing. 

bout Naming a Layer File 

you planned how to name the layers in your drawing, you should also 
logical, useful naming scheme for your layer files. To keep track of whe
er came from, the layer filename should be as similar as possible to the 
f the drawing file from which it originated. One way to name layer f
he drawing filename followed by a descriptive name for the layer. For 

5, you might name the layer file, HOUSE_HL.LYR. 

 the Layer Manager 
yer Manager gives you control over each layer’s number, status (on, 
, and unlocked), color, and name. It displays the number of entities on 
yer in the Count column. 
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.2: The Layer Manager dialog box Figure 7

Access

 To o

• 
ger dialog box appears. 

• r Manage. The 

• Or use the keyboard shortcut (Ctrl) + (L). The Layer Manager dialog box 
appears. 

• Or click on the active layer’s name in the status window. 

Initially, the only active buttons are AllOn, New, Ok, and Cancel. When you 
highlight the layer you want to work with, other buttons will become active. 

Changing a Layer’s Number  

 To change a layer’s number: 

1. Click on the number of the layer you want to change. The layer you 
selected is highlighted in the Layer Manager dialog box. Notice that in 
addition to AllOn and New, the SetActive, ActiveOnly, Erase, Delete, 
MoveUp, and MoveDn buttons are active. 

Hint: To select several successive layers (for example, layers 3 through 6) click 

ing Layer Manager 

pen the Layer Manager, use one of these options: 

Select Layers from the Utility menu and click on Manage in the Layer 
menu. The Layer Mana

• Or select Layer Manager from the Tools pull-down menu. The Layer 
Manager dialog box appears. 

Or use the keyboard shortcut (L) for Layer and (S8) fo
Layer Manager dialog box appears. 

on the first one, press down and hold (Shift), and click on the last layer. Release 
the (Shift) key when you have highlighted the successive layers you want to work 

ger dialog box. with in the Layer Mana
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To select several layers that are not in consecutive order (for example, 
 

lick on the other layers. Release the (Ctrl) key when you have 
highlighted the nonconsecutive layers you want to work with in the 

. 

on. Alternatively, you can use the mouse to reposition 
the layer with drag and drop. Just click on the number, drag your mouse, 
and release the left mouse button when you reach the desired new 

ition the layer. 

 

layers 3, 5, and 7), you select the first one, press down and hold (Ctrl),
and c

Layer Manager dialog box

2. Click on the MoveUp or MoveDn button until you are satisfied with the 
layer’s new positi

number to dynamically repos

Hint: When you make changes to the position of the layers by using the MoveUp
or MoveDn buttons or the drag-and-drop method, DataCAD automatically inserts 
a checkmark in the Save new layer order box. If this box does not contain a 
checkmark, your changes will not be saved and the layers will return to their 
original positions when you leave the Layer Manager dialog. 

3. Click on the Apply or Ok button when you finish rearranging the layers. 
This saves your layers in the new arrangement and deactivates the Revert 
button. When you click the Ok button, the Layer Manager dialog box 
disappears and you return to the drawing window. 

 To return the layers you moved to their original positions, use one of these 
options: 

• Click on the Revert button if this option is available. If you selected 
Apply, the Revert button will not be active. If you selected Ok, the Layer 
Manager dialog box will not be displayed on your screen. 

• Or click on the Undo arrow once if the Layer Manager dialog box is not 

• 
n. 

So
Use Layer Manager to sort your drawing’s layers by clicking on the column 
titles. Clicki
exa l n 
in the Name column. If you click the Name column a second time, the layers will 
app

Hint place a 

on your screen to return to the positions that were last active. 

Or press (Ctrl)+(Z) for Undo if the Layer Manager dialog box is not on 
your scree

rting the Layers 

ng the same column title twice will reverse the sorting order. For 
mp e, you may want to sort the layers alphabetically A-Z by the informatio

ear alphabetically Z-A. 

: Sorting your layers by clicking on the column titles does not automatically 
checkm ly 
sorted o
appears

ark in the Save new layer order box. If you want to save the layers in the new
rder, make sure you click in the Save new layer order box so that a checkmark 
 before you exit from the Layer Manager dialog box. 

If you just want to quickly check the on/off or lock/unlock status of the layers, 
 in that order. In these cases, you probably 

e Save new layer order box. Leaving the 
box un re 
in whe x. 

you may not want to store the layers
wouldn’t want to put a checkmark in th

checked means that DataCAD will return the layers to the order they we
n you last opened the Layer Manager dialog bo
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Figu

This is what happens when you use the column titles to sort your layers: 

• LayerNum: Layers are arranged in numerical order. Clicking LayerNum 
again reverses the layers. 

• On: Layers that are On will appear first. Clicking On again makes the Off 
layers appear first. 

• Lock: Layers that are locked will appear first. Clicking Lock again makes the 
unlocked layers appear first. 

• Color: Layers will be sorted from white through the darkest shades. Clicking 
Color again will sort layers from darkest shades to white. 

• Name: Layers will be sorted alphabetically from A to Z. Clicking Name again 
will sort layers from Z to A. 

• Count: Layers will be sorted numerically from the smallest to the largest 
number. Clicking Count again will sort layers from the largest to the smallest 
numbers. 

Hint: Count indicates the number of entities contained on a particular layer. You can sort 

re 7.3: Layers sorted alphabetically  

by count to quickly find the layers that do not contain any drawing entities. This makes it 
easy for you to delete empty layers from your file. 

Changing Layer Settings 
Each layer has different settings that you can change. These settings are on/off, 
lock/unlock, color, and name. 
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On/Off 

A solid yello lear 
bulb m  layer. Only 
one bulb in the layer list d active); 
however, any number of bulbs may be yellow (on) o

e
. 

ay
ang

f setting for several layers: 

1. Highlight the layers you want to change by using (Shift) for successive or 
(Ctrl) for nonconsecutive layers. 

2. Click on the light bulb for one of the highlighted layers. All the bulbs in 
the highlighted layers are changed to the same setting.  

Hint: This is true even if some of the bulbs in the layers you selected were on 

w light bulb in the On column indicates that a layer is on; a c
eans that a layer is off. The green bulb designates the active

can be green (meaning that layer is on an
r clear (off). 

 To change the on/off setting for one layer: 

1. Click on the light bulb of the layer you want to change. If th
originally yellow, it changes to clear and vice versa

 bulb was 

2. Click on Apply if you want to make other changes in the L
or click Ok to return to the drawing window, where your ch
effect. 

 To change the on/of

er Manager 
e is in 

and others were off. For example, if you highlighted layers 3 (on), 5 (off), and 6 
(on) before you clicked on the bulb in layer 3, DataCAD would switch all three 
bulbs off. 

3. Click on Apply if you want to make other changes in the Layer Manager 
or click Ok to return to the drawing window, where all your changes are 
in effect. 

 
Figure 7.4: Changing the On/Off status of a layer 

 To turn all the layers on: 

1. Click the AllOn button. 

2. Click on Apply if you want to make other changes in the Layer Manager 
or click Ok to return to the drawing window, where all the layers are on. 

 To designate the active layer: 

1. Select the layer you want to change to active status. 

2. Click on the SetActive button. The bulb for the highlighted layer changes 
to green and its name is underlined. The bulb for the layer that was 
previously active changes to yellow (on) and its name is no longer 
underlined. 
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3. Click on Apply if you want to make other changes in the Layer Manager 
g window. Notice that the layer you 

 as active: 

or click Ok to return to the drawing window. Notice that the active layer 
pears in the drawing window. 

 an open padlock. Locked 
layers (red, closed padlock) are protected and cannot be edited. 

  lock o

1. ’s 

Remember that if you locked a layer, DataCAD will not allow you to 

 l

1. eral nonconsecutive 

2. ed 

3. 

Color 

In the L
Chang  
the col
color d

 To of a layer: 

or click Ok to return to the drawin
selected is active in the status box in your drawing window. 

 To display only the layer you designate

1. Highlight the layer you want to designate as active. 

2. Click the ActiveOnly button. The highlighted layer’s bulb is green 
(indicating it is on and active); all other bulbs are clear (off). The layer’s 
name is also underlined. 

3. Click on Apply if you want to make other changes in the Layer Manager 

is the only one that ap

Lock/Unlock 

You can edit unlocked layers, which are designated by

To r unlock one layer: 

Click on the padlock you want to change. DataCAD changes that layer
lock status accordingly. 

2. Make changes to other layers in the Layer Manager if necessary. 

make any changes to it. 

3. Click Ok to return to the drawing window. 

To ock or unlock several layers simultaneously: 

Highlight successive layers by using (Shift) or sev
layers by using (Ctrl) to select the padlocks you want to change. 

Click on a padlock in one of the selected layers. If the padlock you click
was originally unlocked, DataCAD will lock it and all the others in the 
layers you selected in step 1. 

Click Ok to return to the drawing window. 

ayer Manager, the color of each layer appears in a square swatch. 
ing the color that applies to entities on a layer is easy. Keep in mind that
or change will apply only to the entities you create on that layer; the new 
oesn’t affect the entities that were on the layer. 

change the color 

1. Click on the square swatch in the Layer Manager for the layer you want 
to change. The Color Palette dialog box appears. 
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.5: The Color Palette dialog box Figure 7

 

 your own. 

ong the layers in your 

2. Select a new color from the sample swatches in the palette. 

3. Click OK. Notice that the new color you selected appears on the swatch in
the Layer Manager. 

If you do not like any of the available colors, you can easily mix

Caution: Make sure that the color you want to edit is unique am
drawing. If several layers use the same color, change the selected layer’s color as shown 
in the previous steps so that it is different from the others. If the color of the layer you 
want to change is not unique, all other layers sharing that color will also be changed in 
the editing process. 

If you want to mix your own color for a layer, refer to the section on 
r. 

Name 

DataCA
meaningful layer names. You can change a layer’s name in several ways with the 
Layer Manager
or s c

 To 

• Double-click on the layer name you want to change, type the new name 
ess (Enter). The new name appears on 

“Customizing Colors” at the end of this chapte

D allows you to use up to 88 characters (including spaces) for 

. When you click on a layer’s name once, that layer is highlighted 
ele ted; however, you cannot edit the name. 

change a layer’s name use one of these methods: 

(up to 88 characters long), and pr
the list in the Layer Manager. 

 
Figure 7.6: 

• Press (Enter) when a layer is highlighted, type the new name, and press 
(Enter). 

Double-clicking on the layer name lets you type a new name 
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• Press (F2) when a layer is highlighted, type the new name, and press 
(Enter). 

 Other Layer Functions Using
Wit
delete a ese basic functions, 
you e

h the Layer Manager, you can add new layers, erase all the entities on a layer, 
 layer, or revert to previous layer settings. To access th

 us  the buttons on the right side of the layer list. 

 
Figu

Add Ne

The La . While you 
add the lay  

 in 
the use the layer. 

  add a ne

1. t should appear before or above the new one you 

 

re 7.7: Buttons to the right of the layer list show options for changing settings 

w Layer 

yer Manager makes it easy to add new layers to your drawing
er, you also set its name, on/off and lock/unlock status, and color.

Initially, the new layer will not contain any drawing entities; those accumulate
 Count column as you 

To w layer to your drawing file: 

Highlight the layer tha
are creating. DataCAD adds the new layer after the highlighted one. For 
example, if you want the new Brick layer to come before Stucco, you
would highlight Metal. 

 
Figu 7 . 

 New 
e number 

re .8: Highlight the layer above the position where you want the new layer to appear

2. Click on the New button to the right of the layer list. The Create
Layer(s) dialog box appears and you are prompted to “Enter th
of new layers to create.” 
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.9: The Create New Layer(s) dialog box Figure 7

3. Input the number of layers you want to add to your drawing and press 
e new layer appears above the one you initially (Enter) or click Ok. Th

highlighted. 

 
Figure 7.10: The new layer appears below the layer you highlighted in step 1. 

4. Type a name for the new layer and press (Enter). Notice that Count 
contains a zero because there are no entities in this layer yet. 

 
Figure 7.11: Type the new layer’s name. 

5. Continue adding new layers by repeating steps 1 through 4.  

6. Click in the box at the bottom of the Layer Manager to put a checkmark,
indicating that you want DataCAD to save the new layer order. When 
you are finished adding new layers to your drawing file, click on Apply 
(if you want to continue working in the Layer Manager) or Ok (if you do 

 

want to leave the Layer Manager and return to your drawing window 
now). 

 
Figu

Era

You ca e 
when y es on a particular layer of your drawing. 

re 7.12: Check the “Save new layer order” box. 

se Entities from a Layer 

n quickly eliminate all the entities on a layer. This can help you save tim
ou want to make major chang
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1. 

A Warning box 

To erase entities from a layer: 

Highlight the layer that contains the entities you want to eliminate. 

2. Click on the Erase button to the right of the layer list. 
appears. 

 
Figu

3. k on the Yes button or press (Enter). DataCAD puts an eraser in the 
re eliminating all of the entities on that 

particular layer.  

 

re 7.13: Warning box 

Clic
Count column to signify that you a

Hint: The entities will be erased from your drawing when you click Apply or Ok
(to exit the
change yo

 Layer Manager dialog box), but DataCAD gives you a chance to 
ur mind and keep those entities. To change your mind, simply select 

r Cancel button. either the Revert o

 
Figure 7 rs in the Count column to show that entities will be erased from 
that

4.  

indow. DataCAD erases the entities 
on the layer. 

.14: An eraser appea
 particular layer. 

Click on Apply if you want to have the entities erased while you continue
working in the Layer Manager. Click Ok if you want to have the entities 
erased and return to your drawing w

 
Figure 7.15: . 

Delete a La

You can eliminate an e sn’t matter whether 
the e ne. 

. 

u a chance to change your mind. 

 Entities were eliminated from the layer

yer 

ntire layer from your drawing. It doe
 lay r contains hundreds of entities or no

 To delete a layer: 

1. Highlight the layer you want to eliminate from your drawing file

2. Click on the Delete button to the right of the layer list. A warning box 
appears, giving yo
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Figure 7.16: Warning box 

3. Select Yes or press (Enter) to indicate that you want to continue. The layer 
disappears from the list. 

Oh No!  What if you accidentally deleted the wrong layer? Don’t panic because 
DataCAD gives you two more chances to change your mind. You can click 
Revert to restore the layer immediately; the other alternatives are to select 
Cancel or use the Undo function. 

Changing an Incorrect Layer Setting 
Ther the 
Lay
select R
you lea

Revert 

If you a uch as eliminate all its entities, turn 

yer’s status to Off 
 give you a chance to return to 

the  (the 
button is gray), it’s too l

Cancel 

If Reve  
as elim ade during the current 
Lay button. Selecting Cancel closes 
the  
chan e s 
to thos

Cancel  changed in the Layer Manager dialog box since 
you
sele
the Lay
exit the dialog by choosing the Ok button. 

e are three ways for you to change settings if you made a mistake in 
er Manager dialog box. Depending on when you notice the mistake, you can 

evert or Cancel or use the Undo button if you don’t catch the error until 
ve the Layer Manager dialog box.  

to Previous Settings in the Layer Manager 

ccidentally do something to a layer (s
a layer off, or eliminate the layer entirely), you can go back to the previous 
settings with Revert.  

Revert is available after you do something on the Layer Manager’s list and only 
applies to what you just did. For example, if you change a la
and then give the layer a new name, Revert will

 older name but will not turn the status to On. If Revert is unavailable
ate to change your mind about a previous decision. 

rt is not available (the button is gray) or you notice a previous error (such
inating all the entities in the wrong layer) you m

er Manager session, you can use the Cancel 
 Layer Manager and puts you back in the drawing window, ignores all the

g s you made since you entered the dialog box, and returns all layer setting
e that existed previously in your drawing file. 

 affects all the settings you
 opened it. You can’t selectively eliminate some changes and retain others. If 
cting Cancel eliminated settings that you wanted to keep, you must reopen 

er Manager dialog box, make the changes again, and save them when you 
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Undo 

Use the Undo arrow on your button bar or select Undo Layer Manager from t
Edit pull-down menu if the Layer Manager dialog box is not active on your 
screen. This eliminates all the things you changed the last time you used the 
Layer Manager dialog box. If you restored your old layer settings with Undo 
want to

he 

but 
 keep them after all, just click on the Redo button or select Redo Layer 

og box give you several exit 

Manager from the Edit pull-down menu. 

Exiting from the Layer Manager 
The buttons on the bottom of the Layer Manager dial
options: 

 
Figure 7.17: Exit options 

• Apply. When you click on this button, the  changes you make in the layer list 
ins 

• Sav
inv yers. By 

to u t 
befo the Layer Manager. 

•  
dia
reta
Lay

• Ok g this button returns you to your drawing screen and makes all 

Custo
Pas nd 
modifie

Set
A password can provide a level of security to individual drawing files. 
DataCAD’s password option requires that the password be entered correctly to 
open the drawing. 

Warning: There is no way to circumvent this setting if you forget your password. Use a 

take effect in your drawing while the Layer Manager dialog box rema
open.  

e new layer order. This check box is available if any of your changes 
olved the original layer order or if you added or deleted la

default, when this box is initially active, it contains a checkmark. Remember 
ncheck this box if you want to go back to the layer order that was in effec
re you opened 

Cancel. This disregards everything you did since opening the Layer Manager
log box. Clicking this button returns you to the drawing window and 
ins your layer settings to those that were in effect before you opened the 
er Manager. 

. Clickin
the layer setting changes take effect in your drawing file. 

mizing Drawing Settings 
swords, scale and angle types, and a variety of display options can be set a

d at any time during your work session. 

ting a Password 

password you can easily remember or store a reminder of it in a safe place. 

 To set a password for your drawing: 

1. Go to the Utility menu in the Menu Window and click on Settings. The 
Settings menu is displayed. 
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2. Click on Password in the Settings menu. A small dialog box is displayed. 

3. Enter a password, up to ten characters long, and press (Enter) or click OK. 
DataCAD prompts you to verify the password. 

5. Type the same password again, and press (Enter) or click OK. The 
password is set. Make sure you save your drawing before closing it so 
that the new password is saved with the drawing file.  

6. Repeat these steps if you need to change the password. 

Setting Scale and Angle Types 
You can change the scale and angle types your drawing uses. When you change 

tive dimensions in your drawing will be updated. 

e: 

, 

 

 Options” later in this section for details on these settings. 

5. Right-click to exit the ScaleTyp menu when you’re finished. 

 To change the angle type in your drawing: 

enu in the Menu Window and click on Settings.  

the scale type, all associa

 To change the scale typ

1. Go to the Utility menu in the Menu Window and click on Settings.  

2. Click on ScaleTyp in the Settings menu. 

3. Click on the scale type you want: architectural, engineering, decimal, 
metric, inch fractions, decimal inches, meters, centimeters, millimeters
DIN standard, or AS1100 standard. 

4. Choose how dimensions are displayed, using the Units, DoFloat, SigDigit,
and StakFrac options. Toggle these on or off, as you like. See “ScaleTyp 
Menu

1. Go to the Utility m

2. Click on AngleTyp in the Settings menu. 

3. Click on the angle type you want: normal, bearing, decimal degrees, 
radians, or gradients. See “AngleTyp Menu Options” later in this section 
for details on these settings. 

4. Choose how angles are used. You can do this by using the Compass, 
ClkWise, and StartAng options.  

5. Right-click to exit the AngleTyp menu when you’re finished. 

4.  

0° 90°

90° 0°

180° 270°

Positive Positive

ro
ta

tio
n

ro
ta

tio
n

270°

CompassNormal

180°

 
Figure 7.18: The Normal angle type as is (left) and with Compass applied (right). 
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ScaleTyp Menu Options 
Arch Uses and displays dimensions and coordinates in the architectural scale, or Imperial 

 fractions of inches); this is DataCAD’s default scale type 
Engr 

Dec  
Inch c es 
Inch/De displays dimensions and coordinates in decimal inches 
Met eters, centimeters, and 

Met eters 
Cen t ntimeters 

rs with 

rating 

ensions and coordinates with unit abbreviations 
DoFloat,  Toggle on so that distance readouts use a floating decimal point; only available with 

the Decimal, Inch/Dec, Meters, CentiMtr, or MilliMtr scale types. When DoFloat is 
ber of significant digits to display is displayed in the Message 

e. 

fraction to overwrite the non-fractional portion of the dimension when using 

 

ivates it 
lockwise direction; toggle off to increase the 

e is 

Star

Editing Scale, Angle, and Distance Lists 
With some functions, DataCAD will 
cho
your d
values,

 To list scale, angle, or distance definitions: 

enu in the Menu Window and click on Settings. The 

units (feet, inches, and
Uses and displays dimensions and coordinates in the engineering scale (feet and 
decimal inches) 

imal Uses and displays dimensions and coordinates in decimal feet 
/Fr  Uses and displays dimensions and coordinates in inches and  fractions of inch

c Uses and 
ric Uses and displays dimensions and coordinates in m

millimeters 
ers Uses and displays dimensions and coordinates in decimal m
tiM r Uses and displays dimensions and coordinates in decimal ce

MilliMtr Uses and displays dimensions and coordinates in decimal millimeters 
DIN Uses and displays dimensions and coordinates in the form meters.centimete

superscripted millimeters 
AS1100 Uses and displays dimensions and coordinates in millimeters with a space sepa

thousands, hundred thousands, millions and so on; input is done in meters 
Units Toggle on to use and display dim

toggled off, the num
Area and the SigDigit option becomes available. 

SigDigit,  Sets the number of decimal places, or significant digits (0 to 3), to display; only 
available with the Decimal, Inch/Dec, Meters, CentiMtr, or MilliMtr scale types, 
when DoFloat is toggled off 

StakFrac Toggle on so that fractions of an inch are displayed “stacked” (with the numerator 
over the denominator) rather than inline; available only with the Arch scale typ
Some third-party fonts have improper character definitions, which may cause the 

StakFrac. Should this occur, try using a different font. 

AngleTyp Menu Options 
Normal Toggle on to set zero degrees equal to the positive X axis, a horizontal line to the right
Bearing Toggle on to enter angles using bearings 
DecDeg Toggle on to enter angles in decimal degrees 
Radians Toggle on to enter angles in radians 
Grads Toggle on to enter angles in gradients 
Compass Sets zero degrees equal to the positive Y axis, a vertical line pointing north; this is not 

a toggle, but simply clicking on it act
ClkWise Toggle on to increase the angle in a c

angle in a counterclockwise direction. When you click on Compass, ClkWis
automatically toggled on. 

tAng Sets zero degrees equal to two specified points 

list scale, angle, or distance values for you to 
ose from. You can modify these scale, angle, and distance lists associated with 

rawing. You can list the current values, add new values, change existing 
 or delete values you don’t use. 

1. Go to the Utility m
Settings menu is displayed. 

2. Click on EditDefs in the Settings menu. The EditDefs menu is displayed. 

3. Click on the definition list you’d like to edit: Scales, Angles, or Distnces.  

4. Click on List. The definitions are displayed in the Menu Window. 
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5. Right-click anywhere on the screen or press any key on your keyboard to
exit the list. 

 To add a value to a definition list: 

1. Go to th

 

e Utility menu in the Menu Window and click on Settings. The 
Settings menu is displayed. 

in the list you want to add to, you must either delete or 

ted 

(Enter) before continuing with 

e 
ce lists 

 file (with a .SCL, .ANG. or .DIS file extension, respectively) 

ayed. 

4.  are prompted to select the definition to delete. User 

5. 

ion list: 

. The 
Settings menu is displayed. 

2. itDefs in the Settings menu. The EditDefs menu is displayed. 

4. u are prompted to select the definition that you want 

5. efinition you want to change. If you’re changing an angle or 
distance, you are prompted to enter the new definition in the Message 
Area. If you’re changing a scale you are prompted to “Enter a new string 
for this scale”; enter the text that will appear in the list and press (Enter) 
before continuing with the next step. 

6. Enter a new definition to replace the existing one and press (Enter). 

2. Click on EditDefs in the Settings menu. The EditDefs menu is displayed. 

3. Click on the definition list you’d like to edit: Scales, Angles, or Distnces. 
You are limited to 18 definitions in a scale, distance or angle list. If you 
already have 18 
change an existing one. 

4. Click on Add. If you’re adding a new angle or distance, you are promp
to enter the new definition in the Message Area. If you’re adding a new 
scale you are first prompted to “Enter a new string for this scale”. Enter 
the text that will appear in the list and press 
the next step. 

5. Type a new definition and press (Enter). The new value is added to th
definition list. You can save your customized scale, angle, or distan
to a separate
and load them into DataCAD at any time for use in your drawings. 

 To delete a value from a definition list: 

1. Go to the Utility menu in the Menu Window and click on Settings. The 
Settings menu is displayed. 

2. Click on EditDefs in the Settings menu. The EditDefs menu is displ

3. Click on the definition list you’d like to edit: Scales, Angles, or Distnces. 

Click on Delete. You
prompts are displayed in the Message Area. 

Click on the definition in the list that you want to delete. The definition is 
deleted. 

 To change a value in a definit

1. Go to the Utility menu in the Menu Window and click on Settings

Click on Ed

3. Click on the list to be edited: Scales, Angles, or Distnces. 

Click on Change. Yo
to change. 

Click on the d
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 To save your customized definition list: 

. 

5. Type a name for the customized list file, and click on Save or press (Enter). 

 l

The 
nu is displayed. 

. 

gles, or Distnces. 

5. d 
 loaded into 

DataCAD. 

or more information on the calculator, see “DataCAD’s Online 
Calculator” in “The Drawing Board” chapter. 

t example follows: 

SCA
1/3
1/16
3/32”=1
1/8 -
3/16
1/4”=1’-
3/8”=1’-
1/2” -
3/4=
1”=1’-0”
1 1/2”=1
2”=1’-0”
3”=1’-0” .25000000 
6”=1’-0” .50000000 
12”=
24”=

1. Go to the Utility menu in the Menu Window and click on Settings. The 
Settings menu is displayed. 

2. Click on EditDefs in the Settings menu. The EditDefs menu is displayed

3. Click on the definition list you’d like to edit: Scales, Angles, or Distnces. 

4. Click on SaveFile. A dialog box is displayed. 

The customized list is saved. 

To oad a customized definition list for use in your drawing: 

1. Go to the Utility menu in the Menu Window and click on Settings. 
Settings me

2. Click on EditDefs in the Settings menu. The EditDefs menu is displayed

3. Click on the definition list you’d like to edit: Scales, An

4. Click on LoadFile. A dialog box is displayed. 

Click on the name of the customized list file that you want to load, an
click on Open or press (Enter). The customized list is

More About Architectural Scales 

To calculate additional scales, you can use DataCAD’s online calculator. For 
example, to calculate the scale value for 1/4”=1’-0”, type =(1/4)/12 when you’re 
prompted for a new scaling value. Or type =.25/12 to get the same result: 
0.02083333”. F

An architectural scale lis

LE DECIMAL FORM 
2”=1’-0” .00260416 
”=1’-0” .00520833 

’-0” .00781250 
”=1’ 0” .01041666 
”=1’-0” .01562500 

0” .02083333 
0” .03125000 

=1’ 0” .04166666 
1’-0” .06250000 

 .08333333 
’-0” .12500000 
 .16666666 

1’-0” 1.00000000 
1’-0” 2.00000000 
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More A

To calcu
exampl
when y
.004166

SCA
1:10 
1:20 .00416666 
1:33
1:40 .00208333 
1:50 .00166666 
1:80 .00104166 
1:100 .00083333 
1:200 .00041666 
1:400 .00020833 
1:600 .00013888 
1:1000 .00008333 

More About Metric Scales 

o use 
DataCAD’s online calculator for this, type =1/20 and press (Enter) to get the new 
scale value 0.05000000. For more information on the calculator, see “DataCAD’s 

awing Board” chapter.  

 

alue menus, see “Value 
Menus” in “The Drawing Board” chapter. 

bout Engineering Scales 

late additional scales, you can use DataCAD’s online calculator. For 
e, to calculate the scale value for 1:20, type =(1/20)/12 and press (Enter) 
ou’re prompted for a new scaling value. The calculated value is 
66. An engineering scale list example follows: 

LE DECIMAL FORM 
.00833333 

 .00250000 

To calculate additional scales, simply type the ratio in decimal form. T

Online Calculator” in “The Dr

A metric scale list example follows: 

SCALE DECIMAL FORM 
1:1 1.00000000 
1:2 0.50000000 
1:5 0.20000000 
1:10 0.10000000 
1:20 0.05000000 
1:50 0.02000000 
1:100 0.01000000 
1:200 0.00500000 
1:500 0.00200000 
1:1000 0.00100000 
1:2000 0.00050000 
1:5000 0.00020000 
1:10000 0.00010000 

Setting Cursor Accuracy 
Your cursor’s miss distance is the length, in pixels, extending from the center of 
your cursor’s crosshairs outward. The smaller the miss distance, the closer you’ll 
have to place your cursor to an entity to select it, for example. This distance 
affects object snapping and other editing commands where you use your cursor
to select a point or entity. The default miss distance is 10. 

 To set your cursor’s miss distance: 

1. Go to the Utility menu in the Menu Window and click on Settings. The 
Settings menu is displayed. 

2. Click on MissDist in the Settings menu. A value menu is displayed in the 
Menu Window. For more information on using v
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3. Choose a new distance value from the list or type a new value, and press 

Set
Ther ncluding 
grid  information displayed in 
the

When y  your drawing, the grid spacing becomes smaller. The 
grid can become so small that it’s difficult to work with and even distracting. You 

ttings menu to turn off the display grids 
 

: Press (PgDn) and (PgUp) to zoom in and out on your drawing, 

(Enter). 

ting Display Options 
e are several display options that you can customize in DataCAD, i
 display, reference mark display, cursor size, and

 Message Area. 

ou zoom out from

can use the SmalGrid option in the Se
when it reaches a specific pixel spacing. A good setting is usually between 15 and
20 pixels. 

Shortcut

 To set the smallest grid size at which the display grid will still display: 

. The 

2. e Settings menu. A value menu is displayed in the 

Drawing Board” chapter. 

id 
ter). 

ettings menu. Toggle 
orary visual references 

for  can't 
sna

Shortcu e display of your drawing in the Drawing Area. 

1. Go to the Utility menu in the Menu Window and click on Settings
Settings menu is displayed. 

Click on SmalGrid in th
Menu Window. For more information on using value menus, see “Value 
Menus” in “The 

3. Choose a new value from the list or type a new value for the smallest gr
size that will display, and press (En

Another display option is the Draw Marks toggle in the S
DrwMarks on to have DataCAD automatically draw temp

every point and entity you draw. These small Xs do not plot, and you
p to them. When you refresh the Drawing Area, the marks disappear. 

t: Press (Esc) to refresh th

You n
large cu he Drawing Area; toggle it off to display a smaller cursor. 
Wh y

Shortcu nd small cursors. 

 ca  also toggle the BigCursr option on in the Settings menu to display a 
rsor that spans t

en ou toggle BigCursr off, you can specify the size of the cursor. 

t: Press (+) to toggle between large a

 To set the size of a small cursor: 

1. Go to the Utility menu in the Menu Window and click on Settings. The 

2. ggle it on. If it’s already toggled on, skip to step 3. 

 
formation on value menus, see “Value Menus” in 

4. 
er). 

Settings menu is displayed. 

Click on BigCursr to to

3. Click on BigCursr to toggle it off. A value menu is displayed in the Menu
Window. For more in
“The Drawing Board” chapter. 

Use the value menu or type a new value for the cursor size, in pixels, and 
press (Ent
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Two
custom isplay. To allow the display of negative coordinates 
in t
disp y

Set
You can adjust the distance the screen scrolls when you use the arrow keys to 

Drawing 

Shortcu

 additional options in the Settings menu, NegDist and ShowZ, allow you to 
ize the Message Area d

he Message Area, toggle NegDist on. Toggle ShowZ on to continuously 
la  the current Z-base and Z-height settings in the Message Area. 

ting the Panning Distance 

pan around your drawing. For example, a setting of 50% scrolls 50% of the 
Area width each time you press an arrow key. 

t: Press the arrow keys to pan around your drawing. 

 To a e: 

played. 

mation on value menus, see “Value 
Menus” in “The Drawing Board” chapter. 

om the list or type a new value, and press 

Automatically Saving Your Drawing 

er operations are momentarily interrupted. If there are a lot of 
entities on a layer, you may want to adjust this save delay to a higher setting to 

s until you’re finished working on that layer. 

ttings. The 

d in the 

e you last saved your drawing (.DC5) file. 

djust the scroll distanc

1. Go to the Utility menu in the Menu Window and click on Settings. The 
Settings menu is dis

2. Click on ScrlDist in the Settings menu. A value menu is displayed in the 
Menu Window. For more infor

3. Choose a new scroll distance fr
(Enter). 

DataCAD’s automatic save feature creates an autosave (.ASV) file that you can 
use to recover your drawing file should DataCAD unexpectedly close before 
you’re able to save the changes you’ve made to your drawing. The SaveDlay 
option in the Settings menu determines how often DataCAD automatically saves 
your entire drawing, updating the autosave (.ASV) file. When an autosave is in 
progress, the activity light in the Status Area next to SWOTHLUDFB turns red 
briefly, and oth

avoid frequent interruption

The autosave function does not permanently save your drawing, and so your 
drawing (.DC5) file is not updated. See “More About Recovering Lost Work” in 
“The Drawing Board” chapter for information on how to use autosave files. 

 To adjust the time interval between automatic saves: 

1. Go to the Utility menu in the Menu Window and click on Se
Settings menu is displayed. 

2. Click on SaveDlay in the Settings menu. A value menu is displaye
Menu Window. To turn off the automatic save function, set SaveDlay to 
zero. This, however, is not recommended, as it leaves you no way to 
recover work done sinc

3. Use the value menu to choose a value for the time interval or type a new 
time value, and press (Enter). 
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Syn
In Data o 
draw a led on by 
default so that the coordinate display in the Message Area matches the rotated 

rotated cursor but want to view the 

 toggle the text, dimensions, hatching, 
 Because the text, dimensions, and 

hat
want to
you dr ou plot the drawing. 

 c

1. nu in the Menu Window and click on Display. The 

3. 
 added to your drawing, or you can choose not to display them 

 

 display hatch patterns; toggle it off 

Some D  a 

chronizing the Distance Display 
CAD, you can rotate the grids along with your cursor to make it easier t
t an angle. The DistSync option in the Settings menu is togg

cursor position. If you are working with a 
distance relative to standard X and Y coordinates, toggle DistSync off. 

Customizing Display 
You can use the Display menu options to
or certain drawing attributes on or off.

ching that you add to your drawing are made up of many entities, you may 
 toggle one or all of these options off to speed up the refresh time while 

aw. Toggle these options on again before y

To ustomize the display of your drawing: 

Go to the Utility me
Display menu is displayed. 

Display all the text, associative dimensions, and hatch patterns that 
you’ve
while you work to decrease drawing refresh times. Toggle ShowTxt on to 
display text; toggle it off to display text as boxes. Toggle ShowDim on to
display associative dimensions; toggle it off to hide associative 
dimensions. Toggle ShowHtch on to
to hide hatch patterns. 

ataCAD menu options are toggles, switches that can be turned on or off. When
toggle is o
is of

n, the button appears depressed and the button name is green. When a toggle 
f, the button appears raised and the button name is red.  

 
.19: ShowTxt toggle on Figure 7

 
Figure 7.20: ShowTxt toggle off 
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3. Look at the toggles that change how the lines in your drawing are 
displayed. Toggle ShowWgt on to display line weights you’ve applied 
your dr

to 
awing; toggle it off to display lines with a weight greater than 1 as 

er-
e off, 

user-defined lines, such as insulation, hedge, and shingles, appear as 
n UserLine is toggled off causing user-defined lines 

o d
im to 

disp

ha
isp

poi  on SmallSym to set the smallest displayable 
sym
disp
See
information on using value menus. 

Ch
Similarly to SmallSym in step 4, SmallTxt sets the smallest text size 

isp
dis
Box
all 
Boa er for more information on using color menus. You can 
sele
box

is
on. 

7. Dis  2D curves by toggling CurveCtr on. 

8. Display visible attributes added with a macro by toggling ShowAttr on. 

9. Click on LyrOr
Tog st on
the active laye ggle Inorder on to refresh the layers in the order 
you
any . 

If Display List is

single solid lines. You can also toggle on UserLine to display any us
defined linetypes you’ve used in your drawing. If UserLine is toggl

single solid lines. Whe
t isplay as solid, these lines are not changed in any way; they are 
s ply represented on screen by a simple solid line. Toggle OverSht on 

lay line overshoots. 

nge display setting4. C s for symbols as well. Toggle ShowIns on to 
d lay symbol insertion points; toggle it off to hide symbol insertion 

nts. You can also click
bol size. Any symbol smaller than the SmallSym setting will be 
layed as a box. A setting of 0 displays all symbols, regardless of size. 

 “Value Menus” in “The Drawing Board” chapter for more 

5. ange settings for displaying text by clicking on SmallTxt or BoxColor. 

d layable on screen; any text smaller than the SmallTxt setting is 
played as a box. A setting of 0 displays all text, regardless of size. 
Color sets the color of the boxes that replace small text or that replace 

text if ShowTxt is toggled off. See “Color Menus” in “The Drawing 
rd” chapt
ct a global text box color or click on NoChange to display the text 
es in the same color as the text they replace. 

6. D play control points of associative dimensions by toggling DimPoint 

play the center points of

der to assign the order in which to refresh drawing layers. 
gle Fir  to refresh the active layer first. Toggle Last on to refresh 

r last. To
 created them. Only one of these three options can be toggled on at 
 one time

 on, DispList is also available in the Utility / Display menu. Click 
DispList; then cl
Dis as 
info bo
Drawing Board”

ick Status to see how many entities and line segments are in the 
wplay List, ell as how much memory is used to maintain the list. For more 

rmation a ut Display List, see “Customizing Miscellaneous Settings” in “The 
 chapter. 

10. Loo  Ar
displayed. The
a lower setting the 
setting when d

11. Rig  e ngs. 

k at the cFactr option; it changes how arcs and curves are 
 higher the setting, the smoother curves are displayed. Use 
 while drawing to increase refresh speeds; then increase 
rawing is complete. (See Figure 7.21.) 

ht-click to xit when you’ve finished changing Display menu setti
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Display with arc factor s  value of 0.5et to a

Display with arc a factor set to  value of 5.0  
ttings  Figure 7.21: Arc factor se

Customizing Color
You can us
dialog box

 To use mize

1. Clic Palett
box is displaye

s 
e any customized palette by simply loading it in the Color Palette 
. 

a custo d palette: 

k on es in the Tools pull-down menu. The Color Palette dialog 
d. 

 
.22: The Color Palette dialog box 

Click on Load in the Color Palette dialog box. 

Figure 7

2. A dialog box is displayed, 
prompting you to “Enter name of the RGB palette to load”. 



CUSTOMIZING DISPLAY  |    175 

 
.23: RGB palette name Figure 7

ally use your new palette in subsequent drawing  

 To m

1. te 

2. 

4. 
ow to find the color you prefer. Since the 

3. Click on the name of the .RGB file you want to use, and click on Open. 
DataCAD will automatic
sessions. 

ix your own custom color: 

Click on Palettes in the Tools pull-down menu to display the Color Palet
dialog box.  

Click on the swatch you want to customize in the Color Palette dialog 
box. 

3. Click on Edit to open the Color Picker dialog box.  

Use your mouse in the RGB (red, green, blue) and/or HSB (hue, 
saturation, brightness) wind
original and new colors appear at the bottom of the Color Picker dialog 
box, it is easy to compare the two.  

 
 The Color Picker dialog box Figure 7:24:

5. Sele
eap

ct OK when you are satisfied with the new color. The Color Palette 
r pears with your new color in the swatch. 
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6. G e the custom color a special name in the input box beside the color 
tch. 

iv
swa

 
me for the custom color Figure 7.25: Supply a na

8. Click OK to exit the Color Palette dialog box. 



Drawin ls, Windows, & 
Doors 

The Architc ee most basic 
drawing ele
drawing 2-l e, 
different do

With a single choice the Architct menu, you can begin 
drawing walls whose intersections can be cleaned 

tomatically. Windows, doors, and other wall openings can 
en be inserted with just a few clicks and, if necessary, 

removed just as easily. 

8 
In this chapter: 

 walls 

 Drawing and removing 

 Drawing and removing 
windows 

 Drawing and removing 
openings in walls 

 

g Wal

t menu in the Edit menu combines the thr
ments under a single menu. Architct includes options for 

as windows and six 

 Drawing 2-line, 3-line, 
and 4-line

ine, 3-lin and 4-line walls as well 
or styles, all with a variety of customizable options. 

from 
doors 

au
th
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Drawing Walls 
Walls can be drawn by simply toggling on the Walls option in the Architct menu. 
DataCAD automatically cleans wall intersections, including the last intersection 
where the first and last walls drawn meet. 

You can draw 2-line walls using the 2LnWalls option, 3-line walls using the 
3LnWalls option, or 4-line walls using the 4LnWalls option. Two line walls draw 
an inside and an outside line, 3-line walls add a centerline, and 4-line walls add 
two cavity walls. The 2LnWalls, 3LnWalls, and 4LnWalls toggles are mutually 
exclusive; when one is toggled on, the others are automatically toggled off. 

Outside wall

Center line

Cavity wall

Inside wall with Hilite

2LnWall

3LnWall

4LnWall  
Figure 8.1: DataCAD’s wall types 

You can also use the Walls option in the DCAD_AEC macro to draw walls. This 
Walls option works the same way that Walls in the Architct menu does, although 
it does have fewer settings to customize wall display. 

 To draw walls: 

1. Make sure Ortho is toggled on. Walls can only be drawn in orthographic, 
or plan, view; if you’re not already in plan view, click on Ortho in the 
Projection Pad or click Orthographic in the View pull-down menu. 

2. Go to the Edit menu in the Menu Window and click on Architct. 

Shortcut: Press (=) to quickly toggle Walls on or off from anywhere in DataCAD. 

3. Click on Walls in the Architct menu to toggle it on; Wall is checked in the 
Create pull-down menu, and you can now draw walls instead of lines. 

4. Click on 2LnWalls to draw 2-line walls, click on 3LnWalls to draw 3-line 
walls, or click on 4LnWalls to draw 4-line walls. 

5. Set the wall attributes using the Hilite option along with Width for 2-line 
walls, CntrLine for 3-line walls, and Exterior, Interior, and Cavity for 4-
line walls. See “More About Setting Wall Attributes” later in this chapter. 
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6. Select two points to draw a wall. When you do this, the line connecting 
those two points becomes the outside wall, inside wall, center of the wall, 
or c , Inside, 
Cnt  Outside to 

ef
the center of 
 o
ll a
 walls based 

l intersections as yo
walls; click on Cap to cap wall ends as you draw your walls
prompted to “Select first end point of new line/wall”. For m
information on using Clean and Cap, see “More About Finishing Walls” 
later in this chapter. 

8. Click anywhere in the Drawing Area or use coordinate entry to start 
drawing your walls. You are prompted to “Select next end point of new 
line/wall”. 

9. Move the cursor using your mouse and click again or use coordinate 
entry to specify the end of the first wall. 

10. Click anywhere on the inside or outside of the wall, depending on what 
you did in step 6. If you chose Outside, CntrWall, or CntrCvty in step 6, 
click anywhere on the inside of the wall; if you chose Inside in step 6, 
click anywhere on the outside the wall. 

11. Notice that your cursor is still connected to the end of your first wall. You 
can continue selecting wall end points, as you did in step 9; all 
intersections will be automatically cleaned. 

12. Finish drawing walls by right-clicking to disconnect your cursor from the 
wall, or clicking near the first endpoint of your first wall to close your 
wall plan. Your cursor is automatically disconnected. 

Sometimes, you may need to fix wall intersections that didn’t clean properly 
when they were drawn. Use the Cleanup menu’s TIntsct, LIntsct, and XIntsct 
options to clean wall intersections. Use the Cleanup menu’s WeldLine and Weld 
Wall options to mend openings in walls. See “Cleaning Wall Intersections” and 
“Welding Lines and Walls” in the “Editing Drawings” chapter. 

More About Setting the Width of Walls 

When toggling on the Walls option in the Architct menu, you are prompted for a 
new wall width. A wall width is the distance between the inside and outside wall. 
You can also change wall width anytime while drawing 2-line or 3-line walls. 

 To change the width of walls to be drawn: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

2. Click on Width in the Architct menu. A value menu is displayed in the 
Menu Window. The Width option is not available when 4LnWalls is 
toggled on 

enter of the wall cavity, depending on whether Outside
rWall, or CntrCvty is toggled on, respectively. Click on

define walls by the outside of the wall, click on Inside to d
the inside of the wall, click on CntrWall to define them by 
the wall, or click on CntrCvty to define them by the center
cavity. When drawing 2-line walls or 3-line walls, CntrWa
work the same way. You can choose either option to create
the wall center. 

7. Click on Clean to automatically clean wal

ine them by 

f the wall 
nd CntrCvty 

on 

u
. You are 

 draw your 

ore 
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3. Use the value menu to enter a new width, or type a new width and press 
 the new wall thickness and subsequent walls will be 

us, 

r inside walls, including colors, 
te option in the Architct menu. Other 

or 4-line walls. 

 To ide or inside wall in a different color, 

1. 

2. e 

n a color to the outside 

3.  to highlight the outside of your walls. 

4. 
ose a 

5. 

6. 

To set attributes for the center line when drawing 3-line walls: 

2. Click on CntrLine in the Architct menu. The CntrLine menu is displayed 
in the Menu Window. The CntrLine option is only displayed when 

ed on. 

at the aspect ratio of the linetype is preserved. 

 To set t cavity wall when 

Go

2. Clic r in the Architct menu. A list of width values is displayed 

3. Use  to set the 
exterior wall thickness. For more information about how to use value 
menus, see “Value Menus” in “The Drawing Board” chapter. 

(Enter). DataCAD sets
drawn with that thickness. For more information on using value men
see “Value Menus” in “The Drawing Board” chapter. 

More About Setting Wall Attributes 

You can assign different attributes to outside o
linetypes, and line weights by using the Hili
attribute options apply only to 3-line 

draw walls with either the outs
linetype, or line weight: 

Go to the Edit menu in the Menu Window and click on Architct. 

Click on Hilite in the Architct menu. The Hilite menu is displayed in th
Menu Window. You can only set Hilite options for either the inside wall 
or the outside wall; for example, you can’t assig
wall and a linetype to the inside wall. 

Click on Outside in the Hilite menu
Click on Inside to highlight the inside of your walls. 

Click on Color to choose a highlight color, click on LineWgt to choose a 
line weight to highlight your walls with, or click on LineType to cho
linetype as a highlight. 

Right-click to return to the Architct menu. 

Begin drawing your walls. Notice that the color, linetype, or line weight 
attributes you set are applied as walls are drawn. 

 

1. Go to the Edit menu in the Menu Window and click on Architct. 

3LnWalls is toggl

3. Click on Color to choose a highlight color, click on LineWgt to choose a 
line weight to highlight your walls with, click on LineType to choose a 
linetype as a highlight, or click on Spacing to set the spacing for the center 
line. The Spacing setting lengthens both the lines and the spaces in a 
linetype, so th

he distance from the exterior wall to the exterior 
drawing 4-line walls: 

1.  to the Edit menu in the Menu Window and click on Architct. 

k on Exterio
in the Menu Window. 

 the value menu, or type a new value and press (Enter)
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 To set the distance from the interior wall to the interior cavity wall when 
g 4-line walls: 

k on Arc

drawin

1. Clic hitct in the Edit menu. 

 the Architct menu. A list of width values is displayed 

ss. 

r the cavity wall when drawing 4-line walls: 

avity menu is displayed in the 

3. 
click 

 on Spacing to set the spacing for cavity 

More A

As 
inte
cursor n toggle on Clean 
in the Architct menu to automatically trim the interior wall lines as you draw the 
walls so that your walls look continuous, without internal lines at corners. 

Sometimes you may need to fix wall intersections that didn’t clean properly 
when they were drawn. Use the Cleanup menu’s TIntsct, LIntsct, and XIntsct 
options to clean wall intersections. Use the Cleanup menu’s WeldLine and Weld 
Wall options to mend openings in walls. 

Shortcut: Press (\) to toggle Clean on or off. 

2. Click on Interior in
in the Menu Window. 

3. Use the value menu, or type a new value and press (Enter) to set the 
interior wall thickne

 To set the attributes fo

1. Click on Architct in the Edit menu. 

2. Click on Cavity in the Architct menu. The C
Menu Window. 

Click on Width to set the width from the exterior cavity wall to the 
interior cavity wall; click on Color to choose a color for cavity walls; 
on LineWgt to set the line weight of cavity walls; click on LineType to set 
the linetype for cavity walls; click
walls. 

bout Finishing Walls 

you saw in the tutorial in this manual, DataCAD always cleans the 
rsections of walls as you draw them, as long as you don’t disconnect your 

from the last wall you drew. For T intersections, you ca

The Cap option in the Architct menu can be toggled on to insert a wall cap or 
closure on the end of a wall. When you draw walls, wall ends are automatically 
capped instead of remaining open. 

The Clean and Cap toggles are mutually exclusive; when one is toggled on, the 
other is automatically toggled off. 

Using Wall Styles 
You can save wall styles for 2-line, 3-line, or 4-line walls with the wall attributes 
you use most often, and then use them in any drawing file. The following 
attributes are saved in a wall style: 

• line color, linetype, line spacing, and line weight of wall lines. The Spacing 
setting lengthens both the lines and the spaces in a linetype, so that the aspect 
ratio of the linetype is preserved. 

• whether you want to highlight the inside or outside line of your walls using 
color, line weight, and linetype. 
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• wall widths and center line and cavity wall attributes. 

 menu in the Menu Window and click on Architct. 

Architct menu. The Wall Style Manager dialog 

other small dialog box is displayed, prompting you to 
enter a new wall style name. 

4. Type a name for your new wall style, and press (Enter) or click on OK. The 
wall style is saved and now appears in the drop-down list in the bottom 
left corner of the dialog box.  

5. Click on OK to close the dialog box. 

 To save changes to a wall style: 

t menu in the Menu Window and click on Architct. 

2. Click on WallStyl in the Architct menu. The Wall Style Manager dialog 

wall style you want to save changes 

4. 

5. Available section at the bottom of the 
 

 To u

2. 

3. Available section at the bottom 
in 

4. 

 To d

2. 

list in the Wall Styles Available section at the bottom 

 The selected wall style is deleted. 

5. Click on OK to close the dialog box. 

 To save a new wall style: 

1. Go to the Edit

2. Click on WallStyl in the 
box is displayed. 

3. Click on SaveAs in the Wall Styles Available section at the bottom of the 
dialog box.  An

1. Go to the Edi

box is displayed. 

3. Using the drop-down list in the Wall Styles Available section at the 
bottom of the dialog box, select the 
to. 

Change wall settings as necessary. 

Click on Save in the Wall Styles 
dialog box. The wall style is saved with any changes you made to wall
settings. 

se a wall style: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

Click on WallStyl in the Architct menu. The Wall Style Manager dialog 
box is displayed. 

Use the drop-down list in the Wall Styles 
of the dialog box to select the wall style you want to use. Wall settings 
the dialog box are changed to those of the wall style you selected. 

Click on OK to close the dialog box. 

elete a wall style: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

Click on WallStyl in the Architct menu. The Wall Style Manager dialog 
box is displayed. 

3. Use the drop-down 
of the dialog box to select the wall style you want to delete. 

4. Click on Delete.
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To display the settings for a wall style: 

t menu in the Menu Window and click on Architct. 

 the Architct menu. The Wall Style Manager dialog 

yle whose settings you want to view. 

4. settings and close the dialog box, or 

Cuttin
You can use CutW

 To c

1. 

3. 

ain to choose your walls 

4. 

5. Select one side of the opening by clicking on a point on the wall or using 
xact coordinates. To choose a coordinate 

ity pull-down menu. 

6. To select the other side of the opening, move the mouse along the wall 
and click on any point or use coordinate entry. The wall is cut and the 
wall ends are capped automatically. 

If the wall opening is a result of adding a door or window when Cutout was 
toggled off, you must use Erase in the Edit menu to erase the framed opening. 
You will then need to use WeldW ll in the Edit/Cleanup menu to weld the wall. 

 and click on Architct. 

3.  walls. If your walls are on a layer 

4. 

5. g and move your mouse diagonally to 
stretch the rubberband box around it, completely enclosing all elements 
of the opening. You can stretch the box around multiple openings to 
remove them all at once. 

 

1. Go to the Edi

2. Click on WallStyl in
box is displayed. 

3. Use the drop-down list in the Wall Styles Available section at the bottom 
of the dialog box to select the wall st
Wall settings in the dialog box are changed to those of the wall style you 
selected. 

Click on OK to use those wall style 
click on Cancel to close the dialog box without changing wall settings. 

g Walls 
all in the Architct menu to remove sections of walls. 

ut openings in walls using the mouse: 

Go to the Edit menu in the Menu Window and click on Architct. 

2. Click on CutWall in the Architct menu. The CutWall menu is displayed. 

Determine which layer your walls are on. If your walls are on a layer 
other than the active layer, click on LyrSrch to toggle it on. If LyrSrch is 
already on, toggle it off and then back on ag
layer. The layers in your drawing are listed in the Menu Window. 

Click on the layer your walls are drawn on. 

coordinate entry to specify the e
entry method, use the Input Mode option in the Util

a

 To remove an opening from your drawing: 

1. Go to the Edit menu in the Menu Window

2. Click on CutWall in the Architct menu. The CutWall menu is displayed. 

Determine which layer contains your
other than the active layer, click on LyrSrch to toggle it on. The layers in 
your drawing are listed in the Menu Window. 

Click on Remove in the CutWall menu. 

Click to one side of the openin
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6. Click to complete the box. DataCAD removes the opening and welds t
wall. If any remnant of the opening remains, click (Esc) to refresh the 
drawing. 

ing Doors 

he 

Draw
Not only can you draw walls using the Architct menu, you can also use it to 
dra  a 
jamb in
specifie  
angle. 

You can
and str es option lets you draw 
doors by indicating the door sides (doorjambs). When Sides is toggled off, doors 

 and strike side. 

selected the layer your walls are on, 
you may see the error message “No walls found to cut. Please check search 

n) to 
wn on in 

the list in the Menu Window. 

 d

1. indow and click on Architct. 

3. mb, angle, style, thickness, head height, and swing style as 
e 

4. 

 a 
r use coordinate entry. You are prompted to “Select strike side of 

5. 
g.” See “More 

door should swing. You are prompted to “Select any point on the outside 

w doors, complete with door swings, in a few quick steps. DataCAD places
to the wall, erases the wall between the jambs, draws the door at the 
d thickness, and draws the door swing at the specified direction and

 draw doors by selecting the sides of the door or by selecting the center 
ike side of the door. When toggled on, the Sid

are drawn by indicating their center

If LyrSrch is not toggled on or you have not 

layer”. Toggle LyrSrch on (if it’s already on, toggle it off and then on agai
display the layers in your drawing. Click on the layer your walls are dra

To raw a door using the mouse: 

Go to the Edit menu in the Menu W

2. Click on DoorSwng in the Architct menu. The DoorSwng menu is 
displayed. You can also access the DoorSwng menu in the Edit/ Architct 
menu using the Doors option in the DCAD_AEC macro. 

Set the door ja
necessary. See the following pages for more information on setting thes
door options. 

Look at the Sides toggle switch. If Sides is toggled on, you are prompted 
to “Select hinge side of door.” If Sides is toggled off, you are prompted to 
“Select center of door.” To enter the point you’re prompted for, click on
wall o
door.” 

Click on the wall or use coordinate entry to enter the strike side of the 
door. You are prompted to “Select direction of door swin
About Coordinate Entry” in “The Drawing Board” chapter. 

6. Click either inside or outside the wall, to indicate which direction the 

of the wall.” 

7. Click anywhere outside the wall. The door and doorjamb are drawn. 
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Figure 8.2: Drawing a door 

More About Door Styles 

The
fold, sl ure 8.3 for examples of door styles. 
Sin c
the o
single f
panel s ate 
overhe  representing the overhead door in a raised 
pos  
of the d

 DoorStyl menu allows you to choose from six door styles: single, double, bi-
iding, pocket, and overhead. See Fig

gle reates single-leaf, hinged doors of any size. This is the default setting for 
 Do rStyl menu. Click on Double to draw two opposing doors hung on a 

rame. Bi-fold creates simplified folding doors, while Sliding creates 2-
liding doors, and Pocket creates pocket doors. Click on Overhead to cre
ad garage doors. A dotted line

ition will be drawn, with the dimensions equaling the width and head height
oor. 

Single Double Bi-Fold

Sliding Pocket Overhead  
Figure 8.3: Door styles available in the DoorStyl menu 
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Mo

Some o
Click o
option draws door jambs for each wall opening, while InWall precisely centers 
door op nt 
betwee
on is th  use Remove to 
erase the do
on a dif e 
layer y

JambIn or will be drawn by rough 
opening or finished opening. 
insi t
outside
door w ataCAD 
dra  

To expl ides to draw a door with JambIn off, the two 
points you select mark the inside of the finished opening; therefore, the jamb will 

. If you toggle JambIn on and draw 

b is drawn inside the two points. 

You can also change the jamb width for your doors. 

 To set a new jamb width: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

2. Click on DoorSwng in the Architct menu. The DoorSwng menu is 
displayed. 

b width value and press (Enter). 

MtchWall in the DoorSwng menu is toggled on by default, causing jamb depth to 
Wall is toggled off, the 

Jam
depth i bDpth is only available from the 
menu when 

More A

Click o o determine the door opening. An angle 
set to 
resu es 
a right 90-
0’ is en
degrees

re About Door Jambs 

f the DoorSwng menu options affect how the door is drawn in the wall. 
n DrawJamb, InWall, or Cutout to toggle the option on.The DrawJamb 

enings between the two wall faces, and Cutout removes the wall segme
n the two jambs. An added benefit to drawing doors with Cutout toggled 
at the walls will automatically weld themselves if you

or. You may need to use LyrSrch with Cutout if you’re drawing doors 
ferent layer than your walls are on; click on LyrSrch and then click on th

our walls are on.  

 is a toggle that determines whether the do
Rough opening means that the door jamb is drawn 

de he opening specified; finished opening means the door jamb will be drawn 
 the opening specified. By default, JambIn is toggled off, meaning the 
ill be drawn by finished opening. When JambIn is toggled on, D

ws the door by rough opening. 

ain further, when using S

be drawn outside the two points specified
another door, the two points you select mark the rough opening in the wall, and 
the jam

3. Click on JambWdth in the DoorSwng menu. 

4. Choose or type a jam

automatically match the wall width. When Mtch
bDpth option becomes available; you can use JambDpth to set the jamb 

ndependently of the wall width. Jam
MtchWall is toggled off. 

bout Door Angles 

n Angle in the DoorSwng menu t
0-0’ will result in the doors being drawn closed, while a 90-0’ angle will 

lt in the doors being drawn fully open. For bi-fold doors, a 90° angle creat
angle at the intersection of each door. When an angle between 0-0’ and 
tered, DataCAD will draw single and double doors open to varying 
.  
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Dat A
angle b
chosen  open. When fully open, 
sliding doors will be drawn to one side and at the first point chosen for the door 

oint. When doors are drawn closed, 

To set the angle of the door opening: 

2. Click on DoorSwng in the Architct menu. The DoorSwng menu is 

4. angle or type an angle value and press 

More About Door Swing 

The  of 
the doo ve 
no doo
of the d
Arc opt

Wit o
ma t
default
menu.  
the doo

More A ttings 

Reg n 
the cen  
find an s” in the 
“Dimen

The DrwMarks option in the DoorSwng menu is another helpful, visual drawing 
 on, DataCAD draws small crosses on the screen 

 
) to refresh the screen. 

They don’t plot, and you can’t object snap to them. 

rwMarks in the Utility/Settings menu 
and
“Before ation on the Settings menu’s 
DrwMarks option. 

The DoorSwng menu also has options to set the door thickness and head height. 

aC D will draw sliding and pocket doors open to varying degrees when an 
etween 10-0’ and 90-0’ is chosen. When any angle 90-0’ or greater is 
, sliding and pocket doors will be drawn fully

opening, making the opening at the second p
the door overlap is equal to double the door thickness. The Angle setting does 
not affect Overhead doors; they are always drawn the same, regardless of angle. 

 

1. Go to the Edit menu in the Menu Window and click on Architct. 

displayed. 

3. Click on Angle in the DoorSwng menu. 

Use the value menu to enter a new 
(Enter). An angle of 0-0’ draws doors closed. An angle of 90-0’ draws most 
doors fully open. See “Value Menus” in “The Drawing Board” chapter for 
more information on how to use them. 

 SwngStyl option in the DoorStyl menu lets you choose the type and color
r swing. You can choose to draw either a line or arc swing style or to ha

r swing drawn at all. The Line option draws a straight line from the corner 
oorjamb to the corner of the open door to represent the door swing. The 
ion draws a curve from the corner of the jamb to the corner of the door. 

h b th Line and Arc, you can toggle MtchDoor on in the SwngStyl menu to 
tch he door swing color to the door color. This option is toggled on by 

. When MtchDoor is toggled off, the SwngColr option is available in the 
Click on SwngColr to choose a color for the door swing, independent from
r color. 

bout Other Door Se

ardless of which way you draw a door, you can use CntrPnt to add a point i
ter of the door. Then you can use the automatic dimensioning feature to
d dimension to this center point. See “Drawing Linear Dimension
sions” chapter. 

aid. With DrwMarks toggled
where you’ve selected points in the Drawing Area. These marks are a temporary
visual reference only; they disappear when you press (Esc

This DrwMarks option is independent of D
 affects only doors and windows. See “Setting Display Options” in the 

 You Draw” chapter for more inform
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 s

1. 

2. 

 

4. 

 To 

2. 

3.  

4. Use the value menu to enter a door thickness, or type a height value and 

Removing a Door 
You can quickly remove any door from your drawing and automatically weld the 
wall with the Remove option in the DoorSwng menu. Keep in mind, however, 
that Remove only erases the door if Cutout was toggled on in the DoorSwng 
menu when the door was drawn. If you didn’t use Cutout when you drew the 
door, use Erase to erase the door as a group. You will then need to use WeldWall 
in the Edit/Cleanup menu to weld the wall.  See “Erasing Entities” and “Welding 
Lines or Walls” in the “Editing Drawings” chapter. 

1. Go to the Edit menu in the Menu Window and click on Architct. 

t menu. The DoorSwng menu is 

3. menu. You are prompted to “Select 

4. 

5. 
 the box 

To et the door thickness: 

Go to the Edit menu in the Menu Window and click on Architct. 

Click on DoorSwng in the Architct menu. The DoorSwng menu is 
displayed. 

3. Click on Thicknss in the DoorSwng menu. A value menu is displayed in
the Menu Window. 

Use the value menu to enter a door thickness, or type a thickness value 
and press (Enter). See “Value Menus” in “The Drawing Board” chapter for 
more information on how to use them. 

set the door head height: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

Click on DoorSwng in the Architct menu. The DoorSwng menu is 
displayed. 

Click on HeadHgt in the DoorSwng menu. A value menu is displayed in
the Menu Window. 

press (Enter). 

 To remove a door from your drawing: 

2. Click on DoorSwng in the Architc
displayed. 

Click on Remove in the DoorSwng 
first point of box around door or window to remove.” 

Click above and to the left of the door to be removed. 

Move your mouse diagonally, completely enclosing all elements of the 
door, and click. DataCAD removes the door. You can stretch
around multiple doors to remove them all at once. 
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Dr
The Wi sed openings in walls, either by 
selecting the sides of the window or by selecting the center and strike side of the 

ndows by changing basic window 
, glass thickness, sill height, and 

1. Go to the Edit menu in the Menu Window and click on Architct. 

enu. The Windows menu is displayed 

3. rojections, thickness of 

4. 

5. 
ou are prompted to “Select second jamb of window” or “Select 

cted the layer your walls 
are on, you may encounter the error message “No walls found to cut. 

. Toggle LyrSrch on (if it’s already on, toggle it 
rawing. Choose the 

layer your walls are drawn on from the list in the Menu Window. 

6. Click on the wall to enter the side of the window jamb. You are prompted 
to “Select any point on the outside of the wall.” 

7. Click outside the wall. The window is drawn. 

awing Windows 
ndows option draws windows with ca

window. You can customize the detail of the wi
components, including jamb size, sill projection
head height.  

 To draw a window: 

2. Click on Windows in the Architct m
in the Menu Window. 

Set the window jamb, exterior and interior sill p
glass, and sill height and head height as necessary. See the following 
pages for more information on setting window options. 

Toggle Sides on to draw windows by selecting the window sides (jambs); 
toggle Sides off to draw windows by selecting their center point and one 
side. If Sides is toggled on, you are prompted to “Select one jamb of 
window.” If Sides is toggled off, you are prompted to “Select center of 
window.”  

Click on a wall to enter one side of the window jamb or the center of the 
window. Y
one jamb of window”, depending on the status of the Sides toggle. 

If LyrSrch is not toggled on or you have not sele

Please check search layer”
off and then on again) to display the layers in your d

 
Figure 8.4: Drawing a window with Sides toggled on 



|  CHAPTER 8: DRAWING WALLS, WINDOWS, & DOORS  190

Mo

Some o
wall. T hile 
InWall he two wall faces, and 
Cut
InW , s 
with Cu emselves if 
you use Re h with this if 
you  
LyrSrch . 

er the window will be drawn by rough 
ening. Rough opening means that the window jamb is 

 
s toggled off, 

meaning the window will be drawn by finished opening. When JambIn is 
raws the window by rough opening. 

To l
points shed opening, and the jamb will be 
dra  
ano
the jam

MtchW g the jamb depth of the window to 
aut a se 
Jam  
only av

You can

 s

1. d click on Architct. 

2. Click on Windows in the Architct menu. The Windows menu is displayed 

nter a jamb width, or type a jamb width value 
and press (Enter). 

More About Sill and Glass Settings 

Other Windows options you’ll want to set include distances for the exterior and 
interior sill projections, the thickness of the glass, and the sill height and head 
height.  

 To change the distance of the exterior sill projection: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

2. Click on Windows in the Architct menu. The Windows menu is displayed 
in the Menu Window. 

re About Window Jambs 

f the Windows menu’s options affect how the window is drawn in the 
he DrawJamb option draws window jambs for each wall opening, w
 precisely centers window openings between t

out removes the wall segment between the two jambs. Click on DrawJamb, 
all  or Cutout to toggle the option on. An added benefit to drawing window

tout toggled on is that the walls will automatically weld th
move to erase the window. You may need to use LyrSrc

’re drawing windows on a different layer than your walls are on; click on 
 and then click on the layer your walls are on

JambIn is a toggle that determines wheth
opening or finished op
drawn inside the opening specified; finished opening refers to the window jamb
being drawn outside the opening specified. By default, JambIn i

toggled on, DataCAD d

exp ain further, when using Sides to draw a window with JambIn off, the two 
you select mark the inside of the fini

wn outside the two points specified. If you toggle JambIn on and draw 
ther window, the two points you select mark the rough opening in the wall; 

b is drawn inside the two points. 

all is toggled on by default, causin
om tically match the wall width. When this option is toggled off, you can u
bDpth to set the jamb depth independently of the wall width. JambDpth is

ailable from the menu when MtchWall is toggled off. 

 also change the jamb width for your windows. 

To et a new jamb width: 

Go to the Edit menu in the Menu Window an

in the Menu Window. 

3. Click on JambWdth in the Windows menu. 

4. Use the value menu to e
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3. Click on OutSill in the Windows menu. A value menu is displayed in the 

4. exterior sill projection, or type a sill 

 To 

1. 

2. played 

3.  

(Enter). 

 To 

1. ow and click on Architct. 

 the Menu Window. 

e Windows menu. A value menu is displayed in 

4. thickness, or type a new value and 

 To 

1. 

ed 

3. he 

4. ter a new exterior sill projection, or type a new 

 To e to the current Z-base elevation: 

1. Go to the Edit menu in the Menu Window and click on Architct. 

he Windows menu is displayed 

Menu Window. 

Use the value menu to enter a new 
projection value and press (Enter). 

change the distance of the interior sill projection: 

Go to the Edit menu in the Menu Window and click on Architct. 

Click on Windows in the Architct menu. The Windows menu is dis
in the Menu Window. 

Click on InSill in the Windows menu. A value menu is displayed in the
Menu Window. 

4. Use the value menu to enter a new interior sill projection, or type a sill 
projection value and press 

change the thickness of the glass: 

Go to the Edit menu in the Menu Wind

2. Click on Windows in the Architct menu. The Windows menu is displayed 
in

3. Click on GlassThk in th
the Menu Window. 

Use the value menu to enter a new 
press (Enter). If you enter a thickness of 0”, DataCAD draws a single sheet 
of glass. 

enter a new window sill height relative to the current Z-base elevation: 

Go to the Edit menu in the Menu Window and click on Architct. 

2. Click on Windows in the Architct menu. The Windows menu is display
in the Menu Window. 

Click on SillHgt in the Windows menu. A value menu is displayed in t
Menu Window. 

Use the value menu to en
height value and press (Enter). 

enter a new window head height relativ

2. Click on Windows in the Architct menu. T
in the Menu Window. 

3. Click on HeadHgt in the Windows menu. A value menu is displayed in 
the Menu Window. 

4. Use the value menu to enter a new exterior sill projection,  or type a new 
height value and press (Enter). 
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More About Other Window Settings 

Reg
poin n
dimensioning feature to find and dimension to this center point. 

The r
aid. Wi
when you select points in the Drawing Area. This DrwMarks option is 
ind
and wi appear 
when y  They don’t plot, and you can’t object 
sna

 can qu awing and automatically weld 
 in mind, however, 

menu whe as drawn. If you didn’t use Cutout when you drew 
You will then need to use 

all i

em

Go 

li  
in the Menu

li st 
poi

Clic

5. Move your mouse diagonally, completely enclosing all elements of the 
ataCAD removes the window. You can stretch the 

inear bays 
of windows. Click OneWindw in the Windows menu in the DCAD_AEC macro 
to access the Window menu in the Edit/Architct menu. 

 To draw a linear bay of windows: 

1. Click DCAD_AEC in the Macros pull-down menu. If DCAD_AEC is not 
listed in your Macros menu, click Configure in the Macros menu and add 
DCAD_AEC to the Macros in Menu list. 

2. Click Windows in the DCAD_AEC menu. The Windows menu is 
displayed. To model 3D windows, use the Windows menu in the 
AEC_Modl macro. 

3. Click HeadHght in the Windows menu. A value menu is displayed, and 
you are prompted to “Enter new window header height” in the Message 
Area. 

ardless of which way you draw a window, you can use CntrPnt to add a 
t i  the center of the window. You can use DataCAD’s automatic 

 D wMarks option in the Windows menu is another helpful, visual drawing 
th DrwMarks toggled on, DataCAD draws small crosses on the screen 

ependent of DrwMarks in the Utility/Settings menu and affects only doors 
ndows. These marks are a temporary visual reference only; they dis
ou press (Esc) to refresh the screen.

p to them. 

Removing a Window 
You ickly remove any window from your dr
the wall with the Remove option in the Windows menu. Keep
that Remove only erases the window if Cutout was toggled on in the Windows 

n the window w
the window, use Erase to erase the window as a group. 
WeldW n the Edit/Cleanup menu to weld the wall. 

 To r ove a window from your drawing: 

1. to the Edit menu in the Menu Window and click on Architct. 

2. C ck on Windows in the Architct menu. The Windows menu is displayed
 Window. 

3. C ck on Remove in the Windows menu. You are prompted to “Select fir
nt of box around door or window to remove.” 

4. k above and to the left of the window to be removed. 

window, and click. D
box around multiple windows to remove them all at once. 

Drawing Linear Bays of Windows 
With the Windows menu in the DCAD_AEC macro, you can draw 2D l
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4. Type a new header height or use the value menu to enter a new height. 

5. Press (Enter) or right-click to accept the new value and exit the menu. The 
Windows menu is displayed again. 

6. Click SillHght in the Windows menu. A value menu is displayed, and you 
are prompted to “Enter new window sill height” in the Message Area. 

7. Type a new sill height or use the value menu to enter a new height. 

8. Press (Enter) or right-click to accept the new value and exit the menu. The 
Windows menu is displayed again. 

9. Click LinrWndw in the Windows menu to display the linear windows 
menu. 

10. Decide if you want to draw a set quantity of equally spaced bays, as 
many bays of a set size that can be fit into a space, or a set number and 
size of bays. In the Linear menu, click Eq Bays to draw equally spaced 
bays, click FitBays to fit bays into a space, or click SetBays to specify the 
number and size of the bays. When using the SetBays option, the opening 
length is determined by the number and size of the bays, as you specify. 

11. Set bay and window options as necessary. See “Linear Window Bay 
ted 

indow wall”. 

 

n ending point for your bay 
of windows. You are prompted to “Enter a point on the outside of the 

 e drawn. 

Linear W
Bay Qty 

is automatically calculated 
Bay Size w 

ly 

WallWd able 

Cutout nd cut an opening; of the three 
options Cutout, CntrLin, and InnrEdg, only one can be toggled on at any given time. 

ening will be cut from Z-base to Z-height 
(from the bottom of the wall to the top), just as it is with the Cutout option in the 

CntrLin 
n 

InnrEdg 
the three options Cutout, CntrLin, and InnrEdg, only one can be toggled on 
ven time 

Options” on the following pages for more information. You are promp
to “Enter starting point of w

12. Use the mouse or coordinate entry to select a starting point for your bay 
of windows. You are prompted to “Enter ending point of window wall”.
For more information on using coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. 

13. Use the mouse or coordinate entry to select a

wall”. 

14. Click anywhere outside the wall. The bays of windows ar

indow Bay Options 
Set the number of window bays you want drawn; not available when using FitBays 
because bay quantity 
Set the width of each window bay, which will be multiplied to create the windo
wall; not available when using Eq Bays because individual bay size is automatical
calculated 

th Set the width of the wall, which in turn determines the depth of the sills; not avail
when Cutout is toggled on because the wall width, and therefore the sill depth, is 
calculated automatically 
Toggle on to automatically calculate the wall width a

When you use Cutout, the window wall op

Architct menu. 
Toggle on to center the depth of the wall along the starting and ending points you 
enter; of the three options Cutout, CntrLin, and InnrEdg, only one can be toggled o
at any given time 
Toggle on to draw the inside face of the wall along the starting and ending points you 
enter; of 
at any gi
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By Ends 

By Cent 

Mullions s. For 
rd” 

are 

e 

ions; the depth is the mullion dimension through 

e 

End, and FullEnd, only 

w 
e can 

. For more information on using color 
menus, see “Color Menus” in “The Drawing Board” chapter. 

dth of mullion lines; make mullion lines wider by 
increasing this value 

ting 
ct 

ratio of the linetype is preserved. 
Glass Customize the dimensions and position of window glass; following are the Glass 

 1-Line is toggled on. The thickness and offset 
for window glass are set using value menus. For more information on 

 Drawing Board” chapter. 
 and the inside face 

 on to model glass as a double line between mullions; of the three 
, only one can be toggled on at a time 
le line between mullions; of the three 

e toggled on at a time 
sing color menus, 

 lines 
LineWdth Sets the line width of glass lines; make glass lines wider by increasing 

this value 
LinSpcng Sets the line spacing of window glass lines. The LinSpcng setting 

lengthens both the lines and the spaces in a linetype, so that the aspect 
ratio of the linetype is preserved. 

Toggle on to draw a window wall by selecting the starting and ending points of the 
wall; of the two options By Ends and By Cent, only one can be toggled on at any 
given time 
Toggle on to draw a window wall by selecting the starting point and the center point 
of the wall; of the two options By Ends and By Cent, only one can be toggled on at 
any given time 

 The width, depth, and offset for window mullions are set using value menu
more information on value menus, see “Value Menus” in “The Drawing Boa
chapter. Customize the dimensions and position of window mullions; following 
the Mullions menu options: 
DoMulln Models mullions; toggle this option off to draw windows without 

mullions 
Width Sets the width of mullions; the width is the mullion dimension along th

face of the wall 
Depth Sets the depth of mull

the wall 
Offset Sets the distance from the inner edge of the wall to the inner edge of th

mullion 
DoMarks Toggle on to display a snapping point to the center of each mullion 
No Ends Toggle on to draw windows without mullions at either end of the 

window wall; of the three options No Ends, Half
one can be toggled on at any given time 

HalfEnd Toggle on to draw mullions of half-width on either end of the windo
wall; of the three options No Ends, HalfEnd, and FullEnd, only on
be toggled on at any given time 

FullEnd Toggle on to draw mullions of full-width on either end of the window 
wall; of the three options No Ends, HalfEnd, and FullEnd, only one can 
be toggled on at any given time 

Color Sets the color of mullion lines

Linetype Sets the linetype of mullion lines 
LineWdth Sets the line wi

LinSpcng Sets the line spacing of window mullion lines, The LinSpcng set
lengthens both the lines and the spaces in a linetype, so that the aspe

menu options: 
DoGlass Models glass; toggle this option off to draw windows without glass 
Thicknss Sets the thickness, or distance between the panes, of the glass; this 

setting has no effect when

value menus, see “Value Menus” in “The
Offset Sets the distance between the inner edge of the wall

of the glass pane 
1-Line Toggle on to model glass as a single line between mullions; of the three 

options 1-Line, 2-Line, and 3-Line, only one can be toggled on at a time 
2-Line Toggle

options 1-Line, 2-Line, and 3-Line
3-Line Toggle on to model glass as a trip

options 1-Line, 2-Line, and 3-Line, only one can b
Color Sets the color of glass lines. For more information on u

see “Color Menus” in “The Drawing Board” chapter. 
Linetype Sets the linetype of glass
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Sills Customize the dimensions and position of inner and outer window sills. The inside 

Outsill Sets the distance from the outer edge of the window wall to the edge of 

s, 

ets the linetype of sill lines 

f window sill lines 

Drawing Curved B
Wit ed 
bay f
macro 

 To 

2. Click Windows in the DCAD_AEC menu. The Windows menu is 
odel 3D windows, use the Windows menu in the 

cro 

nd 
ssage 

5. Press  or right-click to accept the new value and exit the menu. The 
 is displayed again. 

he new value and exit the menu. The 

 

and outside sills, header depth, and sill depth for window sills are set using value 
menus. For more information on value menus, see “Value Menus” in “The Drawing 
Board” chapter. Following are the Sills menu options: 
DoSill Models sills and headers; toggle this option off to draw windows 

without sills and headers 
Insill Sets the distance from the inner edge of the window wall to the edge of 

the inner sill 

the outer sill 
HeadDpth Sets the depth of the window header 
SillDpth Sets the depth of the window sill 
Color Sets the color of sill lines. For more information on using color menu

see “Color Menus” in “The Drawing Board” chapter. 
Linetype S
LineWdth Sets the line width of sill lines; make sill lines wider by increasing this 

value 
LinSpcng Sets the line spacing o

ays of Windows 
h the Windows menu in the DCAD_AEC macro, you can draw 2D curv
s o  windows. Click OneWindw in the Windows menu in the DCAD_AEC 

to access the Window menu in the Edit/ Architct menu. 

draw a curved bay of windows: 

1. Click DCAD_AEC in the Macros pull-down menu. If DCAD_AEC is not 
listed in your Macros menu, click Configure in the Macros menu and add 
DCAD_AEC to the Macros in Menu list. 

displayed. To m
AEC_Modl ma

3. Click HeadHght in the Windows menu. A value menu is displayed, a
you are prompted to “Enter new window header height” in the Me
Area. 

4. Type a new header height or use the value menu to enter a new height. 

(Enter)
Windows menu

6. Click SillHght in the Windows menu. A value menu is displayed, and you 
are prompted to “Enter new window sill height” in the Message Area. 

7. Type a new sill height or use the value menu to enter a new height. 

8. Press (Enter) or right-click to accept t
Windows menu is displayed again. 

9. Click CircWndw in the Windows menu to display the Circular windows
menu. 
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10. Decide if you want to draw a set quantity of equally spaced bays, as 

size of 

using the SetBays option, the opening 
cify. 

11. 
e information. You are prompted to “Enter center 

12.  arc of 

  
your bay of windows. You are prompted to “Enter ending point of 

14. dinate entry to select an ending point for the arc of 

Curved Window Bay Options 
t drawn; not available when using FitBays 

Bay l  

WallWdth
CntrLin u 

me 
InnrEdg  

n 

Clckwse off to model windows in 
a counterclockwise direction 

 to slightly increase or decrease 
 specified precisely into 

Averagd is toggled off, any leftover space at either end of the curved window wall is 
easing the separation angle of 

Mullions epth, and 
ue 

re the 

f to draw windows without 

Width Sets the width of mullions; the width is the mullion dimension along the 
face of the wall 

he depth of mullions; the depth is the mullion dimension through 

isplay a snapping point to the center of each mullion 

many bays of a set size that can be fit into a space, or a set number and 
size of bays. You can draw a set quantity of equally spaced bays, as many 
bays of a set size that can be fit into a space, or a set number and 
bays. In the Circular menu, click Eq Bays to draw equally spaced bays, 
click FitBays to fit bays into a space, or click SetBays to specify the 
number and size of the bays. When 
length is determined by the number and size of the bays that you spe

Set bay and window options as necessary. See “Curved Window Bay 
Options” below for mor
point of window wall arc”. 

Use the mouse or coordinate entry to select a center point for the
your bay of windows. You are prompted to “Enter starting point of 
window wall arc”. 

13. Use the mouse or coordinate entry to select a starting point for the arc of

window wall”. For more information on using coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 

Use the mouse or coor
your bay of windows. The bay of windows is drawn. 

Bay Qty Set the number of window bays you wan
because bay quantity is automatically calculated 

Ang e Set the separation angle between individual window bays, which will be multiplied
to create the total curvature of the window wall; not available when using Eq Bays 
because individual bay angle is automatically calculated 

 Set the width of the wall, which in turn determines the depth of the sills 
Toggle on to center the depth of the wall along the starting and ending points yo
enter; of the two options CntrLin and InnrEdg, only one can be toggled on at a ti
Toggle on to draw the inside face of the window wall along the starting and ending
points you enter; of the two options CntrLin and InnrEdg, only one can be toggled o
at a time 
Toggle on to model windows in a clockwise direction; toggle 

Averagd Available only when FitBays is toggled on; toggle on
the separation angle of each bay to fit the number of bays you
the defined opening, leaving no extra space at one end of the window wall; if 

filled with bays of a smaller width. Increasing or decr
each bay will increase or decrease, respectively, the width of each bay. 

 Customize the dimensions and position of window mullions. The width, d
offset for window mullions are set using value menus. For more information on val
menus, see “Value Menus” in “The Drawing Board” chapter. Following a
Mullions menu options: 
DoMulln Models mullions; toggle this option of

mullions 

Depth Sets t
the wall 

Offset Sets the distance from the inner edge of the wall to the inner edge of the 
mullion 

DoMarks Toggle on to d
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No Ends Toggle on to draw windows without mullions at either end of the 
window wall; of the three options No Ends, HalfEnd, and FullEnd, only 

 window 
ly one can 

ee options No Ends, HalfEnd, and FullEnd, only one can 

. 

 lines. The LinSpcng setting 

Glass ss 

DoGlass Models glass; toggle this option off to draw windows without glass 

ffset 
ion on 

. 
Sets the distance between the inner edge of the wall and the inside face 
of the glass 

lass as a single line between mullions; of the three 
e 
ee 

 at a time 
 the three 

see “Color Menus” in “The Drawing Board” chapter. 

Sills 

awing 
chapter. Following are the Sills menu options: 

DoSill Models sills and headers; toggle this option off to draw windows 
 headers 

Insill Sets the distance from the inner edge of the window wall to the edge of 

 For more information on using color menus, 

easing this 

 

one can be toggled on at any given time 
HalfEnd Toggle on to draw mullions of half-width on either end of the

wall; of the three options No Ends, HalfEnd, and FullEnd, on
be toggled on at any given time 

FullEnd Toggle on to draw mullions of full-width on either end of the window 
wall; of the thr
be toggled on at any given time 

Color Sets the color of mullion lines. For more information on using color 
menus, see “Color Menus” in “The Drawing Board” chapter

Linetype Sets the linetype of mullion lines 
LineWdth Sets the line width of mullion lines; make mullion lines wider by 

increasing this value 
LinSpcng Sets the line spacing of window mullion

lengthens both the lines and the spaces in a linetype, so that the aspect 
ratio of the linetype is preserved. 

Customize the dimensions and position of window glass; following are the Gla
menu options: 

Thicknss Sets the thickness, or distance between the panes, of the glass; this 
setting has no effect when 1-Line is toggled on. The thickness and o
for window glass are set using value menus. For more informat
value menus, see “Value Menus” in “The Drawing Board” chapter

Offset 

1-Line Toggle on to model g
options 1-Line, 2-Line, and 3-Line, only one can be toggled on at a tim

2-Line Toggle on to model glass as a double line between mullions; of the thr
options 1-Line, 2-Line, and 3-Line, only one can be toggled on

3-Line Toggle on to model glass as a triple line between mullions; of
options 1-Line, 2-Line, and 3-Line, only one can be toggled on at a time 

Color Sets the color of glass lines. For more information on using color menus, 

Linetype Sets the linetype of glass lines 
LineWdth Sets the line width of glass lines; make glass lines wider by increasing 

this value 
LinSpcng Sets the line spacing of window glass lines 
Customize the dimensions and position of inner and outer window sills. The inside 
and outside sills, header depth, and sill depth for window sills are set using value 
menus. For more information on value menus, see “Value Menus” in “The Dr
Board” 

without sills and

the inner sill 
Outsill Sets the distance from the outer edge of the window wall to the edge of 

the outer sill 
HeadDpth Sets the depth of the window header 
SillDpth Sets the depth of the window sill 
Color Sets the color of sill lines.

see “Color Menus” in “The Drawing Board” chapter. 
Linetype Sets the linetype of sill lines 
LineWdth Sets the line width of sill lines; make sill lines wider by incr

value 
LinSpcng Sets the line spacing of window sill lines 





Drawing Other Geometry 
Da
Architct
me a
sim  
options to automate drawing stai
well as a Polyline option to draw complex figures or 
bou a

9 
apter: 

ons 

rves 

 Drawing polylines 

g stairs 

 Drawing columns 

levators 

 

taCAD offers several additional drawing tools outside of the 
 menu. The Polygons and Curves menus in the Edit 

In this ch

nu llow you to draw a number of geometric shapes, from  Drawing polyg
ple rectangles to Bezier curves. The DCAD_AEC macro has 

rs, elevators and columns as 
 Drawing cu

nd ries for elements such as hatch patterns.  Drawin

 Drawing e
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Draw
Wit
sides. DataCAD uses a temporary circle to define a polygon. The relationship 
between th b option 
(see Figure e 
orientati n

 

1. e 

switches.  The Dynamic, CntrPnt, Vertex, Diameter, 

 

ted 

use coordinate entry to select the first point 
inate Entry” in 
methods. 

led off, the distance 
ary circle; with 

f 

ing Polygons 
h the Polygon menu, you can draw rectangles or polygons with up to 36 

is circle and the resulting polygon is dependent on the Inscri
 9.1). The points you select to draw the polygon will determine th

o  of the polygon in your drawing.   

To draw a polygon: 

Go to the Edit menu in the Menu Window and click on Polygons. Th
Polygons menu is displayed. 

2. Look at the toggle 
and Inscribe options are toggled on by default. Change these settings as 
necessary. See “Polygon Menu Options” below for more information. 

3. Click on No.Sides in the Polygons menu. A value menu is displayed, and
you are prompted to “Enter number of sides”. 

4. Use the value menu or type a number, and press (Enter). You are promp
to “Select first point on polygon”. 

5. Click in the Drawing Area or 
for the polygon, as prompted. See “Drawing Using Coord
“The Drawing Board” chapter to review coordinate entry 

6. Click to select the second point on the outside of the temporary circle 
used to define the polygon. With Diameter togg
between these two points defines the radius of the tempor
Diameter toggled on, the distance between the points is the diameter o
the circle. The polygon is drawn. 

Polygon drawn with Inscribe on Polygon drawn with Inscribe off  
Figure 9.1: Polygons are actually defined by two points on a circle. These circles are not 
displaye

Polygon Menu Options 

When y
points you specify are vertices opposite each other on the polygon. With Vertex 
on x off 
and Di hat are 
opposite each other. 

d. 

ou create polygons with both Vertex and Diameter toggled on, the two 

and Diameter off, you specify the center point and one vertex. With Verte
ameter on, you specify the mid-point of two sides of the polygon t
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Dyn
the second point; Dynamic is toggled on by default 

 point, marking the center of the polygon; CntrPnt is 

Vert

lt
Diameter Toggle on to draw polygons by defining the diameter of the polygon (two points 

and one side fault 
Inscribe Toggle on to draw polygons as though they were inscribed within a circle; toggle off 

Inscribe is toggled on by default. See Figure 9.1 for more information about using 
Inscribe. 

Draw
To w
X and Y es of these diagonal corners is displayed in the Message Area 
as you draw the rectangle. 

ick on RectAngl in the Polygons menu. 

t marking the center 

r outside of the wall, respectively, after you enter the 
ectangle. 

e information on using coordinate entry, see 
er. 

5. 

amic Toggle on to see the size and shape of the polygon you’re drawing before you choose 

CntrPnt Toggle on to display a snapping
toggled on by default 

ex Toggle on to draw polygons by defining two vertices of the polygon; toggle off to 
define polygons by the mid-points of opposite sides of the polygon; Vertex is toggled 
on by defau  

opposite each other); toggle off to define the radius of the polygon (the center point 
 or vertex); Diameter is toggled on by de

to draw polygons as though a circle was inscribed within them (see Figure 9.1); 

ing Rectangles 
dra  a rectangle, you must select two diagonally opposite corner points. The 

 coordinat

 To draw a rectangle: 

1. Click on Polygons in the Edit menu. 

2. Cl

3. Toggle CntrPnt on to automatically add a snap poin
of the rectangle. If Walls are toggled on and the Outside or Inside option 
in the Architct menu is toggled on as well, you will be prompted to 
indicate the inside o
second point for your r

4. Click in the Drawing Area or use coordinate entry to select the first point 
of the rectangle. For mor
“Drawing Using Coordinate Entry” in “The Drawing Board” chapt

Move the cursor diagonally and click or use coordinate entry to enter the 
second point of the rectangle. The rectangle is drawn. 
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Dr
You c using a wide 
variety of methods.  

awing Curves 
an draw circles, arcs, ellipses, and other curvilinear entities 

Drawing 2-Point Arcs 
Two-point arcs are drawn by indicating the radius of the arc and then defining 
the length of the arc. 

Second Point

First Point
Center Point 

.2: 2-point arc Figure 9

 To 

enu 

2. k on 2D Curves in 
bmenu. 

3.  menu to preview the arc before you 

 

se 
ing 

art point of arc”. 

6. ise from the first point; toggle it 

7. the arc by clicking in the Drawing Area or use 
, 

t have to be exactly on the arc. The arc is drawn. 

Draw t Arcs 
Thr e end points of the arc as well as one 

draw a 2-point arc: 

1. Click on Curves in the Edit menu in the Menu Window. The Curves m
is displayed in the Menu Window. 

Click on 2PtArc in the Curves menu. You can also clic
the Create pull-down menu and then click on 2-Point Arc in the su
The 2PtArc menu is displayed. 

Toggle Dynamic on in the 2PtArc
enter the final point. With Dynamic toggled on, you can move your 
mouse around the center point to preview the arc at various angles before
selecting the second point. You are prompted to “Select center of arc”. 

4. Select the center point of the arc by clicking in the Drawing Area or u
coordinate entry. For more information on coordinate entry, see “Draw
Using Coordinate Entry” in “The Drawing Board” chapter. You are 
prompted to “Select st

5. Select the first point on the arc by clicking in the Drawing Area or use 
coordinate entry. The ClkWise option is now available in the menu. You 
are prompted to “Select end point of arc”. 

Toggle ClkWise on to draw the arc clockw
off to draw the arc counterclockwise. 

Select the second point on 
coordinate entry. This point is used only to determine the angle of the arc
so it doesn’

ing 3-Poin
ee-point arcs are drawn by selecting th

other point on the arc. 
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Second Point

Third Point

First Point  
Figure 9.3: 3-point arc 

nt arc: 

u 

2. 

3. Toggle Dynamic on in the 3PtArc menu to preview the arc before you 

ird 

4. 
coordinate entry. You are prompted to “Select second end point of 

ate entry, see “Drawing Using 
dinate Entry” in “The Drawing Board” chapter. 

5. S le r 
usin
poi  arc will be drawn in a counterclockwise direction. You are 
prompted to “Select any point on the arc”. 

6. le
coor

Drawing
You can r

 To draw a 3-poi

1. Click on Curves in the Edit menu in the Menu Window. The Curves men
is displayed in the Menu Window. 

Click on 3PtArc in the Curves menu. You can also click on 2D Curves in 
the Create pull-down menu and then click on 3-Point Arc in the submenu. 
The 3PtArc menu is displayed. 

enter the final point. With Dynamic toggled on, you can move your 
mouse to preview the arc at various angles before selecting the th
point. You are prompted to “Select first end point of arc”. 

Select the first end point of the arc by clicking in the Drawing Area or 
using 
arc”. For more information on coordin
Coor

e ct the second end point of the arc by clicking in the Drawing Area o
g coordinate entry. Keep in mind when selecting the second end 

nt that the

Se ct the third point on the arc by clicking in the Drawing Area or using 
dinate entry. The arc is drawn, along with its center point. 

 Arcs By Center Angle 
 d aw arcs based on a center angle that you define. 

 
Figu

 To 

indow. The Curves menu 
is displayed in the Menu Window. 

re 9.4: An arc defined by selecting an end point, the center point, and an angle 

draw an arc by defining the center angle: 

1. Click on Curves in the Edit menu in the Menu W
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2. Click on CentAngl in the Curves menu. You can also click on 2D C
in the Create pull-down menu and then click on Center Angle Arc in t
submenu. The CentAngl menu is displayed, and you are prompted to 
“Select starting poi

urves 
he 

nt of arc”. 

e Drawing Area or 

 

splayed in the Menu Window. 

 

Dra
You can

3. Select the first end point of the arc by clicking in th
using coordinate entry. For more information on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 
Keep in mind when selecting this starting point that the arc will be drawn
in a counterclockwise direction. You are prompted to “Select center of 
arc”. 

4. Select the center point of the arc by click in the Drawing Area or using 
coordinate entry. You are prompted to “Enter included angle”, and a 
value menu listing angle values is di

5. Type an angle or use the value menu to enter an angle, and press (Enter). 
For more information on using value menus, see “Value Menus” in “The
Drawing Board” chapter. The arc is drawn. 

wing Arcs By Arc Length 
 draw arcs by defining their length. 

 
Figure 9. n arc defined by the starting point, center point, and length of the arc 5: A

 To draw

ves in the Edit menu in the Menu Window. The Curves menu 
. 

n 
. 

The rompted to “Select starting 
point of arc”. 

end point of the arc by clicking in the Drawing Area or 

ee n 

arc”. 

4. Select the center point of the arc by clicking in the Drawing Area or using 
coordinate entry. You are prompted to “Enter arc length”; a value menu 
listing length values is displayed in the Menu Window. 

 an arc based on the arc’s length: 

1. Click on Cur
is displayed in the Menu Window

2. Click on CentArc in the Curves menu. You can also click on 2D Curves i
the Create pull-down menu and then click on Center Arc in the submenu

 CentArc menu is displayed, and you are p

3. Select the first 
using coordinate entry. For more information on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 

nt that the arc will be drawK p in mind when selecting this starting poi
in a counterclockwise direction. You are prompted to “Select center of 
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5. 5. Type a length or use the value menu to enter a length, and press (Enter). For more 
r. The information on using value menus, see “Value Menus” in “The Drawing Board” chapte

arc is drawn. 

Drawing Arcs By Chord Length 
You can draw arcs by defining the length of a chord, measuring from the starting 
point of the arc to an end point. 

 
.6: An arc defined by seFigure 9 lecting the starting point of the arc, its center point, and the 

length of a chord from end point to end point. 

 To draw an 

u 

ves 

re prompted to 

3. Area or using 
g 
 

. You are prompted to “Select center of arc”. 

4. Select the center point of the arc by clicking in the Drawing Area or using 
ter chord length”; a value 

to enter a length, and press (Enter). 

Draw
You n of the 
arc’s ra

arc based on chord length: 

1. Click on Curves in the Edit menu in the Menu Window. The Curves men
is displayed in the Menu Window. 

2. Click on CentChrd in the Curves menu. You can also click on 2D Cur
in the Create pull-down menu and then click on Center Chord Arc in the 
submenu. The CentChrd menu is displayed, and you a
“Select starting point of arc”. 

Select the first end point of the arc by click in the Drawing 
coordinate entry. For more information on coordinate entry, see “Drawin
Using Coordinate Entry” in “The Drawing Board” chapter. Keep in mind
when selecting this starting point that the arc will be drawn in a 
counterclockwise direction

coordinate entry. You are prompted to “En
menu listing length values is displayed in the Menu Window. For more 
information on using value menus, see “Value Menus” in “The Drawing 
Board” chapter. 

5. Type a length or use the value menu 
The arc is drawn. 

ing Arcs By Radius 
 ca  draw arcs by selecting two endpoints and then entering the length 

dius. 
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.7: An arc defined by selecting a starting point and an ending point for the arc and 
ting an arc radius 

Figure 9
then set

 To draw an arc based on a specified radius: 

1. enu 

2. nu. You can also click on 2D Curves 
in the Create pull-down menu and then click on End Point Radius Arc in 

you are prompted to 

Click on Curves in the Edit menu in the Menu Window. The Curves m
is displayed in the Menu Window. 

 Click on EndPtRad in the Curves me

the submenu. The EndPtRad menu is displayed, and 
“Select starting point of arc”. 

To properly define an arc, you must make the radius value larger than half the 
distance between the starting and ending points. If the message “These poi
not define an arc” is dis

nts do 
played, increase the radius length. 

3. Select the first end point of the arc by clicking in the Drawing Area or 
using coordinate entry. Keep in mind when selecting this starting poin
that the arc will be drawn in a counterclockwise direction. You are 
prompted to “Select e

t 

nding point of arc”. 

4. Select the end point of the arc by clicking in the Drawing Area or using 
e prompted to “Enter radius of arc”; a value menu 

 the value menu to enter a radius, and press 
(Ent

angle. 

coordinate entry. You ar
listing radius length values is displayed in the Menu Window. 

5. Type a radius length or use
er). The arc is drawn. 

Drawing Arcs By Included Angle 
You can draw arcs by selecting the end points of the arc and then entering an arc 

 
n arc defined by selecting a starting point and an ending point and then enteringFigure 9.8: A  

the included angle for the arc. 
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 To  an arc based on its included angle: 

k on Curves in the Edit menu in the Menu Window. The Curves m
isplayed in the Menu Window. 

draw

1. Clic enu 
is d

in t  Point Angle Arc in 
the

3. Sele
e 
. 

Kee will be drawn 
in a counterclockwise direction. You are prompted to “Select ending point 

alue 

5. Type an angle or use the value menu to enter an angle, and press (Enter). 
 value menus, see “Value Menus” in “The 

Drawing Arcs Using a T
The a
the angle of 

2. Click on EndPtAng in the Curves menu. You can also click on 2D Curves 
he Create pull-down menu and then click on End
 submenu. The EndPtAng menu is displayed, and you are prompted 

to “Select starting point of arc”. 

ct the first end point of the arc by clicking in the Drawing Area or 
using coordinate entry. For more information on coordinate entry, se
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter

p in mind when selecting this starting point that the arc 

of arc”. 

4. Select the end point of the arc by clicking in the Drawing Area or using 
coordinate entry. You are prompted to “Enter included angle”; a v
menu listing angle values is displayed in the Menu Window. 

For more information on using
Drawing Board” chapter.  The arc is drawn. 

angent Line 
 St rtDir option in the Curves menu uses a temporary tangent line to define 

the arc. 

 
Figure 9.9: nd then setting the arc angle by 
plac  

 To d

1. Click on Curves in the Edit menu in the Menu Window. The Curves menu 

2. n 
enu and then click on Start Direction of Arc in the 

rting point of arc”. 

3. 
usi
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 
Keep in mind when selecting this starting point that the arc will be drawn 
in a counterclockwise direction. You are prompted to “Select ending point 
of arc”. 

 An arc defined by selecting two end points a
ing a temporary tangent line 

raw an arc using a temporary tangent line: 

is displayed in the Menu Window. 

Click on StartDir in the Curves menu. You can also click on 2D Curves i
the Create pull-down m
submenu. The StartDir menu is displayed, and you are prompted to 
“Select sta

Select the first end point of the arc by clicking in the Drawing Area or 
ng coordinate entry. For more information on coordinate entry, see 
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4. 
coo ”. 
No d 
the

5. c 
you

6. Click to set the tangent line. The arc is drawn. If Ortho mode is toggled 
 

Drawing T
You can dra y simply selecting 
the

 To 

1.  the Menu Window. The Curves menu 

2. 

ption that is 
 

3. 

ing, see “Object 
g 

nu (or simply right-click using 
your mouse) to deselect the entity; you can then select another entity for 

ou are prompted to “Select ending point of arc”. 

sing 
y, see “Drawing 

si
ra

drawing tangent arcs by entering end points. Right-click to detach your 
cur

Drawing
You can dr

Select the end point of the arc by clicking in the Drawing Area or using 
rdinate entry. You are prompted to “Select starting direction of arc
tice that a line is now connected to the starting point you entered, an
 line moves as you move your mouse.   

Move your cursor until the line is positioned as a tangent line to the ar
 want to draw.  

on, the tangent line will “jump” in increments equal to the snap angle
setting. For more information on about Ortho mode, see “Using 
SWOTHLUDFB” in “The Drawing Board” chapter. 

angent Arcs 
w arcs that are tangent to an existing line or arc b

 entity to be tangent and then selecting an end point. 

draw arcs tangent to another entity: 

Click on Curves in the Edit menu in
is displayed in the Menu Window. 

Click on Tangent in the Curves menu. You can also click on 2D Curves in 
the Create pull-down menu and then click on Tangent Arc in the 
submenu. The Tangent menu is displayed with a Dynamic o
toggled on by default, allowing you to preview the arc before entering the
final point.  You are prompted to “Select line or arc from which to draw”. 

Move your cursor over the entity that will be tangent to the arc you’re 
drawing and click to select it. You can also object snap to an entity at a 
particular point. For more information on object snapp
Snapping” in the “Drawing Tools” chapter.If you’ve selected the wron
entity, click on NewLine in the Tangent me

your tangent. Y

4. Select the end point of the arc by clicking in the Drawing Area or u
coordinate entry. For more information on coordinate entr
U g Coordinate Entry” in “The Drawing Board” chapter. The arc is n
d wn. Notice your cursor is still attached to the arc. You can continue 

sor from the last arc you drew. 

 Circles By Radius 
aw a circle by defining its radius. 
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 A circle defined by selecting a center point and a point on the circle Figure 9.10:

raw

1. Clic enu 

2. Clic n 
e

ub
toggled on by default, allowing you to preview the circle before you select 

e prompted to “Select center of circle”. 

r 

Notice the radius (and therefore the circle) changes size as you move your 
prompted to “Select any point on circle”. 

Draw
You ca

 To d ased on its radius: 

k on Curves in the Edit menu in the Menu Window. The Curves m

 a circle b

is displayed in the Menu Window. 

k on RadCirc in the Curves menu. You can also click on 2D Curves i
 Create pull-down menu and then clicth k on Radius Circle in the 

s menu. The RadCirc menu is displayed with a Dynamic option that is 

the last point. You ar

3. Select the center point of the circle by clicking in the Drawing Area o
using coordinate entry. For more information on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 

mouse. You are 

4. Select a point on the circle by clicking in the Drawing Area or using 
coordinate entry. The circle is drawn. 

ing Circles By Diameter 
n draw a circle by defining its diameter. 

 
.11: A circle defined by selecting two points opposite each other on the circle 

cle based on its diameter: 

Figure 9

 To draw a cir

 1. Click on Curves in the Edit menu in the Menu Window. The Curves menu
is displayed in the Menu Window. 
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2. Click on DiaCirc in the Curves menu. You can also click on 2D Curves 
the Create pull-down menu and then click on Diameter Circle in the 
submenu. The DiaCirc

in 

 menu is displayed with a Dynamic option that is 
ect 

3. ng 
ice the diameter (and therefore the circle) changes 

oint 

4. 
entry. The circle is drawn. 

Drawi
You can

toggled on by default, allowing you to preview the circle before you sel
the last point. You are prompted to “Select first point on circle”. 

Select the first point on the circle by clicking in the Drawing Area or usi
coordinate entry. Not
size as you move your mouse. You are prompted to “Select second p
on circle”. 

Select the second point on the circle by clicking in the Drawing Area or 
using coordinate 

ng Circles By Points 
 draw a circle by defining three points on the circle. 

 
.12: A circle defined by selecting three points Figure 9

 

1. 

2. 
ircle in the 

submenu. The 3PtCirc menu is displayed with a Dynamic option that is 
ct 

3. g 

inate Entry” in “The Drawing Board” chapter. You are 
prompted to “Select second point on circle”. 

4. e circle by clicking in the Drawing Area or 
using coordinate entry. Notice the circle changes size as you move your 

ompted to “Select third point on circle”. 

ele
usin  The circle is drawn. 

To draw a circle by selecting points: 

Click on Curves in the Edit menu in the Menu Window. The Curves menu 
is displayed in the Menu Window. 

Click on 3PtCirc in the Curves menu. You can also click on 2D Curves in 
the Create pull-down menu and then click on 3-Point C

toggled on by default, allowing you to preview the circle before you sele
the last point. You are prompted to “Select first point on circle”. 

Select the first point on the circle by clicking in the Drawing Area or usin
coordinate entry. For more information on coordinate entry, see “Drawing 
Using Coord

Select the second point on th

mouse. You are pr

5. S ct the third point on the circle by clicking in the Drawing Area or 
g coordinate entry.
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Drawing Ellipses 
You can draw ellipses by simply selecting two diagonally opposed points, as 

 were selecting two diagothough you nal corners of a rectangle. 

1. Clic  Curves menu 
is displayed in the Menu Window. 

 Clic ed with a 
Dynamic option that is toggled on by default, allowing you to preview 
the  “Select 
firs

usin
“Dr
No
are 

usin

Drawing Curves Using Control Points 
plex curves by selecting control points that affect how 

 To draw an ellipse: 

k on Curves in the Edit menu in the Menu Window. The

2. k on Ellipse in the Curves menu. The Ellipse menu is display

 ellipse before you select the last point. You are prompted to
t corner of ellipse rectangle”. 

3. Select the first point for the ellipse by clicking in the Drawing Area or 
g coordinate entry. For more information on coordinate entry, see 
awing Using Coordinate Entry” in “The Drawing Board” chapter. 

tice the ellipse changes shape and size as you move your mouse. You 
prompted to “Select second corner of ellipse rectangle”. 

4. Select the second point for the ellipse by clicking in the Drawing Area or 
g coordinate entry. The ellipse is drawn. 

You can draw more com
the curves are drawn. 

 
 A Bezier curve with selected control points Figure 9.13:

 
Figure 9.14: A B-spline curve with selected control points 
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o draw a Bezier curve: 

1. Click on Curves in the Edit menu in the Menu Window. The Curves menu 
is displayed in the Menu Window. 

2. Click on Bezier in the Curves menu. You can also click on 2D Curves in 
the Create pull-down menu and then click on Bezier Curve in the 
submenu. The Bezier menu is displayed with a Dynamic option that is 
toggled on by default, allowing you to preview the curve as you select 
control points. You are prompted to “Select Bezier control point”. 

3. Select a control point for the curve by clicking in the Drawing Area or 
using coordinate entry. For more information on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 

4. Continue selecting control points; you must select at least three but no 
more than eight points.  

5. Right-click to detach your cursor from the curve. The Bezier curve is 
drawn. If you enter all eight control points, your cursor is detached 
automatically and the curve is drawn. 

The formula used to create B-spline curves in DataCAD is specific to Third Order 
splines. 

 To draw a B-spline curve: 

1. Click on Curves in the Edit menu in the Menu Window. The Curves menu 
is displayed in the Menu Window. 

2. Click on B-Spline in the Curves menu. You can also click on 2D Curves in 
the Create pull-down menu and then click on B-Spline Curve in the 
submenu. The B-Spline menu is displayed with a Dynamic option that is 
toggled on by default, allowing you to preview the curve as you select 
control points. You are prompted to “Select B-Spline control point”. 

3. Select a control point for the curve by clicking in the Drawing Area or 
using coordinate entry. For more information on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 

4. Continue selecting control points; you must select at least three but no 
more than eight points.  

5. Right-click to detach your cursor from the curve. The B-spline curve is 
drawn. If you enter all eight control points, your cursor is detached 
automatically and the curve is drawn. 

Drawing Curves Using Surveyor’s Data 
You can draw curves based on surveyor’s data that you enter. Based on this data 
and the options you use, DataCAD can even extrapolate additional data. For 
instance, if you enter the radius point of the curve, the central angle of the curve 
and the starting point of the curve, DataCAD can calculate the coordinates of the 
ending point and draw the curve. For more information on the options noted in 
Figure 9.15, see “CurvData Menu Options” on the following page. 

 T
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Figure 9.15: An arc drawn by entering surveyor’s data 

 To draw a curve using surveyor’s data: 

1. Click on Curves in the Edit menu in the Menu Window. The Curves menu 
is displayed in the Menu Window. 

2. Click on CurvData in the Curves menu. You can also click on 2D Curves 
in the Create pull-down menu and then click on Curve from Data in the 
submenu. The CurvData menu is displayed. 

3. Enter the surveyor’s data using CurvData menu options. Once enough 
information has been entered to draw the curve, an Add option is 
displayed in the CurvData menu. 

4. Click on Add. The curve is drawn. 

CurvData Menu Options 
RP Defines the center, or radius point, of the curve 
PC Defines the starting point, or the point of curve, of the curve 
PT Defines the ending point, or point of tangency, of the curve 
PI Defines the point of intersection, where the tangent line intersects the starting point 

(PC) of the curve 
Angle Defines the central angle about the radius point 
Radius Defines the radius of the curve, or the distance between the radius point and the 

starting point (PC) or the ending point (PT) of the curve 
Tangent Defines the distance from the starting point (PC) or ending point (PT) to the 

intersection of the tangent lines to these two points 
Chord Defines the straight-line distance between the starting point (PC) and the ending 

point (PT) of the curve 
ArcLnth Defines the distance along the curve from the starting point (PC) to the ending point 

(PT) 
BrngIn Defines the bearing of the line going into the starting point (PC) of the curve 
BrngOut Defines the bearing of the line going away from the ending point (PT) of the curve 
BrngPC Defines the bearing of the line from the radius point to the starting point (PC) of the 

curve 
BrngPT Defines the bearing of the line from the radius point to the ending point (PT) of the 

curve 
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Drawing Polylines 
 series of lines and/or arcs that are treated by DataCAD A polyline is a continuous

as a single entity. You can use the RectAngl option to quickly draw rectangular 
polylines or draw polylines, segment by segment. Polylines drawn this way can 
be open or closed depending on whether you toggle Closed off or on.  

Closed

Open  
Figure 9.16: Examples of a closed polyline (drawn with Closed toggled on) and an open 

Clo
about h
cannot
polylin  
the “D

 To 

1. 

2. 

3. t first 

4. 

 To draw a polyline, segment by segment: 

1. Click on Curves in the Edit menu in the Menu Window. 

polyline (drawn with Closed toggle off) 

sed polylines can be hatched; see the “Hatch” chapter for more information 
atching. If your polyline(no matter how irregular) is not closed, you 

 hatch it.  In addition, you can measure the area or perimeter of a closed 
e or find its centroid; see “Measuring Areas, Perimeters, and Volumes” in
rawing Tools” chapter for more information. 

draw a rectangular polyline: 

Click on Curves in the Edit menu in the Menu Window. 

Click on Polyline in the Curves menu. 

Click on RectAngl in the Polyline menu. You are prompted to “Selec
corner of rectangle”. 

Click in the Drawing Area or object snap to a point to select the first 
corner of the polyline. Notice that the rectangle stretches as you move 
your cursor. You are prompted to “Select second corner of rectangle”. 

5. Click in the Drawing Area or object snap to a point to select the second 
corner of the polyline. The polyline is drawn. 
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2. Click on Polyline in the Curves menu. Closed is toggled on by defau
allowing you to draw a polyline that will automatically be closed whe
you’re finished selecting points. 

lt, 
n 

You are prompted to “Select first point on 

3. r 
ate entry. For more information on coordinate entry, see 

e 

, 2-point arcs, or 3-point arcs to your polyline: 

• To select the second point of a line segment, click in the Drawing 
Area, use coordinate entry, or object snap to a point on an entity. 

n 3PtArc in the Polyline menu. Select a 
int 

t the 3-point arc function. 

ter you right-click to exit the arc 

5. ur polyline by clicking on Tangent in the Polyline 

6. il 

7. 
’re 

 is 

 

1. n Curves in the Edit menu in the Menu Window. 

lt in 

4. 

5. the View pull-down menu to look at the 

polyline”. 

Select the first point for the polyline by clicking in the Drawing Area o
using coordin
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Th
options 2PtArc and 3PtArc are displayed in the Polyline menu. You are 
prompted to “Select next point on polyline”. 

4. Add line segments

• To draw a 2-point arc, click on 2PtArc in the Polyline menu. Select a 
center point for the arc, and then select an end point. Right-click to 
exit the 2-point arc function. 

• To draw a 3-point arc, click o
second end point for the arc (with the first end point being the po
you selected in the previous step), and then select any other point on 
the arc. Right-click to exi

 The option Tangent is displayed in the Polyline menu after you finish 
drawing the first line segment or af
functions. You are prompted to “Select next point on polyline”. 

Draw a tangent arc in yo
menu. Move your cursor until the arc displayed is the one you want 
drawn, and then click to draw the arc. 

Continue drawing line segments or arcs, as outlined in steps 4 and 5, unt
your polyline is complete. 

Click Backup any time to erase the last line segment or arc of your 
polyline. You can click Cancel at any time to erase the polyline you
drawing. 

8. Right-click to finish the polyline. If Closed is toggled on, the polyline
automatically closed. If Closed is toggled off, your cursor is detached 
from the last point of the polyline. 

To draw a polyline that is both closed and covered: 

Click o

2. Click on Polyline in the Curves menu. Closed is toggled on by defau
the Polyline menu. 

3. Toggle Covered on in the Polyline menu. 

Draw the polyline. Right-click when you are finished. 

Select Object Viewer from 
covered polyline from all angles.  
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Contour Search 
Contour search (ContSrch) is an option that is available in the Curves, Polyline, 
Hatch, and Boundary menus. With this tool, you can easily create outlines for 
fills and hatches. It automatically searches for the boundaries of a closed shape 
and creates a polyline around it. For example, contour search can find the edges 
of your walls in plan view so that you can add a hatch pattern to your drawing. 

 s

1. g window. 

e Polyline 
n

3. Cli  
poi

Hin e color if you want the contour to be 

To earch for the contour of a closed polyline: 

Make sure you have a closed polyline in your drawin

2. Select Curves from the Edit menu and click on Polyline. Th
me u appears. 

ck on ContSrch from the Polyline menu. You are prompted to “Select
nt inside/outside contour.”  

t: You can press (K) to change th
obvious. 

4. Cli d polyline or entity. 
sed 

p l sor within a closed group of 
lines. DataCAD searches for the boundary and draws a closed polyline 

You can also select Hatch fr Utility menu, select Boundary from the Hatch 
me  
or entit

Ed
You
conver
conver ify arcs in the polyline, 
convert lines and arcs into a polyline, or open or close a polyline. A vertex is the 

 polyline intersect, usually marked with a point. 

 can 

yline; you must convert 
the entire polyline. 

  convert a

1. 

2. u. The Edit menu is displayed. 

t 

4. Move your mouse over one of the lines or vertices of the polyline and 
click. The polyline is exploded. 

ck an entity along the boundary of the close
DataCAD creates a closed polyline that corresponds to the original clo

o yline. Alternatively, you can place the cur

around the perimeter. 

om the 
nu, and click on ContSrch. Then, click on the boundary of the closed polyline

y so that DataCAD can draw around its perimeter. 

iting Polylines 
 can edit any polyline in your drawing. You can add or delete a vertex, 

t line segments to curves and curves to line segments, move a vertex, 
t the entire polyline into lines and arcs, mod

point where two segments of the

Converting Polylines 

You can convert a polyline to standard lines and curves, and conversely you
convert lines and arcs into a single polyline. You can also convert an open 
polyline to a closed one. A polyline is considered a single entity by DataCAD.  
You cannot convert a single line or arc that is part of a pol

To  polyline into standard lines and arcs: 

Click on Polyline in the Curves menu. The Polyline menu is displayed. 

Click on Edit in the Polyline men

3. Click on Explode in the Polyline menu. You are prompted to “Selec
polyline to explode into lines/arcs”. 
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 c

1. 

2. 

3.  start 
”. 

ggle AndCopy off to convert the lines and arcs 

5. olyline and 

e displayed in the Message Area. 

2. 

3. 

 To 

1. 

2. 

3. 
area enclosed by lines, a polyline is created, 

sed 

od to define the boundary. 

  

1. 

2. 

if you want to convert the polyline to a slab. 

Editing Polyline Vertices  

You can add, delete, or move a vertex on a polyline. The MoveCrnr option lets 
you move a vertex freely; the DynCrnr option preserves the angle of the existing 
vertex while letting you move it. 

To onvert lines and arcs into a polyline: 

Click on Polyline in the Curves menu. The Polyline menu is displayed. 

Click on Edit in the Polyline menu. The Edit menu is displayed. 

Click on Generate in the Polyline menu. You are prompted to “Select
point of polyline

4. Toggle AndCopy on to retain the original lines and arcs and draw a 
polyline on top of them; to
to a polyline. 

Move your mouse over one of the lines or vertices of the p
click. Dots are drawn at each vertex of the new polyline, and its 
perimeter, area, and volume ar

 To open or close a polyline: 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

Click on Edit in the Polyline menu. The Edit menu is displayed. 

Click on Close in the Edit menu. You are prompted to “Select polyline to 
be closed”. 

4. Move your mouse over the polyline and click. A line segment is added to 
the polyline, closing it. 

convert a closed shape to a polyline: 

Click on Polyline in the Curves menu. The Polyline menu is displayed. 

Click on ContSrch in the Polyline menu. The ContSrch menu is displayed, 
and you are prompted to “Select point inside/outside contour”. 

Click inside the area you want to convert, or click outside the area. If 
contour search finds an 
tracing those lines. If contour search cannot find a completely enclo
area, the message “Contour is not closed” is displayed; you must search 
again or use another meth

To convert a closed polyline to a polygon or slab: 

Select DCAD 3D from the Edit menu. This displays the 3DEdit menu. 

Click on Explode. The Explode menu appears. 

3. Select ToPgons if you want to convert the polyline to a polygon; 
alternatively, select ToSlab 
These are mutually exclusive toggle switches. “Select entity to 
<EXPLODE>” appears in the message area. 

4. Click on the closed polygon you want to convert. 
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 To add a vertex to a polyline: 

6. Move your mouse to position the new vertex and click, or use coordinate 
entry to enter the vertex position. The new vertex is added and the 
polyline is modified. 

7. Repeat steps 4 and 5 to continue adding vertices to polylines in your 
drawing. To exit this function, click on another Edit menu option, or 
right-click until the Polyline menu is displayed again in the Menu 
Window. 

 To delete a vertex from a polyline: 

3. Click on DelCrnr in the Edit menu. You are prompted to “Select corner to 
be deleted”. 

5. Repeat the previous step to continue deleting vertices from polylines in 
 another Edit menu option, or 

 To 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

2. 

3. er 

4. 

ur 

6. e to reposition the vertex and click; you can also use 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

2. Click on Edit in the Polyline menu. The Edit menu is displayed. 

3. Click on AddCrnr in the Edit menu. You are prompted to “Select edge to 
which to add the corner”. 

4. Toggle Info on at the bottom of the Edit menu to display the area and 
perimeter of the polyline, as you position the new vertex.  

5. Move your mouse over the line or arc segment of the polyline that you 
want to add the vertex to, and click. Notice your cursor is now attached to 
the segment; this point will be the new vertex.  

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

2. Click on Edit in the Polyline menu. The Edit menu is displayed. 

4. Move your mouse over the vertex that you want to delete, and click. The 
vertex is deleted, and the polyline is modified. 

your drawing. To exit this function, click on
right-click until the Polyline menu is displayed again in the Menu 
Window. 

move a vertex on a polyline: 

Click on Edit in the Polyline menu. The Edit menu is displayed. 

Click on MoveCrnr in the Edit menu. You are prompted to “Select corn
to be moved”. 

Toggle Info on at the bottom of the Edit menu to display the area and 
perimeter of the polyline, as you reposition the vertex. 

5. Move your mouse over the vertex that you want to move, and click. Yo
cursor is now attached to the vertex you selected. 

Move your mous
coordinate entry to precisely position the vertex. The new vertex is 
moved and the polyline is modified. 
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7. Repeat steps 4 and 5 to continue moving vertices on polylines in your 
drawing. To exit this function, click on another Edit menu option, or 
right-click until the Polyline menu is displayed again in the Menu 
Window. 

 To move a vertex dynamically: 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

Click on Edit in the Polyline menu. The Edit menu is displayed. 

Click on DynCrnr in the Edit menu. You are pro

2. 

3. mpted to “Select corner to 

4. 

6. 
 

7. 
s function, click on another Edit menu option, or 

Editing

  edit an ar

1. u. The Polyline menu is displayed. 

3.  

eposition the arc. 

t 

ate entry to edit the 

 and 5 to continue editing arcs on the polyline. To exit this 
function, click on another Edit menu option, or right-click until the 
Polyline menu is displayed again in the Menu Window. 

be moved”. 

Toggle Info on at the bottom of the Edit menu to display the area and 
perimeter of the polyline, as you reposition the vertex. 

5. Move your mouse over the vertex that you want to move, and click. Your 
cursor is now attached to the vertex you selected. 

Move your mouse to reposition the vertex and click; you can also use 
coordinate entry to precisely position the vertex. For more information on
coordinate entry, see “Drawing Using Coordinate Entry” in “The 
Drawing Board” chapter. The new vertex is moved and the polyline is 
modified. 

Repeat steps 4 and 5 to continue moving vertices on polylines in your 
drawing. To exit thi
right-click until the Polyline menu is displayed again in the Menu 
Window. 

 Polyline Arcs 

To c in a polyline: 

Click on Polyline in the Curves men

2. Click on Edit in the Polyline menu. The Edit menu is displayed. 

Click on EditArc in the Polyline menu. You are prompted to “Select arc to
be modified”. 

4. Toggle Info on at the bottom of the Edit menu to display the area and 
perimeter of the polyline, as you r

5. Move your mouse over the arc you want to edit and click. Notice tha
your cursor is now attached to the arc.  

6. Move your mouse to change the arc and then click. The new arc is drawn 
and the polyline is modified. You can also use coordin
arc. For more informa-tion on coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. 

7. Repeat steps 4
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Editing Polyline Edges 

You can drag a polyline’s edge to a new position or delete an edge entirely. 

 To reposition a line in a polyline: 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

2. Click on Edit in the Polyline menu. The Edit menu is displayed. 

3. Click on DragEdge in the Polyline menu. You are prompted to “Select an 
edge to drag”. 

4. Toggle Info on at the bottom of the Edit menu to display the area and 
perimeter of the polyline, as you reposition the edge. 

5. Move your mouse over the edge you want to edit and click. Notice that 
your cursor is now attached to the line.  

6. Move your mouse to change the line’s position and then click. The new 
edge is drawn and the polyline is modified. You can also use coordinate 
entry to edit the edge. For more informa-tion on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. 

ue editing edges on the polyline. To exit this 
function, click on another Edit menu option, or right-click until the 

ow. 

 d

1. ine menu is displayed. 

3.  the Polyline menu. You are prompted to “Select edge 

4. e you want to delete and click. The edge is 

5.  
 

Conver

You can  
arc to a
option: y polyline segment you click 
on. So if you click on an ar
stra
which y

 To c

1. 

2. dit in the Polyline menu. The Edit menu is displayed.. 

3. Click on Arc<>Edge in the Polyline menu. You are prompted to “Select 
edge/arc to be modified”. 

7. Repeat steps 4 and 5 to contin

Polyline menu is displayed again in the Menu Wind

To elete an edge from a polyline: 

Click on Polyline in the Curves menu. The Polyl

2. Click on Edit in the Polyline menu. The Edit menu is displayed. 

Click on Del Edge in
to be deleted”. 

Move your mouse over the edg
deleted  

Repeat the previous step to continue deleting edges on the polyline. To
exit this function, click on another Edit menu option, or right-click until
the Polyline menu is displayed again in the Menu Window. 

ting Edges and Arcs 

 convert an edge (or line) in a polyline to an arc, or conversely, convert an
 straight edge. Both of these actions can be done with a single menu 
 the Arc<>Edge option simply converts an

c, this function will automatically change it to a 
ight line segment; and if you click on an edge, it will convert it to an arc, 

ou can then define by dragging it into position. 

onvert an arc to a straight edge or an edge to an arc: 

Click on Polyline in the Curves menu. The Polyline menu is displayed. 

Click on E
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4. Toggle Info on at the bottom of the Edit menu to display the area and 
perimeter of the polyline, as you convert the edge or arc. 

Move your mouse over the edge or arc that you want to convert and click.5.   

nverted into an arc; move your 

6. it this 

e menu is displayed again in the Menu Window. 

Editing

You r a 
line ing 
the line aning up the line 
exte
groups ataCAD uses a 

1. Select Curves from the Edit menu; then, choose Polyline. 

; then, choose one of these options, 

3.  

  c

. 
us, 

ing file until you modify it 

ed 

us” in “The Drawing Board” chapter. 

• If you clicked on an arc, it is converted into a straight edge. 

• If you clicked on an edge, it is co
mouse to position the arc and click. 

Repeat the previous step to continue converting arcs or edges. To ex
function, click on another Edit menu option, or right-click until the 
Polylin

 Polyline Corners 

 can connect any two nonparallel edges in a polyline with either an arc o
. The Fillets option connects two edges with an arc, automatically adjust

 segments to match the arc radius and, if indicated, cle
nsions to form a smooth curve. Chamfer clips the corners of rectangular 

, connecting two joined sides with a line. By default, D
distance of 1’-0” for the first and second chamfer distance. 

 To edit the vertices of polylines:  

2. Click on Edit in the Polyline menu
depending on what type of vertex you want: 

• Fillets – Clicking on Radius lets you control the fillet.  

• Chamfer – Clicking on Distnces and selecting two values lets you 
control the chamfer. 

Select the first edge of the polyline you want to fillet or chamfer. Then,
click on the second. 

To onnect two lines with an arc: 

1. Choose Fillets from the Cleanup menu. The following options are 
displayed: 

• Radius Sets the fillet radius. To join two nonparallel, 
nonintersecting lines, accept the standard radius of zero
This extends the lines to intersect.After you set the radi
DataCAD saves it with the draw
again. 

• Clip Trims (erases) the line segments extending past the 
intersection of the selected lines; set Clip prior to selecting 
the entities to fillet 

• LyrSrch Scans all layers during selection operations when toggl
on 

2. Select the first line to trim. For more information on using selection 
menus, see “Selection Men
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3. Select the second line to trim. DataCAD creates a fillet at the intersec

connect two lines with a line: 

tion. 

 To 

• Clip Trims (erases) the line segments extending the intersection 

 

To measure the area or perimeter of a closed polyline: 

e and click on Edit. 

2. Click on Area/Per. 

mu s. 

 

 

 

• 

• 

5. Toggle on ContSrch. 

polyline you want to measure. DataCAD traces the 

. 

2. Click on Area/Per to display the Area/Per menu. 

1. Choose Chamfer from the Cleanup menu. The following options appear: 

• Distnces Sets the first and second chamfer distance 

of the selected lines to chamfer 

• LyrSrch Scans all layers during selection operations when toggled 
on 

2. Select the first line to trim. For more information on using selection 
menus, see “Selection Menus” in “The Drawing Board” chapter. 

3. Select the second line trim. A chamfer is created at the intersection of the 
two lines. 

Measuring Polylines 
You can measure the area or perimeter of a closed polyline. If you are measuring 
land, you can use the Acres option. In addition, you can find the closed polyline’s
centroid. 

 

1. Select Curves from the Edit menu; then, choose Polylin

3. Click on Select in the Area/Per menu and click on the closed polyline you 
want to measure. 

4. Select the appropriate toggles. The Perim+ and Perim- options are 
tually exclusive as are the Area+ and Area- toggle

• Acres – displays the area within the closed polyline as acreage. 

• Perim+ - displays the perimeter of the closed polyline.  

• Perim- - subtracts the perimeter of a void contained within a closed 
polyline. This is useful with windows and doors in elevations. 

Area+ - displays the area of the closed polyline. 

Area- - subtracts the area of the void(s) contained wihin a closed 
polyline. 

6. Click on the closed 
contour of the polyline and displays the measurement information in the 
Message Area. 

 To find the centroid of an irregular closed polyline: 

1. Select Curves from the Edit menu; then, choose Polyline and click on Edit
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3. Select ContSrch and click on the closed polyline. 

Voids
You ca
polygo
(to which you want to ad  the closed polyline that 
rep
hatch, 
Then, you would draw closed polylines around each of the windows and doors; 
the

 To a

1. olyline in the Curves menu. The Polyline menu is displayed. 

(s) within that master polyline. 

4.  polyline that you want to put the void in. 

5.  sure Entity and AddVoid are toggled on in the Voids menu. 

You cou rom the Utility 
menu; click Pattern, choose one of the options, and press (Enter); then click 
Begin. The area within the master polyline is hatched, but the voids are not. 
Alternatively, you could fill the master polyline with solid fills or bitmaps. 

 To erase a void polyline: 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

2. Click on Voids in the Polyline menu. “Select master polyline to process 
voids” appears in the Message Window. 

3. Click on the master polyline that contains the void(s) you want to erase. 
The Voids menu appears. 

4. Toggle ErasVoid on. You are prompted to “Select polyline to delete from 

5. Click on a void to erase it. If you want to eliminate more voids, click on 
them, too. 

 To convert a void to a polygon: 

1. Click on Polyline in the Curves menu. The Polyline menu is displayed. 

4. Click on ShowIt to simply display a temporary crosshair or choose AddIt 
to put an actual dot in the center of your closed polyline. 

 in Polylines 
n add voids to or erase voids from polylines as well as convert voids to 
ns. To add a polyline void, you must first draw the closed master polyline 

d the void); then, draw
resents the void itself. For example, in a building elevation that you want to 

you would create a master polyline around the perimeter of the elevation. 

se would become voids or areas that you wouldn’t want to hatch. 

dd a void to a polyline: 

Click on P

2. Draw your master, closed polyline. Then, draw the closed polyline(s) that 
will become your void

3. Click on Voids in the Polyline menu. You are prompted to “Select master 
polyline to process voids”. 

Click on the closed master
DataCAD puts dashed lines around that shape. You are prompted to 
“Select entity to select polylines to convert to voids”. 

Make

6. Click on the polyline that will represent the void. The void is added. 
Dashed lines surround the void. 

7. Continue selecting other closed polylines within the master if necessary. 

ld easily hatch the polyline with voids. Just select Hatch f

drawing”. 
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2. Click on Voids in the Polyline menu.  

The Stairs tool in the DCAD_AEC macro creates basic 2D single- and double-run 

 To 

D_AEC 

 on how to add it to the menu. The Stairs menu is displayed in the 
Menu Window. 

2. tairs in the DCAD_AEC menu.  

raw stairs 
going down, or click on UpAndDn  to draw bidirectional stairs. 

4. l, 
 stairs going up on the right side of the stair 

well. 

5. Customize stair options if necessary: 

• To set the number of stair risers, click on NumRiser. Use the value 
menu or type a number, and press (Enter). For more information on 
using value menus, see “Value Menus” in “The Drawing Board” 
chapter. 

• To set the distance from the railing to the first riser, click on Offset. 
Use the value menu or type a number, and press (Enter). 

• To set the stair width including newel posts and stringers, click on 
StrWidth. Use the value menu or type a number, and press (Enter). 

• To set the width of the stair treads, click on TrdWidth. Use the value 
menu or type a number, and press (Enter). 

• To set the nosing overhang, click on Nosing. Use the value menu or 
type a number, and press (Enter). 

• To set the color of the stairs, click on Color and use the color menu. 
For more information on setting colors, see “Color Menus” in “The 
Drawing Board” chapter. 

6. Click on Rails to customize the stair railings. Railing options are 
displayed in the Menu Window. For details on railing options, see “Stair 
Railing Options” below.You are prompted to “Select railing option”. 

7. Click on a railing option to change the setting. 

3. Toggle ConvVoid on. You are prompted to “Select void to convert to a 
polygon”. 

4. Click on a void to convert it. 

Drawing Stairs 

stairs. 

draw stairs: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCA
menu is displayed in the Menu Window. If DCAD_AEC is not listed in 
the Macros pull-down menu, see “Customizing the Macros Menu” for 
details

Click on S

3. Click on Up Only to draw stairs going up, click on Dn Only to d

Click on Up Left to draw stairs going up on the left side of the stair wel
or click on Up Rght to draw
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8. Click on StrWell to customize the stair well. Stair well options are 
displayed in the Menu Window. For details on stair well options, see 
“Stair Well Options” on the following page. You are prompted to “Select 
stair well option”. 

9. Click on a stair well option to change the setting. 

10. Click on SectnLin to customize the section lines that are drawn when 
UpOnly or UpAndDn is toggled on. Section line options are displayed in 
the Menu Window. For details on section line options, see “Section Line 
Options” on the following page. You are prompted to “Select stair 
variable option”. 

11. Click on a section line option to change the setting. You are prompted to 
“Enter starting location of stair”. 

12. Click in the Drawing Area or use coordinate entry, and press (Enter). For 
more information on coordinate entry, see “Drawing Using Coordinate 
Entry” in “The Drawing Board” chapter. Notice that your cursor is now 
attached to the point you just entered. You are prompted to “Enter point 
along stairs”. 

13. Enter a point along the stair line by clicking in the Drawing Area or using 
coordinate entry, and press (Enter). You are prompted to “Point to inside of 
stair well”. 

14. Click to indicate the inside of the stair well. The stairs are drawn. 

Stair Railing Options 
DrwRail Toggle on to draw railings 
Diameter Set the railing diameter; use the value menu or type a number, and press (Enter) 
Clearnce Set the clearance from the wall (the space between the railing and the wall); use the 

value menu or type a number, and press (Enter) 
RunOut Set the railing runout (the extension past the last tread); use the value menu or type a 

number, and press (Enter) 
Color Set the color of the railings using the color menu. For more information on setting 

colors, see “Color Menus” in “The Drawing Board” chapter. 

Stair Well Options 
DrwWell Toggle on to draw stair wells 
LandLnth Set the stair landing length; use the value menu or type a number, and press (Enter) 
ChseWdth Set the chase width (the distance between stair wells); use the value menu or type a 

number, and press (Enter) 
Color Set the color of the stair wells using the color menu 

Section Line Options 
GapWidth Set the width of the gap between section lines; use the value menu or type a number, 

and press (Enter) 
LinAngle Set the angle of section lines; use the value menu or type a number, and press (Enter) 
LinColor Set the color of section lines using the color menu 
DashSpcg Set the dashed line spacing; use the value menu or type a number, and press (Enter) 
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Drawing Columns 
With the Columns menu in the DCAD_AEC macro, you can draw a single 
column or multiple columns in straight or curved rows. Single columns are 
simply symbols inserted into your drawing. Multiple columns are defined on a 
rectangular or radial grid and drawn with column grid lines that are finished 
with labels identifying the ends of each grid line. 

Drawing a Single Column 
Single columns can be added by simply opening a template and choosing a 
column symbol to add to your drawing. 

 To draw a single column: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. 

2. Click on Columns in the DCAD_AEC menu. If DCAD_AEC is not listed 
in the Macros pull-down menu, see “Customizing the Macros Menu” for 
details on how to add it to the menu. The Columns menu is displayed in 
the Menu Window. 

3. Click on OneColum in the Columns menu. A dialog box is displayed, 
prompting you to “Enter template filename”. 

4. Click on a template of column symbols to open it or change to another 
folder to find the template you want. For more information about using 
templates and symbols, see the “Templates and Symbols” chapter. 

5. Click on Open or press (Enter). The dialog box closes, and a template 
window opens on the right side of the Drawing Area. 

6. Click on the column symbol you want to use. Notice that a box 
representing the symbol is now attached to your cursor. 

7. Click in the Drawing Area to add the symbol to your drawing. You can 
also use coordinate entry to place the symbol. For more information on 
coordinate entry, see “Drawing Using Coordinate Entry” in “The 
Drawing Board” chapter. 

Drawing Rectangular Grids of Columns 
One way to draw multiple columns is to define a rectangular grid. Columns are 
then placed according to the grid. Rectangular grids are defined by the number 
of column rows in both the X and Y directions. 

 To draw a rectangular grid of columns: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. 

2. Click on Columns in the DCAD_AEC menu. The Columns menu is 
displayed in the Menu Window. 

3. Click on RectGrid in the Columns menu. The Rectnglr menu is displayed 
in the Menu Window with all the options for creating rectangular grids. 
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4. Define the number of columns in the grid by clicking on X Rows to set the 
number of columns in the X direction or click on Y Rows to set the 
number of columns in the Y played; type a 
value or use the value men ormation on 

o

ir
between rows in the Y dire

u
X
z

n under “Rectangular Grid Options” below for details on r

 clicking on SymbName. 
dialog box is displayed, prompting you to “Enter symbol fil

7. Click on a column symbol name to use that symbol; or change to another 
folder to find the symbol you want. 

8. Click on Open or press (Enter). The dialog box closes. 

9. Use other options in the Rectnglr menu to customize how columns, the 
column grid, and the labels are drawn. See “Rectangular Grid Options” 
below for details. You are prompted to “Enter grid starting point or 
choose grid option”. 

10. Enter the starting point for the grid by clicking in the Drawing Area or 
using coordinate entry. For more information on coordinate entry, see 
“Drawing Using Coordinate Entry” in “The Drawing Board” chapter. The 
columns are drawn. 

Rectangular Grid Options 

Keep in mind that when the column grid is rotated 90°, the X direction is vertical 
and the Y direction is horizontal. 

X Rows Set the number of rows in the X direction of the grid using the value menu 
Y Rows Set the number of rows in the Y direction of the grid using the value menu 
X Spcg Set the distance between the Y rows using the value menu 
Y Spcg Set the distance between the X rows using the value menu 
SymbName Choose the symbol for the columns you want to draw 
Numbring Customize numbering of grid rows as displayed in grid labels; toggle Lft2Rht on to 

number Y rows of the grid from left to right, or toggle it off to number Y rows from 
right to left; toggle Top2Bot on to letter X rows top to bottom, or toggle it off to letter 
X rows from bottom to top 

Controls Displays toggles for the top, bottom, left, and right sides of the grid: toggle GridLbl 
on to draw labels for that side of the grid; toggle ExtLine on to extend grid lines for 
that side 

Rotation Rotate the column grid, the column symbols or the label text; to rotate the grid, click 
on Rotation, click on ColmGrid, enter a rotation angle using the value menu, and 
press (Enter); to rotate column symbols, click on Rotation, click on Columns, enter a 
rotation angle using the value menu, and press (Enter); to rotate label text, toggle Text 
on (you can’t set a text rotation angle). For more information on using value menus, 
see “Value Menus” in “The Drawing Board” chapter. 

Layers Displays options you can use to set the layers to draw column grid entities on: click 
on GridLayr and then click on the layer to draw the grid lines on; click on SymLayr 
and then click on the layer to draw the label symbols on; click on ColLayr and then 
click on the layer to draw the column symbols on 

 direction. A value menu is dis
u, and press (Enter). For more inf

using value menus, see “Value Menus” in “The Drawing B

5. Click on X Spcg to set the distance between rows in the X d
click on Y Spcg to set the distance 

ard” chapter. 

ection, or 
ction. A 

value menu is displayed; type a value or use the value men
(Enter). Keep in mind that when the grid is rotated 90°, the “
refers to the vertical and the “Y direction” refers to the hori
Rotatio

, and press 
 direction” 
ontal. See 

otating 
the column grid. 

6. Choose the column symbol for the grid by A 
ename”. 
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Colors Displays three options you can use to set the colors to draw column grid entities in; 
olor menu to choose a color for the grid lines; click on 

sing to draw the grid lines 
nction 

on lines 

 

 To draw a radial grid of columns: 

acros pull-down menu. The DCAD_AEC 

2. EC menu. The Columns menu is 

3. 

 

ound the grid origin) by clicking on CurvRows to set the number 

5. 
lue or use the value menu, and press 

n on using value menus, see “Value Menus” in 
“The Drawing Board” chapter. 

6. een the curved rows (set in step 4) by clicking on 
d; type a value or use the value 

•

click on GridColr and use the c
SymColr and use the color menu to choose a color for the label symbols; click on 
ChrColr and use the color menu to choose a color for the label characters 

LnFactor Set the spacing within the linetype that you’re u
LnExtnsn Set the distance that the grid lines extend past the outer column; useful in conju

with LblOffst, which sets the labels’ extension line lengths 
LblOffst Set the distance of the lines extending from the labels to the end of the extensi

of the grid 
CharSize Set the size of the label text; for example, if you are plotting at 1/8” = 1’ scale and you 

want text to plot 1/4” high on the sheet, set this option to 2’ (2 feet at 1/8” scale 
equals 1/4”) 

CharName Set the starting number for the X rows and the starting letter for the Y rows 
CharFont Set the font to be used for label text; the font dialog box is displayed, listing all 

DataCAD fonts (normally found in your DATACAD\CHR folder) 

Drawing Radial Grids of Columns 
One way to draw multiple columns is to define a radial grid. Columns are then 
placed according to the grid. Radial grids are defined by the number of 
concentric column rows around a grid origin and the number of rows radially
from the grid origin. 

1. Click on DCAD_AEC in the M
menu is displayed in the Menu Window. 

Click on Columns in the DCAD_A
displayed in the Menu Window. 

Click on RadlGrid in the Columns menu. The Radial menu is displayed 
with all the options for creating circular grids. See “Radial Grid Options” 
later in this chapter for details on these options.

4. Define the number of concentric column rows in the grid (concentric 
circles ar
of concentric circles in the grid. A value menu is displayed; type a value 
or use the value menu, and press (Enter). 

Set the number of radial rows in the grid by clicking on RadlRows. A 
value menu is displayed; type a va
(Enter). For more informatio

Set the distance betw
CurvSpcg. A value menu is displaye
menu, and press (Enter). 

7. Determine the angle between radial rows using any of three different 
methods: 

 Toggle Fill on and toggle IncAngl off. The angle between radial rows 
is calculated automatically based on where you place the first and last 
radial rows. 
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• Toggle both Fill and IncAngl on. When you click on IncAngl, a valu
menu is displayed, which you

e 
 can use to enter the total included 

ngle between each radial 
row.  

he grid by clicking on SymbName. A 

 

Click on Open or press (Enter). The dialog box closes. 

ustomize how columns, the 
al Grid Options” for 

rid option”. 

 
rawing 

dinate Entry” in “The Drawing Board” chapter. You are 

13. 
 

 as described in the first option in step 6, then you are 

Radial
CurvRows Set the number of curved rows, or concentric circles, around the grid origin 
Rad
CurvSpc en curved rows 
SepAngl rows; available only when Fill is toggled off 
IncA

Fill 
SymbNa
Numbrin d rows as displayed in grid labels: toggle Clkwise on to 

kwise direction, or toggle it off to number 
 the 

Controls l rows: toggle GridLbl on to draw labels for 
 
ow 

Rotation  text: to rotate column symbols, click on Rotation, click 
on Columns, enter a rotation angle using the value menu, and press (Enter); to rotate 
label text, toggle Text on (you can’t specify a text rotation angle). For more 
information on using value menus, see “Value Menus” in “The Drawing Board” 
chapter. 

angle between the first and last radial rows. The angle between the 
remaining radial rows is calculated automatically. 

• Toggle Fill off and click on SepAngl. A value menu is displayed, 
which you can use to enter the separation a

8. Choose the column symbol for t
dialog box is displayed, prompting you to “Enter symbol filename”. 

9. Click on a column symbol name to use that symbol; or change to another
folder to find the symbol you want. 

10. 

11. Use other options in the Radial menu to c
column grid, and the labels are drawn. See “Radi
details and set these options as necessary. You are prompted to “Enter 
grid origin or choose g

12. Enter the origin of the grid by clicking in the Drawing Area or using 
coordinate entry. For more information on coordinate entry, see “D
Using Coor
prompted to “Indicate position of first column. 

Enter the coordinates of the first column by clicking in the Drawing Area 
or using coordinate entry. If you set either the included angle (IncAngl) or
the separation angle (SepAngl) in step 6, the columns are drawn. If you 
toggled Fill on
prompted to “Indicate orientation of last radial row”. 

14. Position the last radial row by clicking in the Drawing Area or using 
coordinate entry. The columns are drawn. 

 Grid Options 

lRows Set the number of radial rows extending out from the grid origin 
g Set the distance betwe

Set the (separation) angle between radial 
ngl Set the (included) angle between the first and last radial rows; available only when 

Fill is toggled on 
Toggle on to automatically calculate the angle between radial rows 

me Choose the symbol for the columns you want to draw 
g Customize numbering of gri

number the radial rows of the grid in a cloc
radial rows counterclockwise; toggle In2Out on to letter the curved rows from
center of the grid outward, or toggle In2Out off to letter curved rows from the 
outermost row inward 
Displays toggles for the first and last radia
the first or last radial row; toggle ExtLine on to draw grid lines for the first or last
radial row; toggle Columns on to draw column symbols in the first or last radial r
Rotate column symbols or label
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Layers Displays three options you can use to set the layers to draw column grid entities o
cli

n: 
ck on GridLayr and then click on the layer to draw the grid lines on; click on 

SymLayr and then click on the layer to draw the label symbols on; click on ColLayr 

ties in: 
k on GridColr and use the color menu to choose a color for the grid lines; click on 

 on 

LnFacto e you’re using to draw the grid lines 
LnE n

y in your 

LblOf nsion lines 

CharSize at 1/8” = 1’ scale and you 
(2 feet at 1/8” scale 

Cha m

CharFon the font to be used for label text; the font dialog box is displayed, listing all 
DataCAD fonts (normally found in your DATACAD\CHR folder 

Draw
With th  can draw a single 
elevator or banks of elevators. Start by customizing the capacities, doors, shaft 
wal . 

 

1. 
he Menu Window. 

displayed; use the Num Cab, Capacity, Cab, Walls, Doors, ByFront, and 
customize your elevators. 

d to 

e 

”. 

apacity value you choose, 
DataCAD automatically resizes the elevator dimensions to match those 

Graphic Standards; you can, however, modify 
using the Cab, Walls, and Doors options. You are 

levator cab. Cab options are displayed in 
the Menu Window. You are prompted to “Select cab variable to change”. 

 is displayed; when you 
click on Color, a color menu is displayed. 

and then click on the layer to draw the column symbols on 
Colors Displays three options you can use to set the colors to draw column grid enti

clic
SymColr and use the color menu to choose a color for the label symbols; click
ChrColr and use the color menu to choose a color for the label characters 

r Set the spacing within the linetyp
xtns  Set the distance of the grid lines extend past the outer column; useful in conjunction 

with LblOffst, which sets the labels’ extension line lengths. The LnExtnsn option is 
useful to extend the grid lines so that grid labels do not overlap another entit
drawing. 

fst Set the distance of the lines extending from the labels to the end of the exte
of the grid 
Set the size of the label text; for example, if you are plotting 
want text to plot 1/4” high on the sheet, set this option to 2’ 
equals 1/4”) 

rNa e Set the starting number for the radial rows and the starting letter for the curved rows. 
The CharName option is useful when you construct a composite grid in which the 
first columns are not necessarily “1” or “A”. 

t Set 

ing Elevators 
e Elevator option in the DCAD_AEC macro, you

ls, and cabs of the elevator banks, then select points to draw the elevators

To draw elevators: 

Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in t

2. Click on Elevator in the DCAD_AEC menu. The Elevator menu is 

ByBack options to 

3. Click on Num Cab. A value menu is displayed, and you are prompte
“Enter number of elevator cabs”. 

4. Type the number of elevator cabs you want in the bank of elevators or us
the value menu to enter the number of cabs, and press (Enter). 

5. Click on Capacity. A list of capacity values in pounds is displayed in the 
Menu Window. You are prompted to “Select standard elevator capacity

6. Click on the capacity value. Based on the c

found in Architectural 
these dimensions 
returned to the Elevator menu. 

7. Click on Cab to customize the e

8. Click on a cab option to change the setting. For all cab options except 
Color, a value menu listing clearance distances
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9. U  the value menu to enter a clearance distance for the cab option or 
e a new

se
typ ect a color for 

lic
is

“El ” below.You are prompted to “Select wall 
var

. Ch Left, Right, or 

valu a new value, 

 options, see 
“Elevator Door Options” below. You are prompted to “Select door 

 

  front or the back wall. When 

 outside face of the 
back elevator shaft wall. Only one of the options, ByFront and ByBack, 

Front is toggled on, you are 

anks. To select the corner of the elevator 
ea or use coordinate entry. For more 

ntry, see “Drawing Using Coordinate Entry” 

 now attached to this point, and you 

16. f the elevator bank or the bearing of the row of 

elevator bank” if ByFront is toggled 
ck is 

17. 

Elevator Cab Options 
front of the elevator cab and the inside face of 

Set the clearance distance between the left side of the elevator (as you face the back of 
the cab) cab and the inside face of the elevator shaft wall 

 value, and press (Enter); use the color menu to sel
the elevator cab lines. 

10. C k on Walls to customize the elevator shaft walls. Walls options are 
d played in the Menu Window. For details on Walls options, see 

evator Shaft Wall Options
iable to change”. 

11 ange wall dimensions by clicking on Front, Back, 
Between. A value menu listing wall dimensions is displayed. Use the 

e menu to enter a dimension for the wall option or type 
and press (Enter). 

12. Click on Doors to customize the elevator doors. Door options are 
displayed in the Menu Window. For details on Doors

variable to change”. 

13. Click on a door option to change the setting.  

14. Position the elevator bank by defining the
you toggle ByFront on, the two points you select in the following steps 
define the outside face of the front elevator shaft wall; when you toggle 
ByBack on, the two points you select will define the

can be toggled on at any one time. If By
prompted to “Enter one front corner of elevator bank”. If ByBack is 
toggled on, you are prompted to “Enter one back corner of elevator 
bank”. 

15. Begin drawing the elevator b
bank, click in the Drawing Ar
information on coordinate e
in “The Drawing Board” chapter. (The elevator bank will be drawn 
starting at this corner.) Your cursor is
are prompted to “Indicate direction of elevator bank”. 

Notice the “direction” o
elevators. Position the line now attached to your cursor so that it’s 
parallel to the front and back of the elevator bank, and click. You are 
prompted to “Point to back side of 
on; you are prompted to “Point to front side of elevator bank” if ByBa
toggled on. 

Click anywhere towards the front or back of the bank, as prompted. The 
bank of elevators is drawn. 

ClearFrt Set the clearance distance between the 
the elevator shaft wall 

ClearBck Set the clearance distance between the back of the elevator cab and the inside face of 
the elevator shaft wall 

ClearLft 
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ClearRht Set the clearance distance between the right side of the elevator cab and the inside
face of the elevator shaft wall 

ClearBtw Set the clearance distance between elevator cabs when the separating shaft wall 
between the cabs is not drawn 

CabWidth Set the width of the elevator cab using the value menu 
CabDepth Set the depth of the elevator cab using the value menu 

 

Color Set the color of the elevator cab lines using the color menu. For more information on 
setting colors, see “Color Menus” in “The Drawing Board” chapter. 

 the value menu 
Between Set the width of the wall between elevator cabs using the value menu 

 wall of the elevator shaft when the elevator banks are 

 

ince 
ck 

DrwCnt  to draw the elevator shaft wall between elevators when the elevator banks 
lls are not drawn. Toggling DrwCntr on 

en elevators. 
Colo

Elevato
None Toggle on to draw elevators without doors 
Single Toggle on to draw elevators with single doors 

ith double doors 

d 
 elevator 

tor 
doors are drawn. 

AtBack Toggle on to draw doors at the back of the elevator bank 
g doors, with the left panel outside and the 

 offset from the center of 
the cab (using the Offset option), toggling Alternat on causes the first elevator to be 

et to the right, and the next to be drawn with the doors 

Width 
Thicknss
Offset tance is the 

istance of 1’-0” center the door one foot to the right of the center of 
fset distance of -1’-0” centers the door one foot to the left of the 

Color rs using the color menu. For more information on 
 Drawing Board” chapter. 

Elevator Shaft Wall Options 
Front Set the width of the front wall of the elevator shaft using the value menu 
Back Set the width of the back wall of the elevator shaft using the value menu 
Left Set the width of the left wall of the elevator shaft using the value menu 
Right Set the width of the right wall of the elevator shaft using

DrwBack Toggle on to draw the back
drawn; when toggled off, the back wall of the elevator shaft is not drawn and the side 
walls of the elevator shaft are extended a distance equal to half the width of the back
wall (in other words, side walls are drawn to the center line of the back wall). 
Toggling DrwBack off allows for easy creation of back-to-back elevator banks, s
two halves of a back wall put together equal one party wall between back-to-ba
cabs. 

r Toggle on
are drawn; when toggled off, these center wa
increases the center-to-center distance betwe

r Set the color of the elevator shaft walls using the color menu 

r Door Options 

Double Toggle on to draw elevators w
Lap Toggle on to draw elevators with overlapping doors 
AtFront Toggle on to draw doors at the front of the elevator bank. Toggle both AtFront an

AtBack on to draw elevators with doors at both the front and the back of the
bank. Toggling both options off is the equivalent of toggling None on: no eleva

Alternat Toggle on to alternate drawing overlappin
left panel inside, on every other elevator; when the door is

drawn with the doors offs
offset to the left, creating the effect of pairs of elevators based on the proximity of 
their doors 
Set the width of the elevator doors using the value menu 

 Set the thickness of the elevator doors using the value menu 
Elevator doors are drawn off-center by the distance specified. The offset dis
distance along the front wall from the center of the cab to the center of the elevator 
door. An offset d
the cab, while an of
center of the cab. 
Set the color of the elevator doo
setting colors, see “Color Menus” in “The
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Other Ways to Draw 
lines and entering points directly in the Drawing Area are the Drawing 

mo D has other tools 
tha
of y

The Copy and Mirror options in the Edit menu are two such tools that 
can 
from dr

DataCA
ideas before you begin drawing. With the FreeHand tool in the 

h in a variety of line widths and 

10 
In this chapter: 

entities 

 Making multiple copies 
of entities 

ntities 

tching 

 

st common ways of drawing. However, DataCA
t can significantly increase your productivity and even the accuracy 
our drawings. 

 Copying 

add entities to your drawing with just a few steps, freeing you 
awing similar things over and over.  

D even offers a tool that can be used to sketch your 

 Mirroring e

 Ske

Utility menu, you can sketc
linetypes. 
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Co
There a opy option in the Edit pull-
down menu (grouped with Cut and Paste) is a standard Windows command and 
can  
Windo ut, Copy, and Paste, see “Basic 
Edi
menu i  
pull-do stance within the same 
drawing. W

• cop

• cop

• copy entities to a different layer in your drawing; or 

ities, arranged in rectangular or circular 

To copy  option in the Move menu. 
See

Co
When y , you are prompted to 
ent w  
copy is defined by these two 
points will b .  

To copy an entity a specified distance and angle: 

1.  Window, or click on Copy 
(located just below the Move option) in the Edit pull-down menu. The 

o copy”. To use the same distance and 

2. oint. 
es 

oints you select in steps 2 and 3 can 
be selected anywhere on the screen; they indicate the distance and angle 

3. Click in the Drawing Area or use coordinate entry to enter the second 
dinate entry, see “Drawing 

try” in “The Drawing Board” chapter. A selection 
he Menu Window.  

n method in the menu. For more information on using 
“Selection Menus” in “The Drawing Board” chapter. 

pying Entities 
re two ways to copy DataCAD entities. The C

 be used to quickly copy entities to other DataCAD drawings or to other 
ws applications. For details on how to use C

ting Tools” in “The Drawing Board” chapter. The Copy option in the Edit 
n the Menu Window (also available just below the Move option in the Edit
wn menu) duplicates entities at a specified di

ith this option, you can: 

y entities at a distance and angle that you set; 

y entities by dragging them  

• make multiple copies of selected ent
arrays 

 entities in the Z direction, use the AndCopy
 “Moving Entities” in the “Editing Drawings” chapter for details.. 

pying Entities a Specified Distance and Angle 
ou use Copy in the Edit menu in the Menu Window

er t o points. The distance between these two points will be the distance the
 drawn from the original selected entity; the angle 

e the angle the copy is drawn from the original selected entity

 

Click on Copy in the Edit menu in the Menu

Copy menu is displayed in the Menu Window, and you are prompted to 
“Select first point of the distance t
angle as the last time you used Copy, click on PrevDist. 

Click in the Drawing Area or use coordinate entry to enter the first p
A directional arrow is displayed; notice that moving your mouse chang
the length and angle of the arrow. You are prompted to “Select second 
point of the distance to copy”. The p

to copy only, and not the beginning and ending points of the copy. 

point. For more information on using coor
Using Coordinate En
menu as well as other Copy options are displayed in t

4. Click on a selectio
selection menus, see 
You are prompted to select the entities you want to copy. 
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5. Select the entities; they are copied in the drawing. You can continue 
selecting entities to make additional copies at the same distance and 
angle. 

Copy entities at the same distance and angle but in the opposite direction
by clicking on Invert and then selecting the entities to be copied (see 
Figure 10.1). 

6.  

7. Enter a new distance and angle by clicking on NewDist and continuing 
with step 2 above. 

Invert Original Copy
 

Figure 10.1: Inverting a copy 

Copying Entites by Dragging 
y 

st y angle. 

tities by dragging them: 

1. Click on Copy in the Edit menu. The Copy menu is displayed in the 
ow. 

The Drag menu is displayed in the 
w. 

3. Toggle LyrSrch on if the entities you want to copy are on a different layer 

plex entities more smoothly by setting the maximum number of 
splayed while dragging. Click on MaxLines and use the 

enu to enter the number of lines. Press (Enter) or right-click to 
 to the D ontain 

 lines than the 
entities is displayed when you begin to drag them. The entities 

fter you select the new location for them. When you set 
, the rectangular box is always displayed while dragging. 

5. Toggle Multi on to make multiple selections of entities to be copied. 

to drag 

8. Check the button for Multi. If it is toggled off, skip to step 9. If you 
n Begin and continue with step 9. 

Instead of entering a specific distance and angle to copy entities, you can simpl
ance and at andrag the copy any di

 To copy en

Menu Wind

2. Click on Drag in the Copy menu. 
Menu Windo

than the active layer. 

4. Drag com
lines to be di
value m
return rag menu. When the entities you selected to drag c
more  the MaxLines setting, a rectangular box representing 
selected 
reappear a
MaxLines to 0

6. Click on a selection method in the menu. You are prompted to select the 
entities you want to copy. 

7. Select the entities to be copied. You are prompted to select a point 
from. 

toggled Multi on in step 5, click o
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9. Click on a point in the Drawing Area; you can also use coordinate entry 

  

Co
You can stance from and perpendicular to the original. 
While you can’t copy an entity at any angle, as you can with the Copy function 

ghtforward way to quickly make one entity 
into an e

 To copy an entity perpendicular to the original: 

fset menu is displayed in the Menu Window. 

nce just as you did in steps 2 and 3 in the 
“Copying Entities a Specified Distance and Angle” on the previous 

 to select two 

he 
fore you place it in your drawing. 

3. rch on if the entities you want to copy are on a different layer 

4.  

5. e original entity. The copy is placed.  

ating steps 4 and 5; or if Dynamic is 
n 

Cop i
When y an one layer in your drawing, the ToLayer option is 
displayed in the Copy menu. T
ano
origina r 
layer at gle. For more information on creating layers, 

ou Draw” chapter. 

or object snapping to select this point. For more information on using 
coordinate entry, see “Drawing Using Coordinate Entry” in “The 
Drawing Board” chapter. 

10. Move your mouse to drag the entities to their new position and click to
place them. The entities are copied in the drawing. 

pying Entities at the Perpendicular 
 copy an entity a specific di

described above, this is a very strai
ntire row. 

1. Click on Geometry in the Tools pull-down menu, and then click on Offset. 
The Of

2. Set the copy distance using one of the following methods: 

• You can define the dista

page. Click in the Drawing Area or use coordinate entry
points to define the distance. 

• You can toggle Dynamic on; you’ll be able to see the position of t
copy be

• You can click on PerpDist to display a value menu. Use the value 
menu or type distance and press (Enter). 

Toggle LyrS
than the active layer. 

Click on the entity you want to copy. The selected entity is displayed in
dashed lines. If you toggled Dynamic on in step 2, a copy of the entity is 
attached to your cursor. You are prompted with “Offset to which side?” 

Click to one side or the other of th

6. Continue copying entities by repe
toggled on, simply repeat step 5. To redefine the offset distance, click o
NewDist and continue with step 2 above. 

y ng to Another Layer 
ou have more th

oLayer is used to copy entities from one layer to 
ther in your drawing. You can copy entities in the same position as the 

l layer (no distance and angle entered) or you can copy entities to anothe
 a specified distance and an

see “Creating Layers” in the “Before Y
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 c

1. y 
ow Move) in the Edit pull-down menu. The Copy menu is 

2. 
 Menu Window, and you are prompted to 

e 

to copy 
ithout 

5. u chose in step 3. You 
ake additional copies. 

 c

1. 
Move option) in the Edit pull-down menu. The 

ed Copy, click on PrevDist. 

dinate entry to enter the first point. 
A directional arrow is displayed; notice that moving your mouse changes 

 
n steps 2 and 3 can 

 angle 

3. ing Area or use coordinate entry to enter the second 
 

4. y menu. A list of all the layers in your 
drawing is displayed in the Menu Window, and you are prompted to 

e 
ions are 

 the Menu Window. For more information on using selection 

6. ction method in the menu. You are prompted to select the 

To opy entities to another layer without changing their positions: 

Click on Copy in the Edit menu in the Menu Window, or click on Cop
(located just bel
displayed in the Menu Window. 

Click on ToLayer in the Copy menu. A list of all the layers in your 
drawing is displayed in the
“Select layer to copy to”. 

3. Click on the layer you’d like to copy entities to, or type the name of th
layer, and press (Enter). The ToLayer menu is displayed in the Menu 
Window. Use Match and Filter to select or find the layer you want 
to. For details on how to use these options, see “Selecting Layers W
Using Layer Names” and “Searching for Layers” in the “Before You 
Draw” chapter. 

4. Click on a selection method in the menu. You are prompted to select the 
entities you want to copy. 

Select the entities; they are copied to the layer yo
can continue selecting entities to m

6. Choose another layer to copy entities to by clicking on NewLyr and 
continuing with step 3 above. 

To opy entities to another layer at a specific distance and angle: 

Click on Copy in the Edit menu in the Menu Window, or click on Copy 
(located just below the 
Copy menu is displayed in the Menu Window, and you are prompted to 
“Select first point of the distance to copy”. To use the same distance and 
angle as the last time you us

2. Click in the Drawing Area or use coor

the length and angle of the arrow. You are prompted to “Select second
point of the distance to copy”. The points you select i
be selected anywhere on the screen; they indicate the distance and
to copy only, and not the beginning and ending points of the copy. 

Click in the Draw
point. A selection menu as well as other Copy options are displayed in the
Menu Window. 

Click on ToLayer in the Cop

“Select layer to copy to”. 

5. Click on the layer you’d like to copy entities to, or type the name of th
layer, and press (Enter). A selection menu as well as other Copy opt
displayed in
menus, see “Selection Menus” in “The Drawing Board” chapter. 

Click on a sele
entities you want to copy. 
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7. Select the entities; they are copied to the layer you chose in step 5. You 
can continue selecting entities to make additional copies. 

Choose another layer to cop8. y entities to if necessary. Just click on NewLyr 

Co
You can make multiple copies of an entity in a one-dimensional, rectangular, or 
circular array. A one-dimensional array simply makes multiple copies in one 
dire
specified angle of separation around a center of rotation. 

A re
angle. Y  copy an array of elements in the X direction, the Y direction, or in 
bot i
the tota
repetiti riginal. A two-by-two array has a total of four 
entities. (See figures 10.2 and 10.3.) You can also change the angle of the X and Y 

ed angle. 

and continue with step 5 above. 

pying Using Arrays 

ction. In a circular array, an entity is copied a specified number of times at a 

ctangular array repeats an entity a specified number of times at a specified 
ou can

h d rections at the same time. The number of X and Y repetitions determines 
l number of entities in the array. An array of one X repetition and one Y 
on has only one entity, the o

axes to create a rectangular array at the specifi

Distance to C opy

X Repetitions =3

Y Repetitions =1

Result

 
Figure 10.2: the 
Copy men  t  
entity in a one-dimension

Creating a rectangular array in only the X direction. You can also use Array in 
u o make multiple copies in only one direction. See the instructions for copying an

al array below. 

Distance to C opy

X Repetitions =1

Y Repetitions =4

 
0.3: Creating a rectangular array in only the Y direction. You can also use Array in the 
enu to make multiple copies in only one direction. See the instructions for copying an
a one-dimensional array below. 

Figure 1
Copy m  
entity in 
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 To copy an entity in a one-dimensional array: 

1. Click on Copy in the Edit menu in the Menu Window, or click on Copy 
(located just below the Move option) in the Edit pull-down menu. The 
Copy menu is displayed in the Menu Window, and you are prompted to 
“Select first point of the distance to copy”. 

2. Click in the Drawing Area or use coordinate entry to enter the first point. 
ges 

n the array, and not the beginning and ending 

3. d 
 the 

4. u. A value menu is displayed, and you 

5. ber, and press (Enter). You are prompted 

6. ied in the array you defined. You can 

 To 

1. 

enu Window. 

s added each time you copy.  

. 

 
e and 

 can 
 and 

4. 
Window, and you are 

he 

5. , and press (Enter). You are prompted 
to “Enter number of Y repetitions”. 

A directional arrow is displayed; notice that moving your mouse chan
the length and angle of the arrow. You are prompted to “Select second 
point of the distance to copy”. The points you select in steps 2 and 3 can 
be selected anywhere on the screen; they indicate only the distance and 
direction of each copy i
points of the copy. 

Click in the Drawing Area or use coordinate entry to enter the secon
point. A selection menu as well as other Copy options are displayed in
Menu Window.  

Click on Array in the Copy men
are prompted to “Enter the number of repetitions”. 

Use the value menu or type a num
to select the entities you want to copy. 

Select the entities; they are cop
continue selecting entities to make additional copies. 

copy an entity in a rectangular array: 

Click on Copy in the Edit menu in the Menu Window, or click on Copy 
(located just below the Move option) in the Edit pull-down menu. The 
Copy menu is displayed in the M

2. Click on RectArry in the Copy menu. The RectArry menu is displayed in 
the Menu Window, and you are prompted to “Select first point of the 
distance to copy”. Toggle Counter on in the RectArry menu to display the 
number of entitie

3. Click in the Drawing Area or use coordinate entry to enter the first point
Two bi-directional arrows are displayed, representing the X and Y axes. 
Notice that moving your mouse changes the length and direction of the
arrows; the length and direction of the arrows indicates the distanc
angle you want to copy entities at. You are prompted to “Select second 
point of the distance to copy”. The points you select in steps 3 and 4
be selected anywhere on the screen; they indicate only the distance
direction of each copy in the array, and not the beginning and ending 
points of the copy. 

Click in the Drawing Area or use coordinate entry to enter the second 
point. A value menu is displayed in the Menu 
prompted to “Enter number of X repetitions”. For more information on 
using coordinate entry, see “Drawing Using Coordinate Entry” in “T
Drawing Board” chapter. 

Use the value menu or type a number
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6. Use the value menu or type a number, and press (Enter). The RectArry 
g 

9. continue with 

Keep in roup from the original copied entity. If 
you
arra w

menu is displayed in the Menu Window. For more information on usin
value menus, see “Value Menus” in “The Drawing Board” chapter. 

7. Click on a selection method in the menu. You are prompted to select the 
entities you want to copy. 

8. Select the entities; they are copied in the array you defined. You can 
continue selecting entities to make additional copies.  

Click on NewArray to define another rectangular array and 
step 3 above. Or click exit to return to the Edit menu. 

 mind that an array is a separate g
 use Group in the selection menu and select an entity in an array, the entire 
y ill be copied. 

Original

' X 'Distance
ToCopy

'Y 'Distance
ToCopy

XRepetitions=4
YRepetitions=3

Result

 
0.4: Creating a rectangular array 

copy an entity in a rectangular array set at an angle: 

Click on Copy in the Edit me

Figure 1

 To 

1. nu in the Menu Window, or click on Copy 

2.  

3. Click on Angular in the RectArry menu. You are prompted to “Select first 
opy”. 

(located just below the Move option) in the Edit pull-down menu. The 
Copy menu is displayed in the Menu Window. 

Click on RectArry  in the Copy menu. The RectArry menu is displayed in
the Menu Window. 

point of the distance to c



COPYING ENTITIES  |    243 

4. Enter the angle for the X axis for the copy by defining the beginning and 

array, and not the beginning 

y to enter the beginning point. A directional arrow is 
w. 

e 
dinate entry, see “Drawing Using Coordinate 

5. 
ow and, therefore, define the angle. Two bi-directional arrows 

tion of the arrows; the length and 
y 

e 
to copy”. 

ng Area or use coordinate entry to enter the second 

tions”. For more information on 
. 

7. e a number, and press (Enter). You are prompted 

8. ress (Enter). The RectArry 
nu Window. Toggle Counter on in the 
e number of entities added each time you 

9. enu. You are prompted to select the 

10. 
entities to make additional copies.  

 th 

Keep in ray is a separate group from the original copied entity. If 
you e tire 
arra

 To copy an entity in a circular array: 

ck on Copy 

enu Window. 

n 

array”. For more information on circular array options, see “CircArry 
Menu Options” later in this chapter. 

end points of a directional arrow. The points you select for directional 
arrows can be selected anywhere on the screen; they indicate only the 
distance and direction of each copy in the 
and ending points of the copy. Click in the Drawing Area or use 
coordinate entr
displayed; notice that moving your mouse changes the angle of the arro
You are prompted to “Select vector indicating angle of array”. For mor
information on using coor
Entry” in “The Drawing Board” chapter. 

Click in the Drawing Area or use coordinate entry to enter the end point 
of the arr
are displayed, representing the X and Y axes. Notice that moving your 
mouse changes the length and direc
direction of the arrows indicates the distance and angle you want to cop
entities at.  You are prompted to “Select the second point of the distanc

6. Click in the Drawi
point. A value menu is displayed in the Menu Window, and you are 
prompted to “Enter number of X repeti
using value menus, see “Value Menus” in “The Drawing Board” chapter

Use the value menu or typ
to “Enter number of Y repetitions”. 

Use the value menu or type a number, and p
menu is displayed in the Me
RectArry menu to display th
copy. 

Click on a selection method in the m
entities you want to copy. 

Select the entities; they are copied in the array you defined. You can 
continue selecting 

10. Click on NewArray to define another rectangular array and continue wi
step 3 above. Or click exit to return to the Edit menu. 

 mind that an ar
 us  Group in the selection menu and select an entity in an array, the en
y will be copied. 

1. Click on Copy in the Edit menu in the Menu Window, or cli
(located just below the Move option) in the Edit pull-down menu. The 
Copy menu is displayed in the M

2. Click on CircArry in the Copy menu. The CircArry menu is displayed i
the Menu Window, and you are prompted to “Select center point of 
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3. Click in the Drawing Area or use coordinate entry to enter the center 

 
e Menu 

Window, and you are prompted to “Select angle between items (+=CCW, 
CW” means that entering a positive angle will copy the 

menu or type a number, and press (Enter). Another value 
n 
 

cArry 
menu is displayed in the Menu Window. 

menu. You are prompted to select the 

8. ou can 

 Edit menu. 

Kee n  copied entity. If 
you
array w

More A

The Z e  
in a rec nu, the ZIncrX option sets the Z 
elev o
elev i
array that co

The ZI ation 
on usin . 

You can use the ZIncrX and ZIncrY to generate such things as three-dimensional 
e Figure 10.5). You can also generate several 

thr or-to-
floor h  X and Y 
distance of zero. This creates an array of floors, stacked one above the other. 

point. You are prompted to “Select center of object”. 

4. Click in the Drawing Area or use coordinate entry to enter the center of
the entities you’re copying. A value menu is displayed in th

-=CW)”. “+=C
array in a counterclockwise direction; “-=CW” means that entering a 
negative angle will copy the array clockwise. 

5. Use the value 
menu is displayed, and you are prompted to “Enter number of objects i
array”. For more information on using value menus, see “Value Menus”
in “The Drawing Board” chapter. 

6. Use the value menu or type a number, and press (Enter). The Cir

7. Click on a selection method in the 
entities you want to copy. 

Select the entities; they are copied in the array you defined. Y
continue selecting entities to make additional copies. When you are 
finished, click exit to return to the

p i  mind that an array is a separate group from the original
 use Group in the selection menu and select an entity in an array, the entire 

ill be copied. 

bout Using Z Elevations in Rectangular Arrays 

levation can be increased or decreased incrementally with each repetition
tangular array. In the RectArry me

ati n in the X direction of an array, while the ZIncrY option sets the Z 
at on in the Y direction of an array. To set an incremental Z elevation for an 

pies an entity in both the X and Y directions, set both options. 

ncrX and ZIncrY options are set using value menus. For more inform
g value menus, see “Value Menus” in “The Drawing Board” chapter

stairs with only a few keystrokes (se
ee-dimensional floors of a building by setting ZIncrX or ZIncrY to the flo

eight for the building and copying a rectangular array with an
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X Repetiti ns = 1

ns = 8

Z Inco

Y Repetitio

r X = 0

Z Incr Y = 8"  
0.5: Creating 3D stairs with the incremental Z elevation options Figure 1

Mo

You ca
entity copies using the following CircArry menu options: 

NewCentr Sets a new center for the array you are copying; click on NewCentr, select a new 
entity to copy 

ing; click on ObjCent, select a new center 
point for the entity, and then select the entity to copy 

Sep.Angl Sets a new angle of separation between each entity in the array; click on Sep.Angl, 
 (Enter) 

mber, 

repetition in the array; click on Z-Incr, enter a positive 
value to increase the elevation or a negative value to decrease it, and press (Enter) (use 

 
Rotate Toggle on to rotate each copy in the array by an angle equal to the angle of separation; 

inal 

Mi
In som  part of your drawing would save 
you o
side of a hotel corridor and mirror that side to create the full corridor than it 
wo   to 
do j t

 To mirror entities: 

 point along the line of reflection”. 
time you used Mirror. 

on line, click on PrevLine in the Mirror 
 

2.  
 line. You are prompted to “Select second point along the 

re About CircArry Menu Options 

n change array settings, set a Z elevation for the array, and even rotate the 

center point for the array, and then select the 
ObjCent Sets a new center for the entity you are copy

enter a new angle, and press
No.Objct Sets a new number of repetitions for the array; click on No.Objct, enter a new nu

and press (Enter) 
Z-Incr Sets the Z elevation with each 

this option to draw 3D circular stairs)

toggle off to leave the orientation of each copy in the array the same as the orig
entity 

rroring Entities 
e projects, being able to copy and mirror

 a l t of time. For instance, it would be far more efficient to draw only one 

uld be to draw both sides. The Mirror option in the Edit menu allows you
us  that, mirroring geometry across a reflection line that you define. 

1. Click on Mirror in either the Edit menu in the Menu Window or the Edit 
pull-down menu. The Mirror menu is displayed in the Menu Window, 
and you are prompted to “Select first
You can use the same reflection line as the last 
Instead of defining a new reflecti
menu. The PrevLine option is only available if you have used Mirror
during the current drawing session. 

Click in the Drawing Area or use coordinate entry to select the first point
of the reflection
line of reflection”. 
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3. Click in the Drawing Area or use coordinate entry to select the second 
point of the reflection line. A temporary, dashed line representing the 

4. 
 3. 

5. ir  
AndCopy on. ties 

ro

6. Toggle FixText
When FixText 
10.6) 

7. 
select the entit

8. Select the entities; they are mirrored across the reflection line you defined. 
You can continue selecting entities to mirror. When you are finished, click 
exit to exit the Mirror menu and return to the Edit menu. 

reflection line is drawn, and the Mirror menu is displayed in the Menu 
Window. 

Determine if the reflection line is not correct. If it is, click on NewLine and 
repeat steps 2 and

M ror and copy the selected entities across the reflection line by toggling
Toggle AndCopy off to mirror and move selected enti

ac ss the reflection line. 

 on to mirror the position of text but not its orientation. 
if toggled off, text is mirrored and rotated 180°. (See Figure 

Click on a selection method in the Mirror menu. You are prompted to 
ies you want to mirror. 

 
Figure 10.6: Mirroring text with FixText toggled on (left) and toggled off (right) 

ng Your Plan 
Y u can use the FreeHand option to sketch lines in varying widths and linetypes. 
When using linetypes such as dotted or dashed, you can give a rendered or 

ove the cursor 
across the Drawing Area as you draw. Sketching with FreeHand works best is 

d snapping and ortho mode off. Press (X) to toggle grid 
ress  to toggle ortho mode off. 

Hand in the Utility menu in the Menu Window. The 
FreeHand menu is displayed in the Menu Window. 

polylines. Of the Lines, 
3DLines, and PolyLine options, only one can be toggled on at any given 
time. 

Sketchi
o

weighted quality to the lines by varying the speed that you m

you toggle both gri
snapping off, and p (O)

 To sketch: 

1. Click on Free

2. Toggle Lines on to draw lines, toggle 3DLines on to draw three-
dimensional lines, or toggle PolyLine on to draw 
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3. Toggle Closed on to automatically close the shape when you finish 
drawing. 

4. Click in the Drawing Area and then move your mouse to draw. 

5. Click to disconnect your cursor from the line when your sketch is 
ntinue drawing additional shapes or click Exit to 

6.  

complete. You can co
return to the Utility menu. 



|  CHAPTER 10: OTHER WAYS TO DRAW  248

 



Drawing Tools 
There are many tools in DataCAD to aid in drawing. Reference points 
can be set anywhere in your drawing, giving you a precise way to 
position new entities. Object snapping, too, can help you add entities 
to existing geometry quickly and accurately. 

You can also identify and measure entities in your drawing to retrieve 
information, such as what layer the entity is drawn on, it’s linetype 
and line weight, it’s length or angle, or even its area or perimeter 
measurements. 

You can even use the LyrUtil macro to recover your work if 
your drawing file somehow becomes corrupted. 

11 
In this chapter: 

 Setting reference points 

 Object snapping 

 Identifying entities 

 Measuring entities 

 Dividing entities 

 Editing entity attributes 

 Recovering corrupted 
drawings 
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Setting Reference Points 
A reference point is used as a starting point for drawing. In DataCAD, there are 
two kinds of reference points: floating and fixed. 

Floating reference points are useful when you use relative coordinate entry 
methods to draw. They can be set at any time, regardless of what menu is 
displayed or what you’re drawing, by using the reference point shortcut noted in 
the sidebar. Floating reference points are temporary and can be displayed and 
snapped to, but they can’t be plotted. 

To see how floating reference points are used when drawing, see the “Tutorial: 
Drawing a Schoolhouse” chapter, specifically the instructions on drawing 
interior walls and adding windows and doors to the schoolhouse. 

Fixed reference points are useful when you use absolute coordinate entry 
methods to draw. Absolute coordinate entry uses absolute zero as a fixed point of 
reference: every time you enter a point using absolute coordinate entry, the 
distances you enter are measured from absolute zero. With a fixed reference 
point, you can use another point in your drawing, exactly as you would use 
absolute zero.  

 To set a floating reference point: 

Click on Reference point in the Tools pull-down menu. The RefPnt menu is 
displayed in the Menu Window. 

Shortcut: Press (`) (located in the upper-left corner of most keyboards, just 
below (Esc)) to quickly access the RefPnt menu and set a reference point. After 
selecting a point, you are automatically returned to the menu you were working in 
before you set the point. 

2. Click on DrwMarks to display a small “x”, representing the reference 
point. 

3. Click in the Drawing Area, use coordinate entry, or object snap to a point 
in your drawing to select the reference point. The reference point is 
marked with a small “x”. Reference points are displayed until you refresh 
your drawing by pressing (Esc). 

 To set a fixed reference point: 

1. Click on Settings in the Utility menu. The Settings menu is displayed in 
the Menu Window. 

2. Click on FixedRef in the Settings menu. You are prompted to “Select fixed 
reference point using cursor”. 

3. If you’d like the fixed reference point marked with a small “x”, toggle 
DrwMarks on in the Settings menu. 

4. Click in the Drawing Area, use coordinate entry, or object snap to a point 
in your drawing to select the reference point. If DrwMarks was toggled 
on in the previous step, the reference point is marked with a small “x”. 
Reference points are displayed until you refresh your drawing by 
pressing (Esc). 
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5. Right-click to exit the Settings menu. You can now continue drawing, 
using your fixed reference point. 

6. Use absolute zero ag reference point, 
n 

o.

. F
co
r coor
 t

 To use a reference point, using this example: 

1. Click on Input Mode in the Tools pull-down menu and make 
Cartesian is checked. 

2. Click on Window in the Create pull-down menu, or click Wi
Edit/Architct menu in the Menu Window. The Windows menu is 
displayed. 

3. Press (`); the RefPnt menu is displayed in the Menu Window. 

Shortcut: To set a reference point using the mouse, press (Ctrl) and click. To set 

ain if necessary. Instead of your fixed 
click on Settings in the Utility menu, toggle FixedRef off and then o
again (click on the option twice), and then click on AbsZer
exit the Settings menu, and continue drawing. 

More About Setting Reference Points 

 Right-click to 

Reference points can give you a quick way to draw very precisely
to insert a window in a wall 3’-0” from the corner of a room, you 
reference point at that corner and then, using relative Cartesian fo
entry, simply enter the distance from the reference point, which in
0”. 

or example, 
uld create a 

dinate 
his case is 3’-

sure relative 

ndows in the 

a reference point at a specific point on an entity by object snapping to it, press 
(Ctrl) and click the middle mouse button or press (Ctrl) + (Shift) and click the left 
mouse button. 

4. Toggle DrwMarks on to display the reference point. 

5. Object snap to the inside left corner of the wall to place your reference 
point exactly at the corner intersection. You are prompted to “Select one 
jamb of window”. For more information on object snapping, see “Object 
Snapping” in this chapter. 

6. Press (Spacebar) to activate coordinate entry. You are prompted to “Enter 
relative X-distance”. 

7. Type 3 and press (Enter). You are prompted to “Enter relative Y-distance”. 

8. Type 0 and press (Enter). Your cursor is connected to a point on the wall 
that is 3’-0” from the corner of the room. You are prompted to “Select 
second jamb of window”. 

9. Press (Spacebar) to activate coordinate entry, and enter the X and Y 
coordinates for the other side of the window. You are prompted to “Select 
any point on the outside of the wall”. 

10. Click anywhere outside the wall. The window is drawn, exactly 3’-0” 
from the corner of the room. 
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Using reference points with direction-distance coordinate entry is even easier 

ame 
example: 

ode in the Tools pull-down menu and make sure 

 

4. Toggle DrwMarks on to display the reference point. 

orner of the wall to place your reference 
e 

at will be used in the following 

6.  mode is on, then drag your cursor to the right and click. 

and faster. 

 To use a reference point and direction-distance mode, using the s

1. Click on Input M
Direction-Distance is checked. 

2. Click on Window in the Create pull-down menu, or click Windows in the
Edit/Architct menu in the Menu Window. The Windows menu is 
displayed. 

3. Press (`); the RefPnt menu is displayed in the Menu Window. 

5. Object snap to the inside left c
point exactly at the corner intersection. You are prompted to “Indicate th
reference angle”, which is the direction th
steps. 

Make sure Ortho
You are prompted to “Enter one jamb of window”. 

Shortcut: To toggle Ortho mode on or off, press (O). 

7. Pr (Spacebar) press (Enter). You are prompted to “Select 

8. 
 

outside of the wall”.  

9. ll.  

Ob
Object s oint on an existing entity or 
selecting a snap point that you’ve set. De
pro s
may be at point so you can begin drawing from that point. 

The ts. 

n 
apping methods. 

ObjSnap Menu Options 

Most object snapping options are in the ObjSnap menu; however, a related 
function called Get-Snap also uses snapping to help you draw. See “Using Get-
Snap” later in this chapter for details. 

SelSet, Quick, FastSym, and Fast3D can increase object snapping speed. See “More 

ess , type 3, and 
second jamb of window”.  

Drag your cursor to the right. Press (Spacebar), type the width of the 
window, and press (Enter). You are prompted to “Select any point on the

Click anywhere on the exterior side. The window is inserted in the wa

ject Snapping 
napping is a precise way of selecting a p

pending on what drawing function is in 
gre s, this point may simply be entered to complete the task, or your cursor 

 attached to th

re are several ways you can object snap to drawing entities and snap poin
You can use one method or any combination of the object snapping methods 
described in this chapter. See the following pages for detailed instructions o
how to use the various object sn

None Toggles all object snap methods off 

About Increasing Snapping Speed” on the following page. 
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FastSym Toggle on to snap only to symbol insertion points rather than end points within the 
symbol 

Fast
MissDis t while still being able to snap to it 
LyrSnap 

SrchHch tch lines; toggle off to ignore hatching when object snapping 
and increase snapping speed 

Qui

SelSet 
Apertur

Mo

You can
display ted. 

 

1. Go to the Utility menu in the Menu Window and click on Measures. 

2. 

3. nate entry to enter the snapping 

Mo

If you’r tton mouse, set your middle mouse button to Middle 
Button; do not set it to Double Click, because you will not be able to use it for 
obje  

To check your mouse settings: 

 click on 
Settings and then on Control Panel.  

 Mouse in the Control Panel window to open the Mouse 
g box.  

 the left button is set to Click 
Select, the middle button is set to Middle Button, and the right button is 

no Middle Button setting, 

5. 

Mo

There a
SelSet,  want to 
snap to

3D Toggle on to snap to the center marker of circular 3D entities 
tt Set the distance your cursor can be from a poin

Toggle on to snap to entities on all displayed layers; toggle off to snap to entities only 
on the active layer 
Toggle on to snap to ha

ck Toggle on to snap to the first entity you drew; toggle off to snap to the nearest point 
according to the snapping methods you have toggled on 
Toggle on to snap only to entities in the active selection set 

e Toggle on to display a box representing the miss distance. Toggle Aperture on to 
make sure the point you want to snap to is inside the miss distance.  

re About Snapping Points 

 add snapping points anywhere in your drawing; these points are 
ed as dots in the Drawing Area but can’t be plot

To add a snapping point to your drawing: 

Click on SnapPnt in the Measures menu. 

Click in the Drawing Area or use coordi
point. The point is displayed in the Drawing Area. 

re About Using Your Mouse for Snapping 

e using a three-bu

ct snapping. If your middle mouse button doesn’t seem to be snapping to
points, check your mouse settings. 

 

1. Close DataCAD if it is running. From the Windows Start menu,

2. Double-click on
Properties dialo

3. Click on the Devices tab and make sure you have a three-button mouse 
driver installed. 

4. Click on the Buttons tab and make sure

set to Alternate Menu/Click Select. If there is 
set the middle mouse button to Unassigned or Default. 

Click on OK to close the dialog box. 

re About Increasing Snapping Speed 

re several options you can use to increase object snapping speed. Use 
SrchHch, and FastSym to more precisely target the geometry you
. 
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The
many c
contou
area or lection method, only those entities whose center axis markers or 
contr l poin

Snapp
You ca t 
sna p d 
on, s
long as that . 

 To 

1. 
can also click on Options in the Tools pull-down menu, and then click on 
Object Snap in the submenu. The ObjSnap menu is displayed. Press 
(PageDown) to zoom in on your drawing and place your cursor more 
accurately. 

2. Click on Nearest in the ObjSnap menu. 

oint you’d like to snap to, and press (N) or 
click the middle mouse button. The nearest point on any entity is snapped 

Sna p
You ca  entity in a specified number of sections, with each section 
separated b
Drw

 Fast3D option can also increase snapping speed when your drawing has 
ircular 3D entities, such as 3D arcs, cylinders, cones, domes, tori, or 
r curves. When you toggle on Fast3D and then select entities using the 
 fence se

o ts are within the defined area or fence are selected. 

ing to the Nearest Point 
n snap to the point nearest your cursor, regardless of what other objec

p o tions are toggled on. For instance, even if you don’t have MidPnt toggle
it i  still possible to snap to the midpoint of a line using the Nearest option, as 

midpoint is the point nearest to your cursor

snap to the nearest point: 

Go to the Utility menu in the Menu Window and click on ObjSnap. You 

3. Move your cursor close to the p

to. 

p ing to Dividing Points 
n divide an

y a snapping point. These snapping points are only visible if 
Marks is toggled on in the Settings menu and after you snap to them. 

 
1.1: Snapping to a point on a divided entity Figure 1

bjSnap. You 
nd then click on 

2. e 

3.  an entity by use the value menu or typing 

4. r 
le mouse button. The nearest division point is snapped to. 

 To snap to a dividing point: 

1. Go to the Utility menu in the Menu Window and click on O
can also click on Options in the Tools pull-down menu, a
Object Snap in the submenu. The ObjSnap menu is displayed. 

Click on No.Pnts in the ObjSnap menu. A value menu is displayed in th
Menu Window. 

Set the number of divisions for
a number. Then press (Enter). 

Move your cursor close to the point you’d like to snap to, and press (N) o
click the midd
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Sna
You ca f entities in your drawing. 

pping to End Points 
n snap to the end points o

 
Figure 11.2: Snapping to an end point of a line 

 To snap to the nearest end point: 

1. Go to the Utility menu in the Menu Window and click on ObjSnap. You 
can also click on Options in the Tools pull-down menu, and then click on 
Object Snap in the submenu. The ObjSnap menu is displayed. You can 
also snap to end points of lines in unexploded symbols and nested 
symbols. For more information on symbols, see the “Templates and 
Symbols” chapter. 

2. Click on EndPnt in the ObjSnap menu. 

3. Move your cursor close to the point you’d like to snap to, and press (N) or 
click the middle mouse button. The nearest end point is snapped to. 

Snapping to the Midpoint of a Line 
point of a line. You can snap to the nearest mid

 
Figu

 To snap to t est midpoint of a line: 

then click on 

2. ObjSnap menu. 

(N)
est midpoint is snapped to. 

Snapping to Arc and Circle Centers 
You can snap to the center point of an arc or circle. 

re 11.3: Snapping to the midpoint of a line 

he near

1. Go to the Utility menu in the Menu Window and click on ObjSnap. You 
can also click on Options in the Tools pull-down menu, and 
Object Snap in the submenu. The ObjSnap menu is displayed. 

Click on MidPnt in the 

3. Move your cursor close to the point you’d like to snap to, and press  or 
click the middle mouse button. The near



|  CHAPTER 11: DRAWING TOOLS  256

 
Figure 11.4: Snapping to the center point of a circle 

 To snap to the nearest center point: 

1. Go to the Utility menu in the Menu Window and click on ObjSnap. You 
can also click on Options in the Tools pull-down menu, and then click on 
Object Snap in the submenu. The ObjSnap menu is displayed. 

2. Click on Center in the ObjSnap menu. 

3. Move your cursor close to the point you’d like to snap to, and press (N) or 
click the middle mouse button. The nearest center point of any arc or 

adrant Points 
You n
circ

circle point is snapped to. 

Snapping to Qu
 ca  snap to points marking the north, south, east, or west quadrants of a 
le or arc. 

 
 Snapping to a quadrant point on a circle Figure 11.5:

 To 

1. 
 

enu. The ObjSnap menu is displayed. 

3. r 
ped to. 

nes, arcs, and circles. 

snap to the nearest quadrant point: 

Go to the Utility menu in the Menu Window and click on ObjSnap. You 
can also click on Options in the Tools pull-down menu, and then click on
Object Snap in the subm

2. Click on Quadrant in the ObjSnap menu. 

Move your cursor close to the point you’d like to snap to, and press (N) o
click the middle mouse button. The nearest quadrant point is snap

Snapping to Intersections 
You can snap to the intersection of li

 
Figure 11.6: Snapping to an intersection of two lines 
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 To snap to the nearest intersection point: 

1. Go to the Utility menu in the Menu Window and click on ObjSnap. You 
can also click on Options in the Tools pull-down menu, and then click on 
Object Snap in the submenu. The ObjSnap menu is displayed. 

2. Click on Intsect in the ObjSnap menu. 

3. Move your cursor close to the point you’d like to snap to, and press (N) or 
click the middle mouse button. The nearest intersection point is snapped 
to. 

You can use perpendicular snapping to draw a line that is perfectly 
perpendicular to another line, arc, or circle. 

Snapping to a Perpendicular 

90°

 
Figure 11.7: Snapping to a point that forms a perpendicular to a line 

 To draw a line perpendicular to another entity: 

1. Go to the Utility menu in the Menu Window and click on ObjSnap. You 
can also click on Options in the Tools pull-down menu, and then click on 
Object Snap in the submenu. The ObjSnap menu is displayed. 

2. Click on Perpend in the ObjSnap menu. 

3. Click in the Drawing Area or use coordinate entry to enter the first end 

4. Move your cursor close to the entity you’d like to draw the line 
iddle mouse button to snap 

Snapping to Tangents 
You n le. 

point of the line. 

perpendicular to, and press (N) or click the m
to it. The nearest perpendicular point on that entity is snapped to. 

 ca  use tangent snapping to draw a line that is tangent to an arc or circ

 
1.8: Snapping to a point that forms a Figure 1 tangent with a circle 

 

1. 

2. angent in the ObjSnap menu. 

To draw a line that is tangent to an arc or circle: 

Click on Options in the Tools pull-down menu, and then click on Object 
Snap in the submenu. The ObjSnap menu is displayed. 

Click on T
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3. Click in the Drawing Area or use coordinate entry to enter the first end 

4. Move your cursor close to the arc or circle you’d like to draw the line 
 mouse button to snap to it. 

Using Super Snap 
Sup S wing. 
Instead
distanc napped to is 
automatically enter
tha

 To 

2. Press and hold down (Shift) and object snap to a point in your drawing. 
The Get-Snap pop-up menu is displayed. 

3. Click on Get X to enter a horizontal distance; click on Get Y to enter a 
vertical distance. The distance is entered. 

 To add to or subtract from the Get X distance: 

1. Enter a point in your drawing. This may be one end point of a wall or the 
first point in the distance to move an entity. 

2. Press and hold down (Shift) and object snap to a point in your drawing. 
The Get-Snap pop-up menu is displayed. 

 a horizontal distance; click on Get Y + 
 A value menu is displayed, and you 

  

 entered. 

 To 

1. be one end point of a wall or the 

2. t-

3. Click on Get Angle from the pop-up menu. A value menu is displayed, 

4. Use the value menu or type a length for your line, and press (Enter). The 
line is created at the referenced angle and length. 

point of the line. 

tangent to, and press (N) or click the middle
The nearest tangent point on the arc or circle is snapped to. 

er nap allows you to input distances relative to other objects in the dra
 of inputting a distance, you can simply object snap to a point; the 
e between your original point and the point you s

ed. So you can quickly create, move, copy, or stretch entities 
t align with other objects without having to draw guidelines or markers first.  

use snapping to enter a horizontal or vertical distance: 

1. Enter a point in your drawing. This may be one end point of a wall or the 
first point in the distance to move an entity. 

3. Click on Get X + Distance to enter
Distance to enter a vertical distance.
are prompted to “Enter a relative distance”.

4. Enter a positive value to add to the distance between your original point 
and the point you snapped to; enter a negative value to subtract from the 
distance between your original point and the point you snapped to. The 
distance is

use snapping to define an angle: 

Enter a point in your drawing. This may 
first point in the distance to move an entity. 

Press (Shift) and object snap to the point that lies along the angle. The Ge
Snap pop-up menu is displayed. 

and you are prompted to ”Enter relative distance”. 
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 To use snapping to define an angle, and then add or subtract from it: 

he 

 point that lies along the angle. The Get-

displayed, and you are prompted to ”Enter angle from the origin”. 

 the reference angle, use the value menu or 

ype a value, and 
press (Enter). The line is created at the referenced angle and length. 

Id t
You ca

 To 

 

2.  want to identify. The selected 
ibutes 

 

identify. Click on 3DViews in the Identify menu to display the 3DViews 
w 

3. Change the current settings for linetype, layer, line color, line weight, 

ettings are changed; any entities you 

m again. 

More About Entity Attributes 

The attributes displayed when you identify an entity can vary, depending on the 
type of entity. For example, if you identify a line, the following information 
might be displayed: 

LINE (entity type) Click on the entity type to display all of that entity’s attributes in the 
Message Area. 

Walls (layer entity is on) 
White (entity color) 

Spacing (line spacing) Click on Spacing, LineWgt, Oversht, Z-Base, or Z-Hgt to display that 
information in the Message Area. 

Oversht (line overshoot) 
Z-B z
Z-Hgt (z

 

1. Enter a point in your drawing. This may be one end point of a wall or t
first point in the distance to move an entity. 

2. Press  and object snap to the(Shift)
Snap pop-up menu is displayed. 

3. Click on Get Angle + Angle in the pop-up menu. A value menu is 

4. To enter the angle to add to
type an angle, and press (Enter). The default is 90°. You are prompted to 
“Enter relative distance”. 

5. To enter the length of the line, use the value menu or t

en ifying Entities 
n review the attributes of any entity in your drawing. 

identify an entity: 

1. Click on Identify in the Tools pull-down menu. The Identify menu is
displayed in the Menu Window. 

Click on the entity in your drawing that you
entity is temporarily displayed as dashed lines, and a list of its attr
is displayed in the Menu Window. It may be necessary to change the view
of your drawing, so that you have a clear view of the entity you want to 

menu and change the view of your drawing, choose a view from the Vie
pull-down menu, or simply zoom in on your drawing. 

overshoot, and line spacing to match those of the entity you identified in 
step 2 by clicking on SetAll. The s
subsequently draw will automatically have those attributes, until you 
change the

Solid (linetype) 

LineWgt (line weight) 

ase ( -base of line) 
-height of line) 
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If you select text, the following information might be displayed: 

TEX
Text (lay
Red (entity color) 
Rom
Size (tex

Angle (t
Wei (
Slan
Aspect (

Me s
You ca easure the distance between 
two
peri e
measur

ngles 

ompted to “Select line”. 

at you want to identify. The line is 

  measur

1. e 

2. 

g, 

  m

1. own menu, click on Measure, and then click on 

T (entity type) 
er entity is on) 

ans (font) 
t size) Click on Size, Angle, Weight, Slant, or Aspect to display that 

information in the Message Area. 
ext angle) 

ght text weight) 
t (text slant) 

text aspect ratio) 

a uring Entities 
n measure the length or angle of entities or m

 points without dimensioning them. You can also calculate areas and 
m ters as well as the total length of lines in your drawing. And most 

ements can be added as text to your drawing. 

Measuring Lengths and A
You can take a variety of measurements of lines, arcs, and angles in your 
drawing. 

 To measure the length of a line: 

1. Go to the Tools pull-down menu, click on Measure, and then click on 
Line. You are pr

2. Click on the line in your drawing th
displayed as a dashed line and the measurement is displayed in the 
Message Area.  

3. Add this measurement as text to your drawing by clicking on ToDrwing, 
setting the text options as necessary, and clicking in the drawing where 
you want to place the text. 

To e the angle of a line: 

Go to the Tools pull-down menu, click on Measure, and then click on Lin
Angle. You are prompted to “Select line”. 

Click on the line. The angle measurement is displayed in the Message 
Area. 

3. Add this measurement as text to your drawing by clicking on ToDrwin
setting the text options as necessary, and clicking in the drawing where 
you want to place the text. 

To easure the distance between two points in your drawing: 

Go to the Tools pull-d
Point to Point. You are prompted to “Select first point of distance to 
measure”. 

2. Click on the first point, object snap to a point, or use coordinate entry to 
select a point. You are prompted to “Select second point of distance to 
measure”. 
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3. Click on the second point, object snap to a point, or use coordinate ent
to select a point. The measurement is displayed in the Me

ry 
ssage Area.  

, 
 as necessary, and clicking in the drawing where 

 To 

1. Go to the Tools pull-down menu, click on Measure, and then click on 

yed in the 

3. 
rawing where 

 

1. Go to the Tools pull-down menu, click on Measure, and then click on 

fy. It’s 

3. Add this measurement as text to your drawing by clicking on ToDrwing, 
tions as necessary, and clicking in the drawing where 

 To measure the chord length of an arc:: 

1. 
ve”. 

d the measurement is displayed in the 

3.  drawing by clicking on ToDrwing, 
setting the text options as necessary, and clicking in the drawing where 

 To measure the arc length of a curve: 

 menu, click on Measure, and then click on Arc 

ea.  

3. Add this measurement as text to your drawing by clicking on ToDrwing, 
setting the text options as necessary, and clicking in the drawing where 
you want to place the text. 

4. Add this measurement as text to your drawing by clicking on ToDrwing
setting the text options
you want to place the text. 

measure the diameter of a curve: 

Diameter. You are prompted to “Select curve”. 

2. Click on the curve in your drawing that you want to identify. The curve is 
displayed as a dashed line and the measurement is displa
Message Area.  

Add this measurement in text to your drawing by clicking on ToDrwing, 
setting the text options as necessary, and clicking in the d
you want to place the text. 

To measure the radius of a curve: 

Radius. You are prompted to “Select curve”. 

2. Click on the curve in your drawing that you want to identi
displayed in a dashed line and the measurement is displayed in the 
Message Area. 

setting the text op
you want to place the text. 

Go to the Tools pull-down menu, click on Measure, and then click on 
Chord. You are prompted to “Select cur

2. Click on the curve in your drawing that you want to identify. It’s 
displayed in a dashed line an
Message Area.  

Add this measurement as text to your

you want to place the text. 

1. Go to the Tools pull-down
Length. You are prompted to “Select curve”. 

2. Click on the curve in your drawing that you want to identify. It’s 
displayed in a dashed line and the measurement is displayed in the 
Message Ar
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 To measure the circumference of a circle: 

2. 
n a dashed line and the measurement is displayed in the 

3. s text to your drawing by clicking on ToDrwing, 

ant to place the text. 

 

k on 

2. Click on the first line. You are prompted to “Select second line of distance 

ween two lines: 

asurement is displayed in the Message 

awing by clicking on ToDrwing, 
n the drawing where 

Me
You
linetyp e Color, Linetype, and Weight filters 
individ

 To 

2. Decide which lines you want to include: 

1. Go to the Tools pull-down menu, click on Measure, and then click on 
Circumference. You are prompted to “Select curve”. 

Click on the circle in your drawing that you want to identify. It’s 
displayed i
Message Area.  

Add this measurement a
setting the text options as necessary, and clicking in the drawing where 
you w

To measure the included angle between two lines: 

1. Go to the Tools pull-down menu, click on Measure, and then clic
Inclusive Angle. You are prompted to “Select first line of angle to 
measure”. 

to measure”. 

3. Click on the second line. The measurement is displayed in the Message 
Area. 

4. Add this measurement as text to your drawing by clicking on ToDrwing, 
setting the text options as necessary, and clicking in the drawing where 
you want to place the text. 

 To measure the excluded angle bet

1. Go to the Tools pull-down menu, click on Measure, and then click on 
Exclusive Angle. You are prompted to “Select first line of angle to 
measure”. 

2. Click on the first line. You are prompted to “Select second line of distance 
to measure”. 

3. Click on the second line. The me
Area. 

4. Add this measurement as text to your dr
setting the text options as necessary, and clicking i
you want to place the text. 

asuring the Total Length of Lines 
 can calculate the total length of lines in a drawing according to color, 

e, and line weight. You can use th
ually or in any combination. 

measure total length of lines: 

1. Go to the Tools pull-down menu, click on Measure, and then click on 
Takeoffs. The Takeoffs menu is displayed in the Menu Window.  
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• To include all lines of a specific color in the measurement, click on 
from 

 

e information on using value menus, see “Value 
Menus” in “The Drawing Board” chapter. 

all displayed layers, toggle LyrSrch on. Toggle it 

t 
s as necessary; and click in the drawing where you want to place 

cle 
in your drawing, or you can define a temporary polyline to measure an area or 

d volume of an existing polyline or circle: 

eter. The Area/Per menu is displayed in the Menu Window.  

om the drawing scale type set in 

it the scale type list. If 

e or circle for 

c, or Inch/Dec for the scale type, 
the Acres option is available in the Area/ Per menu, which you can toggle 
on to display area units in acres. 

Color in the Takeoffs menu, and then select a color 
the color menu. For more information on using color 
menus, see “Color Menus” in “The Drawing Board” 
chapter. 

• To include all lines of a specific type, click on Linetype in the Takeoffs 
menu, and then select a linetype from the menu. 

• To include all lines of a specific weight, click on Weight in the Takeoffs
menu, and then select a weight from the value menu. For 
mor

• To include lines on 
off to include only those lines on the active layer. 

3. Click on Begin. The measurement is displayed in the Message Area. 

4. Add this measurement as text to your drawing by clicking on ToDrwing; 
choose to add the area, the perimeter, or both to your drawing; set the tex
option
the text. 

Measuring Areas, Perimeters, and Volumes 
You can calculate the area, perimeter, and volume of an existing polyline or cir

arc in your drawing.  

 To measure the area, perimeter, an

1. Go to the Tools pull-down menu, click on Measure, and then click on 
Area/Perim

2. Click on ScaleTyp; a list of scale types is displayed in the Menu Window. 
This ScaleTyp setting is independent fr
the Settings/ ScaleTyp 

3. Click on a scale type to select it, and right-click to ex
you selected Decimal, InchDec, Meters, Centimtr, Millimtr, DIN, or 
AS1100 for the scale type, the AreaPrec option is available in the scale 
type menu. Use this option to set the number of digits of precision to be 
displayed for area calculations. 

4. Toggle AddSnap on to add a snapping point to your drawing at each 
vertex of the polyline you select. 

5. Click on Select. You are prompted to “Select polylin
area/perimeter calculation”. 

6. Click on the polyline or circle you want to measure. The area and 
perimeter measurements are displayed in the Message Area, and 
additional Area/Per menu options are displayed in the Menu Window. If 
you select Arch, Engr, Decimal, Inch/Fr
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7. Display the centroid of the polyline by clicking on Centroid; then click on 
 on 

Area/Per menu to 

 for 

click in 

 To , and volume of a polyline you define: 

. The Area/Per menu is displayed in the Menu Window.  

3. le type 
cale 
 can 

 

 
ecisely select the first point for the polyline. You are 

prompted to “Select next point on polyline”. 

 you want to 
measure is enclosed by the polyline. You can also trace around arcs. See 

es” on the following pages for details. 

ou selected with the first one. Your cursor is 
detached from the polyline, and the area and perimeter measurements are 

dditional Area/Per menu options are 
 

, or 
 add a snapping point at the centroid. Right-click to 

return to the Area\Per menu. 

ShowIt to display a cross marking the centroid of the polyline, or click
AddIt to add a snapping point at the centroid. Right-click to return to the 
Area\Per menu. 

8. Add or subtract the next area or perimeter measurement from the total. 
Click on Perim+ to add the next perimeter measurement, click on Perim- 
to subtract the next perimeter measurement, click on Area+ to add the 
next area measurement, or click on Area- to subtract the next area 
measurement. Repeat step 6 as necessary to add or subtract an area or 
perimeter measurement. Click on Volume in the 
display the volume of the selected polyline. If you select Decimal, 
InchDec, Meters, Centi-mtr, Millimtr, DIN, or AS1100 for the scale type, 
AreaPrec is available in the scale type menu. Click on AreaPrec and use 
the value menu to set the number of digits of precision to be displayed
area calculations. 

9. Add the measurement as text to your drawing by clicking on ToDrwing; 
choose to add the area, the perimeter, the volume, or both area and 
perimeter to your drawing; set the text options as necessary; and 
the drawing to place the text.  

measure the area, perimeter

1. Go to the Tools pull-down menu, click on Measure, and then click on 
Area/Perimeter

2. Click on ScaleTyp. A list of scale types is displayed in the Menu Window.  

Click on a scale type to select it, and then right-click to exit the sca
list. If you select Arch, Engr, Decimal, Inch/Frc, or Inch/Dec for the s
type, the Acres option is available in the Area/ Per menu, which you
toggle on to display area units in acres. 

4. Toggle AddSnap on to add a snapping point to your drawing at each
vertex of the polyline you select. 

5. Define the polyline to measure by clicking in the Drawing Area or using
object snap to pr

6. Continue selecting points as necessary, until the area

“More About Tracing Polylin

7. Click on Close in the Area/Per menu to automatically connect the last 
point on the polyline y

displayed in the Message Area. A
displayed in the Menu Window. Click on Volume in the Area/Per menu
to display the volume of the selected polyline. 

8. Display the centroid of the polyline if necessary. Click on Centroid; then 
click on ShowIt to display a cross marking the centroid of the polyline
click on AddIt to
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9. Add or subtract the next area or perimeter measurement from the total. 
Click on Perim+ to add the next perimeter measurement, click on Perim- 

e 

10.  

 

Mo

Besides ur polylines, you can also trace around 2-
poi
opt s
your poly

 To 

2. 

bject snap, see “Object Snapping” earlier in this 
chapter. 

e 

1. Begin your polyline anywhere on the shape and continue it until you 

t of arc”. 

4. Click anywhere on the arc. 

5. Repeat steps 3 and 4 to immediately trace around another 3-point arc, or 
right-click to exit the 3PtArc menu. 

to subtract the next perimeter measurement, click on Area+ to add th
next area measurement, or click on Area- to subtract the next area 
measurement. Repeat step 6 and 7 as necessary to add or subtract an area 
or perimeter measurement. To measure a rectangular area or perimeter, 
simply click on RectAngl in the Area/Per menu, and enter two, 
diagonally opposite points. 

Add this measurement as text to your drawing by clicking on ToDrwing;
choose to add the area, the perimeter, the volume, or both area and 
perimeter to your drawing; set the text options as necessary; and click in
the drawing to place the text. 

re About Tracing Polylines 

 tracing straight sides for yo
nt arcs, 3-point arcs, and tangent arcs. The 2PtArc, 3PtArc, and Tangent 
ion  are available in the Area/Per menu after you select the first point for 

line. 

trace 2-point arcs: 

1. Begin your polyline anywhere on the shape and continue it until you 
select one end point of the 2-point arc. 

Click on 2PtArc in the Area/Per menu. You are prompted to “Select 
center of arc”. 

3. Click on the center of the arc, or object snap to it. You are prompted to 
“Select end point of arc”. 

4. Click or object snap to the other end point of the arc. For more 
information on how to o

5. Repeat steps 3 and 4 to immediately trace around another 2-point arc, or 
right-click to exit the 2PtArc menu. 

6. Continue tracing your polyline, and click on Close when finished. Th
area and perimeter measurements are displayed in the Message Area. 

 To trace 3-point arcs: 

select one end point of the 3-point arc. 

2. Click on 3PtArc in the Area/Per menu. You are prompted to “Select 
second end poin

3. Click on the second end point of the arc, or object snap to it. You are 
prompted to “Select any point on the arc”. 
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6. Continue tracing your polyline, and click on Close when finished. The 
area and perimeter measurements are displayed in the Message Are

trace tangent arcs: 

Begin your polyline anywhere on the shape, making sure you trace the 
line the arc was draw

a. 

 To 

1. 
n tangent to before you reach the first end point of 

2. the first end point of the tangent arc, click on 
 

4. ther tangent arc, or right-

5. , and click on Close when finished. The 
Area. 

Wo
The Ge
in your
rotate t X and Y axes to match an entity. 

Dividi
You n
sna
equal t

You ca den Section proportion. Golden Section 
div s  
sect
1:1.618,

  To 

3. r, and press (Enter). 

kip to step 5. However, to divide the line into 

are 

elect second point”. 

the tangent arc. 

Once you’ve selected 
Tangent in the Area/Per menu. You are prompted to “Select ending point
of arc”. 

3. Click on the other end point of the arc, or object snap to it.  

Repeat step 3 to immediately trace around ano
click to exit the Tangent menu. 

Continue tracing your polyline
area and perimeter measurements are displayed in the Message 

rking with Entities 
ometry menu has three options that may help you work with the entities 
 drawing. You can mark divisions or intersections of entities as well as 
he snap grid and even the 

ng Entities 
 ca  calculate equal divisions of lines and arcs and mark those divisions with 
p points. This feature is useful for such things as dividing a stair run into 

read lengths.  

n also divide a line using the Gol
ide  a line into two segments, one longer than the other, so that the smaller
ion is to the larger section as the larger is to the whole. The exact ratio is 

 a proportion considered harmonic by ancient Greeks. 

divide a line: 

1. Click on Geometry in the Tools pull-down menu, and then click on 
Divide. The Divide menu is displayed in the Menu Window. 

2. Click on Divisions. A value menu is displayed, and you are prompted to 
“Enter the number of divisions”. 

Use the value menu or type a numbe

4. Decide how you want to divide the line. If you simply want to divide the 
line into equal parts, s
sections of a specific distance as well, click on Div+Dist. A value menu is 
displayed, and you are prompted to “Enter distance between division 
points”. Use the value menu or type a number, and press (Enter). You 
prompted to “Select first point”. 

5. Click in the Drawing Area to select the first end point of the line, or use 
object snap to select it. You are prompted to “S
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6. Click in the Drawing Area to select the second end point of the line, o
use object snap to select it. The

r 
 line is divided, and a snap point is 

displayed at each division. 

e, or line: 

 displayed in the Menu Window. 

2. Click on Divisions. A value menu is displayed, and you are prompted to 
er of divisions”. 

4. Decide how you want to divide the line, arc, or circle. If you simply want 

yed and you are prompted to “Enter distance 

e”.  

6. ea. 
oint is displayed at each division. 

 To divide a line using Golden Section: 

3.  
k on Entity. You are prompted to “Select line, arc, or circle to 

ent 

vide. The line 
 

Line vi

 To divide an arc, circl

1. Click on Geometry in the Tools pull-down menu, and then click on 
Divide. The Divide menu is

“Enter the numb

3. Use the value menu or type a number, and press (Enter). 

to divide the entity into equal parts, skip to step 5. However, to divide the 
entity into sections of a specific distance as well, click on Div+Dist. A 
value menu is displa
between division points”. Use the value menu or type a number, and 
press (Enter).  

5. Click on Entity. You are prompted to “Select line, arc, or circle to divid

Select the entity you want to divide by clicking on it in the Drawing Ar
The line is divided, and a snap p

1. Click on Geometry in the Tools pull-down menu, and then click on 
Divide. The Divide menu is displayed in the Menu Window. 

2. Click on GoldSect. You are prompted to “Select first point”. 

Select the two end points of the line or simply select the line itself. To do
this, clic
divide”. When you select the two end points of a line, the longer segm
starts at the first end point. When you select the line using Entity, the 
longer segment is on the side of the line that you clicked on. 

4. Click in the Drawing Area to select the entity you want to di
is divided, and a snap point is displayed at the division between the two
segments. 

Golden Section:
di ded at point B, where the ratio

of AB : AC is equal to 1 : 1.618

A B C

 
1.9: Dividing a line using Golden Section Figure 1
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Ma i
You ca tersect and mark the 
inte

 To 

1. ols pull-down menu, and then click on 
ow. 

. 
 first line”. 

d 

4.  the other line to select it. The intersection is marked with a 

Ma h
You can p grid to match the angle of an entity, making it easier to 
draw. This does not rotate the X and Y axes. 

is displayed in the Menu Window. 
to orthographic (plan) view when you 

ivs. A value 
ted to “Enter 

ompted 

 

cursor is rotated to match the angle of the entity at the 
point you selected. 

ty’s angle, click on a line to select it. The cursor and 

 
or and snap grid are 

tated to match the angle of the line bisecting the selected 
tities (see Figure 11.11). 

rk ng Line Intersections 
n identify the precise point where two lines in

rsection with a snapping point. 

mark the intersection of two lines: 

Click on Geometry in the To
Intrsect. The Intrsect menu is displayed in the Menu Wind

2. Determine if the two lines are on different layers. If so, toggle LyrSrch on
You are prompted to “Select

3. Click on one of the lines to select it. You are prompted to “Select secon
line”. 

Click on
snapping point. 

tc ing the Snap Grid to an Entity 
 rotate the sna

 To match the snap grid to an entity: 

1. Click on Geometry in the Tools pull-down menu, and then click on 
Tangents. The Tangents menu 
DataCAD automatically changes 
use Tangents. 

2. Set the number of cursor snap angles by clicking on TanD
menu is displayed in the Menu Window, and you are promp
the number of cursor snap angles”. 

3. Use the value menu or type a number, and press (Enter). You are pr
to “Select the line to draw tangent to”. 

4. Select an entity to match its angle or select two lines and align the snap
grid with the line that bisects the angle between them. You can also select 
an arc or circle; the 

• To match an enti
snap grid are rotated to match the angle of the line. 

• To match a bisected angle between two lines, click on Bi-sect. Click on
the two lines to select them. The curs
ro
en

• To align the X and Y axes with the tangent entity, toggle DistSync on 
in the Utility/Settings menu (see Figure 11.10). 
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0°

0°
0°

screen coordi

Line to draw tangent to

Original cu

nate

Line selected
Line selected

rsor orientation

screen coordinates s

90°

90°

90°

Befo n

After e
(DistSync O (DistSync ON in 2D settings menu)

re Ta gents mode

New cursor orientation

New cursor orientation

Tang nts mode enabled
FF in 2D settings menu)

After Tangents mode enabled
 

Figure 11.10: Rotating the cursor and snap grid with Tangents, both with and without DistSync 
toggled on 

Second line to bisect

First line to bisect

Tangents mode using Bisect

New cursor orientation

 
Figure 11.11: Rotating cursor and snap grid to match bisecting angle 

Layer Utility 
y macro to recover a corrupted drawing file or to 

release excess memory being held in a drawing file. Excess memory can be tied 
up in a drawing file that has undergone extensive editing. Using Layer Utility is 

ted ones. 

drawing and load the layers from the layer file into the 

the

You can use the Layer Utilit

a two-step process: 

• First, save the layers of the problem drawing file to a layer file. You can save 
all the layers in the drawing or only selec

• Second, create a new 
new drawing. Corrupted drawing information and excess memory are not 
saved or transferred to the new drawing. It is very important that you load 

 layers into a new drawing file and not into an existing drawing file. 
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 s

1. rUtil menu is 

e Macros menu and add it to the Macros in 

2.  in 

ed for your 

 

•

tility, 
ave menu. The Layers menu 

g the 
ore You Draw” chapter. 

. 

 

1. scribed in “The Drawing Board” chapter. 

w. 

4.  the name of the layer file you want to load, and click Open. The 
layer file is loaded into your new drawing. You are prompted with 

5.  

 To d

e Menu Window. 

2. Click on Del Lyrs in the LyrUtil menu. A dialog box is displayed. 

3. Click on the layer file you want to delete, and then click Open. The layer 
file is deleted. 

To ave drawing layers: 

Click on LyrUtil in the Macros pull-down menu. The Ly
displayed in the Menu Window. If LyrUtil is not listed in your Macros 
menu, click Configure in th
Menu list. 

Click on LyrSave in the LyrUtil menu. The LyrSave menu is displayed
the Menu Window. 

3. Determine if you defined go-to-views for your drawing. If so, toggle 
Views on to save them. 

4. Determine if you have multi-scale plotting details defin
drawing. If so, toggle Details on to save them. 

5. Save your layers to a layer file using one of the following: 

 To save all the layers in the drawing, click on SaveAll.  

• To save only those layers that are toggled on (currently being 
displayed), click on SaveOn. 

• To change the layers that are toggled on without leaving Layer U
click on Lyr Menu in the LyrS
is displayed in the Menu Window. For details on usin
Layers menu, see the “Bef

6. Look at the dialog box. Enter the name of the layer file and click Open
The layer file is saved. 

To load a layer file into a new drawing file: 

Create a drawing, as de

2. Click on LyrUtil in the Macros pull-down menu. The LyrUtil menu is 
displayed in the Menu Windo

3. Click on LyrLoad in the LyrUtil menu. A dialog box is displayed.  

Click on

“Would you like to delete this session’s control and layer files”. 

Click Yes in the Menu Window to delete the layer (.LYS) file; click No to
retain the layer file. 

elete layer files you no longer need: 

1. Click on LyrUtil in the Macros pull-down menu. The LyrUtil menu is 
displayed in th
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More About Layer Utility 

nts of unused memory. Layer Utility releases this memory 

 a corrupted file and rebuild the 
drawing file. Corrupted drawing files are usually caused by power or hardware 

 is running. When a drawing file is corrupted, information 
is d

 

The file size of a drawing is increased when entities are added to the drawing, 
but it is not reduced in size when they are deleted. This results in a file with 
potentially large amou
from the file, shrinking drawing file size. 

Layer Utility can also recover unaffected data in

failure while DataCAD
istorted or cannot be accessed. 
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Editing Drawings 
The Edit menu contains several tools you can use to change the 
visible characteristics of entities as well as their position in the 

In this cha

drawing. Wall and line intersections can be cleaned, breaks can 
ther entity or to an 

inte c

In add
numbe t only can you change 
suc t
move, . 

12 
pter: 

 Cleaning intersections 

 Welding lines and walls 

ing lines 

anging entity 
attributes 

ntities 

 Rotating entities 

ntities 

entities 

 Stretching entities 

 Clipping entities 

 

be welded, and lines can be trimmed to ano
rse tion in your drawing. 

ition to repairing drawing mistakes, you can also use a 
r of features to edit entities. No

 Trimm

 Ch

h a tributes as the color or linetype of an entity, you can also 
rotate, or stretch an entity or even an entire room

 Moving e

 Erasing e

 Enlarging 
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Trimm
There a u can use to trim corners and lines, weld lines and 
wal  a

Trimm
You ither an arc or a line. The Fillets 
option connects two lines with an arc and can then trim them to make a smooth 
cur
two lin ese two lines do not have to be connected prior to 
usi  
they ca

 To 

1. 
Window. 

of the fillet arc, click on Radius. A 

ains 
ng is 

very time you open the drawing the 

5. ted lines to the ends of 

6. ers by toggling LyrSrch on. You are 

7. u are prompted to “Select second 

Clic

You can
intersec o lines. The lines are 
lengthened

ing, Welding, and Cleaning 
re several tools yo

ls, nd clean up intersections in your drawing.  

ing Corners 
 can connect any two non-parallel lines with e

ve. The Chamfer option connects two lines with a line and can then trim the 
es to the chamfer. Th

ng Fillets or Chamfer. They can be two lines that form the corner of a room, or
n be two completely separate lines in your drawing. 

connect two lines with an arc: 

Click on Cleanup in the Edit menu in the Menu Window. The Cleanup 
menu is displayed in the Menu 

2. Click on Fillets in the Cleanup menu. The Fillets menu is displayed in the 
Menu Window. 

3. Change the fillet radius if necessary. The default setting for the fillet 
radius is 1’-0.” To change the radius 
value menu is displayed. 

4. Use the value menu or type a radius, and press (Enter). The radius rem
at this setting for this drawing until you change it. In fact, this setti
saved with the drawing, so that e
Fillets radius is automatically set to the value you enter in these steps. 

Toggle Clip on or off. To trim the ends of the selec
the arc, toggle Clip on. To draw the arc but leave the ends of the lines 
unaffected, toggle Clip off (see Figure 12.1). 

Connect lines on two different lay
prompted to “Select first line to fillet.” 

Click on one of the lines to select it. Yo
line to fillet.” 

k on the other line to select it. The two lines are connected by an arc. 

 use Fillets to extend two nonparallel, nonintersecting lines until they 
t. Simply set the Radius to 0, and select the tw

 until they intersect. 

 
2.1: Lines trimmed to fillet (Clip oFigure 1 n) and lines left untrimmed (Clip off) 
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1. 

2.  the Cleanup menu. The Chamfer menu is displayed 
in the Menu Window. 

3. 
ines to the 

chamfer point on each line. A value menu is displayed. You are prompted 

4. u or type a chamfer distance for the first line you will 
select, and press . Another value menu is displayed. You are 

e.” 

ter). 

 the ends 

7. 

Click on the other line to select it. The two lines are connected by a line.  

fer. 

To connect two lines with a line: 

Click on Cleanup in the Edit menu in the Menu Window. The Cleanup 
menu is displayed in the Menu Window. 

Click on Chamfer in

Set the chamfer distance for each line by clicking on Distnces. The chamfer 
distance is the distance from the intersection of the two l

to “Enter first chamfer distance.” See Figure 12.2 for an illustration of 
chamfer distances and how they relate to the lines you select. 

Use the value men
(Enter)

prompted to “Enter second chamfer distanc

5. Use the value menu or type a chamfer distance for the second line you 
will select, and press (En

6. Toggle Clip on or off. To trim the ends of the selected lines to the ends of 
the chamfer line, toggle Clip on. To draw the chamfer but leave
of the lines unaffected, toggle Clip off.  

6. Connect lines on two different layers by toggling LyrSrch on. You are 
prompted to “Select first line to chamfer.” 

Click on one of the lines to select it. You are prompted to “Select second 
line to chamfer.” 

Lines may be shortened or lengthened to meet the ends of the cham

 
Figure 12.2: The first chamfer distance entered corresponds with the first line you select, and
the second chamfer distance entered corresponds with the second line you select. 
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Trimming Entities 
Trim i  arcs. 
You ca rim 
two lin  can specify not only what entities you 
want trimm

 To 

1. Click on Line Cleanup in the Edit pull-down menu and then click on 1 
 

rtened or lengthened to meet the trim line. This 
line can either be an existing line in your drawing or it can be a 

at you draw.  

 on Entity in 
erent 

 to 

m line, click in the Drawing Area or use 
nter the first end point of your trim line. Click in the 

f 
. 

3.  the trim line; this will be the side that 

4. 
 line. For more information on using 

m ng entities involves either shortening or lengthening selected lines or
n trim existing entities to a temporary line that you draw, you can t
es so they intersect cleanly, or you

ed, but exactly how to trim them. 

trim entities so they end at a line you specify: 

Line Trim in the submenu. The 1LnTrim menu is displayed in the Menu
Window. 

2. Select a trim line, a line that entities will be trimmed to. Entities in your 
drawing will either be sho

temporary line th

• To use an existing line in your drawing as the trim line, click
the 1LnTrim menu. Toggle LyrSrch on if your trim line is on a diff
layer. Click on the line in your drawing to select it as the trim line. Skip
step 4.  

• To draw a temporary tri
coordinate entry to e
Drawing Area or use coordinate entry to enter the second end point o
your trim line. A dashed line representing the trim line is displayed

Click anywhere on the outside of
will be trimmed (see Figure 12.3). 

Choose a selection method, and then select the entities you want to trim. 
The entities are trimmed to the trim
selection menus, see “Selection Menus” in “The Drawing Board” chapter. 

 
Figure 12.3: Trimming entities to a trim line 

Line Cleanup in the Edit pull-down menu and then click on 2 
Line Trim in the submenu. The 2LnTrim menu is displayed in the Menu 

. You 

3. t to trim. You are prompted to “Select 

 To trim two lines to their intersection: 

1. Click on 

Window. 

2. Toggle LyrSrch on if the lines you want to trim are on different layers
are prompted to “Select first line to trim.” 

Click on one of the lines you wan
second line to trim.” 
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4. Click on the other line you want to trim. The lines are trimmed at t
intersection. The lines you select do not have to intersect; if they don’t, 
they will be lengthened when they are trimmed. 

heir 

 
Figure 12.4: Trimming two intersecting lines  

 To specify the entities to be trimmed and how to trim them: 

1. Click on Line Cleanup in the Edit pull-down menu and then click on Free 
Trim in the submenu. The FreeTrim menu is displayed in the Menu 

 

trimmed or exit the FreeTrim menu by 
clicking once. 

Window. FreeTrim only trims to or between selected entities; therefore, 
you must select not only the entity you want to trim but also all the 
entities that it intersects with. 

2. Choose a selection method, and then select the entities you want to trim
as well as any intersecting entities. All selected entities are displayed in 
dashed lines. 

3. Click on Begin in the FreeTrim menu. You are prompted to “Select entity 
section to be trimmed.” 

4. Click on the line or arc segment that you want trimmed (removed). 
DataCAD searches for the nearest intersections and trims to the 
intersection points (see Figure 12.5). 

Continue selecting segments to be 
clicking on Exit or right-

If you get unexpected results after using FreeTrim, click on Undo in the Edit pull-
down menu. 

 
Figure 12.5: Selecting the line segment you want trimmed (removed) 

Welding Lines and Walls 
You can repair lines and walls that have breaks in them, making a single, 
straight, continuous line or wall. 
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 To weld lines: 

1. Click on Line Cleanup in the Edit pull-down menu and then click o
Weld Line in the submenu. The WeldLine menu is displayed in the M
Window.  

Toggle LyrSrch on if t

n 
enu 

2. he lines you want to weld together are on different 

3. ct 

 
rrect?” 

layers. You are prompted to “Select first line to weld.” 

Click on one of the lines you want to weld. You are prompted to “Sele
second line to weld.” 

4. Click on the other line you want to weld. The lines are welded. You are
prompted with “Is this co

5. Click on Yes if the weld is correct. Click on No if it is not; the lines are 
returned to their original state. 

 
Figu

 To w

nu 
ng a window or door, 

2. ifferent 

3. Select the walls to be welded by drawing a rubberband box around the 

ox in order for the walls to be welded. To select 
u 

wall opening to weld.” 

re 12.6: Two lines welded into a single line 

eld walls: 

1. Click on Wall Cleanup in the Edit pull-down menu and then click on 
Weld Wall in the submenu. The WeldWall menu is displayed in the Me
Window. If you have already cut the walls by inserti
you must first erase the window or door before you can weld the walls. 

Toggle LyrSrch on if the walls you want to weld together are on d
layers. You are prompted to “Select first point on box around wall 
opening to weld.” 

two wall ends you want to weld. There must be only two wall ends 
within the rubberband b
the first corner of this box, click above and to the left of the wall ends yo
want to weld. You are prompted to “Select second point on box around 
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4. Move your mouse diagonally to stretch the rubberband box around t
two wall ends you want to weld and click. The walls are welded. If the 
two walls are no

he 

t in line with each other, an error message will be 
displayed, saying that the two walls can’t be welded. 

 
Figure 12.7: Welding two wall ends 

Cleaning Wall Intersections 
You can clean the wall intersections of 2-line, 3-line, or 4-line walls that meet in 
an L, T, or X shape. 

 
Figure 12.8: T-shaped intersections with different wall types 

 
Figure 12.9: L-shaped intersections with different wall types 
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Figure 12.10: X-shaped intersections with different wall types 

 To clean wall lines meeting in a T intersection: 

1. Click on Wall Cleanup in the Edit pull-down menu and then click on T-
Intersection in the submenu. The TIntsct menu is displayed in the Menu 
Window. 

2. Toggle LyrSrch on if the wall intersection you want to clean is on a 
different layer than the active layer. You are prompted to “Select first 
corner around T intersect (wall line ends only).” 

3. Select the intersection to be cleaned by drawing a rubberband box around 
it. To select the first corner of the box, click above and to the left of the 
intersection. You are prompted to “Select second corner around T 
intersect (wall line ends only).” 

4. Move your mouse diagonally to stretch the rubberband box around the 
intersection, and click. You are prompted to “Point to wall line to trim to.” 
Make sure you include only one intersection within the rubberband box. 

5. Click on the wall line to trim to (see Figure 12.11). The intersection is 
cleaned. 

 
Figure 12.11: Cleaning a T-shaped intersection 
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 To clean wall lines meeting in a L intersection: 

1. Click on n click on L-
Intersec d in the Menu 

 is on a 
e

berban
eft of the 

 

4. Move your mouse diagonally to stretch the rubberband box 

 Wall Cleanup in the Edit pull-down menu and the
tion in the submenu. The LIntsct  menu is displaye

Window. 

2. Toggle LyrSrch on if the wall intersection you want to clean
different layer than the active layer. You are prompted to “S
corner around L intersect (wall line ends only).” 

3. Select the intersection to be cleaned by drawing a rub

lect first 

d box around 
it. To select the first corner of the box, click above and to the l
intersection you want to clean. You are prompted to “Select
around L intersect (wall line ends only).” 

second corner 

around the 
intersection, and click. The intersection is cleaned. 

 
Figure 12.12: Cleaning L-shaped intersections 

 To clean wall lines meeting in a X intersection: 

1. Click on Wall Cleanup in the Edit pull-down menu and then click on X-
Intersection in the submenu. The XIntsct  menu is displayed in the Menu 
Window. 

2. Toggle LyrSrch on if the wall intersection you want to clean is on a 
different layer than the active layer. You are prompted to “Select first 
corner around X intersect (0 line ends).” 

3. Select the intersection to be cleaned by drawing a rubberband box around 
it. To select the first corner of the box, click above and to the left of the 
intersection you want to clean. You are prompted to “Select second corner 
around X intersect (0 line ends).” 

4. Move your mouse diagonally to stretch the rubberband box around the 
intersection and click. The intersection is cleaned. 
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Box

Original Resulting "X" Intersection  
Figure 12.13: Cleaning an X-shaped intersection 

Changing Entities 
Yo etype, line weight, color, line 

-height. You can also change the size, weight, 
slan

In addi , 
and thi ion, too, can be edited. There’s even a macro that you can use to 
con

Ch g
The lin
can all -
solid lin

  change e

1. . 

2. 
er. 

ne spacing), OverSht (line overshoot), Z-Base, or Z-

4. 
g 

5. Change the color of the entity by clicking on Color. Select the color you 

6. ou are prompted to select 
the entities you want to change. 

7. Select the entities you want to change. The attributes of these entities are 
modified. 

u can change an entity’s attributes, such as lin
spacing, overshoot, Z-base, and Z

t, aspect, and font of text. 

tion to attributes, some entities have information associated with them
s informat

vert lines to walls or walls to lines. 

an ing Entity Attributes 
etype, line weight, line spacing, overshoot, Z-base, and Z-height attributes 
be changed using value menus. Line spacing settings apply only to non
etypes. Use a color menu to change an entity’s color. 

To ntity attributes: 

Click on Change in either the Edit pull-down menu or the Menu Window
The Change menu is displayed in the Menu Window. 

Toggle LyrSrch on if the entities you want to change are on a different 
layer than the active lay

3. Click on the attribute you want to change: LineType, LineWgt (line 
weight), Spacing (li
Hgt (Z-height). A value menu is displayed. 

Use the value menu or type a number, and press (Enter). For more 
information on using value menus, see “Value Menus” in “The Drawin
Board” chapter. 

want to use from the color menu. For more information on using color 
menus, see “Color Menus” in “The Drawing Board” chapter. 

Choose the selection method you want to use. Y
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Figu 1

  

1. 
ow. 

4. 
t. 

5. t 
ction 

6. ompted to select the 

7. 

Changing T
You  
depend

 c

1. 

3. yer 
ctive layer. 

4. e size, 

on text 

re 2.14: Changing the overshoot of lines 

To change entity attributes to match those of another entity: 

Click on Change in either the Edit menu or the Menu Window. The 
Change menu is displayed in the Menu Wind

2. Click on Match. 

3. Toggle LyrSrch on if the entities you want to change are on a different 
layer from the entities you want to match. 

Choose which attributes to change by toggling on any of the following 
options: LineType, LineWgt, Color, Spacing, OverSht. Z-Base, and Z-Hg
Or click on All to toggle all of these attribute options on. 

Choose the selection method you want to use. You are prompted to selec
the entities you want to change. For more information on sele
menus, see “Selection Menus” in “The Drawing Board” chapter. 

Select the entities you want to change. You are pr
entity whose attributes you want to match. 

Select the entity to match. The attributes of the entities you selected in 
step 6 are modified. 

ext Attributes 
 can change the attributes of a single line of text or of all text in your drawing,

ing on what selection method you use. 

To hange the attributes of text: 

Click on Change in the Edit menu. The Change menu is displayed in the 
Menu Window. 

2. Click on Text in the Change menu. 

Toggle LyrSrch on if the text you want to change is on a different la
than the a

Change the appearance of text in your drawing. You can change th
weight, slant, aspect, contents, capitalization, font name, and matching 
characteristics in the Change\Text menu. For more information 
parameter settings, see the “Text, Notes, and Labels” chapter. 
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• To change the font, click on FontName, then select a font in the Font 

 
dialog box. You can display true-type fonts (TTF), DataCAD fonts (CHR), 

 
; then enter the new size in the Height filed or select a value 

•  the lines of text, type an angle value or click on one 

• pect 
 on one in the Aspect list box. 

lue 

• he line weight of text when using a DataCAD font, type a 

• 
the TTF Style list box. 

• 
tline, as 

necessary. 

5. dialog box. 

 

7. hen select the text. It is 
displayed in the Message Area. For more information on selection menus, 

rawing Board” chapter. 

ant to change. The attributes of the text are modified. 

 c

1. hange in the Edit menu. The Change menu is displayed in the 

2.  Match.. 

r 

4. which attributes to change by toggling on any of the following 
 

Name list box. Keep in mind that the fonts displayed under Font Name 
are determined by the Font Type selection in the lower-left corner of the

or both in the list.  

• To change the text’s size, use the Size button and type the new value. 
Alternatively, you can click FontName to open the Set Text Parameters
dialog box
from the Height list box. 

To change the angle of
in the Angle list box. 

To change the height of each character relative to its width, type an as
ratio value or click

• To change the slant of text when using a DataCAD font, type a slant va
or click on one in the CHR Slant list box. 

To change t
weight value or click on one in the CHR Weight list box. 

To change the font style when using a true-type font, click on a style in 

To change the text properties when using a true-type font, select Fill, 
Outline, or Both and then set the colors for the Fill and Ou

Click on OK to save the text parameter changes and close the 

6. Change the text itself by clicking on Contents. (Otherwise, skip to step 9.)
You are prompted to select the text you want to change. 

Choose a selection method from the menu, and t

see “Selection Menus” in “The D

8. Type the new text and press (Enter). 

9. Choose the selection method you want to use. You are prompted to select 
the text you want to change. 

10. Select the text you w

To hange text attributes to match those of another text block: 

Click on C
Menu Window. 

Click on

3. Toggle LyrSrch on if the text you want to change is on a different laye
from the text you want to match. 

Choose 
options: Size, Weight, Slant, Aspect, and FontName. Or click on All to
toggle all of these attribute options on. 
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5. Choose the selection method you want to use. You are prompted to sele
the text you want to change. 

Select the text you want to change. You a

ct 

6. re prompted to select the text 

Editin
Most of the taCAD entities don’t have any additional information 
atta hat are 
hyperli he FormAtr 
ma .

 To edit entity attributes: 

figure in the Macros menu and add it to the Macros in 

ect entity 

4. he edit box to the text you want to change.  

6. 

Co
Using t o, you can convert lines to 2-line, 3-line, or 4-line walls. 
You can only convert lines; you can’t convert curves. Alternatively, you can 
conver
lines an wall, so that it 
wil  

 To convert lines or walls: 

 pull-down menu. The Lin2Wall menu is 

t 

3. sion result: 

• 

whose attributes you want to match. 

7. Select the text to match. The attributes of the text you selected in step 6 
are modified. 

g Entity Information 
standard Da

ched to them, but a few do, such as associative hatching and entities t
nked to go-to-views. You can edit this information using t

cro  

1. Click on FormAtr in the Macros pull-down menu. The FormAtr menu is 
displayed in the Menu Window. If FormAtr is not listed in your Macros 
menu, click Con
Menu list. 

2. Click on Entities in the FormAtr menu. You are prompted to “Sel
to edit attribute fields.” 

3. Click on the entity. The entity’s information is displayed in the Drawing 
Area. 

Press (Tab) to move t

5. Type the new text and press (Enter). The information is changed. 

Repeat steps 4 – 5 to continue editing, or press (Esc) to exit editing and 
return to your drawing. 

nverting Lines to Walls 
he Lin2Wall macr

t walls to lines. This tool can be useful when, for instance, you draw three 
d then want DataCAD to recognize those lines as a 3-line 

l be properly cut when you insert doors or windows. 

1. Click on Lin2Wall in the Macros
displayed in the Menu Window. If Lin2Wall is not listed in your Macros 
menu, click Configure in the Macros menu and add it to the Macros in 
Menu list.  

2. Toggle LyrSrch on if the lines/walls you want to convert are on a differen
layer than the active layer.  

Choose your conver

• To convert walls to lines, click on Lines. 

To convert lines to 2-line walls, click on 2LnWall. 
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• To convert lines to 3-line walls, click on 3LnWall. 

To convert lines to • 4-line walls, click on 4LnWall. 

 

5.  change. The entities are modified, although 
their actual appearance on screen won’t change. See “More About 

es to Walls” below for details. 

walls, 
erted to walls. 

 Lines to Walls 

Wh y
recogn ve 
drawn  that you now want to convert into a single 3-line wall, simply 
cho  
con  
Attrib setting is changed so that DataCAD recognizes each line as part of a 3-line 
wa  
setting ave 
an Attr and lines in 4-line 
wal

Moving Entities 
 to a different position in your drawing by either 

spe  
its new  

If an en ed to others in a group or selection set, it remains linked when 
you o

You can use object snapping to align a point on the entity you move with a point 
on  
you wa irst 
entity i  and aligned at the points you snapped to. 

Movin

 To move entities to absolute zero: 

 from the Tool menu. Set the input mode to Absolute 

2. ion 
, press (PgUp) to zoom out. 

4. int near the center of the drawing. 

ordinates 0, 0 as the distance from absolute zero. 

4. Choose the selection method you want to use. You are prompted to select
the entities you want to change. 

Select the entities you want to

Converting Lin

When you use Lin2Wall to convert lines with doors or windows in them to 
use the Entity selection method to ensure that all lines are conv

More About Converting

en ou convert lines to walls in your drawing, they will no longer be 
ized as separate lines; DataCAD will instead see them as a wall. If you’
 three lines

ose the 3LnWall option and select each of the lines. When you select a line to
vert it, its appearance isn’t changed and it’s not redrawn on screen; rather its

ll. If you use Identify after you’ve converted the lines, you’ll see the Attrib
displayed in the Message Area. Single lines and lines in 2-line walls h
ib setting equal to 5; lines in 3-line walls have Attrib=36; 

ls have Attrib=63. 

You can move an entity
cifying the distance and angle to move the entity or by dragging the entity to

 position. You can also move entities to another layer in your drawing.

tity is link
 m ve it. 

another entity in your drawing. Simply snap to the entity to move at the point
nt to align, and then snap to the other entity at the point to align. The f
s moved

g Entities to Absolute Zero 

1. Select Input Mode
Cartesian. 

Recalculate the extents of the drawing by clicking the R in the Navigat
Pad. Then

3. Select Move from the Edit menu. 

Select the first po

5. Respond to the prompt for the second point of the distance to move by 
pressing (Spacebar); this allows you to use coordinate entry. Press (Enter) 
twice to accept the co
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6. Draw an area box around the entire drawing, making sure that LyrSrch
on and that 

 is 
no layers are locked. 

Movin istance and Angle 
When you use Move, you are prompted to enter two points. The distance 

ce the entity is moved from the 
orig
move fr

 To move an entity a specified distance and angle: 

1.  the Edit menu. The Move menu is displayed in the 
Menu Window, and you are prompted to “Select first point of the distance 

2. the Drawing Area or use coordinate entry to enter the first point. 
A directional arrow is displayed; notice that moving your mouse changes 

ce and angle as the 

3. Click in the Drawing Area or use coordinate entry to enter the second 
enu as well as other Move options are displayed in 

4. Move the selected entities in the Z direction if necessary. Click on MoveZ, 
tities in the Z 

(Enter)

if the entities you want to move are on a different layer 
than the active layer. 

6.  
. 

t to move. For more information on using selection 

8.  

• 

• 

g Entities by Specific D

between these two points will be the distan
inal position; the angle defined by these two points will be the angle of the 

om the original position. 

Click on Move in

to move.” 

Click in 

the length and angle of the arrow. You are prompted to “Select second 
point of the distance to move.” To use the same distan
last time you used Move, click on PrevDist. 

point. A selection m
the Menu Window. The points you select in steps 2 and 3 can be selected 
anywhere on the screen; they indicate the distance and angle to move 
only, and not the beginning and ending points of the move. 

and use the value menu to enter the distance to move the en
direction. Press  or right-click to return to the Move menu. 

5. Toggle LyrSrch on 

Toggle AndCopy on to copy the selected entities the specified distance
and angle

7. Click on a selection method in the menu. You are prompted to select the 
entities you wan
menus, see “Selection Menus” in “The Drawing Board” chapter. 

Select the entities; they are moved in the drawing. You can continue
selecting entities to move them at the same distance and angle. 

To move entities at the same distance and angle but in the opposite 
direction, click on Invert and then select the entities to be moved. 

To enter a new distance and angle, click on NewDist and continue with 
step 2 above. 
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2.15: SpFigure 1 ecifying the distance and angle to move a polygon 

Movin
One advantage to dragging entities is that you have the option to select multiple 
ent

 

1. 

he 

4. Toggle AndCopy on to copy the selected entities as you drag them. 

e 

selected entities is displayed when you begin to drag them. The entities 
elect the new location for them. When you set 
ectangular box is always displayed while dragging. 

7. Click on a selection method in the menu. You are prompted to select the 
entities you want to move. 

8. Select the entities to be moved. You are prompted to select a point to drag 
from. 

9. Skip to step 10 if Multi is toggled off. If you toggled Multi on in step 6, 
click on Begin and continue with step 10.  

g Entities by Dragging 

ities before moving them. 

To move entities by dragging them: 

Click on Move in the Edit menu. The Move menu is displayed in the 
Menu Window. 

2. Click on Drag in the Move menu. The Drag menu is displayed in t
Menu Window. 

3. Toggle LyrSrch on if the entities you want to move are on a different layer 
than the active layer. 

5. Change the maximum number of lines to be displayed if your entities ar
complex and you want a smoother drag. Click on MaxLines and use the 
value menu to enter the number of lines. Press (Enter) or right-click to 
return to the Drag menu. When the entities you selected to drag contain 
more lines than the MaxLines setting, a rectangular box representing the 

reappear after you s
MaxLines to 0, the r

6. Toggle Multi on to make multiple selections of entities to be moved. 
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10. Click on a point in the Drawing Area; you can also use coordinate entry 
or object snapping to select this point. For more information on using 
coordinate entry, see “Drawing Using Coordinate Entry” in “The 
Drawing Board” chapter. 

11. Move your mouse to drag the entities to their new position and click to 
place them. The entities are moved in the drawing. 

12. Continue dragging and placing copies of the selected entities if AndCopy 
is toggled on. 

Moving Entities to Another Layer 
When you have more than one layer in your drawing, the ToLayer option is 
displayed in the Move menu. ToLayer is used to move entities from one layer to 
another in your drawing. You can move entities in the same position as the 
original layer (no distance and angle entered) or you can move entities to another 
layer at a specified distance and angle. For more information on creating layers, 
see “Creating Layers” in the “Before You Draw” chapter. 

anging their positions: 

2. 

nu 

. 

t layer 

6. You 

7. 

 To 

 

 on the screen; 

 To move entities to another layer without ch

1. Click on Move in the Edit menu. The Move menu is displayed in the 
Menu Window. 

Click on ToLayer in the Move menu. A list of all the layers in your 
drawing is displayed in the Menu Window, and you are prompted to 
“Select layer to move to.”  

3. Click on the layer you’d like to move entities to or type the name of the 
layer and press (Enter). The ToLayer menu is displayed in the Me
Window. Use Match and Filter to select or find the layer you want to 
move to. For details on how to use these options, see “Selecting Layers 
Without Using Layer Names” and “Searching for Layers” in the “Before 
You Draw” chapter

4. Toggle LyrSrch on if the entities you want to move are on a differen
than the active layer. 

5. Click on a selection method in the menu. You are prompted to select the 
entities you want to move. 

Select the entities; they are moved to the layer you chose in step 3. 
can continue selecting entities to move them. 

Choose another layer to move entities to by clicking on NewLyr and 
continuing with step 4 above. 

move entities to another layer at a different distance and angle: 

1.  Click on Move in the Edit menu. The Move menu is displayed in the 
Menu Window and you are prompted to “Select first point of the distance
to move.” To use the same distance and angle as the last time you used 
Move, click on PrevDist. 

The points you select in steps 2 and 3 can be selected anywhere
they indicate the distance and angle to move only, not the beginning and ending 
points of the move. 
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2. Click in the Drawing Area or use coordinate entry to enter the first poin
A directiona

t. 
l arrow is displayed; notice that moving your mouse changes 

pted to “Select second 

ptions are displayed in 
the Menu Window. For more information on using coordinate entry, see 

ntry” in “The Drawing Board” chapter. 

f all the layers in your 

 
nu as well as other Move options 

are displayed in the Menu Window. 

n if the entities you want to move are on a different layer 

 more information on using selection 
menus, see “Selection Menus” in “The Drawing Board” chapter. 

y are moved to the layer you chose in step 5. You 

icking on NewLyr and 
6 above. 

Ro t
You can turn an e nd position it at a specific angle. 
Or 
positio ing the entity. 

  r

1. 

2. entry to enter the center of 
ed in 

dow. 

4. 
of rotation is 90°. Use the value menu or 

5. 

e 

the length and angle of the arrow. You are prom
point of the distance to move.” 

3. Click in the Drawing Area or use coordinate entry to enter the second 
point. A selection menu as well as other Move o

“Drawing Using Coordinate E

4. Click on ToLayer in the Move menu. A list o
drawing is displayed in the Menu Window. You are prompted to “Select 
layer to move to.” 

5. Click on the layer you’d like to move entities to, or type the name of the
layer, and press (Enter). A selection me

6. Toggle LyrSrch o
than the active layer. 

7. Click on a selection method in the menu. You are prompted to select the 
entities you want to move. For

8. Select the entities; the
can continue selecting entities to move them. 

9. Choose another layer to move entities to by cl
continuing with step 

ta ing Entities 
ntity around a rotation center a

you can dynamically rotate an entity, allowing you to preview the rotated 
n before plac

To otate an entity: 

Click on Rotate in the Edit menu. The Rotate menu is displayed in the 
Menu Window, and you are prompted to “Select center of rotation.” 

Click in the Drawing Area or use coordinate 
rotation. A selection menu as well as other Rotate options are display
the Menu Win

3. Toggle LyrSrch on if the entities you want to rotate are on a different layer 
than the active layer. 

Enter an angle of rotation by clicking on NewAngle. A value menu is 
displayed. The default angle 
type an angle, and press (Enter). 

Toggle AndCopy on if you want to both rotate and copy the selected 
entities. 

6. Click on a selection method in the menu. You are prompted to select th
entities you want to rotate. 
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7. Select the entities; they are rotated in the drawing. You can continue 
selecting entities to rotate them at the same angle and around the same 
center. 

• To rotate entities around the same rotation center but at the opposite 
angle, click on Invert and then select the entities to be rotated. 

To return to the original angle, click on Invert again. 

To enter a new center of rotation, click on NewCentr and continue with 
step 2 abov

• 

• 
e. 

 

1. enu is displayed in the 

2.  
 in 

3. r 

5. 

6. e rotation before you place the entity. The 

7. 
er rotating of complex entities. Click on MaxLines and use the 

8. tities to be rotated. 

e 
nt to rotate. 

the same angle and around the same 
center. 

und the same rotation center but at the opposite 
be rotated. 

• To enter a new center of rotation, click on NewCentr and continue with 

More About Setting an Angle of Rotation 

Not only can you set the angle of rotation using the NewAngle value menu, but 
you can also use other options when you click on Match in the value menu to get 
exactly the angle you want. You can: 

• click on an entity to match its angle of rotation  

To rotate an entity dynamically: 

Click on Rotate in the Edit menu. The Rotate m
Menu Window, and you are prompted to “Select center of rotation.” 

Click in the Drawing Area or use coordinate entry to enter the center of
rotation. A selection menu as well as other Rotate options are displayed
the Menu Window. 

Toggle LyrSrch on if the entities you want to rotate are on a different laye
than the active layer. 

4. Click on NewAngle to enter an angle of rotation. A value menu is 
displayed. Use the value menu or type an angle and press (Enter). 

Toggle AndCopy on to both rotate and copy the selected entities. 

Click on Dynamic to preview th
MaxLines and Multi options are displayed. 

Set the maximum number of lines to be displayed while rotating for 
smooth
value menu to enter the number of lines. Press (Enter) or right-click to 
return to the Rotate menu. 

Toggle Multi on to select multiple en

9. Click on a selection method in the menu. You are prompted to select th
entities you wa

10. Select the entities; they are rotated in the drawing. You can continue 
selecting entities to rotate them at 

• To rotate entities aro
angle, click on Invert and then select the entities to 

step 2 above. 
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• select two points which define an angle of rotation to match 

• enter an angle of rotation and then use the inverse of that angle 

• enter an angle of rotation and then use the complement of that angle 

• enter an angle of rotation and then use the supplement of that angle 

For instance, when your original angle is 30°, clicking on Invert in the Match 
menu gives you an angle of rotation of –30°. The complement angle is 60° and the 
supplement angle is 150°. 

Stretching Entities 
You can increase or decrease the length of an entity –- or even an entire room --- 
while maintaining connections to adjacent entities. For example, you can stretch 
a wall or closet without breaking it from connected walls. 

 To stretch an entity: 

1. Click on Stretch in the Edit menu. The Stretch menu is displayed in the 
Menu Window, and you are prompted to “Select first point of the distance 
to stretch.” 

Click in the Drawing Area or use coordinate entry to enter the first point. A 
directional arrow is displayed; notice that moving your mouse changes 
the length and angle of the arrow. You are prompted to “Select second 
point of the distance to stretch.”  

To increase the possible angles of the directional arrow, press (O) to toggle ortho 
mode off. 

3. Click in the Drawing Area or use coordinate entry to enter the second 
point. A selection menu as well as other Stretch options are displayed in 
the Menu Window. 

4. Toggle LyrSrch on if any of the entities you want to stretch are on a 
different layer than the active layer. 

5. Click on a selection method in the menu. You are prompted to select the 
entities you want to stretch. 

6. Select the entities; they are stretched in the drawing. You can continue 
selecting entities to stretch them at the same distance and angle. 

• To stretch entities at the same distance and angle but in the opposite 
direction, click on Invert and then select the entites to be stretched. 

• To enter a new stretch distance and angle, click on NewDist and continue 
with step 2 above. 
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Figure 12.16: Stretching a wall 

Enlarging Entities 
You can increase or decrease the size of an entity by entering specific 
enlargement values for the X, Y, and Z axes. 

 To enlarge an entity: 

1. Click on Enlarge in the Edit menu. The Enlarge menu is displayed in the 
Menu Window, and you are prompted to “Select center of enlargement.” 

2. Click in the Drawing Area or use coordinate entry to enter the center of 
enlargement. A selection menu as well as other Enlarge options are 
displayed in the Menu Window, and the enlargement factor and line 
spacing setting are displayed in the Message Area. 

3. Click on EnlrgeZ to enter a Z elevation for the center of enlargement. Use 
the value menu to enter a Z elevation and press (Enter). 

4. Toggle LyrSrch on if the entities you want to enlarge are on a different 
layer than the active layer. 

5. Click on Enlrgmnt in the Enlarge menu to change one or all of the 
enlargement factors. The XEnlgmt, YEnlgmt, ZEnlgmt, LineFact, and 
SetAll options are displayed. 

6. Click on any enlargement factor option to display a value menu that you 
can use to set these factors: 

• To enlarge entities along the X axis, click on XEnlgmt. 

• To enlarge entities along the Y axis, click on YEnlgmt. 

• To enlarge entities along the Z axis, click on ZEnlgmt. 
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• To set the line spacing enlargement factor for non-solid linetypes, click on 
cts how linetypes like Dashed are 

e 

7. Use the value menu or type an enlargement setting, and press (Enter).  

  select the 

. 
ge them by the same factor and around the same 

• ties around the same enlargement center but at different 
ties to be 

t enlargement 
rea. For example, 

• er of enlargement, click on Center and continue with 

Erasi
You can remove entities from your drawing by simply using the selection menu 
in the Erase menu to select the entities. You can also erase a specific segment of a 
line, circle, or curve.  

All entities in an array are identified as a single group. To erase entities within an 
array, use the Entity or Area selection method. 

 To erase an entity: 

1. Click on Erase in the Edit menu. The Erase menu is displayed in the 
Menu Window. 

2. Toggle LyrSrch on if the entities you want to erase are on a layer other 
than the active layer. 

3. Click on a selection method in the menu. ou are prompted to select the 

4.  Select the entities; they are erased from the drawing. You can continue 
selecting entities to erase them. 

Avoid selecting an entity where it crosses another entity because it may be 

LineFact. The LineFact setting affe
enlarged. A setting matching those of the X, Y, and Z enlargement factors 
will maintain the linetype’s spacing. The LineFact setting cannot b
applied to the geometry of referenced files. 

• To set all of these options to the same setting and enlarge the entity 
equally in all directions, click on SetAll. 

8. Right-click to return to the Enlarge menu. 

9. Toggle AndCopy on if you want to both enlarge and copy the selected 
entities. 

10. Click on a selection method in the menu. You are prompted to
entities you want to enlarge. 

11 Select the entities; they are enlarged in the drawing. You can continue 
selecting entities to enlar
center. 

To enlarge enti
enlargement factors, click on Invert and then select the enti
enlarged. Invert mathematically inverts all of the curren
factors and displayed the new factors in the Message A
if your enlargement factor is 2.0, clicking on Invert sets it to 0.5. 

To enter a new cent
step 2 above. 

ng Entities 

Y
entities you want to erase. 

difficult for DataCAD to know which entity you want to select. Zoom in on your 
drawing or change your view to select entities more precisely. 
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5. Right-click when you’re finished erasing entities to exit the Erase me

erase a selected piece of an entity: 

Click on Erase in the Edit menu. The Erase menu is displayed in the 
Menu Window. 

Click on Partial in the Erase menu. The Partial menu i

nu. 

 To 

1. 

2. s displayed. 

Cli dicate its selection, and 

Toggle LyrSrch on if the entities you want to erase are on a layer other than 
the active layer. You are prompted to “Select entity to modify.” 

ck on the entity. It is displayed in dashed lines to in
you are prompted to “Select first point of line segment to remove.” 

You cannot partially erase an ellipse, B-spline or Bezier curve, polyline, or 
contour. 

5. Object snap or click on one point of the segment you want to remove. You
are prompted to “Select second point of line segment to remove.” 

Object snap or click on the other end point of the segment yo

 

6. u want to 

at 
ou 

7. 
ircle, or click outside the two points you selected to remove the 

8.  

Ed
You can
making  efficient and productive. Simple linking 
groups selected entities 
gro ps

Linking Entities 
You
selection sets into a single gr poses. 

Caution

remove. When erasing the end of an entity, select the second point 
slightly beyond the end of the segment to avoid leaving a single point 
the end of the line. If you’re erasing part of a line, the line segment y
selected is removed; skip to step 8. If you’re erasing part of a curve or 
circle, you are prompted to “Select point on arc to clip out.” 

Click between the two points you selected to remove that segment of the 
curve or c
rest of the curve or circle. 

Repeat steps 4 – 7 as necessary to continue erasing entities. When you’re
finished erasing entities, right-click to exit the Erase menu. 

iting Multiple Entities 
 associate entities in DataCAD to simplify editing groups of entities, 
 your drawing process more

together, while selection sets associate entities and 
u  based on their attributes. 

 can combine entities, groups, areas of your drawing, or even multiple 
oup for editing pur

: When you link entities, DataCAD moves all entities in the group to the same 
layer. By definition, all entities in a group must be on the same layer. 

 To 

 

 

link entities: 

1. Click on LinkEnts in the Edit menu in the Menu Window, or click on Link
Entities in the Tools pull-down menu. The LinkEnts menu is displayed in 
the Menu Window. 

2. Toggle LyrSrch on if the entities you want to link are on different layers. 
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3. Click on a selection method in the menu. You are prompted to select the 
entities you want to link. 

Click on the entities you want to link; they are displayed in dashed lines 
as you select them. 

Right-click when you’re finished selecting entities. This links the selected
entities.  

4. 

5.  

 

1. Window, or click on Link 

 link are on different layers.  

4. 
t to unlink. 

 removes the 
selected entities from the group. 

7. t-click again to exit the LinkEnts menu. 

Wo i
Selection sets
certain tion sets available in 
Dat A

Unlike 
selectio
identify
set, and
selectio
copying entities, for instance, you can specify a selection set to edit. 

 To d

1. indow, or click on 

2. ction sets available in 

3. 
tities in that selection 

set, nothing in your drawing will be displayed in dashed lines. 

6. Click on Exit or right-click again to exit the LinkEnts menu. 

To unlink entities: 

Click on LinkEnts in the Edit menu in the Menu 
Entities in the Tools pull-down menu. The LinkEnts menu is displayed in 
the Menu Window. 

2. Toggle LyrSrch on if the entities you want to

3. Toggle Unlink on in the LinkEnts menu. 

Click on a selection method in the menu. You are prompted to select the 
entities you wan

5. Click on the entities you want to unlink; they are displayed in dashed 
lines as you select them. 

6. Right-click when you’re finished selecting entities. This

Click on Exit or righ

rk ng with Selection Sets 
 are temporary storage containers, used to quickly identify and edit 

 entities in your drawing. There are eight selec
aC D.  

linking entities, selection sets do not regroup entities; in fact, entities in a 
n set will maintain their association with their group. Instead, you can 
 entities by particular attributes, associate those entities with a selection 
 then select all of those entities at once by using the SelSet option in the 
n menus. Instead of using the usual selection methods when moving or 

isplay the entities in a selection set: 

Click on EditSets in the Edit menu in the Menu W
Selection Sets in the Tools pull-down menu. The EditSets menu is 
displayed in the Menu Window. 

Click on Show in the EditSets menu. All eight sele
DataCAD are displayed in the Menu Window. 

Click on the selection set you want to view. All entities in that selection 
set are displayed in dashed lines; if there are no en
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 a

1. 

 the Menu Window. 

yed in the Menu Window. You can add entities to a 
 

3. 
 dashed lines, and the AddTo menu is 

o 

To dd entities to a selection set: 

Click on EditSets in the Edit menu in the Menu Window, or click on 
Selection Sets in the Tools pull-down menu. The EditSets menu is 
displayed in

2. Click on AddTo in the EditSets menu. All eight selection sets available in 
DataCAD are displa
selection set automatically. See “Automatically Adding to Selection Sets”
later in this chapter for more information. 

Click on the selection set you want to add entities to. All entities already 
in that selection set are displayed in
displayed in the Menu Window. 

If you need to delete an entity from a selection set, click on DelFrom in the AddT
menu to quickly access the DelFrom menu. 

4. n Mask. Four entity attribute types are displayed in the Menu 

s. These settings apply not only to the 

Besides using Mask, you can add entities to a selection set by simply clicking on 

Click o
Window: Entity, Color, LineType, and Weight. These attribute type 
settings are set to All by default, as noted in the Message Area. You can 
change any or all of these setting
AddTo menu but also to the DelFrom menu. 

them; they are displayed in dashed lines as you select them. 

• To include only certain types of entities in the selection set, click on Entity. 
lick on every entity type that you 

o A 
colo  
add  selecting. 

• 

• nly certain entity line weights in the selection set, click on 
We
we

Right-click to r

6. Tog e 
on 

7. Clic o select 
the
simply enclose the 

mo n 
“Th

Sel s 
ma

A list of entity types is displayed. C
want to add to the selection set. Right-click when you’re finished 
selecting. 

• T include only certain entity colors in the selection set, click on Color. 
r menu is displayed. Click on every color for entities that you want to
 to the selection set. Right-click when you’re finished

To include only certain linetypes in the selection set, click on LineType. A 
list of linetypes is displayed. Click on the linetype that you want to add to 
the selection set. 

To include o
ight. A value menu is displayed. Use the value menu to enter the line 
ight of entities you want to add to the selection set, and press (Enter). 

5. eturn to the AddTo menu. 

gle LyrSrch on if the entities you want to add to the selection set ar
different layers. 

k on Area or Fence in the selection menu. You are prompted t
 entities you want to add to the selection set. It may be beneficial to 

entire drawing in the area or fence box, so that every 
entity that matches attribute settings is added to the selection set. For 

re information on how to use Area or Fence, see “Selection Menus” i
e Drawing Board” chapter. 

8. ect the entities you want to add to the selection set. All selected entitie
tching the mask settings are displayed in dashed lines. 



|  CHAPTER 12: EDITING DRAWINGS  298

9. ht-click to exit the AddTo menu and retuRig rn to the EditSets menu. 

 To dele

1. Clic
Selection Sets in the T
disp

t selection sets available 
in DataCAD are displayed in the Menu Window. 

3. Click on the selection set you want to delete entities from. All entities in 
that selection set are displayed in dashed lines, and the DelFrom menu is 
displayed in the Menu Window. 

If you need to add an entity to a selection set, click on AddTo in the DelFrom 

te entities from a selection set: 

k on EditSets in the Edit menu in the Menu Window, or click on 
ools pull-down menu. The EditSets menu is 

layed in the Menu Window. 

2. Click on DelFrom in the EditSets menu. All eigh

menu to quickly access the AddTo menu. 

4. Click on Mask. Four entity attribute types are displayed in the Menu 
Window: Entity, Color, LineType, and Weight. These attribute type 
settings are set to All by default, as noted in the Message Area. You can 
change any or all of these settings. These settings apply not only to the 
DelFrom menu but also to the AddTo menu. 

Besides using Mask, you can also delete entities from a selection set by simply 
clicking on them; they are displayed in their assigned linetype as you select 
them. 

• To choose the type of entity you want to delete from the selection set, 
click on Entity. A list of entity types is displayed. Click on every entity 
type that you want to delete from the selection set. Right-click when 
you’re finished selecting. 

• To choose the color of entities you want to delete from the selection set, 
click on Color. A color menu is displayed. Click on every color for entities 
that you want to delete from the selection set, or click on Match and then 
click on entities of the color you want to delete. Right-click when you’re 
finished selecting. 

• To choose the linetype of entities you want to delete from the selection 
set, click on LineType. A list of linetypes is displayed. Click on the 
linetype that you want to delete from the selection set. 

• To choose the line weight of entities you want to delete from the selection 
set, click on Weight. A value menu is displayed. Use the value menu to 
enter the line weight of entities you want to delete from the selection set, 
and press (Enter). 

5. Right-click to return to the DelFrom menu. 

6. Toggle LyrSrch on if the entities you want to delete from the selection set 
are on different layers. 

7. Click on Area or Fence in the selection menu. You are prompted to select 
the entities you want to delete from the selection set. For more 
information on how to use Area or Fence, see “Selection Menus” in “The 
Drawing Board” chapter. 
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8. Select the entities you want to delete from the selection set. All selected 
entities matching the mask settings are displayed in their normal 
linetype; entities still in the selection set remain displayed in dashed lines. 

9. Right-click to return to the EditSets menu. 

To edit a selection set, the set must be active. See “Automatically Adding to 
Selection Sets” above for details on how to activate a selection set. 

More About Selection Sets 

Selection sets let you select entities in your drawing based on particular 
attributes of those entities. Say, for instance, you want to change all yellow text in 
your drawing to green. The complexity of your drawing combined with a lot of 
yellow text would make it time-consuming and even difficult to use the standard 
selection methods to identify the entities in your drawing that you want to 
change to green. However, masking by Entity (text) and Color (yellow) and then 
using the Area selection method to select the entire drawing quickly adds all 
yellow text to the selection set. To change the color of the yellow text to green, 
simply select Green from the color menu in the Change menu, and then click on 
SelSet; the text color is changed. 

Clearing Selection Sets 

Because there are only eight selection sets available, you may on occasion need to 
reuse one that you’ve already defined. Before you can redefine a selection set, 
you must first delete its current contents. 

 To clear a selection set: 

1. Click on EditSets in the Edit menu in the Menu Window, or click on 
Selection Sets in the Tools pull-down menu. The EditSets menu is 
displayed in the Menu Window. 

2. Click on Clear in the EditSets menu. All eight selection sets available in 
DataCAD are displayed in the Menu Window, and you are prompted to 
“Select selection set to clear.” 

3. Click on the selection set you want to clear. You are prompted to verify 
whether you want to clear that selection set. 

4. Click Yes to clear the selection set; the selection set is cleared. Click No to 
cancel the clear function. 

Naming Selection Sets 

You can name your selection sets to help you better identify them. 

Shortcut: To activate a selection set, press (Alt) + a number 1 through 8, which 
corresponds to the number of the selection set. For instance, press (Alt) + (1) to make 
SelSet1 active; press (Alt) + (1) again to deactivate selection set 1. 

 To name a selection set: 

1. Click on EditSets in the Edit menu in the Menu Window, or click on 
Selection Sets in the Tools pull-down menu. The EditSets menu is 
displayed in the Menu Window. 



|  CHAPTER 12: EDITING DRAWINGS  300

2. Click on NameSet in the EditSets menu. All eight selection sets available 
in DataCAD are displayed in the Menu Window, and you are prompted 
to “Select selection set to rename.” 

3. Click on the selection set you want to name. You are prompted to “Enter 
new name.” 

4. Type a name for the selection set and press (Enter). The selection set is 
named.  

5. Repeat steps 3 – 4 to continue naming sets. Right-click when finished to 
return to the EditSets menu. 

Automatically Adding to Selection Sets 

Another way to add entities to a selection set is to append them as you draw 
them. Simply set the active selection set and then toggle Append on in the 
EditSets menu. 

 To automatically add entities to a selection set: 

1. Click on EditSets in the Edit menu in the Menu Window, or click on 
Selection Sets in the Tools pull-down menu. The EditSets menu is 
displayed in the Menu Window. 

2. Click on SetActiv in the EditSets menu. All eight selection sets available in 
DataCAD are displayed in the Menu Window, and you are prompted to 
“Select selection set to set active.” 

3. Click on the selection set you want to activate. A dollar sign ($) is 
displayed before the selection set’s name in the menu window, and the 
active selection set name is displayed in the Status Area.  

4. Right-click to return to the EditSets menu. 

5. Toggle Append on in the EditSets menu. Any entities you draw will now 
be automatically added to the active selection set. 

Clipping and Cropping 
The ClipIt macro can be used to erase, move, or copy 2D and 3D lines, 2D arcs, or 
2D circles. ClipIt is especially useful for editing hatched areas in elevation 
drawings or for copying large portions of your drawing. Entities that are clipped 
or cropped retain such attributes as linetype and line color. Circles, 2D arcs, and 
2D lines all retain their Z-base and Z-height settings. The Z values for the new 
end points for 3D lines are recalculated based on the slope of the line. 

ClipIt only works in orthographic (plan) view. So if you are using a perspective 
view, DataCAD will automatically switch to plan view for ClipIt functions and 
then switch back to perspective view when you exit ClipIt. 

Caution: Make sure you leave the ClipIt macro by clicking the Exit button in the menu 
window. This macro creates a temporary file that it uses as an undo buffer. If you exit the 
ClipIt macro by right-clicking, this temporary undo buffer is not deleted. That can lead to 
file corruption in future drawing sessions. When you click on the Exit button to leave the 
ClipIt macro, you delete the temporary undo buffer. 
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You can choose whether to clip or crop the selected portion of your drawing. 
Clipping selects entities inside the selection boundary, while cropping selects 
entities outside the selection boundary.  

 
Figure 12.17: Clipping vs. cropping 

You can also choose to erase the selection from your drawing, move the selection 
to another place in your drawing, or copy the selection to another place in your 
drawing. 

 
Figure 12.18: Different results from cutting, cutting and copying, and copying 

 To clip or crop entities in your drawing: 

1. Click on ClipIt in the Macros pull-down menu. The ClipIt menu is 
displayed in the Menu Window. If ClipIt is not listed in your Macros 
menu, click on Configure in the Macros menu and add ClipIt to the 
Macros in Menu list. 

2. The ClipIt boundary separates a selected area from the rest of your 
drawing, allowing you to select entities either inside or outside of it. 
Toggle one of four boundary types on: 

• Area lets you draw a rectangular boundary by selecting two diagonal 
corners of the rectangle. 

• Fence lets you draw a polygonal boundary with up to 36 sides that can be 
concave or convex as long as its lines don’t cross. If you select less than 36 
points for the boundary, right-click to finish the polygon. 
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• RadCirc lets you draw a circle by defining its radius (select its center 
point and a point on the circle). 

• DiaCirc lets you draw a circle by defining its diameter (select two points 
opposite each other on the circle). 

Generally, ClipIt processes entities most quickly when the boundary is a 
rectangle or a simple polygon with only three or four sides. A circular boundary 
will process more slowly, and a more complex polygon will have the slowest 
processing time. 

3. Click on Cut to erase entities, click on CutCopy to move entities, or click 
on Copy to copy entities. You can clip or crop entities from multiple 
layers, but you can only copy entities to the active layer. 

4. Click on Clip to select entities inside the boundary you will draw or click 
on Crop to select entities outside the boundary. 

5. Click on 2D Line, 3D Line, 2D Arc, or Circle to specify the type of entity 
you want to select. You can select one or any combination of these four 
entity types. 

6. Toggle Boundary on to leave the outline of the boundary in your 
drawing. (See the “After Clipping” examples for Cut and CutCopy in 
Figure 12.18 for an example of a boundary outline.) 

7. Toggle LyrSrch on to clip or crop entities on all layers that are toggled on; 
toggle LyrSrch off to clip or crop entities on only the active layer. 

To decrease processing time, click on Layers in the ClipIt menu and toggle off all 
the layers that don’t have entities that you want to clip or crop. This Layers option 
accesses the Layers menu in DataCAD without exiting ClipIt. 

8. Select points as prompted to draw the boundary. After you select the last 
point for the boundary: 

• If you toggled Cut on, selected entities are clipped or cropped. Skip to 
step 11. 

• If you toggled CutCopy or Copy on, you are prompted to “Enter point to 
drag from.”  

9. Click in the Drawing Area to enter the point where your cursor will 
attach to the copy. You are prompted to “Enter point of insertion on [the 
active layer].”  

10. Place the copy in your drawing. To do this, move your mouse and click in 
the Drawing Area, use coordinate entry, or object snap to an existing 
entity. Repeat this step to continue placing copies. 

11. Repeat steps 2 – 10 to continue clipping or cropping, or click on Exit to 
close the ClipIt macro. 

If your drawing is very complex, the percentage of entities clipped/cropped (not 
the percentage of processing time) is displayed in the Message Area. When 
processing is complete, the total time is also displayed. 
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You can change the layer to copy to – without changing the active layer setting – by 
clicking on ToLayer in the ClipIt menu and selecting the layer you want to copy 
to. To create new layers to copy to, use the Layers option in the ClipIt menu to 
quickly access the Layers menu without exiting ClipIt. 
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Text, Notes, and Labels 
You can add notes, labels, and other text to your drawing using 
DataCAD’s Text tool. You can control text appearance and justification 
and even save these settings as a text style that you can use in any 
drawing. To place text in your drawing, simply click in the Drawing 
Area to select a justification point or define an area to fit the text into. 
With either method, you can position notes quickly and precisely. 

Text can be imported into your drawing or even exported from it. 
DataCAD uses text (.TXT) files in each of these processes. 

You can use Windows TrueType fonts to enter text in your drawings. 

You can also add room, door and window labels using some of 
DataCAD’s macros. Descriptive attributes can even be assigned 
to door and window labels and later applied to schedules and 
reports. 

13 
In this chapter: 

 Drawing text and arrows 

 Editing text 

 Importing and exporting 
text 

 Using TrueType fonts 

 Drawing room labels 

 Drawing door and 
window labels 
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Drawing Text 
Text can be entered and edited anywhere in your plan. DataCAD has 23 text 
fonts you can use, and you can add your own fonts to your DATACAD\CHR 
folder. You can also use any true-type fonts (TTF) that you have installed on your 
computer. 

When the Text menu is displayed, the text cursor replaces the standard drawing 
crosshairs. This cursor appearance represents the current text height, angle, slant, 
and aspect ratio settings. To change the appearance of text already in your 
drawing, you must select Change\Text\FontName to open the Set Text 
Parameters dialog box. This lets you change text parameters. See “Changing Text 
Attributes” in the “Editing Drawings” chapter. 

 To add text to your drawing: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Customize the appearance of text by clicking on each setting option in the 
Text menu or clicking on FontName to change all the settings at once: 

• Click on a font in the Font Name list box. Keep in mind that the fonts 
displayed under Font Name are determined by the Font Type selection in 
the lower-left corner of the dialog box. You can display true-type fonts 
(TTF), DataCAD fonts (CHR), or both in the list. You are limited to using 
32 fonts in a drawing session. 

• To set the text’s actual size in your drawing, type a height value or click 
on one in the Height list box. With TxtScale toggled on, text is entered in 
the drawing relative to the current plot scale setting.  For example, if you 
set Height to 1” and the plotting scale to ¼”, text entered in your drawing 
would appear 4’ high. 

• To set the angle of the lines of text, type an angle value or click on one in 
the Angle list box. 

• The aspect ratio of text is the height relative to the width of each character. 
An aspect ratio of 1 represents the normal character style, while an aspect 
ratio of 5 produces text that is taller and narrower. To set the height of 
each character relative to its width, type an aspect ratio value or click on 
one in the Aspect list box. 

• When using a DataCAD font, you can set the angle of each character of 
text, as measured from the base of the character to its top. Type a slant 
value or click on one in the CHR Slant list box. 
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• When using a DataCAD font, you can set a text weight from 1 to 99, with 
“1” being the default weight setting. To triple the weight of text, for 
instance, set Weight to 3. To set the line weight of the text, type a weight 
value or click on one in the CHR Weight list box. Another way to produce 
heavy text on a drawing is to place it on a separate layer and then define 
a unique color for that layer. When you plot the drawing, you can assign 
a thicker pen to that layer. See “Using Pen Tables” in the “Printing Your 
Drawing” chapter for details on how to set pens for plotting. 

• When using a true-type font, you can select a font style. Click on a style in 
the TTF Style list box. 

• When using a true-type font, you can set the properties for the font using 
the TTF Properties options. Select Fill, Outline, or Both and then set the 
colors for the Fill and Outline, as necessary. 

3. Click on OK to save the text parameter changes and close the dialog box. 

4. Set the space between lines of text by clicking on Factor. Use the value 
menu or type a factor for your text, and right-click to return to the Text 
menu. DataCAD calculates the amount of space between lines of text by 
multiplying the text height by the factor. 

5. Toggle Dynamic on to enter text directly into the drawing as you type it. 
Toggle Dynamic off to enter the text only in the Message Area; you will 
have to press (Enter) to add the text to the drawing. 

Hint: With Dynamic on, your cursor must remain in the drawing window if you 
want carriage return to work when you press (Enter). 

6. Toggle TxtScale on to size your text by using the Size setting relative to 
the plot scale. If you toggle TxtScale off, the text size displays and plots, 
according to the Height setting in the text parameters dialog box. 

7. Toggle AllCaps on to enter your text in capital letters; toggle AllCaps off 
to enter text as you typed it. 

8. Decide on how you want to justify the text. To left justify text, toggle Left 
on; to center justify text, toggle Center on; to right justify text, toggle 
Right on. 

9. Click in the Drawing Area or use coordinate entry to select the point 
where text should be entered in your drawing. This point is the point of 
justification for the text you enter. 

10. Type the text. If you toggled Dynamic on in step 5, the text is displayed in 
the drawing as you type; if Dynamic is toggled off, the text is displayed in 
the Message Area and you must press (Enter) to add the text to the 
drawing. 

Text can include many other characters in addition to those found on the 
keyboard. These extended characters are typed by pressing (Alt) + a character 
number. See the Appendix for a complete list of extended characters. 

11. Click on Exit in the Menu Window or right-click when you’re finished 
entering text. 
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Justifying Text 
You can change the justification of text after you enter it in your drawing. Text 
can be justified to the left, center, or right of a justification line that you define. 

 To justify text in your drawing: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on Justify in the Text menu. You are prompted to “Select first point 
on justification line”. 

3. Click in the Drawing Area or use coordinate entry to enter the first point 
of the justification line. You are prompted to “Select second point on 
justification line”. 

4. Click in the Drawing Area or use coordinate entry to enter the second 
point of the justification line. The Justify menu is displayed in the Menu 
Window. 

5. Decide how you want to justify the text. To left justify text, toggle Left on; 
to center justify text, toggle Center on; to right justify text, toggle Right 
on. 

6. Click on a selection method in the menu. You are prompted to select the 
text you want to justify. For more information on using selection menus, 
see “Selection Menus” in “The Drawing Board” chapter. 

7. Select the text you want to justify. The text is aligned with the justification 
line, according to the justification setting you chose in step 5. 

8. Continue selecting text to justify it to the same justification line; click on 
NewLine to define a new justification line and continue with step 3 
above; or right-click to return to the Text menu. 

Fitting Text into Defined Areas 
Another way to enter text in your drawing is to define the height and width of 
the area where you’d like to place a line of text. The text size and aspect ratio are 
automatically calculated so that the text you type fits into the area you defined. 

 To fit text into an area: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on FitText in the Text menu. You are prompted to “Select text start 
point”. 

3. Click in the Drawing Area or use coordinate entry to enter the point 
where you want the text to begin. You are prompted to “Select text end 
point”. 

4. Click in the Drawing Area or use coordinate entry to enter the point 
where you want the text to end. You are prompted to “Select point to 
mark text height”. 
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5. Click in the Drawing Area or use coordinate entry to enter a point; this 
point and the end point you selected in step 4 define the height of the 
area. You are prompted to “Enter text”. 

6. Type the line of text that you want to fit in the defined area. 

7. Press (Enter). The aspect ratio and size is calculated, and the text you typed 
is fit into the area you defined. The Aspect and Size settings in the Text 
menu are actually changed to the values calculated in step 7. To return 
them to their original settings before FitText was used, click on Reset in 
the Text menu. 

8. Enter additional lines of text using the same aspect ratio and size 
calculated in step 7 by simply typing the additional text. 

9. Right-click to return to the Text menu. 

Importing and Exporting Text 
You can export text in your drawing to a text (.TXT) file as well as import a text 
file into your drawing. 

 To import text into your drawing: 

1. Click on Text File in the Insert pull-down menu. A dialog box is 
displayed, listing all text files in your DATACAD\PLT folder. 

2. Click on the text (.TXT) file you want to import to select it, and then click 
on Open. The dialog box closes, and the FromFile menu is displayed in 
the Menu Window. 

3. Use the menu options (as described earlier in this chapter in the 
instructions on adding text to your drawing) to customize the appearance 
of the text you want to import. You are prompted to “Position text using 
cursor”. 

4. Click in the Drawing Area or use coordinate entry to enter the upper-left 
point of the block of text being imported. The text is added to the 
drawing. 

WrapLen option uses a value menu to set the number of characters allowed per 
line; characters over this number are wrapped to the next line. 

5. Continue selecting points to copy the imported text to other parts of your 
drawing, or right-click to return to the Text menu. 

 To export text from your drawing: 

1. Click on Export in the File pull-down menu, and then click on TXT in the 
submenu. A dialog box is displayed, prompting you to “Enter the name 
of the text file to create”. 

2. Type a name for the text file that your text will be exported to, and then 
click on Save. The dialog box closes, and a selection menu is displayed in 
the Menu Window. 

3. Click on a selection method in the menu. You are prompted to select the 
text you want to add to the text file. For more information on using 
selection menus, see “Selection Menus” in “The Drawing Board” chapter. 
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4. Select the text you want to export. The text is exported to the text file you 
created in step 2. 

5. Continue selecting text to export to the text file, or right-click to display 
the dialog box again and save another text file. If you don’t need to save 
another text file, click Cancel to close the dialog box and display the Text 
menu in the Menu Window. 

Using Text Styles 
You can save your Text menu settings as a text style, and then use them to 
quickly apply those settings before adding text to a drawing.  

 To save a text style: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on TxtStyl in the Text menu. The TxtStyl menu is displayed in the 
Menu Window. 

3. Click on SaveCurr in the TxtStyl menu. A list of existing text styles is 
displayed in the Menu Window, including the default style. You are 
prompted to “Enter name to save current text style to”. 

4. Type a name for your new text style and press (Enter). The text style is 
saved, and you are returned to the TxtStyl menu.  

 To use a text style: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on TxtStyl in the Text menu. The TxtStyl menu is displayed in the 
Menu Window. 

3. Click on Load in the TxtStyl menu. A list of text styles is displayed in the 
Menu Window, and you are prompted to “Enter name of text style to 
load”. 

4. Click on a text style in the list. Settings for Text menu options are changed 
to those of the text style you chose; any text you draw now will use those 
settings. 

 To delete a text style: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on TxtStyl in the Text menu. The TxtStyl menu is displayed in the 
Menu Window. 

3. Click on Delete in the TxtStyl menu. A list of existing text styles is 
displayed in the Menu Window, and you are prompted to “Enter name of 
text style to delete”. 
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4. Click on the name of the text style you want to delete. The text style is 
deleted. 

5. Return to the TxtStyl menu by either clicking on Exit in the Menu 
Window or right-clicking. 

 To display the settings for a text style: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on TxtStyl in the Text menu. The TxtStyl menu is displayed in the 
Menu Window. 

3. Click on ShowVals in the TxtStyl menu. A list of text styles is displayed in 
the Menu Window, and you are prompted to “Enter name of text style to 
show”. 

4. Click on the name of the text style you want to view. The values of the 
selected text style are displayed in the Message Area. 

5. Return to the TxtStyl menu by clicking on Exit or right-clicking. 

Drawing Text Arrows 
You can draw arrows from text in your drawing to the parts of the drawing the 
text refers to. The size, style, aspect, weight, and color of the arrowheads are fully 
customizable. 

OPEN 4:1

CLOSED 3:1

BRIDGE 2:1

DOT 1:1

TICK

Arrowhead styles

0.5:1

Variable aspect ratios  
Figure 13.1: Examples of different styles and aspect ratios for text arrowheads 

 To draw a text arrow: 

1. Click on Text in the Create pull-down menu, or click on Text in the Edit 
menu in the Menu Window. The Text menu is displayed in the Menu 
Window. 

2. Click on Arrows in the Text menu. The Arrows menu is displayed in the 
Menu Window. 

3. Choose an arrowhead style.  Click on Style in the Arrows menu. A list of 
five arrowhead styles is displayed. (See Figure 13.2 for examples.) 
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4. Click on the name of the arrowhead style you want to use, and right-click 
to return to the Arrows menu. For Open and Closed arrowheads, Size sets 
the length of the arrowhead base. For Bridge arrowheads, Size sets the 
radius of the curve of the arrowhead. For Dot arrowheads, Size sets the 
diameter of the dot. For Tick arrowheads, Size sets the length of the tick 
mark. 

5. Indicate the size of the arrowhead. The size of the arrowhead is the 
measurement of its widest point. Arrowhead size is relative to text size; if 
the Size setting in the Text menu is 1 and the Size setting in the Arrows 
menu is 3, the arrowhead size will be three times the height of your text. 
To set the size of the arrowhead, click on Size. A value menu is displayed. 

6. Use the value menu or type a number for the size, and press (Enter). This 
setting, “Relative arrow size”, is displayed in the Message Area whenever 
you are in the Arrows menu. 

7. Set the aspect ratio for arrowheads by clicking on Aspect in the Arrows 
menu. A value menu is displayed.  

8. Use the value menu or type a number for the aspect ratio, and press 
(Enter). (See Figure 13.2 for examples of aspect settings.) An ANSI-
standard arrowhead has an aspect ratio of 6. 

9. Set the line weight for arrowheads by clicking on Weight. A value menu is 
displayed. 

10. Use the value menu or type a number for the line weight, and press 
(Enter). 

11. To set the color for arrowheads, click on Color. A color menu is displayed. 
For more information on using color menus, see “Color Menus” in “The 
Drawing Board” chapter. 

12. Use the color menu to select a color for arrowheads. You are prompted to 
“Draw arrow”. 

13. Draw arrows. Arrows are drawn from the end of the arrow to the point of 
the arrowhead. Click in the Drawing Area or use coordinate entry to enter 
the end of the arrow. 

14. Continue entering points to draw bends or angles in the arrow if 
necessary. The last point you enter will be the point of the arrowhead. 

15. Right-click to complete the arrow; the arrowhead is drawn, according to 
the settings specified in the steps above. 

Using TrueType Fonts Instead of .CHR Fonts 
In addition to single and multi-stroke, vector-based DataCAD .CHR fonts, you 
can use Windows TrueType fonts in your drawings. You can convert TrueType 
fonts to 3D for signage in architectural models. If you are using an earlier version 
than DataCAD 10, TrueType fonts will appear in your drawing as DataCAD CHR 
fonts. 
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 To use TrueType fonts: 

1. Select Text from the Edit menu. Then, click on FontName in the Text 
menu. The Set Text Parameters dialog box appears. 

 
Figure 13.2: Control the appearance of TrueType fonts 

2. Type something in the small box at the lower right corner of the Font 
Preview area. For example, in Figure 13.3, HapPenInc is the name of the 
Hap company that manufactures pens. The larger display shows what the 
text will look like, depending on the font you highlight in the FontName 
section of this dialog box. 

3. Go to the Font Type section and click Only TTF if you want to display just 
the TrueType fonts in the Font Name section of this dialog box. 

4. Change the settings in the Font Name, Height, Angle, Aspect, CHR Slant, 
CHR Weight, and TTF Style sections until the sample in the Font Preview 
window is correct. 

5. Control the color of the font’s fill and outline in the TTF Properties 
section. Color choices are displayed in the Font Preview window.  

• To choose colors, click Fill, Outline, or Both in the TTF Properties section. 

• To use the active layer’s color for the fill and/or outline, check the Fill 
using current color and/or the Outline using current color boxes. 

• To specify your own colors for the fill and/or outline, uncheck the boxes. 
Then click on the color swatch to the left of the unchecked box to display 
the Color Palette dialog box, where you can either select a standard color 
or mix your own. For more information on using the color palette, see 
“Color Menus” in “The Drawing Board” chapter and “Customizing 
Colors” in the “Before You Draw” chapter. 



|  CHAPTER 13: TEXT, NOTES, AND LABELS  314

6. Click OK when you are satisfied with your text parameters. When you 
return to the Drawing Window, the cursor changes to a text tool and you 
are prompted to “Select point to position text.” 

7. Click where you want the text to appear in your drawing. 

8. Type the text in your drawing. Notice that all your font settings are in 
effect. 

9. Right-click when you are finished typing text. 

 
Figure 13.3: Results of TrueType font decisions in the drawing 

 To convert TrueType fonts to 3D: 

1. Go to the 3DEdit menu and select Explode. 

2. Click on TTF2Plin in the Explode menu to convert the TrueType fonts to 
covered polylines. 

You can now create 3D signage by exploding the polylines to slabs. To do this, 
use the ToSlab option in the Explode menu. 

Drawing Labels 
In addition to drawing standard text, you can add labels to rooms, doors, and 
windows using some of DataCAD’s macros. Descriptive attributes can even be 
assigned to door and window labels. 

Drawing Room Labels 
You can customize the appearance of both the text and the border of the label. 
Room labels can have only one line of text per label. 

 To draw a room label: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD AEC 
menu is displayed in the Menu Window. 

2. Click on RmLabels in the DCAD AEC menu. The RoomLabl menu is 
displayed. 
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3. Indicate which of the three types of borders you want to use for the label. 
Click on Box to draw a rectangle around the text; click on Capsule to 
draw a rectangle with rounded corners around the text; click on None to 
draw labels with no border at all. Of the Box, Capsule, and None options, 
only one can be toggled on at any one time. 

4. Customize the appearance of label text with several options that use 
value menus: 

• To set the label text’s size, click on TextSize. Use the value menu or type a 
size for your label text, and right-click to return to the RoomLabl menu. If 
TxtScale is on in the Text menu, label text size will be determined relative 
to the current plotting scale. 

• To set the angle of the lines of label text, click on TextAngl. Use the value 
menu or type an angle for your label text, and right-click to return to the 
RoomLabl menu. 

• To set the line weight of the label text, click on TextWgt. Use the value 
menu or type a size for your text, and right-click to return to the 
RoomLabl menu. 

• To set the angle of each character of label text, as measured from the base 
of the character to its top, click on TextSlnt. Use the value menu or type an 
angle for text characters, and right-click to return to the RoomLabl menu. 

• To set the height of each character relative to its width, click on TextAspt. 
Use the value menu or type an aspect ratio for your text, and right-click to 
return to the RoomLabl menu. The aspect ratio of text is the height relative 
to the width of each character. An aspect ratio of 1 represents the normal 
character style, while an aspect ratio of 5 produces text that is taller and 
narrower. 

5. Choose a font to use for label text by clicking on TextFont. A dialog box is 
displayed, listing all the fonts available in your DATACAD\CHR folder. 
Click on a font to select it, and click on Open. 

6. Insert a symbol as part of your room labels by clicking on AddSymb. A 
dialog box is displayed. If necessary, change to your DATACAD\SYM 
folder, to list all your symbol folders. Open a symbol folder, select the 
symbol to be used with labels, and click on Open. The AddSymb option 
appears depressed, indicating that a symbol will be used with labels. To 
stop using a symbol in room labels, click on AddSymb again to turn that 
option off. The AddSymb option appears raised. 

7. Set the text color for room labels by clicking on TextColr. Use the color 
menu to choose a color. If necessary, right-click to return to the RoomLabl 
menu. For more information on using color menus, see “Color Menus” in 
“The Drawing Board” chapter. 

8. Set the border color for room labels by clicking on BrdrColr. Use the color 
menu to choose a color. If necessary, right-click to return to the RoomLabl 
menu. 

9. Place the room label by clicking in the Drawing Area or using coordinate 
entry to enter a point that will be the bottom left corner of the label. You 
are prompted to “Enter label text”. 
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10. Type the text for the room label and press (Enter). The label is added to 
your drawing. 

11. Repeat steps 9 – 10 to continue adding labels to your drawing, or right-
click to exit the RoomLabl menu. 

Drawing Door Labels 
You can add labels (or “tags”) for doors in your drawing.  

Drawing Window Labels 
You can add labels (or “tags”) for windows in your drawing.  



Dimensions 
Dimensions in DataCAD can measure the distance between 
two points, the diameter or radius of curves, or the angle 
between two entities. You have full control over how the 
dimension text, lines, and arrows look as well as where they are 
placed in your drawing.  

Stringline and baseline dimensions can be drawn by simply 
selecting a series of points; they can even be drawn 
automatically, with the distance between every end point along 
a wall measured and added to the series of dimensions. 

You can even draw associative dimensions. These dimensions 
are linked to the entity they measure; whenever that entity 
changes size, the dimension is automatically updated. 

14 
In this chapter: 

 Dimension text and line 
styles 

 Adding dimensions to 
your drawing 

 Editing dimensions 

 Associative 
dimensioning 
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Drawing Linear Dimensions 
Linear dimensions, the most common type of dimensions, measure the distance 
between two points. You can draw standard stringline or baseline linear 
dimensions, which require you to select the end points for each dimension, or 
you can automatically create a stringline or baseline dimension by simply 
selecting the two end points of the entire series of dimensions. In addition, you 
can edit dimensions or explode them into separate entities. 

 To dimension between two points in your drawing: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Linear Dimension in the submenu. The Linear menu is displayed in the 
Menu Window. 

2. Choose one of the following options to position dimensions: 

• To dimension a single line, arc, or circle, simply click on Entity and follow 
the prompts. 

Of the Horizntl, Vertical, Aligned, and Rotated options, only one can be toggled 
on at any time. 

• To draw horizontal linear dimensions, toggle Horizntl on. 

• To draw vertical linear dimensions, toggle Vertical on. 

• To draw linear dimensions that are parallel to the dimensioned entity, 
toggle Aligned on. 

• To set the angle to draw linear dimensions, click on Rotated and use the 
value menu to enter a rotation angle. For more information on using 
value menus, see “Value Menus” in “The Drawing Board” chapter. 

 
Figure 14.1: Examples of the four available positions for linear dimensions 
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3. Decide whether you want to use associative dimensions. Associative 
dimensions are connected to the entity they measure; so if you were to 
stretch that entity, its dimension would automatically be updated. Toggle 
Assoc on if you want to draw associative dimensions. Another advantage 
to using associative dimensions is that if you change drawing scales (from 
architectural to engineering, for example), all associative dimensions 
would automatically be updated with the new scale. 

4. Customize the way dimension text is drawn by clicking on TextStyl and 
setting the options as necessary. (See “Text Style Options for Linear 
Dimensions” on the following pages for details.) 

5. Customize the way dimension lines are drawn by clicking on DimStyl 
and setting the options as necessary. (See “Line Style Options for Linear 
Dimensions” on the following pages for details.) 

6. Customize the way dimension arrows are drawn by clicking on ArroStyl 
and setting the options as necessary. (See “Arrow Style Options for Linear 
Dimensions” on the following pages for details.) 

7. Respond to the prompt to “Select first point of distance to dimension”. 
For greater accuracy, object snap to one end point of the distance you 
want to dimension. You can also select this point by clicking in the 
Drawing Area or using coordinate entry. You are prompted to “Select 
second point of distance to dimension”. For more information on how to 
object snap to an entity, see “Object Snapping” in the “Drawing Tools” 
chapter. 

8. Object snap to the second end point of the distance you want to 
dimension. The dimension lines are displayed; notice if you move your 
mouse cursor to the other side of the entity you’re dimensioning, the 
dimension lines flip to that side. You are asked, “Dimension which side of 
line?” 

9. Click to one side of the line to place the dimension on that side. If the 
dimension text fits between the extension lines, the dimension is drawn; 
skip to step 12 to continue. 

 If the dimension text doesn’t fit between the extension lines, only the 
dimension lines are drawn, and you’re prompted with “Text does not fit. 
Enter new text position”. 

10. Place dimension text that doesn’t fit between the extension lines by using 
any of the following options: 

You can use any combination of the Rotate, DrwLeadr, and TextStyl options to 
customize dimension text. 

• Click on Rotate and use the value menu to set an angle for the text; click 
in the Drawing Area to place the text. 

• Click on DrwLeadr to draw a leader from the dimension line to the text. 
Click in the Drawing Area or use coordinate entry to draw the leader, and 
then right-click to place the dimension text. 

• Click on TextStyl to change the text style settings so that the text will fit 
between the extension lines; click in the Drawing Area to place the text. 
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11. Draw stringline dimensions from the dimension you just drew by clicking 
on StrngLin. To draw baseline dimensions, click on Baseline. Follow the 
prompts to draw the series of dimensions. Using StrngLin or Baseline to 
dimension along an entire wall of your plan can save you time because 
you only have to enter the second point of each dimension. Whether this 
series of dimensions is stringline or baseline depends on the settings in 
the AutoStyl menu. 

12. Finish drawing the dimension series. Then right-click to return to the 
Linear menu. 

13. Complete drawing stringline dimensions. Then click on Overall in the 
Linear menu to dimension the entire stringline. 

14. Continue with step 8 above to enter additional dimensions. 

 To automatically create a series of dimensions: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Linear Dimension in the submenu. The Linear menu is displayed in the 
Menu Window. 

2. Indicate which of these four options you want use to position dimensions: 

• To draw horizontal linear dimensions, toggle Horizntl on. 

• To draw vertical linear dimensions, toggle Vertical on. 

• To draw linear dimensions that are parallel to the dimensioned entity, 
toggle Aligned on. 

• To set the angle to draw linear dimensions, click on Rotated and use the 
value menu to enter a rotation angle. 

See Figure 14.2 for examples of these options. 

3. Decide whether you want to use associative dimensions. Associative 
dimensions are connected to the entity they measure; so if you were to 
stretch that entity, its dimension would automatically be updated. Toggle 
Assoc on if you want to draw associative dimensions. Associative dimen-
sions can be exploded, or changed to standard dimensions that aren’t 
connected to the entity. See “Exploding Dimensions” later in this chapter 
for more information. 

4. Customize the way dimension text is drawn by clicking on TextStyl and 
setting the options as necessary. (See “Text Style Options for Linear 
Dimensions” on the following pages for details.) 

5. Customize the way dimension lines are drawn by clicking on DimStyl 
and setting the options as necessary. (See “Line Style Options for Linear 
Dimensions” on the following pages for details.) 

6. Customize the way dimension arrows are drawn by clicking on ArroStyl 
and setting the options as necessary. (See “Arrow Style Options for Linear 
Dimensions” on the following pages for details.) 
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7. Customize the way automatic dimensions are drawn by clicking on 
AutoStyl and setting the options as necessary. (See “Automatic 
Dimension Style Options for Linear Dimensions” on the following pages 
for details.) 

8. Click on AutoDim. You are prompted to “Select first end point of line to 
dimension along”.  

9. Object snap to one end point of the distance you want to dimension for 
greater accuracy. You can also select this point by clicking in the Drawing 
Area or using coordinate entry. You are prompted to “Select second end 
point of line to dimension along”. 

10. Object snap to the second end point of the distance you want to 
dimension. The dimension lines are displayed; notice if you move your 
mouse cursor to the other side of the entity you’re dimensioning, the 
dimension lines flip to that side. You are asked, “Dimension which side of 
line?” 

11. Click to one side of the line to place the dimension on that side. The series 
of dimensions is drawn. 

12. Continue using automatic dimensioning by going back to step 9 above. 
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Stringline dimensions

Stringline with an overall dimension

Baseline dimensions  
Figure 14.2: Examples of stringline, stringline with overall, and baseline dimensions 

Text Style Options for Linear Dimensions 

Use the following options in the TextStyl menu to customize dimension text 
styles: 

TextSize Set the dimension text’s actual size in your drawing. The TextSize, Weight, Slant, 
Aspect, Color, TxtScale, and FontName options work exactly like equivalent options 
in the Text menu. See the “Text” chapter for more information.  

For more information on using value menus, see “Value Menus” in “The Drawing 
Board” chapter. The decimal separator for all dimensions and numbers is 
determined by the Decimal Symbol setting. In your Windows Start menu, click on 
Set-tings, click on Control Panel, click on Regional Settings, and click on the 
Number tab. 

Weight Set the line weight of dimension text, from 1 to 99 with “1” being the default weight 
setting; to triple the weight of text, for instance, set Weight to 3 

Slant Set the angle of each character of text, as measured from the base of the character to 
its top 

Aspect Set the height of each character relative to its width; an aspect ratio of 1 represents the 
normal character style, while an aspect ratio of 5 produces text that is taller and 
narrower 

TxtScale Toggle TxtScale on to size your text by using the Size setting relative to the plot scale; 
toggle TxtScale off to size your text size based only on the TextSize setting 
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InHorz Toggle on to place dimension text horizontally in your drawing (independent of the 
orientation of the dimension lines); the dimension line is “broken” to accommodate 
the text 

OutHorz Toggle on to place dimension text horizontally in your drawing (independent of the 
orientation of the dimension lines) and at the end of the leader; this option is only 
used with the DrwLeader option, which is available only if the text is too large to fit 
between the dimension’s extension lines  

Above Toggle on to draw the dimension text parallel to and "above" the dimension line; if 
InHorz is also toggled on, then the dimension text will be drawn horizontally but the 
dimension line will not be "broken" 

Offset Set the distance of text from the dimension line 
Auto Toggle on to automatically place text, according to the TextStyl menu settings; toggle 

off to place the text for each dimension manually, using Rotate, DrwLeadr, or TextStyl 
as described in the instructions for drawing dimensions earlier in this chapter; when 
Auto is off, right-clicking to place the dimension text will place the text as if Auto 
were toggled on 

Color Set the color of dimension text. For more information on using color menus, see 
“Color Menus” in “The Drawing Board” chapter. 

FontName Set the font used for dimension text (see Figure 14.3) 
 

 
Figure 14.3: Selecting a font, with a preview of the selection 

Line Style Options for Linear Dimensions 

Each dimension in a string-line shares its extension lines with the next dimension 
in the series, so you see only a single line displayed on screen. But when you plot 
your drawing, your plotter reads two lines – the second extension line for one 
dimension and the first extension line for the following dimension. If your 
plotter prints both these lines, extension lines in a string-line can appear to have 
a double thickness. To avoid this, toggle either Line 1 or Line 2 off when you 
draw stringline dimensions. 

Use the following options in the DimStyl menu to customize dimension line 
styles: 

Line 1 Toggle on to draw the first extension line 
Line 2 Toggle on to draw the second extension line 
Offset Set the distance between the entity being dimensioned and the beginning of the 

extension lines of the dimension (see Figure 14.4) 
Overlap Set the distance extension lines are drawn past dimension lines (see Figure 14.4) 
Incrment Set the distance between dimension lines when drawing baseline dimensions; this 

option has no effect on stringline dimensions unless set to 0, which results in a 
running dimension without the first arrow (see Figure 14.4) 
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Overrun Set the distance dimension lines are drawn past extension lines; a setting of 0 results 
in the dimension line ending at the extension lines (see Figure 14.4) 

FixdDist Toggle on to draw dimension lines a fixed distance away from the entity being 
dimensioned; toggle off to enter the distance yourself when you click to select which 
side of the entity to draw the dimension on (see Figure 14.4) 

DINStd Toggle on to use the DIN Standard, set by the German Institute for Standardization 
(see Figure 14.5) 

Rounding Set rounding for dimension text; toggle RoundIt on and choose from rounding up or 
down or banker’s rounding; click on Precsion to set the fractional rounding value for 
rounding up or down 

Limits Set the upper and lower limit for the size of entities to dimension (see Figure 14.6) 
Tolrance Set positive and negative geometric tolerances (see Figure 14.6) 

E

B

C

D

A

 
Figure 14.4: Dimension settings: A = Offset, B = Overrun, C = Overlap, D = Increment (with 
FixdDist toggled on), E = Text Offset 

 
Figure 14.5: DIN standard dimension 

 
Figure 14.6: Dimensions with Limit and Tolrance settings 

Arrow Style Options for Linear Dimensions 

Use the following options in the ArroStyl menu to customize dimension arrow 
styles: 

Of the three options Arrows, TickMrks, and Dots, only one can be toggled on at a time. 

Arrows Toggle on to draw arrows at the ends of dimension lines 
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TickMrks Toggle on to draw tick marks at the ends of dimension lines 
Dots Toggle on to draw dots at the ends of dimension lines 
Size Set the size of dimension arrows, tick marks, or dots; this setting is relative to the 

dimension text size, so if Size is set to 2, dimension arrows will be drawn twice the 
size of dimension text. The dimension text size is set using the TextSize option in the 
Linear/TextStyl menu. 

Weight Set the line weight of tick marks; not available if Arrows or Dots is toggled on 
Aspect Set the aspect ratio of the dimension arrows; this aspect ratio setting is the length of 

the arrowhead divided by the height, so a setting of 1 draws arrowheads with a 90° 
angle; not available when TickMrks or Dots is toggled on 

Color Set the color of arrows, dots, or tick marks. For more information on using color 
menus, see “Color Menus” in “The Drawing Board” chapter. 

Automatic Dimension Style Options for Linear Dimensions 

Use the following options in the AutoStyl menu to customize automatic 
dimension styles: 

Baseline Toggle on to draw a series of dimensions that all have one end point in common 
StrngLin Toggle on to draw a series of dimensions, each of which uses the last end point of the 

previous dimension as the first end point of the next dimension 
Of the two options OnlyPnts and NoPnts, only one can be toggled on at a time. 

OnlyPnts Toggle on to dimension to center points only; useful for dimensioning window and 
door openings 

NoPnts Toggle on to dimension to every center and end point that is greater than the 
minimum distance to dimension (set with the MinDist option) 

MinDist Set the minimum distance to dimension; a setting of zero (0) results in all distances, 
no matter how small, being dimensioned 

MissDist Set the search distance for points to dimension; the miss distance is perpendicular to 
the line you want to dimension. For more information on using value menus, see 
“Value Menus” in “The Drawing Board” chapter. 

LyrSrch Toggle on if any of the entities you want to dimension are on layers other than the 
active layer 

DirDim Toggle on to automatically go directly to the AutoDim menu when you click on 
Linear Dimension in the Create pull-down menu 

Editing Linear Dimensions 
You can edit any linear dimensions in your drawing by changing the text styles, 
lines styles, or arrow styles of the dimension. You can also change the position of 
dimension text. 

 To edit linear dimension text, lines, or arrows: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Linear Dimension in the submenu. The Linear menu is displayed in the 
Menu Window.  

2. Click on Change in the Linear menu. The Change menu is displayed in 
the Menu Window. 

3. Go to the Change menu and click on TextStyl to change the dimension 
text settings, click on DimStyl to change the dimension line settings, or 
click on ArroStyl to change the dimension arrow settings. The TextStyl, 
DimStyl, and ArroStyl options in the Change menu are the same as those 
in the Linear menu. See “Text Style Options for Linear Dimensions”, 
“Line Style Options for Linear Dimensions”, and “Arrow Style Options 
for Linear Dimensions” earlier in this chapter for details. 
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4. Click on a selection method in the Change menu. You are prompted to 
select the dimension you want to change. 

5. Click on the dimension you want to edit. The dimension is changed to 
match the text, line, and arrow style changes you made in step 3. 

 To move dimension text: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Linear Dimension in the submenu. The Linear menu is displayed in the 
Menu Window.  

2. Click on Change in the Linear menu. The Change menu is displayed in 
the Menu Window. 

3. Click on TxtPostn in the Change menu. You are prompted to “Select 
associative dimension to change text position”. 

4. Click on the dimension text you want to move. A box representing the 
text is connected to your cursor, and the Rotate option is displayed in the 
menu. 

5. Rotate the text before repositioning it in your drawing by clicking on 
Rotate and using the value menu to enter a rotation angle. Otherwise, 
continue with step 6. 

6. Move your cursor to the new location and click to place the text in its new 
position, or use coordinate entry to enter a new location for the text. For 
more information on using coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. 

7. Move dimension text back to its default position by clicking on Default 
and then clicking on the dimension text. The text is returned to its default 
angle and position. 

Exploding Linear Dimensions 
While you can freely edit non-associative dimensions, there may also be times 
that you need to edit an associative dimension measurement. Associative 
dimensions are connected to the entity they measure, so these measurements 
automatically adjust when the entity changes size. To edit an associative 
dimension, you first must explode the dimension, or disconnect it from the entity 
it’s associated with.  

When you explode dimensions, their appearance is not affected. 

 To explode an associative dimension: 

n click on 
the 

2.  

3. e Explode menu. You are prompted to 
select the dimension you want to explode. 

1. Click on Dimension in the Create pull-down menu, and the
Linear Dimension in the submenu. The Linear menu is displayed in 
Menu Window. 

Click on Explode in the Linear menu. The Explode menu is displayed in
the Menu Window. 

Click on a selection method in th
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4. Click on the associative dimension(s) you want to explode. The 
 

they measure. 

g imensions for Angles and Curves 
n two lines as well as the diameter or radius 

of a curve. 

 To dimension the angle between two lines: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Angular Dimension in the submenu. The Angular menu is displayed in 
the Menu Window. 

2. Customize the way dimension text is drawn by clicking on TextStyl and 
setting the options as necessary. (See “Text Style Options for Angle and 
Curve Dimensions” on the following pages for details.) 

3. Customize the way dimension lines are drawn by clicking on DimStyl 
and setting the options as necessary. (See “Line Style Options for Angle 
and Curve Dimensions” on the following pages for details.) 

4. Customize the way dimension arrows are drawn by clicking on ArroStyl 
and setting the options as necessary. (See “Arrow Style Options for Angle 
and Curve Dimensions” on the following pages for details.) 

5. Toggle LyrSrch on if the lines that form the angle you want to dimension 
are on different layers. You are prompted to “Select first line”. 

6. Click on one of the lines in your drawing that forms the angle you want 
to dimension. The line is displayed as dashed to indicate its selection. You 
are prompted to “Select second line”. 

7. Click on the other line in your drawing that forms the angle you want to 
dimension. The line is displayed as dashed to indicate its selection. 
Notice, too, that your cursor is connected to a curve representing the 
angle dimension line; moving your cursor changes the position of the 
dimension line. 

8. Position the angle dimension line and click to place it in your drawing. 
You are prompted to “Enter angle”. 

9. Press (Enter) to accept the actual angle measurement, or type an angle and 
press (Enter). The dimension line is drawn, and a small box representing 
the dimension text is connected to your cursor. 

10. Place the dimension text next to the dimension line by positioning your 
cursor and clicking. To place the text in its default position, simply right-
click. The dimension is completed. 

 To dimension a curve’s diameter: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Diameter Dimension in the submenu. The Diameter menu is displayed in 
the Menu Window. 

dimensions you selected are exploded, or disassociated from the entities

Drawin  D
You can dimension the angle betwee
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2. Customize the way dimension text is drawn by clicking on TextStyl and 
setting the options as necessary. (See “Text Style Options for Angle and 
Curve Dimensions” on the following pages for details.) 

3. Customize the way dimension lines are drawn by clicking on DimStyl 
and setting the options as necessary. (See “Line Style Options for Angle 
and Curve Dimensions” on the following pages for details.) 

4. Customize the way dimension arrows are drawn by clicking on ArroStyl 
and setting the options as necessary. (See “Arrow Style Options for Angle 
and Curve Dimensions” on the following pages for details.) 

5. Toggle LyrSrch on if the curve you want to dimension is on another layer. 
You are prompted to “Select arc or circle to dimension”. 

6. Click on the curve you want to dimension. You are prompted to “Enter 
diameter”. 

7. Press (Enter) to accept the actual diameter measurement, or type a 
diameter and press (Enter). The dimension is drawn. 

 To dimension a curve’s radius: 

1. Click on Dimension in the Create pull-down menu, and then click on 
Radius Dimension in the submenu. The Radius menu is displayed in the 
Menu Window. 

2. Customize the way dimension text is drawn by clicking on TextStyl and 
setting the options as necessary. (See “Text Style Options for Angle and 
Curve Dimensions” on the following pages for details.)  

3. Customize the way dimension lines are drawn by clicking on DimStyl 
and setting the options as necessary. (See “Line Style Options for Angle 
and Curve Dimensions” on the following pages for details.) 

4. Customize the way dimension arrows are drawn by clicking on ArroStyl 
and setting the options as necessary. (See “Arrow Style Options for Angle 
and Curve Dimensions” on the following pages for details.) 

5. Toggle LyrSrch on if the curve you want to dimension is on another layer. 
You are prompted to “Select arc or circle to dimension”. 

6. Click on the curve you want to dimension. You are prompted to “Enter 
radius”. 

7. Press (Enter) to accept the actual radius measurement, or type a radius and 
press (Enter). The dimension is drawn. 

Text Style Options for Angle and Curve Dimensions 

Use the following options in the TextStyl menu to customize dimension text 
styles: 

TextSize Set the dimension text’s actual size in your drawing. The TextSize, Weight, Slant, 
Aspect, Color, TxtScale, and FontName options work exactly like equivalent options 
in the Text menu. See the “Text” chapter for more information. 

Weight Set the line weight of dimension text, from 1 to 99 with “1” being the default weight 
setting; to triple the weight of text, for instance, set Weight to 3. For more information 
on using value menus, see “Value Menus” in “The Drawing Board” chapter. 
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Slant Set the angle of each character of text, as measured from the base of the character to 
its top 

Aspect Set the height of each character relative to its width; an aspect ratio of 1 represents the 
normal character style, while an aspect ratio of 5 produces text that is taller and 
narrower 

TxtScale Toggle TxtScale on to size your text by using the Size setting relative to the plot scale; 
toggle TxtScale off to size your text size based only on the TextSize setting 

Auto Toggle on to automatically place text, according to the TextStyl menu settings; toggle 
off to place the text for each dimension manually, using Rotate, DrwLeadr, or TextStyl 
as described in the instructions for drawing dimensions earlier in this chapter 

Color Set the color of dimension text 
FontName Set the font used for dimension text (See Figure 14.3) 
 

The decimal separator for all dimensions and numbers is determined by the 
Decimal Symbol setting. In your Windows Start menu, click on Set-tings, click on 
Control Panel, click on Regional Settings, and click on the Number tab. 

Line Style Options for Angle and Curve Dimensions 

Use the following options in the DimStyl menu to customize dimension line 
styles: 

Offset Set the distance between the entity being dimensioned and the beginning of the 
extension lines of the dimension. See Figure 14.4 for an example of Offset and 
Overlap settings. 

Overlap Set the distance extension lines are drawn past dimension lines 
CntrMark Toggle on to draw center marks for diameter and radius dimensions 
Rounding Set rounding for dimension text; toggle RoundIt on and choose from rounding up or 

down or banker’s rounding; click on Precsion to set the fractional rounding value for 
rounding up or down 

Limits Set the upper and lower limit for the size of entities to dimension (see Figure 14.6) 
Tolrance Set positive and negative geometric tolerances (see Figure 14.6) 

Arrow Style Options for Angle and Curve Dimensions 

While the Arrows, TickMrks, and Dots toggles are displayed only in the ArroStyl 
menu for linear dimensions, they affect all four dimension types: Linear, Angular, 
Diameter, and Radius. Use the following options in the ArroStyl menu to 
customize dimension arrow styles: 

Size Set the size of dimension arrows, tick marks, or dots; this setting is relative to the 
dimension text size, so if Size is set to 2, dimension arrows will be drawn twice the 
size of dimension text 

Weight Set the line weight of tick marks; not available if Arrows or Dots is toggled on in the 
ArroStyl menu for linear dimensions 

Aspect Set the aspect ratio of the dimension arrows; this aspect ratio setting is the length of 
the arrowhead divided by the height, so a setting of 1 draws arrowheads with a 90° 
angle; not available when TickMrks or Dots is toggled on in the ArroStyl menu for 
linear dimensions 

Color Set the color of arrows, dots, or tick marks. For more information on using color 
menus, see “Color Menus” in “The Drawing Board” chapter. 

 

 

 





Hatch 
Hatch patterns can add detail as well as visual information to 
your drawings. In DataCAD, there are two types of hatch, 
standard and associative. Standard hatch is a group of entities 
inserted in your drawing according to Hatch menu settings. 
Associative hatch, however, is a single entity and will update 
itself as necessary when you edit your drawing. Both types of 
hatch require you to define polyline boundaries for the hatch 
pattern. 

15 
In this chapter: 

 Drawing hatch 

 Hatch boundaries 

 Associative hatching 

 



|  CHAPTER 15: HATCH  332

Drawing Hatch Patterns 
You can fill areas of your drawing with repetitive patterns, called hatch patterns, 
to distinguish between building materials or to highlight parts of your drawing. 
Standard hatch, however, can increase file size and refresh times dramatically. To 
control file size as well as save time while editing your drawing, use associative 
hatch. See the Appendix for a list of the hatch patterns that come with DataCAD. 

Drawing Standard Hatch 
The lines in hatch patterns are separate entities that are linked as a group, so you 
can move or edit the entire area of hatch using the Group option in selection 
menus. However, you can also edit individual lines in the hatch pattern using the 
Entity selection method. 

 To draw a standard hatch pattern: 

1. Click on Hatch in the Create pull-down menu, or click on Hatch in the 
Utility menu in the Menu Window. The Hatch menu is displayed in the 
Menu Window. 

2. Click on HtchType to set the hatching type. The HtchLine menu is 
displayed. 

3. Toggle Normal on to alternate hatching within defined boundaries, toggle 
OutMost on to hatch only the first boundary, or toggle Ignore on to hatch 
within the outermost boundary and ignore all other boundaries (see 
Figures 15.1, 15.2, and 15.3 for examples). 

 
Figure 15.1: Hatching using the Normal hatching type 

 
Figure 15.2: Hatching using the OutMost hatching type 
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Figure 15.3: Hatching using the Ignore hatching type 

4. Right-click to return to the Hatch menu. 

5. Click on Pattern. A list of hatch patterns is displayed in the Menu 
Window, along with a preview window. Notice that as you move your 
cursor over each hatch pattern name in the list, an example of the 
highlighted hatch pattern is displayed in the preview window. Click on 
ScrlFwrd to scroll forward through the list of patterns; click on ScrlBack to 
scroll back through the list. 

6. Choose a pattern by clicking on its name in the list. You are returned to 
the Hatch menu. 

7. Change the scale that the hatch will be drawn in by clicking on Scale. A 
value menu is displayed. The Scale setting in the Hatch menu affects only 
the scale of the hatch pattern; it does not change the drawing scale. The 
pattern Line, for example, is based on 1/32” increments. To draw the Line 
pattern with 4” spacing, set Scale to 128.  (128 * 1/32”=4”). 

8. Use the value menu or type a scale, and press (Enter).  

9. Change the angle of the pattern by clicking on Angle. A value menu is 
displayed. 

10. Use the value menu or type an angle, and press (Enter). (The default 
setting is 0°.) 

11. Set the point where the hatch pattern will begin by clicking on Origin. 
You are prompted to “Select hatch pattern origin” . 

12. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity to select the origin for the hatch pattern. 

13. Define a boundary for the hatch pattern. A boundary is a polyline that 
defines the area of your drawing that will be hatched. Click on Boundary. 
The Polyline menu is displayed, and you are prompted to “Select first 
point on boundary to hatch to”. To define a rectangular boundary, simply 
click on Boundary and then RectAngl in the Polyline menu, and enter 
two, diagonally opposite points. 

14. Select the first point of the boundary by clicking in the Drawing Area, 
using coordinate entry, or object snapping to an entity. The options 2PtArc 
and 3PtArc are displayed in the Polyline menu. You are prompted to 
“Select next point on boundary to hatch to”. For more information on 
coordinate entry, see “Drawing Using Coordinate Entry” in “The 
Drawing Board” chapter. 

15. Add a line segment, 2-point arc, or 3-point arc to your polyline boundary: 
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• To select the second point of a line segment, click in the Drawing Area, 
use coordinate entry, or object snap to a point on an entity. 

• To add a 2-point arc to the boundary, click on 2PtArc in the Polyline 
menu. Select a center point for the arc, and then select an end point. 
Right-click to exit the 2-point arc function. 

• To add a 3-point arc to the boundary, click on 3PtArc in the Polyline 
menu. Select a second end point for the arc (with the first end point being 
the point you selected in the previous step), and then select any other 
point on the arc. Right-click to exit the 3-point arc function. 

 The option Tangent is displayed in the Polyline menu, and you are 
prompted to “Select next point on boundary to hatch to”. 

You can click Backup any time to erase the last line segment or arc of your 
polyline. You can click Cancel at any time to erase the boundary you’re drawing. 

16. Draw a tangent arc in your polyline by clicking on Tangent in the Polyline 
menu. Move your cursor until the arc displayed is the one you want 
drawn, and then click to draw the arc. 

17. Continue selecting points for line segments or arcs, as outlined in steps 15 
and 16, until your polyline boundary is complete. 

18. Click on Close in the Polyline menu. The Hatch menu is displayed in the 
Menu Window. 

19. Click on Begin to hatch the area within the boundary. The hatch pattern is 
drawn. Click on Clear to delete the boundary and return all hatch settings 
to their defaults. 

 To hatch a master polyline that contains voids (or areas that you do not want 
to hatch): 

1. Create the master polyline. This will contain the hatch pattern. For details 
on creating the master polyline, see “Voids in Polylines” in the “Drawing 
Other Geometry” chapter. 

2. Create the polylines that will serve as voids (areas that will not be 
hatched). 

3. Click on Voids in the Polyline menu. You are prompted to “Select master 
polyline to process voids”. 

4. Click on the closed master polyline that you want to put the void in. 
DataCAD puts dashed lines around that shape. You are prompted to 
“Select entity to select polylines to convert to voids”. 

5. Make sure Entity and AddVoid are toggled on in the Voids menu. 

6. Click on the polyline that will represent the void. The void is added. 
Dashed lines surround the void. 

7. Continue selecting other closed polylines within the master if necessary. 

8. Select Hatch from the Utility menu. 
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9. Click Pattern and choose one of the options. Make other adjustments to 
the pattern if necessary. For example, you may want to change the scale 
or the angle. 

10. Press (Enter) when you are satisfied that the pattern, scale, angle, and 
hatch type shown in the Message Window meet your needs. 

11. Click the polyline you created in steps 1 through 7. This selects the 
polyline. 

12. Click on Begin. The hatch pattern you selected appears within the master 
polyline boundary; however, the voids you created are empty. 

 To hatch a closed polyline with contour search: 

1. Select Hatch from the Utility menu. 

2. Use Pattern and select one of the options. Make other adjustments (such 
as changing the scale or the angle). Press (Enter) when you are satisfied 
with your selections. 

3. Choose Boundary from the Hatch menu. 

4. Click on ContSrch in the Boundary menu. You are prompted to “Select 
point inside/outside contour.” 

5. Click on the boundary of the closed polyline you want to use. 

6. Right-click to return to the Hatch menu. 

7. Select Begin. DataCAD applies the hatch pattern you selected within the 
closed polyline you identified with ContSrch. 

Using SPB Fills Instead of Standard Hatch Patterns 
Instead of using the standard vector-based hatch patterns (saved as .PAT files), 
you can use solid, pattern, and bitmap (SPB) fills. Unlike hatch patterns, solid 
fills will display and print with the same density, no matter what the viewed or 
plotted scale is. 

 To use solid, pattern, and bitmap fills: 

1. Click on Display in the Utility menu and make sure Fill On and Bmp On 
are activated in the Display menu. Then, right-click to return to the Utility 
menu. In the Status Window, there is now an upper-case F in 
SWOTHLUDFB, indicating that Fill is on (lower-case f means it’s off). 

2. Select Hatch from the Utility menu. 

3. Choose SPB-Fill from the Hatch menu. 

4. Click on Settings to choose the colors and patterns you want in your 
drawing. The Select Fill Color/Patterndialog box appears. 
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Figure 15.4: Control the solid, pattern, and bitmap (SPB) fills. 

5. Make decisions about the solid, pattern, and/or bitmap fills for your 
drawing. Your choices are displayed in the Preview window of the Select 
Fill Color/Pattern dialog box. 

• Click in the box beside Solid Pattern Fill or Bitmap Fill. These are 
mutually exclusive. 

• Use the Fill Settings options to make decisions about solid pattern details.  

• Control the fill and pattern colors by clicking on the rectangular 
swatch and making your selections from the Color Palette 
dialog box.  For more information, see “Customizing 
Colors” in the “Before You Draw” chapter. 

• Select the pattern you prefer from the drop-down box. The outline 
boundary, pattern, and fill may have different colors. Your 
choices are shown in the Preview window. 

• Check the Entity box if you want the fill to display with the color of 
the polyline entity in the drawing. 

• Use the Bitmap/JPEG options to make decisions about bitmap fills. 

• Click the file folder button to select the .BMP or .JPG image you want 
to use. 

• Uncheck the Maintain Aspect box if you want to change the X/Y 
aspect of the original image. 

6. Click OK on the Select Fill Color/Pattern dialog box when you are 
satisfied with your choices. The dialog box disappears. 

7. Click on an existing polyline area that you want to fill. If none exists yet, 
select Boundary from the SolidFil menu and draw one. 

You can control whether solid fills and bitmaps print behind or in front of lines 
by using the Print first or Print last options in the Pen Table. For more 
information about using the Pen Table, see “Using Pen Tables” in the “Printing 
Your Drawing” chapter. 
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Drawing Associative Hatch 
Associative hatch treats hatch patterns as a single entity, instead of a group of 
entities as standard hatch does. You can associatively hatch only 3D polygons 
and 2D polylines. When you use associative hatch: 

• You can stretch walls in your drawing, and the hatch will update 
automatically. 

• You can rotate your drawing without changing the angle of the hatch pattern. 

• Your drawing file size is usually smaller because the hatch pattern is a single 
entity instead of a group of entities. 

• You can’t edit individual lines in the hatch pattern. 

• The hatch is drawn the same color as your entity. If you use standard hatch 
(Associat toggled off), the hatch is drawn in the current layer’s color. 

• You have different hatch type options: OutLine draws an outline around the 
hatching, while NoOutLin does not. 

 To draw associative hatching: 

1. Click on Hatch in the Create pull-down menu, or click on Hatch in the 
Utility menu in the Menu Window. The Hatch menu is displayed in the 
Menu Window. 

2. Click on HtchType to set the hatching type. The HtchLine menu is 
displayed. 

3. Toggle Outline on to draw an outline around the hatching; toggle 
NoOutLin on to draw only the hatching. 

4. Continue with step 5 in the instructions on drawing a standard hatch 
pattern on the previous pages. 

After the hatching is drawn, you can click on DelAssoc to remove the associative 
hatching, without clearing the boundary you traced. Click Clear to delete the 
boundary and return the hatch settings to their defaults. 
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7.  

 



Symbols, Images, and Objects 
A symbol is a group of lines and arcs that is treated as a single 
entity. Symbols in DataCAD can be organized and displayed in 
templates. With DataCAD’s Template menu, you can enter 
symbols in your drawing, revise symbol descriptions as well as 
the symbols themselves, and even create new symbols from 
geometry in your drawing. Each symbol can have an unlimited 
amount of information associated with it. And one of the 
biggest advantages to using symbols in your drawings, instead 
of separate lines and arcs, is that you can use this information 
to generate a variety of schedules and estimates. 

In addition to symbols, you can also import bitmap (.BMP) and 
JPEG (.JPG) images into your drawings or insert o2c objects. 

16 
In this chapter: 

 Using templates 

 Creating templates 

 Working with symbols 

 Creating symbols 

 Importing BMP and 
JPEG images 

 Inserting o2c objects 
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Inserting Symbols in Your Drawing 
There are two methods for inserting symbols into your drawing. Using the Insert 
pull-down menu is faster, but using the Template menu offers you more options 
for working with your symbols. 

 To insert a symbol into your drawing using the Insert menu: 

1. Click on Symbol in the Insert pull-down menu. A dialog box is displayed, 
listing all symbol folders in your DATACAD\SYM folder. 

Shortcut: Press (“) (the double quotation key) to insert a symbol. 

2. Double-click on a symbol folder to open it and display those symbols. 

3. Click on the name of the symbol you want to use; if Show Preview is 
checked, a preview of the selected symbol is displayed in the preview 
window on the right side of the dialog box. The symbol preview displays 
in either orthographic (plan) or isometric view, depending on either the 
Symbol Preview setting on the Misc tab of the Program Preferences dialog 
box, available from the Tools pull-down menu, or the Isometric View 
checkbox in the Insert Symbol dialog box. 

4. Click on Open. The dialog box closes, and the Insert/Symbol menu is 
displayed in the Menu Window. Notice that a box representing the 
extents of the symbol is now attached to your cursor at the symbol’s 
insertion point. 

5. Change the symbol’s size if necessary. Before you place the symbol in 
your drawing, you can increase or decrease the size of an entity by 
entering specific enlargement values for the X, Y, and Z axes: 

• To resize the symbol while maintaining its original scale, increase the 
XEnlgmt, YEnlgmt, and ZEnlgmt values equally 

• To adjust the size of the symbol along the X axis, click on XEnlgmt. Use 
the value menu or type an enlargement factor, and press (Enter). 

• To adjust the size of the symbol along the Y axis, click on YEnlgmt. Use 
the value menu or type an enlargement factor, and press (Enter). 

• To adjust the size of the symbol along the Z axis, click on ZEnlgmt. Use 
the value menu or type an enlargement factor, and press (Enter). 

6. Rotate the symbol either dynamically positioning it or by setting a 
specific rotation angle for the symbol. The symbol is rotated around the 
insertion point, the point where the symbol is attached to your cursor.  

• To dynamically rotate the symbol into position when you place it in your 
drawing, toggle DynamRot on.  

• To set a specific rotation angle, toggle DynamRot off. Use the value menu 
or type an angle, and press (Enter). 

7. Cconvert the symbol into standard and separate lines and arcs when you 
place it in your drawing by toggling Explode on. 
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8. Place the symbol by clicking in the Drawing Area, using coordinate entry, 
or object snapping to a point in your drawing. The symbol is inserted into 
your drawing. For details on coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. For details on object 
snapping, see “Object Snapping” in the “Drawing Tools” chapter. 

9. Repeat the previous step to continue placing the symbol in your drawing, 
or right-click to exit the menu. 

 To insert a symbol into your drawing using the Template menu: 

1. Right-click until the Utility menu is displayed in the Menu Window. 

2. Click on Template in the Utility menu. A dialog box is displayed. 

Shortcut: Press (T) anytime to open the Template menu. 

3. Locate the template you’d like to use and click on it to select it. The 
templates that come with DataCAD are in your DATACAD\TPL folder. 

4. Click on Open. The template is displayed on the right side of the Drawing 
Area, and the Template menu is displayed in the Menu Window. 

5. Rotate the symbol into position either dynamically or by setting a specific 
rotation angle. The symbol is rotated around the insertion point, the point 
where the symbol is attached to your cursor. 

• To dynamically rotate the symbol into position when you place it in your 
drawing, toggle DynamRot on.  

• To set a specific rotation angle, toggle DynamRot off. Use the value menu 
or type an angle, and press (Enter). 

6. Change the symbol size if necessary. Before you place a symbol in your 
drawing, you can increase or decrease the size of an entity by entering 
specific enlargement values for the X, Y, and Z axes: 

• To enlarge entities along the X axis, click on XEnlgmt. Use the value menu 
or type an enlargement factor, and press (Enter). 

• To enlarge entities along the Y axis, click on YEnlgmt. Use the value menu 
or type an enlargement factor, and press (Enter). 

• To enlarge entities along the Z axis, click on ZEnlgmt. Use the value menu 
or type an enlargement factor, and press (Enter). 

• To set the line spacing enlargement factor for non-solid linetypes, click on 
LineFact. Use the value menu or type a line factor, and press (Enter). The 
LineFact setting affects how linetypes like Dashed are enlarged. A setting 
matching those of the X, Y, and Z enlargement factors will maintain the 
linetype’s spacing. 

• To set all of these options to the same setting and enlarge the entity 
equally in all directions, click on SetAll. Use the value menu or type an 
enlargement factor, and press (Enter). 
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7. Decide if you need to place symbols above or below the current Z-base. 
When placing tree symbols on a 3D site plan for example, you can change 
the Z-Offset option to enter the trees at the proper elevation. To set the 
vertical distance above or below the correct Z-base where you’d like to 
insert your symbols, click on Z-Offset. Use the value menu or type an 
offset value, and press (Enter). Enter a positive value to place the symbol 
above the current Z-base; enter a negative value to place the symbol 
below the current Z-base. 

8. Decide if you want to change the symbol. Normally, symbols are placed 
in your drawing as a single entity, so DataCAD doesn’t recognize the 
individual lines and arcs that make up the symbol. To be able to edit a 
symbol in your drawing, you must explode (or convert) the symbol into 
separate lines and arcs. To convert the symbol into separate lines and arcs 
when you place it in your drawing, toggle Explode on. (Note that this will 
only explode those symbols entered into your drawing after Explode is 
toggled on. To explode symbols already in your drawing, you must use 
the SymExp macro, as described in the “Editing Symbols” section later in 
this chapter. Exploded symbols appear the same as standard symbols, but 
DataCAD recognizes only the individual lines and arcs that make up the 
symbol, and not necessarily their relationship to each other. 

9. Select a symbol from the template by moving your cursor over the 
symbol you want to use and clicking. A box, representing the extents of 
the symbol, is attached to your cursor at the symbol’s insertion point. The 
symbol’s insertion point is marked by a small “x” once you place the 
symbol in your drawing. 

You can object snap to any point on a symbol to select an insertion point other 
than the one associated with the symbol definition. This is especially useful if you 
want to align a symbol with another entity in your drawing. Simply snap to the 
symbol in the template and then snap to the entity in your drawing to place the 
symbol. 

10. Place the symbol in your drawing by clicking in the Drawing Area, using 
coordinate entry, or object snapping to a point in your drawing. The 
symbol is inserted into your drawing.  

11. Repeat the previous step to continue placing the symbol in your drawing, 
or right-click to detach from the symbol. 

12. Open a different template if necessary by clicking on NewFile and 
selecting another template file from the dialog box. 

13. Close the template window by clicking on TemplOff. 

More About Templates and Symbols 

Each template is a graphic representation of the template (.TPL) file and is 
displayed with a number of divisions, each containing a symbol. The template 
file itself is a simple text file containing the name of the file, the number of rows 
and columns in the template, and the paths to the symbols associated with that 
template. When you select a template, the symbols associated with that template 
file are displayed in the template window. 
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Inserting Plumbing Symbols 
Not only can you insert plumbing symbols in your drawing, but you can also 
design lines of multiple plumbing fixtures and toilet partitions. The Furnitur and 
Mechanic options in the DCAD_AEC macro open a dialog box, allowing you to 
choose a template to display. 

 To insert a plumbing symbol: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. If DCAD_AEC is not listed in 
the Macros pull-down menu, see “Customizing the Macros Menu” for 
details on how to add it to the menu. 

2. Click on Plumbing in the DCAD_AEC menu. The Plumbing menu is 
displayed in the Menu Window. You are prompted to “Enter first point 
along fixture wall”. 

3. Define the wall where you will place plumbing fixtures. To enter one end 
point of the wall your plumbing fixtures will be drawn along, click in the 
Drawing Area, use coordinate entry, or object snap to a point in your 
drawing. You are prompted to “Enter second point along fixture wall”. 

4. Enter the other end point of the wall by clicking in the Drawing Area, 
using coordinate entry, or object snapping to a point in your drawing. You 
are prompted to “Point to side of wall on which to add fixtures”. 

5. Click on the side of the wall where the plumbing fixtures will be drawn. 
Several fixture options are displayed in the Menu Window. 

6. Add fixtures such as handicapped stalls, standard stalls, urinals, and 
sinks to your drawing. Click on PlumbSym to display the standard 
template dialog box and insert plumbing symbols using the Template 
menu, as described earlier in this chapter. To determine the number of 
each, click on the “+” and “-“ buttons under the HC Stall, Stall, Urinal, 
and Sink headings. The total number of each fixture, along with the 
available space left along the wall, is displayed in the Message Area. You 
can only add a fixture if available space allows. 

7. Customize the dimensions and location of each type of fixture: 

• To customize handicapped stalls, click on HC Stall. The HC Stall menu is 
displayed in the Menu Window. Use the options, as described in 
“Handicapped Stall Options” below, to customize handicapped stall 
fixtures. 

• To customize standard stalls, click on Stall. The Stall menu is displayed in 
the Menu Window. Use the options, as described in “Standard Stall 
Options” below, to customize stall fixtures. 

• To customize urinals, click on Urinal. The Urinal menu is displayed in the 
Menu Window. Use the options, as described in “Urinal Options” below, 
to customize urinal fixtures. 

• To customize sinks, click on Sink. The Sink menu is displayed in the 
Menu Window. Use the options, as described in “Sink Options” below, to 
customize sink fixtures. 
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8. Draw the plumbing fixtures according to the Plumbing menu options 
you’ve set by clicking on Begin. The fixtures are drawn, beginning from 
the second wall end point you entered. Handicapped stalls are always 
drawn first, followed by standard stalls, urinals, and finally sinks. You 
can’t customize the order in which fixtures are drawn. 

Handicapped Stall Options 

DataCAD’s toilet symbols are in your DATACAD\SYM\ TOILETS folder. 

Number Set the number of stalls to draw (use the value menu to set the number or click on 
+HC Stl and -HC Stl in the Plumbing menu). For more information on using value 
menus, see “Value Menus” in “The Drawing Board” chapter. 

Length Set the length of the stall; the length is measured from the wall behind the fixture to 
the inside of the partition containing the stall door 

Width Set the width of the stall; the width is measured from the inside of one partition wall 
to the inside of the other 

OpgWidth Set the width of the stall opening; if a door is drawn, this option also sets the width of 
the door 

Doors Toggle on to draw doors on stalls; toggle off to draw stalls without doors 
 
The HingeRt and SwingIn options are only available if Doors is toggled on. 

HingeRt Toggle on to draw doors hinged on the right side of stalls (as you face the stall); 
toggle off to draw doors hinged on the left side of stalls 

SwingIn Toggle on to draw doors that swing into stalls; toggle off to draw doors that swing 
out from stalls 

ToiltSym Open dialog box and select a custom toilet symbol to use when drawing handicapped 
stalls 

ResetDef Reset all HC Stall menu settings to their defaults 

Standard Stall Options 

DataCAD’s toilet symbols are in your DATACAD\SYM\ TOILETS folder. 

Number Set the number of stalls to draw (use the value menu to set the number or click on 
+Stall and -Stall in the Plumbing menu). For more information on using value menus, 
see “Value Menus” in “The Drawing Board” chapter. 

Length Set the length of the stall; the length is measured from the wall behind the fixture to 
the inside of the partition containing the stall door 

Width Set the width of the stall; the width is measured from the inside of one partition wall 
to the inside of the other 

OpgWidth Set the width of the stall opening; if a door is drawn, this option also sets the width of 
the door 

Doors Toggle on to draw doors on stalls; toggle off to draw stalls without doors 
 
The HingeRt and SwingIn options are only available if Doors is toggled on. 

HingeRt Toggle on to draw doors hinged on the right side of stalls (as you face the stall); 
toggle off to draw doors hinged on the left side of stalls 

SwingIn Toggle on to draw doors that swing into stalls; toggle off to draw doors that swing 
out from stalls 

ToiltSym Open dialog box and select a custom toilet symbol to use when drawing stalls 
ResetDef Reset all Stall menu settings to their defaults  

Urinal Options 
Number Set the number of urinals to draw (use the value menu to set the number or click on 

+Urinal and -Urinal in the Plumbing menu). For more information on using value 
menus, see “Value Menus” in “The Drawing Board” chapter. 

Spacing Set the distance between urinal partitions; if partitions are not drawn, the distance is 
measured from the center of one urinal to the center of the next 
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Partitn Toggle on to draw partitions between urinals; toggle off to draw urinals without 
partitions (a partition is always drawn between the last urinal and the first sink) 

PrtnSize Set the length of partitions; the length is measured from the wall out to the edge of the 
partition; PrtnSize is only available when the Partitn option is toggled on 

UrnlSym Open dialog box and select a custom urinal symbol to use when drawing urinals. 
DataCAD’s urinal symbols are in your DATACAD\SYM\ TOILETS folder. 

ResetDef Reset all Urinal menu settings to their defaults  

Sink Options 
Number Set the number of sinks to draw (use the value menu to set the number or click on 

+Sink and -Sink in the Plumbing menu) 
Spacing Set the distance from the center of one sink to the center of the next; only available if 

FitSinks is toggled off. Because the FitSinks option uses all remaining space on the 
fixture wall, the Space Left display in the Message Area always reads 0 when FitSinks 
is toggled on, no matter how many sinks are added or subtracted. 

FitSinks Toggle on to override the Spacing setting and automatically calculate the spacing 
between sinks; you can add sinks until they butt up against one another but this 
option will not allow them to overlap; toggle off to use the Spacing setting 

CodeMin Toggle on to set a minimum distance of 1’-6” between the center of the last sink and 
inner edge of the wall; toggle off to automatically set this to half the center-to-center 
sink spacing 

SinkSym Open dialog box and select a custom sink symbol to use when drawing sinks. 
DataCAD’s sink symbols are in your DATACAD\SYM\ SINKS folder. 

ResetDef Reset all Sink menu settings to their defaults 

Drawing Electrical Symbols and Ceiling Grids 
Along with inserting electrical symbols in your drawing, you can also create 
ceiling grids of any size and orientation. 

 To insert electrical symbols: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. If DCAD_AEC is not listed in 
the Macros pull-down menu, see “Customizing the Macros Menu” for 
details on how to add it to the menu. 

2. Click on Electric in the DCAD_AEC menu. The Electric menu is displayed 
in the Menu Window.  

3. Click on ElecSymb in the Electric menu. If no template is currently being 
displayed, a dialog box is displayed. 

4. Continue with step 3 of the instructions on inserting a symbol using the 
Template menu on page 341. 

 To create a ceiling grid: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. 

2. Click on Electric in the DCAD_AEC menu. The Electric menu is displayed 
in the Menu Window.  

3. Click on CeilGrid in the Electric menu. The CeilGrid menu is displayed. 
You can also use the CeilGrid menu to draw a floor grid that you can 
place furniture symbols on. Be sure to toggle Z-base on in the CeilGrid 
menu. 
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4. Draw the ceiling grid at either Z-base or Z-height. To draw the ceiling 
grid at the current Z-base, toggle Z-Base on in the CeilGrid menu. To 
draw the grid at the current Z-height, toggle Z-Hite on. 

5. Define a boundary for the ceiling grid. Click on Boundary to display the 
Boundary menu in the Menu Window. 

6. Use any 3D polygon as a boundary for your grid. If you already have a 
3D polygon in your drawing that you can use for the boundary, you can 
select it; if you don't, you can create a boundary for your ceiling grid. 

• To use a 3D polygon already in your drawing, click on Select. A selection 
menu is displayed, and you are prompted to select a ceiling boundary. 
Choose a selection method from the selection menu, and then select the 
3D polygon you want to use for your boundary. Skip to step 10. For more 
information on using selection menus, see “Selection Menus” in “The 
Drawing Board” chapter. 

• To create a boundary for your grid, click on Create. The Create menu is 
displayed in the Menu Window. You are prompted to "Enter the first 
corner of the ceiling boundary". 

7. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity in your drawing to select the first point for the boundary. You are 
prompted to "Enter the next corner of the ceiling boundary". You can add 
your boundary to a specific selection set as well as set the color, linetype, 
line width, and line spacing of the boundary line. For more information 
about boundary settings, see Boundary Menu Settings on the following 
pages. 

8. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity in your drawing to select the next point on the boundary.  

9. Repeat the previous step until your boundary is complete. You can click 
Backup any time to erase the last line segment or arc of your boundary. 
You can click Cancel at any time to erase the boundary you’re drawing. 

10. Right-click or click on Close in the Create menu to finish your boundary. 
You are returned to the Boundary menu. 

11. Right-click to exit the Boundary menu and return to the CeilGrid menu. 

12. Click on Grids to display the Grids menu. For more information about 
grid settings, see “Grids Menu Settings” on the following pages. 

13. Set the distance between grid lines in the X direction by clicking on X-Size 
in the Grids menu. A value menu is displayed. 

14. Use the value menu or type a distance, and press (Enter). 

15. Set the distance between grid lines in the Y direction by clicking on Y-Size 
in the Grids menu. A value menu is displayed. 

16. Use the value menu or type a distance, and press (Enter). 

17. Rotate the grid by clicking on RotAngle in the Grids menu. A value menu 
is displayed. 

18. Use the value menu or type an angle, and press (Enter). 
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19. Notice if you've selected a polygon for your boundary and you want to 
trace over the polygon to graphically show the boundary, toggle 
DoBound on in the Grids menu to display the grid boundary when you 
draw the grid. If you created a boundary in step 6, toggle DoBound off. 

You can add your grid to a specific selection set as well as set the color, linetype, 
line width, and line spacing of the grid lines. 

20. Draw the grid by entering a point in the Drawing Area where you want 
the grid to start. Click in the Drawing Area, use coordinate entry, or object 
snap to an entity in your drawing to enter the grid starting point. The 
grid is drawn within the boundary. You can enter the starting point 
anywhere in the Drawing Area, but the grid will actually be drawn only 
within the boundary you defined earlier. 

21. Right-click to exit the Grids menu and return to the CeilGrid menu. 

22. Add lighting fixtures to your ceiling grid. Click on Fixtures in the 
CeilGrid menu to display the Fixtures menu. For more information about 
fixture settings, see “Fixtures Menu Settings” on the following pages. 

23. Use a symbol for the lighting fixtures by toggling UseSymb on; to use a 
polygon to represent the fixtures, toggle UsePoly on. (A different set of 
options will be available, depending on which option you toggle on.) 

24. Define the symbol or polygon to be used for your fixtures. Of the two 
options, UseSymb and UsePoly, only one can be toggled on at any given 
time. 

• If you toggled UseSymb on, click on SymbNam in the Fixtures menu. A 
dialog box is displayed, and you are prompted to "Enter file name of 
symbol to use". Select a symbol to use for the lighting fixtures, and click 
on Open. 

• If you toggled UsePoly on, click on PolySize. A list of rectangular sizes 
followed by a list of circular sizes are displayed in the Menu Window. 
Click on a size for the polygon, and then right-click to return to the 
Fixtures menu. Use the CustRect option to define a custom-sized 
rectangle, or use the Cust Rnd option to define a custom circular polygon. 

25. Enter the fixtures at an angle in your grid by clicking on RotAngle and 
using the value menu to enter a rotation angle. 

26. Toggle Cutout on to automatically erase the grid lines that would 
otherwise run through the middle of the fixture symbol or polygon. 

27. Enter each fixture by its corner by toggling ByCornr on; to enter each 
fixture by its center, toggle ByCentr on. 

28. Notice that a circle or rectangle representing the fixture is now attached to 
your cursor. Click in the Drawing Area, use coordinate entry, or object 
snap to a point on your grid to draw a fixture. 

29. Repeat the previous step to enter additional fixtures on your ceiling grid. 

Click on Cleanup in the CeilGrid menu to use the Cleanup menu without exiting 
the DCAD_AEC macro. 
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Boundary Menu Settings 
Select Select an existing boundary or any 3D polygon to act as a boundary for your ceiling 

grid 
Create Draw a boundary for the ceiling grid; enter up to 36 sides in a single boundary 
Delete Delete any existing boundaries or 3D polygons 
Sel Set Choose the selection set to add a boundary to; only the first boundary added to a 

selection set can have a grid drawn in it 
ShwBoun Displays the number of polygons in that selection set 
Clear SS Delete all boundaries from that selection set. The ClearSS option doesn't delete the 

actual polygons from your drawing; rather this option simply disassociates the 
polygons from the selection set.  

Color Set the color of boundaries  
LineType Set the linetype of boundaries 
LineWdth Set the width of boundary lines. For more information on using value menus, see 

“Value Menus” in “The Drawing Board” chapter. 
LinSpcng Set the spacing of boundary lines (only affects linetypes with spaces in them, such as 

Dashed) 

Grids Menu Settings 
X-Size Set the distance between grid lines in the X direction 
Y-Size Set the distance between grid lines in the Y direction 
RotAngle Set the rotation angle of the grid 
DoBound Toggle on to draw the grid boundary when you draw the grid 
Grid SS Set the selection set to add the grid to 
ShowGrid Display the number of lines in the current selection set in the Message Area 
Append Toggle on to add multiple grids to the same selection set; toggle off to replace the 

previous grid drawn in the current selection set with a new grid. If Append is toggled 
off and you insert lighting fixtures into overlapping grids, only the last grid drawn 
will be affected by such settings as Cutout. 

Color Set the color of grids. For more information on using color menus, see “Color Menus” 
in “The Drawing Board” chapter. 

LineType Set the linetype of grids 
LineWdth Set the width of grid lines. For more information on using value menus, see “Value 

Menus” in “The Drawing Board” chapter. 
LinSpcng Set the spacing of grid lines (only affects linetypes with spaces in them, such as 

Dashed) 

Fixtures Menu Settings 
UseSymb Toggle on to use a symbol to represent fixtures 
UsePoly Toggle on to use a polygon for fixtures 
SymbName Choose the symbol to use for fixtures; available only when UseSymb is toggled on 
PolySize Choose a rectangular or round polygon to represent fixtures; available only when 

UsePoly is toggled on 
RotAngle Set the rotation angle for fixtures 
Cutout Toggle on to cut the ceiling grid and erase grid lines that would otherwise display 

over the fixture 
ByCornr Toggle on to insert fixtures by their corners 
ByCentr Toggle on to insert fixtures by their centers 
Grid SS Set the selection set to add the grid to 
ShowGrid Display the number of lines in the current selection set in the Message Area 
ObjSnap Shortcut to the ObjSnap menu. For more information on object snapping, see “Object 

Snapping” in the “Drawing Tools” chapter. 
Color Set the color of fixtures 
LineType Set the linetype of fixtures 
LineWdth Set the width of fixture lines 
LinSpcng Set the spacing of fixture lines (only affects linetypes with spaces in them, such as 

Dashed) 
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Inserting Stamps 
You can choose from more than a dozen pre-formatted date-, time-, and file-
related stamps to insert into your drawing. The examples shown in the stamp 
selection menu are based on the current date, time, and file settings as they will 
appear in the drawing. The values are updated when the display is regenerated 
and when the drawing is printed. Since a stamp is really an ordinary DataCAD 
text entity that contains a special formatting string, it has all the font, sizing, and 
style options of ordinary DataCAD text strings. You can further customize how 
you want stamps to appear in your drawing by doing a change/text/content and 
adding text around the special strings. Stamp text can be used in XREFs and 
symbols. The values update automatically, making stamps very flexible. 

 To add a stamp to your drawing: 

1. Select Stamp form the Insert pull-down menu. 

2. Select the stamp you want to use from the extended menu. 

Inserting o2c Objects 
Thousands of o2c objects -- including people, cars, furniture, and landscape 
elements -- are available for you to import into DataCAD drawings. Or you can 
import your own o2c objects, such as your company logo. 

 To insert an o2c object: 

1. Click on o2c Object in the Insert pull-down menu. A dialog box is 
displayed, prompting you to “Select o2c file to import”. 

2. Locate the o2c object you want to insert into your drawing, and click on it 
to select it. 

3. Click on Open. The dialog box closes, and a box representing the extents 
of the o2c object is now attached to your cursor. 

4. Place the object by clicking in the Drawing Area, using coordinate entry, 
or object snapping to a point in your drawing. The o2c object is inserted 
into your drawing. For details on coordinate entry, see “Drawing Using 
Coordinate Entry” in “The Drawing Board” chapter. For details on object 
snapping, see “Object Snapping” in the “Drawing Tools” chapter. 

5. Repeat the previous step to continue placing the object in your drawing, 
or right-click to exit the menu. 

Importing BMP and JPEG Images 
You can import both bitmap (.BMP) and JPEG (.JPG) files into your DataCAD 
drawing. Import any number of black and white, grayscale, and 8- to 32-bit color 
images. You can trace scanned drawings, display site maps, or show digital 
photos of existing building facades when you import bitmaps into your drawing. 

Imported bitmaps are referenced, not inserted into your drawing file. That means 
your drawing file size will not increase. 



|  CHAPTER 16: SYMBOLS, IMAGES, AND OBJECTS  350

 To import an image: 

1. Click on Bitmap in the Insert pull-down menu. The Select Image dialog 
box is displayed. 

3. Click on the .BMP or .JPG file you want to insert in your drawing and 
click Open. The Bitmap menu is displayed in the Menu Window, and you 
are prompted to “Enter first point of bitmap rectangle”. 

4. Toggle OutLine on if you want to draw a visible polyline boundary 
around the inserted image. Toggle NoOutLin on if you do not want a 
visible boundary around the image. These are mutually exclusive toggles. 

5. Toggle the FixRatio option on to preserve the original dimensions of the 
image; toggle it off to dynamically stretch the X and/or Y ratios while you 
are inserting the bitmap. After you insert the image, you cannot change 
the ratio if FixRatio was turned on; therefore, for future flexibility, you 
may want to turn FixRation off. 

While working in your drawing, you can toggle off Bmp On in the Display 
menu to decrease drawing refresh times by not displaying all the bitmaps 
in your drawing. Toggle it on again to display all images in your drawing 
as well as allow printing of them. Notice that SWOTHLUDFB in the 
Status Window contains an upper-case letter B if BmpOn is active; but it 
turns to a lower-case b if BmpOn is not active. 

4. Enter the first corner of the image’s extents by clicking in the Drawing 
Area, using coordinate entry, or object snapping to an existing point in 
your drawing. Notice that if you move your cursor diagonally away from 
that point, a rectangular box (representing the extents of your image) 
stretches with it. You are prompted to “Enter second point of bitmap 
rectangle”.  

6. Enter the corner diagonal from the first corner by clicking in the Drawing 
Area, using coordinate entry, or object snapping to an existing point in 
your drawing. The image is inserted in your drawing. If Bmp On is 
toggled off in the Utility/Display menu, only a rectangular box 
representing the extents of the image is displayed in your drawing. To 
display your image, toggle Bmp On in the Display menu. 

7. Use the Calibrate options in the Enlarge menu to scale bitmaps to real-
world size. For more information about this, see “Calibrating 
Enlargements” in this chapter. 

You can control whether bitmaps or JPEGs print behind or in front of lines by 
using the Print first or Print last options in the Pen Table. For more information 
about using the Pen Table, see “Using Pen Tables” in the “Printing Your 
Drawing” chapter. 

Calibrating Enlargements 
You can enlarge or reduce imported bitmap and vector graphics to real-world 
scale. For example, if you import a site map, you can use the Calibrate Distance 
function to enlarge the plan to real-world dimensions. 
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 To calibrate imported bitmaps or vector graphics and enlarge to real-world 
size: 

1. Select Enlarge from the Edit menu. You are prompted to “Select CENTER 
of enlargement.” 

2. Click on the graphic you want to resize. Options appear in the Enlarge 
menu. 

3. Select Enlrgmnt to display the calibration options. 

4. Click on CalDist.  

5. Show the length of an entity or a known distance in the bitmap by 
clicking on your imported graphic at the first point to begin drawing a 
measuring line. Extend the line and click again when you reach the end of 
the entity or known distance in the graphic. You are prompted to “Enter 
new distance.” The current distance follows this prompt.  

6. Replace that value with what it should be in the “real world.” For 
example, the current value may be 0.8, but in reality, it should be 6 feet; 
therefore, you would type 6 in the input field. Press (Enter).  DataCAD 
calculates the enlargement factor and displays it in the Message Window. 

7. Select the entity or entities that you want to enlarge by that factor. 

CalDist automatically calculates an equal X/Y enlargement factor. Instead of 
CalDist, you can use the CalX-Y, CalX, or CalY options to enlarge entities 
independently or unequally in the X and Y directions. 

Drawing Arrows 
You can draw arrows of varying widths using the Arrow macro. 

 To draw an arrow: 

1. Click on Arrow in the Macros pull-down menu. The Arrow menu is 
displayed in the Menu Window. If ARROW is not listed in the Macros 
pull-down menu, see “Customizing the Macros Menu” for details on how 
to add it to the menu. 

2. Click on Width in the Arrow menu. A value menu is displayed. 

3. Use the value menu or type a width for the arrow, and press (Enter). You 
are prompted to "Enter first point of arrow centerline". 

4. Enter the two end points of the arrow. Click in the Drawing Area, use 
coordinate entry, or object snap to an entity to enter the base of the arrow. 
Notice that the length and direction of the arrow changes as you move 
your cursor. You are prompted to "Enter second point of arrow 
centerline". 

5. Click in the Drawing Area, use coordinate entry, or object snap to an 
entity to enter the tip of the arrowhead. The arrow is drawn. 
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Creating and Editing Templates 
Templates are a very effective way to organize a library of predrawn items, 
which you can use in many different projects. You can, for instance, create a 
template with symbols that you use frequently or one that supports office 
standards. See “More About Creating Templates” for details on defining 
information fields. 

Each template has information fields defined specifically for that template. 
Whenever you add a symbol to that template, you can enter information 
describing that symbol in each field.  There are six standard information fields 
that are defined for every template, but you can define an unlimited number of 
additional fields. 

 To create a template: 

1. Click on Template in the Utility menu; or if you’re already in the Template 
menu, click on NewFile. A dialog box is displayed. 

2. Type a name for your new template, and click on Open or press (Enter). 
The dialog box closes, and you are prompted with “Create new file?” For 
more information about establishing a naming system for template files, 
see “More About Naming Templates” later in this chapter. 

Toggle AutoPath on in the Template menu to automatically create a folder 
in your SYM\ folder with the same name as the template file you’re 
creating. This allows you to easily keep track of the symbols associated 
with your new template. 

3. Click on Yes in the Menu Window to create the template. You are 
prompted with “Field name”. 

4. Notice that all templates have six standard fields automatically defined 
for them. You can either define additional information fields, or simply 
create the template with only the standard six fields. To use only the 
standard fields, right-click and skip to step 7. To enter an additional field, 
type a name for the field (up to 20 characters) and press (Enter). A list of 
field data types is displayed in the Menu Window, and you are prompted 
to “Select field type”. 

5. Notice that there are three field types available: text, number, and dollar. 
To create a field that you can enter letters and numbers into, click on Text. 
To create a field that you can enter an integer into, click on Number. To 
create a field that you can enter a real number with two fixed decimal 
places, click on Dollar. Numbers entered in a text field cannot be used in 
any calculations. 

6. Repeat steps 4 – 5 to continue entering information fields.  

7. Right-click when you’ve completed entering fields. The template is 
created and displayed at the right side of the DataCAD window, and the 
Template menu is displayed in the Menu Window. For information on 
how to add symbols to your new template, see “Creating Symbols later in 
this chapter. 
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More About Creating Templates 

When you create a template, DataCAD automatically defines six information 
fields: 

Field Name Field Type 
Item nam Text 
Manufact Text 
Model No Text 
Remark 1 Text 
Remark 2 Text 
Cost Dollar 

 

You can create an unlimited number of additional information fields when you 
create a template. This is the only time you can define information fields; once the 
template is created, you can’t add another field or delete a field, nor can you 
change the field’s name or type.  

While you can’t change the fields themselves, you can always edit any 
information you’ve entered into a field. See “Editing Information Fields” later in 
this chapter for more information. All fields you create can accept up to 80 
characters of information.  

More About Naming Templates 

As you add more and more templates to your library, it becomes increasingly 
important to name those templates in an organized, easily recognizable way. You 
can simply give your templates longer, more descriptive names, such as “office 
chairs.tpl” or “living room.tpl”.  Template names with spaces or more than 8 
characters may not be compatible with older versions of DataCAD.  The total 
name including path cannot exceed 80 characters. Or you can devise a naming 
system like the following one: 

• Sweet’s catalog section number 

• title of template 

• chronological number of template 

For example, if you’re creating a template of door jamb details, and three similar 
templates already exist, you could name this fourth template 08JAMB04.TPL: 
“08” is the catalog number, “JAMB” is the title of the template, and “04” tells you 
it’s the fourth template of door jambs. 

Editing Templates 
Templates you create in DataCAD have a standard number of divisions: three 
columns and 12 rows. Once you’ve created a template, you can change the 
number of divisions to suit your needs. For information on editing the symbols 
in a template, see “Editing Symbols” later in this chapter. 

The number of divisions in a template doesn’t have to equal the number of 
symbols associated with that template. You can have more divisions than 
symbols, in which case some of the divisions in your template will be empty. You 
can also have fewer divisions than symbols, so that not all symbols associated 
with that template will be displayed at once. Displaying fewer symbols will also 
increase refresh times. 
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 To change the number of divisions in a template: 

1. Create your template. Then click on Divisons in the Template menu. You 
are prompted with “Number of X-divisions in template”. 

2. Use the value menu or type the number of columns for your template, 
and press (Enter). You are prompted with “Number of Y-divisions in 
template”. 

3. Use the value menu or type the number of rows for your template, and 
press (Enter). The template is updated with the new divisions, and you are 
returned to the Template menu. 

Creating and Editing Symbols 
Creating and editing symbols is a very effective way to build a library of 
predrawn items that you can use in many different projects. You can, for 
instance, draw a lighting fixture, create a symbol from the fixture geometry and 
add it to a template, and then very quickly place several instances of that fixture 
in your drawing.  

To quickly determine the exact path and folder name of a symbol, click on 
SymName in the Template menu and then click on the symbol. 

You can also enter descriptive information about each symbol, and then edit that 
information. You can even replace symbols in your drawing with others in your 
symbol library. 

 To create a symbol and add it to a template: 

1. Click on Template in the Utility menu. The Template menu is displayed in 
the Menu Window. 

Shortcut: Press (T) to display the Template menu. 

2. Click on SaveSymb. A dialog box is displayed, prompting you to “Enter 
name of symbol file to be saved. Symbol folders are stored in your 
DATACAD\SYM folder. 

3. Make sure the folder that’s open in the dialog box is the one you want to 
save the symbol in. If it’s not, change to the proper folder. 

4. Type a name for your symbol and click on Save. The SaveSymb menu is 
displayed in the Menu Window. Use SaveSymb to select either symbols 
already in your drawing or geometry you want to make into a symbol;  
both types of selection will be added to the currently displayed template. 

5. Choose a selection method and then select the parts of your drawing you 
want to make into a symbol. You are prompted to “Select reference point 
for symbol”. 

6. Select the reference, or insertion. You can point for the symbol, click in the 
Drawing Area, use coordinate entry, or object snap to a point in your 
drawing. The entities you selected are copied into the first open space in 
the template; if there are no open spaces in the currently displayed 
template, the symbol can’t be displayed in that template until you 
increase the number of template divisions. The first field, called Item 
Name, is displayed in the Message Area. 
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7. Enter a name for your symbol. You are prompted to enter information for 
additional fields. 

8. Continue to enter symbol information for each field, or press (Enter) to 
skip a field and continue with the next. To skip all remaining fields, right-
click. The dialog box is displayed again. 

9. Continue with step 3 above to save additional symbols. 

More About Naming Symbols 

As you add more and more symbols to your templates, it becomes increasingly 
important to name those symbols in an organized, easily recognizable way. You 
can simply give your symbols longer, more descriptive names, such as “office 
chair.sym” or “kitchen sink.sym”. Or you can devise a naming system like the 
following one: 

• Sweet’s catalog section number 

• title of symbol 

• chronological number of symbol 

For example, if you’re creating a door jamb symbol, and two similar symbols 
already exist, you could name this third symbol 08JAMB03.SM3: “08” is the 
catalog number, “JAMB” is the title of the symbol, and “03” tells you it’s the third 
door jamb symbol. Symbol names with spaces or more than 8 characters may not 
be compatible with older versions of DataCAD.  The total name including path 
cannot exceed 80 characters. 

Editing Symbols 
To edit symbols, you must first explode, or convert, them into individual lines and 
arcs. You can do this when you insert the symbol into your drawing or after the 
symbol has been inserted. Once the symbol has been edited, you can reform the 
symbol lines and arcs into a single symbol entity and copy it back into the 
template and then update the symbols already in your drawing. 

 To explode a symbol when you place it in your drawing and edit it: 

1. Click on Template in the Utility menu. A dialog box is displayed, 
allowing you to choose a template to open.  

2. Click on the template you want to use, and click on Open. The template is 
displayed on the right side of the Drawing Area, and the Template menu 
is displayed in the Menu Window. 

3. Toggle Explode on in the Template menu. 

4. Click on the symbol in the template that you want to insert into your 
drawing. 

5. Place the symbol in your drawing. You can click in the Drawing Area, use 
coordinate entry, or object snap to an entity in your drawing. The symbol 
is copied to your drawing and automatically exploded into separate 
entities. 



|  CHAPTER 16: SYMBOLS, IMAGES, AND OBJECTS  356

6. Edit the symbol geometry as necessary. For more information on editing 
lines and arcs, see the “Editing Drawings” chapter. 

7. Copy your changes back to the template. Click on Redefine in the 
Template menu. You are prompted to “Point to symbol in template 
window to redefine”.  

8. Click on the symbol in the template that you just edited in the Drawing 
Area. A selection menu is displayed, and you are prompted to select the 
geometry you want to be your new symbol. 

9. Choose a selection method, and then select the geometry for the symbol. 
Your selection is highlighted with dashed lines. If necessary, continue 
selecting geometry until all entities that you want to be included in the 
new symbol are highlighted. 

10. Click on Continue to go on with the symbol definition process. You are 
prompted to “Select a reference point for symbol”. 

11. Click in the Drawing Area or use coordinate entry to select the point that 
will be used to insert the symbols in drawings. The edits to the symbol 
are copied to the template. 

12. Update all instances of that symbol in your drawing. Click on Re-Load in 
the Template menu. You are prompted to “Point to symbol in template 
window to re-load from disk”. 

13. Click on the symbol in the template that you want to reload, or click on 
All in the Re-Load menu to reload all symbols in your drawing. 

 To explode a symbol already in your drawing and edit it: 

1. Click on SymExp in the Macros pull-down menu. A selection menu is 
displayed in the Menu Window. If SYMEXP is not listed in your Macros 
menu, click Configure in the Macros menu and add SYMEXP to the 
Macros in Menu list. 

2. Choose a selection method, and then select the symbol(s) you want to 
edit. The number of symbols selected and the number of entities they 
were exploded into is displayed in the Message Area. For more 
information on using selection menus, see “Selection Menus” in “The 
Drawing Board” chapter. 

3. Edit the symbol geometry as necessary. 

4. Load your changes to this symbol back into its template if necessary. 
Then, open the appropriate template and continue with step 7 in the 
previous instructions. 

Editing Information Fields 
You can edit information associated with symbols by selecting a symbol in a 
template or one that’s already in your drawing. Use the Reports option in the 
Template menu to extract symbol information for all symbols used in your 
drawing, and create specification reports or cost estimates. See the “Reports and 
Estimates” chapter for more information. 
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 To edit symbol information: 

1. Open the template that the symbol (whose information you want to edit) 
is associated with.  

2. Click on EditFlds in the Template menu. 

3. Click on the symbol, either in the template or in your drawing, whose 
information you want to edit. The fields for that symbol are displayed in 
the Menu Window. 

4. Click on the field you want to edit. 

5. Type the new information for that field and press (Enter). 

6. Repeat steps 4 –5 to continue changing field information as necessary. 

7. Edit information for another symbol by right-clicking and continuing 
with step 3 above. Right-click twice to exit back to the Template menu.  

 To edit symbol information: 

1. Click on FormAtr in the Macros pull-down menu. The FormAtr menu is 
displayed in the Menu Window. If FormAtr is not listed in your Macros 
menu, click Configure in the Macros menu and add it to the Macros in 
Menu list. 

2. Click on Symbol in the FormAtr menu. You are prompted to “Select 
symbol to edit attribute fields”. 

3. Click on the symbol. The symbol’s information is displayed in the 
Drawing Area. 

4. Press (Tab) to move the edit box to the text you want to change.  

5. Type the new text and press (Enter). The information is changed. 

6. Repeat steps 4 – 5 to continue editing. 

7. Press (Esc) to exit editing and return to your drawing. You are prompted 
with “Do you wish to update symbol file [symbol path and filename]?” 

8. Click on Yes to update the symbol information; click on No to cancel the 
changes. 

Replacing Symbols in Your Drawing 
You can replace one symbol in your drawing with another and choose whether to 
replace one instance of that symbol or all instances throughout your drawing. 
This is useful, for instance, if you’ve entered one type of bathroom sink 
throughout your drawing and you need to replace it with another type. 

 To replace one symbol with another symbol: 

1. Click on Template in the Utility menu. The Template menu is displayed in 
the Menu Window. 

2. Click on Replace in the Template menu. The Replace menu is displayed in 
the Menu Window, and you are prompted to “Point to the symbol to 
replace”. 
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3. Click on the symbol in your drawing that you want to replace. You are 
prompted to “Point to symbol to replace with”. 

4. Choose the new symbol that will replace the original by clicking on a 
symbol in a template or on one that’s already in your drawing. A selection 
menu is displayed in the Menu Window. 

5. Replace only particular instances of the symbol you selected in step 3 or  
replace all instances of that symbol. To choose particular instances of the 
symbol, choose a selection method from the menu, and continue with the 
next step. To replace all instances of the symbol, click on All; all instances 
of the symbol are immediately replaced, and you can skip to step 7. 

6. Select each instance of the symbol that you want to replace. Each symbol 
is replaced as you select it.  

7. Finish replacing symbols. Then, right-click to return to the Template 
menu. 

 To replace several different symbols with another symbol: 

1. Click on Template in the Utility menu. The Template menu is displayed in 
the Menu Window. 

2. Click on Replace in the Template menu. The Replace menu is displayed in 
the Menu Window, and you are prompted to “Point to the symbol to 
replace”. 

3. Click on AnySymb in the Replace menu. You are prompted to “Point to 
symbol to replace with”. 

4. Choose the new symbol that will replace the original by clicking on a 
symbol in a template or on one that’s already in your drawing. A selection 
menu is displayed in the Menu Window. 

5. Select each symbol you want to replace or replace every symbol in your 
drawing. To choose each symbol, choose a selection method from the 
menu, and continue with the next step. To replace all symbols, click on 
All; all symbols in your drawing are immediately replaced. 

6. Select the symbols to be replaced. Each symbol is replaced as you select it.  

7. Finish replacing symbols. Then, right-click to exit the Replace menu and 
return to the Template menu. 

Deleting Symbols 
You can erase symbols from your drawing or delete them from a template.  

 To erase a symbol: 

1. Click on Erase in the Edit menu. The Erase menu is displayed in the 
Menu Window. 

2. Toggle LyrSrch on if the symbols you want to erase are on a layer other 
than the active layer. 

3. Click on a selection method in the menu. You are prompted to select the 
entities you want to erase. 
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4. Select the symbols; they are erased from the drawing. You can continue 
selecting symbols to erase them. Avoid selecting a symbol where it 
crosses another entity, because it may be difficult for DataCAD to know 
which entity you want to select. Zoom in on your drawing or change 
your view to select symbols more precisely. 

5. Finish erasing symbols. Then, right-click to exit the Erase menu. 

 To delete a symbol from a template: 

1. Click on Template in the Utility menu. A dialog box is displayed, 
allowing you to choose a template to open.  

2. Click on the template with the symbol you want to delete, and click on 
Open. The template is displayed on the right side of the Drawing Area, 
and the Template menu is displayed in the Menu Window. 

3. Click on DelSymb in the Template menu. You are prompted to “Select 
symbol to delete from this template file”. 

4. Click on the symbol you want to delete from the template. You are asked 
to confirm your selection. 

5. Click on Yes to delete the symbol; click on No to cancel the function. 

6. Continue selecting symbols to delete them from the template, or right-
click to exit the DelSymb menu.  

More About Erasing Symbols 

When you erase symbols from your drawing, it’s important to purge the symbol 
from your drawing as well. When you add a symbol to your drawing, DataCAD 
associates that symbol with your drawing. This association is not deleted when 
you erase the symbol and continues to take up drawing file space. To delete the 
association as well, you must use the PurgeSym option in the Template menu. 

 To purge symbol associations from your drawing: 

1. Click on PurgeSym in the Template menu. You are prompted with “Are 
you sure you want to purge unused symbols?” 

2. Click on Yes to purge the associations with symbols that have been 
deleted; click on No to cancel the function. 

 





Borders and Title Blocks 
You can draw drawing sheet borders and title blocks manually, 
using DataCAD’s Polygons menu, or you can use the Drawing 
Sheet tool in the DCAD_AEC macro to automate the process. 

17 
In this chapter: 

 Drawing sheet borders 

 Adding title blocks 
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Drawing Borders and Title Blocks 
Borders and title blocks can be added to your drawing in two ways: either follow 
the procedure outlined in the tutorial in this manual, or use the Drawing Sheet 
tool in the DCAD_AEC macro.  

 To use the Drawing Sheet tool: 

1. Click on DCAD_AEC in the Macros pull-down menu. The DCAD_AEC 
menu is displayed in the Menu Window. If DCAD_AEC is not listed in 
the Macros pull-down menu, see “Customizing the Macros Menu” for 
details on how to add it to the menu. 

2. Click on DwgSheet in the DCAD_AEC menu. The DwgSheet menu is 
displayed in the Menu Window. 

3. Notice the Drawing Sheet tool. It calculates the size of the border sheet by 
using the plotting scale and paper size you will use when you print your 
drawing. To enter the plotting scale, click on Scale. A value menu is 
displayed, and you are prompted to “Select the plotter output scale you 
will be using.” 

4. Use the value menu to enter the plotting scale you will use. 

5. Enter the sheet size you will use when plotting by clicking on PaperSiz. A 
menu listing sheet sizes is displayed, and you are prompted to “Select the 
sheet size you will be plotting to.” 

6. Click on a sheet size in the list; or to define a custom sheet size, click on 
Custom and then use the value menus to enter the plotting width and 
height. 

7. Right-click to return to the DwgSheet menu. 

8. Define the title block. To specify the location of the title block on the sheet, 
click on TitleLoc. 

9. Choose one of the following locations for your title block: 

• Click on Top to place the title block on the top of the sheet. 

• Click on Bottom to place it on the bottom of the sheet. 

• Click on Left to place it on the left side of the sheet. 

• Click on Right to place it on the right side of the sheet. 

• Click on None to draw the sheet border without a title block. 

10. Set the number of boxes you want the title block to contain by clicking on 
TitleDiv. A value menu is displayed, and you are prompted to “Enter 
number of title block divisions across.” For more information on using 
value menus, see “Value Menus” in “The Drawing Board” chapter. 

11. Use the value menu or type a number, and press (Enter). You are prompted 
to “Enter number of title block divisions down”. 

12. Use the value menu or type a number, and press (Enter). You are returned 
to the DwgSheet menu. 
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13. Set the height of the title block by click on TitleSiz. A value menu is 
displayed, and you are prompted to “Enter height of drawing sheet title 
block”. 

14. Use the value menu or type a size, and press (Enter). You are returned to 
the DwgSheet menu. 

15. Set the number of detail blocks by clicking on DtailDiv. A value menu is 
displayed, and you are prompted to “Enter number of detail block 
divisions across”. 

16. Use the value menu or type a number, and press (Enter). You are prompted 
to “Enter number of detail block divisions down”. 

17. Use the value menu or type a number, and press (Enter). You are returned 
to the DwgSheet menu. 

18. Set the height of detail title blocks by clicking on DtailTtl. A value menu is 
displayed, and you are prompted to “Enter the height of detail title 
block”. 

19. Use the value menu or type a height, and press (Enter). You are returned to 
the DwgSheet menu. 

20. Add a snapping point at the center of your sheet border by toggling 
AddSnap on. Toggle AddSnap off to draw sheet borders without the 
center snapping point. 

21. Draw the border and title block. You must select the center point of the 
drawing sheet border. Click in the Drawing Area, use coordinate entry, or 
object snap to an entity to select the center point. The sheet border is 
drawn. 

22. Add common architectural symbols to your title block. Click on 
DwgSymb, open the DRAWING.TPL file in the TPL\DWG folder in your 
DataCAD folder, and insert symbols as necessary. For more information 
on how to insert symbols, see “Inserting Symbols in Your Drawing” in the 
“Templates & Symbols” chapter. 
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8.  

 



Elevations and Sections 
With the EZ Tools macro, you can parametrically draw 
residential or commercial elevations and sections quickly and 
easily. This set of tools eliminates the need for the tedious 
linework and calculations otherwise required to create basic 
elevations. All angles, lines, offsets, and line lengths are done 
automatically, leaving you free to concentrate on the drawing 
aesthetics. 

The Elevations tool assists in drawing exterior and interior 
residential elevations, including door, window, and cabinet 
elevations, while the Sections tool draws cabinet outline 
sections. 

18 
In this chapter: 
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 Drawing door elevations 

 Drawing window 
elevations 

 Drawing cabinet 
elevations 

 Drawing cabinet 
sections 
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Drawing Exterior Elevations 
Exterior elevations are defined by selecting two points along the line of the 
subfloor. The exterior elevation will be drawn relative to those two points, based 
on the Exterior menu settings. 

 
Figure 18.1: A sample exterior elevation with default exterior elevation settings noted. EZ Tools 
draws only those lines represented above by extra line thickness. 

 To draw an exterior elevation: 

1. Click on EZTOOLS in the Macros pull-down menu. The EZ Tools menu is 
displayed in the Menu Window. If EZTOOLS is not listed in the Macros 
pull-down menu, click Configure in the Macros menu and add EZTOOLS 
to the Macros in Menu list. 

2. Click on Elev in the EZ Tools menu. The Elev menu is displayed in the 
Menu Window. 
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3. Click on Exterior in the Elev menu. The Exterior menu is displayed in the 
Menu Window. 

4. Choose between a full or partial elevation. Full exterior elevations are 
drawn by assuming that the points you will select are on two opposite 
walls of the structure. Partial elevations are drawn by assuming that the 
first point you select will be on a wall and the second point will be at the 
mid-point of the structure. To draw a full elevation, toggle Full on; to 
draw a partial elevation, toggle Partial on. Of the two options, Full and 
Partial, only one can be toggled on at any given time. 

5. Set the roof style for your elevation by clicking on Style. The Style menu 
is displayed in the Menu Window, and you are prompted to “Select roof 
style”. 

6. Toggle Gable on to draw a gable roof in your elevation; toggle Hip on to 
draw a hip roof in your elevation; toggle Boston on to draw a Boston-style 
roof in your elevation; or toggle Shed on to draw a shed roof in your 
elevation. Of the four options, Gable, Hip, Boston, and Shed, only one can 
be toggled on at any given time. You are returned to the Elev menu. 

7. Set the height of the top plate on which the rafters rest by clicking on 
PlateHgt. A value menu is displayed, and you are prompted to “Enter 
plate height”. The default PlateHgt setting is 8’-0”. For more information 
on using value menus, see “Value Menus” in “The Drawing Board” 
chapter. 

8. Use the value menu or type a height, and press (Enter). 

9. Set the rise of the roof for every one foot of run by clicking on Pitch. A 
value menu is displayed, and you are prompted to “Enter rise per foot for 
roof”. 

10. Use the value menu or type a pitch value, and press (Enter). The default 
Pitch setting is 6”. 

11. Notice that the roof thickness is drawn relative to the plate height, and 
the roof line is always drawn an additional 1/2” from the top surface of 
the rafter. To set the width of the rafters, click on RoofThck. A value menu 
is displayed, and you are prompted to “Enter the roof thickness”. 

12. Use the value menu or type a thickness, and press (Enter). The default 
RoofThck setting is 9 1/2”. 

13. Notice that the roof overhang is measured from the wall exterior framing 
surface to the back surface of the fascia. To set the length of the roof 
overhang, click on Overhang. A value menu is displayed, and you are 
prompted to “Enter the roof overhang”. 

14. Use the value menu or type a length, and press (Enter). The default 
Overhang setting is 1’-0”. 

15. Notice that the wall thickness is drawn relative to the first point you will 
select to draw the elevation. To set the wall thickness, click on WallThck. 
A value menu is displayed, and you are prompted to “Enter the wall 
thickness”. 
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16. Use the value menu or type a thickness, and press (Enter). The default 
WallThck setting is 3 1/2”. 

17. Notice that the fascia width is measured across the back surface of the 
fascia; the fascia thickness is set to 3/4” and can’t be changed. To set the 
fascia width, click on Fascia. A value menu is displayed, and you are 
prompted to “Enter the width of the fascia”. 

18. Use the value menu or type a width, and press (Enter). The default Fascia 
setting is 7 1/2”. 

19. Notice that the rake board width is measured from the roof line. To set the 
rake board width, click on Rake Brd. A value menu is displayed, and you 
are prompted to “Enter the width of the rake board”. 

20. Use the value menu or type a height, and press (Enter). The default Rake 
Brd setting is 7 1/2”. 

19. Notice that the corner board width is measured relative to the exterior 
wall line. To set the corner board width, click on CornrBrd. A value menu 
is displayed, and you are prompted to “Enter the width of the corner 
board”. 

20. Use the value menu or type a width, and press (Enter). The default 
CornrBrd setting is 5 1/2”. 

19. Notice that the thickness of the cladding is measured from the wall 
framing out to the exterior wall line. To set the cladding thickness, click 
on CladThck. A value menu is displayed, and you are prompted to “Enter 
the cladding thickness”. 

20. Use the value menu or type a thickness, and press (Enter). The default 
CladThck setting is 1 1/2”. 

19. Notice that the grade elevation is measured relative to the subfloor. To set 
the grade elevation, click on GradElev. A value menu is displayed, and 
you are prompted to “Enter sub-floor distance above the grade”. 

20. Use the value menu or type a distance, and press (Enter). The default 
GradElev setting is 2’-0”. The distance between the top surface of the 
subfloor and the bottom edge of the cladding is 1’-0” and can’t be 
changed. For best results, set the grade elevation to 1’-0” or greater. 

21. Set the color of the outside lines of the elevation by clicking on Out Colr. 
A color menu is displayed, and you are prompted to “Select outer color”. 

22. Use the color menu to set the outside line color. The default Out Colr 
setting is White. 

23. Set the color of the inside lines of the elevation by clicking on In Colr. A 
color menu is displayed, and you are prompted to “Select inner color”. 
The default In Colr setting is Red. 

24. Use the color menu to set the inside line color. 
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25. Select the two points along the top surface of the subfloor. The first point 
should be located on the outside surface of the wall framing. To select the 
first point, click in the Drawing Area, use coordinate entry, or object snap 
to a point in your drawing. You are prompted to select the other side of 
the elevation. 

26. Select the second point, click in the Drawing Area by using coordinate 
entry, or object snapping to a point in your drawing. The elevation is 
drawn, aligned with the two points you just selected. You can click on 
Defaults at any time to restore all default settings in the Exterior menu. 

Drawing Door Elevations 
Door elevations are defined by selecting two points along the subfloor line. The 
door elevation will be drawn relative to those two points, based on the Door 
menu settings. 

 To draw a door elevation: 

1. Click on EZTOOLS in the Macros pull-down menu. The EZ Tools menu is 
displayed in the Menu Window. If EZTOOLS is not listed in the Macros 
pull-down menu, click Configure in the Macros menu and add EZTOOLS 
to the Macros in Menu list. 

2. Click on Elev in the EZ Tools menu. The Elev menu is displayed in the 
Menu Window. 

3. Click on Door in the Elev menu. The Door menu is displayed in the Menu 
Window. 

4. To draw single doors, toggle Single on; to draw double doors, toggle 
Double on.  Of the two options, Single and Double, only one can be 
toggled on at any given time. The Single and Double toggles do not apply 
to Garage A, Garage B, or Sliding door styles. 

5. Set the door style for your elevation by clicking on Style. The Style menu 
is displayed in the Menu Window, and you are prompted to “Pick style of 
door to draw”. 
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Figure 18.2: Door styles available for door elevations 

6. Click on a door style in the list. You are returned to the Door menu. See 
“Door Styles for Elevations” below for details. 

 
Figure 18.3: Door elevation settings 

7. Set the head height of the door by clicking on Head Hgt. A value menu is 
displayed, and you are prompted to “Enter door head height”. 

8. Use the value menu or type a height, and press (Enter). 

9. Draw door trim in your elevation by toggling Trim on; to draw the door 
sidelight, toggle SideLght on. The Stop option is displayed. Of the two 
options, Trim and SideLght, only one can be toggled on at any given time. 
The default setting for Trim is 2 1/2”, the style for the SideLght option is 
automatically set, and the Stop option default is 3/4”. 

10. Toggle Stop on to draw the door stop if you toggled either Trim or 
SideLght on in the previous step. 
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11. Set the trim color by clicking on TrimColr. A color menu is displayed, and 
you are prompted to “Select the trim color”. 

12. Use the color menu to set the trim color. The default TrimColr setting is 
White. 

13. Set the door color by clicking on DoorColr. A color menu is displayed, 
and you are prompted to “Select the door color”. 

14. Use the color menu to set the door color. The default DoorColr setting is 
Red. 

15. Enter the first point for the door elevation. You can click in the Drawing 
Area, use coordinate entry, or object snap to a point in your drawing. You 
are prompted to enter a point for the other side of the door. 

16. Enter the second point for the door.  You can click in the Drawing Area, 
use coordinate entry, or object snap to a point in your drawing. The door 
elevation is drawn. You can click on Defaults at any time to restore all 
default settings in the Door menu. 

Door Styles for Elevations 
Flush Flush door style 
HalfLght Half light door style 
Patio Patio door style 
French French door style 
Leaded Leaded glass door style 
HalfLead Half leaded glass door style 
SixPanel Six panel door style 
Bifold Bifold door style 
Accord Accordian door style 
Vented Vented door style 
NarLtRt Door drawn with a narrow light on the right side of the door 
NarLtLft Door drawn with a narrow light on the left side of the door 
StorFrnt Storefront door style 
Garage A Garage door style, with four panels; Single and Double toggles do not apply to this 

style 
Garage B Garage door style, with four panels and four windows in the second panel from the 

top; Single and Double toggles do not apply to this style 
Sliding Sliding door style; Single and Double toggles do not apply to this style 

Drawing Window Elevations 
Window elevations are defined by selecting two points along the subfloor line. 
The window elevation will be drawn relative to those two points, based on the 
Window menu settings. 

 To draw a window elevation: 

1. Click on EZTOOLS in the Macros pull-down menu. The EZ Tools menu is 
displayed in the Menu Window. If EZTOOLS is not listed in the Macros 
pull-down menu, click Configure in the Macros menu and add EZTOOLS 
to the Macros in Menu list. 

2. Click on Elev in the EZ Tools menu. The Elev menu is displayed in the 
Menu Window. 

3. Click on Window in the Elev menu. The Window menu is displayed in 
the Menu Window. 
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4. Draw single windows by toggling Single on; draw double windows by 
toggling Double on. Of the two options, Single and Double, only one can 
be toggled on at any given time. 

5. Set the window style for your elevation by clicking on Style. The Style 
menu is displayed in the Menu Window, and you are prompted to “Pick 
style of window to draw”. The Single and Double toggles do not apply to 
the casement and sliding window styles. 

 
Figure 18.4: Window styles available for window elevations 

6. Click on a window style in the list. You are returned to the Window 
menu. See “Window Styles for Elevations” below for details. 

7. Set the head height of the window by clicking on Head Hgt. A value 
menu is displayed, and you are prompted to “Enter window head 
height”. 

8. Use the value menu or type a height, and press (Enter). 

9. Set the sill height of the window by clicking on Sill Hgt. A value menu is 
displayed, and you are prompted to “Enter window sill height”. 

10. Use the value menu or type a height, and press (Enter). 

11. Draw brick sills, capstones, or shutters with your window elevations. To 
draw brick sills, toggle BrkSillA on to draw brick sills along the bottom of 
the window, or toggle BrkSillB on to draw brick sills along the bottom 
and top of the window. To draw a bottom and top sill with a capstone, 
toggle Capstone on. To draw shutters, toggle ShutterA on to draw a single 
shutter on either side of the window, or toggle ShutterB on to draw a 
double shutter on either side of the window. To draw window elevations 
without brick sills, capstones, or shutters, click on whatever option is 
toggled on to toggle it off again. Of the five options BrkSillA, BrkSillB, 
Capstone, ShutterA, and ShutterB, only one can be toggled on at any 
given time. 
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Figure 18.5: Sill and shutter styles for window elevations 

12. Set the frame color by clicking on FramColr. A color menu is displayed, 
and you are prompted to “Select the frame color”. 

13. Use the color menu to set the frame color. The default FramColr setting is 
White. 

14. Set the window sash color by clicking on SashColr. A color menu is 
displayed, and you are prompted to “Select the sash color”. 

15. Use the color menu to set the sash color. The default SashColr setting is 
Red. 

16. Enter the first point for the window by clicking in the Drawing Area, 
using coordinate entry, or object snapping to a point in your drawing. You 
are prompted to enter a point for the other side of the window. 

17. Enter the second point for the window by clicking in the Drawing Area, 
using coordinate entry, or object snapping to a point in your drawing. The 
window elevation is drawn. You can click on Defaults at any time to 
restore all default settings in the Window menu. 

Window Styles for Elevations 
Picture Picture window style 
Pict 4x8 Picture window style with four columns and eight rows of panes 
Pct3x6 Picture window style with three columns and six rows of panes 
PictLead Picture window style with leaded glass 
DH 1/1 Double-hung window style with no panes 
DH 4/4 Double-hung window style with four panes in each window 
DH 6/6 Double-hung window style with six panes in each window 
DH 6/4 Double-hung window style with six panes in the top window and four panes in the 

bottom window 
DH 9/6 Double-hung window style with nine panes in the top window and six panes in the 

bottom window 
CasemntA Casement window style with no panes; Single and Double toggles do not apply to 

this style 
CasemntB Casement window style with three panes of equal size; Single and Double toggles do 

not apply to this style 
CasemntC Casement window style with four panes of equal size; Single and Double toggles do 

not apply to this style 
CasemntD Casement window style with three panes, with the center pane larger and the two 

side panes of equal size; Single and Double toggles do not apply to this style 
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CasemntE Casement window style with four panes, two center panes larger and of equal size 
and the two outside panes of equal size; Single and Double toggles do not apply to 
this style 

HSliderA Horizontal sliding window style with two panes of equal size; Single and Double 
toggles do not apply to this style 

HSliderB Horizontal sliding window style with three panes of equal size; Single and Double 
toggles do not apply to this style 

Drawing Cabinet Elevations 
Cabinet elevations are defined by selecting two points along the subfloor line. 
The cabinet elevation will be drawn relative to those two points, based on the 
Cabinet menu settings. 

Click on Section in the Elev menu to display the Section menu and draw cabinet 
sections. 

 To draw a cabinet elevation: 

1. Click on EZTOOLS in the Macros pull-down menu. The EZ Tools menu is 
displayed in the Menu Window. If EZTOOLS is not listed in the Macros 
pull-down menu, click Configure in the Macros menu and add EZTOOLS 
to the Macros in Menu list. 

2. Click on Elev in the EZ Tools menu. The Elev menu is displayed in the 
Menu Window. 

3. Click on Cabinet in the Elev menu. The Cabinet menu is displayed in the 
Menu Window. 

4. Draw cabinets with one door by toggling Single on; draw cabinets with 
double doors by toggling Double on. Of the two options, Single and 
Double, only one can be toggled on at any given time.  The Single and 
Double toggles to not apply to the drawer, desk, pantry, or oven cabinet 
styles. 

5. Set the cabinet style for your elevation by clicking on Style. The Style 
menu is displayed in the Menu Window, and you are prompted to “Pick 
style of cabinet to draw”. 

 
Figure 18.6: Cabinet elevation styles 
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6. Click on a cabinet style in the list. You are returned to the Cabinet menu. 
See “Cabinet Styles for Elevations” below for details. 

7. Set the wall height of the cabinet by clicking on WCab Hgt. A value menu 
is displayed, and you are prompted to “Enter wall cabinet height”. 

8. Use the value menu or type a height, and press (Enter). 

9. Set the splash height of the cabinet by clicking on SplshHgt. A value 
menu is displayed, and you are prompted to “Enter wall splash height”. 

10. Use the value menu or type a height, and press (Enter). 

11. Draw cabinet pulls on the right by toggling Pull Rt on. To draw cabinet 
pulls on the left, toggle Pull Lft on. These options only affect cabinet 
elevations when Single is toggled on in the Cabinet menu; they have no 
effect when Double is toggled on. Of the two options Pull Rt and Pull Lft, 
only one can be toggled on at any given time. 

12. Set the counter color by clicking on CntrColr. A color menu is displayed, 
and you are prompted to “Select the counter color”. 

13. Use the color menu to set the counter color. 

14. Set the cabinet color by clicking on Cab Colr. A color menu is displayed, 
and you are prompted to “Select the cabinet color”. 

15. Use the color menu to set the cabinet color. The default Cab Colr setting is 
Red. 

16. Enter the first point for the cabinet. You can click in the Drawing Area, 
use coordinate entry, or object snap to a point in your drawing. You are 
prompted to enter a point for the other side of the cabinet. 

17. Enter the second point for the cabinet. You can click in the Drawing Area, 
use coordinate entry, or object snap to a point in your drawing. The 
cabinet elevation is drawn. You can click on Defaults at any time to 
restore all default settings in the Cabinet menu. 

Cabinet Styles for Elevations 
Std Wall Standard wall cabinet style 
Std Base Standard base cabinet style 
Std Drwr Standard drawer cabinet style; Single and Double toggles do not apply to this style 
Std Sink Standard sink cabinet style 
Std Desk Standard desk cabinet style; Single and Double toggles do not apply to this style 
Van Base Vanity base cabinet style 
Van Drwr Vanity drawer cabinet style; Single and Double toggles do not apply to this style 
Van Sink Vanity sink cabinet style 
HC Wall Handicapped wall cabinet style 
HC Drwr Handicapped drawer cabinet style; Single and Double toggles do not apply to this 

style 
HC Sink Handicapped sink cabinet style 
HC Desk Handicapped desk cabinet style; Single and Double toggles do not apply to this style 
Pantry Pantry cabinet style; Single and Double toggles do not apply to this style 
Oven Oven cabinet style; Single and Double toggles do not apply to this style 
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Drawing Sections 
The Section tool gives you a quick way to create an outline section cut through 
cabinets, baths and showers. Click on Elev in the Section menu to display the 
Elev menu and draw elevations. 

 
Figre 14.6: A sample cabinet section with default settings noted 

 To draw a cabinet section: 

1. Click on EZTOOLS in the Macros pull-down menu. The EZ Tools menu is 
displayed in the Menu Window. If EZTOOLS is not listed in the Macros 
pull-down menu, click Configure in the Macros menu and add EZTOOLS 
to the Macros in Menu list. 

2. Click on Section in the EZ Tools menu. The Section menu is displayed in 
the Menu Window. 

3. Click on Cabinet in the Section menu. The Cabinet menu is displayed in 
the Menu Window. 

4. Set the cabinet style for your section by clicking on Style. The Style menu 
is displayed in the Menu Window, and you are prompted to “Select the 
type of section to draw”. See “Cabinet Styles for Sections” below for 
details. 

5. Click on a style in the list. You are returned to the Cabinet menu. 

6. Set the soffit height of the cabinet by clicking on Soff Hgt. A value menu is 
displayed, and you are prompted to “Enter soffit height”. 

7. Use the value menu or type a height, and press (Enter). 

8. Set the wall elevation of the cabinet by clicking on WCabElev. A value 
menu is displayed, and you are prompted to “Enter wall cabinet 
elevation”. 

9. Use the value menu or type a value, and press (Enter). 

10. Set the wall height of the cabinet by clicking on WCab Hgt. A value menu 
is displayed, and you are prompted to “Enter wall cabinet height”. 

11. Use the value menu or type a height, and press (Enter). 

12. Set the back-splash height of the cabinet by clicking on SplshHgt. A value 
menu is displayed, and you are prompted to “Enter back-splash height”. 
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13. Use the value menu or type a height, and press (Enter). 

14. Set the section color by clicking on SectColr. A color menu is displayed, 
and you are prompted to “Select the section color”. 

15. Use the color menu to set the section color. The default SectColr setting is 
White. 

16. Set the element color (for bathtubs and showers) by clicking on ElemColr. 
A color menu is displayed, and you are prompted to “Select the element 
color”. 

17. Use the color menu to set the element color. The default ElemColr setting 
is Red. 

18. Enter the first point for the cabinet section. You can click in the Drawing 
Area, use coordinate entry, or object snap to a point in your drawing. You 
are prompted to enter a point for the other side of the section. 

19. Enter the second point for the cabinet section. You can click in the 
Drawing Area, use coordinate entry, or object snap to a point in your 
drawing. The cabinet section is drawn. You can click on Defaults at any 
time to restore all default settings in the Cabinet menu. 

Cabinet Styles for Sections 
Standard Standard cabinet style 
HandiCap Handicapped cabinet style 
Vanity Vanity cabinet style 
PassThru Pass-through cabinet style 
BarTop Bar top style 
Bathtub Bathtub style 
Shower Shower style 
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Printing Your Drawing 
Printing in DataCAD offers you many different options, so you 
can always get the result you need. You can set the plotting 
scale for your drawing, customize pen widths for plotting, and 
assign colors and weights to different plotter pens. You can plot 
your drawing, or a part of it, using a quick layout; or you can 
place multiple details on a single sheet using multi-scale layout. 
DataCAD’s print preview allows you to visually check your 
plot before you send it to your plotter, or you can do a quick 
check plot to make sure your final plot will be correct. You can 
even choose to print a single sheet that you’ve set up, or you 
can define and then plot several sheets at once. 

19 
In this chapter: 

 Assigning colors and 
plotter pen widths 

 Laying out your drawing 
on sheets 

 Previewing your print 

 Checking your print 

 Printing details and 
drawings 

 Batch plotting 
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Printing Basics 
The first time you print a drawing, you need to set several printing options, 
including the printer or plotter you’ll use, the paper size and orientation, and the 
layout orientation of the drawing. These settings become part of your drawing 
when you save the file and will be remembered the next time you print the 
drawing. You can always change these settings by simply using the Print Setup 
option in the File pull-down menu. 

 To print a drawing: 

1. Decide if you want to print the text, dimensions, hatching, and line 
weights in your drawing. If you do, make sure ShowTxt, ShowDim, 
ShowHtch, and ShowWgt, respectively, are toggled on in the 
Utility/Display menu. Keep in mind that your drawing will print as it’s 
displayed. 

2. Click on Print in the File pull-down menu, or click on Plotter in the Utility 
menu in the Menu Window. Depending on whether you’ve printed this 
drawing before or not, one of two things may happen now: 

• If you’ve printed this drawing before, the Plotter menu is displayed in the 
Menu Window. Click on Setup in the Plotter menu to display the 
Printer/Plotter Settings dialog box. 

• If this is the first time you’ve printed this drawing, you are prompted 
with “A printer has not been selected for this drawing. Please click OK to 
open the Print Setup dialog box and assign a printer to this drawing file.” 
Click on OK to close the message box and display the Printer/Plotter 
Settings dialog box. 

3. In the Printer section at the top of the dialog box, use the Name drop-
down box to select the printer you’d like to use. 

4. Go to the Paper section of the dialog box and use the Size drop-down box 
to select a paper size. The paper sizes available in the Size drop-down box 
are read from your printer driver. If a size you want is not listed, then 
your printer doesn’t support it or the driver may not be configured to 
display it. You can change the driver properties by closing DataCAD and 
opening the Printers dialog box from the Control Panel in Windows. 
Choose the next closest appropriate size, select User-Defined if listed, or 
use a different printer. 

Notice that the Effective Plotting Area dimensions, displayed directly 
below the Size drop-down box, change depending on the Size of paper 
you choose. The effective plotting area is the printable area for the paper 
size you’ve selected, as defined by the printer manufacturer’s driver. Any 
part of the drawing extending outside this area will not be printed (see 
Figure 19.1). 
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Some printer drivers, such as LaserJets and older plotters, don’t support 
user-defined paper sizes, even though that option remains listed in the 
Size drop-down box. One way to check is to select User-Defined for the 
paper size, and enter a width and length for the paper size. If the Effective 
Plotting Area dimensions don’t change based on the size dimensions, 
then the selected printer’s driver doesn’t support user-defined paper 
sizes. Select another paper size from the drop-down box. 

Limits of 24”x36” sheet

Effective plotting area, as reported by Windows driver in
print set-up for the selected printer (23.6”x34.66”)

Limits of drawing must be within effective plotting area

Non-printing region  
Figure 19.1: Example of printed sheet showing the edges of the sheet, the non-printing area, 
the effective plotting area, and the extents of the drawing 

5. Set the orientation for your printed sheet by clicking on Normal or 
Rotated. 

6. Go to the Copies section at the bottom of the dialog box and enter the 
number of copies of each sheet you’d like to print. 

7. Go to the DataCAD Layout Orientation section at the bottom of the dialog 
box. Click on Normal to print the sheet as it appears on screen or click on 
Rotated to rotate the sheet 90° for plotting. The Rotated option in the 
DataCAD Layout Orientation section rotates the geometry for the print 
only; it does not rotate the drawing itself. 

8. Click OK to close the Printer/Plotter Settings dialog box. The Plotter 
menu is displayed in the Menu Window. 

9. Change the plotting scale by clicking on Scale. A value menu is displayed, 
and you are prompted to “Enter new scale”. 

10. Use the value menu to select a new scale, and press (Enter). 
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11. Determine if you have lines in your drawing with a line weight above 
“1.” If so, you can change the amount of space between pen passes when 
printing these thicker lines (see Figure 19.2). Click on PenWidth in the 
Plotter menu, and use the value menu to enter a width. 

  
Figure 19.2: Lines drawn with a line weight of 4 and printed with a pen width setting of 12 (left) 
and 95 (right) 

12. Use Pen Table to assign each pen in your plotter to a line color in your 
drawing, as well as to set the width and color density for each pen. To 
change Pen Table settings, click on PenTable in the Plotter menu; the Pen 
Table dialog box is displayed. Change the settings as necessary and click 
on OK. See “Using Pen Tables” later in this chapter for more information. 

13. Plot your drawing or detail at a rotation angle by clicking on Rotate in the 
Plotter menu. Depending on the plotting history for this drawing, one of 
two things may happen: 

• If you haven’t plotted this drawing before, or if you used the QwkLyout 
option the last time you plotted it, you are prompted to “Select center of 
rotation”. Click in the Drawing Area to enter the center of rotation for 
your plot. You are prompted to “Enter angle of rotation”. 

• If you used the MltLyout option the last time you plotted the drawing, 
you are prompted to “Enter angle of rotation”. 

14. Use the value menu or type an angle, and press (Enter).  

15. Lay out your drawing on a sheet by using the QwkLyout option; lay out 
multiple details on a sheet by using the MltLyout option. See “Laying Out 
Your Drawing” later in this chapter for more information on using the 
QwkLyout and MltLyout options. 

16. Toggle Preview on to preview your plot before you actually send it to the 
plotter; toggle Preview off to skip the preview and send the sheet directly 
to the plotter. (The Preview toggle can only be used with the Plot and 
Partial options in the Plotter menu. See “More About Previewing Your 
Plot” below for details.) 

17. Plot the sheet using one of the following: 

• To plot the sheet, click on Plot in the Plotter menu. If you toggled Preview 
off in the previous step, the sheet is plotted; if you toggled Preview on, 
the DataCAD Plot Previewer window opens, allowing you to preview the 
plot before sending it to your plotter. To interrupt a plot in progress, press 
(End). 

• To plot the sheet to a file, click on ToFile in the Plotter menu. A dialog box 
is displayed. Enter a filename for your plot (.PLT) file and click on Save. 
Plot files are saved by default in your DATACAD\PLT folder. 
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• To plot only a part of your drawing, click on Partial. Choose a selection 
method from the Partial menu and then select the part of your drawing 
you want plotted. If you toggled Preview off in the previous step, the 
selection is plotted; if you toggled Preview on, the DataCAD Plot 
Previewer window opens, allowing you to preview the selection before 
sending it to your plotter. 

More About Previewing Your Plot 

Previewing a plotting sheet before actually printing it allows you to verify that 
you’re using the proper paper size and plotting scale, that your drawing is 
positioned properly, and that such things as hatching, dimensions, and line 
overshoot are displayed as you want them. From the DataCAD Plot Previewer 
window, you can change the view of your preview and then plot, copy, or save it. 

 

 

 

 
 
 

 

Click on Copy to copy an image of the preview to 
the Windows clipboard. Then paste it into another 
Windows application. 

Click on Save As to save an image of the preview as a PDF file or a metafile. 
In the Save As dialog box, select either Adobe Acrobat File (.PDF) or Windows 
Enhanced Metafile (.EMF) from the Save as Type list box, type a name for the 
file, and click on Save. 

Click on Zoom In, Zoom Out, and Full Page to view the 
preview at different levels of detail. You can also simply 
click on the preview to zoom in or press (Ctrl) or (Shift) and 
click to zoom out. 

Click on Plot to plot your drawing, 
just as it’s displayed in the Plot 
Previewer window. 

Click on Close to 
close the Plot 
Previewer window, 
without actually 
plotting your 
preview, and 
return to your 
drawing. 

Figure 19.3: The DataCAD Plot Previewer window 

Printing a Check Plot 
You can also use check plots; this allows you to do a quick test print to your laser 
printer before sending the file to your plotter. Check plots use separate settings 
for the printer, paper size, and paper orientation you designated. 

 To do a check plot: 

1. Click on Setup in the Plotter menu. The Printer/Plotter Settings dialog 
box is displayed. 

2. Go to the Check Plot section and click on Fit To to fit the drawing to a 
single page, or click on Use This Factor to scale your drawing to a 
particular size for the check plot. Notice that all the settings above the 
Check Plot section are now grayed back and the settings in the Check Plot 
section are now available. The FitTo option scales a previously defined 
layout to fit on the selected paper size. It does not automatically scale 
your drawing to fit on a defined paper size. 
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3. Select a printer or plotter to use from the drop-down box under the To 
This Printer label. 

4. Select Fit To if necessary. Choose a page size from the drop-down box; if 
you selected Use This Factor, enter a percentage to scale the drawing for 
the check plot. If you use the Use This Factor option, your drawing and 
pen widths (as set in the Pen Table) are scaled. 

5. Select Normal or Rotated paper orientation. This setting works exactly 
like the one described in “Printing Basics”. 

6. Click on OK to close the Printer/Plotter Settings dialog box. 

7. Continue with step 9 in the instructions under “Printing Basics” earlier in 
this chapter. 

Using Pen Tables 
Using pen tables will allow you to print the lines in your drawing in different 
colors than you drew them, in greyscale, or in black -– or all of these in a single 
print! 

 
Figure 19.4: In the Pen Assignments list box on the left, lines drawn in Lt Blue are assigned to 
pen number 7. In the Pen Settings table on the right, pen number 7 has been set to plot at 
.6mm width and at 100% density (full color) in a grey color. 

 To use a pen table: 

1. Click on PenTable in the Plotter menu. 

2. Go to the Pen Assignments list box and click on the color you want to 
assign to a pen. The color and its name are displayed beneath the list box, 
along with the pen number that color is currently assigned to. 

3. Type the pen number you want to assign to that color. The pen 
assignment is changed in the list. 

4. Repeat steps 2 – 3 to continue changing pen assignments as necessary. 

To print lines in your drawing in a specific color 
and width, first assign a pen number to the on-
screen line color in the Pen Assignments list box. 

Next, set the desired width, density, and printed 
color for that pen number in the Pen Settings 
table. 

Checking the Map to Color box prompts you to 
select a printed color for the pen. The color 
you select will be displayed in the color swatch 
beside the checkbox. 

If the Map to Color box is not checked, the pen 
number will print in the on-screen color. 

Check All Black to override the above color 
settings and print all pens in black. 
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5. Go to the Pen Settings section. Enter the pen width and color density for 
each pen that you assigned a color to.  

The Percent Density setting allows you to print screened colors. A setting 
of 100% prints full color; entering a lesser percentage prints a screened 
color. This setting works only with printers that accept RGB color 
definitions. A LaserJet IV, for instance, can print shades of grey using 
screened black, but a LaserJet III can only print black. 

The Percent Density and Map to Color settings are used only for color 
and greyscale printing, so they are only available when All Black is 
unchecked. 

6. Print lines in your drawing in a different color than they are on screen by 
checking the Map to Color box for the pen assigned to the color you used 
in your drawing. A color dialog box is displayed. 

7. Select the color you’d like to print and click on OK. The new color is 
displayed next to the Map to Color checkbox. The Map to Color 
checkboxes only affect printing; they don’t change entity colors in your 
drawing 

8. Print all lines in black, regardless of what color they are on screen or what 
settings are entered in the rest of the pen table, by checking the All Black 
option at the bottom of the Pen Table dialog box. 

9. Click on OK to save the changes you made to the pen table. 

More About Using Pen Tables 

Following are some examples of how pen table settings affect plotting: 

• If you set the Width for Pen 1 to .25 and the Percent Density to 20% and leave 
Map to Color unchecked, all lines printed with Pen 1 will be printed .25mm 
wide in 20% of their full color (i.e., with a 20% color screen). Full color is a 
color at 100% density. 

• You can produce heavy text on a print by drawing all text in a specific color, 
and then mapping that color to a thicker pen using the Pen Table dialog box. 

• To print in gray scale, check the Map to Color option for any pen you’d like 
to print as gray scale. The Windows Color dialog box is displayed. Since 
black is chosen by default, click on OK to accept black as the color mapped to 
that pen. Then set the Percent Density option: to print a half-toned black 
color, for instance, change Percent Density to 50%. Some black and white 
printers will automatically produce greyscale print when Map to Color and 
All Black are left unchecked. 

• To print lines in a different color than they are on screen, click on the Map to 
Color checkbox. Select a color from the Windows Color dialog box; black is 
selected by default. Click on OK. All lines using that pen will be reprinted in 
the selected color, regardless of their color on the screen. The Map to Color 
options only affect printing; the actual colors of the entities aren’t changed. 
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Saving and Using Pen Table Settings 
You can save a lot of time when setting up to plot your drawings if you save your 
Pen Table settings in a .PEN file. You can then quickly load those settings when 
you want to use them, instead of having to change all the Pen Table settings each 
time you print.  

The name of the Pen Table file used in a drawing is always saved in that 
drawing. The default Pen Table file is DCADWIN.PEN, located in your 
DATACAD\SUP folder. 

 To save pen table settings: 

1. Click on PenTable in the Plotter menu. The Pen Table dialog box is 
displayed. 

2. Change the settings as necessary. 

3. Click on Save As in the Pen Table dialog box. Another dialog box is 
displayed, prompting you to “Save pen file as . . .”. 

4. Type a name for the Pen Table settings file and click on Save. The dialog 
box closes. 

5. Click on OK in the Pen Table dialog box to close it. 

 To use pen table settings that you’ve saved in a .PEN file: 

1. Click on PenTable in the Plotter menu. The Pen Table dialog box is 
displayed. 

2. Click on Load in the Pen Table dialog box. Another dialog box is 
displayed, prompting you to “Load pen file”. 

3. Click on the pen file you want to use, and click on Open. The dialog box 
closes, and the settings are loaded into the Pen Table dialog box. 

4. Click on OK in the Pen Table dialog box to close it. 

Laying Out Your Drawing 
You have two options for defining plot sheets. You can quickly lay out your 
drawing at a single scale on a sheet, or you can place multiple details at different 
scales on a single sheet. Whenever you change Plotter menu settings, make sure 
you check the layouts you’ve already set up before plotting. 

Using Quick Layout 
As its name implies, quick layout is meant to be a fast, simple way to print all or 
part of your drawing on a single sheet. 

 To quickly lay out your drawing for plotting at a single scale: 

• 1. Click on QwkLyout in the Plotter menu. Notice that a grid 
representing the plotting area of the selected paper size is now attached to 
your cursor. (A dashed grid may also be displayed, representing the last 
defined quick layout.) 
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• 2. Position the grid over your drawing, so that the part you want to 
print is inside the grid. If your drawing is too large or small for the grid, 
exit the Layout menu and change the plotting scale; repeat steps 1 – 2. 

• 3. Position the grid as you want it and click. The layout is defined, 
and you can continue with the plotting instructions given in “Printing 
Basics” earlier in this chapter. 

Using Multi-Scale Layout 
Multi-scale layout lets you place multiple details, each at any scale, on a single 
sheet. You can define up to 256 multi-scale sheets for plotting. Sheets can be 
renamed as well as have their contents deleted. See “More About Editing Details 
and Sheets” below for details. 

Multi-scale plotting can be used with go-to-views to lay out multiple floors of a 
building on a single sheet. Toggle only layers for the first floor on and then save 
this view using the GotoView option in the View pull-down menu. Repeat for 
additional floors. Then place each go-to-view on the sheet using multi-scale 
plotting. See “Tutorial: Printing a Drawing” for an example of how to use go-to-
views and multi-scale plotting together. 

 To use multi-scale layout: 

1. Click on MltLyout in the Plotter menu. The MltLyout menu is displayed. 

2. Make sure ShowAll is toggled on to display all details already on the 
sheet while you’re placing additional details. 

3. Select the sheet you want to work on. Click on Sheet in the MltLyout 
menu. A list of plotting sheets, along with a few other options, is 
displayed in the Menu Window. 

4. Click on the sheet you want to work on, keeping in mind you can click on 
ScrlFwrd and ScrlBack to scroll through all 256 sheets available to you. 

5. Right-click to return to the MltLyout menu. 

6. Now you can define how you’d like to set up your sheet layout. Click on 
LyoutSet in the MltLyout menu. The LyoutSet menu is displayed. 

• Set the number of divisions for the sheet by clicking on LyoutDiv in the 
LyoutSet menu. A value menu is displayed, and you are prompted to 
“Enter X-divisions for layout sheet.” Use the value menu or type a 
number, and press (Enter). A value menu is displayed, and you are 
prompted to “Enter Y-divisions for layout sheet.” Use the value menu or 
type a number, and press (Enter). You are returned to the LyoutSet menu. 

• Toggle AutoCalc on in the LyoutSet menu to have DataCAD 
automatically recalculate the extents of a detail before you place it on the 
sheet.  If this option is toggled off, you may need to use the ReCalc option 
for the layout box to accurately represent the extents of the detail. 

• Toggle Extents on in the LyoutSet menu to display only the extents of 
details already on the sheet. This reduces refresh time when you’re 
working on a sheet with several details on it. Toggle Extents off to display 
the details. 
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• Toggle Snap2Div on to make the cursor snap to the intersection of 
divisions you defined by clicking LyoutDiv. 

• Toggle on either GridLins or GridMrks. These are mutually exclusive 
toggles. GridLns uses dashed lines to represent the layout grid; GridMrks 
displays only the corner marks. 

• Toggle on either CC Exts or EntExts. These are mutually exclusive 
toggles. When you toggle on  CC Exts (clip cube extents), the layout box 
will reflect the extents of the clip cube (which may not correspond with 
the extents of the entities contained within it). If you toggle on EntExts 
(entity extents), the Layout box will reflect the extents of the entities 
(which may not correspond with the extents of the clip cube surrounding 
them). 

7. Right-click to return to the MltLyout menu. 

8. Begin placing details on the sheet. You can place the current view of your 
drawing or select a go-to-view that you’ve defined. 

• To place the current view of your drawing, click on Layout in the 
MltLyout menu. Notice that a box representing the extents of the current 
view is now attached to your cursor.  

• To change a plot layout setting, click on LyoutSet in the MltLyout menu. 

If you select Layout, you can use InsPoint to select or snap to a specific point 
within the drawing. This becomes the insertion point for the detail. If you select 
Layout, you can toggle Snap2Div on so the detail can be snapped to the 
intersection you defined with LyoutDiv. You can also change the “handle” to 
position a multi-scale plotting detail on the fly by using the arrow keys during 
layout. If you select LyoutSet, you can use AutoCalc and Extents options as well 
as Snap2Div. Both Layout and LyoutSet let you set the mutually exclusive 
toggles GridLins or GridMrks as well as CC Exts or EntExts. 

• To place a go-to-view you’ve defined, click on GotoView in the MltLyout 
menu. A list of your go-to-views is displayed in the Menu Window. Click 
on the go-to-view you want to place on the sheet. Notice that a box 
representing the extents of the go-to-view is now attached to your cursor.  

Shortcut: To save go-to-views, click on either 3DViews in the Plotter menu or on 
the “V” in the Navigation pad to quickly access the 3DViews menu and then the 
GotoView menu. 

9. Press (PageUp) or (PageDown) to dynamically scale the detail, then click on 
the sheet to place the detail. You are prompted to “Enter name of new 
detail”.  

10. Type a name for the detail and press (Enter). If you’re placing go-to-views, 
you can add another go-to-view or right-click to return to the MltLyout 
menu. 

11. Right-click to return to the Plotter menu and plot your sheets. 

More About Editing Details and Sheets 

You can make changes to sheets and the individual details on them.  
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 To rename a sheet: 

1. Click on Sheet in the MltLyout menu. 

2. Click on Rename. The Name menu is displayed, and you are prompted to 
“Select sheet to rename”. 

3. Click on the sheet in the list that you want to rename. You are prompted 
to “Enter new name”. 

4. Type a new name for the sheet and press (Enter). The sheet name is 
changed in the list. 

 To erase all details on a sheet: 

1. Click on Sheet in the MltLyout menu. 

2. Click on Clear. You are prompted to “Select sheet to clear”. 

Warning: You cannot undo clearing a sheet. Be certain you’re clearing the 
correct sheet. 

3. Click on the sheet in the list that you want to clear. You are prompted 
with “Are you sure you wish to clear ‘[sheet name]’”. 

4. Click on Yes to clear the sheet; click on No to cancel. 

 To erase only selected details from a sheet: 

1. Click on Details in the MltLyout menu. The Details menu is displayed in 
the Menu Window. 

2. Click on Delete in the Details menu. You are prompted to “Select detail to 
delete from list”. 

3. Go to the Menu Window and click on the detail you want to delete. It’s 
removed from the list and from the sheet. 

 To move a detail on a sheet: 

1. Go to the MltLyout menu, click on the name of the detail you want to 
move. Notice as you move your cursor over the Drawing Area, a box 
representing the extents of the detail is now attached to your cursor. 

2. Press (PageUp) or (PageDown) to dynamically scale the detail. Then click on 
the sheet to place the detail on the sheet. 

 To update a detail with your drawing’s current layer settings: 

1. Click on Details in the MltLyout menu. The Details menu is displayed in 
the Menu Window. 

2. Click on Update in the Details menu. You are prompted to “Select detail 
to update from list”. 

3. Click on the detail you want to update. The detail is redrawn with your 
current layer settings. 
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 To toggle layers on or off in a detail: 

1. Click on Details in the MltLyout menu. The Details menu is displayed in 
the Menu Window. 

2. Click on LyrTogl in the Details menu. You are prompted to “Select the 
detail to toggle layers on and off”. 

3. Click on the detail you want to change. The layers used in that detail are 
displayed in the Menu Window. 

4. Click on layers to toggle them on or off, as necessary. The detail is 
updated on the sheet as you toggle layers on and off. 

5. Right-click three times to return to the MltLyout menu. 

 To change the current view of your drawing to match a detail: 

1. Click on Details in the MltLyout menu. The Details menu is displayed in 
the Menu Window. 

2. Click on MakeCurr in the Details menu. You are prompted to “Select the 
detail you wish to use as the current view”. 

3. Click on the detail you want to use. You are returned to the Utility menu, 
and the view of your drawing is changed. 

Batch Plotting 
You can batch plot details, multi-layout sheets, and go-to-views from one 
drawing or from multiple drawings, all at once. Batch plotting your drawings 
can save your office a lot of time; instead of waiting for each drawing to finish 
printing before you print others, you can batch plot everything at once. You can 
set up a batch plot for multiple drawings and plot them all overnight, thereby 
freeing up valuable time during regular office hours. It isn’t possible to batch plot 
in a background mode, so you must wait until the batch plotting process is 
complete before continuing your work in DataCAD. 

See “Printing Basics”, “Using Pen Tables”, and “Laying Out Your Drawing” 
earlier in this chapter for details. Keep in mind that all go-to-views that are batch 
plotted will use the same quick layout that you set up using the QwkLyout 
option in the Plotter menu. Using multi-layout sheets is recommended for 
greatest control over your plotting results. 

 To batch plot from a single drawing: 

1. Set up details, multi-layout sheets, and go-to-views and change other 
Plotter menu settings as necessary.  

2. Click on BatchPlt in the Plotter menu. The DataCAD Batch Plotting Setup 
dialog box is displayed. 
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Figure 19.5: The Batch Plotting Setup dialog box 

3. Notice that the list box in the Batch Plotting Setup dialog box lists any 
quick layouts, go-to-views, and multi-layout sheets that you’ve defined 
for the drawing. To choose the views and layouts to plot, click in the 
checkbox beside the view or layout. A white box indicates that view will 
not be plotted; a black box indicates that view will be plotted. If the 
checkbox beside the Go-To-Views or Multi-Layout Sheets folders is half 
white and half black, some of the views or sheets will be printed but not 
all of them. Click the Clear All button to uncheck all boxes. 

4. Go to the Copies input box at the top of the dialog box. Enter the number 
of copies of each layout you want to plot. 

5. Go to the top of the dialog box. Check the Plot to File(s) option to plot 
each selected layout to a file, instead of sending them directly to your 
plotter. These plot files will be saved to your DATACAD\PLT folder, with 
the following filenames:  

Go-to-views:  “go-to-view” viewname.PLT 

Quick layout:  drawing name – “quick layout”.PLT 

Multi-layout sheets: drawing name – “sheet” sheetname.PLT 

6. Go to the top of the dialog box. Check the Append Results to Log File 
option to copy details of the plotting process and results to a file called 
BATCHPLOT.LOG in your DATACAD\PLT folder. Normally, each 
DataCAD station that batch plots will have a separate BATCHPLOT.LOG 
file. However, if you set each DataCAD station to a shared network folder 
for plot files (.PLT) and .LOG files, then all plot results will be appended 
in a single .LOG file. 
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7. Go to the bottom of the dialog box. Check the Skip Screen Redraws 
option to speed up the plotting process. Checking this option skips 
displaying each drawing or view as it is opened; you simply won't see 
each view or layout displayed as it is plotted. 

8. Click on Plot to begin plotting; click on OK to save these plot settings for 
plotting later (see instructions below for batch plotting from multiple 
drawings); or click on Cancel to cancel the batch plot settings and close 
the dialog box. 

 To batch plot from multiple drawings: 

1. Complete steps 1 – 7 in the instructions above (batch plotting from a 
single drawing) for each drawing you’d like to include in the multiple-
drawing batch plot. Click on OK in step 8 to simply save the plot settings. 

2. Click on Close All in the File pull-down menu to close all drawings. Make 
sure you click Yes to save changes for each file. 

3. Click on Batch Plot in the File pull-down menu. The DataCAD Batch 
Plotting Setup dialog box is displayed. 

 
Figure 19.6: The Batch Plotting dialog box; notice the differences between this one and Figure 
19.5 

4. Click on Add to open the dialog box to select the drawings you want to 
batch plot. After you add drawings to the Batch Plotting Setup list box, 
you can save the group of drawings as a Project Set File (.SET); simply 
click on Save As, type a name for the .SET file, and click on Save.  In 
subsequent batch plotting sessions, you can load a .SET file to quickly 
plot sets of drawings that are commonly plotted together, without having 
to add them to the Batch Plotting Setup list box each time. 
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5. Select the drawings that you set up for batch plotting in step 1, and click 
on Open. The dialog box closes and the drawing names and paths are 
displayed in the list box in the DataCAD Batch Plotting Setup dialog box. 
To remove a drawing from the list, select it and click on Remove. Click on 
Clear All to remove all drawings listed. 

6. Enter the number of copies to be plotted. This setting overrides the 
number of copies setting that you entered in the Batch Plotting dialog box 
for each individual drawing. 

7. Plot each drawing to a file instead of sending them directly to your 
plotter, check the Plot to File(s) option at the top of the dialog box. These 
plot files will be saved to your DATACAD\PLT folder, with the filename: 
drawing name – “sheet” sheetname.PLT. This setting overrides the Plot to 
File setting in each individual drawing. 

8. Go to the top of the dialog box and check the Append Results to Log File 
option to copy details of the plotting process and results to a file called 
BATCHPLOT.LOG in your DataCAD\PLT folder. Normally, each 
DataCAD station that batch plots will have a separate BATCHPLOT.LOG 
file. However, if you set each DataCAD station to a shared network folder 
for plot files (.PLT) and .LOG files, then all plot results will be appended 
in a single .LOG file. 

9. Go to the bottom of the dialog box and check the Skip Screen Redraws 
option to speed up the plotting process. Checking this option skips 
displaying each drawing or view as it is opened; you simply won't see 
each view or layout displayed as it is plotted. 

10. Go to the bottom of the dialog box and check the Ignore Autosave and 
‘File in Use’ Conditions option. This setting lets DataCAD ignore 
autosave and in use messages that would normally interrupt batch 
plotting. 

11. Click on Plot to begin plotting; click on OK to save these plotting settings 
for plotting later; or click on Cancel to cancel the batch plot settings and 
close the dialog box.  

Printer selection and batch plot settings are stored in each drawing, so you could 
batch plot each drawing to a different printer. 

 To batch plot drawings to Adobe Acrobat’s PDF format: 

1. Check Plot to Files in the Batch Plotting Setup dialog box (see Figure19.5). 

2. Set the File Format to PDF. 

Larger firms may want to develop customized batch plotting routines using an 
enhanced scripting language. For more information about how to do this, contact 
DataCAD Technical Support. 

 

 





Modeling Basics 
DataCAD has a comprehensive set of 3D modeling tools, which 
can be used to complement the 2D tools. Since DataCAD is a 
true 3D modeling program, 2D and 3D data can coexist in the 
same drawing, allowing the user to combine the flexibility and 
strengths of each method. For example, you can develop a 2D 
drawing that can then be used to construct a 3D profile or 
perhaps a surface of revolution. 

20 
In this chapter: 

 Z-base and Z-height 

 The zero plane 

 Changing 3D settings 

 Drawing 3D lines 

 3D snapping 

 Using markers 
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Z-Base and Z-Height 
After using DataCAD as a 2D drafting tool, you’re probably familiar with the 
concept of Z-base and Z-height as the “floor” and “ceiling” of entities you draw. 
When you use the 3D modeling tools in DataCAD, however, Z-base and Z-height 
no longer have to be floor and ceiling values. Instead, they’re measured from the 
zero plane. Normally, the zero plane is parallel to the floor of your model; so in 
plan view, positive values for Z-base and Z-height extend toward you (out of the 
screen) while negative Z values extend away from you (into the screen). See “The 
Zero Plane” below for more information. 

Z-base doesn’t have to be at a lower elevation than Z-height, although you may 
find it easier to use them this way. Keep in mind, however, that entities are 
always constructed from Z-base to Z-height. 

Most 3D entities have some kind of thickness associated with them; for instance, 
slabs have thickness while cylinders and cones have height. Because you can 
place the zero plane, Z-base, and Z-height in any spatial orientation with respect 
to your model, DataCAD can use the Z-base and Z-height settings to determine 
the thickness or height of a 3D entity. They can represent the front and back walls 
of a building, the sides of a bookcase, or any other two values that, taken 
together, create a depth to a drawing object.  

In addition to Z-base and Z-height, you can use two auxiliary Z elevations as 
well: Z-User1 and Z-User2. These elevations are two extra planes in space, placed 
somewhere between Z-base and Z-height, that can be useful for creating 3D 
entities. 

The Zero Plane 
The zero plane is the plane in your model where Z=0. In plan view, the zero plane 
is fixed at the ground plane; however, in other views, you can change its position 
in relation to your model. It is important to note that, regardless of how its 
position changes relative to your model, the zero plane is always parallel to the 
screen. When you change its position, the zero plane doesn’t change in relation to your 
screen; rather it changes in relation to your model. So when you change views of your 
model, you can use the following methods to change the orientation of the zero 
plane as well: 

• Change the view of your model to orthographic (plan) view. The zero plane is 
changed to equal the ground plane. This method is best used when changes 
to your model can be made in plan view. Keep in mind that the model is 
temporarily displayed in plan view when you define a new elevation. 

• Create a new elevation (click on New in the View/Elevation pull-down 
menu). The zero plane is changed to equal the elevation plane. This method 
is best used when changes to your model can be made in elevation view. 

• Change the view of your model to a parallel view; this is often an elevation 
but you can use any parallel view. Use EditPlne in the 3DViews menu to 
change the orientation of the zero plane. See “More About the Zero Plane” 
below for more information on using the EditPlne and PlneSnap options. 
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• Change the view of your model to an isometric or similar view. Using 
PlneSnap in the 3DViews menu, change the orientation of the zero plane by 
selecting three points on the plane, such as the corners of a slab. This method 
is useful when you want to change the zero plane to match the plane of a roof 
or something similar. 

• Using the Controls option in the 3DViews menu, change the view of your 
model to any parallel view. The zero plane is changed so that it passes 
through the view center. 

More About Positioning the Zero Plane 

As described above, you can use both EditPlne and PlneSnap to position the zero 
plane. Following are specific instructions on using both options. 

 To position the zero plane using EditPlne: 

1. Change to a parallel view that will allow you to draw a line indicating 
where you want the zero plane to be. This parallel view is usually an 
elevation of some kind. 

2. Click on DCAD 3D in the Edit menu in the Menu Window. The 3DEdit 
menu is displayed. 

3. Click on 3DViews in the 3DEdit menu. The 3DViews menu is displayed. 

4. Click on EditPlne in the 3DViews menu. The EditPlne menu is displayed. 

5. Notice that a new view center is created when you define a new zero 
plane. To set the Z coordinate (or height) of the view center, click on 
CenterZ in the EditPlne menu, enter a Z value, and press (Enter). You are 
prompted to “Select a point on the edit plane”. The CenterZ setting 
automatically reverts back to its default of 5’-0” after you finish defining 
the new zero plane. 

6. Click in the Drawing Area or use coordinate entry to enter the first point 
of the new zero plane. This point will also be the new view center. The 
cursor changes to a New Elevation Indicator, and you are prompted to 
“Indicate the direction of the edit plane”. See “More About the New 
Elevation Indicator Cursor” in the “Viewing Your Model” chapter. 

7. Click in the Drawing Area or use coordinate entry to enter the second 
point of the new zero plane. The view is changed based on the plane you 
just defined. 

8. Save this new view. Click on AddView in the EditPlne menu, type a name 
for the view, and press (Enter). The view is added to your go-to-view list. 
Keep in mind that view names can include up to eight characters but no 
spaces. If your model moves off screen, click Reset in the EditPlne menu. 
The view is changed back to the most recent plan view. 

There are a few rules when using PlneSnap that you should be aware of before 
you begin: 

• When you select the three plane-defining points, be sure you snap to them in 
a clockwise direction. 
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• The first two points you snap to will align with the bottom of the screen in 
the new view; be sure to select the points in such a way that the new view 
will make sense to you. Keep in mind that if the new view is not what you 
wanted, you can always click on Reset in the PlneSnap menu to revert back to 
your original view. 

In the following example, we need to place a skylight in the roof. To do this, we 
must first reposition the zero plane so it matches the plane of the roof. The easiest 
method for doing this is to use PlneSnap to simply snap to three points of the 
roof. 

Remembering to work in a clockwise direction, we snap to the first two points 
along the bottom edge of the roof, rather than along the side. This bottom edge of 
the roof is aligned with the bottom of the screen, making it easy for us to orient 
ourselves to the new view, shown on the right of the example below. 

1

2

3

Clockwise

This edge will align with the bottom of the screen.

12

3

 
Figure 20.1: An example of effectively using PlneSnap to define a new zero plane 

 To position the zero plane using PlneSnap: 

1. Change to a parallel view that will gives you easy access to three points 
that lie on the plane that will be the new zero plane.  

2. Click on DCAD 3D in the Edit menu in the Menu Window. The 3DEdit 
menu is displayed. 

3. Click on 3DViews in the 3DEdit menu. The 3DViews menu is displayed. 

4. Click on PlneSnap in the 3DViews menu. The PlneSnap menu is 
displayed, and the cursor changes to a 3D world-snapping cursor. You are 
prompted to “Select first point of snapping plane”. For details on the 3D 
world-snapping cursor, see “All About 3D Snapping” later in this chapter. 

5. Enter the first point on the new zero plane and snap to a point on your 
model. You are prompted to “Select second point of snapping plane”. 

6. Enter the second point on the new zero plane and snap to the point on 
your model. You are prompted to “Select third point of snapping plane”. 

7. Enter the third point on the new zero plane and snap to the point on your 
model. The view is changed based on the plane you just defined. If your 
model moves off screen, click Reset in the PlneSnap menu. The view is 
changed back to the most recent plan view 

8. Save this new view. Click on AddView in the PlneSnap menu, type a 
name for the view, and press (Enter). The view is added to your go-to-view 
list. Keep in mind that view names can include up to eight characters but 
no spaces. 
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Changing 3D Settings 
The 3D Settings menu has several toggles and other settings that affect the 3D 
menus. You can either click on Settings in the 3DEdit menu, or click on Options 
in the Tools pull-down menu and then click on 3D Settings in the submenu. 

3D Settings Toggles 
There are several toggles that affect drawing using 3D entities: 

LyrSrch Toggle on to scan all layers when you’re selecting entities; this option works exactly 
like the one in 2D selection menus. See “More About Selection Menus” in “The 
Drawing Board” chapter for more information on Layer Search. 

QckSrch Toggle on to select curved 3D entities only by their center points; toggle off to select 
them by any displayed edge 

LyrSnap Toggle on to scan all layers when you’re snapping to entities; toggle off to snap to 
entities on the current active layer only. See “More About 3D Snapping” later in this 
chapter for more information on quick snap.  

QckSnap Toggle on to snap only to straight edges or center points of 3D entities; toggle off to 
snap to these points as well as the endpoints of curved entities 

DrawMrks  
MeshGrid  
MeshPnt  
GlobeDiv  
Dynamic  
SlabRefs  

Setting Primary and Secondary Divisions 
Primary divisions are the number of curve divisions in the plane of the screen, also 
known as the sweep angle. Secondary divisions are those divisions that affect 
curves that bulge into or out of the plane of the screen; these are known as rise or 
roll angles. You can set the primary and secondary divisions for curved 3D entities 
using the 3D Settings menu. 

 To set the number of primary divisions: 

1. Click on Settings in the 3DEdit menu. The Settings menu is displayed. 

2. Click on PrimDivs in the Settings menu. A value menu is displayed, and 
you are prompted to “Enter number of primary circle divisions”. 

3. Use the value menu or type a value, and press (Enter). The primary 
divisions setting is changed, and you are returned to the Settings menu. 

 To set the number of secondary divisions: 

1. Click on Settings in the 3DEdit menu. The Settings menu is displayed. 

2. Click on ScndDivs in the Settings menu. A value menu is displayed, and 
you are prompted to “Enter number of secondary circle divisions”. 

3. Use the value menu or type a value, and press (Enter). The secondary 
divisions setting is changed, and you are returned to the Settings menu. 

Setting Z-Elevations 
You can change the Z-base and Z-height elevations in the 3D Settings menu, as 
well as two alternative Z-elevation settings. 
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 To change a Z-elevation: 

1. Click on Settings in the 3DEdit menu. The Settings menu is displayed. 

2. Click on the Z-elevation you want to change: Z-base, Z-height, or one of 
the two alternative Z-elevations, Z-User1 or Z-User2. A value menu is 
displayed, and you are prompted to enter a new value for the Z-
elevation. 

3. Use the value menu or type a value, and press (Enter). The Z-elevation is 
changed, and you are returned to the Settings menu. 

Drawing 3D Lines 
3D lines are like wires or threads in space; they can connect any two points in 3D 
space. They are not constrained to lie in the XY plane; however, unlike 2D lines, 
3D lines have no extrusion value. 

When you draw 3D lines from Z-base to Z-height and select two points at exactly 
the same place on the screen, you create a line that is perpendicular to the screen. 
Such a line looks like a dot from the current view (a line viewed end-on). 
Although this method works, it is usually conceptually easier to draw such lines 
flat across the screen in an appropriate elevation view. 

You can specify the end points of 3D lines in the same way that you specify the 
end points of 2D lines. You can select points with the left mouse button, snap to 
points with the middle mouse button, or enter coordinates. You can also use the 
3D cursor. 

The first four options in the 3DEntity/3DLine menu are toggles that specify one 
of the four standard Z-elevations at which you can define entities. 3D lines can be 
drawn at Z-base, Z-height (Z-Hgt), or one of two alternative Z elevations (Z-
User1 or Z-User2), which are set using the SetZUsr1 and SetZUsr2 options in the 
3DLine menu, respectively.  

 To set the height of the Z-User1 variable: 

1. Choose SetZUsr1 from the 3DLine menu. A list of values is displayed. 

2. Choose or type a height value and press (Enter). 

 To set the height of the Z-User2 variable:  

1. Choose SetZUsr2 from the 3DLine menu. A list of values is displayed. 

2. Choose or type a height value and press (Enter). 

You can also draw 3D lines that begin at Z-base (first point selected) and end at 
Z-height (second point selected) by toggling the Base/Hgt option on in the 
3DLine menu. See “Z-Base and Z-Height” in the beginning of this chapter for 
more information on Z-elevations. 

Further, you can toggle Chain on to create 3D lines that rubberband from the last 
point entered, just like 2D lines. If you toggle Chain off, you must select both end 
points of each 3D line you draw. 
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All about 3D Snapping 
DataCAD 3D uses a different technique for object snapping than the two-
dimensional DataCAD editor.  

The most important difference between normal 3D snapping and its 2D 
counterpart is that normal 3D snapping attaches the cursor to the projection of 
the model on the screen, not to the model itself. A projection is a two-
dimensional view of a three-dimensional object. If you want to attach the cursor 
to points on the model, you need to orient the zero plane (screen plane) so that it 
coincides with the part of the model you are snapping to. 

Three-dimensional snapping is designed to work when the model is displayed in 
orthographic or any parallel view. See “The Zero Plane” earlier in this chapter for 
more information. 
Zero Plane not aligned with
the model.

Snapping here attaches the cursor to the
projection on the screen, not to the model.

Screen

  
Figure 20.2: Normal snapping 
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Zero plane aligned with
the model.

Snapping here attaches the cusor
directly to the model.

Screen
 

Figure 20.3: Zero plane alignment 

In several menus in DataCAD 3D, you can use a 3D world-snapping cursor to 
snap to the end points you see in the model. This 3D world-snapping cursor 
snaps to the entities themselves rather than connecting to the projections of those 
entities. If the 3D cursor appears, then world snapping is on; if you press the 
middle button on the mouse, you snap to points on the model and not the 
projections of those points on the screen. World snapping works regardless of the 
location of the zero plane.  

 
Figure 20.4: 3D world-snapping cursor 
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World snapping here with
the 3-D cursor will attach
you directly to the model

Zero plane not aligned
with the model

Screen
 

Figure 20.5: World snapping with 3D cursor 

More About 3D Snapping 

If you toggle Fast3D on in the Utility/ObjSnap menu or toggle QckSnap on in the 
3DEdit/Settings menu, you can only snap to the edges of straight-edged objects 
and the center axis points of curved entities. If you toggle Fast3D or QckSnap off, 
you can snap to the end points of the circular divisions as well.  

The following is a list of entities that you can snap to using Fast 3D and Quick 
Snap: 

3D Lines Snap to either end of a 3D line 
Polygons Snap to either end of any displayed edge (including the edges of 

voids) 
Blocks Snap to either end of any edge 
Slabs Snap to either end of any displayed edge (including the edges of 

voids) 
3D Arc Snap to the arc center marker; with QckSnap off, you can snap to 

the end points of the division segments that make up the arc 
itself 

Horizontal or Vertical Cylinder Snap to any of the three center axis markers; with QckSnap off, 
you can snap to the end points of the circular divisions of a 
cylinder 

Cone Snap to any of the three center axis markers; with QckSnap off, 
you can snap to the end points of the circular divisions of the 
cone 

Truncated Cone Snap to any of the three center axis markers; with QckSnap off, 
you can snap to the end points of the circular divisions of the 
truncated cone 

Sphere Snap to any of the three center axis markers; with QckSnap off, 
you can snap to any edge of the facets that make up the sphere 

Torus Snap to the center marker of the sweep or the center markers at 
the beginning and end of the roll; with QckSnap off, you can 
snap to any edge of the facets that make up the torus 

Contour Curve or Mesh Surface Snap to any control point; QckSnap has no effect on snapping to 
contours or mesh surfaces 

Surface of Revolution Snap to any control point; with QckSnap off, you can snap to any 
edge of the single-curvature facets which make up the surface of 
revolution, but you cannot snap to the edges of the double-
curvature facets 



|  CHAPTER 20: MODELING BASICS  404

Symbol Snap to any displayed edge of any portion of the symbol 
according to the rules for each individual entity that makes up 
the symbol 

Using Markers 
A marker is a 3D snapping point. When you choose Marker from the 3DEntity 
menu, the following options appear: 

Z-Base Places a marker at the current Z-base 
Z-Hgt Places a marker at the current Z-height 
3DCursor Snaps to any object with world snapping enabled; for more information on world 

snapping, see “3D Snapping” in the “3D Editing” chapter. See “All about 3D 
Snapping” earlier in this chapter for more information on world snapping. 

3DViews Accesses the 3DViews menu 
 

 



Modeling with 3D Polygons, 
Slabs, and Blocks 

DataCAD’s 3D polygons, slabs and blocks are closely related 
entities with a few important differences. A 3D polygon is a 
single entity with no thickness (unlike a 2D polygon, which is a 
group of lines drawn from Z-base to Z-height). Slabs, usually 
the most common entity in a model, are very similar to 
polygons, except that they have a thickness that you can 
specify. Blocks are simple solids with six rectangular or 
parallelogram-shaped faces. Because the top of a block doen’t 
have to lie directly over its bottom, blocks are particularly 
useful for modeling support members that lean to one side. 

Another important distinction between 3D polygons and slabs 
is that slabs have a reference face, which is the face of the slab 
that orients the slab, controls the direction that you can pass a 
void through the slab, and is important when moving or 
adding vertices or voids to a slab. DataCAD automatically 
assigns one face of a slab to be the reference face, depending on 
what kind of slab you draw: 

Horizontal slabs If you draw the slab from Z-base with the 
specified thickness (Base+Thk toggle), the 
reference face is at Z-base. If you draw the 
slab from Z-height with the specified 
thickness (Hgt+Thk toggle), the reference 
face is at Z-height. If you draw the slab from 
Z-base to Z-height (Base/Hgt toggle), the 
reference face is at Z-base. 

Vertical slabs When you draw a slab from the top of the 
screen to the bottom, the reference face in on 
the left. When you draw a slab from the 
bottom of the screen to the top, the reference 
face in on the right. 

 Inclined slabs The reference face is always on the underside 
of the slab. 

If you forget which face of a slab is the reference face, toggle 
SlabRefs on in the 3DEdit/Settings menu. Dots will be 
displayed on every vertice of each reference face, along with an 
additional dot on one of the opposite vertices. 

21 
In this chapter: 

 Drawing horizontal and 
vertical 3D polygons 

 Drawing horizontal and 
vertical slabs 

 Using inclined polygons 
and slabs to draw roofs 

 Adding voids to 3D 
polygons and slabs  

 Editing 3D polygons 
and slabs 

 Drawing blocks 
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Drawing Rectangular 3D Polygons and Slabs 
 To draw a rectangular 3D polygon:  

1. Choose RectAngl from the Polygon menu.  

2. Choose a Z elevation (Z-Base, Z-Hgt, Z-User1, or Z-User2) at which to 
draw the rectangle. To set the alternative Z elevations, choose SetZUsr1 to 
set the Z-User1 elevation or choose SetZUsr2 to set the Z-User2 elevation. 

3. Select a point to start the rectangle. 

4. Drag the cursor diagonally to size the rectangle and click. The rectangle is 
drawn. You can also create rectangular polygons with Horizntl, but using 
RectAngl is faster and easier. 

 To draw rectangular slabs: 

1. Choose RectAngl from the Slab menu.  

2. Choose a Z elevation at which to draw the rectangular slab: from Z-base 
to a thickness (Base+Thk), from Z-height to a thickness (Hgt+Thk), or 
from Z-base to Z-height (Base/Hgt). 

3. Determine if you are using Base+Thk or Hgt+Thk to draw slabs. Set the 
thickness value by choosing Thicknss from the RectAngl menu and then 
choosing or typing a value and pressing (Enter). As with all Z 
measurements, a positive thickness extends out of the screen and a 
negative thickness extends into the screen. 

4. Select a point to start the rectangle. 

5. Drag the cursor diagonally to size the slab and click. The slab appears. 
You can also create rectangular slabs with Horizntl, but using RectAngl is 
faster and easier. 

Drawing Horizontal 3D Polygons and Slabs 
 To draw horizontal 3D polygons: 

1. Choose Horizntl from the Polygon menu. 

2. Choose the elevation at which you want to draw the polygon: Z-base, Z-
height (Z-Hgt), or one of the two alternative Z elevations (Z-User1 or Z-
User2). These alternative Z elevations are set using the SetZUsr1 and 
SetZUsr2 options in the menu, respectively. To set the height of an 
alternative Z elevation, choose SetZUsr1 or SetZUsr2 from the Polygon 
menu, and then choose or type a height value and press (Enter). See “Z-
Base and Z-Height” in the “Modeling Basics” chapter for details about Z-
elevations. 

3. Select the first point of the polygon. You can create polygons of up to 36 
vertices this way.  
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4. Continue selecting points until you are ready to close the polygon. If you 
make a mistake in placing a vertex, use Backup to erase the last selected 
point. Use Backup to erase the last side of the polygon you drew. Backup 
is available as soon as you select the first point of a polygon and until you 
close the polygon or right-click to disconnect from the polygon you’re 
drawing. To cancel the polygon before the polygon is completed and 
added to the drawing, choose Cancel. Use Cancel to erase the polygon 
you’re currently drawing. Cancel is only available after you select the 
third point of the polygon and until you close the polygon or right-click 
to disconnect from the polygon you’re drawing. You can also choose Exit, 
which is available until you select the third point of the polygon, when it 
becomes Close. Use Exit to stop drawing a polygon and erase what 
you’ve drawn to that point.  

If you create a 36-vertex polygon, DataCAD closes the polygon for you. 
To circumvent this 36-vertex limitation, see “Editing 3D Polygons and 
Slabs” later in this chapter.  

5. Connect the last point you selected with the first one and close the 
polygon by choosing Close or right-clicking. 

 To draw horizontal slabs: 

1. Choose Horizntl from the Slab menu. 

2. Choose the elevation at which you want to draw the slab: Z-base 
extending to a thickness (Base+Thk), Z-height extending to a thickness 
(Hgt+Thk), or Z-base extending to Z-height (Base/Hgt). Backup is 
available as soon as you select the first point of a slab and until you close 
the slab or right-click to disconnect from the slab you’re drawing. 

3. Set a thickness for the slab by choosing Thicknss from the Horizntl menu. 
Then choose or type a value and press (Enter). As with all Z measurements, 
a positive thickness extends out of the screen and a negative thickness 
extends into the screen. Set Thicknss when you are drawing slabs with 
Base+Thk or Hgt+Thk; otherwise, the Thicknss setting is ignored. 

4. Select the first point or vertex of the slab. You can create slabs of up to 36 
vertices. If you create a 36-vertex slab, DataCAD closes the slab for you. If 
you make a mistake in placing a vertex, use Backup to remove the last 
vertex you entered and then continue to place vertices. Use Exit to stop 
drawing a polygon and erase what you’ve drawn to that point. After you 
select the third point of the polygon, the Exit option changes to Close. See 
“Editing 3D Polygons and Slabs” later in this chapter for more 
information about simulating polygons or slabs with more than 36 sides. 

5. Select a second corner point that, along with the first point, forms an edge 
for the base of the block. 

6. Choose Cancel if you want to cancel the slab before it is completed and 
added to the drawing. Cancel is only available after you select the third 
point of the slab and until you close the slab or right-click to disconnect 
from the slab you’re drawing. 

7. Use Close if you want to connect the last point you selected with the first 
one and finish the slab. 
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Drawing Vertical 3D Polygons and Slabs 
Vertical polygons and slabs are rectangular shapes drawn edge on. Vertical 
polygons are useful for quickly creating forms that show some kind of extruded 
quality, like gutters or irregular curtain walls, while vertical slabs are useful for 
quickly creating free-standing walls. Draw the edge of the vertical polygon or 
slab by selecting points on the screen; the height of the entity is determined by 
the separation of Z-base and Z-height (or the two alternative Z elevations).  

 To draw a vertical 3D polygon: 

1. Choose Vertical from the Polygon menu.  

2. Choose to draw the polygon from Z-base to Z-height (Base/Hgt) or from 
Z alternative 1 to Z alternative 2 (Z1/Z2). These toggles set the height of 
the vertical polygon to run from one Z elevation to the other (from Z-base 
to Z-height or from Z1 to Z2). To set the height of the Z1 or Z2 elevation, 
choose Z-User1 or Z-User2 from the Polygon menu, and then choose or 
type a height value and press (Enter). 

3. Choose Chain to create vertical polygons in succession, with the first edge 
of each polygon connected to the last edge of the previous polygon. This 
is similar to the way 2D lines are drawn. When you toggle Chain off, 
DataCAD does not automatically connect lines, so you must select both 
points of each polygon edge you draw. 

4. Select two points on the screen creating one edge of the vertical polygon. 
The polygon is drawn upright, into or out of the screen. 

  
Figure 21.1: Vertical polygons 

 To draw a vertical slab: 

1. Choose Vertical from the Slab menu.  

2. Choose to draw the slab from Z-base to Z-height (Base/Hgt) or from Z-
alternative 1 to Z-alternative 2 (Z1/Z2). These toggles set the height of the 
vertical slab to run from one Z elevation to the other; they are mutually 
exclusive. To set the values of Z-alternative 1 and Z-alternative 2, choose 
Z-User1 or Z-User2 from the Vertical menu, and then choose a value from 
the list or type a value and press (Enter). 

3. Set the thickness of the slab by choosing Thicknss from the Vertical menu. 
Then choose or type a value and press (Enter). Do not confuse this setting 
with the Thicknss setting in Horizontal and Rectangular slabs. Thickness 
for vertical slabs refers to the short dimension of the slab as seen across 
the screen, not the depth of the slab going into the screen. 
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4. Choose Left, Center, or Right to determine the side of the slab on which to 
attach the cursor. The terms Left, Center, and Right refer to the slab as 
drawn from the top of the screen toward the bottom. If you draw the slab 
from the bottom to the top with Left toggled on, your cursor appears 
attached to the right side of the slab. These toggles are mutually exclusive 
and can be activated at any time, even after you select the first point of 
the slab. 

Left Center Right  
Figure 21.2: Cursor positions on vertical slabs 

5. Select the first corner point of the vertical slab. 

6. Move the cursor diagonally to the opposite point of the slab. The slab 
sizes dynamically with the cursor. Click to complete the slab. The slab is 
drawn upright, between the two elevations you selected in step 2. 

  
Figure 21.3: Vertical slabs 

Use SlabRefs to display markers that indicate the reference face for a slab as well 
as the direction of extrusion. The reference face of the slab is determined by the 
points selected on the screen. The extrusion is determined by the relative Z-base 
and Z-height (or Z-User1 or Z-User2) settings you have entered. 

A

ReferenceFace=ABCD
ExtrusionValue=AE

Zbase =A
Zheight =E

Whencreatingvoids, thereferencefacesof themaster andsecondary
slabsmustbe inthesameplane, andtheirextrusionvaluesmust beequal.

D
B

C

E

 
Figure 21.4: Reference faces 
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Drawing Inclined 3D Polygons and Slabs 
Inclined polygons can be used to create roof elements. Roofs that you create with 
this menu do not have a thickness. To create roofs with thickness, use the Inclines 
menu in the 3DEntity/Slab menu, or use the RoofIt tool available from the 
Toolbox menu to create simple roofs automatically. 

 To create roof elements using inclined polygons: 

1. Use the 3DViews option from the Polygon menu to place the model in an 
orthographic view. 

2. Set Z-Base to the height of the lowest point on the roof. 

3. Set Z-Hgt to the height of the ridge line (peak) of the roof. DataCAD 
needs Z-base and Z-height information about the roofs that you are going 
to create—information that is easily calculated but not immediately at 
hand. Calculate the heights and breadths of roofs before using the 
Inclines menu. 

4. Choose Inclines from the Polygon menu.  

5. Continue with the sections below to draw the three- or four-edged 
inclined polygon you need. 

 To create roof elements using inclined slabs: 

1. Place the model into orthographic (plan) view. 

2. Choose Inclines from the Slab menu. 

3. Choose Thicknss to set the depth of the roof element; choose or type a 
value and press (Enter). 

4. Choose whether to add the thickness perpendicularly or vertically. 
Vertical adds the thickness of the slab to the roof element vertically, or 
perpendicular to the ground. This produces a plumb cut on the edge of 
the roof element. Perpend adds the thickness of the slab to the roof 
perpendicularly to the roof slope. 

5. Continue with the instructions below to draw the three- or four-edged 
inclined slab you need. 

 To draw gable, A-frame, and shed roofs: 

1. Choose 4EdgPara from the Inclines menu. 

2. Select the first corner point at the bottom edge of the slope. 

3. Select the second corner point at the bottom edge of the slope. 

4. Select the first corner point on the ridge of the roof. Enter this third point 
opposite the first point, as shown below. Locate this point by snapping or 
with a reference point shortcut and coordinate entry. The fourth corner 
point is automatically derived. 
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Figure 21.5: Four-edged parallelograms 

 To draw hip and mansard roofs: 

1. Choose 4EdgTrap from the Inclines menu. 

2. Select the first corner point at the bottom edge of the slope. 

3. Select the second corner point at the bottom edge of the slope. 

4. Select the first corner point on the ridge of the roof. Enter this third point 
opposite the first point, as shown below. Locate this point by snapping or 
with a reference point shortcut and coordinate entry. The fourth corner 
point is automatically derived. 
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Figure 21.6: Four-edged trapezoids 

When a portion of a roof has four edges, but the opposite edges are not parallel 
due to unusual intersections or valleys with other roofing elements, use the four-
edged general inclined polygon or slab option. 
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 To draw dormers and other unusual roofs: 

1. Choose 4EdgGen from the Inclines menu. 

2. Select the first corner point at the bottom edge of the slope. 

3. Select the second corner point at the bottom edge of the slope. 

4. Select the first corner point on the ridge of the roof. Enter this third point 
opposite the first point, as shown below. Locate this point by snapping or 
with a reference point shortcut and coordinate entry.  

5. Select the last corner point on the ridge of the roof. 
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Figure 21.7: Four-edged general incline 

 To draw the triangular pieces of hip roofs: 

1. Choose 3EdgBot from the Inclines menu. 

2. Select the first point at the bottom edge of the slope (at Z-base). 

3. Select the second corner point at the bottom edge of the slope (also at Z-
base). 

4. Select the corner point on the ridge of the roof (at Z-height). Locate this 
point by snapping or with a reference point shortcut and coordinate entry. 
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Figure 21.8: Three-edged bottom incline 
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 To draw simple dormers: 

1. Choose 3EdgTop from the Inclines menu. 

2. Select the first corner point on the ridge of the roof (at Z-height). 

3. Select the second corner point on the ridge of the roof (also at Z-height). 
Locate this point by snapping or with a reference point shortcut and 
coordinate entry. 

4. Select the corner point at the bottom edge of the slope (at Z-base). 

 

1 3
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Figure 21.9: Three-edged top incline 

The four-edged vertical incline is created edge on, very much like the vertical 
polygon or slab, except that the incline has an independent thickness associated 
with it that controls the depth of the beam. 

 To draw rafters using vertical inclined polygons or slabs: 

1. Choose 4EdgVert from the Inclines menu. 

2. Choose Thicknss to set the depth of the polygon or slab (rafter). A list of 
values appears. 

3. Choose or type a value and press (Enter). 

4. Select the location for the lower edge of the polygon or slab, or the base of 
the incline, including the thickness of the polygon or slab. 

5. Select the location for the upper edge of the polygon or slab, or the top of 
the incline. The polygon or slab ends at the Z-height, including the 
thickness of the polygon or slab. 
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 Plan Elevation

Z-Base of 9'-0"
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Figure 21.10: Four-edged vertical incline 

 To create three-edged vertical, inclined polygons or slabs: 

1. Choose 3EdgPoly from the Inclines menu. 

2. Set the thickness of the slab using the Thicknss option if you’re drawing a 
slab. 

3. Snap to the first corner point on the incline. Use the 3D cursor to snap to 
the corners of roof elements already in place. You don’t have to select the 
points in any particular order. 

4. Snap to the second corner point on the incline. 

5. Snap to the third corner point on the incline. The polygon or slab is 
drawn.  

Adding Voids to Polygons and Slabs 
The Voids menu in the Polygon and Slab menus has options for creating and 
deleting holes in polygons and slabs. You create a void by drawing a small 
polygon or slab (representing the void) inside a larger (primary) polygon or slab. 
The smaller polygon or slab is then converted into a void with the AddVoid 
option. 

When creating slabs, the reference face of each void must coincide exactly with 
the reference face of the primary slab, and the voids must be exactly as thick as 
the primary slab. 

 To add a void:  

1. Draw a primary polygon or slab (the polygon or slab you will be adding a 
void to). Use PlneSnap, NewElev, or EditPlne (in the 3DViews menu) to 
bring the primary polygon or slab into the zero plane before adding 
voids. When you create both the primary and void polygons or slabs 
without changing the view, they automatically lie in the same plane. 
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2. Draw the void polygon or slab inside the primary polygon or slab in 
exactly the same plane, at Z-base (or whatever Z elevation you drew the 
primary polygon or slab at) equal to zero. You can draw more than one 
void polygon or slab at this time. Make sure the void polygon or slab lies 
completely within the primary polygon or slab.  

3. Choose Voids from the Polygon or Slab menu. 

4. Highlight the primary polygon or slab by selecting one of its edges. 

5. Choose AddVoid. 

6. Select the void polygon(s) or slab(s) you drew in step 2. The void 
polygons or slabs are highlighted as you select them. The primary 
polygon or slab now has voids in it. 

When you add a void to a polygon or slab, you are left with one entity (a 
polygon or slab with a hole in it) where separate polygons or slabs existed before. 
If you erase or move the primary polygon or slab, the void moves with it, as you 
would expect of a single entity. The void polygons or slabs no longer have an 
identity apart from the primary polygon or slab to which they belong. 

Use ConvVoid to convert voids back into the polygons or slabs from which they 
originated. You must convert a void when you want to edit the void by adding, 
deleting, or moving vertices using the Partial menu. 

 To convert a void: 

1. Select Voids from the Polygon or Slab menu. 

2. Select a primary polygon or slab by indicating one of its edges. The 
primary polygon or slab and any voids are highlighted. 

3. Choose ConvVoid from the Voids menu. 

4. Select the voids that you want to convert back into polygons or slabs. Any 
converted voids now exist as individual, embedded polygons or slabs. 

To add vertices to a void, convert the void back into a polygon or slab with 
ConVoid, add vertices with AddVertx from the Partial menu, then use AddVoid 
to turn the polygon or slab back into a void. You can also move a void or resize it 
using 3DEdit/Stretch. 

Once you add a void to a primary polygon or slab, the void polygon or slab no 
longer exists as an independent entity; it becomes a hole in a larger object. Use 
ErasVoid to remove these voids from a primary polygon or slab.  

 To erase a void: 

1. Choose Voids from the Polygon or Slab menu. 

2. Select the primary polygon or slab by indicating one of its edges. The 
polygon or slab and any voids are highlighted. 

3. Choose ErasVoid from the Voids menu. 

4. Select the voids that you want to delete from the polygon or slab. Selected 
voids disappear entirely, sealing the hole. 
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Editing 3D Polygons and Slabs 
With the Partial menu options, you can edit - move, add, or delete vertices in - a 
polygon or slab. You can also toggle the edges of a polygon or slab to visible or 
invisible.  

To maintain its integrity, edit the polygon or slab in the same plane in which it 
was created or at least in a plane parallel to the polygon or slab. Use PlneSnap, 
NewElev, or EditPlne from the 3DViews menu. See the chapter on “Viewing Your 
Model” for more information about the options for PlneSnap, NewElev, and 
EditPlne in the 3Dviews menu. 

To simulate polygons or slabs with more than 36 sides, you can create a 36-sided 
polygon or slab and mark one of the edges as invisible. You can connect another 
polygon or slab with a shared invisible edge to the first invisible edge. By hiding 
the seams, you can build a patchwork of polygons or slabs that simulates a 
polygon or slab of an unlimited number of sides. 

 To add vertices to a polygon or slab: 

1. Choose AddVrtex from the Partial menu. Make sure that the current 
editing plane is parallel to the polygon or slab you want to edit.  

Warning: Use caution with MovVrtex and AddVrtex. These commands can 
create physically impossible shapes. The most common problems include letting 
edges cross over one another and pulling vertices out of the plane of the polygon 
or slab, thus creating a twisted and ambiguous shape. 

2. Select the edge of the polygon or slab to which you want to add a vertex. 
Remember that a polygon or slab can have no more than 36 vertices. 
Notice that this edge of the polygon or slab becomes a rubberband line 
with your cursor attached to the edge. 

3. Position the new vertex.  

 

Add Here

Before After  

Figure 21.11: Adding a vertex 

 To delete the vertices of a polygon or slab: 

1. Choose DelVrtex from the Partial menu. 

2. Select the vertex you want to delete. The vertex disappears and the two 
edges that led into the deleted vertex now become a single edge. Because 
a polygon or slab can have no less than three vertices, you cannot delete a 
vertex from a triangular-shaped polygon or slab. 
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 Before After

Delete

 
Figure 21.12: Deleting a vertex 

 To reposition the vertex of a polygon or slab: 

1. Choose MovVrtex from the Partial menu. Make sure that your current 
editing plane is parallel to the polygon or slab that you want to edit. 

2. Select the vertex you want to move. Notice that this vertex is now 
attached to your cursor and the two edges of the polygon or slab that lead 
to this vertex become rubberband lines. You can also move a vertex with 
the Stretch option in the 3DEdit menu. 

3. Select a new vertex position.  

 

Moved

AfterBefore  
Figure 21.13: Moving a vertex 

Use the MarkVis toggle to change the visibility of individual edges of a polygon 
or slab. Selecting a visible edge makes it invisible, while selecting an invisible 
edge makes it visible. Edges made invisible are not erased; they are suppressed 
from view, usually to hide the seams between adjacent polygons or slabs. 
Invisible edges remain invisible after hidden line removal, but the polygon or 
slab is processed as if they were visible; invisible edges can obscure objects that 
lie behind them. 

 To make an edge visible or invisible: 

1. Choose MarkVis from the Partial menu. 

2. Select the edge of the polygon or slab you want invisible. 
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Figure 21.14: Using MarkVis on one edge 

 To make all edges visible: 

1. Choose MarkAll from the Partial menu. 

2. Select the polygon or slab that you want visible. The edges of the selected 
polygon or slab become visible.  

 To make all edges invisible: 

1. Choose UnMrkAll from the Partial menu. 

2. Select the polygon or slab that you want invisible. The edges of the 
selected polygon or slab become invisible.  

Making a polygon or slab completely invisible with UnMrkAll has obvious 
problems. The best way to recover an invisible polygon or slab is to use Area or 
Fence from the selection menu with MarkAll in the region where you think the 
polygon or slab exists. 

Drawing Blocks 
A block is a simple solid with six rectangular or parallelogram-shaped faces. 
Because the top of a block is not constrained to lie directly over its bottom, blocks 
are particularly useful for modeling supporting members that lean to one side. 

 To draw blocks: 

1. Choose Block from the 3D Entity menu.  

2. Select the shape of the base of the block: for a rectangular base, choose 
RectAngl; for a parallelogram base, choose Parallel. 

3. Choose AutoHgt to automatically place the vertex at Z-height, centered 
over the center point of the base; otherwise, you must place the vertex 
manually. 

4. Choose to place the reference face of the block with one of the following: 

• Base+Thk At Z-base, extending up through a distance equal to the 
thickness parameter set below 

• Hgt+Thk At Z-height, extending up through a distance equal to the 
thickness parameter set below 

• Base/Hgt At Z-base, extending up to Z-height 
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If you choose Base+Thk or Hgt+Thk, you can use Thicknss to set the 
thickness of the block. (Otherwise, the Thicknss setting is ignored.) As 
with all Z measurements, a positive thickness extends out of the screen, 
and a negative thickness extends into the screen. Choose Thicknss from 
the Blocks menu, and then choose or type a value and press (Enter). 

5. Continue with the sections below for either rectangular-based blocks or 
parallelogram-based blocks. 

 To draw rectangular-based blocks: 

1. Select the first corner of the block base. 

2. Move the mouse diagonally, expanding the base of the block to the proper 
size. Select the second corner of the block base. If you selected AutoHgt, 
DataCAD places the top of the block directly over the bottom and the 
block is finished. 

3. Turn AutoHgt off and select a location of the top of the block; the sides of 
the block are drawn, connecting the top and bottom faces. 

  
Figure 21.15: Rectangular-based blocks 

 To draw parallelogram-based blocks: 

1. Select a point to serve as one corner of the block. 

2. Select a second corner that, along with the first point, forms an edge for 
the base of the block. 

3. Select a third corner point to form the parallelogram base of the block. 
Notice how opposite sides of the base remain parallel but are not 
constrained to right angles. When you select AutoHgt, DataCAD places 
the top of the block directly over the bottom and the block is finished. 

4. Turn AutoHgt off and select a location of the top of the block; the sides of 
the block lean to connect the top and bottom faces. 
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Drawing Single-Curved 
Entities 

Unlike their 2D counterparts, all curved 3D entities in 
DataCAD are actually drawn using a number of short line 
segments to approximate true curves.  

Some 3D entities, such as cylinders, 3D arcs, cones, and 
truncated cones, only curve in one direction, around the 
entity’s center point or central axis. For these entities, you only 
need to set the number of primary divisions. 

Entities that curve in more than one direction, such as domes 
and spheres, tori, surfaces of revolution, and mesh surfaces, 
have both primary and secondary division settings. See 
“Drawing Double-Curved Entities” for more information on 
drawing entities with both primary and secondary divisions. 

22 
In this chapter: 

 Drawing 3D arcs 

 Drawing horizontal 
cylinders 

 Drawing vertical 
cylinders 

 Drawing cones 

 Drawing truncated 
cones 
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Drawing 3D Arcs 
3D arcs are essentially the same as their 2D counterparts, with the following 
exceptions: 

• 3D arcs can exist at any orientation in space; 

• 3D arcs can be specified as open or closed; 

• 3D arcs have no extrusion value 

• 3D arcs are approximations of arcs consisting of many short line segments 
called divisions. 

The first eight options on the 3DArc menu are quite common and are seen 
wherever there is a curved 3D entity. Creating this 3D arc footprint is often the 
first step in creating a curved 3D entity. This footprint defines the sweep angles 
for the entity. 

3D two- and three-point arcs and radius, diameter, and three-point circles are 
drawn exactly as their 2D counterparts. Use ClkWise, available only with 2PtArc, 
to create an arc in the clockwise direction rather than counterclockwise. Use 
Closed to close the arc and perform a hidden line removal. See “Drawing 
Curves” in the “Drawing Other Geometry” chapter for more information about 
arcs and circles. 

  
Figure 22.1: Open and closed arcs and circles 

Use Tangent to draw arcs that are tangent to a specified line. This method is 
slightly different from the way tangent arcs are created in 2D. 

 To draw a 3D tangent arc: 

1. Choose Tangent from the 3DArc menu. 

2. Select the first point of the tangent line. This is the line that the 3D arc 
draws to. 

3. Select the beginning point of the arc. 

4. Select the end point of the arc. 
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First point of
tangent line

Beginning of arc

End of arc

 
Figure 22.2: Drawing a tangent arc 

A dog-leg arc is defined by the two tangent points of the arc and the point at 
which those two tangent lines cross (the knee point). You can use DogLeg to 
create an arc that must be tangent to existing lines. 

 To draw a dog-leg arc: 

1. Choose DogLeg from the 3DArc menu. 

2. Select the first point of tangency, or the first point of the arc. 

3. Select the knee point, the point where the two lines of tangency meet. 

4. Select the second point of tangency, or the end of the arc. 

 

Beginning tangent point Knee point

Ending tangent point

 
Figure 22.3: Drawing a dog-leg arc 

You can enter the arc at the current elevation of Z-base or Z-height. Choose Z-
base or Z-Hgt, respectively, and draw the arc. 

 To create 3D arcs that curve out of the screen: 

1. Choose Vertical from the 3DArc menu. 

2. Select the center point of the arc. 

3. Select a starting point for the arc. A list of values appears. 

4. Choose or type a value and press (Enter). 

5. Type the angle of elevation for the first end point and press (Enter). 

6. Type the angle of elevation for the second end point and press (Enter). 
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 To set the number of divisions for 3D arcs: 

1. Choose Divisons from the 3DArc menu. A list of values appears. 

2. Choose or type a division value and press (Enter). 
24 Divisions 10 Divisions

 
Figure 22.4: Divisions examples 

Drawing Vertical Cylinders 
Vertical cylinders are drawn as columns or posts standing on end. The diameter 
of the column is dynamically specified by drawing the footprint of the cylinder 
using one of the standard 3D arcs. The height of the column is controlled by 
setting Z-base, Z-height, and thickness. 

 To draw a vertical cylinder: 

1. Choose VertCyl from the 3DEntity menu.  

2. Select one of these options: 2PtArc, 3PtArc, Tangent, DogLeg, RadCirc, 
DiaCirc, and 3PtCirc. These options are identical to those in the 3DArc 
menu. Choose one of these options to draw the footprint of the cylinder. 
A footprint is the shape of the base of the cylinder. To draw a full cylinder, 
for instance, choose RadCirc, DiaCirc, or 3PtCirc to draw a circular 
footprint. 

3. Choose whether to draw the cylinder from Z-base to the thickness value 
(Base+Thk), from Z-height to the thickness value (Hgt+Thk), or from Z-
base to Z-height (Base/Hgt). 

4. Use Closed to create a closed cylinder for hidden line removals. The 
cylinder is processed as a solid element with Closed on. 

5. Follow the prompts in drawing the footprint of the cylinder. For more 
information on using 2PtArc, 3PtArc, Tangent, DogLeg, RadCirc, DiaCirc, 
3PtCirc and ClkWise, see “3D Arcs” earlier in this chapter. 
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Figure 22.5: Vertical columns 

Set Thicknss when you draw cylinders by Base+Thk or Hgt+Thk; otherwise the 
Thicknss value is ignored. As is true for all Z measurements, positive thickness 
extends out of the screen, while negative thickness extends into the screen. 

 To set a thickness: 

1. Choose Thicknss from the VertCyl menu. A list of values appears. 

2. Choose or type a value and press (Enter). 

 To set the number of divisions for the cylinders: 

1. Choose Divisons from the VertCyl menu. A list of values appears. This 
setting is the same as PrimDivs in the 3D Settings menu. 

2. Choose or type a value and press (Enter).  

The 3DViews option is a shortcut to the 3D Views menu. See the “Viewing Your 
Model” chapter for more information about the 3Dviews menu. 

Drawing Horizontal Cylinders 
Horizontal cylinders draw flat across the screen. 

 To draw a horizontal cylinder: 

1. Choose HorizCyl from the 3DEntity menu. 

2. Select a radius for the cylinder. 

3. Choose the extent of the sweep angles with StartAng and EndAngle, or 
select one of the four presets: FullCirc, TopHalf, BotHalf, or SideHalf.  

For more control over the portion of the cylinder that appears, you can: 

• reorient the view to draw a vertical cylinder and use the 3DArc menu to 
set the portion of the cylinder needed 

• stay with horizontal cylinders and explicitly specify sweep angles for the 
cylinder 

4. Select two points to represent the end points of the cylinder. 
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To create a cylinder section that covers from the 10:00 position to the 2:00 position 
on a clock, decide which way you want to draw the cylinder across the screen. 
You can draw it from top to bottom or bottom to top. When drawing from top to 
bottom, remember that cylinders are drawn counterclockwise. 

 
Figure 22.6: Horizontal cylinder 

 To specify the beginning angle of the cylinder sweep angle: 

1. Choose StartAng from the HorizCyl menu. A list of beginning sweep 
angles appears. 

2. Choose or type a beginning sweep angle and press (Enter). 

 To specify the ending sweep angle of the cylinder sweep angle: 

1. Choose EndAngle from the HorizCyl menu. A list of ending sweep angles 
appears. 

2. Choose or type an ending sweep angle and press (Enter). 

Plan view

Pick 1

Pick 2

Beginning angle
(45°)

Ending angle
(135°)

 
Figure 22.7: Computing sweep angles 
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 To control the radius of the cylinder: 

1. Choose Radius from the HorizCyl menu. A list of radius values appears. 

2. Choose or type a radius value and press (Enter). 

 To draw a full and complete cylinder:  

1. Choose FullCirc from the HorizCyl menu. 

2. Select the center point of one end of the cylinder. 

3. Select the center point of the other end of the cylinder. 

 To draw the top half of a cylinder using a preset pair of sweep angles (much 
like a speed bump):  

1. Choose TopHalf from the HorizCyl menu. 

2. Select the center point of one end of the cylinder. 

3. Select the center point of the other end of the cylinder. 

 To draw the bottom half of a cylinder using a preset pair of sweep angles 
(much like a trough):  

1. Choose BotHalf from the HorizCyl menu. 

2. Select the center point of one end of the cylinder. 

3. Select the center point of the other end of the cylinder. 

 To draw half of a cylinder using a preset pair of sweep angles.  

1. Choose SideHalf from the HorizCyl menu. 

2. Select the center point of one end of the cylinder. 

3. Select the center point of the other end of the cylinder. When the two 
points used to define the cylinder are drawn from the top to the bottom of 
the screen, the resulting half-cylinder appears on the left. 

Use Closed to create a closed cylinder for hidden line removals. The cylinder is 
processed as a solid element when Closed is on. 

Use the Z-base toggle to set the centerline of the cylinder to lie at Z-base. If you 
draw a full circle cylinder, half of the cylinder lies above Z-base and half lies 
below. Similarly, the Z-Hgt toggle sets the centerline of the cylinder to lie at Z-
height. If you draw a full circle cylinder, half of the cylinder lies above Z-height 
and half lies below. 

 To set the number of divisions for the cylinders: 

1. Choose Divisons from the HorizCyl menu. A list of values appears. This 
setting is the same as PrimDivs in the 3DEdit/Settings menu. 

2. Choose or type a value for the number of cylinder divisions and press 
(Enter).  

3DViews accesses the 3DViews menu. See the “Viewing Your Model” chapter for 
more information about the 3Dviews menu. 
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Drawing Cones and Truncated Cones 
Cones are entities that are not used often in architectural modeling, but they are 
sometimes seen in spires and pylons. You can create cones by drawing the base 
of the cone (at Z-base) using the standard 3D Arc menu and placing the vertex of 
the cone at Z-height. DataCAD automatically places the vertex, thus creating a 
right cylinder, or you can place the vertex yourself, creating a skewed cylinder. 

 To draw a cone: 

1. Choose Cone from the 3DEntity menu.  

2. Choose AutoHgt to automatically place the vertex of the cone at Z-Hgt, 
centered over the center point of the base. Otherwise, you will have to 
manually place the vertex. 

3. Use Divisons to set the number of divisions for the cone. (This setting is 
the same as the PrimDivs setting of the 3DEdit/Settings menu.) To set the 
divisions of a cone, choose Divisons from the Cone menu, and then 
choose or type a value for the number of divisions and press (Enter). 

4. Toggle Closed on to close the bottom of the cone, creating a solid base. 
This base won’t be visible unless you perform a hidden line removal or 
shade the image.  

5. Draw the footprint (sweep angle) of the cone. The base of the cone is 
always drawn at Z-base and the vertex is always drawn at Z-height. See 
“Drawing 3D Arcs” earlier in this chapter for more information about 
drawing the footprints of the cone or on using 2PtArc, 3PtArc, Tangent, 
DogLeg, RadCirc, DiaCirc, 3PtCirc, ClkWise and Closed. 

6. Place the vertex of the cone if you toggled AutoHgt off. If you place the 
vertex to one side, you create a skewed cone. 

Vertex placed manually
(AutoHgt off)

 
Figure 22.8: Cones 

See “Drawing 3D Arcs” earlier in this chapter for more information about 
drawing the footprints of the cone or on using 2PtArc, 3PtArc, Tangent, DogLeg, 
RadCirc, DiaCirc, 3PtCirc, ClkWise and Closed. 

Truncated cones have sheared off tops. Creating a truncated cone is similar to 
creating a regular cone, except you must also specify the diameter of the top 
opening of the truncated cone. 

 To draw a truncated cone: 

1. Choose TrunCone from the 3DEntity menu.  

2. Set the Z-base and Z-height appropriately. As with regular cones, you 
draw truncated cones from Z-base to Z-height. 
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3. Toggle Closed on to close the bottom and top of the cone, creating a solid 
base and top. This solid base and top won’t be visible unless you perform 
a hidden line removal or shade the image. 

4. Choose the footprint (sweep angle) of the truncated cone by drawing one 
of the 3D arcs. 

5. Determine whether AutoHgt is toggled on or off. If AutoHgt is toggled 
on, DataCAD prompts for the diameter of the top part of the truncated 
cone. If AutoHgt is toggled off, DataCAD prompts you for the center 
point of the top circle, and then the radius. 

 
Figure 22.9: Truncated cones 

The 3DViews option is a shortcut to the 3D Views menu. See the “Viewing Your 
Model” chapter for more information about the 3Dviews menu. 
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Drawing Double-Curved 
Entities 

Unlike their 2D counterparts, all curved 3D entities in 
DataCAD are actually drawn using a number of short line 
segments to approximate true curves.  

Some 3D entities, such as cylinders, 3D arcs, cones, and 
truncated cones, only curve in one direction, around the 
entity’s center point or central axis. See “Drawing Single-
Curved Entities” for more information on drawing entities with 
only primary divisions. 

Entities that curve in more than one direction, such as domes 
and spheres, tori, surfaces of revolution, and mesh surfaces, 
have both primary and secondary division settings. Primary 
divisions are the number of curve divisions in the plane of the 
screen, also known as the sweep angle. Secondary divisions are 
those divisions that affect curves that bulge into or out of the 
plane of the screen; these are known as rise or roll angles. 

23 
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Drawing Spheres and Domes 
Spheres are any full sphere or section of a sphere. The menu combines features 
from both the vertical and horizontal cylinder menus as well as the 3D arcs 
menu. See “Drawing 3D Arcs,” “Drawing Vertical Cylinders,” and “Drawing 
Horizontal Cylinders” in the “Drawing Single-Curved Entities” chapter for more 
information. 

 To draw a sphere: 

1. Choose Sphere from the 3DEntity menu.  

2. Choose a 3DArc option from the top part of the menu: 2PtArc, 3PtArc, 
Tangent, DogLeg, RadCirc, DiaCirc, 3PtCirc, or ClkWise to enter the 
footprint (sweep angles) of the sphere. See “Drawing 3D Arcs” in the 
“Drawing Single-Curved Entities” chapter for more information on using 
2PtArc, 3PtArc, Tangent, DogLeg, RadCirc, DiaCirc, 3PtCirc, and 
ClkWise. 

3. Set the rise angles with StartAng or EndAngle or use one of the presets: 
FullCirc, TopHalf, or BotHalf. This determines exactly how much of the 
sphere curves out of the plane of the screen. 

4. Set the Z-base or Z-height properly to set the location of the sphere. The 
sphere is drawn with its center point at either Z-base or Z-height, 
depending on which is toggled on. 

5. Draw the footprint with 3DArc options. DataCAD generates the dome 
from the footprint and the rise angles you supplied. 

 
Figure 23.1: Spheres 

For more control over the portion of the sphere that appears, you can specify rise 
angles. A rise angle describes the angle by which something tilts out of the plane 
of the screen. Something that lies exactly in the plane of the screen has a rise 
angle of 0°; something that extends straight out of the screen has a rise angle of 
90°. 

 To set the beginning rise angle for the sphere: 

1. Choose StartAng from the Sphere menu. A list of beginning rise angles 
appears. 

2. Choose or type a beginning rise angle and press (Enter). 
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 To set the ending rise angle for the sphere: 

1. Choose EndAngle from the Sphere menu. A list of ending rise angles 
appears. 

2. Choose or type an ending rise angle and press (Enter). When setting the 
rise angles for the beginning and end of the sphere, remember that 
spheres are drawn counterclockwise. 

Use FullCirc to create a sphere section encompassing both the north and south 
hemispheres. Use TopHalf to create a sphere section with just the northern 
hemisphere. Use BotHalf to create a sphere section with just the southern 
hemisphere. Use Z-Base to set the center of the sphere at the Z-base. Use Z-Hgt to 
set the center of the sphere at the Z-height. 

 To set the primary (sweep) divisions of the dome: 

1. Choose PrimDivs from the Sphere menu. A list of values appears. 

2. Choose or type a value for the number of primary divisions and press 
(Enter). 

 To set the secondary (roll) divisions of the dome: 

1. Choose StartAng from the HorizCyl menu. A list of values appears. 

2. Choose or type a value for the number of secondary divisions and press 
(Enter). 

 

Primary
divisions

Secondary
divisions

 
Figure 23.2: Primary and secondary divisions 
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Drawing Tori 
A torus is a donut-shaped entity. Full tori are obviously very rare in architectural 
modeling, but sections of tori are fairly common. Typical applications include 
turns in railings, elbow connectors in pipes, and even children’s playground 
slides.  

 To draw a torus: 

1. Choose Torus from the 3DEntity menu.  

2. Choose a 3DArc option from the top of the menu: 2PtArc, 3PtArc, 
Tangent, DogLeg, RadCirc, DiaCirc, 3PtCirc, ClkWise, or Radius for 
creating the footprint (sweep angles) of the torus. See “Drawing 3D Arcs” 
in the “Drawing Single-Curved Entities” chapter for more information on 
using 2PtArc, 3PtArc, Tangent, DogLeg, RadCirc, DiaCirc, 3PtCirc, and 
ClkWise. 

3. Set the roll angles for the tube part of the torus with StartAng or 
EndAngle or use one of the preset angles FullCirc, TopHalf, BotHalf, 
InHalf, or OutHalf. 

4. Choose Z-base or Z-height. Center the torus at either the Z-base or the Z-
height, respectively. 

5. Draw the 3DArc footprint of the torus. The torus (or toroidal section) is 
calculated from the footprint and the roll angles. 

For more control over how far the torus sweeps out of the plane of the sphere, 
you can specify roll angles. A roll angle describes the angle by which something 
tilts out of the plane of the screen. Something that lies exactly in the plane of the 
screen has a roll angle of 0°; something that comes straight out of the screen has a 
roll angle of 90°.  

 To set the beginning roll angle for the torus: 

1. Choose StartAng from the Torus menu. A list of beginning roll angle 
values appears. 

2. Choose or type a beginning roll angle and press (Enter). 

 To set the ending roll angle for the torus: 

1. Choose EndAngle from the Torus menu. A list of ending roll angle values 
appears. 

2. Choose or type an ending roll angle and press (Enter). When setting the 
roll angles, remember that tori are drawn counterclockwise as seen in a 
front elevation. 

You can also use these preset options to set the most common roll angles: 

FullCirc Creates a full inner-tube torus section 
TopHalf Creates a torus section using only the top part of the torus roll 
BotHalf Creates a torus section using only the bottom part of the torus roll 
InHalf Creates a torus using only the inside part of the torus roll 
OutHalf Creates a torus using only the outside part of the torus roll 
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 To indicate the radius of the tube section of the torus (not the radius of the 
torus itself): 

1. Choose Radius from the Torus menu. A list of radius values appears. 

2. Choose or type a radius value and press (Enter). 

 To set the primary (planar) divisions of the torus: 

1. Choose PrimDivs from the Torus menu. A list of values appears. 

2. Choose or type a value for the number of primary divisions and press 
(Enter). 

 To set the secondary (roll) divisions of the torus: 

1. Choose ScndDivs from the Torus menu. A list of values appears. 

2. Choose or type a value for the number of secondary divisions and press 
(Enter). 

  
Figure 23.3: Torus connecting two cylinders 

Drawing Surfaces of Revolution 
Use RevSurf to create 3D solids with radial symmetry. Columns, lampshades, 
fountains, and canopies are all examples of objects with radial symmetry that 
you can model using RevSurf. 

Surfaces of revolution are so named because of the way you construct them: a 
polyline profile revolved around an axis of revolution. As the profile revolves 
around a given axis, it “sweeps out” a surface in its wake. This surface is the 
surface of revolution. To create any surface of revolution, you must determine 
what profile and axis combination generates the surface you want. 

Surfaces of revolution are single entities. To modify or edit a surface of 
revolution, you can explode it and stretch it, or enlarge it to create complex 
shapes. If you’re trying to model a shape that doesn’t have radial symmetry, but 
is close, try starting with a surface of revolution. Then through enlargements, 
explosions, and stretches, shape the solid into the form you need. 
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Figure 23.4: Surface of revolution 

 To draw a surface of revolution: 

1. Choose RevSurf from the 3DEntity menu.  

2. Draw or select the profile to rotate. Create the cross section of the object as 
a polyline. If you already have a polyline, you can use Select to select the 
polyline. You can use Backup and Cancel to create polylines. 

3. Choose Exit. The rise angle options are displayed. 

4. Set the rise angles for the surface of revolution: 

StartAng Sets the beginning rise angle on the surface of revolution 
EndAngle Sets the ending rise angle on the surface of revolution 
FullCirc Sets the rise angle to rotate the profile 360° around, thus creating a full solid 
TopHalf Sets the rise angle to rotate the profile 180° out of the screen, creating just the 

top half of a full surface of revolution 
BotHalf Sets the rise angle to rotate the profile 180° into of the screen, creating just 

the bottom half of a full surface of revolution 
SideHalf Sets the rise angle to rotate the profile 180° into and out of the screen, on 

whatever side the contour appears, thus creating half of a full surface of 
revolution 

5. Choose a surface of revolution: 

Open With open ends and sides; no surfaces are generated for these parts of the 
surface of revolution 

ClosSid With closed sides; sides are inside surfaces, the part of the surface of 
revolution you see if you stand on the axis of revolution and look outward 
toward the profile, or if you stand outside the surface and look inward 
toward the axis 

ClosEnd With closed ends; ends refer to the top and bottom, the part of the surface of 
revolution you see if you look along the axis of revolution 
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6. Choose PrimDivs to set the number of circular divisions along the roll of 
the surface of revolution (the surfaces which curve out of or into the plane 
of the screen, which rotate around the X or Y screen axes. Choose 
PrimDivs from the RevSurf menu, and then choose or type a value for the 
number circular divisions along the roll and press (Enter). 

7. Choose ScndDivs to set the number of circular divisions along the sweep 
of the surface of revolution (the surfaces that show curvature in the plane 
of the screen, which rotate around the Z screen axis). Choose ScndDivs 
from the RevSurf menu, and then choose or type a value for the number 
of circular divisions along the sweep and press (Enter). 

8. Choose Z-Base or Z-Hgt to create a surface of revolution whose axis of 
revolution is at the Z-base or Z-height, respectively. 

9. Choose Exit when you are done with the polyline cross section. 

 
Figure 23.5: Polyline cross section 

10. Select two points for the axis of revolution. The action here is to spin the 
polyline profile around the axis of revolution, sweeping out a solid in the 
process. 
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Figure 23.6: Selecting the axis of revolution 

Drawing Mesh Surfaces 
A mesh surface is a smooth patch that you can mold into a variety of useful shapes 
including free-form built structures, tents, and canopies. Mesh surfaces are the 
surface equivalents of Bezier curves. 

Like contours, mesh surfaces are created through a series of control points that 
you specify. The greater the variation in the elevation of these control points, the 
more dramatic the curves in the surface. 

There are always exactly 16 control points to specify for a mesh surface, and 
these 16 control points always form a 4x4 grid of points, although the spacing of 
these points may not be uniform. 

 
Figure 23.7: Mesh surfaces 

There are three ways to create a mesh surface: 

• Specify all 16 control points individually, as four rows, with four points per 
row. The first control point is numbered [1,1], meaning row 1, column 1 in the 
grid of points. The second control point is numbered [1,2], then [1,3] followed 
by [1,4], then [2,1], etc. You can change the Z-base or Z-height at any time 
during the entry of control points, thus creating a surface that curves into and 
out of the screen. The resulting surface is a Bezier-like curved sheet that 
curves into and out of the screen. 
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• Draw a rubberband box that forms the outer boundary of the mesh surface. 
The 16 control points are equally spaced in this box. The resulting surface is a 
flat sheet. 

• Place four points in the drawing that represent the four rows of a rectangular 
sheet surface that go into the screen. 

 To manually draw a mesh surface: 

1. Choose MeshSurf from the 3DEntity menu.  

2. Select the Z elevation of the first control point [1,1]. 

3. Select the first control point. 

4. Repeat steps 2 and 3 until you enter all 16 control points. 

 
Figure 23.8: Mesh grid and its corresponding control points 

 To create a rectangular mesh surface: 

1. Choose RectSurf from the MeshSurf menu. 

2. Select one corner of a rubberband box to contain the mesh surface.  

3. Select the opposite corner of the rectangular region. The 16 control points 
are automatically placed within the boundary rectangle, all at the same 
elevation and an equal distance apart. To create a rolling surface, take an 
elevation view and use the stretch command to move the control points. 

 
Figure 23.9: Rectangular mesh surface 
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 To create a vertical mesh surface from Z-base to Z-height: 

1. Choose VertSurf from the MeshSurf menu. 

2. Select four points across the screen. DataCAD generates a mesh surface 
that runs from Z-base to Z-height that fits the control points. For each 
control point you select on the screen, DataCAD generates four points: 
one at Z-base at that location, one at Z-height, and two more, equally 
spaced between these extremes. 

 
Figure 23.10: Vertical mesh surface 

 To set the number of columns (divisions in the surface in direction 1): 

1. Choose DivsDir1 from the MeshSurf menu. A list of surface division 
values appears. 

2. Choose or type a value for the number of surface divisions in Direction 1 
and press (Enter). 

 To set the number of rows (divisions in the surface in direction 2): 

1. Choose DivsDir2 from the MeshSurf menu. A list of surface division 
values appears. 

2. Choose or type a value for the number of surface division in Direction 2 
and press (Enter). 

Use DispPts to display the control points for the surface. When you edit a mesh 
surface, toggle DispPts on. Toggle DispPts off for presentations. 

Use DispGrid to connect the surface’s control points with lines. Toggle DispGrid 
off for presentations. 

As with Contours, you can specify an increment distance to add or subtract to 
the base elevation as you enter control points. SetIndx sets the index and 
AddIndx and SubIndx determine whether you add to or subtract from the 
current Z elevation value. See “Drawing Topographical Maps with Contours” 
earlier in the “Site Modeling” chapter for more information about contours. 

 To specify and increment distance: 

1. Choose SetIndx from the MeshSurf menu. A list of distance values 
appears. 

2. Choose or type an increment distance and press (Enter). 
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These are the four standard elevations at which you can enter a mesh surface 
control point Use all four to create a mesh surface with varying Z elevations. Use 
AddIndx or SubIndx to change these values.  

 To set the values for Z-User1 and Z-User2: 

1. Choose one of these elevation options from the MeshSurf menu. A list of 
elevation values appears. 

2. Choose or type an elevation value and press (Enter). 
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Site Modeling 
DataCAD has a tool you can use for site modeling: the Drop 
Mesh tool. The Drop Mesh tool creates a triangulated regular 
network (TRN) of 3D polygons and is an averaged 
representation of data points.  

Drop Mesh produces a "clean," rectilinear result, which may be 
desirable when accuracy is less of a concern than the visual 
representation. 

Contours are curved 3D lines drawn through points that you 
enter. These are particularly useful for drawing topographical 
maps. 

As with most tools in DataCAD, the Drop Mesh can be used to 
create not only site models but also any surface in your model. 
Contours can be used in other drawing situations as well. 

24 
In this chapter: 

 Using the drop mesh 

 Using contours to create 
topographical maps 
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Site Modeling with Drop Mesh 
One additional option is displayed in the 3DEntity/Polygon menu. DropMesh is 
used to create a regular, triangulated, polygon mesh that lays over selected 
geometry or points, which can be created from a survey data file. This mesh can 
then be shaded or processed through a hidden line removal to provide a model 
of the building site.  

A drop mesh is a group of triangulated polygons, not a single entity; thus, it can 
increase your drawing file size substantially.  A mesh with 100 X divisions and 
100 Y divisions will add 20,000 polygons to your drawing (X divisions x Y 
divisions x 2 polygons per grid division, or 100x100x2), increasing your drawing 
file by 3MB.  Additionally, since entities are not deleted from the drawing 
database even after you delete them from the drawing itself, your drawing file 
size can increase rapidly if you add a drop mesh, delete it, add another one, and 
so on. To remove unused entities from the drawing database, use Layer Utility in 
the Edit/Toolbox menu. It is recommended that you only use as many divisions 
as is necessary for a reasonably accurate model. 

A drop mesh acts like a cloth dropped over the geometry. The way it drapes over 
the geometry can be adjusted with the Div-X, Div-Y, Stiffnss, Smooth, and 
SmthPass options. The mesh is made up of a grid of polygon divisions, with lines 
running in both the X and Y directions. These divisions are set with the Div-X 
and Div-Y options, and increasing these values adds flexibility to the mesh. 
Smooth adds points between the geometry to flatten the surface. SmthPass 
increases the number of smoothing passes. Stiffnss controls how closely the mesh 
coincides with the actual geometry; in other words, the lower the stiffness setting 
the more tightly it fits to the geometry. 

 To drop a mesh: 

1. Choose DropMesh from the 3DEntity/Polygon menu. Notice that the 
current settings are displayed in the Message Window. 

2. Choose Div-X and Div-Y to set the number of X and Y divisions in the 
mesh grid.  

3. Choose Stiffnss to set the stiffness of the mesh. Enter a number from 1 
through 10, where 1 is the stiffest, and press (Enter). The default setting is 
5. 

4. Choose Smooth to toggle on smoothing. This setting will have no effect 
on points created from an imported survey data file; it only works with 
vector geometry. Use of this option increases the time it takes DataCAD to 
generate the mesh. 

5. Determine if Smooth is toggled on. If Smooth is toggled on, the SmthPass 
option becomes available on the DropMesh menu. Choose SmthPass to 
set the number of smoothing passes. Enter a number from 1 through 10, 
where 1 is the minimum number of passes. 1 is the default setting.  

6. Toggle DropEdge on to model the site edges. When DropEdge is toggled 
on, EdgeHgt becomes available on the menu. Choose EdgeHgt to set the 
distance below the lowest, calculated point of the site model. The default 
edge height is 10 feet. 
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7. Toggle ShowDiag on if you want to display the diagonal polygon edges 
of the mesh. 

8. Drop a mesh over either selected geometry or imported, survey points. To 
drop a mesh over existing geometry, use the selection menu at the top of 
the DropMesh menu to select geometry in your drawing. You can select 
all of the geometry or only a portion of it. When selection is complete, 
continue with step 10. You can choose Clear at any time to cancel your 
selections. To use survey data instead, skip to step 9. You can drop a mesh 
over any geometry in the drawing except geometric primitives, such as 
spheres, cones, or cylinders. To drop a mesh over geometric primitives, 
you must first explode the entities. 

9. Make sure survey data is in a text file formatted in columns. You must use 
one of four data formats, including X-Y-Z, Y-X-Z, Angle-Distance-Height, 
and Distance-Angle-Height. To import one of these files, first choose 
ImprtScl from the DropMesh menu to set the scale for the data of the 
imported file. Then choose Import from the DropMesh menu, select a 
data format from the Files of Type drop-down box, and select a file to 
import and click Open. Points based on the survey data are displayed in 
the Drawing Window. 

10. Choose Begin from the DropMesh menu to begin drawing the drop mesh. 
Press End to cancel the mesh at any time. 
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The following series of figures demonstrate the effect that the divisions, stiffness, 
and smoothing options have on a drop mesh.  

 
Figure 24.1: Site plan drawn using contours 

 
Figure 24.2: Isometric view of contour line drawing.
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Figure 24.3A: Model using 16 x 30 divisions, a stiffness setting of 5, and Smooth toggled off.  
The isometric view to the right shows the results of these drop mesh settings. As you can see 
above, the mesh (represented by the gray line) does not always meet the points on the contour 
lines (represented by the darker line and dots). The result is a rougher approximation of the 
contour geometry. 

Figure 24.4A: Divisions are increased to 32 x 60, while the stiffness and smooth settings 
remain the same. A higher resolution mesh produces a stair-step effect with this stiffness setting. 
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Figure 24.3B: Isometric view of model using 16 x 30 divisions with stiffness set to 5 and 
Smooth toggled off. 

 
Figure 24.4B: Isometric view of model with divisions increased to 32 x 60. 
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Figure 24.5A: Divisions remain at 32 x 60 with Smooth toggled off, but stiffness is increased to 
9. The stiffness is adjusted to counter the stair-stepping effect, resulting in a closer relationship 
to the contour points. 

 

Figure 24.6A: Another way to smooth the drop mesh is to use the Smooth option. Here the 
divisions and stiffness have been reduced to their original values of 16 x 30 and 5, respectively. 
However, Smooth has been toggled on and SmthPass has been set to 5. The interpolation of 
the smoothing operation creates smoother transitions between contour points. 
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Figure 24.5B: Isometric view of model with stiffness increased to 9. 

 

 
Figure 24.6B: Isometric view of model with Smooth toggled on and set to 5. 

Drawing Topographical Maps with Contours 
Contours are curved versions of 3D lines, and like 3D lines, they have no 
thickness. Use contours to create topographical maps.  

Creating contours is similar to creating Bezier or B-spline curves. You place a 
number of control points that define the curve. DataCAD accepts up to 36 control 
points. Unlike Bezier or B-spline curves, the contour curve that DataCAD 
generates passes through the points that you draw. 

 To draw a contour: 

1. Choose Contour from the 3DEntity menu.  

2. Choose the type of contour you want to draw: Natural, Cyclic, or 
Tangent. Natural creates a contour that begins at the first control point 
you select and ends at the last point. Cyclic creates a contour that 
connects the first and last control points with a smooth curve, creating a 
closed shape. Tangent creates a contour that connects two additional 
points to the control points, creating a tangency at the end of the contour. 
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3. Use the Stiffnss option to determine the curvature as the contour passes 
through each control point. A high stiffness forces the contour to remain 
flat as it passes through each point. To set a stiffness for the contour, 
choose Stiffnss from the Contour menu, and choose or type a stiffness 
value and press (Enter). 

4. Choose Divisons and enter a value to indicate the number of line 
segments you want to use in between each control point. The further 
apart your control points, the more divisions you need. If you set too 
many divisions, your display regeneration time slows. 

5. Choose the elevation at which you want to draw this contour: Z-Base, Z-
User1, Z-User2, or Z-Hgt. Z-Base, Z-User1, Z-User2, and Z-Hgt are the 
four standard elevations at which you can enter a contour control point. 
You can use AddIndx or SubIndx to alter these values. To set the Z 
elevations, Z-User1 and Z-User2, choose one of these elevation options 
from the Contour menu, and then choose or type an elevation value and 
press (Enter). 

6. Determine if you are working with tangent contours. Only with tangent 
contours, select a first tangent point, the point before the curve. This point 
determines the direction of the curve as it enters the first control point. 

7. Select the control points. You can choose up to 36 control points for any 
one contour. You may select AddIndx or SubIndx to enter the next control 
point at a new elevation. Choose AddIndx to add the value of the Index 
setting to the current Z elevation value. Choose SubIndx to subtract the 
value of the Index setting from the current Z elevation value. 

• If you are working with tangent contours, specify the ending tangent 
point. This is the point after the curve. It determines the direction that the 
curve heads as it enters the last control point.  

Natural Cyclic Tangent  
Figure 24.7: Types of contours 

Use 3DCursor to attach a control point to a particular point on your model 
(vertex of a slab, center of a sphere, etc.), by snapping in world coordinates with 
the 3D cursor. 

You can force the contour to lie in a plane by specifying that the control points 
have a fixed Z elevation. Use the Z-Base, Z-Hgt, Z-User1, or Z-User2 toggles to 
set the height. 

Use SetIndx to help create a single contour that rises steadily in the Z direction. 
For example, to create a series of concentric contours set at 10’ intervals, use 
SetIndx to set the index to 10’. After drawing the first contour at Z-base, select 
AddIndx and draw the second contour, which would be entered into the 
drawing 10’ higher than the first, and so on. 
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 To draw a contour that steadily rises: 

1. Choose SetIndx from the Contour menu. A list of index distance values 
appears. 

2. Choose or type an index distance and press (Enter). 

 



Editing 3D Entities 
The 3DEdit menu looks similar to its 2D counterpart and, in 
most cases, works the same way.  In fact, the Erase, Layers, and 
Identify options in the 3DEdit menu are actually shortcuts to 
those menus in the (2D) Edit menu. However, keep in mind 
that the 3DEdit menu options should only be used on 3D 
entities, unless otherwise noted. See the “Rules for Editing 3D 
Entities” section in this chapter for details. 

Perhaps one of the most useful features of 3D entities is that 
you can edit them in any plan or parallel view. The 3DEdit 
menu works closely, in fact, with the 3DViews menu; all 3DEdit 
submenus have a 3DViews option, which takes you 
immediately to the 3DViews menu. In addition, to help you 
move quickly from menu to menu, the 3DEdit menu also 
includes shortcuts to the Edit menu and the 3DEntity menu. 

25 
In this chapter: 

 Rules for editing 3D 
entities 

 Moving, copying, 
rotating, stretching, 
mirroring, and enlarging 
3D entities 

 Exploding 3D entities 

 Modifying 3D entity 
attributes 
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Rules for Editing 3D Entities 
Keep in mind the following when editing 3D entities: 

• You can’t erase edges. The lines that make up a 3D entity represent the edges 
of a single entity; they are not an entity themselves. If you try to erase one 
edge of a slab, for instance, the entire slab is deleted. 

• Edit 2D entities with 2D editing options only. The Edit menu contains the 
2D editing tools you’ll need to edit 2D entities. However, the Erase, Change, 
and Explode options in the 3DEdit menu can also be used on 2D entities. 

• Many 2D editing options can be used on 3D entities. The Stretch option in 
the Edit menu, for instance, can be used on a horizontal slab. However, keep 
in mind that most 2D editing options work only in plan view. When you 
select such an editing option, DataCAD automatically changes to plan view. 

• Edit in plan or parallel views only. If your model is not being displayed in 
plan or parallel view and you select a 3D editing option, DataCAD 
automatically changes to the last plan or parallel view. 

• Select entities in any view. However, when using Entity or Group in 3D 
selection menus, you can select entities according to the following rules: 

3D line Anywhere on the line 
Polygon Any displayed edge (including the edges of voids) 
Slab Any displayed edge (including the edges of voids) 
Block Any displayed edge 
3D arc The arc’s center marker 
Cylinder Any of the three center axis markers 
Cone Any of the three center axis markers 
Truncated cone Any of the three center axis markers 
Sphere The center marker 
Torus The center marker of the sweep or the center markers at the beginning and 

end of the roll 
Contour Any control point (you can’t select the curve itself) 
Mesh surface Any displayed edge of the control grid or any of the displayed control points 

(you can’t select the surface itself) 
Surface of Rev. Any control point 
Symbol The insertion point 

With QckSnap toggled off (3DEdit/Settings menu), you can select any circular 
division of a 3D arc, cone, truncated cone, sphere, or torus; you can also select 
any edge of a single-curved facet of a surface of revolution but not an edge of a 
double-curved facet. With both QckSnap and Fast3D (Utility/ObjSnap menu) 
toggled off, you can select any displayed edge of a symbol, according to the rules 
for each entity in that symbol. 

Moving 3D Entities 
Use Move in the 3DEdit menu to move an entity to a different position on the 
screen. 3D Move works the same as the 2D Move option, with the exception of 
the following: 
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• When specifying the two points of the distance to move, the model can be in 
any parallel or orthographic view. DataCAD draws specific distances across 
the screen, but the distance and direction is taken with respect to the model in 
the current view. For example, if you view the model in an elevation view 
and specify a distance and angle to move, such as 10’ at 90°, objects that you 
select move up, off the ground plane. 

• The model displays in any view during the process of selecting entities to 
move. This makes the precise selection of individual entities or collections of 
entities easier, especially in cases where entities are stacked one upon another 
or when it is difficult to separate one entity from another. 
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Figure 25.1: Using the 3D Move option 

Choose 3DCursor from the Move menu to toggle on the world snapping cursor. 
The world cursor lets you snap directly to the objects in the model rather than to 
their projections on the screen. See “All About 3D Snapping” in the “Modeling 
Basics” chapter for more information on the world snapping cursor. 

 To move an entity: 

1. Choose Move from the 3DEdit menu.  

2. Toggle AndCopy on to copy the entity at the same time you move it. If 
you toggle AndCopy off, the entities move to the new location but do not 
copy. 

3. Select the first point of the distance to move. 

4. Select the second point of the distance to move. 

5. Choose Z-Dist to move the entity in the Z-direction relative to the plane 
on the screen. Positive distances indicate movement out of the screen; 
negative distances indicate movement into the screen. You can also use Z-
Only to set the move distance to zero (0) in the X and Y directions. Then 
select the entities to move. Entities move relative to the screen Z-axis. 
DataCAD resets the Z-distance to zero each time you choose Move from 
the 3DEdit menu. 

6. Choose a selection method and select the objects to move. Use the 
3DViews menu to reorient your view to get the best vantage point for 
selecting objects. DataCAD moves the selected entities relative to the 
plane of the screen. 

7. Choose Invert if you make a mistake and select the wrong entity to move; 
then, reselect the moved entity. The entity returns to its original position. 
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You can also use PrevDist to use the last distance and direction specified in an 
editing option. You can choose this option instead of specifying two points of the 
distance to move. Or use NewDist to enter a new move distance. This does not 
change the Z distance. NewDist only appears after you’ve entered a move 
distance. 

 To move an entity to another layer in your drawing file: 

1. Choose ToLayer from the Move menu. 

2. Choose a layer from the list, or use Match or Filter to indicate the layer to 
move to. See the instructions below to use Match and Filter. 

3. Choose a selection method and select the entity or entities to move. 

Use Match to select a layer by selecting an entity on that layer. Set the active 
layer, move objects to another layer, or point DataCAD to a specific layer, all 
without having to remember layer names. 

 To move entities to another layer using Match: 

1. Select ToLayer from the Move menu. You are prompted to Select layer to 
move to. 

2. Choose Match from the menu. You are prompted to Select entity to match. 
Use Match with any of the following Layers options: On/Off; SetActiv; 
ActvOnly; Lock; Name; EraseLyr; DelLayer; SaveLyr; ViewLyr, Select. It is 
also available when using ToLayer under Move and Copy or when using 
LyrSrch. 

3. Select an entity to select the layer it is on. You are prompted to Select entity 
to move. 

4. Select the entity you want to move to the selected layer. The entity is 
moved to the selected layer. 

Use the Filter toggle to scan, or filter, for layers with similar names. When you 
specify a prefix or suffix that the filter searches for, a list of layers with that affix 
appears. To access a layer that you don’t know the name of, use Filter to search 
for layers with a similar affix. 

For example, if you specify layers by plumbing and electrical, you might have 
layers named 1FLPLUMB.LYR, 2FLPLUMB.LYR, 3FLPLUMB.LYR, and 
1FLELECT.LYR, 2FLELECT.LYR, and 3FLELECT.LYR. To search for a plumbing 
layer, use ???plumb. You can search for first floor layers using a prefix of 1fl: 1fl* 
or 1fl?????. 

Use the asterisk (*) in place of any number of characters and the question mark 
(?) in place of each character you’re unsure of. 

The Filter toggle only appears when you are prompted to select from the list of 
layers. The filter disregards any characters following an asterisk. Therefore, if 
you entered *plumb to search for plumbing layers, all layer names would be 
displayed.   

 To filter layers: 

1. Choose Filter from the ToLayer menu to toggle Filter on. 
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2. Type the affix, including the wildcard character(s), for the layer you want 
to find and press (Enter). A list of layer files with this affix appears.  

 DataCAD also allows you to scroll through different layer groups with 
similar affixes. If the group you initially searched for doesn’t contain the 
layer you wanted, you can scroll through the remaining groups to find 
the appropriate layer. 

FiltrBack Scrolls back to a group of similarly named layers. 
FiltrFrwd Scrolls forward to a group of similarly named layers. 

3. Choose the layers you want to use. 

DataCAD remembers the last affix for which you filtered. The prefix name 
appears in the Message Window and the layer names appear in the Menu 
Window when you re-enter the Filter function. 

Copying 3D Entities 
The 3D Copy option works identically to the 2D Copy option: specify the 
distance to copy from any parallel or orthographic view, and then select the 
objects to copy in any view. 

 To copy 3D entities: 

1. Choose Copy from the 3DEdit menu.  

2. Enter the first point of the distance to copy. 

3. Enter the second point of the distance to copy. 

4. Select the objects to copy using the Selection Menu. You can use the 3D 
Viewer to reorient your view and get the best vantage point for selecting 
the objects. DataCAD copies the selected entities relative to the plane of 
the screen. 

Rectangular Arrays 

Use RectArry to create three-dimensional rectangular arrays of 3D entities at any 
orientation in space. This option works like the 2D rectangular array option, 
except that you can copy objects in the X, Y, and Z directions simultaneously, 
each with its own spacing and number of repetitions.  

 To create a rectangular array: 

1. Choose Copy from the 3DEdit menu. 

2. Choose RectArry from the Copy menu. 

3. Set the Z distance to copy if you are creating an array of more than one 
element in the Z direction. 

4. Select the first point of the distance to copy each element of the array. 

5. Select the second point of the distance to copy each element of the array.  

6. Type the number of repetitions in the array in the X direction, Y direction, 
and Z direction, pressing (Enter) after each value entered. 
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7. Choose a selection method and select the objects to copy in the 
rectangular array. You can use the 3DViews menu to reorient your view to 
get the best vantage point in selecting objects. 

 

  
Figure 25.2: Original object to copy 

 

3 copies in X
5 copies in Y
2 copies in Z

 
Figure 25.3: Resulting array 

Choose 3DCursor to toggle on the world snapping cursor. The world cursor lets 
you snap directly to the objects in the model rather than to their projections on 
the screen. See “All About 3D Snapping” in the “Modeling Basics” chapter for 
more information. 

Rotating 3D Entities 
Like all 3D editing options, you can use the Rotate option in any parallel or 
orthographic view. Choose the center of rotation, and then select the objects to 
rotate. You can rotate the objects in any order.  

 To rotate a 3D entity: 

1. Choose Rotate from the 3DEdit menu.  

2. Choose AndCopy to copy the entities at the same time you rotate them. 
To rotate entities without copying them, leave AndCopy toggled off. 

3. Select a point that defines the center of rotation relative to the plane of the 
screen. If you want the Z-coordinate of the center of rotation to be 
something other than zero, use CenterZ to enter the Z-coordinate. See the 
instructions below to set the Z-coordinate. You can use NewCentr to re-
enter the center of rotation relative to the current plane of the screen. This 
option does not change the Z-coordinate of the center of rotation. 
NewCentr only appears after you choose a center of rotation. 
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4. Choose which of the three axes (X, Y or Z) you wish to rotate around, 
relative to the screen. Use X-Axis to rotate selected entities about an axis 
parallel to the X axis of the screen and passing through the center of 
rotation. Use Y-Axis to rotate selected entities about an axis parallel to the 
Y axis of the screen and passing through the center of rotation. Use Z-
Axis to rotate selected entities about an axis parallel to the Z axis of the 
screen and passing through the center of rotation. 

5. Choose XAngle, YAngle, or ZAngle to set the angle at which entities 
rotate around the X, Y, and Z axis, respectively, relative to the plane of the 
screen at the time the center of rotation is specified. The option you 
choose should match the axis that you selected in step 3. Use XAngle, 
YAngle, and ZAngle to Choose XAngle, YAngle, or ZAngle from the 
Rotate menu, and then choose or type a value and press (Enter). 

6. Choose a selection method and select the objects that you want to rotate. 
You can use the 3D Viewer to reorient your view to find the best vantage 
point in selecting objects.  

7. Select Invert if you make a mistake and select the wrong entity to rotate. 
Then, reselect the entity. The entity returns to its original position. 

 To set the Z-coordinate of the center of rotation relative to the plane of the 
screen: 

1. Choose CenterZ from the menu. A list of values appears. 

2. Choose or type a value and press (Enter). DataCAD resets CenterZ to zero 
each time you choose Rotate from the 3DEdit menu.  

Mirroring 3D Entities 
Use Mirror to mirror entities about a plane in space. You can view a model from 
any angle in space; the mirror plane is always perpendicular to the screen. 

You define the mirroring plane the same way as with the 2D Mirror option. 

 To mirror a 3D entity: 

1. Choose Mirror from the 3DEdit menu.  

2. Choose AndCopy to copy entities at the same time you mirror them. To 
mirror entities without copying them, leave AndCopy toggled off. 

3. Select a point that defines one end point of a line in the mirroring plane. 

4. Select a point that defines the other end point of a line in the mirroring 
plane. You can use NewLine to re-enter the mirroring plane 
perpendicular to the current plane of the screen. NewLine only appears 
after you create a mirror line. 

5. Choose a selection method and select the objects that you want to mirror. 
You can use the 3D Viewer to reorient your view to find the best vantage 
point for selecting objects. 
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Stretching 3D Entities 
3D Stretch lets you stretch three-dimensional entities similarly to 2D Stretch. As 
with other 3DEntity menu options, you can specify the distance, direction and 
entities to stretch from any parallel or orthographic (plan) view. 

• Explode curved 3D entities into polygons or lines before stretching them. See 
“Exploding Entities” later in this chapter for instructions. 

• Cylinders, 3D arcs, spheres, cones, truncated cones, and tori are non-
stretchable entities. Use Enlarge to increase or decrease their size in one 
direction by an appropriate factor, or explode them into polygons and then 
stretch the polygons. 

• 3D Stretch can only be used on 3D lines, polygons (and their voids, if any), 
blocks, slabs (and their voids, if any), contour curves, and mesh surfaces. You 
can use Stretch to edit polygons, slabs, and voids. You must define the 
distance to stretch in a plane parallel to the polygon or slab you want to 
stretch, or the resulting polygon or slab may become non-planar. To make 
sure that the plane of the screen is parallel to the slab, you can use PlneSnap, 
NewElev, or EditPlne. 

• If the entity you select is contained completely within the limits of the 
selecting point, area, or fence, DataCAD moves the entity the distance you 
indicated to stretch. 

 To stretch a 3D entity: 

1. Choose Stretch from the 3DEdit menu. See the “Viewing Your Model” 
chapter for more information.  

2. Select the first point of the distance to stretch. 

3. Select the second point of the distance to stretch. 

4. Choose Z-Dist to enter a distance to stretch portions of entities in the Z 
direction relative to the plane of the screen. Positive distances indicate 
movement out of the screen; negative distances indicate movement into 
the screen. You can use NewDist to re-enter the distance to stretch in the 
X and Y directions. NewDist does not change the distance to stretch in the 
Z direction.  

5. Use PrevDist if you want to deal with the last X and Y distance and 
direction you specified in an editing option to stretch. You can use this 
option instead of specifying the distance to stretch in steps 2 and 3. 

6. Choose a selection method and select the objects that you want to stretch. 
You can use the 3D Viewer to reorient your view to get the best vantage 
point for selecting objects. 

7. Choose Invert if you make a mistake and select the wrong entity to 
stretch. Then, reselect the stretched entity. The entity returns to its original 
size. DataCAD resets the Z distance to zero each time you choose Stretch 
from the 3DEdit menu. Choose Z-Only to set the stretch distance in the X 
and Y directions to zero. Then select the entities to stretch.  
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Enlarging 3D Entities 
Use Enlarge to enlarge or scale entities to different sizes in the X, Y, and Z 
directions. Enlarge works similarly to its 2D counterpart, except that you can set 
the center of enlargement in any orthographic or parallel view. You can also 
select entities you want to enlarge in any view or orientation once you enter the 
center of enlargement. 

 To enlarge a 3D entity: 

1. Choose Enlarge from the 3DEdit menu.  

2. Choose AndCopy to copy entities at the same time you enlarge them. To 
enlarge entities without copying them, leave AndCopy toggled off. After 
you choose a center of rotation, you can use NewCentr to re-enter the 
center of enlargement. This option does not change the Z coordinate of 
the center of enlargement. To set the Z coordinate relative to the plane of 
the screen, choose CenterZ from the menu, and then choose or type a 
value and press (Enter). 

3. Select a point that defines the center of enlargement relative to the plane 
of the screen. 

4. Use XEnlgmt, YEnlgmt, and ZEnlgmt to change the current value of the 
enlargement factor in the X, Y, and Z directions of the screen, respectively. 
The enlargement factor cannot be zero. Choose XEnlgmt from the menu, 
and then choose or type a value and press (Enter). Use Reset to set all of 
the enlargement factors to 1.0. 2.0x sets all of the enlargement factors to 
2.0. 0.5x sets all of the enlargement factors to 0.5. 

5. Choose a selection method and select the objects that you want to enlarge. 
You can use the 3D Viewer to reorient your view to get the best vantage 
point for selecting objects. 

6. Choose Invert if you make a mistake and select the wrong entity to 
enlarge. Then, reselect the entity. The entity returns to its original size. 
DataCAD resets the CenterZ to zero each time you choose Enlarge from 
the 3DEdit menu. 

Exploding 3D Entities 
Use Explode to separate 3D entities into their polygonal facets or into three-
dimensional lines. After you explode an entity into lines or polygons, it is not 
possible to reverse the operation and recreate the original entity from these lines 
and polygons. 

Explode can create a large amount of data in the drawing file. For example, take 
a single sphere having 20 divisions in the sweep direction (primary divisions) 
and 10 divisions in the rise direction (secondary divisions). After an explode 
operation, this single sphere produces some 200 polygons, each of which 
occupies approximately as much drawing storage space as did the original 
sphere. A mesh surface having 20 divisions in each direction would produce 800 
polygons, which would collectively require 364 times as much drawing storage 
space as the original mesh surface. 
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• Explode separates curved entities (cylinders, cones, truncated cones, tori, 
spheres, mesh surfaces, and surfaces of revolution) into lines or polygons for 
subsequent editing operations (like stretch). 

• You can explode a text entity into 3D lines that you can then rotate in space. 
The lines then respond to a hidden line removal.  

• Explode determines the validity of exploding entities. For example, if you 
select a contour curve to explode into polygons, DataCAD ignores the 
selection and does not explode the curve because it has no polygonal 
components. 

 To explode a 3D entity: 

1. Choose Explode from the 3DEdit menu.  

2. Toggle ToLines on to explode entities into 3D lines, or toggle ToPgons on 
to explode entities into polygons. 

3. Choose a selection method and select the objects that you want to 
explode. You can use the 3DViews menu to reorient your view to get the 
best vantage point in selecting objects. 

Changing 3D Entities 
3D Change lets you change the divisions of circular entities and the stiffness of 
contours as well as colors, linetypes, line overshoots, and more. 

  To change an attribute of a 3D entity: 

1. Choose Change from the 3DEdit menu.  

2. Choose the option you want to change. 

3. Choose or enter a new value; follow the prompts in the Message Window. 

4. Choose Closed to indicate whether 3D arcs, cylinders, cones, and 
truncated cones are treated as closed solids or as open surfaces, then 
choose one of the following: 

Yes 3D entities will be treated as closed shapes 
No 3D entities will be treated as open shapes 

5. Choose a selection method and select the objects that you want to change. 
You can use the 3DViews menu to reorient your view to get the best 
vantage point for selecting objects. 

Use PrimDivs to change the number of segment divisions of circular entities. 
PrimDivs affects 3D arcs, cylinders, cones, truncated cones, spheres, tori, surfaces 
of revolution, contour curves, and mesh surfaces. For spheres, surfaces of 
revolution, and tori, PrimDivs affects only the number of segment divisions in 
the sweep direction (in the plane of the screen). For mesh surfaces, it affects only 
the number of segment divisions in the first direction. For contour curves, it 
affects the number of segment divisions between each control point of the curve.  
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Use ScndDivs to change the number of segment divisions of certain circular 
entities. This toggle affects only spheres, tori, surfaces of revolution, and mesh 
surfaces. For spheres and surfaces of revolution, it affects the number of segment 
divisions in the rise direction. For tori, it affects the number of segment divisions 
in the roll direction. For mesh surfaces, it affects the number of segment divisions 
in the second direction.  

Use Stiffnss to change the stiffness factor associated with contour curves. Stiffnss 
affects only contour curves. The stiffness can be any number except zero. 
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Viewing Your Model 
DataCAD gives you several ways to view your model to help 
you draw and create views for plotting or presentations. While 
there are many different kinds of views, only plan, parallel, 
perspective, and oblique are commonly used for architectural 
models, and DataCAD lets you customize each of these types of 
views. You must use a parallel or plan view for editing your 
drawing, while perspectives and obliques are most often used 
for visualization, rendering, and presentations. 

Once you have a view defined, you can perform a hidden line 
removal of it or shade it. You can save any hidden-line, shaded, 
or standard 3D view and then link any entity in your model to 
that view to easily display it. You can even create walk-
throughs of your model. 

The o2c-based object viewer provides real-time, dynamic, 
shaded 3D views of DataCAD models. You can adjust many of 
the o2c settings and save them as high-quality rendered 
images. 
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views 

 Shading your model 

 Performing hidden line 
removals on your model 
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views 

 Creating walk-throughs 

 Using the o2c-based 
object viewer 
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Ortho (Plan View)

Plan Oblique (Axonometric View)

Parallel (Isometric View)

Perspective (Two point)Perspective (Three point)

Elevation Oblique

Parallel (Isometric View)

Perspective (One point)

Back (Parallel View)

Front (Parallel View) Left (Parallel View)

Right (Parallel View)

 
Figure 26.1: Examples of views you can create in DataCAD 
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Creating Parallel Views 
Parallel in the View pull-down menu restores the last parallel view you 
generated and displays the globe. Elevations and isometrics are parallel views 
but by no means the only ones. Because these two cases are used so frequently, 
they have their own menu selections. It may help, however, to remember that 
these are just different kinds of parallel views. You can, in fact, choose any eye 
point to create a parallel view. See “More About Changing the Eye Point for a 
View” later in this chapter for more information on the globe display and how it 
affects parallel views. 

Elevations and isometric views can be quickly created in DataCAD in just a few 
steps. Isometric views can be created by simply choosing Isometric from the 
View pull-down menu in the Menu Bar or by choosing Isometrc from the 
3DViews menu. You can use the Viewer Toolbar to work with any parallel view. 
Choose Viewer Toolbar from the View pull-down menu. This toolbar will 
automatically change when you change your view to any parallel view or to 
orthographic (plan) view. 

More About Rotation Angles in 3D Views 

In 2D, positive rotation angles go counterclockwise; in 3D, the concept is a bit 
more complex. This rotation angle of -90° flips the model to the left. DataCAD 
uses the right-hand rule to indicate the direction in which positive angles run. To 
understand the right-hand rule, point the thumb of your right hand in the 
direction of the axis in question. Your fingers curl in the direction of positive 
rotation. The Y-axis goes up, so when you point your thumb up, your fingers curl 
toward you a counterclockwise direction. Negative angles, therefore, run in a 
clockwise direction. 

90°

POSITIVE AXIS OF ROTATION  
Figure 26.2: Right-hand rule 
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More About Changing the View Center 

When you create the first parallel view in a drawing, DataCAD calculates the 
view center by examining the extents of the model. DataCAD generates all 
parallel views with the assumption that the model is situated over a point called 
the view center, or the point in space at which the observer is looking. DataCAD 
places the view center in the middle of the extents, halfway between Z-base and 
Z-height. Ideally, this is somewhere near the center of the model.  

The view center is not attached to the model in any way, so if the model moves, 
the view center does not change. Be careful when you use Globe. Sometimes 
models spin off the screen completely because the globe is always situated 
directly over view center. Reposition the view center to somewhere inside the 
model to avoid this problem. 

The view center in a perspective view is always the point of intersection between 
the picture plane and the line of sight. 

 To reposition the view center: 

1. Choose Reset from the Controls menu. Reset places the drawing in the 
last orthographic view you generated. This helps you find a center of the 
model. 

2. Choose ViewCntr; an Auto option becomes available. 

3. Select a new center point in one of the following ways: 

• select a point in the center of the model 

• choose Auto to calculate a view center with the center point halfway 
between Z-base and Z-height 

The new view center is set, and you return to the Controls menu. 

Both the NewElev and EditPlne options change the view center implicitly. In 
both of these options, you select a point on the plane where Z=0. This point 
becomes the new view center for parallel views. This point also becomes the new 
grid origin for grid snapping. See “Creating Perspective Views” later in this 
chapter for more information on the view center in a perspective view. 

More About Changing the Eye Point for a View 

The globe display is used to reorient your eye point in a parallel or perspective 
view; it is automatically displayed on screen whenever you choose a parallel or 
perspective view. Selecting a point inside the globe display indicates the new 
observer position for viewing the model. 

In perspective views, the globe changes the elevation of the observer’s eye point 
and the direction from which you observe the model (north, south, east, or west), 
but it does not change the view center, the distance to the object, or the cone of 
vision. 

In a parallel view, the globe sets the observer’s eye point above or below the 
ground plane at which the observer stands. The center of the globe represents a 
point directly over view center and all points on the outer circle represent a point 
in space directly below the view center looking up. 
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Figure 26.3: Globe perspective 

To visualize how the globe operates, imagine that the model sits inside a large 
sphere. Half of the sphere is above the ground plane, and half of it is below, with 
the ground plane cutting the sphere at the equator. The equator of this sphere is 
represented as the inner circle on the globe. All points inside this circle, therefore, 
are the upper half of the sphere (above ground) and all points outside the inner 
circle are the lower half of the sphere (below ground). 

While the Globe display is in the upper-left corner of the screen by default, you 
can use the Globe option in the 3DViews menu to reposition the globe on the 
screen. You can: 

• Move the globe to a different location on the screen so that you can continue 
to work on a part of the model without interference 

• Change the size of the globe; a larger globe gives you finer control over the 
rotation of a parallel or perspective view 

 To move the Globe display: 

1. Choose Globe from the 3DViews menu. The Globe menu is displayed: 

Default Returns the globe to its customary position in the upper-left corner of the 
Drawing Window 

2. Select a new center for the globe. Move your mouse to dynamically size 
the Globe display. 

3. Select a point on the perimeter of the new globe. The globe moves to the 
selected position. 

Use Controls to specify a vantage point for a parallel view. You can think of the 
Controls menu as a more accurate version of Globe and just another way of 
generating parallel views. You can use the Controls menu to position the view 
center inside the model for smoother operation of the globe.  

When you choose Controls from the 3DViews menu, a toolbar appears at the top 
of the screen, along with the Controls menu in the Menu Window. 

The cursor you see while you are in the Controls menu displays the current 
orientation of the X, Y, and Z world coordinate axes.  
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Figure 26.4: Screen coordinates vs. world coordinates 

The Screen option rotates the view around the screen coordinate axes. Screen 
coordinates refer to the right-handed coordinate system that you worked with in 
2D. The +X axis goes to the right, the +Y axis goes up, and the +Z axis comes out 
of the screen. This does not change. 

The World option rotates the view around the world coordinate axes. World 
coordinates refer to the right-handed coordinate system associated with the 
model. Imagine that your model is in orthographic view, and you attach the 
screen coordinate axes to the model itself. What you have is a set of three axes 
known as world coordinate axes. These do not change with respect to the model 
but do change with respect to the screen. 

When you choose any of the Rotate options, DataCAD rotates the view by a set 
number of degrees around the axis you indicate.  

Reset changes the current view to the last orthographic view taken. Reset also 
brings the model back into view in case it moves off the screen. Use this option 
before using ViewCntr. 

RotAngle controls the number of degrees that the object rotates under any 
Rotate+ or Rotate- options. 

Four additional input modes are available in the Controls menu: relative and 
absolute cylindrical (distance, angle, Z coordinate) and relative and absolute 
spherical (distance, plan angle, rise angle). These modes provide additional 
variables to the Z component of coordinate entry, which may be helpful in 
specialized modeling applications like entering a 3D line that represents a solar 
angle. 

 To set the rotation angle: 

1. Choose RotAngle from the Controls menu. A list of rotation angles 
appears. 

2. Choose or type a value and press (Enter). 
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AddView adds the current parallel view to the list of saved views. 

Creating an Isometric View 
Isometric creates a true isometric view. Isometric views are a special parallel view 
where the X- and Y-axes of the model form a 30° angle from the horizontal. To 
make sure that the angle is precise, choose Isometrc from the 3DViews menu in 
the Menu Window or choose Isometric from the View pull-down menu in the 
Menu Bar at the top of the screen. 

Creating Elevations 
Elevations are a special kind of parallel view. When you view an elevation in 
plan, the front of the model faces the bottom of the screen. 

Use Front to view the front elevation of the model. Use Back to view the back 
elevation of the model. Use Right to view the right elevation of the model. Use 
Left to view the left elevation of the model. 

In addition to the four preset elevations—Front, Back, Left, and Right—you can 
create non-orthogonal elevations. You can use New to generate views for 
rendering or to orient the model for a side view in which you can precisely place 
the zero plane, Z-base, and Z-height. If you choose a Front Elevation, you cannot 
guarantee where Z-base and Z-height are in relation to the new view.  

 To create a new elevation: 

1. Choose NewElev from the 3DViews/Elevtion menu in the Menu 
Window, or choose Elevation/New from the View pull-down menu in the 
Menu Bar at the top of the DataCAD screen. The view changes into plan 
view so that you can specify the elevation line. CenterZ appears in the 
Menu Window. 

2. Choose CenterZ to set the height of the view center. You must choose this 
option before you select the first point in the new elevation indicator. A 
list of values is displayed in the Menu Window. 

3. Choose or type a value and press (Enter). 

4. Select a point to lie on the new zero plane (such as the corner of a wall). 
This point also serves as the new view center and grid origin. 

Move the cursor and it changes into a New Elevation Indicator. There are 
several parts to this cursor: 

Z-base indicator 
Z-height indicator 
Zero plane (the plane at which Z = 0) 
Direction of view 
The Z-base and Z-height indicators may not be visible if their values 
appear off the screen or if their values are set to zero, in which case these 
indicators coincide with the zero plane. 



|  CHAPTER 26: VIEWING YOUR MODEL  472

 

The Zeroplane (Z=0)

New view center
and grid origin

Z-Height

Z-Base

Out of the screen Into the screen  
Figure 26.5: The new elevation indicator 

5. Adjust Z-base and Z-height if necessary. The indicators change position to 
show you the new location of Z-base and Z-height. Remember that 
negative distances go in the direction of the view (into the screen). 

6. Select a point in the direction of the view. The specified view appears on 
the screen. 

Options for creating front, back, left, right, and new elevations are available from 
both the View/Elevation menu in the Menu Bar at the top of the DataCAD screen 
and the 3DViews/Elevtion menu in the Menu Window. 

 To add the current elevation to the list of saved views: 

1. Choose AddView from the Elevation menu. 

2. Type the name of the new view, up to eight characters, and press (Enter). 
The view is added to the list of saved views. 

More About the New Elevation Indicator Cursor 

This cursor has an arrow indicating the direction of the new zero plane position 
and a tail representing the current Z-base and Z-height settings. (The end of the 
tail nearest the crosshair is Z-base and the end furthest from the crosshair is Z-
height.) If Z-base is set to 0, the tail meets the crosshair; if Z-height is set to 0, the 
end of the tail won’t be displayed. 
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Figure 26.6: The New Elevation Indicator cursor with Z-base=0 and Z-height=8 

Creating Perspective Views 
DataCAD can generate one-, two-, and three-point perspectives. The differences 
between these perspective types lie only in the location of the eye of the observer 
(EyePntZ) and the point in the model at which the observer is focusing 
(CentPntZ). 

You can use the Viewer Toolbar to work with your perspective view. Choose 
Viewer Toolbar from the View pull-down menu. This toolbar will automatically 
change when you change your view to any parallel view or to orthographic 
(plan) view.   

For each perspective type, you must select an eye point for the observer and a 
view center to mark the point in the model where the observer is looking. When 
you select the first point the cone of vision is displayed. See “More About 
Changing the Eye Point for a View” earlier in this chapter for more information 
on the globe. 

Cone of Vision

View Center
Eye Point
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Line of Sight

 
Figure 26.7: Cone of vision for perspective view 
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The line that cuts across the cone of vision is the picture plane. Things in front of 
this plane (on the same side as you, the observer) appear larger than normal; 
things behind the picture plane appear smaller.  

The line that leads directly from the eye point to the view center is the line of 
sight. As with parallel views, always place the view center somewhere inside the 
model so that the globe is stable and predictable. 

Establishing Perspective Settings 

 To set the elevation of the observer’s eye point: 

1. Choose EyePntZ from the SetPersp menu. A list of perspective eye point 
values appears. 

2. Choose or type a value and press (Enter). 

 To set the elevation of the center of the view: 

1. Choose CentPntZ from the SetPersp menu. A list of values appears. 

2. Choose or type a value and press (Enter). 

The Reset option in the SetPersp menu returns you to a perspective view using 
the current settings in this menu. 

Use HthrClip to reduce the fisheye distortion that can appear in close-up 
perspectives. You can also increase the hither clip distance to partially cut your 
model shown in perspective view, and then create a shaded “sectional 
perspective” with the Quick Shader menu. The hither clip plane is displayed as a 
crosshair on the cone of vision. 

 To use Hither Clip: 

1. Choose HthrClip from the SetPersp menu. A list of values appears. 

2. Choose or type a value and press (Enter). 

 

60°

Hither-clip distance

Cone of Vision

View Center

Eye Point

Picture Plane

Line of Sight

 
Figure 26.8: Cone of vision with hither clip 
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Toggle FixCone on in the SetPersp menu to fix the width of the cone of vision. 
The width of the field of vision in a fixed cone is set using either ConeAng or 
Camera. 

 To set the width of the field of vision to an angle using ConeAng: 

1. Choose ConeAng from the SetPersp menu. A list of values appears. 

2. Choose or type a value between 1 and 179 degrees and press (Enter). 

 To set the width of the field of vision using Camera: 

1. Choose Camera from the SetPersp menu. A list of values appears. 

2. Choose or type a value and press (Enter). Camera sets the width of the 
field of vision by expressing it as the length of a camera lens. The longer 
the lens, the narrower the cone of vision. 

Creating a One-Point Perspective 
Create one-point perspectives by choosing an eye point at the same elevation as 
the view center; the observer is looking straight ahead, neither up nor down. A 
one-point perspective must have the picture plane parallel to one of the frontal 
faces of the model. 

 To create a one-point perspective: 

1. Choose SetPersp from the 3DViews menu. When you choose Prspect from 
the 3DViews menu for the first time in a drawing, the SetPersp menu is 
automatically displayed so you can set up the perspective view. 

2. Set EyePntZ to a reasonable value. When an observer is standing on the 
ground, 5’ is a typical height for the observer’s eye. 

3. Set CentPntZ to the same elevation you used in step 1. 

4. Select a point for the eye point.  

5. Select a point inside the model for the center point. Use ortho mode to 
make sure that the line of sight is perpendicular to one of the faces of the 
model. 

EyePntZ

CentPntZ

Line of Sight at 90
degrees to the front
plane of the model

 
Figure 26.9: One-point perspective 

Creating a Two-Point Perspective 
Use two-point perspectives to relax one of the two constraints that you placed on 
one-point perspectives. You can either: 

• Set the eye point and center point at different elevations and keep the line of 
sight perpendicular to one of the frontal faces of the model; or 
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• Keep the eye point and center point Z the same and set the line of sight at an 
angle other than 90°. 

  
Figure 26.10: Two-point perspective 

Creating a Three-Point Perspective 
Three-point perspectives are generated when the eye point Z elevation is 
different from the center point Z elevation and the line of sight is at an angle 
other than 90°. With these constraints, set the eye point Z and the center point Z 
appropriately and choose these points in your model. 

 

Line of Sight not
perpendicular to
the front planes
of the model

EyePntZ = CentPntZ  
Figure 26.11: Three-point perspective 

Perspective Navigation Controls 
Hotkeys and MouseWheel controls automate perspective setup and navigation 
by using video game-style controls. For more detailed information about the 
navigation aids, see “Walking Through Your Model” later in this chapter. 

Creating Oblique Views 
DataCAD can create both plan obliques (architectural axonometrics) and 
elevation obliques. Choose PlanObl to create a plan oblique or choose ElevObl to 
create an elevation oblique. If this is the first time you’ve chosen ElevObl, follow 
the directions for selecting the NewElev option in the SetObliq menu. See 
“Creating Elevations” earlier in this chapter for more information on the 
NewElev option. 
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Establishing Oblique Settings 
The SetObliq option, which is only available after you select ElevObl, defines 
which elevation of the model you want to use as your frontal elevation in 
constructing the oblique view. It works exactly the same way as the NewElev 
option in the 3DViews/Elevtion menu.  

OblqAng controls the angle of rotation before the plan oblique is taken. Angles 
are usually between 30° and 45°. For elevation obliques, this setting controls the 
angle at which the lines sweep away from the elevation. 

Creating an Elevation Oblique View 

 To create an elevation oblique view: 

1. Select Elevtion from the 3DViews menu. 

2. Choose ElevObl from the Elevation menu. 

 

Oblq Ang
45 degrees

Oblq Ang
30 degrees 

Figure 26.12: Elevation oblique 

Creating a Plan Oblique View 

 To create a plan oblique view: 

1. Select Elevtion from the 3DViews menu. 

2. Choose PlanObl from the Elevation menu. 

Oblq Ang
30 degrees

Oblq Ang
45 degrees 

Figure 26.13: Plan oblique 

Creating a Hidden Line Removal 
Use Hide to perform hidden line removals in DataCAD. DataCAD’s hidden line 
removal system is a two-pass system with an additional initialization step. The 
initialization step performs a few simple and quick operations: allocating 
memory, calculating the limits of your model for a specified view, and initializing 
the temporary hidden line removal database. 
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The hidden line removal process does not recognize text and associative 
dimensions; therefore, they do not appear after a Hide. To display these entities 
after a Hide, convert them into 3D lines with the 3D Edit, Explode command. 

Pass one, the calculating pass of the hidden line removal system, scans through 
the entire model and temporarily separates it into a series of polygonal faces or 
free lines, as follows: 

• DataCAD breaks entities like 2D lines (having height), polygons, slabs, 
blocks, cylinders, etc., into a series of polygons that the hidden line removal 
system can understand and interpret.  

• DataCAD breaks entities like 3D lines, contour curves, 3D arcs, etc., into a 
series of free line segments. Free line segments are assumed to be infinitely 
thin. 

• DataCAD also recognizes voids in polygons. 

Pass two of the hidden line removal process is where most of the work takes 
place and, consequently, usually takes longer. Each line segment that is 
potentially a visible edge or a free line is compared with each polygonal face. 
DataCAD uses the tests to determine if the line segment lies completely in front 
of, completely behind, straddles, or pierces a given polygon. 

Depending on the results of these tests, the line is either eliminated from 
consideration, split into one or more pieces, or left intact to be tested later against 
the remaining polygons. If, after having been compared against all of the possible 
polygons, some portion of the line segment remains, DataCAD displays the 
segment and optionally adds it to a temporary database for the saved image. 

DataCAD uses a number of optimization techniques for reducing the computing 
time of the display pass to a minimum. 

 To perform a hidden line removal: 

1. Choose Hide from the 3DEdit menu, or choose Hidden Line Removal 
from the View pull-down menu. Set the following options as necessary: 

Begin Starts the hidden line removal process and displays operation’s progress in 
the Message Window; press (Delete) or (End) to cancel the hide at any time 

SaveImg Save the image produced by a hidden line removal 
CropImg Performs a hidden line removal only on the portion of the model that is 

visible on the screen  
HLRpart Divides the Drawing Window into smaller sub-areas for faster hides 
Pierce Performs piercing calculations during hide, causing slower hidden line 

removals; to speed up a hide, toggle Pierce off whenever piercing 
calculations are not necessary  

Pierce Off Pierce On

 
ClipBox Hides the portion of the model that is contained within the previously 

defined ClipCube; available only for parallel views of your model; to create 
a similar clipping effect for perspective hidden line images, use HthrClip in 
the 3DViews/SetPersp menu 

All Performs hidden line removals on entities on all layers toggled on 
ActivLyr Performs a hidden line removal only on the entities on the active layer 
SelSet Performs a hidden line removal only on the entities in the active selection set  
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Options Settings to perform different functions within a hidden line removal 
3DViews Sets the view for the model prior to the hidden line removal; since the image 

created by the hidden line removal process contains only 2D lines, the image 
is best viewed in an orthographic view 

2. Choose 3DViews from the Hide menu and orient the model so that you 
can see the image.  

3. Choose Exit to return to the Hide menu. 

4. Choose Begin to start the hidden line removal process. 

Tips on Maximizing Performance 
• Use lines rather than polygons whenever possible. For example, if you want 

to draw some rectangles on the faces of a slab block to schematically 
represent windows, use 3D lines instead of polygons to outline the windows 
to increase performance. Since the rectangles are simply inscribed on the face 
of the slab, polygons are not needed; there is nothing to hide. 

• Use three-dimensional entities like blocks, cylinders, and slabs instead of 
collections of 2D lines and simple polygons. 

• Keep models as simple as possible. As the size of the model increases, the 
time required to compute a given image increases at a faster rate. You may 
consider placing some of the detail for a given model on separate layers so 
that you can temporarily toggle some layers off for preliminary runs of the 
hidden line removal system. After you complete the modeling process, you 
can then toggle on all applicable layers and perform this more complicated 
hidden line removal analysis on the complete model. 

Saving the Hide Image 
If you toggle SaveImg on before you choose Begin, DataCAD saves the hidden 
line removal image for later use; if SaveImg is toggled off, DataCAD does not 
save the image and only displays it on the screen. 

Once the hidden line removal process is complete, the SaveImg menu is 
displayed: 

ActvLyr 
NewLyr 
LyrFile 
Offset 

 

 To add a retained image to the active layer: 

1. Use (Tab) and (Shift) + (Tab) to scan through the available layers to select the 
layer to add the new image to. DataCAD saves the image to the active 
layer. 

2. Choose ActvLyr after the hidden line removal process is complete. 
DataCAD adds the image to the active layer; you return to the Hide 
menu. 



|  CHAPTER 26: VIEWING YOUR MODEL  480

 To add the retained image to a new layer in the drawing: 

1. Choose NewLyr at the completion of the hidden line removal process to 
create a new layer for the drawing. 

2. Enter a name for the new layer. 

3. Indicate whether you want the new layer on or off. If you plan to create a 
series of images, leave the layer off to return directly to the Hide menu 
and create a new image. 

 To add the retained image to a layer file: 

1. Choose LyrFile at the completion of the hidden line removal process. 

2. Enter the name of the layer file you want to create. DataCAD lists the 
layer files in the current layer folder in a dialog box.  

If you click Cancel in the dialog box without specifying a layer file, DataCAD 
deletes the image. 

The image created by the hidden line removal process contains only 2D lines; 
you can use all of the normal DataCAD editing operations on the resulting image 
such as erasing, trimming, enlarging, moving, rotating, stretching, and hatching. 
Since the image contains 2D lines, an orthographic view is the best view. 

Before you choose ActvLyr or NewLyr, you can offset the image in the XY-plane 
by some distance. This helps you to create a composition of views by arranging 
them on the screen apart from each other.  

 To offset an image: 

1. Choose Offset after completion of the hidden line removal process. 

2. Select the first point of a distance to offset the image in the plane of the 
screen. 

3. Select the second point of a distance to offset the image in the plane of the 
screen. 

4. Choose either ActvLyr or NewLyr and proceed with the instructions 
listed above for adding the image to the drawing. 

Choose Cancel to delete the retained image and return to the Hide menu. 
Remember that after the hidden line removal process, if you toggle SaveImg on, 
DataCAD saves the image before you select a destination for it. If you choose 
Cancel, DataCAD deletes the previously saved image from the drawing and 
makes this space available. 

Increasing Hide Speed  
Use HLRpart to partition the Drawing Window into smaller sections, allowing 
for faster hides. Hide treats each section separately, resulting in continuous lines 
being divided. It also allows you to see sections in their entirety as the hidden 
line removal progresses.  

 To change Drawing Window partitions: 

1. Choose HLRpart from the Hide menu. 
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2. Choose Seg-X. 

3. Type a new value and press (Enter). 

4. Choose Seg-Y. 

5. Type a new value and press (Enter). 

Hide Options 
Use Options in the Hide menu to perform different functions within a hidden 
line removal. 

Editing Hidden Line Removal Images 

If you use HLRpart to partition your hidden line removal image, continuous 
lines will be broken wherever they cross a partition. While these breaks aren’t 
visible, they can make editing that image time-consuming, if not difficult. Using 
the Join option allows you to more easily edit the hidden line removal image 
after it is complete. When you perform a hidden line removal with HLRpart on, 
toggle Join on in the Hide/Options menu to weld (reattach) lines on a model. 

Deleting Double Lines 

The DelDoubl option in the Hide/Options menu deletes any double lines in the 
model that were created as a result of performing a hide with Join and HLRpart 
on. 

Drawing Hidden Lines 

If the DrwHidn option in the Hide/Options menu is on before you choose Begin, 
DataCAD draws hidden lines using the line color, linetype, and line spacing you 
set by the HidnColr, HidnStyl, and HidnSpac options. If you toggle DrwHidn off, 
DataCAD does not draw the hidden lines. 

  
Figure 26.14: DrawHidn with a dashed linetype 

Disregarding Back Faces 

Use the BackFace option in the Hide/Options menu for a faster Hide 
performance. DataCAD calls all polygonal faces facing away from the viewer 
backfaces. With this toggle on, DataCAD ignores the backfaces for a hidden line 
removal. This decreases the amount of area to hide and the time it takes to 
complete the hidden line removal. 
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Hidden Line Colors 

Use the HidnColr option in the Hide/Options menu to change the color used to 
draw the hidden lines. This color menu works exactly like its 2D counterpart. See 
“Color Menus” in “The Drawing Board” chapter for more information on the 2D 
options. 

Hidden Linetypes 

Use HidnStyl to change the linetype used to draw the hidden lines. When you 
toggle DrwHidn off, HidnStyl is ignored. When you toggle DrwHidn off, 
HidnColr is ignored. 

 To change the hidden linetype: 

1. Choose HidnStyl from the Options menu. A list of linetypes is displayed. 

2. Select a new linetype for hidden lines. 

Hidden Line Spacing 

Use HidnSpac to change the line spacing used to draw hidden lines. When you 
toggle DrwHidn off, HidnSpac is ignored. 

 To change the hidden line spacing: 

1. Choose HidnSpac from the Options menu. A list of spacing values is 
displayed. 

2. Choose or type a new spacing value and press (Enter). 

Closing 2D Arcs 

Unlike 3D arcs and 3D cylinders, ordinary 2D arcs do not have an option for 
being treated as closed objects. If you toggle CloArc2 on in the Hide/Options 
menu, DataCAD treats 2D arcs as closed, which makes them opaque to the 
hidden line removal process. 2D arcs that have a Z-height work like cylinders 
with closed ends and sides. If you toggle CloArc2 off, during the hidden line 
removal process, DataCAD treats 2D arcs as ordinary curved lines (arcs with no 
Z-height) or open-ended cylinders (arcs having Z-height). 

CloAr2 On CloAr2 Off

These are 2D circles, not cylinders.  
Figure 26.15: 2D circles 
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Closing 2D Ellipses 

If you toggle CloEllp on in the Hide/Options menu, DataCAD treats 2D ellipses 
as closed, solid objects during the hidden line removal process. If you toggle 
CloEllp off, DataCAD treats ellipses as ordinary curved lines (no height) or 
curved surfaces (having height) with no top or bottom. 

Displaying Outlines Only 

Toggle NoEdge on in the Hide/Options menu to display the outline of tori and 
cylinders. NoEdge does not display any other divisions of these entities. 

2D Arc Divisions 

During the hidden line removal process, DataCAD uses the current value of the 
circle divisions setting. This Divisons option is duplicated on the Hide/Options 
menu for convenience in adjusting the current value of this variable. Choose 
Divisons from the Hide/Options menu and set it to an integer value from 4 to 36. 

Automatic Hidden Line Removals 
Use AutoHide to perform hidden line removal on multiple views, or batches. 
Choose AutoHide from the ViewMast menu, and choose from the following 
options: 

Begin Displays selected views on the screen in sequence; after the last view appears, the 
sequence begins again. To stop the sequence, press (End) 

Select Adds or removes views from the sequence; choose the view to add to the sequence, or 
choose the view to remove from the sequence 

ClearAll Clears all viewing selections and you can reset sequences 
SelctAll Selects all views and adds them to the sequence 
LayrSet Sets all layers as views 
DrwHidn Draws hidden lines in the hidden line removal images 
ToScreen Sends the hidden line removal images to the screen only 
ToLayer Sends the hidden line removal images to a layer only 
ToLyrFil Sends the hidden line removal images to a layer file only 
LyrPath Specifies the folder to contain the created layer files 

Creating a Shaded Image 
DataCAD’s Shader creates a shaded image of your model by temporarily breaking 
it down into 3- and 4-sided polygons and then shading the surfaces according to 
light source and shader settings. You can define and place up to seven light 
sources in your model and use ambient light as well. These light sources are 
specific points that radiate light out in all directions and can be toggled on or off 
to create different lighting effects. Each surface of your model is illuminated 
independently of the others, so one surface will not cast a shadow on its 
neighbor. The only factor that affects the light on a surface is the distance of the 
light source from it. The Shader supports all 256 colors in the DataCAD palette as 
well as a rendering palette of 16.8 million colors. 

 To create a shaded image of your model: 

1. Go to the Edit menu in the Menu Window and click on DCAD 3D. The 
3D Edit menu is displayed. 

2. Click on Shader in the 3D Edit menu. The Shader menu is displayed.  
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3. Click on Settings in the Shader menu. The Shader Settings dialog box is 
displayed, allowing you to change light source settings, the background 
color or image of the shader window, how edges are shaded and more. 
The settings in the Shader Settings dialog box are also available 
individually in the Shader menu in the Menu Window. You can use either 
the dialog box or the menu to change settings; all changes will be 
reflected both in the dialog box and the menu options. 

 
Figure 26.16: The Shader Settings dialog box 

4. Change the Light Settings by choosing the light source whose settings 
you want to change from the Light Source list box. Then, follow the 
instructions below: 

• The light sources are named LtName1, LtName2, etc., by default. To 
rename the light source, click in the Name input box and type a new 
name. The name will be updated in the Light Source list box when you 
either click in the list box or click OK to save the shader settings. 

You can also position a light source by simply clicking anywhere in the Drawing 
Area. Click on the light source name in the Menu Window, click On/Off in the 
menu if the light source has not yet been toggled on, and then choose Position 
from the menu. A 3D cursor is displayed in the Drawing Window; note the 
cursor’s coordinates displayed in the Message Window. Click to place the light 
source. Please note that you cannot use the light source settings in the Shader 
Settings dialog box to position the light using this method. 

• The light source’s intensity is the percent of white used in the light, with 
percentage values ranging from 0 to 100. To set the intensity of the light 
source, use the up and down arrows to increase or decrease the percent 
value, respectively. 

• To enter specific coordinates for a light source, click in the X, Y, Z 
Coordinate input boxes and type new coordinates. (The left input box is 
the X coordinate, the middle input box in the Y coordinate, and the right 
input box is the Z coordinate.)  

• To toggle a light source on or off, click in the On/Off checkbox. 
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• To give the light source the ability to cast shadows, toggle Cast Shadows 
on. Note that shadows are not actually cast in the shaded image unless 
Cast Shadows in the bottom right corner of the dialog is checked. 

• The intensity of ambient light can be adjusted just as light source intensity 
was. To set the ambient light intensity, use the up and down arrows to 
increase or decrease the percent value, respectively. 

5. Repeat the previous step for each light source you want to customize. 

6. Go to the Shader Window section. You can customize the background 
color of the Shader window, change the size of the shaded image, and 
change how you move from the shaded image back to your drawing: 

• To change the background color, click on the colored rectangle in the 
Shader Window section. Click on a new color in the Color Palette dialog 
box, and then click on OK. 

• Click on the Right-Click to Exit checkbox to check this option; this will 
allow you to close the shader window by simply right-clicking. Uncheck 
this option to use a pop-up menu to quickly save your image, move 
between images and your drawing, or import your shaded image into 
eZmeeting. 

• The shaded image is created as a bitmap (.BMP) file. You can adjust 
Bitmap Size by using the up and down arrows to increase or decrease the 
percent value, respectively, with 100% being the full size of the Drawing 
Area. You can go as high as 1,000%, depending on how much system 
memory you have available. 

10. Go to the Edge Type section. Click on No Edge to shade only the surfaces 
of your model, click on Show Edge to shade both the edges and surfaces, 
or click on Edge Only to shade only the edges (similar to a hidden line 
removal with lights). The default setting is No Edge. 

11. Add edge and overshoot lines to your shaded image.  

• To set the length of the overshoot, click in the Length input box and type 
a value. The default length is 0.0. 

• To set the width of the lines used for edges and overshoots, use the up 
and down arrows to enter a width in pixels. The default is 1. 

• To draw edge/overshoot lines in the same color as the entity’s surface, 
check the Use Entity Color checkbox. This is checked by default. If you’d 
like to use a different color, uncheck the box, click on the color swatch to 
the right, and choose a new color. The Edge/Overshoot Properties section 
is only available when Show Edge is toggled on. 

12. Use the HighLight setting to produce a visible area of light around a light 
source, much like a lamp throws on a wall and ceiling. This setting is off 
by default, but you can set it to three intensities, with Large being the 
most intense. 
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13. Choose a background image for your shaded image by clicking on the 
folder icon in the Background Image section and choosing a .BMP or .JPG 
file. Leave Maintain Aspect checked to ensure the background image 
covers the entire Shader window. You cannot customize the size of the 
background image. 

14. Go to the bottom right corner of the dialog box. Check Render Both Faces 
to render both sides of a polygon, instead of rendering only the side with 
the positive normal. When this option is unchecked, any negative 
normals of polygons that face you will not be rendered, unless “Normals 
towards viewer” is checked in the following step. 

15. Check “Normals towards viewer” to set the positive normals of all 
polygons so that they face you. Uncheck this option to leave positive 
normals facing their original direction. 

16. Cast shadows in your shaded image, according to the light sources you 
set for shadows in step 4, by checking the Cast Shadows box in the lower 
right corner of the dialog box. (Note that you must still complete steps 19 
– 21 to actually draw the shadows.) 

17. Make sure the Show Lights checkbox is checked on. This option displays 
the light sources as small symbols around your model, letting you see 
exactly where they are positioned. These symbols do not print; they are 
only displayed for visual reference. 

18. Click OK to save your new settings and close the Shader Settings dialog 
box. 

19. Cast shadows in your shaded image by clicking on Shadow in the Shader 
menu. Then, toggle AddShado on. You are prompted to “Select entity to 
receive shadow”.  

20. Select the entity on which the shadow will fall, the polygon acting as the 
floor or ground plane for instance. Use the selection menu to select and 
highlight the entity. If you select the wrong entity, toggle AddShado off 
and select that entity again. Repeat this step to select the correct entity. An 
entity cannot cast a shadow and receive one (have a shadow fall on it) at 
the same time. 

21. Right-click to exit the Shadow menu and return to the Shader menu. 

22. Click Shade in the Shader menu. Your model is shaded and the bitmap 
image is displayed in the Drawing Area. You can now save the shaded 
image as a bitmap file or return to your drawing file. You can save your 
settings and then use them later without having to change all the Shader 
settings again. See “Saving and Using Shader Settings” later in this 
chapter. 

More About Polygon Normals 

A characteristic of a polygon surface is its orientation, or normal. Think of a 
polygon as a sheet of paper that only allows you to write on one side. This side is 
the positive normal, while the other side is the negative normal. In a visual sense, 
polygons are one-dimensional, as they may only be seen from one side in a 
rendered view.  
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To quickly shade your model without changing any Shader settings, click on 
Shade in the View pull-down menu. Your model is shaded. 

You can't see polygon normals in DataCAD. While a normal is a condition of the 
coordinate points that describe a particular polygon, they really don't matter 
much in the DataCAD world. Whether you view, quick-shade or hide a polygon 
from either side, it will look and display exactly the same. The only way to know 
which way a normal faces is to remember how it was created. Did you define the 
polygon right to left counter clockwise, or left to right, clockwise? If you went 
counter-clockwise, then the normal faces towards you, or out of the screen. If you 
went clockwise, then it faces away from you, into the screen. This method of 
orientation is known as the right-hand rule. To further complicate things, if you 
mirror an entity, all of its normals will reverse. 

Saving and Using Shader Settings 
You can save your settings and then use them later without having to change all 
the Shader settings again. 

 To save your shader settings: 

1. Customize the options in the Shader Settings dialog box. See “Creating a 
Shaded Image” earlier in this chapter for more information on 
customizing shader settings. 

2. Click on the Save As button in the Shader Settings dialog box. A dialog 
box is displayed, prompting you to “Save light information to”. 

3. Change to the folder where you want to save your .LIT file, if necessary, 
and type a name for the file. 

4. Click on Save. The dialog box closes and your .LIT file is saved. 

 To use a .LIT file: 

1. Click on Settings in the Shader menu. The Shader Settings dialog box is 
displayed. 

2. Click on Load. A dialog box is displayed, prompting you to “Load light 
information from”. 

3. Change to the folder where your .LIT file is stored if necessary. Then, click 
on the file. 

4. Click on Open. The dialog box closes, and the light settings are loaded 
into the Shader Settings dialog box. 
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Saving Your Shaded Image 
You can save your shaded image or send the bitmap to an eZmeeting conference. 

 To save your shaded image: 

1. Click on Save or Save As in the File menu, or right-click in the bitmap 
window to display a pop-up menu and click on Save Bitmap or Save 
Bitmap As. (Keep in mind that if you use the Save option, the bitmap is 
saved in the last folder you used.) The Right-Click to Exit option in the 
Shader Settings dialog box must be unchecked for the pop-up menu to 
display when you right-click in the Shader window. 

2. Determine if you used the Save As option in the previous step. If so, type 
a name for the bitmap file, and click Save. 

Using the OpenGL Shader 
The OpenGL Shader lets you create preliminary architectural views of 3D 
models. Use the OpenGL Shader for shadow casting, custom edge color and 
thickness settings, custom overshoot settings, bitmap background image, and 
color mapping. 

 To use the OpenGL Shader: 

1. Select DCAD 3D from the Edit menu, choose Shader from the 3DEdit 
menu, and Settings from the Shader menu. The Shader Settings dialog 
box appears. 

 
Figure 26.17: The Shader Settings dialog box 

2. Make changes in the Shader Settings dialog box to meet your needs. 

• Enter a name for the light source. 

• Set the XYZ coordinates for the light. You can use 10000 to simulate 
sunlight. 

• Make sure that the On/Off box in the Light Source section of the dialog 
box contains a check. 

• Check the Cast Shadows box. This allows the light source to cast 
shadows. 
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• Put a check in the Cast Shadows box at the bottom right corner of the 
dialog box. This is a global setting that affects the OpenGL Shader. 

3. Click OK to exit the Shader Settings dialog box and return to the Drawing 
Window. 

4. Select 3DViews from the Shader menu. This sets up a perspective view of 
the model. 

5. Select Prspect from the 3DViews menu to recall the last perspective view. 
Then, right-click to return to the Shader menu. 

6. Select Shadow from the Shader menu. This determines which polygons 
will receive shadows. 

7. Position the ground plane to receive shadows. 

8. Select entities to receive shadows. Right-click when you are finished 
selecting entities to receive shadows. 

9. Select Shade to render the model. 

10. Use the arrow keys and (PageUp) and (PageDn) to adjust the perspective 
view for the next image. When you have the desired view, proceed. 

11. Select Settings to adjust Shader options in the Shader Settings dialog box. 

• Turn on Show Edge in the Shader Settings dialog box. 

• Set the Edge Overshoot. For this example, we used 6 inches (0.6). 

• Set the rendered edge width. 

• Set a custom edge color. 

12. Click on the Shade button to render the model. 

Viewing Selected Entities in Your Model 
Use ClipCube to restrict your view of the model so that only the entities inside a 
rectangular region are visible. If an entity is only partially inside the clip cube, 
DataCAD clips it at the point where it passes outside the cube. This reduces the 
visual clutter of a complex model as it develops. You cannot edit entities outside 
of the clip cube. 

There are two clip cubes you can use: one for orthographic view and one for 
parallel views. These cubes are independent of one another. When you begin the 
clip cube operation from orthographic view, DataCAD uses the orthographic clip 
cube. When you use ClipCube while in a parallel view, the parallel clip cube is 
used. 

The clip cube status is one of the attributes stored with the AddView function in 
the GoToView menu. Restoring a saved view also restores the clip cube that was 
in use when you saved the view. 

The Arc Factor setting controls the smoothness of clipped arcs that use a solid 
linetype. 

 To activate the clip cube: 

 1. Toggle ClipOn on. 
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 To create a new clip cube: 

1. Choose New Cube from the ClipCube menu. 

2. Set Z-Min and Z-Max so that they enclose the part of the model you want. 
First set the height of the floor of the clip cube by choosing Z-Min from 
the ClipCube menu, and then choosing or typing a value and pressing 
(Enter). 

3. Set the height of the ceiling of the clip cube by choosing Z-Max from the 
ClipCube menu, and then choosing or typing a value and pressing (Enter). 

4. Select the area with a rubberband box. 

5. Right-click to exit, or select two new corners to reset the rubberband box. 

6. Choose ClipOn to toggle the cube on. 

Drawing the
Clip cube

Clip On
 

Figure 26.18: Clip cube 

Refresh updates the screen after you activate the clip cube. When Refresh is off, 
press (Esc) to refresh the screen yourself to see the effects of the new clip cube. 

You can insert an XREF into your drawing and define a clip cube within it. Either 
you can do this by using the Insert pull-down menu or by selecting XRefClip 
from the 3DViews menu. 

 To define a clip cube in an XREF attached to your drawing with Reference 
File Management: 

1. Open a new drawing or select an existing file. 

2. Attach a reference file to it by selecting Reference File from the Insert pull-
down menu.  

3. Double-click on the name of the file you want to insert. Your cursor is 
now loaded with a boundary box that represents the extents of the 
reference file. Toggle on ByCenter in the InsX-REF menu. You are 
prompted to “Position XREF on drawing.” Click the left mouse button to 
place the reference file by its center. The reference file appears in your 
Drawing Window. 

4. Select Reference File Management from the Insert pull-down menu. 
Choose Clip Cubes from the extended menu. You are prompted to “Select 
XREF to modify ClipCube.” 

5. Click on the reference file you placed in your Drawing Window. Notice 
that the reference file’s Z-base and Z-height appear in the Message Area. 



SAVING A VIEW  |    491 

6. Select Z-Min in the Identify menu, choose or type a value that is below 
the floor or Z-base of the model, and press (Enter). Similarly, select Z-Max 
to set the Z-height above the roof of the model. 

7. Click on NewCube. You are prompted to “Select the first corner of the 
clipping cube.” 

8. Click where you want the clip cube to begin. Then, pull the rubberband 
out diagonally and click when it encloses the area you want to display in 
the clip cube.  

9. Select ClipOn. This toggles the clip cube on. 

 To define a clip cube in an XREF attached to your drawing with XRefClip: 

1. Open a new drawing or select an existing file. 

2. Attach a reference file to it by selecting Reference File from the Insert pull-
down menu. 

3. Double-click on the name of the file you want to insert. Your cursor is 
now loaded with a boundary box that represents the extents of the 
reference file. Toggle on ByCenter in the InsX-REF menu. You are 
prompted to “Position XREF on drawing.” Click the left mouse button to 
place the reference file by its center. The reference file appears in your 
Drawing Window. 

4. Make sure you are in the 3DViews menu. Select ClipCube from the 
3DViews menu. The ClipCube menu appears. 

5. Select XRefClip from the ClipCube menu. You are prompted to “Select 
XREF to modify ClipCube.” 

6. Click on the XRef you placed in your drawing. The Identify menu 
appears. 

7. Set Z-Min and Z-Max values so that they are respectively below and 
above the model’s Z-base and Z-height. 

8. Click on NewCube. You are prompted to “Select the first corner of the 
clipping cube.” 

9. Click where you want the clip cube to begin. Then, pull the rubberband 
out diagonally and click when it encloses the area you want to display in 
the clip cube. 

10. Select ClipOn. This toggles the clip cube on. 

Saving a View 
Use SaveImg in the 3DViews menu to create a snapshot of the current view. The 
snapshot consists of 2D lines and can be edited with normal 2D editing 
commands in orthographic view. 

 To save an image: 

1. Choose SaveImg from the 3DViews menu. 
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2. Choose an offset distance for the image, if necessary. After you select the 
first and second points of the image offset, the SaveImg menu is 
displayed: 

ActivLyr  Save the image to the active layer 
NewLyr  Save the image to an automatically created new active layer 
LyrFile  Save the image to an automatically created layer file 
Offset Select the distance and direction to offset a saved image from the current 

geometry 
3. Select the destination for the saved image. 

4. Enter a name for the new destination layer (when you place the image on 
a new layer or in a layer file). DataCAD generates the image. The image 
that this procedure creates is made entirely of 2D lines with Z-base = 0 
and Z-height = 0; therefore, DataCAD creates the image flat on the 
ground plane and in orthographic view. 

GotoView 
When you save a view using the GotoView menu in the 3DViews menu, 
DataCAD stores information about the current view including: 

• viewing scale 

• WindowIn location (what you have zoomed in on) 

• view type (orthographic, parallel, perspective, or oblique) 

• location and orientation of the zero plane 

• location of the view center 

• active and inactive layers 

• size, location, and status (on or off) of the clip cube 

Restoring these saved views actually restores all of these stored settings to their 
previous state. Please note, however, that restoring a view does not restore the 
values of Z-base and Z-height. The Layers On/Off setting may or may not be 
restored depending on whether LyrSet is on or off. The LyrSet option in the 
GotoView menu restores layers to their last saved condition (on, off, active). 
When LyrSet is off, DataCAD uses the current state of the layers but restores all 
the other parameters. 

The top part of the GotoView menu displays the names of any saved views in the 
drawing. If there are more than ten views for this drawing, ScrlFwrd and 
ScrlBack appear on the menu to let you scroll through your views. Selecting a 
view from the menu restores that view to the Drawing Window. 

 To add the current view to the list of saved views: 

1. Choose Go-to-View from the View pull-down menu. 

2. Choose AddView from the GotoView menu. 

3. Type the name of the new view, up to eight characters, and press (Enter). 
The view is added to the list of saved views. 



SAVING A VIEW  |    493 

 To add any changes you made to the view without creating a new view: 

1. Choose Go-to-View from the View pull-down menu. 

2. Choose Update from the GotoView menu. 

3. Choose the view that you want to update with the current settings. This 
update includes active or inactive layers, scale, and location of the zero 
plane. 

 To delete a selected view from the menu: 

1. Choose Go-to-View from the View pull-down menu. 

2. Choose DelView from the GotoView menu. 

3. Choose the view that you want to delete. DataCAD deletes the view 
parameters only; the entities in the drawing are not affected by this 
operation. 

 To move a view from one position in the menu to another: 

1. Choose Go-to-View from the View pull-down menu. 

2. Choose MoveView from the GotoView menu. 

3. Choose the view that you want to move from the list of saved views. 

4. Choose the view you want to appear after the view selected in step 2. The 
moved view appears before the view selected in step 3. This is useful for 
moving an often-used view into one of the first ten positions on the menu 
so you can access it quickly and easily. 

 To rename a saved view: 

1. Choose Go-to-View from the View pull-down menu. 

2. Choose NameView from the GotoView menu. 

3. Choose the view that you want to rename. 

4. Type the new view name, up to eight characters, and press (Enter). The 
view is renamed. 

 To toggle between the previous and current views respectively: 

1. Use (Ctrl) + Left Arrow. 

2. Use (Ctrl) + Right Arrow. 

Linking to a View 
You can also link go-to-views to any entity in your drawing. For instance, you 
could link a door in your plan to a door schedule. Then simply pressing (Alt) and 
clicking on that door would display the go-to-view of your door schedule. You 
can also use the linking shortcut (press (Alt) and click on an entity) to select an 
entity and choose a view to link to. However, the following instructions offer 
greater flexibility when choosing entities to link to. 
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 To link an entity to a go-to-view: 

1. Choose GotoView from the View pull-down menu. The GotoView menu 
is displayed in the Menu Window. 

2. Choose HyprView from the GotoView menu. You are prompted to “Select 
the view to link to an entity.” 

3. Choose a view from the list in the Menu Window. A selection menu is 
displayed in the Menu Window. 

4. Choose a selection method. You can also toggle Multi on to select 
multiple entities. 

5. Select the entity or entities to link to. The link to the go-to-view you chose 
in step 3 is established. Repeat steps 2 – 5 to continue linking entities to 
go-to-views. If no go-to-view is linked to the entity you select, you will be 
prompted to link one. 

5. Restore the linked view by pressing and holding down (Alt) while 
selecting the entity with your left mouse button. 

 To create hyperlinks between drawing entities and GotoViews, Internet 
URLs, and programs: 

• Use (Ctrl) + Right-click while selecting an entity to access the 
hyperlink pop-up menu. You can add a link between the entity and a 
GotoView, a URL, or a file. In the extended menu, use Add to create a 
new link, Delete to eliminate one, or Edit to change an existing link. 

• Use (Ctrl) + Right-click to recall a linked URL or file. 

• Select Hyperlinks from the View pull-down menu to display existing 
hyperlinks in your drawing. 

Walking Through Your Model 
With the WalkThru option in the 3DViews menu, DataCAD simulates an 
observer walking through a perspective model. You can walk toward or away 
from the model, turn right or left, step up or down or to one side, or look up or 
down or to one side. Before using the options that move you around the model, 
you must set the distance or angle to control how far you will move with each 
option. 

Before you can use WalkThru, you must set up a perspective view. After you’ve 
set up a perspective view, you can toggle on the Viewer Toolbar in the View pull-
down menu to display a walk-through toolbar containing the same functions as 
the 3DViews/WalkThru menu. 

Perspective Navigation Controls 

Use hotkeys and MouseWheel controls to help you walk through your model. 
You can use these hotkeys in any perspective view. 

(PageUp) Walk backward 
(PageDn) Walk forward 
MouseWheel Walk forward/backward 
(Up Arrow) Walk forward 
(Dn Arrow) Walk backward 



WALKING THROUGH YOUR MODEL  |    495 

(Right Arrow) Step right 
(Left Arrow) Step left 
(Shift) + (Up Arrow) Look up 
(Shift) + (Dn Arrow) Look down 
(Shift) + (Right Arrow) Turn right 
(Shift) + (Left Arrow) Turn left 
 

The WalkThru, Options menu lets you customize the way you navigate. 

 To customize walk-through options: 

1. Go to the 3DViews menu and select WalkThru. 

2. Select Options from the WalkThru menu. 

3. Set the three toggle switches, keeping the following in mind: 

• If FixFocal is toggled on, you will always look at the same point in your 
model while navigating. 

• If FixFocal is toggled off, your focal point will move the same distance as 
your eye point while navigating. 

• If both Fix Focal and FixDist are toggled on, you will navigate spherically 
around a fixed focal point. 

• You cannot toggle off FixFocal and FixDist at the same time. 

• If PanView is toggled on, the walk-through controls are disabled. This 
means you can pan and zoom your perspective view as if it were a two-
dimensional drawing. 

Walking 

WalkDist controls how far forward or backward the observer walks with 
WalkFwrd and WalkBack. 

 To change the walking distance: 

1. Choose WalkDist from the WalkThru menu. A list of values is displayed. 

2. Choose or type a value and press (Enter). 

Now choose WalkFwrd or WalkBack from the WalkThru menu. WalkFwrd makes 
it look as if the observer has stepped toward the model by a distance equal to the 
walk distance by shifting both the eye point and the view center forward along 
the line of sight. WalkBack makes it look as if the observer has stepped away 
from the model by a distance equal to the walk distance by shifting both the eye 
point and the view center backwards along the line of sight.  

Turning 

TurnAngl controls how far the observer will turn with TurnLeft and TurnRght. 

 To change the turning distance: 

1. Choose TurnAngl from the WalkThru menu. A list of angles is displayed. 

2. Choose or type a value and press (Enter). 
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Choose TurnRght or TurnLeft from the WalkThru menu. TurnRght turns the 
observer’s cone of vision to the right (clockwise) by an angle equal to the 
TurnAngl. TurnLeft turns the observer’s cone of vision to the left 
(counterclockwise) by an angle equal to the TurnAngl. 

Stepping 

StepDist sets the step distance used with StepUp, StepDown, StepLeft and 
StepRght. 

 To change the stepping distance: 

1. Choose StepDist from the WalkThru menu. A list of values is displayed. 

2. Choose or type a step distance and press (Enter). 

StepUp moves both the observer’s eye point and the view center upward, away 
from the ground plane. StepDist controls the distance that the observer’s eye 
point is elevated. With StepDown, both the observer’s eye point and the view 
center move downward, toward the ground plane. StepDist controls the distance 
that the observer’s eye point is lowered. 

StepLeft shifts the view to the right, as if the observer took a step to the left. 
Technically, this option causes both the observer’s eye point and view center to 
move to the left by a distance equal to the StepDist. In this context, left means the 
observer’s left, facing toward the view center. StepRght shifts the view to the left, 
as if the observer took a step to the right by causing both the observer’s eye point 
and view center to move to the right by a distance equal to the StepDist. In this 
context, right means the observer’s right, facing toward the view center. 

Looking 

LookAngl sets the angle that the line of sight changes using LookUp or 
LookDown. 

 To set the rotation angle of the observer’s line of sight: 

1. Choose LookAngl from the WalkThru menu. A list of values is displayed. 

2. Choose or type a value and press (Enter). 

LookUp changes the view to simulate looking up, away from the ground plane. 
The eye point remains fixed while the view center moves up, away from the 
ground plane by an angle equal to the LookAngl.  

LookDown changes the view to simulate looking down, toward the ground 
plane. The eye point remains fixed while the view center moves down, toward 
the ground plane by an angle equal to the LookAngl. 

Saving a View 

 To add the current perspective view to the list of saved views: 

1. Choose AddView from the WalkThru menu. 

2. Type the name of the new view, up to eight characters, and press (Enter). 
The view is added to the list of saved views. 
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Using the o2c-based Object Viewer 
The Object Viewer lets you see your model and enhance the image by controlling 
the rendered colors and textures. 

 To use the Object Viewer: 

1. Select Object Viewer from the View pull-down menu. The o2c-based 
Object Viewer window appears. 

 
Figure 26.19: The Object Viewer  

2. Use the toolbar icons to control the view: 

• Sun – toggles sunlight on and off 

• Ambient lights 1, 2, and 3 – toggles ambient lighting on and off 

• Lamp – toggles interior lighting on and off 

• Sun/moon – switches between day and night 

• Parallel/perspective – switches between views 

• Clockwise rotation – hold down to move around the Z axis 

• Counterclockwise rotation – hold down to move around the Z axis 

• Decrease field of view 

• Increase field of view 

• Plan view 

• Elevation views – left, right, front, and back 
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• Isometric view 

• Oblique or axonometric view 

3. Depress and hold the left mouse button while you move the cursor to 
dynamically adjust the view. 

4. Depress and hold the right mouse button while you draw the cursor 
toward you or away from you to zoom in and out. Alternatively, use the + 
and – buttons at the bottom right corner of the Object Viewer to zoom in 
(+) and out (-). 

5. Right-click to open the o2c pop-up menu. From here, you can further 
control the view or save it to a file. 

• Show all - makes the entire model fit in the screen. Or click on the “a” 
button at the junction of the scroll bars. 

 
Figure 26.20: The Save bitmap dialog box 

• Start raytrace - renders the model. Or click on the R button at the right 
edge of the horizontal scroll bar of the Object Viewer to raytrace the 
model. 

• Save image - creates a permanent high-quality rendering. The Save 
bitmap dialog box lets you control the quality of the file while you save 
the view as a bitmap image. In the Quality section, high produces the best 
results, but it takes longer to process. Set the Width in pixels (try 320 for 
thumbnails, 640 for presentations, and 1024 for printing); DataCAD uses 
the width to automatically calculate the Height in pixels. Check Raytrace 
if you want shadows and reflections in your saved image; however, this 
takes a long time to process. Type the File name and select the 
appropriate folder (shown in the Save in box). Click on the Save button 
when you are finished and want to return to the Object Viewer. 
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Figure 26.21: The Background dialog box 

• Background – controls what is behind the model in the Object Viewer. 
Use Load image to access lists of available bitmap files; use Select color to 
choose from the Color dialog box. If you selected Load image, you can 
also check “Tiled background picture” to put many copies of the bitmap 
behind your model and further control the X and Y offset. If you clicked 
Select color, all options except Monochrome are unavailable (greyed). 

6. Exit the Object Viewer by clicking on the X in the right corner of the title 
bar. 

Color Mapping 
Using the View/Shader color map dialog box, you can define materials for 
rendering and assign them to specific colors in the DataCAD palette. Mapping 
entity colors to material definitions controls rendered output. The material 
settings for a given drawing are stored in a .DMF (DataCAD Material File) 
file. You can save custom material files for use in other drawings. Also, you can 
save individual material definitions and load them one at a time. These 
definitions are compatible with other o2c-based programs such as DCvis, ArCon, 
and o2c Composer. 

DataCAD lets you choose from a standard set of matte, glossy, and glass 
materials.  By adjusting the various settings and experimenting a bit, you'll be 
able create your own materials to produce artistic, photo-realistic renderings of 
DataCAD models. 

 To use the Viewer/Shader color map: 

1. Access material settings for a given color by using (Ctrl)-right-click on an 
entity in the DataCAD Drawing Window. A small pop-up menu appears. 
For this example, just the STUCCO layer is active. 

2. Select o2c Settings from the pop-up menu. This opens a dialog box that 
lets you precisely define the materials. The name of the active material file 
appears in the title of the Color Map dialog box. 

3. Look at the Preview window to see the results of your choices in the rest 
of this dialog box. 



|  CHAPTER 26: VIEWING YOUR MODEL  500

 
Figure 26.22: The color mapping decisions you make affect the Preview model. 

4. Use the slider bars, input boxes, and check boxes in the various sections 
of the dialog box to define the material. 

• Entity Color – click on the rectangle to make your selection from the 
Color Palette. Alternatively, click on the arrows on the right and left sides 
of the color box to scroll through options in the palette. All entities that 
have the same color will also have the same material properties. The first 
15 colors shown on the ColorPalette are most frequently used in 
DataCAD and are the most popular; however, you can define up to 255 
unique materials per drawing by using custom colors (beyond yellow). 

• Rendered Color – click on the rectangle to make your selection from the 
Color Palette. Use the slider bars to further determine the proportion of 
diffuse and ambient lighting properties of materials. A high diffuse 
proportion will cause the light from defined light sources to reflect 
strongly into various nonspecific directions. Use low diffuse values to 
simulate light-absorbing materials such as velvet.  If the ambient 
proportion is too high, the object will appear relatively pale (like plastic) 
because it will very strongly reflect the environment’s light. Rendered 
Color is the material color for all entities that are the current Entity Color. 
For example, if you choose white in the Entity Color section, the 
Rendered Color you select for all white entities could be Dahlia Purple or 
any other color in the Color Palette, including a custom-mixed color that 
you define with the Color Picker dialog box. 

• Reflection - defines both the color and the proportional degree for 
reflections. In principle, the color defines the highlight on the objects.  
Higher reflection proportion values simulate glossy surfaces, such as 
chrome. 
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• Highlight Size – determines the size of reflected highlights from light 
sources. Adjustments to this value can only be seen in the o2c Player 
when using the raytrace option; they are not shown in the Preview 
window. You must use a relatively high reflective proportion to see the 
effect of changing this value. In principle, this value measures the 
intensity of a highlight as a function of the angle. The higher the value is, 
the smaller the highlight becomes. For matte-shining materials (such as 
unpolished gold or anodized aluminum), use small values around 3; for 
high gloss materials (such as polished gold or polished plastic), use large 
values. 

• Opacity – the top slider bar determines the degree to which the material 
is opaque or transparent. A value of 50% means that when examining an 
object with this material, 50% of the color behind the object shows 
through it and 50% of the object’s color is visible. The bottom slider bar 
affects how refractive (or hard) the transparent material is. To simulate 
glass, use a refractive index of 12; to simulate something like bubbles in 
water, use a refractive index smaller than 10. To see how your selections 
affect the material, you have to raytrace the object in the Preview window. 

• Material Properties – mutually exclusive buttons apply preset Matte, 
Glossy, or Glass properties to the material. When you first work with the 
color map, you may rely on the presets; however, you will soon feel more 
confident about applying your own definitions via the slider bars and 
other options in this dialog box to produce photo-realistic materials. 
These presets affect the slider bars throughout the dialog box that keep 
the current rendered color, but change its reflective properties. Load lets 
you select an o2c color that will appear in the rectangle in the Rendered 
Color section; Save As lets you name and store your material definitions. 

When simulating real-world elements using computer graphics, the surface 
properties of a material are based on various parameters. The level of realism 
depends partly on how the parameters are set. The o2c Player uses a standard 
computer material model known as PHIGS PLUS. This model simulates real-
world material properties, but real-time renderers such as the o2c Player have 
limitations on how accurately they can be depicted in final rendered output. 

 
The way an object (or surface) appears is affected by both the material 
properties and the lighting (including all sources which light the object). A 
rendered material is made up of a layering of different lighting properties (the 
diffuse portion simulates matte properties; the ambient portion reflects light in the 
environment; the reflective portion simulates polished material properties; and 
the opacity portion simulates transparent material properties. 
 
By using bitmaps, you can also apply textures to enhance the material definition 
to simulate real-world surfaces such as carpet, tile, wallpaper, and brick.The 
preview window lets you see how a material will look before you apply it to your 
model.  
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Figure 26.23: The Load o2c material file dialog box 

• Miscellaneous – check the boxes that apply: self-illuminate, render 
backface, and allow smoothing. Select self-illuminate to see the material 
even without lights. This causes an object to simulate a light source, but it 
will not illuminate its surroundings. This material setting is ideal for neon 
and other low-level lighting that is normally used in dark 
settings. Render backface forces the o2c Player to render both sides of a 
surface. By default, render backface is on for all colors. Smoothing blends 
a material across adjacent, noncoplanar polygons (such as a mesh 
surface).  Otherwise, each polygon will be rendered independently, 
revealing the creases between adjacent polygons.  This option is 
especially useful for rendering reflective and transparent objects that are 
made up of many polygons (such as a sphere or a cylinder).  Without this 
option, shiny objects will reflect a fragmented view of the surrounding 
environment. 

• Texture – controls the interaction of textures and the defined material. 
Check Apply Texture to activate other options. Experiment until you get 
the results you want in the Preview window.  

In some cases, you may want to mix the colors of the texture with the 
diffuse color. This makes it possible to tint (or lighten or darken) a 
texture without modifying the original bitmap. 

If you check Apply texture as reflection map, textures appear to be 
reflected from, rather than mapped onto, a given surface. This 
simulates optimum mirror images, where the object’s texture, not its 
environment, is reflected in the object. 
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Figure 26.24: Select the background image for the o2c viewer. 

• DataCAD Material Assignments – affect your settings, saved in a .DMF 
(DataCAD Material File). The Load button lets you access material 
assignments you created for other models. Save As lets you give the 
current definition a unique name. The current material file name is 
displayed in the title bar. In this example, we used the name Ehm 
Material Map that DataCAD saved as a .DMF file. 

• Preview Object – lets you apply your material definitions to different 
shapes: sphere, cube, cylinder, or teapot. One object may give you a better 
idea of how the material definition will affect the entities in your drawing 
than another. For example, if you wanted a velvety material, you 
probably would steer away from displaying it on the teapot. 

• Background – controls the color behind the image. This is a global setting, 
independent from the material file. When you click on the rectangle, the 
Color Palette appears so that you can select a color. 

 
Figure 26.25: Select the background image for the o2c viewer. 
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• Preview window – lets you see your material assignments. This is a mini 
o2c object viewer. Click on “R” to raytrace the material. Some material 
settings can only be seen in a raytraced view. Although the default object 
is a sphere, you could change this to a cube, cylinder, or teapot to give 
you a better idea of how the material will look in your model. 

5. Click on OK when you are satisfied with all the settings in the color 
mapping dialog box. 

6. Select Object Viewer from the View menu. The Object Viewer appears. 
The decisions that affect the STUCCO layer (see Figure 26.22) are 
displayed in the Object Viewer. If you are unhappy with the way the 
material looks, you can return to step 1 and go through the process again. 

 
Figure 26.26: The results of color mapping decisions shown in Figure 26.22 
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Framing Your Model 
FrameIt is a utility that helps you frame 3D floors, walls, and 
roofs. The RoofIt macro is used to create the outer portion of 
the 3D roof. 

27 
In this chapter: 

 Framing floors 

 Framing walls 

 Framing roofs 

 Saving and using 
framing settings 
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Framing Floors 
 To frame a floor: 

1. Choose Floors from the FrameIt menu.  

2. Verify settings for Plate, Joist, and SubFloor. See “Sill Plate, Joist, and Sub-
Floor Settings” below for more information. 

3. Choose either Center or Sides to define the floor boundary from the 
center line of the vertical member or from one side of the floor to the 
other. 

4. Define the floor to frame by defining a floor boundary or by choosing 
Select and selecting an existing floor boundary. To define the floor 
boundary, object snap to each point of the floor boundary, tracing the 
floor. If you make a mistake, use the Backup button to erase the last point 
you selected. 

5. Choose Opening to define floor openings, such as chimneys or stairs. 
Select the first point of the floor opening, move the mouse to stretch the 
rubberband box around the opening, and select the second point of the 
rubberband box to define the floor opening. 

6. Choose Beam to define beam style and location. Set the following options 
as necessary: 

Single Models single beams 
Double Models double beams 
Custom Customizes the number of entities that make up a beam 
Color Assigns a beam color. See “Color Menus” in “The Drawing Board” chapter 

for more information about how to choose a color. 
Size Sets a beam size (choose Change to change a standard lumber size in the 

menu) 
Flush Positions the top of the beam flush or equal to the top of the joist 
Below Positions the top of the beam equal to the bottom of the joist 
Change Changes the current framing member attributes (those attributes set when 

you selected or defined the floor boundary) 
FileI/O Accesses file options to save the current framing settings in a file, load saved 

settings, or delete or rename framing settings files 
7. Make any changes before choosing Build. Choose Edit or Change to 

access DataCAD editing options, including Move, Copy, Rotate, Mirror, 
Stretch, Enlarge, Erase, and Layers, or to globally change any floor 
member attributes. If you choose Edit or Change, you must choose Build 
again for those changes to take effect. 

8. Save floor settings to a file by choosing SaveFile from the FileI/O menu. 

9. Choose Build and select the boundary on which to generate a floor 
system. Build generates a framing system based on the settings you 
defined above. See the “The Drawing Board” chapter for more 
information on using the selection menu to choose the boundary to 
frame. 

Use the following toggles before you select the boundary to frame for 
added control over the Build process: 

SchemLyr Builds framing members on the schematic layer 
ActvLyr Builds framing members on the active layer 
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FlrsOnly Builds only floors with the current settings; otherwise, DataCAD builds all 
members; only available in the Floors/Build menu 

WalsOnly Builds only walls with the current settings; otherwise, DataCAD builds all 
members; only available in the Walls/Build menu 

RfsOnly Build only roofs with the current settings; otherwise, DataCAD builds all 
members; only available in the Roofs/Build menu 

10. Finish framing. When framing is complete, you have access to the 
following DataCAD options: 3DViews, Hide, and Layers. See the 
“Viewing Your Model” and “Before You Draw” chapters for more 
information on 3DViews, Hide, and Layers. 

11. Choose Exit to return to the Floors menu. 

Sill Plate, Joist, and Subfloor Settings 

Use Plate to set the following sill plate options: 

DoPlate Models sill plates 
Single Models single plates 
Double Models double plates 
Custom Customizes the number of entities that make up the plate 
Color Assigns a plate color. See “Color Menus” in “The Drawing Board” chapter for more 

information about how to choose a color. 
Size Sets a plate size; choose Change to change a standard lumber size in the menu 
  

Use Joist to set the following joist options:  

DoJoist Models the joists 
Size Assigns a joist size, or defines a custom joist size; choose Change to change a standard 

lumber size in the menu 
Spacing Assigns joist spacing (measure spacing from the center line of one joist to the center 

line of the next joist) 
Color Assigns a joist color. See “Color Menus” in “The Drawing Board” chapter for more 

information about how to choose a color. 
Angle  Changes the angle in which your joist member will be modeled within the schematic 

 

Use SubFloor to set the following subfloor options:  

DoSubflr Models the subflooring 
Single Models single layer subfloors 
Double Models double layer subfloors 
Custom Customizes the number of entities that make up a subfloor 
Color Assigns a subfloor color. See “Color Menus” in “The Drawing Board” chapter for 

more information about how to choose a color. 
Thicknss Sets the subfloor thickness for each layer 

Framing Walls 
 To frame a wall: 

1. Choose Walls from the FrameIt menu. 

2. Verify the settings for WallHght, Plate, and Stud. See “Wall Height, Plate, 
and Stud Settings” later in this chapter for more information. 

3. Choose either Center or Sides to define the wall boundary from the center 
line of the vertical member or from one side of the wall to the other. 
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4. Choose either Exterior or Interior. Use Exterior to create outside wall 
systems; DataCAD assumes this will be a closed boundary. Use Interior to 
create inside wall systems; DataCAD toggles Closed off and you are 
drawing a single or string-line wall that does not close itself. 

5. Define the wall to frame by defining a wall boundary or by choosing 
Select and selecting an existing floor or wall boundary. If defining the 
wall by the boundary, object snap to the first point of the wall boundary 
to frame and continue tracing the boundary from that point. If you make 
a mistake, use the Backup button to erase the last point you selected. 

6. Choose Opening to define wall openings. Choose either Window or Door 
(for Exterior) or PassThru or Door (for Interior). If you choose Window or 
PassThru, verify the settings for SillHgt, HeadHght, and HeadStyl. For 
Door, define only HeadHght and HeadStyl. 

Window Defines window openings in the wall 
Door Defines door openings in the wall 
SillHght Defines the sill height; available only when Window is toggled on 
HeadHght Defines the header height of the door 
HeadStyl Defines the header style: 
Cripple Member with smaller studs that run from the top of the header to the bottom 

of the lower top plate; maintains stud spacing 
Boxed Solid member that runs from the top of the header to the bottom of lower 

top plate 
Change Changes any opening attributes 
FileI/O Accesses file options to save the current framing settings in a file, load saved 

settings, or delete or rename framing settings files 
7. Make any changes before choosing Build. Choose Edit or Change to 

access DataCAD editing options, including Move, Copy, Rotate, Mirror, 
Stretch, Enlarge, Erase, and Layers, or to globally change any wall 
member attributes. If you choose Edit or Change, you must choose Build 
again for those changes to take effect. 

8. Save wall settings to a file by choosing SaveFile from the FileI/O menu. 

9. Choose Build and select the boundary on which to generate a wall 
system. Build generates a framing system based on the settings you 
defined above. See “The Drawing Board” chapter for more information 
on using the selection menu to choose the boundary to frame. 

Use the following toggles before you select the boundary to frame for 
added control over the Build process: 

SchemLyr Builds framing members on the schematic layer 
ActvLyr Builds framing members on the active layer 
FlrsOnly Builds only floors with the current settings; otherwise, DataCAD builds all 

members; only available in the Floors/Build menu 
WalsOnly Builds only walls with the current settings; otherwise, DataCAD builds all 

members; only available in the Walls/Build menu 
RfsOnly Build only roofs with the current settings; otherwise, DataCAD builds all 

members; only available in the Roofs/Build menu 
10. Choose Exit when framing is complete to return to the Walls menu. 

Wall Height, Plate, and Stud Settings 

Use WallHght to set wall height options. Choose a wall height from the list or 
type a wall height and press (Enter). 
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Use Plate to set the following top and bottom plate options: 

DoTop Models top plates 
Single Models single top plates 
Double Models double top plates 
Custom Customizes the number of entities that make up a top plate 
Color Assigns a top plate color. See “Color Menus” in “The Drawing Board” chapter for 

more information about how to choose a color. 
DoBottom Models bottom plates 
Single Models single bottom plates 
Double Models double bottom plates 
Custom Customizes the number of entities that make up a bottom plate 
Color Assigns a bottom plate color. See “Color Menus” in “The Drawing Board” chapter for 

more information about how to choose a color. 
Use Stud to set vertical framing member options: 

DoStud Models the vertical stud member 
Size Assigns a stud size or defines a custom stud size 
Spacing Assigns stud spacing (measure spacing from the center line of one stud to the center 

line of the next stud) 
Color Assigns a stud color. See “Color Menus” in “The Drawing Board” chapter for more 

information about how to choose a color. 

Framing Roofs 
Use Roof Framing to create three-dimensional roof framing systems. You can 
frame the following roof types: Shed, Gable, Hip, and Gambrel. See “3D Roofs” 
later in this chapter for more information on roof types 

 To frame a roof: 

1. Choose Roofs from the FrameIt menu. 

2. Choose the roof type to frame: Shed, Gable, Hip, or Gambrel. 

3. Choose Settings to set the options for roof settings, including pitch, purlin 
height, rafters, sheathing, and overhang. See “Settings” below in this 
section for more information. 

4. Define the roof by defining a roof boundary or by choosing Select and 
selecting an existing wall or roof boundary. To define the roof with an 
existing boundary, choose that boundary and continue with step 6. To 
define the roof by a boundary, object snap to the first and second corners 
of the roof boundary to define the length of the roof parallel to the ridge. 
Make sure that you define the roof boundary at a Z-base set to the plate 
height of the wall. 

The following options appear on the menu: 

Closed Models a closed roof boundary 
Backup Backs up one roof corner so you can enter a new position 
Cancel Returns you to the FrameIt menu without defining a roof perimeter 
Close/Exit Stops defining the roof perimeter 

5. Choose the third corner of the roof perimeter to define the width of the 
roof perpendicular to the ridge if you define the roof by the boundary. 
The roof boundary is calculated and closed. 

6. Choose Opening to define roof openings, such as chimneys. Select the 
first point of the roof opening, move the mouse to stretch the rubberband 
box around the opening, and select the second point of the rubberband 
box to define the roof opening. 
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7. Make any changes before choosing Build.  Choose Edit or Change to 
access DataCAD editing options, including Move, Copy, Rotate, Mirror, 
Stretch, Enlarge, Erase, and Layers, or to globally change any roof 
framing member attributes. If you choose Edit or Change, you must 
choose Build again for those changes to take effect. 

8. Save roof settings to a file by choosing SaveFile from the FileI/O menu. 

9. Choose Build and select the boundary on which to generate a roof 
system. Build generates a framing system based on the settings you 
defined above. When you define a roof boundary, FrameIt bases the plate 
height on the current Z-Base setting. When you use Select to select an 
existing wall boundary, FrameIt uses the plate height of the wall. FrameIt 
always centers ridge boards when framing roofs 

10. Choose Exit when framing is complete to return to the Roofs menu. 

Settings 

Use Pitch to set a pitch for Shed, Gable, and Hip roofs. Pitch is defined by rise 
and run; choose a pitch from the menu, or choose Custom, type a pitch, and 
press (Enter). Use UprPitch and LwrPitch to set the pitch for the upper and lower 
sections, respectively, of a Gambrel roof. 

Use MidRdgHt to set the height for purlins for Gambrel roofs. Choose a height 
from the menu, or choose Custom, type a height, and press (Enter).  

Use Rafters to set the following rafter options: 

DoRafter Models rafters; models collar ties every four feet 
Size Sets a rafter size from the list, or defines a custom rafter size 
Spacing Sets rafter spacing or defines custom rafter spacing (measure spacing from the center 

line of one rafter to the center line of the next rafter) 
Color Sets a ridge board and rafter color. See “Color Menus” in “The Drawing Board” 

chapter for more information about how to choose a color. 
EaveSqr Models fascia square to the angle of the rafter 
EavePlmb Models fascia parallel to the wall 
BrdMouth Assigns a Bird’s Mouth dimension; choose a dimension from the menu, or choose 

Custom, type a dimension, and press (Enter) 
Use Sheathng to set the following roof sheathing options: 

DoSheath Models roof sheathing 
Single Models single layer roof sheathing 
Double Models double layer roof sheathing 
Custom Models a custom number of roof sheathing layers 
Color  Assigns a roof sheathing color. See “Color Menus” in “The Drawing Board” chapter 

for more information about how to choose a color. 
Thicknss Assigns the thickness of the roof sheathing material or defines a custom thickness 
Use the following OverHang options to set the overhang distance. Measure 
OverHang from the outside face of the sheathing to the outside face of the rafter. 

EaveOhng Assigns an overhang distance at the eave 

RakeOhng Assigns an overhang distance on the gable end 

RoofIt automates the construction of 3D roof models. You define the roof 
boundary and RoofIt automatically calculates and constructs a roof based on 
your settings. 
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The standard roof types available with RoofIt are Gable, Hip, Boston, Gambrel, 
Mansard, and Shed. You can also create your own customized roof shape. You 
can vary the pitch, overhang, and plate height settings, and specify the type of 
soffit and fascia you want to model. RoofIt also lets you join a new roof to an 
existing roof. You can create dormers or other complex roof shapes using this 
feature. A complete roof model is composed entirely of 3D polygons. Because of 
this, you can easily process the model with DataCAD’s hidden line removal 
feature, Hide. 

 
Figure 27.1: Standard roof types 

 To create a roof model: 

1. Choose RoofIt from the Toolbox menu. The following options are 
displayed: 

RectRoof Constructs an orthogonal (rectangular) roof with no variation in settings; 
RectRoof is the easiest way to model a rectangular roof. RectRoof and 
PolyRoof are mutually exclusive; only one option will be displayed in the 
menu at any given time. If RectRoof is displayed in the RoofIt menu, clicking 
on it will change it to PolyRoof, putting DataCAD in polygonal roof drawing 
mode; you can begin drawing polygonal roofs. To change back to 
rectangular roof drawing mode, click on the PolyRoof option to change it to 
RectRoof. 

PolyRoof Constructs a polygonal roof that is not orthogonal or a roof that has varied 
pitch, overhang, or plate height settings 

Gable Available roof type 
Hip Available roof type 
Boston Available roof type 
Gambrel Available roof type 
Mansard Available roof type 
Shed Available roof type 
Join Defines a Gable, Hip, or Shed roof that connects to an existing roof plane; the 

roof that you join onto may be any roof type you create using RoofIt 
Settings Sets roof options depending on the type of roof you’re drawing. See “Setting 

Options” later in this section. 
PlatHgt Sets different plate height values for each roof line than what’s currently set 

in Settings/PlatHgt during PolyRoof creation; when PlatHgt is on, RoofIt 
prompts you for the plate height of each roof; only changes with Gable and 
Gambrel roofs 

Pitch Sets different pitch values for each roof line than what’s currently set in 
Settings/Pitch during PolyRoof creation; when Pitch is on, RoofIt prompts 
you for the pitch of each roof side; only changes with Gable and Gambrel 
roofs 
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Overhng Sets different overhang values for each roof line than what’s currently set in 
Settings/Overhng during PolyRoof creation; when Overhng is on, RoofIt 
prompts you for the overhang of each roof side; only changes with Gable, 
Gambrel, and Shed roofs 

Layers Shortcut to the Utility/Layers menu without exiting RoofIt. See “Layers” in 
the “Before You Draw” chapter. 

Hide Shortcut to the 3DEdit/Hide menu without exiting Roof It. See the “Viewing 
Your Model” chapter for more information about Hide, 3DViews, and 3D 
Entity. 

3DViews Shortcut to the 3DViews menu and look at your 3D model in different 
orientations without exiting RoofIt. See the “Viewing Your Model” chapter 
for more information about Hide, 3DViews, and 3D Entity. 

3DEntity Shortcut to the 3DEntity menu without exiting RoofIt. See the “Viewing Your 
Model” chapter for more information about Hide, 3DViews, and 3D Entity. 

2. Choose RectRoof or PolyRoof to define a rectangular or polygonal roof. 
See “Defining a Roof Boundary” later in this chapter for more 
information.  

3. Choose one of the six standard roof types: Gable, Hip, Boston, Gambrel, 
Mansard, or Shed. 

4. Choose Join if you are defining a roof to join with an existing Gable, Hip, 
or Shed roof plane. 

5. Choose Settings to set roof options (if you don’t need to vary any values, 
skip to step 6). Choose the option to set. These options vary depending on 
which roof type you selected in step 3. See “Setting Options” later in this 
chapter for more information 

6. Choose PlatHgt, Pitch, or Overhng from the RoofIt menu if you are 
creating a Gable, Gambrel, or Shed polygonal roof. This lets you change 
that setting for each roof edge you draw. Once you select the first point of 
the roof boundary, you can’t move the control from one parameter to 
another. You can only change the value of one parameter as you define 
the roof boundary. 

7. Define a roof boundary by entering length and width values for a 
rectangular roof or by entering a series of four points for a polygonal roof. 
See “Defining the Roof Boundary” later in this chapter for more 
information. 

8. Choose the roof plane to join to when prompted if you are defining a roof 
to join. 

Defining the Roof Boundary 
The method you use to define the roof boundary depends on whether the 
RectRoof or PolyRoof option is displayed in the RoofIt menu. (The option that is 
displayed is the type of roof you’ll draw.) 

Rectangular Roofs 

When you model a rectangular roof, you define the roof shape by selecting 
points (in a clockwise direction) that define its length and width. This results in 
an orthogonal roof shape. 
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 To define a rectangular roof boundary: 

1. Choose PolyRoof if RectRoof is not displayed in the RoofIt menu. Then,  
toggle RectRoof on. 

2. Select the first point of the roof boundary; this point is the first point of 
the roof length, which runs parallel to the ridge of the roof. 

3. Select the second point of roof length.  

4. Select the third point of the roof boundary to define the roof width. The 
roof width is the distance from one side of the building to the other; this is 
perpendicular to the roof length and roof ridge. On a Shed roof, this point 
locates the ridge (minus the overhang). 

  
Figure 27.2: Defining a rectangular roof boundary 

Polygonal Roofs 

To model a non-orthogonal roof or to model a roof with varying parameters 
(PlatHgt, Pitch, or Overhng), use PolyRoof. 

When you define a polygonal roof, you enter a series of four points. These points 
trace the edges of the roof boundary in a clockwise direction. The first and third 
edges of the boundary run parallel to the ridge; and the ridge bisects the second 
and fourth edges. Because the roof shape may be either orthogonal or non-
orthogonal, the edges of the roof don’t have to be parallel and perpendicular to 
the ridge. 

 To define a polygonal roof boundary: 

1. Choose RectRoof if PolyRoof is not displayed in the RoofIt menu. Then, 
toggle PolyRoof on. 

2. Select the first point of the roof boundary. This is the first point of the roof 
length. 

3. Enter the appropriate value if you’re drawing a Gable, Gambrel, or Shed 
roof and you toggled PlatHgt, Pitch, or OverHng on in the RoofIt menu. 
RoofIt applies this value to the first edge of the roof. 

4. Select the second point of the first roof edge. 

5. Enter a value if you’re drawing a Gable, Gambrel, or Shed roof and you 
toggled Overhng on in the RoofIt menu. RoofIt applies this value to the 
second edge of the roof. 
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6. Select the third point of the roof boundary. The second edge of the roof 
boundary is bisected by, but not necessarily perpendicular to, the ridge. 
The Shed roof is an exception; on a Shed roof, this point locates the ridge 
(minus the overhang). 

7. Enter a value if you’re drawing a Gable, Gambrel, or Shed roof and you 
toggled PlatHgt, Pitch, or OverHng on in the RoofIt menu. RoofIt applies 
this value to the third edge of the roof.  

8. Select the fourth point of the roof; unless you toggled OverHng on in the 
RoofIt menu, the boundary closes and the roof model is constructed. 

9. 9. Enter a value if you toggled Overhng on. RoofIt applies this value to the fourth edge of 
the roof. After you enter the value, the boundary closes and the roof model is constructed. 

 
Figure 27.3: Defining an orthogonal PolyRoof boundary 

  
Figure 27.4: Defining a non-orthogonal PolyRoof boundary 

Joining Roofs 
Use Join to define a Gable, Hip, or Shed roof that connects to any one existing 
roof plane. The roof that you join onto may be any roof type created with RoofIt. 

The following example shows how to use RectRoof to join a Hip roof; you can 
also use PolyRoof. Define the roof boundary in a clockwise manner regardless of 
which input mode you use: RectRoof or PolyRoof. 

 To join two roofs: 

1. Model the first roof using the steps outlined at the beginning of this 
section. 
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Figure 27.5: Defining the first boundary 

 
Figure 27.6: First boundary defined (plan view and perspective hidden-line image) 

2. Toggle Join on in the RoofIt menu. This tells RoofIt that the next roof you 
define will join onto an existing roof.  

3. Define the boundary of the second roof. RoofIt prompts you to select the 
roof plane to join onto. When defining the joining roof, if you selected any 
parameters to vary, RoofIt prompts you for values as outlined in the 
previous sections. 

 
Figure 27.7: Join: Defining the second boundary 

4. Select a point within the perimeter of the roof plane to join to. RoofIt 
highlights the roof plane and starts the join operation. The roof you 
defined extends to and clips at the selected roof plane. 

  
Figure 27.8: Selecting roof plane to join 
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Figure 27.9: Result of join (plan view and perspective hidden-line image) 

Settings Options 
The options that appear in the RoofIt/Settings menu depend on the type of roof 
you’re drawing. The following table illustrates which settings appear for each 
roof type: 

 Gable Hip Boston Gambrel Mansard Shed 

PlatHgt X X X X X X 

Pitch X X X X X X 

MidRidge    X X  

2ndPitch    X X  

RoofThck X X X X X X 

Overhng X X X X X X 

GblOffst   X    

WallThck X X X X X X 

Fascia X X X X X  

EndWall X   X  X 

 

Settings options include: 

PlatHgt Sets the roof plate height; this value is an absolute Z-value and is not relative 
to the current Z-base and Z-height settings 

Pitch Sets the roof pitch in rise and run values (4:12, 5:12, 6:12, etc.); or enter a 
Custom pitch 

MidRidge Sets the purlin height on a Gambrel or Mansard roof; mid-ridge is a Z distance 
relative to the current PlatHgt setting 

2ndPitch Sets the second pitch on a Gambrel or a Mansard roof in rise and run values 
(4:12, 5:12, 6:12, etc.); or enter a Custom pitch 

RoofThck Sets the plate thickness of the roof 
Overhng Sets the roof overhang; measure overhang in the X, Y plane, from the roof 

definition boundary to the outermost point on the fascia 
GblOffst Sets the gable offset on a Boston roof; this distance is measured in the X, Y 

plane from the roof definition boundary to the exterior face of the gable end 
wall; only available when you choose to draw a Boston roof 

WallThck Sets the exterior wall thickness; controls the distance in the X, Y plane from the 
roof definition boundary to the intersection of the plate and the bottom plane 
of the roof 

Fascia Sets the width of the fascia on roofs with plumb fascia and horizontal soffits; 
does not affect the roof thickness (controlled by RoofThck); fascia width cannot 
exceed the plumb distance through the roof thickness; only available when 
SoffHorz and FaciaPlb are toggled on 

SoffHorz/SoffIncl Toggles between SoffHorz and SoffIncl to define the shape of the soffit; toggle 
SoffHorz on to draw the underside of the overhang (the soffit) horizontal, or 
parallel to the ground; toggle SoffIncl on to draw the soffit inclined, or parallel 
to the roof plane 
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FaciaPlb/FaciaSqr Toggles between FaciaPlb and FaciaSqr to define the shape of the fascia; toggle 
FaciaPlb on to draw the outside of the overhang (the fascia) plumb, or 
perpendicular to the ground; toggle FaciaSqr on to draw the fascia is square, or 
perpendicular to the roof plane 

EndWall Toggles the construction of end walls as part of the roof model (end walls fill in 
the gaps between the plate and the underside of the roof); when you toggle 
EndWall on, RoofIt prompts you to enter the color of the end walls. EndWall 
only appears when you select a Gable, Boston, Gambrel, or Shed roof type. 
RoofIt determines the thickness of the end wall by using WallThck. 

 
Figure 27.10: Roof parameters 

 
Figure 27.11: 2ndPitch and MidRidge settings 

 
Figure 27.12: Gable offset 
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Figure 27.13: Types of soffit and fascia 

Saving and Using Framing Settings 
Use FileI/O to access file options: 

LoadFile Loads a previously saved file of floor, wall, or roof framing settings 
SaveFile Saves the current framing settings in a file 
DelFile Deletes an existing file of framing settings 
Rename Renames an existing file of framing settings 
 



Modeling Windows and Doors 
The AEC Modeler tool offers you simplified creation of 3D door 
and window modeling. You can model doors and windows in 
plan view or in elevation view. 

28 
In this chapter: 

 Modeling windows 

 Modeling doors 
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Modeling Windows 
The Windows menu in AEC_MODL serves as the master level for accessing all 
three-dimensional window component groups. You can access window data, 
load and save previously designed windows, and select or enter window 
components and data. All windows open outward, away from you. 

Cutting Walls 

CutWall is a toggle used to automatically create voids in slabs or polygons for 
windows. It is available in the Windows menu when InPlan is toggled on. When 
CutWall is toggled on, a LyrSrch toggle also becomes available. 

Window Files 

The WndwFile option is a convenient way to expand on initial template designs, 
tailoring the product to your needs. The files then become additional resources 
for quick recall. The WndwFile menu options include: 

LoadWind Loads window settings from saved files; select or type a window filename and press 
(Enter); the window appears with all previously saved settings 

SaveWind Saves window settings to a file; type the filename and press (Enter) 
DelWind Deletes saved window files from the hard disk. To help prevent accidental deletions, 

the system prompts you for the name of the file you want to delete. Select the file you 
want to delete and press (Enter). Choose Yes to delete the window file; otherwise 
choose No. 

RenWind Renames existing files; select a file to rename, type a new filename of up to eight 
characters long, and press (Enter) 

CopyWind Copies the contents of an existing window file to a new file; select the file to copy 
from and press (Enter), then type the file to copy to and press (Enter) 

Form Displays a window data form. To save Form settings, press (Esc)  

Window Forms 

With the WndwForm option, you can view the settings for the current window. 
The design form offers a comprehensive view of the window parameters on one 
screen. These window parameters are divided into ten major groups.  

Saving Windows as Symbols 

Use the Template option to create and save windows as symbols, developing a 
library of window symbols that you can add quickly to new projects. See the 
“Symbols, Images, and Objects” chapter for more information on templates and 
symbols. 

This Template option is a shortcut to the Template menu. 

Window Height and Wall Thickness 

You can set the head height and sill height of a window with the Head Hgt and 
Sill Hgt options, as well as use the Wall Thk option to change the wall thickness. 
The Head Hgt and Sill Hgt options only appear when In Plan is toggled on, 
while Wall Thk is only available when In Elev is toggled on. When you choose 
Head Hgt, sill Hgt, or Wall Thk, a list of values is displayed. Choose or type a 
new value and press (Enter). The Head Hgt and Sill Hgt settings are relative to Z-
base. 
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Window Types 

The UnitType menu displays available window types. Hinged window types 
open outward, away from the designer. Sliding windows, when viewed from the 
interior design position, have a fixed sash on the right and a movable sash on the 
left.  

Choose from the following window types: 

Fixed Windows with fixed panes of glass 
Casement Casement windows 
Awning Awning windows, hinged at the top 
Hopper Hopper windows, hinged at the bottom 
DblHung Double-hung windows 
Sliding Sliding windows 
% open Determines the amount that the window appears open in the model, with 0% being 

fully closed and 100% being fully open 

Window Casings 

The Casing option controls the casing or exterior window group. You can set any 
of the following window casing options: 

AtHead Models casing elements at the window header 
Width Sets the casing width at the window header, the window jamb, and the sill across the 

window plane; choose the Width option under AtHead, AtJamb, or AtSill, and then 
choose or type a width and press (Enter) 

Thicknss Sets the casing thickness at the window header, the window jamb, and below the sill; 
choose or type a thickness and press (Enter) 

Extensn Sets the extension length past the outside edge of the vertical casing components 
(jamb casing) and past the outside edge of the vertical jamb casing component to the 
sillChoose or type an extension length and press (Enter). For any extension, the 
measurement is always 0 when the outside edge of the vertical casing and the 
extension end are aligned. Positive numbers indicate an extension; negative numbers 
indicate a setback. 

AtJamb Models the casing element at the jamb (Width and Thicknss appear again below 
AtJamb) 

AtSill Models the casing elements below the sill. (Width, Thicknss and Extensn appear 
again below AtSill) 

  
Figure 28.1: Window casing 

Window Trim 

Use Trim to control the trim or interior window component group. You can vary 
elements, such as the trim apron, according to aesthetic preference or design 
requirements: 

AtHead Models trim elements at the window header 
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Width Sets the trim width at the window jamb, across the window jamb; choose or type a 
value and press (Enter) 

Thicknss Sets the trim thickness at the window jamb and the window sill; choose or type a 
value and press (Enter) 

Extensn Sets the trim extension length past the outside edge of the vertical jamb trim 
components (jamb casing) or past the outside edge of the vertical jamb casing 
component of the sill; choose or type a value and press (Enter). For any extension, the 
measurement is always 0 when the outside edge of the vertical casing and the 
extension end are aligned. Positive numbers indicate an extension; negative numbers 
indicate a setback. 

AtJamb Models trim elements at the jamb (Width and Thicknss appear again below AtJamb) 
AtSill Models trim elements at the sill (Width, Thicknss and Extensn appear again below 

AtSill) 

  
Figure 28.2: Window trim 

Window Headers 

The Head option lets you define the window header, or top of the frame. This 
area can become exceedingly detailed in a model rendering, with the inclusion of 
its structural and aesthetic elements in one master group. You can individually 
set the following components to provide a clearer view: 

Do Head Models the header component 
HeadWdth Sets the header width. Measure through the wall, from the inner surface of the wall, 

outward. This option appears when WalWdth is off. When you choose HeadWdth, a 
list of header width values appears. Choose or type a header width and press (Enter). 

Head Thk Sets the window header thickness. Measure from top, the wall opening, to bottom. 
When you choose Head Thk, a list of header thickness values appears. Choose or type 
a header thickness and press (Enter). 

WalWdth Calculates the header width equal to the thickness of the wall. When WalWdth is off, 
the width of the head is controlled by the header width setting. 

  
Figure 28.3: Window header 
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Window Jambs 

Use the following Jamb options to define the window jamb: 

Do Jamb Models jamb components 
JambWdth Sets the jamb width. Measure through the wall from the inner surface of the wall, 

outward. This option appears when WalWdth is off. Choose JambWdth, and then 
choose or type a jamb width and press (Enter). 

Jamb Thk Sets the jamb thickness. Measure from the void edge, or wall opening, inward toward 
the window center along the wall plane. Choose Jamb Thk, and then choose or type a 
jamb thickness and press (Enter). 

WalWdth Sets the wall width. When this toggle is off, the width of the jamb is controlled by 
JambWdth. 

  
Figure 28.4: Window jamb 

Window Sills 

Sill lets you define the window sill. The sill is not broken down into stool 
(interior) and finish (exterior) sill components. Also, the sill horns are 
proportionate and do not carry different lengths on the interior and exterior 
extensions. 

Do Sill Models the sill 
Thicknss Sets the sill thickness from the bottom of the window opening, upward; choose 

Thicknss, and then choose or type a sill thickness and press (Enter) 
In Extn Sets the inside sill extension away from the plane of the wall toward the center of the 

room; choose In Extn, and then choose or type an inside sill thickness and press 
(Enter) 

Out Extn Sets the outside sill extension away from the plane of the wall outward; choose Out 
Extn, and then choose or type an outside sill extension and press (Enter) 

SideExtn Sets the inside and outside (sill horn) extensions from the sides of the window 
opening, outward, along the plane of the wall; choose SideExtn, and then choose or 
type a side extension and press (Enter) 

  
Figure 28.5: Window sill 
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Window Sashes 

Sash defines the window sash assembly. The sash is the frame that holds the 
muntins and glass; without it, the muntins and glass would be suspended in 3D 
space. Single pane or double thermopane windows, while not having muntins, 
must have Centred toggled on to function within the confines of the wall plane.  

Do Sash Models the sash components; when Do Sash is off, muntins and glass are not added 
to the drawing even if DoMuntn and DoGlass are on 

SashWdth Sets the sash width for all components (top and bottom rails and stiles); choose 
SashWdth, and then choose or type a sash width and press (Enter) 

SashThk Sets the sash thickness for all sash components; choose SashThk, and then choose or 
type a sash thickness and press (Enter) 

Centred Centers a sash within the window frame. Centred and Offset are mutually exclusive; 
only one can be toggled on at any given time 

Offset Determines the sash offset placement from the inside of the window jamb. The 
distance is from the interior surface of the wall to the interior surface of the sash; 
choose Offset, and then choose or type a sash offset and press (Enter) 

Muntins 

Use Muntins to define and place window pane dividers within the sash 
assemblies. You can also set the number of window panes and their placement.  

DoMuntn Models muntins, or window pane dividers 
MuntWdth Sets the muntin width along the plane of the wall; the width applies equally to 

vertical and horizontal muntins; choose MuntWdth, and then choose or type a 
muntin width and press (Enter) 

MuntThk Sets the muntin thickness, which is measured through the window; choose MuntThk, 
and then choose or type a muntin thickness and press (Enter) 

PaneHorz Sets the number of panes per window horizontally; choose PaneHorz, and then 
choose or type a value and press (Enter). PaneHorz and PaneVert are also available in 
the Glass menu. They are the same settings, so when you change either option in the 
Muntins menu, the new values are also displayed for the PaneHorz and PaneVert 
options in the Glass menu. 

PaneVert Sets the number of panes per window vertically; choose PaneVert, and then choose or 
type a value and press (Enter) 

Centred Centers a muntin within the sash; Centred and Offset are mutually exclusive; only 
one can be toggled on at any given time 

Offset Sets the offset placement of the muntins from the interior surface of the sash to the 
interior surface of the muntins; choose Offset, and then choose or type a muntin offset 
and press (Enter); Centred and Offset are mutually exclusive; only one can be toggled 
on at any given time 

FullEdg Sets a full-edge muntin at the window sash 
HalfEdg Sets a half-edge muntin at the window 
No Edg Sets a no-edge muntin at the window sash 
Slabs Constructs muntins as slabs; when Slabs is toggled off, muntins are constructed as 3D 

lines 

Glass 

Use Glass to define the number of glass panes horizontally and vertically. It also 
sets the glass thickness for the window panes in the model. Since glass is 
represented as a slab or solid object, it is often left out of a model so that a hidden 
line removal can be performed as if the glass were transparent.  

DoGlass Models window glass in the window panes 
GlassThk Sets the glass thickness; choose GlassThk, and then choose or type a glass thickness 

and press (Enter) 



MODELING DOORS  |    527 

PaneHorz Sets the number of horizontal panes per window; choose PaneHorz, and then choose 
or type a value and press (Enter). PaneHorz and PaneVert are also available in the 
Muntins menu. They are the same settings, so when you change either option in the 
Glass menu, the new values are also displayed for the PaneHorz and PaneVert 
options in the Muntins menu. 

PaneVert Sets the number of vertical panes per window; choose PaneVert, and then choose or 
type a value and press (Enter) 

Centred Centers a window pane glass in the muntin, through the window; Centred and Offset 
are mutually exclusive; only one can be toggled on at any given time 

Offset Sets the offset of the glass panes from the interior surface of the muntin to the interior 
surface of the glass; choose Offset, and then choose or type a glass pane offset and 
press (Enter); Centred and Offset are mutually exclusive; only one can be toggled on at 
any given time 

Modeling Doors 
The Doors menu in the AEC_Modl macro lets you access door data, load or save 
previously designed doors, and select or enter door components and data.  

Cutting Walls 

CutWall is a toggle used to automatically create voids in slabs or polygons for 
doors. It is available in the menu when InPlan is toggled on. When CutWall is 
toggled on, a LyrSrch toggle also becomes available. 

Door File 

Use the DoorFile option to load, save, delete, rename, or copy door files. Choose 
from the following DoorFile options: 

LoadDoor Loads door parameters from saved files; choose or type a door filename and press 
(Enter) 

SaveDoor Saves door parameters to a file; type a filename and press (Enter) 
Del Door Deletes saved door files from the hard disk. To help prevent accidental deletions, the 

system prompts for the filename requested. To delete a door file, select a filename and 
press (Enter). Choose Yes to delete the file; otherwise choose No.  

Ren Door Renames existing files; select a file to rename, type a filename of up to eight 
characters long, and press (Enter) 

CopyDoor Copies the contents of an existing door file to a new file; type the name of the file to 
copy from and press (Enter), then type the filename to copy to and press (Enter) 

Form Displays a door data form 
All doors are created to open inward, toward you. 

Door Forms 

The DoorForm menu lets you view the settings for the door on which you are 
currently working. The design form offers a comprehensive view of the door 
parameters on one screen. 

Saving 3D Doors as Symbols 

Use the Template option to create and save doors as symbols, developing a 
library of door symbols that you can quickly insert into new projects. For more 
information, see “Templates and Symbols” in the “Drawing Elements” chapter. 
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Door Heights and Wall Thickness 

You can set the head height and sill height of a door with the Head Hgt and Sill 
Hgt options, as well as use the Wall Thk option to change the wall thickness. The 
Head Hgt and Sill Hgt options are available only when In Plan is toggled on, 
while Wall Thk is only available when In Elev is toggled on. When you choose 
one of these options, a list of values is displayed in the Menu Window. Choose or 
type a new value and press (Enter). The Head Hgt and Sill Hgt settings are relative 
to Z-base. 

Door Types 

UnitType displays available door types. Doors swing inward (toward you), so 
you should build designs from the interior of a structure. 

Choose a door type from the following options: 

Single Single door, hinged 
Double Double doors, hinged 
Bifold Bi-fold door 
2xBifld Double bi-fold doors 
Sliding Sliding door 
Pocket Pocket doors 
% open Determines the percentage that a door appears open in the model, with 0% being 

fully closed and 100% being fully open 

Door Casings 

Use Casing to control the casing or exterior door component group. You can set 
any of the following door casing options: 

At Head Models casing elements in the door header model 
Width Sets the casing width at the door header, across the door plane, and at the door jamb; 

choose or type a value and press (Enter) 
Thicknss Sets the casing thickness at the door head and at the door jamb; choose or type a 

value and press (Enter) 
Extensn Sets the extension length past the outside edge of the vertical casing components 

(jamb casing). Choose or type a value and press (Enter). For any extension, this 
measurement is always 0 when the outside edge of the vertical casing and the 
extension end are aligned. Positive numbers indicate an extension; negative numbers 
indicate a setback. 

At Jamb Models casing elements in the door jamb model (Width and Thicknss appear again 
after this option) 

  
Figure 28.6: Door casing 
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Door Trim 

Use Trim to control the trim, or interior door component group. You can vary 
such elements as the trim apron, according to aesthetic preference or design 
requirements.  

At Head Models trim elements at the door header model 
Width Sets the trim width at the door header and across the door jamb 
Thicknss Sets the trim thickness at the door header, through the door, and at the door jamb 
Extensn Sets the trim extension length past the outside edge of the vertical jamb trim 

components 
At Jamb Models trim elements in the door jamb model (Width and Thicknss appear again after 

AtJamb) 

  
Figure 28.7: Door trim 

Door Headers 

Use Header to define the door header. This area can become exceedingly detailed 
in a model rendering, including its structural and aesthetic elements in one 
master group. With Header you can break down the various components to 
provide a clearer view. 

Do Head Models the door header 
HeadWdth Sets the door header width. Measure through the door, from the inner surface of the 

door outward. This option appears when WalWdth is off; choose HeadWdth, and 
then choose or type a header width and press (Enter) 

HeadThk Sets the door header thickness. Measure from top (wall opening) to bottom. When 
you choose HeadThk, a list of thickness values appears. Choose or type a header 
thickness and press (Enter). 

WalWdth Calculates a header width equal to the wall thickness; when WalWdth is off, the 
width of the header is controlled by the header width (HeadWdth) setting 

  
Figure 28.8: Door header 
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Door Jambs 

The Jamb menu defines the door jamb, using the following options: 

Do Jamb Models jamb components 
JambWdth Sets the door jamb width (measure from the inner surface of the door, outward 

through the door); available only when WalWdth is off; choose JambWdth, and then 
choose or type a jamb width and press (Enter) 

Thicknss Sets the door jamb thickness (measure from the void edge, or wall opening, inward 
toward the door center along the wall plane); choose Thicknss, and then choose or 
type a jamb thickness and press (Enter) 

WalWdth Sets the jamb width equal to the wall width; when WalWdth is off, the width of the 
jamb is controlled by JambWdth; choose WalWdth, and then choose or type a jamb 
width and press (Enter) 

  
Figure 28.9: Door jamb 

Door Sills 

The Sill menu defines the door sill, using the following options: 

Do Sill Models the sill 
Thicknss Sets the sill thickness from the bottom of the door opening, upward at the sill middle; 

choose Thicknss, and then choose or type a sill thickness and press (Enter) 
EdgeThk Sets the thickness of the tapered edge; choose EdgeThk, and then choose or type an 

edge thickness and press (Enter) 
InExtn Sets the inside sill extension away from the plane of the door toward the center of the 

room; choose InExtn, and then choose or type an extension and press (Enter) 
Out Extn Sets the exterior sill extension across the door plane from the exterior wall outward; 

choose Out Extn, and then choose or type an extension and press (Enter) 
SideExtn Sets the exterior sill extension along the wall plane from the outside edge of the trim 

outward (also known as the “sill horns”); choose SideExtn, and then choose or type 
an extension and press (Enter) 

  
Figure 28.10: Sill thickness 
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Door Stops 

Use Stop to place and size the door stops. The stop is drawn to the exterior of the 
door, whether the door is flush or offset. Door stops are not created for sliding or 
pocket doors, regardless of whether Do Stop is toggled on or not. 

Do Stop Models the door stop 
StopWdth Sets the stop width for all components (measure the stop width in the same direction 

as the jamb width and across the wall plane); choose StopWdth, and then choose or 
type a stop width and press (Enter) 

Stop Thk Sets the stop thickness dimension (measure the stop thickness in the same direction as 
the jamb thickness and across the wall plane); choose Stop Thk, and then choose or 
type a stop thickness and press (Enter) 

Door Options 

The Door menu sizes, positions, and hinges a door, using the following options: 

Do Door Models the door 
Door Thk Sets the door thickness; choose Door Thk, and then choose or type a door thickness 

and press (Enter) 
HingRht Hinges doors on the right; determine the right side of the door by standing inside the 

structure and looking at the door 
HingLft Hinges doors on the left; determine the left side of the door by standing inside the 

structure and looking at the door 
Flush Sets the door flush with the outside wall 
Offset Sets the offset placement of the door from the interior wall surface across the wall 

plane; choose Offset, and then choose or type a value and press (Enter) 

Door Knobs 

Use Knob to place, size, and identify the door knob; only round door knobs are 
available. When Do Door is off, you can’t create a knob regardless of the Do 
Knob setting. 

Do Knob Models the knob 
Diameter Sets the diameter of the door knob; choose Diameter, and then choose or type a door 

knob diameter and press (Enter) 
Extnsion Sets the knob extension out from the door; choose Extnsion, and then choose or type a 

knob extension and press (Enter) 
Knob Hgt  Sets the height of the knob from the bottom of the door; choose Knob Hgt, and then 

choose or type a knob height and press (Enter) 
Offset Sets the knob offset from the door edge; choose Offset, and then choose or type a 

knob offset and press (Enter) 
Inside Models a knob on the door interior 
Outside Models the knob on the door exterior; Outside and Inside can be toggled individually 

or together 





Modeling Concrete Forms 
With the Concrete tool, you can add six different types of 
preconstucted concrete forms to your model: columns, inverted 
tee, single tee, double tee, standard, and I-beam forms. These 
forms are actually slabs and can be edited the same way you’d 
change regular DataCAD slabs, using the editing options in the 
3DEdit menu. 

With the exception of columns, all forms are drawn based on a 
defining line, which is the line connecting the two points you 
enter that represent the two ends of the form. In plan view, this 
line can define the right, left, or center of the form and can lie at 
Z-base or Z-height. This line can also be defined in the Z 
direction. In addition, the form’s top, bottom, or center can 
intersect the defining line in the Z direction. These options give 
you 18 possible positions for every form you draw. 

29 
In this chapter: 

 Drawing columns 

 Drawing inverted, single 
and double tee forms 

 Drawing standard forms 

 Drawing I-beam forms 
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Drawing Columns 
Columns begin as rectangular boxes. You can chamfer the vertical edges of the 
column and add up to four seats to the column to support the girders and beams. 
The location of a column is defined by two points, at opposite corners of a box, 
indicating the overall dimensions of the column. The column extends vertically 
from the current value of Z-base to the current value of Z-height. 

 To draw columns: 

1. Choose Column from the Toolbox menu’s Concrete submenu. The 
following options are displayed: 

Width Sets the column width 
Depth Sets the column height 
Rotate Enters columns that rotate about the entry point; you are prompted for the 

rotation angle of the column 
LoLeft Specifies the location of the column by its lower left corner 
Center Specifies the location of the column by its center point 
UpRight Specifies the location of the column by its upper right corner 
TopSeat/ BotSeat BotSeat LftSeat / RhtSeat Indicate the side of the column where the 

column seat is; you are prompted for the height of the column seat from the 
current value of Z-base (when a toggle is off, column seats are not added for 
that particular side) 

SeatOnly Adds column seats to an existing column or multiple sets of column seats to 
a single column in a multiple-story structure with monolithic concrete 
columns. When this toggle is on, you can add seats to a column, but you 
cannot add actual columns. 

SeatWdth  Sets the distance from the face of the column to the outside of the column 
seat 

SeatHght Sets the distance from the top face of the column seat to the bottom edge of 
the column seat 

Chamfer Chamfers the edges of the column; otherwise, the column is angular in cross 
section (the size of the column seats automatically adjusts) 

ChamSize Sets the size of the column chamfers 
2. Choose any options you want to set. When you choose Width, Depth, 

Rotate, TopSeat, BotSeat, LftSeat, RhtSeat, SeatWdth, and SeatHght a list 
of values appears. 

3. Choose or type a value and press (Enter). 

4. Select a point in the Drawing Window to place the column’s location. 

Drawing Inverted, Single and Double Tee Forms  
Inverted tees, or girders, are typically used for supporting single or double tees 
across a long span such as a parking garage bay. Because they are in the shape of 
an inverted T, the beam portion of a single, double, or quad tee can be placed on 
a tee’s shelf. You have a variety of options for changing the overall dimensions of 
the beam and for its placement in your model. 

 To draw an inverted tee: 

1. Choose InvrtTee from the Concrete menu. The following options are 
displayed: 

OvrlHgh Sets the overall height of the inverted tee; choose OvrlHght, and then choose 
or type a value and press (Enter) 
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OvrlWdth Changes the overall width of the inverted tee; choose OvrlWdth, and then 
choose or type a value and press (Enter) 

NtchDpth Changes the depth of the notch in the inverted tee; choose NtchDpth, and 
then choose or type a value and press (Enter) 

BeamThck Changes the thickness of the narrow portion of the inverted tee; choose 
BeamThck, and then choose or type a value and press (Enter) 

Left Draws the form to the left of the defining line in the X-Y plane 
Center Draws the form centered about the defining line in the X-Y plane 
Right Draws the form to the right of the defining line in the X-Y plane 
Top Draws the form with its top aligned with the defining line 
Center Draws the form with its center aligned to the defining line 
Bottom Draws the form with its bottom aligned to the defining line 
Z-Base Sets the defining line at the Z-base 
Z-Height Sets the defining line at the Z-height 
Single Places a shelf on only one side of the inverted tee (to the left of the defining 

line) on the end of the first inverted tee that is entered 
Double  Places shelves of identical size on both sides of the inverted tee 

2. Select the first end of the defining line. 

3. Select a second point that is the opposite end of the defining line. 

Single tee concrete forms are used as combination beams and floor slabs. In 
applications where the primary function is creating floors, a double tee form is 
generally used. Industrial buildings and parking structures use double tees for 
upper floors that must support large floor loads. A double tee form is easier to 
position and place because of the stability provided by having two beam 
sections. Single tees are used in special cases, where spans are exceptionally long 
or floor loads are exceptionally high. In these cases, the weight and size of double 
tee forms can make them too large and heavy for practical fabrication, shipment, 
or placement. 

 To draw a single tee: 

1. Choose SnglTee from the Concrete menu. The following options are 
displayed: 

Width Sets the overall width of the single tee form (the location of the beam flanges 
of the form are automatically adjusted); choose Width, and then choose or 
type a width and press (Enter) 

Depth Sets the overall depth of the single tee form; choose Depth, and then choose 
or type a depth and press (Enter) 

WebThck Sets the thickness of the floor slab portion of the single tee form; choose 
WebThck, and then choose or type a thickness and press (Enter) 

BeamThck Sets the thickness of the two support beams for the single tee slab  
Left Draws the form to the left of the defining line in the X-Y plane 
Center Draws the form centered about the defining line in the X-Y plane 
Right Draws the form to the right of the defining line in the X-Y plane 
Top Draws the form with its top aligned to the defining line 
Center Draws the form with its center aligned to the defining line 
Bottom Draws the form with its bottom aligned to the defining line 
Z-Base Places the defining line at Z-base 
Z-Hght Places the defining line at Z-height 

2. Set the size of cross-sectional dimensions of the single tee form. 

3. Select the first end point of the defining line. 

4. Select the second end point of the defining line. 
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 To draw a double tee:  

1. Choose DbleTee from the Concrete menu. The following options are 
displayed: 

Width Sets the overall width of the double tee form (the location of the beam 
flanges of the form are automatically adjusted); choose Width, and then 
choose or type a width and press (Enter) 

Depth Sets the overall depth of the double tee form; choose Depth, and then choose 
or type a depth and press (Enter) 

WebThck Sets the thickness of the floor slab portion of the double tee form; choose 
WebThck, and then choose or type a thickness and press (Enter) 

BeamThck  Sets the thickness of the two support beams for the double tee slab; choose 
BeamThck, and then choose or type a thickness and press (Enter) 

Left Draws the form to the left of the defining line in the X-Y plane 
Center Draws the form centered about the defining line in the X-Y plane 
Right Draws the form to the right of the defining line in the X-Y plane 
Top Draws the form with its top aligned to the defining line 
Center Draws the form with its center aligned to the defining line 
Bottom Draws the form with its bottom aligned to the defining line 
Z-Base Places the defining line at Z-base 
Z-Hght Places the defining line at Z-height 

2. Set the size of the cross-sectional dimensions of the double tee form. 

3. Select the first end point of the defining line.  

4. Select the second end point of the defining line. 

Drawing Standard Beam Forms 
Standard beams have a simple rectangular cross section, but they can also have 
chamfers along the four edges of the beam. You can vary the height and width of 
the beam. There are 18 possible ways to position the beam relative to a defining 
line that extends from the first point entered to the second point entered. 

 To draw a standard beam: 

1. Choose Std Beam from the Concrete menu. The following options are 
displayed: 

Width Sets the beam width 
Depth Sets the beam depth 
Chamfer Chamfers the beam on all edges; otherwise, the beam is rectangular in the 

cross section. When Chamfer is on, you must enter the chamfer size.  
Left Draws the form to the left of the defining line in the X-Y plane 
Center Draws the form centered about the defining line in the X-Y plane 
Right Draws the form to the right of the defining line in the X-Y plane 
Top Draws the form with its top aligned to the defining line 
Center Draws the form with its center aligned to the defining line 
Bottom Draws the form with its bottom aligned to the defining line 
Z-Base Sets the beam’s defining line at the Z-base 
Z-Hght Sets the beam’s defining line at the Z-height 

2. Choose any options you want to set. When you choose Width, Depth, and 
Chamfer, a list of values appears. Choose or type a value and press (Enter).  

3. Select the first end of the defining line. 

4. Select the second end of the defining line. 
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Drawing I-Beam Forms  
I-beams are similar to standard beams, except that the beam is narrower at the 
middle of the cross section than it is at either end of the cross section. For a 
typical application, the stresses in the concrete are much higher at the top or 
bottom of the beam; therefore, an I-beam can be more economical to use than a 
standard rectangular beam. 

 To draw an I-beam: 

1. Choose I-Beam from the Concrete menu. The following options are 
displayed: 

Width Sets the overall horizontal measurement of the cross section of the I-beam 
Depth Sets the overall vertical measurement of the cross section of the I-beam 
WebThick Sets the thickness of the narrower portion of the beam independently of the 

overall width of the I-beam 
FlngDpth Sets the vertical dimensions of the I-beam flange independently of all other 

I-beam cross section dimensions 
Left Draws the form to the left of the defining line in the X-Y plane 
Center Draws the form centered about the defining line in the X-Y plane 
Right Draws the form to the right of the defining line in the X-Y plane 
Top Draws the form with its top aligned with the defining line 
Center Draws the form with its center aligned with the defining line 
Bottom Draws the form with its bottom aligned with the defining line 
Z-Base Sets the beam’s defining line at the Z-base 
Z-Height Sets the beam’s defining line at the Z-height 

2. Choose any options you want to set. When you choose Width, Depth, 
WebThick, or FlngDpth, a list of values appears. Choose or type a value 
and press (Enter). 

3. Select the first end of the defining line.  

4. Select the second end of the defining line. 



|  CHAPTER 29: MODELING CONCRETE FORMS  538

 



Modeling Stairs 
The 3D Stairs tool gives you everything you need to create any 
of seven predefined 3D stairs, including single-run, straight-
run, double-back, L-shaped, open-well, curved, and spiral 
stairs. 

For each stair type, you can customize settings for treads, risers, 
landings, stringers, handrails, balusters, and more. These 
settings can then be reviewed on screen and even saved to a 
stair (.STR) file that will allow you to quickly load customized 
settings for drawing additional stairs. 

30 
In this chapter: 

 Drawing 3D stairs 

 Customizing stair 
settings 

 Saving and using stair 
settings 
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Drawing 3D Stairs 
The 3DStairs menu provides everything you need to create a set of three-
dimensional stairs. 3DStairs creates real stairs, not stacked slabs, making this 
representation of stairs more accurate than ever before. The 3DStairs macro has 
these main features: 

• seven predefined stair types -- single-run, straight-run, double-back, L-
shaped, open-well, curved, and spiral 

• a stair calculator, which makes it easy for you to calculate the values of stair 
settings and then readjust the Settings menu values 

With the stair forms and other settings you can customize the shape and 
placement of stair components. There are three ways to define the settings for the 
type of stairs you want to model: 

• use the 3DStairs/Settings menu to select options and enter individual values 
for the various stair components 

• use the Stair Form to display the settings on the screen for reference and/or 
customization 

• save your stair settings to a file through the StrFile menu; when you want to 
model that specific stair type again, you can recall the file 

Because of the interactive nature of stair components, changing one option can 
cause other options to change automatically. For example, when you close 
stringers, you can’t have tread extensions. 

The sections that follow describe how to create each stair type. You can only use 
the Stair Calculator for single-run stairs. See the “More About Drawing Single-
Run Stairs” later in this chapter for more information. 

 To draw 3D stairs: 

1. Choose Toolbox from the Edit menu. 

2. Choose 3DStairs from the Toolbox dialog box.  

3. Choose a stair type. 
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StraightSingle

L-ShapedSpiralDouble Back

CurvedOpen Well
 

Figure 30.1: Stair types 

4. Set the options for the stair style you want. You can use either the Settings 
menu, the Stair Form, or you can load a stair file. When you model single-
run stairs, you can use the Stair Calculator to determine the settings. See 
the “More About Drawing Single-Run Stairs” later in this chapter for 
more information. 

5. Choose Begin to place the stairs. The tool automatically changes to a plan 
view and a boundary box appears representing the run of stairs. When 
Ortho mode is on, the boundary box does not track with the cursor. Press 
(O) to toggle Ortho mode off. 

6. Drag the stairs by the lower outside corner of the first run to the new stair 
position. The boundary box rotates as you move your cursor. 

7. Rotate the stairs to the angle you want. The box rotates as you move the 
cursor. 

8. Click to place the stairs. The stair model appears in the selected location 
with the settings you chose. 

9. Change the results by erasing the last group by pressing (Shift) + (<) and 
repeat steps 3 through 7. 

More About Drawing Single-Run Stairs 

The Stair Calculator (Calculat) is available only when you create single-run stairs. 
Use it to calculate one of six possible values: total rise, number of risers, riser 
height, total run, number of treads, or tread depth. 

Use the Stair Calculator as you would use a desktop calculator; prompts are 
displayed in the Message Window at the bottom of the screen. Save the answers 
to automatically update the 3DStairs/Settings menu for single-run stairs. 
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 To use the stair calculator: 

1. Choose Calculat from the 3DStairs menu.  

2. Select an option from the Calculat menu to calculate and modify: 

TotlRise The number of risers times the riser height; same value regardless of 
whether LandTop is on or off 

# Risers The total rise divided by the riser height, including the rise of the top 
landing; changing the number of risers automatically changes the number of 
treads and vice versa 

RiserHgt The vertical distance from the top of one tread to the top of the next tread; 
the total rise divided by the number of risers 

TotalRun The horizontal distance from the top of the run of stairs to the bottom of the 
stairs; the number of treads times the tread depth (the distance can include 
landing depth for the top and bottom landings when those toggles are 
turned on) 

# Treads The number of treads in the stair run; changing the number of treads 
automatically changes the number of risers and vice versa (you can set 
TreadDth from this menu to recalculate the number of treads) 

TreadDth The horizontal distance from the face of one riser to the face of the next riser; 
the total run divided by the number of treads (you can change # Treads in 
this menu) 

LandBtm When LandBtm is on, the total run value includes the bottom landing depth 
LandTop When LandTop is on, the total run value includes the top landing depth 
Reset Resets your calculator settings to the default values 
Update Overwrite the old settings in the Setting menu with new settings; saves your 

calculated values 
Begin Use Begin to start modeling stairs. Follow the steps in the “Using Stairs” 

section for information on using Begin. 
Template Shortcut to the Template menu; select a template from the menu, or type a 

template name, and press (Enter) 
Hide Perform hidden line removals; see “Hide” in the “3D Editing” chapter for 

more information. See the “Viewing Your Model” chapter for more 
information on templates, hidden line removals, and the 3DViews menu. 

3DViews Shortcut to the 3DViews menu; see the “3D Viewing” chapter for more 
information 

3. Look at the submenu that is displayed after some Calculat menu options. 
If this occurs, choose an option to modify; if not, skip to step 5. 

4. Choose a new value from the menu or type a different value. As you 
change the values of a setting, the results are automatically calculated and 
displayed. The stair calculator only accepts a whole number of treads or 
risers as a result. If the values you enter in a calculation result in a 
fractional solution, the stair calculator modifies the values. 

5. Modify other options by repeating steps 3 and 4. 

6. Choose Update to update the settings in the 3DStairs/Settings menu. 

Total
Rise

Riser
Height

Bottom Landing

Top Landing

1

2

3

4

5

6

7

Number of Risers = 7

 
Figure 30.2: Total rise, riser height, and number of risers 
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Figure 30.3: Total run, tread depth, and number of treads 

For example, to calculate the number of risers through changing RiserHgt: 

 Initial Settings Modified Settings Stair Calculator Results 
TotlRise 12’0” 12’0” 12’3” 
RiserHgt 6” 7” 7” 
#Risers 24 20.57 21 

 

Because #Risers is a fractional number, the Stair Calculator automatically adjusts 
the TotlRise so that the results are whole numbers. If you change TotlRise, Stair 
Calculator adjusts RiserHgt to find a whole number solution. 

Customizing Stair Settings 
Use the Settings menu to change the settings for 3DStairs. Different options 
appear depending on the stair type you selected from the 3DStairs menu.  

The options in the top half of the menu are global settings that apply to all stair 
types. The bottom half of the menu are stair component submenus. Each of these 
submenus contains the various settings for that particular component. 

When you choose any of the Settings options, a list of values appears. Choose a 
value or press (Enter) to accept the given value. 

Base Elevation 

Use BaseElev to change the base elevation of a flight of stairs. Base elevation is 
the height, or elevation, at which the flight of stairs begins. 
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Figure 30.4: Base Elevation 
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Treads 

Use TrdLngth to change the tread length. The tread length is the horizontal 
distance from one side of the tread to the other side. It does not include tread 
extension values. Any tread extensions are added to the tread length and only 
apply to stairs modeled with open stringers.  
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Figure 30.5: Tread length 

Use Trd/Run1 to change the number of treads in the first run of stairs. This 
applies to all stair types. The number of treads does not include the landing at 
the top of the run and is equal to one less than the number of risers. 

Use Trd/Run2 to change the number of treads in the second run of stairs. 
Trd/Run2 is only available for straight, double-back, open-well, and L-shaped 
stairs.  

Use Trd/Run3 to change the number of treads in the third run of stairs. 
Trd/Run3 is only available for open-well stairs.  

Radius of Curved Stairs 

Use Radius to change the inner radius of curved and spiral stairs. Measure 
Radius from the exact center point to the inside face of the stringer for curved 
stairs and the radius of the center pole for spiral stairs.  

 

Radius

Tread
Depth

 
Figure 30.6: Radius on a curved flight of stairs 

Clockwise 

Clkwise applies to all stair types except single and straight. You can place the 
stairs clockwise or counterclockwise depending on your needs. 
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Chases 

Use Chase to control the horizontal distance between the runs of a double-back 
flight of stairs. This setting effects the width of the intermediate landing and the 
tread length. 

 

Intermediate Landing

Double Back Stairs,
Plan View

Chase  
Figure 30.7: Chase 

Landings 

The top, bottom, and in some cases, intermediate landings all have depth and 
thickness settings. You can change the specific settings for each landing you 
create using the Landing menu in the 3DStairs/Settings menu. (Changing the 
settings on the top landing does not affect the settings of the bottom landing, and 
vice versa.) 

Toggle DoLndTp on to model a landing at the top of the flight of stairs; toggle 
DoLndBt on to model a landing at the bottom of a flight of stairs. 

The Depth option sets the landing depth. The landing depth is the horizontal 
distance from the front of the landing to the rear of the landing. When you model 
L-shaped or open-well stairs, you cannot set a landing depth on the intermediate 
landing. The landing depth equals the width of the run of stairs. 

 
Figure 30.8: Landing depth 

Thicknss shows the current thickness of a landing. Measure the landing thickness 
vertically from the underside to the top side. Thicknss sets the top, intermediate, 
and bottom landing thicknesses. 
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For stair types that have intermediate landings, IntrLand is always on. It is 
available for straight, double-back, open-well, or L-shaped stairs only. For 
rectangular or curved intermediate landings, use the Rectangl/Curved option; 
this is available for L-shaped, double-back, or open-well stairs only.  

 

Open Well

Double Back

L-Shaped  
Figure 30.9: Rectangular / curved intermediate landings 

Use Color to set the landing color. All landings in a single flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color. 

Risers 

Use the Riser menu to set options that create risers and determine riser height, 
thickness, and color. Toggle DoRiser on to model risers on your flight of stairs. 

RiserHgt displays the current riser height in the Message Window and lets you 
reset it. The riser height is the vertical distance from the top of one tread to the 
top of the next.  
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Figure 30.10: Riser height, total rise, and tread depth 

The Thicknss option displays the current riser thickness in the Message Window 
and lets you reset it. The riser thickness is the horizontal distance from the front 
side of the riser to the backside of the riser when you choose Thicknss. 

Use Color to set the landing color. All landings in a single flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color. 
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Treads 

Use Tread to set options that model treads and determine the depth, thickness, 
and nosing of the treads. Toggle DoTread on to automatically calculate and 
model treads on a flight of stairs. 

Depth displays the current tread depth in the Message Window and lets you 
reset it. The tread depth is the horizontal distance from the front of one tread to 
the front of the next tread. When you select a spiral stair, TredDegs (tread 
degrees) is displayed in the menu in place of depth. Tread degrees displays the 
inclusive angle of the treads on spiral stairs in the Message Window and lets you 
reset it. 
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Figure 30.11: Tread depth 

Thicknss displays the current tread thickness in the Message Window and lets 
you reset it. The tread thickness is the vertical distance from the top side of the 
tread to the bottom side of the tread. 

LeftExtn and RghtExtn display the current left and right extension, respectively, 
of the tread in the Message Window and lets you reset it. Left extension includes 
tread length, the distance from one stringer to the next. LeftExtn controls the 
distance that the tread extends beyond the outside of the stringer. LeftExtn is 
available only for stairs with open stringers. 

 

Left Tread
Extension

 
Figure 30.12: Tread extension 

When Nosing is toggled on, you can set the nosing length and type for treads. 
3DStairs prompts you for an overhang value when you toggle nosing on. Nosing 
controls the distance that the front of the tread extends beyond the front of the 
riser. 
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To set the nosing type to square or round, click on the RndNosng/SqrNosng 
toggle. This Nosing option changes between round and square just by clicking on 
it. If RndNosng is displayed in the Nosing menu, round nosing will be drawn on 
the stair treads; if SqrNosng is displayed in the Nosing menu, square nosing will 
be drawn on the stair treads. 
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Figure 30.13: Nosing 

Use Color to set the color for the treads. All treads in a flight of stairs are the 
same color. See “Color Menus” in “The Drawing Board” chapter for more 
information about how to choose a color. 

Stringers 

Stringer allows you to set options that create stringers and determine where and 
what kind you want to use. Toggle DoLeft on to model a stringer on the left side 
of the run of stairs, toggle DoCtr on to model a stringer in the center of a run of 
stairs, or toggle DoRght on to model a stringer on the right side of the stairs. 
When using DoCtr, the stringer is always modeled as an open stringer.  

Use the ClosdStr/OpenStr toggle to set the stringer type to open or closed. When 
ClosdStr is displayed in the Stringer menu, stringers will be modeled as closed; 
when OpenStr is displayed in the Stringer menu, stringers will be modeled as 
open. Choose ClosdStr or OpenStr to toggle between the two options. 

Width displays the current width of the stringer in the Message Window and lets 
you reset it. Measure the width from the top edge of the stringer to the bottom 
edge of the stringer. 
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Figure 30.14: Stringer width (open or closed) 
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The stringer thickness is the horizontal distance from the inside of the stringer to 
the outside of the same stringer. Choose Thicknss from the Stringer menu, and 
then choose or type a new thickness value and press (Enter). 
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Figure 30.15: Stringer thickness 

Use Color to set the color for the stringer. All stringers in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color. 

Handrails 

Toggle DoLeft on to model a handrail on the left side of the flight of stairs. Toggle 
DoRght on to model a handrail on the right side of a flight of stairs. When either 
of these options are toggled off, 3DStairs does not model the handrails on that 
side of the stairs. 

The Rectangl/Cylinder toggle lets you choose between modeling a cylindrical or 
rectangular handrail. When you select Cylinder, the Radius and Division options 
appear for you to enter settings. When you select Rectangl, the Width and Depth 
options appear for you to set. 

The Radius/Width toggle displays the current radius or width of the handrail in 
the Message Window, depending on whether you selected cylindrical or 
rectangular handrails. When you model a cylindrical handrail, you can adjust the 
radius of the cylinder. When you model a rectangular handrail, you can adjust 
the width of the rectangle. Measure width from the top of the handrail to the 
bottom of the handrail. 

  
Figure 30.16: Handrail width and depth 
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The Depth/Division toggle displays the current depth or number of divisions in 
the handrail in the Message Window, depending on whether you select 
cylindrical or rectangular handrails. When you model a cylindrical handrail, you 
can adjust the division of the cylinder, or the number of sides in the cylinder. 
When you model a rectangular handrail, you can adjust the depth of the 
rectangle. Measure depth from one side of the handrail to the other side. You can 
use up to 36 divisions, but the more divisions you have, the longer it takes 
DataCAD to redraw. 

Use Height to see or reset the current height of the handrail. Measure handrail 
height from the top surface of the handrail to the top of the tread. 
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Figure 30. 17: Handrail height 

Use Color to set the color for the handrails. All handrails in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color. 

Balusters 

Use the Baluster menu in the 3DStairs/Settings menu to choose what kind of 
balusters, if any, to use for your stairs. Toggle DoBalus in the Baluster menu on to 
model balusters on your flight of stairs. 

The Baluster menu has three options for baluster placement. OnSide models 
balusters on the sides of the stringers, OnTread models balusters on the treads, 
and OnStrng models balusters on the center of the stringer. OnStrng is available 
only when you model a closed stringer. 

Depending on whether you choose OnSide, OnTread, or OnStrngr for baluster 
placement, either the Bal/Tred or Bal/Run1 option is displayed in the Baluster 
menu. The Bal/Tred option displays the number of balusters per tread in the 
Message Window and lets you change the value. Bal/Tred is only available when 
you use OnTread. The Bal/Run1 option displays the current number of balusters 
in the first run of the stairs in the Message Window and lets you change that 
value. Bal/Run1 is available only when you place the balusters on the side of the 
stringer (OnSide) or on the stringer (OnStrng). 

The Bal/Run2 option displays the current number of balusters in the second run 
of the stairs in the Message Window and lets you change that value. Bal/Run2 is 
available only when you place the balusters on the side of the stringer (OnSide) 
or on the stringer (OnStrng) on straight, double-back, open-well, and L-shaped 
stairs. 
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The Bal/Run3 option displays the current number of balusters in the third run of 
the stairs in the Message Window and lets you change that value. Bal/Run3 is 
available only when you place the balusters on the side of the stringer (OnSide) 
or on the stringer (OnStrng) on open-well stairs. 

Use Cylinder/Rectangl to choose between modeling a cylindrical or rectangular 
baluster. When you select Cylinder, the Radius and Division options appear. 
When you select Rectangl, the Width and Depth options appear. 

The Radius/Width toggle displays the current radius or width of the baluster in 
the Message Window, depending on whether you selected cylindrical or 
rectangular balusters. When you model a cylindrical baluster, you can adjust the 
radius of the cylinder. When you model a rectangular baluster, you can adjust the 
width of the rectangle. Measure width from one side to the other of one baluster. 

The Depth/Division toggle displays the current depth or number of divisions in 
the baluster in the Message Window, depending on whether you selected 
cylindrical or rectangular balusters. When you model a cylindrical baluster, you 
can adjust the division of the cylinder, or the number of sides in the cylinder. 
When you model a rectangular baluster, you can adjust the depth of the 
rectangle. Measure depth from the front to the back of the baluster. You can use 
up to 36 divisions, but the more divisions you have, the longer it takes DataCAD 
to redraw 

Width

Depth  
Figure 30.18: Baluster width and depth 

Use Symbol to model balusters as symbols. When balusters are symbols, you can 
replace the balusters produced by 3DStairs with different, more detailed baluster 
symbols that you create. 

 To use custom balusters in stairs: 

1. Create your detailed baluster in the DataCAD drawing window and save 
it as a symbol. See “Creating and Editing Symbols” in the “Symbols, 
Images, and Objects” chapter for more information 

2. Choose 3DStairs from the Toolbox dialog box. 

3. Set the baluster options as necessary. 

4. Toggle Symbol on to draw the balusters as symbols. 

5. Create your run of stairs. 

6. Replace the existing balusters with the symbol you created in step 1 using 
the Replace option in the Template menu. See “Replacing Symbols in 
Your Drawing” in the “Symbols, Images, and Objects” chapter for more 
information. 
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 Balusters on Stringer Balusters on Side Balusters on Tread  
Figure 30.19: Baluster placement 

VertOfst shows the current vertical offset of the baluster. Vertical is the distance 
that the bottom end of the balusters extends below the treads. Vertical offset 
appears only when you select OnSide.  
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Figure 30.20: Baluster vertical offset 

HorzOfst shows the current horizontal offset of the baluster. When you model 
balusters on the treads, measure the offset from the side edge of the tread to the 
middle of the baluster. HorzOfst only appears when you select OnTread. 
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Figure 30.21: Baluster horizontal offset 

Use Color to set the color for the balusters. All balusters in a flight of stairs are 
modeled using the same color. See “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color. 

Newel Posts 

Use NewelPst to model newel posts on the stairs. Toggle DoNlPst on to model 
newel posts on a flight of stairs. When DoNlPst is toggled off, 3DStairs models 
balusters in place of newel posts.  
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 On Off  
Figure 30.22: Newel posts on/off 

Use Cylinder/Rectangl to choose between modeling a cylindrical or rectangular 
newel post. When you select Cylinder, the Radius and Division options are 
displayed. When you select Rectangl, the Width and Depth options are 
displayed. 

The Radius/Width toggle displays the current radius or width of the newel post, 
depending on whether you selected cylindrical or rectangular newel posts, in the 
Message Window. When you model a cylindrical newel post, you can adjust the 
radius of the cylinder. When you model a rectangular newel post, you can adjust 
the width of the rectangle. Measure width from one edge, near a baluster, to the 
other edge, facing out, of the same newel post 

The Depth/Division toggle displays the current depth or number of divisions in 
the newel post, depending on which of the previous options you selected, in the 
Message Window. When you model a cylindrical newel post, you can adjust the 
division of the cylinder, or the number of sides in the cylinder. When you model 
a rectangular newel post, you can adjust the depth of the rectangle. Measure 
depth from the edge of the newel post near the handrail to the open edge. You 
can use up to 36 divisions, but the more divisions you have, the longer it takes 
DataCAD to redraw. 

Depth Width 
Figure 30.23: Newel post width and depth 

Use Symbol to model newel posts as symbols. When newel posts are symbols, 
you can replace the newel posts produced by 3DStairs with custom newel post 
symbols that you create. 

 To use custom newel posts in stairs: 

1. Create your detailed newel post in the DataCAD drawing window and 
save it as a symbol. See “Creating and Editing Symbols” in the “Symbols, 
Images, and Objects” chapter for more information. 

2. Choose 3DStairs from the Toolbox dialog box. 

3. Set the newel post options as necessary. 
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4. Toggle Symbol on to draw the newel posts as symbols. 

5. Create your run of stairs. 

6. Replace the existing newel posts with the symbol you created in step 1 
using the Replace option in the Template menu. See “Replacing Symbols 
in Your Drawing” in the “Symbols, Images, and Objects” chapter for more 
information. 

Use Color to set the color for the newel posts. All newel posts in a flight of stairs 
are modeled using the same color. See “Color Menus” in “The Drawing Board” 
chapter for more information about how to choose a color. 

Stair Form 

 To display values and settings for all stair types: 

1. Choose StrForm from the 3DStairs menu. 

2. Press (Tab) to move forward or (Shift) + (Tab) to move backward through 
each line of the stair form.  

3. Scroll through the two-page form by selecting ScrlFwrd or ScrlBack from 
the menu.  

4. Press (Esc) to save settings and exit the StrForm menu, or choose Exit to 
leave the StrForm menu without saving any changes. For settings with 
options, you can scroll through them using (Spacebar). 

Saving and Using Stair Settings 
Use the StrFile option in the 3DStairs menu to save stair settings for future use, as 
well as load, save, delete, and rename stair setting files: 

LoadStr Loads a stair settings file; choose LoadStr from the StrFile menu and type the name of 
the file to load 

SaveStr Saves your current stair settings to a file; choose SaveStr from the StrFile menu and 
type the name of the file to save 

DelStr Deletes a stair settings file; choose DelStr from the StrFile menu and type the name of 
the file to delete 

Rename Renames an existing stair file; choose Rename from the StrFile menu, choose the file 
to rename, and type a new name 

StrForm Shortcut to the Stair Form menu. See “Stair Form” earlier in this chapter for more 
information on using this menu. 

 

 



Appendix 
This appendix contains additional information for advanced 
users as well as tables defining such things as DataCAD’s 
standard linetypes, hatch patterns, and keyboard shortcuts. 

In this chapter: 

 DWG/DXF translation 
tables 

 Creating custom 
toolbars 

 Creating linetypes 

 Standard hatch patterns 

 Creating keyboard 
shortcuts 

 Standard keyboard 
shortcuts 

 Standard fonts 

 Extended characters 
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DWG/DXF Translation Tables 
Importing data from a DWG or DXF file to a DataCAD (.DC5) file is not always a 
one-to-one translation. There are a few instances where data is handled 
differently in DataCAD. For instance, entities in AutoCAD with a color-by-block 
attribute will be read into DataCAD as white. 

Dimension arrowheads must also be changed in order to display in DataCAD. 
AutoCAD arrowheads, which are blocks (symbols), will be replaced globally with 
the arrowhead style set with the ArroStyl option of the Dmension menus. When 
exported back to a DWG/DXF file, all arrowheads will be set to the AutoCAD 
default. Dimension text and extension lines will remain the same color, but 
dimension lines will be changed to the same color as the extension lines.  

Text, in some cases, is also treated differently in DataCAD. A single instance of 
vertical text in a DWG/DXF file will be translated to horizontal text. MText 
(AutoCAD’s multi-line text) is broken into single lines; it is no longer a single 
entity. 

Third-party fonts may need to be scaled to display correctly. To adjust the scale 
and aspect of a font, open the CHR2SHX.DAT in the \CHR subdirectory of your 
DataCAD directory, locate the font in the list, and modify the values as necessary. 
Fonts can also be added to the list; remember to update the total number of fonts 
in the file (value located on first line of file). Be sure to make necessary 
adjustments before you import or export a file, so that the changes will appear in 
that file. 

The Importing and Exporting sections that follow provide translation tables 
showing how entities are treated in “round-trip” scenarios, where a file would 
begin and end in AutoCAD or DataCAD. 

Importing 
AUTOCAD 
 

DATACAD AUTOCAD

2D Polyline 
(parallel to X,Y plane) 
 

Polyline 2D Polyline (rel.13 or 14) 
Polyline (rel.12) 

2D Polyline  
(not parallel to X,Y plane) 
 

Polyline Symbol‡ 2D Polyline (rel.13 or 14) 
Polyline (rel.12) 

2D Polyline 
(with width assigned to any 
vertices) 
 

Polyline† 2D Polyline (rel.13 or 14) 
Polyline (rel.12) 

3DFace 
 

Polygon 3DFace 
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AUTOCAD 
 

DATACAD AUTOCAD

3D Polyline  
(with varying Z values) 
 

3D Line Line 

3D Polyline  
(planar--no varying Z values) 

Polyline  
(parallel to X,Y plane) 
Polyline Symbol‡ 
 

2D Polyline 

Arc  
(parallel to X,Y plane) 
 

Arc Arc 

Arc  
(not parallel to X,Y plane; 
thickness= 0) 
 

3D Arc Arc 

Arc  
(not parallel to X,Y plane;  
thickness ≠ 0) 
 

Cylinder† Arc 

Attribute Definition Text† (constant data is 
saved as attributes; variable 
data is lost) 
 

Attribute Definition 

Block  Symbol Block 
 

Circle  
(parallel to X,Y plane) 
 

Circle Circle 

Circle  
(not parallel to X,Y plane;  
thickness = 0) 
 

3D Arc† Circle 

Circle  
(not parallel to X,Y plane;  
thickness ≠ 0) 
 

Cylinder† Circle 

Dimensions 
 

Associative Dimensions 
 

Dimensions 

Dimensions  
(angular, radius, or diameter  
dimensions and leaders) 
 

Lines and text Lines and text 

Donut  
(parallel to X,Y plane) 
 

Polyline† Donut 

Donut  
(not parallel to X,Y plane) 
 

Polyline Symbol†‡ Donut 

Ellipse  
(parallel to X,Y plane) 
 

Ellipse Ellipse (rel.13 or 14) 
Lines (rel.12) 

Ellipse  
(not parallel to X,Y plane) 
 

Ellipse Symbol‡ Ellipse (rel.13 or 14) 
Lines (rel.12) 
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AUTOCAD 
 

DATACAD AUTOCAD

Hatch 
 

Associative Hatch (if hatch 
boundary is LW polyline) 
Associative Hatch Symbol‡ 
(if hatch boundary is LW 
polyline but not parallel to 
X,Y plane) 
Lines (if hatch boundary 
includes any other boundary 
type besides LW polyline) 
 

Lines 

Leaders Lines and Text Lines and Text 
 

Light-Weight Polyline (See 2D Polyline above) 
 

 

Line  
(parallel to X,Y plane) 
 

Line Line 

Line  
(not parallel to X,Y plane;  
thickness = 0) 
 

3D Line Line 

Line  
(not parallel to X,Y plane;  
thickness ≠ 0) 

Polygon† Line (if coordinates unchanged) 
Line, with changed thickness (if 
polygon stretched along the axis of 
thickness) 
Polygon (if coordinates changed in 
directions other than axis of 
thickness) 
 

MText 
 

Text Text 

Mesh Polygons Polygons 
 

Point  
(with no thickness) 
 

Point₤ Point 

Point  
(with thickness) 
 

3D Line†₤ Point 

Polyface Mesh Polygons Polygons 
 

Spline 
 

Point† Spline (rel.13 or 14) 

Solid 
 

Polygons, triangulated 3D Faces 

Text, single line or multi-line 
 

Text Text 

 

† AutoCAD entity is imported into DataCAD as an entity with attributes. If the entity is edited in DataCAD, upon export 
it will return to its original (AutoCAD) entity type, incorporating the changes you made in DataCAD. Exceptions to 
this are exploding an entity, which permanently changes the entity type, or deleting an entity. 

‡ AutoCAD entity is imported into DataCAD as a symbol. These symbols are like any other in DataCAD; they cannot be 
edited unless they are first exploded. If you explode an entity in 3D space, however, it will flatten to the X,Y plane. For 
instance, a Donut in a DWG file that is not parallel to the X,Y plane will be imported into DataCAD as a Polyline 
Symbol. If this symbol is not exploded, it will maintain its position when exported back to a DWG file. If the symbol is 
exploded, however, it will flatten to the X,Y plane, even when exported back to a DWG file. 

₤ Point shape is lost in translation. 

 A block comprised of entities on different layers will be imported into DataCAD as a symbol on the layer where the 
block was inserted; that is, all entities for that Block will be moved to the insertion layer. These entities will remain on 
this layer when exported back to a DXF or DWG file. Also, anonymous (unnamed) blocks in AutoCAD will be given a 
unique, numeric name when imported into DataCAD; this name will be saved with the block when exported. 

There are a few AutoCAD entities that cannot be read, displayed, or otherwise 
saved during translation. These include: XREFs, viewports, ACIS data (Body), 
Rays (XLines), Ole Frames, Ole2 Frames, Tolerances, Images, Regions, Proxies, 
and named views. 
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Exporting 
DATACAD AUTOCAD DATACAD

3D Arc 
 

Arc 3D Arc 

3D Line Line 3D Line (if not parallel to 
X,Y plane) 
Line (if parallel to X,Y 
plane) 
 

Arc 
 

Arc Arc 

B-spline 
 

Polyline Polyline 

Bezier 
 

Polyline Polyline 

Circle 
 

Circle Circle 

Cone Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 

Contour 
 

Polyline Polyline 

Cylinder Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 

Dimensions (Associative) Dimensions Dimensions (Associative) 
 

Ellipse 
 

Ellipse (rel.13 or 14) 
Lines (rel.12) 
 

Ellipse 

Hatch (Associative) Lines Lines 
 

Line 
 

Line Line 

Mesh Surface Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 

Point 
 

Point Point 

Polygon  
(with 3-4 vertices and no 
voids) 
 

3D Face Polygon 

Polygon  
(with 5 or more vertices 
and/or voids) 
 

Triangulated into multiple 3D Faces Multiple 3-sided polygons 

Polyline Lightweight Polyline (rel.14) 
Polyline (<rel.14) 
 

Polyline 

Sphere Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 

Surface of Revolution Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 

Symbol Block Symbol 
 

Text Text Text 
 

Torus Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 

Truncated Cone Polyface Mesh 
3D Faces (if Decompose in Options 
dialog is on during export) 
 

Polygons 
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Creating Custom Toolbars 
Key (.KEY) files are the files that DataCAD uses to display and activate toolbars. 
You can create your own custom toolbar by creating a key file describing the 
bitmap files to use for the toolbar icons and the action DataCAD should take 
when each icon is selected. 

The key file is a text file arranged in column groups, each group performing a 
different function. Once you are familiar with these group functions, you can 
easily edit the file. Each line of the key file is 185 columns long. 

L|  |Move    |move___m|1         |Move drawing objects | 
L|  |Copy    |copy___m|2         |Copy drawing objects | 
M|  |RoofIt  |roofit_m|RoofIt    |3D Roof Creation Tool| 
C|  |3dkey   |dcad3d_m|m_dcad3d  |3D Icon Toolbar      | 

 

A description of each column group and its function follows: 

Column(s) Name Function 

1 Action Code Contains an action code that identifies the 
function or program to access 
 

3-4  Not currently used 

6-13 Menu Level String Contains an eight character description for the 
Message Window 
 

15-22 Bitmap (.BMP) filename Contains the bitmap (.BMP) filename 

24-103 Action Contains the action to perform, the menu or 
macro to access, or the sequence to perform 
 

105-184 Message Contains the message, or description of the 
function, that appears in the Message Window; 
acts as a sort of “tool tip” 

 

Column numbers not listed represent pipe characters that separate the columns. 
You cannot adjust the position of the column separators or type in these columns. 

Action Codes 
The action codes, represented by L, P, M, and C in column one of the key file 
example above, identify the function or program to access. 

Action Action 
Code 
! Places comments or leave a note for yourself within the key file 
A Executes a macro key sequence 
C Loads a new key file for a new toolbar 
K Executes a DataCAD shortcut key 
L Accesses an internal DataCAD function, such as Move 
M Executes a DCAL macro  or tool 
T Binds a template file to an icon 
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Menu Level String 
The menu level strings, in columns 6-13, are eight-character descriptions of what 
each icon does or what it accesses. Any characters are valid and you can enter 
whatever you want. This description appears in the Message Window before the 
message. For example, the Move menu icon contains a menu level string that 
displays Move and a message line that displays Move drawing objects in the 
Message Window. 

Bitmap Filenames 
The bitmap (.BMP) filename column group, in columns 15-22, contains the name 
of the bitmap file, or icon, to associate with the specified DataCAD function. A 
list of currently used bitmaps in the DCADWIN.KEY and DCADWIN3.KEY files 
follows. Each bitmap filename matches a DataCAD function name.  

Action 
Each letter in the Action Code column represents an associated action in the 
Action column group, columns 24-103. For example, if the Action Code column 
reads L, the Action column group must contain the menu level string 
corresponding to the menu it accesses. The following are Action Codes, including 
necessary Action column group information: 

Action Code Information Required in the Action Column Group 
 
A A key sequence, such as ^:^S6^F1^F1^F5, calls function keys, or keystrokes, in this 

order. This function allows you to create your own shortcuts to bind to icons. These 
sequences typically match a sequence from the DCAD.MCR file which contains 
only 26 user-definable sequences. See “DataCAD Keyboard Shortcuts” in this 
Appendix for information on creating keyboard shortcuts. 

C An eight-character key filename. 
K The key character that is used in keyboard shortcuts. This action binds a pre-

existing sequence to an icon. For example, the shortcut for the Architect menu is (A). 
Type a in the Action column, not A; these characters are case sensitive. You cannot 
use the (Alt), (Tab¿), or arrow keys in the key character column. 

L The internal menu function number listed in the following table. 
M The name of the tool to access: for example, RoofIt. 
T The path and the filename of the template file to bind to the icon. A comma is 

required between the path and filename with the file extension, as in the following 
example:  tpl\plumb,residenc.tpl. 

DataCAD Internal Menu Function Numbers  
1 - 2dmove 
2 - 2dcopy 
3 - 2drotate 
4 - 2dmirror 
5 - 2dstretch 
6 - 2denlarge 
7 - identify 
8 - 2dchange 
9 - 2derase 
10 - cleanup 
11 - archtect 
12 - 2dpolygons 
13 - curves 
14 - text 
15 - linetype 
16 - hatch 

31 - freehand  
32 - linkents 
33 - fileio 
34 - directory 
35 - 2pt_arc 
36 - 3pt_arc 
37 - centangarc 
38 - centarc 
39 - centchrd 
40 - arctan  
41 - ellipse 
42 - rad_circ 
43 - dia_circ 
44 - 3pt_circ 
45 - 2dmovedrag 
46 - 2drectarray 

61 - selection sets 
62 - 3dviewer  
63 - elevation 
64 - view controls 
65 - editplane 
66 - plnesnap 
67 - setper 
68 - walkthru 
69 - setobliq 
70 - 3dgotoview 
71 - saveimge 
72 - clipcube 
73 - hide 
74 - 3dline 
75 - 3dsettings 
76 - blocks 

90 - rectangular 
polygon  
91 - rectangular slab 
92 - vertical polygon 
93 - vertical slab 
94 - inclined polygon 
95 - inclined slab 
96 - voids 
97 - partial 
98 - 3dmove 
99 - 3dcopy 
100 - 3drotate 
101 - 3denlarge 
102 - 3derase 
103 - 3dstretch 
104 - 3dchange 
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17 - 3dedit 
18 - windowin 
19 - to_scale 
20 - geometry 
21 - 2dgotoview 
22 - grids 
23 - layers 
24 - template 
25 - 2dsettings 
26 - measure 
27 - plotter 
28 - dmension 
29 - display 
30 - objectsnap 
 

47 - 2dcircarray 
48 - fillets 
49 - chamfer 
50 - 1lntrim 
51 - 2lntrim 
52 - weldline 
53 - tintsct 
54 - lintsct 
55 - archdoor 
56 - archwind 
57 - cutwall 
58 - divide 
59 - intersect 
60 - tangents 
 

77 - vertcyln 
78 - horicyln 
79 – cone 
80 - truccone 
81 - sphere 
82 - torus 
83 - meshsurf 
84 - revsurf 
85 - marker 
86 - 3dpolygon 
87 - slab 
88 - horizontal 
polygon 
89 - horizontal slab 
 

105 - 3dexplode 
106 - 3dedit 
107 - 3dentity 
108 - quick shader 
109 - linear dimension 
110 - layer on/off 
111 - layer name 
112 - layer delete 
113 - dxf read 
114 - dxf write 
115 - pixelout 
116 - toolbox 
117 - rstar2 

Message 
Use the Message area column group, columns 105-184, for information about, or 
a definition of, the icon function. When you move the cursor over an icon, the 
Message Window displays this message 

Creating a New Key File 

1. Copy an existing key file from the \DATACAD\SUP\MENUPOF\ 
directory to a new filename. Store this file in the same directory as the 
other key files. 

2. Edit this new file using existing icons and/or icons that you created. You 
can associate any bitmap (.BMP) file with any command or function, 
including functions that are already used in other key files. 

Follow the steps in the "Editing a Key File" portion of "Editing Toolbars" later in 
this section. Remember you can change the bitmap (.BMP) filename in the 
bitmap (.BMP) filename column when creating a new key file. Changing the 
bitmap (.BMP) filename allows a different icon to appear in the toolbar. All 
bitmaps must be 24   x 24 pixels; 16-color bitmaps are recommended. 

Incorrectly editing key files can cause system lockups. Make sure that column 
separators, or pipe characters, remain in their original positions. 

Creating New Icons 

1. Create a 16-color, square bitmap in bitmap (.BMP) format. 

2. Save it with a filename of up to eight characters in the 
\DATACAD\SUP\MENUPOF\ directory. 

Editing Toolbars 
You can change any toolbar by editing its key file. You can also change the menu 
associated with any icon. Make a backup copy of the key file before you edit it. 
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Editing a Key File 

Use the arrow keys to move within the key file. You cannot use (Tab) or place tabs 
anywhere in the key file. Incorrectly editing key files can cause system lockups. 
Please follow these steps carefully and make sure that column separators, or pipe 
characters, remain in their original positions. 

1. Exit DataCAD and open a DOS text editor, such as Notepad. (This will 
ensure that all characters are displayed properly.) 

2. Access the key file directory, \DATACAD\SUP\MENUPOF\, and open 
the key file you'd like to edit, S_DCAD2D.KEY, for example. 

3. Move the cursor to the line where you want to change the menu/icon 
association.  

4. Change any column group: 

Action Code Access a different program; for example, to access a tool instead of 
an internal DataCAD function, change an L to M. 

Menu Level String Type the eight-character description that you want to appear in the 
Message Window, a menu name for example.  

.BMP filename Leave the bitmap (.BMP) filename, which represents the icon, as it is. 
You are choosing a different menu to associate with the icon. 

Action Fill in the information requirements of the Action Code: the new 
internal function number (listed in the DataCAD Internal Menu 
Function Numbers table), path and program name, macro name, key 
sequence, key filename, or key character. 

Message Type the description of the function now associated with the icon. 
5. Save the key file and exit the text editor. 

All bitmaps must be 24 x 24 pixels. 16-color bitmaps are recommended. 

Creating Linetypes 
DataCAD allows you to use four standard linetypes and up to 175 user-defined 
linetypes. The definitions for linetypes provided with DataCAD are located at 
the end of this section. These definitions are in the DCADWIN.LIN file in 
directory \DATACAD\SUP\. Define new linetypes using any text editor. The 
lines consist of small segments linked together to form longer lines. Each 
segment is 100 "units" in length, and may be divided into as many as 20 
definition components. One hundred units equals the line spacing length.  

The first line of each definition must contain either an asterisk (*) or a greater 
than symbol (>), followed by a space and the title of the linetype. When an 
asterisk is used, DataCAD draws a short line, called a tail, to fill any remaining 
space not filled by the pattern. When a greater than symbol is used, DataCAD 
repeats the pattern as many times as possible to fill the specified space and then 
stretches the pattern slightly to fill any remaining space. The title must not 
exceed eight characters in length.  

The second line specifies the factor by which one segment of the linetype must be 
multiplied to draw at the correct size. As 100 units equal the line spacing length 
to draw one segment or 100 units at a size of 8", a factor of 8/12 or .6667 is 
entered. Successive lines of the definition contain the origin, direction, and 
distance of each component in the line segment. Use one line for each 
component, with no more than 20 lines total, including the spacing value. 
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Each component is assigned a length based on the 100-unit dimension. Each 
component definition consists of two numbers. The first number specifies the 
line direction.  

0  Right  
90  Up  
180  Left  
270  Down  
The second number specifies the line length. A line length of 50 equals one half 
the distance of the total line segment. A minus sign (-) before the first number 
moves the pen clockwise. Pen down commands (visible lines) have a space 
between the two numbers. Pen up commands (invisible lines) use a space and a 
minus sign between the two numbers.  

Definitions for linetypes provided in DataCAD are as follows: 

>TelLine  >ElecLine  >Box 
4.0   4.0   4.0  
0  41  0  40  0 65.858 
0  -6  0  -7  0 -10 
71.56  -3.953  -71.56  -3.953  45  10 
0  3.5     90  7.5  -45  10 
-180  -1.675  0  3.5  225 10 
-90  7.5   -90  -3.75  135 10 
0  -1.675  -180  3.5  0 -24.142 
71.56  -3.953  -90  -3.75    
0  -6  0  3.5    
0  41  71.56  -3.953  >PropLine 
   0  -7  8.0  
   0  40  0 75 
>Plywood1     0 -5 
0.0625   >Section  0 5 
0 100  4.0   0 -5 
270 -1  0  88   0 5 
180 100  60  6    
270 -32.3333  300  12    
0 100  60  6    >Insul 
270 -33.3334     0.1667  
180 100  >ShingleR  -118.0362 47.3592 
270 -32.3333  1.0   -88.75 21.5060 
0 100  5  100  -63.25 21.5060 
270 -1  275  4   -37.75 21.5060 
180 100  95  -4  -12.25 20.5060 
90 -1  185  -100   12.25 20.5060 
45 45.7262  0  50  37.75 21.5060 
135 47.1405  5  100  63.25 21.5060 
45 45.7262  275  4  88.75 21.5060 
270 -1  95  -4  118.0362 94.7184 
   185  -100  88.75 21.5060 
   0  50   63.25 21.5060 
>Plywood2     37.75 21.5060 
0.0625      12.25 20.5060 
0 100  >Hedge  -12.25 20.5060 
270 -1  1.0   -37.75 21.5060 
180 100  63.26  22.4  -63.25 21.5060 
270 -32.3333  0  10  -88.75 21.5060 
0 100  289.59  39  -118.0362 47.3592 
270 -33.3334  21.48 18    
180 100  101.19  17    
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270 -1  14.02  13.7  >LapSidR 
0 100  277.08  26.9  0.5  
90 -1  0  10  98  12.5 
135 45.7262  68.12 18  8  110 
45 45.7262  51.20  21.3   278  12.5 
90 -1  291.48  18    188  110 
        
>CentrLin  >Shiplap  >GroundLn 
8.0   0.5   4.0  
0 85  90  5  0 35 
0 -5  0  16  80 4 
0 5  90  7.5  -80 4 
0 -5  0  96   0 5 
   270  5   80 2 
   180 16  -80 2 
>Brick  270  7.5  0 45 
0.6667   180  96  80 3 
0  -2.605     -80 3 
270  45.3125     80 6 
0  28.125  >RigidIns  -80 6 
90  45.3125  0.1667   0 13.924 
180  28.125  270  100    
0  -33.333  0  100     
270  45.3125  -270  -25  >ShingleL 
0  28.125  180  100  1.0  
90  45.3125  -270  -25  355 100 
180  28.125  0  100  85 4 
0  -33.333  -270  -25  265 -4 
270  45.3125  180  100  175 -100 
0  28.125  -270  -25  0 50 
90  45.3125  0  100  355 100 
180  28.125  180  -75  85 4 
0  -2.604  270  100  265 -4 
   0  -25  175 -100 
   -270  100  1 50 
>Grass  0  -25    
0.5   270  100    
0  9  0  -25  >LapSidL 
100  50  -270 100  0.5  
280  -50     262 12.5 
0  17     352 110 
90  30  >4 Block  82 12.5 
270 -30  0.6667   172 110 
0 -1  0  -2.3437    
85  40  270  45.3125    
265  -40  0  95.3125  >12 Block 
0  16  90  45.3125  0.6667  
100  20  180  95.3125  0  -2.3438 
280  -20  0  -2.3437  270  145.3125 
0  17     0  95.3125 
75  30  >8 Block  90  145.3125 
255  -30  0.6667   180  95.3125 
0  16  0  -2.3438  0  -2.3438 
100 20  270  95.3125     
280  -20  0  95.3125    
0  8  90  95.3125    
   180  95.3125    
   0  -2.3437    
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Standard Linetypes 
 

Name

N/A CenterSolid

S
ta

nd
ar

d
U

se
r-

de
fin

ab
le

lin
es

,5
0

m
ax

im
um

1 = 1'-0" on center dots CenterDotted

1 = 1'-0" on center dashes CenterDashed

1 = 1'-0" on center dot to dotDot-Dash Center

1 = 1'-0" on center E to EElecLine Center

1 = 1'-0" on center T to TTelLine Center

1 = 1'-0" on center box to boxBox Center

1 = 1'-0" on center double dashesPropLine Center

0.3 = 6" width insulationInsul Center

0.0.3/4 = 3/4" width plywoodPlywood1 Left edge at line angle of 90°

0.0.1/2 = 1/2" wide plywoodPlywood2 Left edge at line angle of 90°

1 = 4" wide line patternHedge Center

1 = 1'-0" dash to dashCentrLin Center

1 = 1'-0" on center breaksSection Center

0.8 = 4" to the weather
(for line length divisable by set spacing)

ShingleR Left edge at line angle of 270°

0.4 = 4" to the weather
(for line length divisable by set spacing)

0.8 = 4" to the weather
(for line length divisable by set spacing)

0.4 = 4" to the weather
(for line length divisable by set spacing)

LapSidR Left edge at line angle of 270°

0.4 = 4" to the weather
(for line length divisable by set spacing)

ShipLap Left edge at line angle of 270°

0.8 = 4" nominal brick widthBrick Left edge at line angle of 90°

0.8 = 4" nominal brick width4Block Left edge at line angle of 90°

0.8 = 8" nominal block width8Block Left edge at line angle of 90°

0.8 = 12" nominal block width12Block Left edge at line angle of 90°

0.2 = 2" thicknessRigidIns Left edge at line angle of 90°

0.5 = 3" high grassGrass Lower edge at line angle of 90°

1 = 6" between pattern breaksGroundLn Lower edge at line angle of 90°

ShingleL Right edge at line angle of 270°

LapSidL Right edge at line angle of 270°

Pattern Line spacing values Defined by:
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Standard Hatch Patterns 
Hatch patterns included with DataCAD are pictured below. 

Angle 31 32

Box Brass Brick

33 34 35

36 37 38
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Creating Keyboard Shortcuts 
You can use keyboard shortcuts for quick navigation or to perform functions. 
Shortcuts have also been called keyboard macros, keyboard interrupts, 
accelerator keys, hot keys and immediate mode commands. To set up your own 
shortcuts, see "Defining Shortcuts" below. 
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In this manual, all keyboard shortcuts are described exactly how they should be 
executed. If a shortcut requires a lowercase letter, you will be instructed to press 
only that letter. If a shortcut requires an uppercase letter, you will be instructed to 
press (Shift) and that letter. (If Caps Lock is on, you can just press the letter.) In 
some cases, both the uppercase and lowercase letter perform the same function. 

In the following table, the Mnemonic column provides an easy way to remember 
some of the shortcuts. Some shortcuts, like Copy, are noted as being "2D/3D". In 
this case, when you use the shortcut from a 2D menu, you'll open the 2D Copy 
menu. Similarly, using the shortcut while in a 3D menu takes you to the 3D Copy 
menu. 

Defining Shortcuts 
To define your own shortcuts, edit the file DCADWIN.MCR in the 
\DATACAD\SUP\ folder using a text editor. You can only define shortcuts that 
use a letter in combination with (Alt). You cannot define shortcuts that are 
accessed by a single letter or those that use a letter in combination with (Shift). 

You may have some older keyboard shortcuts that include (Alt) + 183 near the 
beginning of the line and end with (Alt) + 184. This was used to turn off menu 
display to increase the speed of shortcut execution in DataCAD for DOS. It is no 
longer needed in DataCAD for Windows, although these shortcuts will still 
function normally in DataCAD for Windows. 

Define each shortcut key on a separate line. The following line defines a shortcut 
to Enlarge: 

 E;^f6 

• The first character E, indicates the key that will start the shortcut. Pressing the 
character E will call the shortcut. This will also supercede the command that 
E currently does.  

• The semicolon indicates that the command is in the Edit menu; a colon would 
indicate the Utility menu.  

• The caret (^) separates each step through the menu structure.  

• F6 indicates the function key that loads the Enlarge option on the Edit menu.  

• If the function were on a menu under Enlarge, you would follow the F6 with 
an additional caret, followed by the appropriate function key on the next 
menu. 

See “Using the Command Line Alias” in “The Drawing Board” chapter for more 
information on keyboard shortcuts. 
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Standard Keyboard Shortcuts 
FUNCTION/MENU MNEMONIC KEY(S) 

2LnTrim menu Join (Alt)+(J) 

3D Edit menu  (J) 

3D Entity menu  (J) or (Alt)+(U) 

3D Views menu Views (Y) or (Shift)+(V) or (Alt)+(V) 

Active layer, scroll backward to set  (Shift)+(Tab) 

Active layer, scroll forward to set  (Tab) 

Append selection set toggle Append (Shift)+(A) 

Architect menu architect (A) 

Cap wall ends toggle  (|) 

Center screen to cursor location  (Home) 

Change menu Change (Alt)+(C) 

Colors, scroll backward Kolors (Shift)+(K)  

Colors, scroll forward kolors (K) 

Coordinate entry  (SpaceBar) 

Copy to clipboard Copy (Ctrl) + (C) 

Copy menu (2D/3D) Copy (C) or (Shift)+(C) 

Cursor size toggle (big vs. regular)  (+) 

Curves menu Arcs (Alt)+(A) 

Cut to clipboard  (Ctrl) + (X) 

Digitizer digitIzer (I) 

Dimension menu Dimension (D) or (Shift)+(D) 

Dimension, Linear menu Dimension (Alt)+(D) 

Directory menu directorY (Alt)+(Y) 

Display list, regenerate  (U) or (Shift)+(U) 

Display associated saved view   (Shift)+(1) to (0) 

Edit menu  (;) or (Ctrl)+(C) 

EditSets menu Selection sets (Shift)+(S) 

Elevation, back  (Ctrl)+(PgUp) 

Elevation, front  (Alt)+(=) 

Elevation, left  (F11) 

Elevation, right  (F12) 

Enlarge menu Enlarge (Alt)+(E) 

Erase last entity  (,) 

Erase last group   (<) 

Erase menu (2D/3D) Erase (E) or (Shift)+(E) 

Exit  (Ctrl)+(F4) 

Fillets menu Fillets (Alt)+(F) 
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FreeHand menu freeHand (Alt)+(H) 

Geometry menu Geometry (Alt)+(G) 

GoToView menu View (V) 

Grids menu  Grids (G) or (Shift)+(G) 

Hatch menu Hatch (H) or (Shift)+(H) 

Help  (Ctrl) + (F1) 

Hide menu   (Shift)+(Y) 

Icon toolbar toggle  (Ctrl)+(F11) 

Identify Identify (Shift)+(I) or (Alt)+(I) 

Input mode:   (Insert) 

1 : Relative Polar (distance, angle) 

2 : Absolute Polar (distance, angle)  

3 : Relative Cartesian (x, y coordinates) 

4 : Absolute Cartesian (x, y coordinates)   

Layer search toggle  (') 

Layers menu Layers (L) or (Shift)+(L) 

Line overshoot amount   (_) 

Line overshoot toggle   (-) 

Line spacing, set  (F) 

Linetype menu Linetype (Alt)+(L) 

Linetypes, scroll backward  (Shift)+(Q)  

Linetypes, scroll forward  (Q) 

Line weight, decrement BIG Weight to small (Shift)+(W) 

Line weight, increment little Weight to big (W) 

Link Entities menu linK (Alt)+(K) 

Measures menu  (Alt)+(X) 

Mirror menu (2D) Mirror (Alt)+(M) 

Move menu (2D/3D) Move (M) 

Multi-view windows multi-view Windows (Ctrl) + (W) 

New drawing, create New  (Ctrl)+(N) or (Alt)+(N) 

Object snap sNap (N) or (Shift)+(N) 

Object Snap menu   (Shift)+(X) 

Object Snap perpendicular toggle Object snap (Alt)+(O) 

Online Help  (Ctrl)+(F1) 

Open Files Open (Ctrl) + (O) 

Ortho mode toggle  Orthogonal (O) or (Shift)+(O) 

Orthographic View orthographic (Alt)+(0) 

Pan  (¡) (¢) (£) (¥) 

Parallel View, most recent  (Alt)+(9) 

Paste from clipboard  (Ctrl) + (V) 
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Perspective View, most recent  (Alt)+(-) 

Plotter menu Plotter (Alt)+(P) 

Polygons menu Rectangle (Alt)+(R) 

Previous view, restore Previous (P) or (Shift)+(P) 

Print Print (Ctrl)+(P) 

Quit Quit (Alt)+(Q) 

Redo  (Ctrl) + (Y) 

Reference point entry  (`) 

Restore last erased entity  (.) 

Restore last erased group  (>) 

Rotate menu (2D/3D) Rotate (R) or (Shift)+(R) 

Save current drawing Save File (Ctrl)+(S) or (Shift)+(F) 

Screen refresh  (Esc) 

Screen refresh by layer, stop  (End) 

Screen refresh, stop  (Del) 

Select sElect (Ctrl) + (E) 

Selection set, change active  (Alt)+(1) to (8) 

Snap grid spacing, set spacing (S) 

Snap grid toggle  (X) 

Snapping point entry  (~)  

Stretch menu Stretch (Alt)+(S) 

Symbol, insert by name  (") 

Tangents menu  (B) or (Shift)+(B) 

Template menu Template (T) or (Shift)+(T) or (Alt)+(B) 

Text menu Text (Alt)+(T) 

Toolbox menu Macros (Shift)+(M) 

ToScale menu  Zoom (Alt)+(Z) 

Undo  (Ctrl) + (Z) 

Utility menu  (:) 

Wall T intersection clean-up toggle   (\) 

Walls toggle and set new wall thickness  (=)  

Weld Line menu Weld (Alt)+(W) 

Window In   (/) 

World coordinate identify  (?) 

Z-base or Z-height attribute entry Z-base/Z-height (Z) or (Shift)+(Z) 

Zoom Extents  (Ctrl)+(-) 

Zoom In  (PgDn) 

Zoom Out  (PgUp) 
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Standard Fonts 
DataCAD includes the following fonts; the first column lists the font name, while 
the second column provides examples of upper- and lowercase characters. 

  

Extended characters 
Five DataCAD fonts feature extended characters. This allows you to include 
common drafting symbols, fractions, and exponents in your text: 

ARCDR2GP ArcDraft General Purpose 
ARCWY2GP ArcWyde General Purpose 
ARCWY2HC ArcWyde Heavy Chisel 
ARCWY2LC ArcWyde Light Chisel 
HLV_TPX Helvetica Thin Proportional with extended characters 
The following chart shows the drafting symbols, exponents and fractions you can 
include in your text.  
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 To create drafting symbols and exponents: 

1. Toggle NumLock on. The indicator light on your keyboard will be green 
if NumLock is on. If NumLock is not toggled on, you will not be able to 
create the drafting symbols and exponents. 

2. Press (Alt) and hold it down while you type the corresponding four-digit 
number using the numeric keypad. The four-digit number always begins 
with zero. Do not use the number keys above the letters on your 
keyboard. 

If you'd like to change your font but you've used extended characters in your 
text, make sure the new font also includes the extended characters. If you choose 
a font that does not include the extended characters, the content of your text may 
be changed. 

To create fractions, use the Exponent/Numerator column of the chart to enter the 
numerator of your fraction; use the Denominator column to draw the 
denominator and the division sign. For example, to draw a fraction of 5/16 in 
your text, hold down (Alt) and type 0135 using the numeric keypad. When you 
release (Alt), the 5 will appear. Depress (Alt) again and type 0153 on the numeric 
keypad. The fraction is completed when you release (Alt). 

 

P r o p e r t y L i n e 

S qu a r e F e e t 

D i a m e t e r 

D r a f t i n g S y m b o l Exponent /
Numerator

Denominator 

P l u s - o r - m i n u s 

A ng l e 

C e n t e r L i n e 

W it h 

D e g r e e 

01142

011441

011440 011330 011550 

011331 011551 

011332 011552 

011333 011553 

011334

011335

011336

011337

011338

011339

011446

011660

011443

011444

011445

 
 

 



Glossary 
  

3D face 

The surface of a solid specified with 3D points. 

3D mesh 

A polygon mesh composed of vertices connected by lines. 

3D polyline 

Polylines with segments oriented in 3D space. 

arc 

A continuous section of a curved line. 

area 

Any part of a drawing within a rectangular window that is temporarily 
drawn during the selection process. All entities and groups enclosed 
completely within this rectangular window are included in the area. All 
entities and groups partially enclosed or not enclosed within the rectangular 
window are not included in the area.  

attribute 

A single value or characteristic associated with an entity.  

bulge 

A curved portion of a polyline. 

center marks 

Small marks displayed to define the exact center of arcs and circles. You can 
also use center marks with object snapping. 

click 

To position the cursor over a selection and press and release a mouse button 
(usually the left button). This command usually refers to selecting or 
deselecting an option. 

choose 

To select a command or option from the Menu Window. 

command 

An instruction from the user to the computer to perform a function. A 
command is usually selected from the Menu Window or the Menu Bar. 
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cursor 

A graphic symbol displayed on the screen to show the location of the mouse. 

default 

Any setting or value that is preset by DataCAD. 

dimension line 

Also called the string line, the dimension line consists of a straight line 
parallel to the points to dimension. The dimension line also contains text 
showing distance information and termination marks, consisting of arrows or 
tick marks drawn at a 45° angle. 

division 

A graphical aid used in cylindrical balusters, newel posts, or hand rails to 
help you better visualize the cylinder. 

doughnut (donut) 

A circular object with hole in the center, composed of two concentric circles 
and a filled center. 

Drawing Window  

The area of the screen that is reserved for your drawing.  

elevation 

The height of an object. It defines the object's position in the direction of the 
Z-axis. 

Also, an orthographic view that shows the front, back, right, or left sides of 
an object. 

entity 

A straight or curved geometric element defined by two endpoints. A circle, 
ellipse, or arc is an entity, as is a B-spline or Bezier curve. A line of text is also 
considered an entity in editing operations. Edit entities alone or when linked 
as a group.  

extension line 

Extension lines typically run from the object you dimension to the line where 
the dimension appears. Extension lines are used only for linear and angular 
dimensioning. You can control the length of the extension line. DataCAD 
typically draws one extension line at each end of a dimension line, but you 
can suppress the line. 



GLOSSARY  |    579 

extents 

The outer-most edges of a drawing. To “display a drawing at its extents” 
means to adjust the view so that the drawing fills the Drawing Window as 
much as possible while still displaying it in its entirety; the outer-most edges 
of the drawing will fit just inside the frame of the Drawing Window. Clicking 
the E in the Navigation Pad does this automatically. 

fence 

Similar to an area but allowing more flexibility, a fence is any portion of a 
drawing within a closed polygon that you draw during the selection process. 
You can select using a concave or convex polygon having up to 36 sides. 

fit 

Specified fixed height of text that expands or contracts to the character width 
between designated points only. 

function keys 

Function keys, (F1) through (F12), are located on the keyboard and are used to 
enter commands. In DataCAD, they are associated with the commands that 
appear in the Menu Window. You can select these commands by pressing the 
associated function key on the keyboard.  

(S1) through (S0) provide access to ten additional commands, selected on the 
keyboard by holding down (Shift) while pressing the appropriate function key. 

grids 

Use display and snap grids to make cursor movement and positioning more 
accurate. The flexibility and control of grids are critical to computer-aided 
design. 

group 

A group is a set of entities linked together logically but not necessarily 
graphically. Entities that do not touch may be part of the same group, and 
entities that are contiguous may be part of different groups. A group may 
contain any number of entities - as many as hundreds or only one.  

Entities are linked as a group in a number of ways. A group of entities drawn 
in succession without disconnecting the cursor are linked as one group. 
Similarly a series of lines of text entered at the same time are linked as one 
group. You can link any group of entities or groups using the LinkEnts 
command. Entities are also linked or associated as one group when they are 
created at the same time with the Copy command. When an existing entity is 
edited, with the Change or Move commands, for example, it retains the same 
group associations. 

The grouping together of entities in DataCAD facilitates editing many related 
items without affecting other entities in the same portion of a drawing. 
Because they are also easily redefined, groups allow the designer to organize 
a drawing as a series of elements composed of logically related pieces or 
entities. 
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keyboard shortcuts 

These key combinations perform an operation or select a setting in the 
middle of another command by interrupting the original command. Once the 
interrupt function is complete, DataCAD automatically returns to the original 
function. 

layers 

In computer-aided design layers are the electronic equivalent of overlaid 
pieces of tracing paper, each containing a small part of the drawing 
information. Each layer can also be saved and loaded for use in other 
drawing files. 

limits 

The maximum and minimum sizes indicated by a toleranced dimension. 

line 

The most fundamental drawing entity; defined by two endpoints. 

Menu Bar 

An area of the screen, located along the top of the DataCAD screen, that 
contains menus to give you quick access to many of DataCAD’s most used 
functions. 

Menu Window  

An area of the screen that displays DataCAD’s primary menu structure. 

Message Window 

The area of the screen reserved for DataCAD prompts and messages. The 
Message Window also displays information from the keyboard as it is 
entered. 

Navigation Pad 

An area of the screen below the Menu Window that displays buttons to pan 
around or zoom in on your drawing, view it at its extents, recalculate extents 
or access the 3DViews menu. 

ortho mode 

Used to draw entities at any angle. Press (O) to toggle Ortho mode off. To 
draw entities orthogonal to one another, press (O) again to toggle ortho mode 
back on. Modify this snap angle by setting the number of divisions under the 
SnapAng option of the Grids menu. 

orthographic view 

A parallel view whose lines of sight are parallel to each other and 
perpendicular to the plane of projection. Orthographic views include plan 
views and elevations. 
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pan 

Move observer's view of a drawing by using the arrow keys to the right of 
the keyboard. Set the pan distance by using ScrlDist in the Settings menu. 

point 

Use the mouse to point to objects on the screen. Move the mouse to move the 
cursor to the appropriate location on the screen. 

Also, a point in space represented on the monitor as a dot, without width or 
height.  

polyface 

3D vertices connected in a specified order. 

polyline 

A connected sequence of lines and arc segments. 

Projection Pad 

An area of the screen below the Menu Window and Navigation Pad with 
buttons that change the view of your drawing. 

prompt 

A message that appears on the screen in the Message Window providing 
information or requesting a command or user action. 

radius 

The measurement used for a cylindrical baluster, newel post, or hand rail. 
The radius is the distance from the center point of the cylinder to the side of 
the cylinder. 

raster printing 

The rendering of a graphic as an image composed of dots rather that of 
vectors, or lines. 

reference point 

An arbitrary point in the Drawing Window from which the next point 
entered will be referenced. 

right-click 

To press and release the right mouse button. 

right-hand rule 

A rule that indicates the direction of angles. Point the thumb of your right 
hand in the direction of the axis in question. Your fingers curl in the direction 
of positive rotation. The Y axis goes up, so when you point your thumb up, 
your fingers curl toward you in the left to right direction. Negative angles, 
therefore, go from right to left. 
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screen refresh 

Updates or redraws the screen from the drawing file in order to display the 
current status of your drawing. This is particularly useful to monitor your 
progress during editing operations. 

scroll back 

Use Scroll Back to view a previously-displayed portion of a list. 

scroll forward 

Use Scroll Forward to view more options when the list of available choices is 
too long to fit on a menu. 

select 

To highlight or otherwise mark an entity, icon, or text. 

selection set  

A user-defined set of entities and/or groups that contains any number of 
entities or groups. Selection sets provide increased efficiency during editing 
by reducing the time required to select entities, groups, or define areas or 
fences. 

setting 

An option that is set to a particular value. You can change settings at any 
time, and they remain in that state until you change them again. 

solid 

Solid filled figures, composed of quadrilateral (four-sided) or triangular 
(three-sided) polygons.  

Status Area 

The area of the screen reserved for status information such as the current 
layer, layer color, snapping on/off, etc.  

string 

A series of characters. 

swap file 

A temporary file created when you enter DataCAD. It is the working file that 
constrains your drawing during a work session. This working file is 
transferred to your drawing (.DC5) file when you exit DataCAD. 

text 

The alphabet, numerals, and special characters added to a drawing. It is 
created using fonts. 
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text leaders 

Short, sometimes angled lines that are automatically drawn back to a point 
on the circumference of the object when a dimension distance is too short to 
contain dimension text. 

thickness 

The projection of a surface into 3D space. 

toggle 

An option switch that you can turn on or off. When a toggle is on, the button 
label is displayed in green; when a toggle is off, the button label is displayed 
in red. 

tolerance 

The total amount a specific dimension is allowed to vary, the difference 
between maximum and minimum limits. 

Trace 

A solid line with a specified width.  

undo 

An option that cancels the latest operation or command performed. It 
appears on the menu only after an action has taken place. 

vector printing 

Line-based drawings produced with commands that are either native to or 
added to a laser printer. 

view center 

The point in space at which the observer is looking. DataCAD places the view 
center in the middle of the extents, halfway between Z-base and Z-height. 

void 

An opening or hole created in a slab. 

window in 

DataCAD's "zoom" function. Displays objects at different scales for drawing 
tasks. To quickly focus on a portion of a drawing for detailed work, press (/) 
to expand that section. 
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. 

.ASV. See Autosave files 

1 

1LnTrim. See Cleanup, 
trimming to one line 

2 

2LnTrim. See Cleanup, 
trimming to 
intersection of two 
lines 

2LnWalls. See Walls, 2-
line 

2-point arcs 

tracing, 265 
2PtArc. See Curves, 

drawing 

3 

3D arcs 

divisions of, 424 
dog-leg, 423 
tangent, 422 
vertical, 423 

3D copying, 457–58 

3D cursor, 451 

3D doors 

as symbols, 528 
casings for, 528 
cutting walls for, 527 
files, 527 
flush with wall, 531 
forms, 528 
headers for, 530 
hinge placement for, 531 
jambs, 530 
knobs, 532 
sills, 531 

stops, 531 
thickness for, 531 
trim, 529 
types of, 528 

3D drawing, 401 

3D entities 

changing attributes of, 462 
editing rules, 454 
enlarging, 461 
exploding, 462 
exporting, 27 
mirroring, 459 
rotating, 458–59 
rules for editing, 454 
selecting curved, 399 
stretching, 460–61 

3D framing, 508–20 

floor, 508–9 
roof, 511–20 
saving settings, 520 
using settings, 520 
wall, 509–11 

3D lines 

chaining, 401 
curved, as contours, 450 
from Z-base to Z-height, 

401 
3D menus 

selection, 33 
3D models 

adding to web page. See 
o2c 

as e-mail attachment. See 
o2c 

exporting as VRML files, 
60 

walking through, 495, 496 
3D moving, 454–57 

3D polygons 

adding vertices to, 416 
creating drop mesh, 444 
deleting vertices from, 416 
editing, 416 
horizontal, 406 

moving vertices in, 417 
rectangular, 406 
vertical, 408 
visible edges on, 417 

3D roofs 

creating with inclined 
polygons, 410 

creating with inclined 
slabs, 410 

defining boundaries for, 
515 

joining, 517 
modeling, 513 
polygonal, 515 
rectangular, 515 
settings for, 518 
types of, 513 

3D settings, 400 

3D snapping 

normal, 401 
world, 402 

3D stairs, 540–54 

balusters for, 550 
base elevation of, 543 
calculator, 542 
chases of, 545 
curved, radius of, 544 
drawing, 540 
form, 554 
handrails for, 549 
landings of, 545 
newel posts for, 553 
placement of, 544 
risers of, 546 
settings, 543 
stringers of, 548 
tread length of, 544 
treads in first run of, 544 
treads in second run of, 

544 
treads in third run of, 544 
treads of, 544, 547 

3D viewing  (tutorial), 
122 

3D views, 467–73, 477–
78 
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changing center of, 468 
changing center of parallel, 

468 
elevations, 467 
hidden line removal, 478–

84 
isometrics, 467 
oblique, 477–78 
perspective, 473–77 
pespective (tutorial), 133 
rotation angles in, 467 
saving, 492–95 
saving an image, 493 
shaded image, 484–89 
using GotoView, 493 
using o2c player with, 62 

3D windows, 522–27 

as symbols, 522 
casings of, 523 
cutting walls for, 522 
files, 522 
forms, 522 
glass for, 527 
headers for, 524 
height of, 523 
jambs for, 525 
muntins for, 526 
sashes for, 526 
sills for, 525 
trim for, 524 
types of, 523 
wall thickness for, 523 

3D world snapping 
cursor, 402 

3DCursor. See Cursor, 
world snapping 

3DViews 

changing to parallel view, 
397 

3EdgBot. See Inclined 
polygons and slabs, 3-
edged bottom 

3EdgPoly. See Inclined 
polygons and slabs, 3-
edged vertical 

3EdgTop. See Inclined 
polygons and slabs, 3-
edged top 

3LnWalls. See Walls, 3-
line 

3-point arcs 

tracing, 266 
3PtArc. See Curves, 

drawing 

3PtCirc. See Curves, 
drawing . See Circles, 
using 3 points 

4 

4EdgGen. See Inclined 
polygons and slabs, 4-
edged general 

4EdgPara. See Inclined 
polygons and slabs, 4-
edged parallelograms 

4EdgTrap. See Inclined 
polygons and slabs, 4-
edged trapezoid 

4EdgVert. See Inclined 
polygons and slabs, 4-
edged vertical 

4LnWalls. See Walls, 4-
line 

A 

Absolute Cartesian 
entry, 43 

drawing line with, 44 
Absolute polar entry, 43 

drawing line with, 44 
AbsZero. See Reference 

point, fixed 

Action codes, 560, 561 

Actv Onl. See Layers, 
setting the active 

AddCrnr. See Polylines, 
editing vertices 

AddView. See 
Elevations, saving 
views 

AddVoid. See Voids, 
adding 

AddVrtex. See Vertex, 
adding 

A-frame roofs, 410 

AllOn. See Layers, 
toggling all on 

AndCopy. See Mirror, 
and copy 

Angles 

calculating, 34, 35 
measure excluded between 

two lines, 262 
measure included between 

two lines, 262 
of cone of vision, 475 
of door openings, 186, 187 
of rotation, 459 
rise, 399, 432, 436 
roll, 399, 434 
setting types of, 165, 166 
sweep, 426 
using right-hand rule, 467 

AngleTyp. See Angles, 
setting types of 

Aperture, of miss 
distance, 253 

Append 

adding entities to active 
selection set 
automatically, 300 

Arc factor, 174 

Arc of curve 

measuring length of, 262 
Arc<>Edge. See 

Polylines, editing 

ArcFactr. See Arc factor 

Arch. See Scales, setting 
types 

Architectural  scales, 169 

Arcs 

2-point, 202 
3-point. See Curves, 

drawing 
center angle of, 204 
closed, 462 
closing 2D, for hide, 483 
connecting two lines with, 

222 
dividing, 267 
divisions, for hide, 483 
drawing based on chord 

length, 205 
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drawing based on included 
angle, 207 

drawing based on length, 
204 

drawing based on radius, 
206 

drawing tangent with 
entity, 208 

drawing with tangent line, 
208 

editing in a polyline, 220 
measuring chord length of, 

261 
Area 

measuring circle or 
polyline, 264 

Area selection, 31, 32 

3D, 33 
Arrays 

copy rectangular, 241, 242 
copying circular, 243 
copying with, 240, 457 
creating 3D rectangular, 

457 
rectangular, 457 
using Z elevations in 

rectangular, 244 
Arrows 

arrowhead style, 312 
drawing as text, 312 
drawing with Arrows 

macro, 351 
on dimension line, 325 
text, drawing (tutorial), 97 

AS1100. See Scales, 
setting types 

Attributes added with 
macro 

displaying visible, 174 
Attributes of 3D entities 

changing, 462 
Autosave files, 57, 172 

open drawing without 
recovering changes, 58 

Axonometrics 

isometric views, 467 
plan obliques, 477 

B 

BackFace. See Hidden 
line removal, 
increasing speed of 

Background color 

changing Drawing 
Window, 23 

Bal/Run1. See Balusters, 
number of 

Bal/Run2. See Balusters, 
number of 

Bal/Run3. See Balusters, 
number of 

Bal/Tred. See Balusters, 
number of 

Balusters, 550 

as symbols, 551 
color of, 552 
cylindrical, 551 
depth of, 551 
divisions of, 551 
horizontal offset of, 552 
modeling, 550 
number of, 550, 551 
placement of, 550 
radius of, 551 
rectangular, 551 
vertical offset of, 552 
width of, 551 

Base/Hgt. See Z-base, to 
Z-height. See 3D lines, 
from Z-base to Z-
height 

Base+Thk. See Z-base, to 
thickness 

BaseElev. See 3D stairs, 
base elevation of 

Batch plotting, 391–94 

customized with scripting 
language, 394 

from a single drawing, 391 
from multiple drawings, 

392 
to PDF format, 394 

Beams, standard, 536 

Bearing. See Angles, 
setting types of 

Bezier curves, 212 

Bi-fold doors, 185 

BigCursr. See Cursor, 
large displaying 

Bitmap filenames, 561 

Bitmap Fills. See SPB 
Fills 

Blocks 

parallelogram, 419 
rectangular, 419 

Border 

adding center snapping 
point, 363 

creating (tutorial), 113 
drawing, 362, 363 
moving (tutorial), 114 
size of, 362 

BoxColor. See Colors, 
displaying box 

B-spline curves, 213 

C 

Cab. See 
Elevators:drawing 2D 
with DataCAD AEC 

Calculating 

angles, 34, 35 
distances, 34 

Calculator, online, 34 

Calibrate 

distance, 351 
enlargement of imported 

graphics, 351 
X/Y enlargement options, 

351 
Camera, 475 

Cancel 

closing dialog boxes using, 
36 

hidden line removal, 479 
roof framing, 511 
saved hide image, 481 

Capacity. See 
Elevators:drawing 2D 
with DataCAD AEC 

Casings 

of 3D doors, 528 
of 3D windows, 523 

Ceiling grid 

boundary menu settings 
for, 348 
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creating with DataCAD 
AEC, 345 

fixtures menu settings for, 
348 

grid menu settings for, 348 
CentAngl. See Curves, 

drawing 

CentChrd 

Curves, drawing, 205 
Center 

of 3D rotation, 459 
Center points of 2D 

curves 

displaying, 174 
CenterZ. See Center, of 

3D rotation 

CentiMtr. See Scales, 
setting types 

Chain. See 3D lines, 
chaining 

creating vertical polygons 
in succession, 408 

Chamfer, 222, 275 

Changing, 282–85 

attributes of 3D entities, 
462 

attributes to match another 
entity, 283 

entity attributes, 282 
text attributes, 283 
text attributes to match 

another text block, 284 
Characters, extended, 

575 

 

 

Chord 

drawing arc based on 
length of, 205 

measuring length of arc, 
261 

CircArry. See Copy, 
circular array 

Circles 

3-point, 422 
dividing, 267 
measuring circumference 

of, 262 

using 3 points, 211 
using diameter, 210, 422 
using radius, 209, 422 

Circumference 

measuring circle, 262 
CircWndw. See 

Windows, curved 
bays of 

Clean, 179 

Cleanup 

chamfers, 275 
connecting two lines with a 

line, 275 
connecting two lines with 

an arc, 274 
fillets, 274 
trimming to intersection of 

two lines, 276 
trimming to nearest, 277 
trimming to one line, 276 
wall intersections 

(tutorial), 75 
Clip Cube 

activating, 491 
creating, 491 
defining in XREF with 

XRefClip, 492 
display boundary of, 30 
usinddefining in XREF 

with Reference File 
Management, 491 

using with XREFs, 49, 
491, 492 

viewing selected entities in 
3D model with, 490 

ClkWise. See Curves, 
drawing. See Angles, 
setting types of 

CloArc2. See Arcs, 
closing 2D for hide 

CloEllp. See Ellipses, 
closing for hide 

ClosdStr. See Stringers, 
closed 

Closed, 462 

CntrCvty. See Walls, 
defining by cavity 
center 

CntrLine. See Walls, 3-
line attributes 

CntrPnt 

polygons, drawing, 201 
CntrWall. See Walls, 

defining by center 

Codes, action, 560, 561 

Color. See Stairs, 
drawing 2D with 
DataCAD AEC. See 
Layers, changing 
color 

changing on display grids, 
142 

Color mapping 

define materials for 
rendering with, 500 

using Viewer/Shader color 
map, 500 

Colors 

changing, 35 
changing background of 

Drawing Window, 23 
changing for entities, 35 
Color Palette, 24, 35 
Color Picker, 36, 176 
copying entities to 

clipboard, 29 
custom, 35, 175 
displaying box, 174 
exporting with Translation 

toggle, 27 
HSB values, 36 
matching, 37 
menu, 35 
of 3D stairs, 546, 548, 549 
of balusters, 552 
of handrails, 550 
of hidden lines, 482 
of newel posts, 554 
RGB values, 36 
standard 15 DataCAD, 36 
using Color Picker to 

create custom, 176 
Columns 

drawing, 534 
Command Line Alias, 

16 

Compass. See Angles, 
setting types of 

Concrete forms, 534–37 

drawing column, 534 
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drawing double tee, 535, 
536 

drawing I-beam, 537 
drawing inverted tee, 534 
drawing single tee, 535 
drawing standard beam, 

536 
Cone of vision, 475 

width of, 475 
 

Cones, 428 

closed, 462 
radius of, 429 
truncated, 428 

Contours 

control points for, 451 
creating topographical map 

with, 450 
cyclic, 450 
elevation of, 451 
natural, 450 
search closed polyline to 

create outline, 216 
smoothing surface, 444 
steadily rising, 452 
stiffness of, 444, 451, 463 
tangent, 450 
tangent point, 451 

Control points 

displaying for associative 
dimensions, 174 

for contours, 450, 451 
for mesh surfaces, 438 

ContSrch. See Polylines, 
converting closed 
shape to. See 
Contours, search 
closed polyline to 
create outline 

Convert 

lines to walls, 285 
walls to lines, 285 

ConvVoid. See Voids, 
converting. See Voids, 
converting to polygon 

Coordinate entry 

absolute Cartesian, 43, 44 
absolute polar, 43, 44 
choosing a method, 44 
distance direction, 43, 45 
placing dimensions with, 

319 

relative Cartesian, 43 
relative polar, 43, 44 

Coordinates 

screen, 470 
world, 470 

Copy, 47 

3D entities, 457–58 
circular array, 243 
entities, 236–45 
new distance, 237, 238 
one-dimensional array, 241 
perpendicular to original, 

238 
rectangular array, 241, 242 
specified distance and 

angle, 236 
to another layer, 239 
to clipboard, setting, 30 
using arrays, 457 

Copy to Clipboard 

entity color, 29 
line weight, 29 

Crossing selection, 31, 
32 

Cursor 

3D, 451 
changes to New Elevation 

Indicator, 397 
changing to New Elevation 

Indicator, 471 
large displaying, 171 
setting accuracy of, 170 
text, 306 
with o2c object attached, 

349 
world snapping, 402, 455, 

458 
CurvData. See Curves, 

drawing based on 
surveyor's data 

CurveCtr. See Center 
points of 2D curves, 
displaying 

Curves 

Bezier, 212, 438 
B-spline, 213 
drawing, 202–14 
drawing based on 

surveyor's data, 213 
drawing with control 

points, 211 
measuring arc length of, 

262 

measuring diameter of, 261 
measuring radius of, 261 

CurvRows. See 
Columns, drawing 2D 
with DataCAD AEC 

CurvSpcg. See Columns, 
drawing 2D with 
DataCAD AEC 

Customizing 

colors, 175 
display settings, 172 
drawing settings, 165 
macros, 27 
miscellaneous settings, 28 
toolbars, 12 
walk-through options, 496 

Customizing DataCAD, 
21 

DXF/DWG file translation, 
25 

interface settings, 22 
macros, 27 
miscellaneous settings, 28 
pathnames, 21 

Cut, 47 

Cutout. See Windows, 
drawing. See Doors, 
drawing 

CutWall. See Walls, 
cutting 

Cyclic contours, 450 

Cylinder. See Newel 
posts, cylindrical. See 
Balusters, cylindrical. 
See Handrails, 
cylindrical 

Cylinders 

closed, 462 
horizontal, 425 
setting number of divisions 

for, 427 
vertical, 424 

D 

DataCAD AEC 

2D columns, 227–31 
2D elevators, 231–33 
2D stairs, 225–26 
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drawing curved bays of 
windows with, 195 

drawing linear bays of 
windows with, 192 

drawing room labels with, 
315 

DataCAD internal menu 

function numbers, 561 
DC Render 

material assignment, 29 
DecDeg. See Angles, 

setting types of 

Decimal. See Scales, 
setting types 

Decimal place, setting, 
165, 166 

Decimal point, floating, 
165, 166 

Definition list 

adding a value to, 167 
angle, 167 
changing a definition, 168 
deleting a value to, 167 
distance, 167 
editing, 167 
loading a customized, 168 
scale, 167 

DelCrnr. See Polylines, 
editing vertices 

DelDoubl. See Hidden 
line removal, deleting 
double lines with 

DelEdge. See Polylines, 
deleting an edge 

Delete 

door settings files, 527 
double lines after hide, 482 
edge from a polyline using, 

221 
framing settings files, 508, 

510, 520 
go-to-view, 494 
layers, 150 
layers with LyrUtil, 271 
saved hide image, 481 
stair settings files, 554 
text styles, 311 
vertices, 416 
wall styles, 183 
window settings files, 522 

DelLayer. See Layers, 
deleting 

DelVrtex. See Vertex, 
deleting 

Depth 

of balusters, 551 
of handrails, 550 
of landings, 545 
of newel posts, 553 
of treads, 547 

DiaCirc. See Circles, 
using diameter 

Diameter 

of circles, 210, 422 
of curve, measuring, 261 
of polygons when drawing, 

201 
Dimensions, 318–30 

aligned, 318 
angle between lines, 327 
angle style for angle and 

curve, 329 
angular, 318 
arrow style for, 325 
arrows, 319, 321 
associative, 319, 320 
automatic, 320 
automatic (tutorial), 102 
automatic style for, 325 
baseline, 322, 324, 325 
center points, 325 
changing linear, 325 
curve diameter, 328 
curve radius, 328 
DIN Standard, 324 
displaying associative, 173 
dots for, 325 
drawing string of (tutorial), 

100 
exploding linear 

associative, 327 
fixed distance of, 324 
geometric tolerances for, 

324 
horizontal, 318 
increment offset of, 324 
limits for, 324 
line offset, 323 
line style for, 319, 320, 

323 
line style for angle and 

curve, 329 
linear, 318 
minimum distance, 325 

miss distance, 325 
moving linear, 326 
object snapping and, 319 
overall, 322 
overrun of extension lines, 

324 
parallel to entity, 318 
rotated, 318 
rounding, 324 
settings (tutorial), 99 
stretching (tutorial), 103 
stringline, 320, 322, 325 
text offset for, 323 
text style for, 319, 320, 

322 
text style for angle and 

curve, 329 
tick marks for, 325 
vertical, 318 

DimPoint. See Control 
points, displaying for 
associative 
dimensions  

DIN. See Scales, setting 
types 

Direction distance 

using with reference point, 
252 

Directories 

changing, 21 
Display 

customizing, 172 
grids, 141 
negative coordinates, 171 
options, setting, 170 
synchronizing distances, 

172 
Display grid 

changing color, 142 
Display list, 28 

Distance 

copy, 238 
direction entry, 43 
direction entry, drawing 

line with, 45 
new, copy, 237 

Distances 

calculating, 34 
display, synchronizing, 

172 
increment, 440 
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measuring between two 
points, 261 

new, 3D move, 456 
previous stretch, 460 
previous, 3D move, 456 
stretch, in Z direction, 460 

DistSync. See Distances, 
display, 
synchronizing 

Divide entities, 266–68 

Divisions 

of 2D arcs, 483 
of balusters, 551 
of contours, 451 
of handrails, 550 
of mesh surfaces, 440 
of newel posts, 553 
primary, 463 
secondary, 463 
setting number for 

cylinders, 427 
setting primary and 

secondary, 399 
Dn Only. See 

Stairs:drawing 2D 
with DataCAD AEC 

DoCtr. See 3D stairs, 
stringers of 

DoFloat. See Scales, 
setting types. See 
Decimal point, 
floating 

DogLeg. See 3D arcs, 
dog-leg 

DoLeft. See Handrails, 
on left side of stairs. 
See 3D stairs, stringers 
of 

DoLndBt. See 3D stairs, 
landing of 

DoLndTp. See 3D stairs, 
landing of 

DoNlPst. See Newel 
posts, modeling 

Doors 

adding 3D (tutorial), 127 
drawing, 184–88 
drawing (tutorial), 81 

labels for, 316 
match swing color to, 187 
removing, 188 
swing color of, 187 
swing styles of, 187 

DoorStyl. See Doors, 
drawing 

DoorSwng. See Doors, 
drawing 

DoRght. See Handrails, 
on right side of stairs. 
See 3D stairs, stringers 
of 

DoRiser. See 3D stairs, 
risers of 

Dormers, drawing, 412, 
413 

DoTread. See 3D stairs, 
treads of 

Double doors, 185 

Double tee concrete 
forms, drawing, 535, 
536 

Drag 

copy entities using, 237 
moving polyline using, 220 
moving using, 288 
moving using (tutorial), 

114 
DragEdge. See Polylines, 

repositioning 

Drawing 

and editing basic skills, 
43–48 

cabinet elevations, 374, 
375 

columns, 2D, 227–31 
creating a new, 7 
creating new default, 9 
curves, 202–14 
default, 9 
door elevations, 369 
doors (tutorial), 81 
elevators, 2D, 231–33 
exterior elevations with EZ 

Tools macro, 366 
line by selecting two 

points, 43 
marks displaying, 171, 

187, 192, 250 

naming, 7 
opening an existing, 6 
polygons, 200–201 
polylines, 214–25 
rectangles, 201 
sketching freehand, 246 
stairs, 2D, 225–26 
using default to create 

new, 8 
using same default for each 

new, 8 
walls (tutorial), 67 
window elevations, 371, 

373 
windows (tutorial), 86 
with coordinate entry, 43 
with linetypes, 46 
with the mouse, 43 

Drawing Area, 20, 21 

Drawing Window 

changing partitions in, 481 
Drawings 

border, moving (tutorial), 
114 

changing entities in, 40 
copying parts of, 39 
customizing settings, 165 
linking, 48 
mirroring parts of, 39 
moving entities in, 40 
recovering lost work, 57 
referencing, 48–54 
saving, 56 
stretching entities in, 40 
viewing, 54 

DrawJamb. See 
Windows, drawing. 
See Doors, drawing 

Drop mesh, 444–50 

DrwHidn. See Hidden 
line removal, drawing 
hidden lines in 

DrwMarks. See 
Drawing, marks 
displaying 

DspGrid1. See Display, 
grids 

DspGrid2. See Display, 
grids 

DWG 

exporting files, 60 
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files, customizing 
translation, 25 

importing drawing file, 9 
saving entity assignments 

when importing, 11 
DWG Translator 

translation tables, 556 
DwgSheet. See Border, 

drawing 

DXF 

exporting files, 60 
files, customizing 

translation, 25 
importing drawing file, 9 

DXF Translator 

translation tables, 556 
Dynamic 

curves, drawing, 202, 203 
polygons, drawing, 201 
tangent curves, drawing, 

208 
DynCrnr. See Polylines, 

editing vertices 

E 

Edit menu, 40, 47 

EditArc. See Polylines, 
editing arcs 

EditDefs. See Definition 
list, editing. See 
Editing, value 
definitions 

Editing 

and drawing basic skills, 
43–48 

drawings, 47 
linear dimensions, 325 
value definitions, 167 

 

 

EditPlne 

changing zero plane 
orientation, 397 

positioning zero plane 
with, 397 

Elevations, 366–76 

cabinet settings for, 375 
cabinet styles for, 374, 376 

creating (tutorial), 136 
creating 3D views of, 471 
creating new, 471 
door, 369 
door settings for, 370 
door styles for, 369, 371 
drawing cabinets, 374, 375 
drawing doors, 369, 371 
drawing exterior, 366 
drawing windows, 371, 

373 
exterior, 366 
exterior roof settings, 367 
saving views, 472 
window settings for, 372 
window styles for, 372, 

373 
Elevators 

drawing 2D with 
DataCAD AEC, 231–33 

Ellipses, 211 

closing, for hide, 483 
EndPnt. See Object 

snapping, to nearest 
end point 

EndPtAng. See Curves, 
drawing 

EndPtRad. See Curves, 
drawing 

Engineering scales, 169 

Engr. See Scales, setting 
types 

Enlarge, 293 

3D entities, 461 
enlargement factor, 293 
imported graphics, 351 
in X direction, 461 
in Y direction, 461 
in Z direction, 461 

Entities 

adding to a selection set, 
297 

attributes of, 259 
clipping with ClipIt, 302 
copying, 47, 236–45 
copying color of, 29 
copying line weight of, 29 
copying perpendicular to 

original, 238 
cropping with ClipIt, 302 
deleting from a selection 

set, 298 

dividing, 266–68 
editing attributes, 285 
enlarging, 293 
erasing, 294 
erasing partial, 295 
identifying, 259 
in a selection set using 

Show, 296 
linking, 32, 296 
linking to a go-to-view, 

495 
measuring, 260–66 
mirroring, 245–46 
moving, 47, 286–90 
moving specified distance 

and angle, 287 
offsetting and copying, 238 
rotating, 290 
rotating dynamically, 291 
selecting, 31 
stretching, 292 
trimming, 276, 277 
unlinking, 296 

EqBays. See Windows, 
curved bays of. See 
Windows, linear bays 
of 

Erase, 294 

contents of layers, 150 
partial, 295 

EraseLyr. See Layers, 
erasing contents of 

ErasVoid. See Voids, 
erasing. See Voids, 
erasing from a 
polyline 

Explode 

3D entities, 462 
converting TrueType fonts 

to 3D, 314 
linear associative 

dimensions, 327 
polyline, 217 
symbols, 340 

Export 

3D entity, 27 
DWG files, 60 
DXF files, 60 
files, 26, 559 
files using Color 

Translation toggle, 26 
o2c objects, 61 
RAY or DC Render files, 

60 
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reference files, 27 
text, 309 
using Linetypes toggle, 26 
VRML files, 60, 61 
XREF files, 27 

Extended characters, 
575 

 

Extension 

left, of stair treads, 547 
right, of stair treads, 547 

Extents 

viewing, 149 

F 

Fast3D. See Object 
snapping, to center of 
3D circular entities 

Fast3D snapping, 403 

FastSym. See Object 
snapping, to symbol 
insertion point 

Fence selection, 31, 32 

3D, 33 
Files 

autosave (.ASV), 57, 172 
customizing DXF/DWG 

translation, 25 
door, 527 
exporting, 26, 60 
exporting XREF, 27 
naming conventions, 59 
project set, 393 
recovering lost work, 57 
referencing, 48–54 

Fillets, 222, 274 

FiltBack. See Filter 

Filter. See Layers, 
filtering 

layers, 456, 457 
FiltFrwd. See Filter 

FitBays. See Windows, 
curved bays of. See 
Windows, linear bays 
of 

FixedRef. See Reference 
point, fixed 

FixText. See Mirror, text 
position 

Floor framing, 508–9 

joist settings for, 509 
sill plate settings for, 509 
subfloor settings for, 509 

Fonts 

changing menu button, 25 
converting TrueType fonts 

to 3D, 314 
setting text parameters for 

TrueType fonts, 313 
standard, 575 
supplied by DataCAD, 306 
true-type (TTF), 306, 313 

FormAtr. See Entities, 
editing attributes 

Fractions, 165 

stacked, 166 
Framing, 3D, 508–20 

roof, 511–20 
wall, 509–11 

Free Zooms 

remembering, 30 
FreeHand 

using to sketch, 246 
FreeTrim. See Cleanup, 

trimming to nearest 

G 

Gable roofs, 410 

Geometry, 238 

redrawing speed for, 28 
Get X. See Snapping, to 

enter horizontal 
distance 

Get Y. See Snapping, to 
enter vertical distance 

Get-Snap. See Snapping 

Girders, drawing, 534 

Glass 

for 3D windows, 194, 197, 
527 

GlassThk. See Windows, 
glass thickness 

Globe display, 468 

repositioning in Drawing 
Window, 469 

using for parallel views, 
468 

using for perspective 
views, 468 

Golden Section, 266 

dividing a line with, 267 
Go-to-views, 493 

adding current view to the 
list, 493 

batch plotting of, 392 
changing an existing, 494 
deleting a view, 494 
linking an entity to, 495 
moving a view, 494 
renaming a view, 494 
using hyperlinks with, 495 

Grads. See Angles, 
setting types of 

GridColr. See Display 
grid, changing color 

GridOrg. See Grids, 
setting origin of 

Grids 

changing size of, 142 
changing the angle in, 144 
display, changing color of, 

142 
display, using, 141 
matching an entity’s angle, 

144 
rotating, 144 
setting origin of, 144, 468 
setting snap angle of, 143 
snap, setting angle of, 143 
snap, using, 141 

GridSize. See Grids, 
changing size of 

Group selection, 31 

H 

Handrails 

color of, 550 
cylindrical, 549 
depth of, 550 
divisions of, 550 
height of, 550 
on left side of stairs, 549 
on right side of stairs, 549 
radius of, 549 
rectangular, 549 
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width of, 549 
Hatch, 332–37 

angle, 333 
associative, 337 
boundaries, 333 
contour search, 335 
displaying, 173 
drawing (tutorial), 105 
drawing standard patterns, 

332 
master polyline with voids, 

224, 334 
origin of, 333 
patterns, 332, 333 
scale, 333 
standard patterns, 567 
type of, 332 
using SPB fills instead of, 

335 
Head. See 3D windows, 

headers for 

Head height 

of doors, 188 
of windows, 191 

Headers, for 3D doors, 
530 

HeadHgt. See Head 
height 

Height. See Handrails, 
height of 

Hgt+Thk. See Z-height, 
to thickness 

Hidden line removal, 
478–84 

adding retained image to 
active layer, 480 

adding retained image to 
layer file, 480 

adding retained image to 
new layer, 480 

arc divisions for, 483 
automatic, 484 
closing 2D arcs for, 483 
closing ellipses for, 483 
colors of hidden lines, 482 
deleting double lines with, 

482 
displaying outlines in, 483 
drawing hidden lines in, 

482 
hidden linetypes for, 482 
increasing speed of, 481, 

482 

joining lines during, 481 
line spacing for hidden 

lines, 483 
maximizing performance 

of, 479 
offsetting an image, 481 
performing, 479 
saving image of, 480 
tutorial, 134 

HidnColr. See Hidden 
line removal, colors of 
hidden lines 

HidnSpac. See Line 
spacing, for hidden 
lines 

HidnStyl. See Linetypes, 
for hidden lines 

Hilite. See Walls, setting 
attributes of 

Hip roofs, 411, 412 

Hither clip, 474 

Horizontal 3D 
polygons, 406 

Horizontal cylinders 

bottom half of, 427 
closed, 427 
full, 427 
radius of, 427 
sweep angle for, 426 
top half of, 427 

Horizontal slabs, 407 

HorzOfst. See Balusters, 
horizontal offset of 

Hotkeys 

for walk-through, 496 
Hotspots, 19 

HthrClip. See Hither clip 

Hyperlinks 

with files, 495 
with GotoViews, 495 
with internet URLs, 495 

I 

I-beams, 537 

Identify entities, 259 

Images 

calibrating enlargement of 
imported, 351 

importing .BMP and .JPG 
files into drawing, 350 

printing controls for .BMP 
and .JPG files with Pen 
Table, 351 

Import 

.BMP file, 350 

.JPG file, 350 
and calibrate enlargement 

of imported graphics, 
351 

DWG or DXF file, 9 
entity assignments for, 9, 

26 
files, 26, 556 
image, 350 
o2c object, 349 
text, 309 

Inch/Dec. See Scales, 
setting types 

Inch/Frc. See Scales, 
setting types 

Inclined polygons and 
slabs 

3-edged bottom, 412 
3-edged top, 413 
3-edged vertical, 414 
4-edged general, 412 
4-edged parallelograms, 

410 
4-edged trapezoid, 411 
4-edged vertical, 413 

Inorder. See Layers, 
refreshing in order of 
creation 

Inscribe. See Polygons 

Insertion point, 47 

InSill. See Windows, 
drawing 

InsPoint. See Insertion 
point 

Interface 

customizing settings for, 
22 

Intersections 

cleaning L, 281 
cleaning T, 280 
cleaning X, 281 
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marking, 268 
IntrLand. See 3D stairs, 

intermediate landings 
of 

Intsect. See Object 
snapping, to nearest 
intersection point 

Inverted tee concrete 
forms, drawing, 534 

InWall. See Windows, 
drawing. See Doors, 
drawing 

Isometric views, 471 

J 

JambDpth. See 
Windows, drawing. 
See Doors, drawing 

JambIn. See Windows, 
drawing. See Doors, 
drawing 

Jambs 

for 3D doors, 530 
for 3D windows, 525 

JambWdth. See 
Windows, width of 
jamb. See Doors, 
drawing 

Join. See Hidden line 
removal, joining lines 
during 

K 

Key files 

creating, 562 
editing, 563 

Keyboard 

shortcuts, 15 
shortcuts, creating, 570 
shortcuts, defining, 571 
shortcuts, standard, 572 

Knobs, for 3D doors, 532 

L 

Labels, 315–16 

customizing, 315 
door, 316 
inserting symbol into, 316 
placing in drawing, 316 
room, 315 
window, 316 

Landings 

color of, 546 
depth of, 545 
intermediate, 546 
modeling, 545 
thickness of, 546 

Layer Manager, 154–64 

adding layers with, 160 
changing a layer’s color 

with, 159 
changing a layer’s name 

with, 160 
changing a layer's number 

with, 155 
changing layer settings 

with, 157 
changing on/off layer 

settings with, 157 
deleting layer(s) with, 163 
designating the active layer 

with, 158 
erasing entities from a 

layer with, 162 
exiting from, 164 
locking/unlocking layers 

with, 158 
moving layers with, 155 
opening, 154 
reverting to previous layer 

settings with, 163 
sorting layers with, 156 
turning all layers on with, 

158 
using Undo to restore old 

layer settings, 164 
Layer search, 32, 186, 

190, 399 

selection, 31 
status of, 33 
status toggle, 19 

Layers 

active, 19 
adding (tutorial), 64 
assigning colors (tutorial), 

66 
changing active (tutorial), 

65 
changing color, 149 
changing the active, 19, 

146 

creating, 145 
deleting, 150 
deleting with LyrUtil, 271 
displaying, 147 
erasing contents of, 150 
filtering, 152, 457 
loading, 153 
loading with LyrUtil, 270 
locking, 148 
moving 3D entity to, 456 
moving entities to another, 

151, 289 
naming convention for, 

154 
order of, 174 
planning, 38 
refreshing, 147 
refreshing in order of 

creation, 174 
renaming, 149 
renaming (tutorial), 64 
saving, 153 
saving with LyrUtil, 270 
searching for, 151 
seed, 146 
setting the active, 146, 151 
toggling all on, 147 
toggling on and off, 147 
unlocking, 148 
viewing, 149 

Layout, 387–90 

Layout plots, 387–90 

LeftExtn. See 3D stairs, 
treads of 

Line spacing 

for hidden lines, 483 
Line weight, 46 

copying, 29 
displaying, 173 

Lines 

connecting two lines with, 
222 

dividing, 267 
dividing with Golden 

Section, 267 
marking intersection of, 

268 
maximum, 288 
measure angle excluded 

between two, 262 
measure angle included 

between two, 262 
measuring angle of, 260 
measuring length of, 260 
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measuring total length of, 
263 

welding, 278 
Linetypes, 46 

creating, 563 
definitions of DataCAD's, 

564 
displaying, 173 
exporting, 26 
for hidden lines, 482 
menu, 46 
settings, 46 
standard, 566 
using, 40 

LineWgt. See Line 
weight 

Link. See Hyperlinks 

entity to go-to-view, 495 
LinkEnts. See Entities, 

linking 

LinrWndw. See 
Windows, linear bays 
of 

LIntsct. See 
Intersections, cleaning 
L 

Load 

layers with LyrUtil, 270 
text styles, 310 
wall styles, 182 

LoadLyr. See Layers, 
loading 

Lock. See Layers, 
locking 

LyrOrder. See Layers, 
order of 

LyrRfsh. See Layers, 
refreshing 

LyrSnap. See Snapping, 
on layers. See Obect 
snapping, on layers 

LyrSrch. See Layers, 
searching for. See 
Layer search 

M 

Macros 

2D DataCAD AEC, 2D 
elevators, 231–33 

Arrows, 351 
ClipIt, 301 
customizing menu in 

Program Preferences, 27 
DataCAD AEC, 343, 345, 

362 
DataCAD AEC, 2D 

columns, 227–31 
DataCAD AEC, 2D stairs, 

225–26 
EZ Tools, 366, 369, 371, 

374, 376 
FormAtr, 285, 357 
FrameIt, 508, 511 
Lin2Wall, 285 
LyrUtil, 270, 271 
RoofIt, 513 
SymExp, 342 

Mansard roofs, 411 

Marker, 404 

Marking 

intersection of two lines, 
268 

Match 

changing entities using, 
283 

changing text attributes 
using, 284 

colors, 37 
moving 3D entities to 

another layer, 456 
moving entities to another 

layer with, 151 
setting active layer using, 

151 
snap grid to an entity, 268 

Max Acceleration 

increasing display speeds 
with, 29 

MaxLines. See Lines, 
maximum. See 
Drag:copy entities 
using 

Measure, 260–66 

Menu Bar, 11 

Menu buttons 

changing fonts of, 25 
Menu level string, 561 

Menu Window, 13 

Edit and Utility, 14 
moving, 24 

Menus 

3DEdit, 398, 454 
3DViews, 397, 398, 467 
AngleTyp, 166 
Architct, 178 
Change, 282 
Cleanup, 222, 274, 275 
Color, 35 
Copy, 236 
Curves, 202–14 
Drag, 237 
Edit, 47 
EditSets, 296, 297, 298, 

299, 300 
Enlarge, 293 
Erase, 294, 295 
FreeHand, 246 
GotoView, 493 
Grids, 141 
Hatch, 332 
Identify, 259 
Insert, 340 
InsX-REF, 48 
Layers, 145, 146 
LineType, 46 
LinkEnts, 32, 296 
Measures, 253 
Move, 287, 289, 290 
ObjSnap, 252, 254, 256, 

257 
Plotter, 121, 380 
RefPnt, 250 
Rotate, 290 
selection (entity, group, 

area), 31 
Settings, 165 
Stretch, 292 
Template, 341, 352, 354, 

358 
Text, 306 
Toolbox, 513, 534 
TxtStyl, 310, 311 
value, 33 
WalkThru, 496 
WindowIn, 55 

Mesh 

drop, 444–50 
Mesh surfaces, 438 

control  points, 441 
creating with varying Z 

elevations, 441 
divisions of, 440 
drawing manually, 439 
rectangular, 439 
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setting values for Z-User1 
and Z-User2, 441 

vertical, 440 
Message Area, 562 

Meters. See Scales, 
setting types 

Metric. See Scales, 
setting types 

Metric scales, 169 

MidPnt. See Object 
snapping, to nearest 
midpoint of line 

MilliMtr. See Scales, 
setting types 

Mirror 

3D entities, 459 
and copy, 246 
defining reflection line, 

245 
entities, 245–46 
text position, 246 

MissDist. See Object 
snapping, defining 
miss distance for. See 
Cursor, setting 
accuracy of 

MltLyout. See Printing, 
multiple views 

Mouse 

snapping with middle 
button, 253 

MouseWheel 

using for walk-through, 
496 

MoveCrnr. See 
Polylines, editing 
vertices 

MoveZ. See Moving, in 
Z direction 

Moving, 286–90 

3D entities, 454–57 
dragging to, 288 
dragging to (tutorial), 114 
in Z direction, 287 
new angle, 289 
new distance, 287, 289 
previous distance, 287 

specified distance and 
angle, 287 

to another layer, 289 
MovVrtex. See Vertex, 

moving 

MtchDoor. See Doors, 
match swing color to 

MtchWall. See Windows, 
drawing. See Doors, 
drawing 

Mullions 

for windows, 194, 196 
Multi-scale plotting, 

387–90 

Muntins, for 3D 
windows, 526 

N 

Name. See Layers, 
renaming 

Natural contours, 450 

Navigation Pad, 17 

moving, 24 
Nearest. See Obejct 

snapping, to nearest 
point 

Negative coordinates 

displaying, 171 
NegDist. See Negative 

coordinates, 
displaying 

New Elevation 
Indicator, 471, 472 

and Z-base and Z-height 
settings, 472 

and zero plane, 472 
cursor changes to, 397 

NewDist. See Copy, new 
distance 

Newel posts 

as symbols, 553 
color of, 554 
cylindrical, 553 
depth of, 553 
divisions of, 553 
modeling, 553 

radius of, 553 
rectangular, 553 
width of, 553 

NewelPst. See 3D stairs, 
newel posts for 

NewLayer. See Layers, 
creating 

NewLine. See Tangents, 
drawing curves as 

No.Pnts. See Object 
snapping, to dividing 
point 

No.Sides. See Polygons 

NoChange. See Color, 
menus 

NoEdge. See Hidden 
line removal, 
displaying outlines in 

Normal. See Angles, 
setting types of 

Nosing. See Stairs, 
drawing 2D with 
DataCAD AEC 

for stair treads, 547 
round, 548 
square, 548 

NumCab. See 
Elevators:drawing 2D 
with DataCAD AEC 

NumRiser. See 
Stairs:drawing 2D 
with DataCAD AEC 

O 

 

o2c 

adding 3D models as e-
mail attachment, 62 

adding 3D models to web 
page, 62 

exporting objects, 61 
inserting objects, 349 
Objects to See, 62 

Object snapping, 252 

defining miss distance for, 
253 
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drawing line perpendicular 
to entity, 257 

increasing speed of, 253 
on layers, 253 
placing dimensions with, 

319 
tangent to arc, 257 
to center of 3D circular 

entities, 253 
to dividing point, 254 
to entities in active 

selection set, 253 
to hatch lines, 253 
to nearest center point, 256 
to nearest end point, 255 
to nearest intersection 

point, 257 
to nearest midpoint of line, 

255 
to nearest point, 254 
to nearest quadrant point, 

256 
to symbol insertion point, 

253 
Object Viewer 

raytracing with, 499 
selecting from View menu, 

498 
using toolbar icons, 499 

ObjSnap. See Object 
snapping 

Oblique views, 477–78 

axonometrics, 477 
creating elevation, 477 
creating plan, 478 
elevation, 477 
plan, 477 
rotation angle for, 477 
settings for, 477 

Offset. See 
Entities,offsetting and 
copying. See 
Stairs:drawing 2D 
with DataCAD AEC 

OneColum. See 
Columns, drawing 2D 
with DataCAD AEC 

OnSide. See Balusters, 
placement of 

OnStrng. See Balusters, 
placement of 

OnTread. See Balusters, 
placement of 

OpenGL Shader 

using for 3D views, 489 
using Shader Settings 

dialog, 490 
OpenStr. See Stringers, 

open 

OutSill. See Windows, 
drawing 

Overhead doors, 185 

Overshoot, 46, 173 

OverSht. See Overshoot 

P 

Palettes 

using customized colors, 
175 

Pan/Scrolls 

remembering, 30 
Parallel views, 467–73 

elevations, 471 
isometric, 471 
new view center as new 

grid origin for snapping, 
468 

using globe for, 468 
Password 

setting, 165 
Paste, 47, 48 

Paste Special, 47, 48 

Pattern Fills. See SPB 
Fills 

PDF format 

batch plotting to, 394 
Pen Table, 384–86 

settings for .BMP and .JPG 
images, 351 

settings for SPB fills, 337 
Pen width. See Printing, 

pen width 

Perimeter 

measuring circle or 
polyline, 264 

Perpend. See Object 
snapping, drawing 
line perpendicular to 
entity 

Perspective views, 473–
77 

1-point, 475 
2-point, 476 
3-point, 476 
camera settings for, 475 
cone of vision, 475 
eyepoint of, 473, 474 
focal point of, 473, 474 
hither clip in, 474 
tutorial, 133 
using globe for, 468 

Plane snap, 398 

changing zero plane 
orientation, 397 

positioning zero plane 
with, 398 

PlneSnap. See Plane 
snap 

Plotting, 380–94. See 
Printing 

scale, 381 
tutorial, 120–24 

Plotting scale. See 
Printing, plotting 
scale for 

Plumbing symbols, 343 

Pocket doors, 185 

Point to Point 

measuring, 261 
Polygon 

converting from closed 
polyline to, 218 

normals, 487 
Polygons, 200–201 

Polylines 

adding voids to, 224, 334 
closed, 217 
connecting two edges with 

chamfer, 222 
connecting two edges with 

fillets, 222 
converting closed shape to, 

218 
converting lines and arcs 

into, 217 
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converting to lines and 
arcs, 217 

converting to polygon, 218 
converting to slab, 218 
converting voids to 

polygon, 225 
covered, 216 
deleting an edge, 221 
drawing, 214–25 
drawing by segments, 215 
editing, 217 
editing arcs, 220 
editing vertices, 218, 219, 

222 
erasing voids from, 224 
finding centroid of closed, 

223 
hatching master containing 

voids, 224, 334 
measuring area of closed, 

223 
measuring perimeter of 

closed, 223 
rectangular, 215 
repositioning, 220 
tracing, 265 
tracing 2-point arcs, 265 
tracing 3-point arcs, 266 
tracing tangent arcs, 266 

PrevDist. See Distance, 
previous 

Preview 

plots, 382, 383 
Primary divisions 

of spheres, 433 
of surfaces of revolution, 

437 
of torus, 435 

Printing, 380–94 

batch plotting, 391–94 
changing view to match a 

detail, 390 
check plot, 383 
color, 385, 386 
editing details, 389 
editing sheets, 389 
effective plotting area for 

paper size, 380 
erasing all details on a 

sheet, 389 
erasing selected details on 

a sheet, 390 
gray scale, 386 
laying out your drawing 

for, 382 
layout orientation, 381 

loading pen table settings 
for, 386 

moving a detail on a sheet, 
390 

multiple views, 382, 387 
multi-scale plots, 387–90 
multi-scale plotting 

(tutorial), 122, 123 
paper orientation, 381 
paper size for, 380 
Pen Table, 382, 384–86 
pen table (tutorial), 121 
Pen Table settings for 

.BMP and .JPG images, 
351 

Pen Table settings for SPB 
fills, 337 

pen width, 382 
plotting scale, 381 
preview of plot, 382, 383 
quick layouts for, 382, 

387, 392 
renaming sheets, 389 
rotating plot for, 382 
saving pen table settings 

for, 386 
selecting printer for, 380 
sheets in batches, 392 
toggling layers on in a 

detail, 390 
tutorial, 120–24 
updating a detail on a sheet 

with layer settings, 390 
using pen table settings, 

386 
widths of pen passes, 385 

Program Preferences 

background color, 23 
creating new drawing with 

default, 8 
customizing with, 21 
DXF/DWG import, 25 
interface settings, 22 
menu button font, 25 
moving interface settings, 

24 
pathnames, 21 
toolbar toggle, 23 

Project 

drawing efficiently, 39 
management, 140 
planning, 37 
planning layers, 38 
sample, 40 

Project Directory, 140 

Project set files, 393 

Projection Pad, 18 

moving, 24 

Q 

QckSnap. See Quick 
snapping 

QckSrch. See 3D entities, 
selecting curved 

Quadrant. See Object 
snapping, to nearest 
quadrant point 

Quick. See Object 
snapping, increasing 
speed of 

Quick snapping, 399, 
403 

QwkLyout. See Printing, 
quick layouts for 

R 

RadCirc. See Circles, 
using radius 

Radians. See Angles, 
setting types of 

Radius 

of 3D stair handrails, 549 
of balusters, 551 
of circles, 209, 422 
of cones, 429 
of curve, measuring, 261 
of curved stairs, 544 
of horizontal cylinders, 

425, 427 
of newel posts, 553 
of torus, 435 

RadlGrid. See Columns, 
drawing 2D with 
DataCAD AEC 

RadlRows. See 
Columns, drawing 2D 
with DataCAD AEC 

Rafters, drawing, 413 

Rails. See Stairs, 
drawing 2D with 
DataCAD AEC 

RAY files 
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exporting, 60 
Raytrace 

with Object Viewer, 499 
Recovering lost drawing 

changes 

before starting DataCAD. 
See Autosave files 

since last save. See 
Autosave files 

using a backup file, 58 
Rectangl. See Newel 

posts, rectangular. See 
Balusters, rectangular. 
See Handrails, 
rectangular 

RectAngl. See Polylines, 
drawing rectangular. 
See Drawing, 
rectangles 

Rectangles 

drawing 3D polygons, 406 
drawing slabs, 406 

Rectangular arrays, 457 

RectArry. See Copy, 
rectangular array 

RectGrid. See Columns, 
drawing 2D with 
DataCAD AEC 

Redo, 47 

Reference files 

inserting, 48 
Reference point, 250–52 

fixed, 250 
floating, 250 
using with direction 

distance, 252 
Referencing 

drawings, 48–54 
files, 48–54 

Referencing drawings, 
48 

and binding, 52 
and displaying layers in, 

50 
and refreshing, 51 
and reloading, 51 
deleting, 52 
highlighting, 53 

orphaned, 54 
resolving orphaned, 54 
self-referencing XREFs, 

49 
using Reference File 

Manager, 49 
using stamps, 349 
with unique clipping 

boundaries, 49 
Reflection line 

defining, 245 
RefPnt. See Reference 

point, floating 

Relative Cartesian entry, 
43 

Relative polar entry, 43 

drawing line with, 44 
Remove 

cutouts in walls, 184 
doors, 188 
windows, 192 

Rendering 

with OpenGL Shader, 490 
RevSurf. See Surfaces of 

revolution 

RghtExtn. See 3D stairs, 
treads of 

Right-hand rule, 467 

Rise angles, 432, 436 

RiserHgt. See 3D stairs, 
riser height of 

Risers, 546 

color of, 546 
height of, 546 
thickness of, 546 

RndNosng. See 
Nosing:for stair treads 

Roll angles, 434 

Roof framing, 511–20 

overhang for, 513 
pitch for, 512 
purlin height for, 512 
rafters for, 512 
sheathing for, 512 
with FrameIt, 511 
with RoofIt, 513 

Roofs 

A-frame, 410 
dormer, 412, 413 
exterior elevations of, 367 
framing, 511–20 
gable, 410 
hip, 411, 412 
mansard, 411 
rafters for, 413 
shed, 410 

Roofs, 3D 

adding (tutorial), 129 
boundaries for, 515 
joining, 517 
modeling, 513 
polygonal, 515 
rectangular, 515 
settings for, 518 
types of, 513 

Rooms 

labels for, 315 
Rotate 

3D entities, 458–59 
center of 3D, 459 
entities, 290 
setting new angle of, 292 

Rotation angles 

in 3D views, 467 
setting, 470 

S 

Sashes, for 3D windows, 
526 

Save All. See Drawings, 
saving 

Save As. See Drawings, 
saving 

SaveDlay. See Saving 
drawings, delay for 
automatic saves 

SaveImg. See Hidden 
line removal, saving 
image of 

SaveLyr. See Layers, 
saving 

Saving 

drawings. See Drawings, 
saving 

drawings, delay for 
automatic saves, 172 

layers, 153 
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layers with LyrUtil, 270 
Scale. See Printing, 

plotting scale for 

drawing, 30 
plotting, 30 

Scales 

architectural, 169 
engineering, 169 
metric, 169 
setting types, 165, 166 

Scales, setting types, 166 

ScaleTyp. See Scales, 
setting types 

Screen coordinates, 470 

ScrlDist. See Scroll 
distance 

Scroll distance, 56, 171 

Search 

contour of closed polyline, 
216 

Secondary divisions 

of spheres, 433 
of surfaces of revolution, 

437 
of torus, 435 

Sections, 376–77 

cabinet, 376 
cabinet styles for, 377 

SectnLin. See Stairs, 
drawing 2D with 
DataCAD AEC 

Selection 

3D, by area, 33 
3D, by fence, 33 
by area, 31, 32 
by crossing, 31, 32 
by entity, 31 
by fence, 31, 32 
by group, 31 
by layer search, 31 
by point, 31 
by selection set, 31 

Selection sets, 32, 296–
300 

adding entities 
automatically to, 300 

adding entities to, 297 
clearing, 299 
deleting entities from, 298 

displaying entities in, 296 
naming, 300 

SelSet. See Object 
snapping, to entities 
in active selection set. 
See Selection, by 
selection set 

SetActiv. See Layers, 
setting the active. See 
Layers, changing the 
active 

SetBays. See Windows, 
curved bays of. See 
Windows, linear bays 
of 

SetIndx 

creating series of 
concentric contours 
with, 451 

SetSnap. See Grids, 
changing size of 

Settings 

changing 3D, 400 
number of primary 

divisions, 399 
number of secondary 

divisions, 400 
password, 165 
Z-elevations, 400 

SetZUsr1. See Z 
alternative elevations, 
setting 

SetZUsr2. See Z 
alternative elevations, 
setting 

Shaded image, 484–89 

creating, 484 
saving, 489 
saving shader settings, 488 
settings for, 484 
using a .LIT file, 488 

Shading, 484–89 

Shed roofs, 410 

ShowAttr. See Attributes 
added with macro, 
displaying visible 

ShowDim. See 
Dimensions, 
displaying associative 

ShowHtch. See Hatch, 
displaying 

ShowIns. See Symbols, 
insertion points 
displaying 

ShowTxt. See Text, 
displaying 

ShowVals. See Text, 
displaying styles. See 
Walls, displaying 
styles 

ShowWgt. See Line 
weight, displaying 

ShowZ. See Z-base, 
displaying. See Z-
height, displaying 

SigDigit. See Scales, 
setting types. See 
Decimal place, setting 

SillHgt. See Windows, 
drawing 

Sills 

for 3D doors, 531 
for 3D windows, 525 

Single doors, 185 

Single tee concrete 
forms, drawing, 535 

Site model with drop 
mesh, 444–50 

Sketch 

using FreeHand to, 246 
Slab 

converting from closed 
polyline to, 218 

SlabRefs. See Slabs, 
reference face 
markers 

Slabs 

adding vertices to, 416 
deleting vertices from, 416 
editing, 416 
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horizontal, 407 
moving vertices in, 417 
rectangular, 406 
reference face markers, 

409 
thickness of, 406, 410 
vertical, 408 
visible edges on, 417 

Sliding doors, 185 

SmalGrid. See Display, 
options, setting 

SmallSym. See Symbols, 
smallest display size 

SmallTxt. See Text, 
displaying smallest 
size 

SmthPass. See Contours, 
smoothing surface 

Snap grid 

changing size of, 142 
matching to an entity, 268 
new view center becomes 

new grid origin, 468 
setting (tutorial), 64 
setting angle of, 143 
using, 141 

SnapAng. See Snap grid, 
setting angle of 

Snapping, 252–59 

3D point, 404 
adding to Get X distance, 

258 
grid origin for, 468 
object, 252 
on layers, 399 
plane, 398 
point, adding, 253 
quick, 399, 403 
subtracting from Get X 

distance, 258 
super, 258 
to add to or subtract from 

defined angle, 259 
to define an angle, 258 
to enter horizontal 

distance, 258 
to enter vertical distance, 

258 
using middle mouse button 

for, 253 
SnapPnt. See Snapping, 

point adding 

Solid Fills. See SPB Fills 

Sorting 

layers, alphabetically, 157 
layers, by color, 156 
layers, by layer number, 

156 
layers, by lock status, 156 
layers, by number of 

entities in, 157 
layers, by on/off status, 

156 
using Layer Manager for, 

156 
SPB Fills, 335 

choosing colors for fill and 
pattern, 336 

choosing pattern, 336 
controlling X/Y aspect of 

bitmap fills, 336 
printing controls with Pen 

Table, 337 
selecting .BMP or .JPG 

image, 336 
using instead of hatch 

patterns, 335 
using Select Fill 

Color/Pattern dialog, 
335 

Spheres, 433 

SqrNosng. See Nosing, 
for stair treads 

SrchHch. See Object 
snapping, to hatch 
lines 

Stairs 

3D, 540–54 
creating 3D with Z-

elevations in rectangular 
arrays, 244 

drawing 2D with 
DataCAD AEC, 225–26 

StakFrac. See Fractions 

Stamps 

inserting in drawing, 349 
values updated 

automatically, 349 
StartAng. See Angles, 

setting types of 

StartDir. See Curves, 
drawing 

Status Area, 18 

active layer, 19 
layer search toggle, 19 
moving, 24 
SWOTHLUDFB, 19 

Stiffnss. See Contours, 
stiffness of 

Stops, for 3D doors, 531 

Stretch, 292 

3D entities, 460–61 
StrForm. See 3D stairs, 

form 

Stringers 

closed, 548 
color of, 549 
in center of stairs, 548 
on left side of stairs, 548 
on right side of stairs, 548 
open, 548 
thickness of, 549 
width of, 548 

StrWell. See Stairs, 
drawing 2D with 
DataCAD AEC 

StrWidth. See Stairs, 
drawing 2D with 
DataCAD AEC 

Styles 

for walls, 182 
Super snap, 258 

Surfaces of revolution, 
435 

drawing, 436 
Survey data file 

creating drop mesh from, 
444, 445 

Sweep angles, 426 

SwngColr. See Doors, 
swing color of 

SwngStyl. See Doors, 
swing style of 

SWOTHLUDFB, 19 

Symbols, 340–49 

3D windows as, 522 
balusters as, 551 
ceiling grid, 345 
changing size of, 340 



 INDEX  |   603 

converting to lines and 
arcs, 340 

copying (tutorial), 112 
creating, 354 
deleting from drawing, 359 
deleting from template, 

359 
editing, 356 
editing information fields 

of, 357 
editing information fields 

with FormAtr macro, 
357 

electrical, 345 
enlarging, 341 
exploding, 340 
exploding and editing one 

already in your drawing, 
357 

exploding and editing 
while placing in your 
drawing, 356 

exploding with SymExp 
macro, 342 

inserting, 340 
inserting into labels, 316 
inserting with Template, 

341 
inserting with Z offset, 342 
insertion points displaying, 

173 
naming, 355 
newel posts as, 553 
of 3D doors, 528 
placing (tutorial), 109 
plumbing, 343–45 
preview, 30 
previewing, 340 
purging from drawing, 360 
replacing, 358 
replacing several, 358 
rotating, 340 
saving, 355 
selecting (tutorial), 109 
smallest display size, 173 
using stamps, 349 

T 

Tangent arcs 

tracing, 266 
Tangents. See Obejct 

snapping, tangent to 
arc. See Curves, 
drawing 

contours, 450 
drawing 3D arcs as, 422 

entity, drawing arc using, 
208 

temporary line, drawing 
arc using, 208 

Templates, 352–54 

changing number of 
divisions in, 354 

creating, 352 
creating additional 

information fields for, 
353 

divisions, 342 
editing, 354 
fields, 352 
naming, 352, 353 
opening (tutorial), 108 
opening another, 342 
opening another (tutorial), 

111 
selecting symbols from, 

342 
Text, 306–16 

adding to drawing, 306 
adjusting to fit in area, 308 
arrows, drawing (tutorial), 

97 
changing angle of, 306 
changing appearance of, 

306 
changing aspect ratio of, 

306 
changing properties of 

true-type font, 307, 313 
changing scale of, 307 
changing size of, 306 
changing style of true-type 

font, 307, 313 
changing weight of, 307 
deleting styles, 311 
displaying, 173 
displaying smallest size, 

174 
displaying styles, 311 
drawing arrows, 312 
editing (tutorial), 98 
entering directly into 

drawing, 307 
exporting, 309 
importing, 309 
inserting, 307 
inserting notes (tutorial), 

96 
inserting room names 

(tutorial), 95 
inserting TrueType text in 

drawing, 314 
justifying, 307, 308 
loading styles, 310 

menu, 30 
scale, 30 
setting attributes (tutorial), 

94 
setting parameters for 

TrueType fonts, 313 
styles of, 310 
using TrueType (TTF) 

fonts for, 313 
Thickness 

of 3D stair landings, 546 
of 3D stair risers, 546 
of 3D stair stringers, 549 
of 3D stair treads, 547 
of doors, 188 
of slabs, 406, 410 
of vertical cylinders, 425 

TIntsct. See 
Intersections, cleaning 
T 

Title block 

adding symbols in, 363 
boxes in, 362 
creating (tutorial), 115 
defining, 362 
detail blocks in, 363 
drawing, 363 
location of, 362 
size of, 363 

ToLayer. See Copy, to 
another layer. See 
Layers, moving 
entities to another 

Tool tip, 12 

Toolbars, 12 

creating custom, 560 
creating icons for, 562 
customizing, 12 
editing, 562 
parallel view, 12 
perspective view, 12 
plan view, 12 
toggling on or off, 23 
undo/redo, 12 

Toolbox 

3DStairs, 540–54 
Concrete, 534 

Torus, 434 

roll angle for, 434 
Tracing 

2-point arcs, 265 
3-point arcs, 266 
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polylines, 265 
tangent arcs, 266 

Translator 

default settings for 
DXF/DWG files, 26 

DWG/DXF, 556 
importing DWG and DXF 

files with, 9 
Trd/Run1. See 3D stairs, 

treads in first run of 

Trd/Run2. See 3D stairs, 
treads in second run 
of 

Trd/Run3. See 3D stairs, 
treads in third run of 

TrdLngth. See 3D stairs, 
tread length of 

TrdWidth. See Stairs, 
drawing 2D with 
DataCAD AEC 

Treads, 547 

color of, 548 
depth of, 547 
extensions of, 547 
nosing for, 547 
thickness of, 547 

Trim 

for 3D doors, 529 
of 3D windows, 524 

Trimming, 274–77 

entities, 276, 277 
entities to end at a 

specified line, 276 
entities to intersection of 

two lines, 276 
entities, specified, 277 

TrueType fonts. See Text, 
using TrueType (TTF) 
fonts for. See Fonts, 
true-type (TTF) 

converting to 3D, 314 
inserting text in drawing, 

314 
setting text parameters for, 

313 
using instead of CHR 

fonts, 313 
TrueType fonts (TTF), 

313 

TTF. See TrueType fonts 

Tutorial 

3D viewing, 122 
adding layers, 64 
assigning layer colors, 66 
automated 3D modeling, 

126–32 
border, creating, 113 
border, moving, 114 
changing active layer, 65 
cleaning wall intersections, 

75 
dimensions, automatic, 102 
dimensions, drawing string 

of, 100 
dimensions, setting, 99 
dimensions, stretching, 103 
drawing 

doors, 81 
windows, 86 

drawing text arrows, 97 
drawing walls, 67 
editing text, 98 
hatching, 105 
inserting notes, 96 
inserting room names, 95 
multi-scale plotting, 122, 

123 
printing, pen table, 121 
renaming layers, 64 
setting snap grid for, 64 
setting text attributes, 94 
symbols, copying, 112 
templates, opening, 108 
title block, creating, 115 
viewing 3D model, 132–37 

U 

Undo, 47 

Units. See Scales, setting 
types 

UnitType. See 3D 
windows, types of 

Unlink. See Entities, 
unlinking 

Up Left. See 
Stairs:drawing 2D 
with DataCAD AEC 

Up Only. See 
Stairs:drawing 2D 
with DataCAD AEC 

Up Rght. See 
Stairs:drawing 2D 
with DataCAD AEC 

UpAndDn. See 
Stairs:drawing 2D 
with DataCAD AEC 

UserLine. See Linetypes, 
displaying 

V 

Vertex 

adding, 218, 416 
deleting, 219, 416 
moving, 218, 219, 417 
moving while keeping 

angle, 218, 219 
of polygons, 201 

Vertical 3D polygons, 
408 

Vertical cylinders 

divisions of, 425 
Vertical slabs, 408 

VertOfst. See Balusters, 
vertical offset of 

View center 

changing with EditPlne, 
468 

changing with NewElev, 
468 

repositioning, 468 
View Master 

automatic hide, 484 
Viewer/Shader 

defining materials with, 
501 

saving material 
assignments in .DMF 
file, 504 

using for color mapping, 
500 

Viewing 

3D models (tutorial), 129 
advanced 3D (tutorial), 

132 
changing, 132 
layers, 149 
selected entities in 3D 

model, 490 
using arrow keys for, 56 
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using ClibCube for, 490 
ViewLyr. See Layers, 

viewing 

Views 

3D oblique, 477–78 
3D perspective, 473–77 
adding current to 

GotoView list, 493 
changing, 132 
changing an existing 

GotoView, 494 
changing center of, 468 
deleting an existing 

GotoView, 494 
hidden line removal in 3D, 

478–84 
isometric, 471 
linking an entity to a 

GotoView, 495 
moving an existing 

GotoView, 494 
parallel, 467–73 
perspective (tutorial), 133 
remembering previous, 30 
renaming an existing 

GotoView, 494 
shaded image, 484–89 

Voids 

adding, 414 
adding to polyline, 224, 

334 
converting, 415 
converting to polygon, 225 
erasing, 415 
erasing from a polyline, 

224 
Volume 

measuring circle or 
polyline, 264 

VRML files, exporting 
3D models to, 60 

W 

Walk through a model 

customizing options for, 
496 

looking, 497 
perspective navigation 

controls, 496 
perspective view, 495 
saving a view of, 498 
stepping, 497 
turning, 497 
using hotkeys, 496 

using MouseWheel, 496 
Viewer toolbar, 496 
walking, 496 

Wall framing, 509–11 

plate settings for, 511 
stud settings for, 511 
wall height for, 511 

Wall Thk. See 3D 
windows, wall 
thickness for 

Walls 

2-line, 178 
3-line, 178 
3-line attributes, 178, 180 
4-line, 178 
4-line attributes, 180, 181 
attributes, 180 
capping, 179, 181 
cleaning, 181 
cleaning (tutorial), 75 
cleaning intersections, 179 
cutting, 183 
cutting, for 3D doors, 527 
cutting, for 3D windows, 

522 
defining by cavity center, 

179 
defining by center, 179 
deleting styles, 183 
displaying styles, 183 
drawing, 178–84 
drawing (tutorial), 67 
finishing for models 

(tutorial), 130 
framing, 509–11 
loading styles, 182 
removing opening from, 

184 
setting attributes of, 178, 

180 
styles, 182 
welding, 188, 278 
width of, 179 

WallStyl. See Walls, 
styles 

Weld Line. See Lines, 
welding 

Welding, 277 

WeldWall. See Walls, 
welding 

Width 

of 3D stair handrails, 549 
of balusters, 551 

of newel posts, 553 
of stair stringers, 548 

WindowIn menu, 55 

free zoom using, 55 
zooming to extents, 55 

Windows 

adding 3D (tutorial), 126 
curved bays of, 195 
drawing, 189–97 
drawing (tutorial), 86 
drawing in elevations, 371 
labels for, 316 
linear bays of, 192 
modeling 3D, 522–27 
mullions, 194, 196 
removing, 192 
width of jamb, 190 

WndwFile. See 3D 
windows, files 

WndwForm. See 3D 
windows, forms 

World coordintates, 470 

X 

XEnlgmt. See Enlarge, in 
X direction 

XIntsct. See 
Intersections, cleaning 
X 

XREF. See Referencing 
drawings 

circular, 49 
self-referencing, 49 

XRefClip. See Clip Cube, 
defining in XREF with 
XRefClip 

Y 

YEnlgmt. See Enlarge, in 
Y direction 

Z 

Z alternative elevations 

setting, 400 
Z-base 

displaying, 171 
for 3D lines, 396, 400 
to thickness, 406 



|  INDEX  606

to Z-height, 406 
Z-Dist. See Distance, 

stretch in Z direction 

Z-elevations 

changing, 400 
using in rectangular arrays, 

244 
ZEnlgmt. See Enlarge, in 

Z direction 

Zero plane, 396–99, 401 

and New Elevation 
Indicator, 472 

Z-height 

displaying, 171 
for 3D lines, 396, 400 
to thickness, 406 

ZIncrX. See Arrays, 
using Z elevations in 
rectangular 

ZIncrY. See Arrays, 
using Z elevations in 
rectangular 

Zoom. See WindowIn 
menu 

Z-User1. See Z 
alternative elevations, 
setting. See Z 
alternative elevations 

Z-User2. See Z 
alternative elevations, 
setting. See Z 
alternative elevations 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 


	Table of Contents
	Up & Running
	How to Use This Manual
	Getting Help in DataCAD

	Installing DataCAD
	System Requirements
	Pre-installation Checklist
	Running the Setup Program


	The Drawing Board
	Opening a Drawing
	Opening an Existing Drawing
	Working with Folders in DataCAD’s Save and Open Dialog Boxes

	Creating a New Drawing
	Creating a New Drawing Using a Default Drawing
	More About Default Drawings

	Importing a DWG or DXF Drawing File
	More About Importing Files Into DataCAD


	A Brief Tour
	The Menu Bar
	Toolbars
	The Menu Window
	Choosing Menu Options

	Using the Command Line Alias
	Customizing the Alias Browse Box
	Making an Alias

	The Navigation Pad
	The Projection Pad
	The Status Area
	Hotspots
	Changing the Active Layer
	Toggling Layer Search On or Off
	Using SWOTHLUDFB

	The Message Area
	The Drawing Area

	Customizing DataCAD
	Customizing Pathnames
	Customizing DataCAD’s Interface
	Customizing File Translation
	Customizing the Macros Menu
	Customizing Miscellaneous Settings

	Common Menus in DataCAD
	Selection Menus
	More About Selection Menus
	More About 3D Selection Menus

	Value Menus
	DataCAD’s Online Calculator

	Color Menus

	Planning Your Project
	Gathering Project Information
	Planning Layers
	Prioritizing Drawing Tasks
	Drawing Efficiently
	Sample Project
	Scope of Work
	Summary of Available Personnel and Drawings Needed
	Planning the Drawing Time
	How Draftsman 1 Drew the First Floor Plan


	Basic Drawing and Editing
	Drawing Using the Mouse
	Drawing Using Coordinate Entry
	More About Coordinate Entry

	Drawing with Linetypes
	Linetype Settings

	Basic Editing Tools

	Referencing Drawings
	Reference File Manager
	Displaying Reference File Layers
	Refreshing and Reloading Reference Files
	Binding Reference Files
	Deleting Reference Files
	Highlighting Reference File Geometry
	Resolving Orphaned Reference Files


	Viewing Drawings
	Zooming In and Out
	Changing Your View Using the Keyboard

	Saving Drawings
	More About Recovering Lost Work
	More About Naming Your Files

	Exporting Files
	More About o2c Objects



	Tutorial: Drawing a Schoolhouse
	Setting Up a New Drawing
	Setting the Snap Grid for the Tutorial
	Creating New Layers for the Tutorial
	Naming Layers for the Tutorial
	Moving Between Layers in the Tutorial
	Assigning Colors to Layers in the Tutorial

	Drawing Walls, Windows, and Doors
	Drawing the Schoolhouse Walls
	Drawing the Schoolhouse’s Exterior Walls
	Drawing the Schoolhouse’s Interior Walls
	Cleaning the Schoolhouse’s Wall Intersections
	Drawing Countertops in the Schoolhouse

	Drawing the Schoolhouse’s Doors and Windows


	Tutorial: Adding Dimensions, Notes, Symbols, and Hatching
	Adding Text to the Schoolhouse Drawing
	Drawing Text Arrows in the Schoolhouse Drawing
	Editing Text in the Schoolhouse Drawing

	Dimensioning the Schoolhouse Drawing
	Drawing a String of Dimensions:
	Automatic Dimensioning
	Stretching Dimensions

	Hatching the Schoolhouse Drawing
	Adding Symbols to the Schoolhouse
	Opening a Template Folder
	Selecting and Placing Symbols
	Selecting Another Template File
	Copying Symbols

	Drawing a Title Block and Border
	Moving the Border
	Drawing a Title Block


	Tutorial: Printing a Drawing
	Printing the Schoolhouse Drawing
	Printing Options
	Assigning Pens
	Using Multi-scale Plotting



	Tutorial: Modeling
	Modeling the Schoolhouse
	Adding Windows
	Adding 3D Doors
	Viewing the 3D Model
	Adding a 3D Roof
	Finishing the Schoolhouse Drawing

	Viewing Your Drawing in 3D
	Advanced 3D Viewing
	Perspective Viewing
	Hidden Line Removal

	Creating Elevations


	Before You Draw
	Managing Your Project
	Setting Up Your Drawing Grids
	Using the Snap Grid
	Using the Display Grids
	Changing Grid Size
	Changing Display Grid Color
	Setting the Snap Angle
	Setting the Grid Angle
	Setting the Grid Origin

	Working With Layers
	Creating Layers
	More About Creating Layers

	Setting the Active Layer
	Displaying Layers
	More About Displaying Layers

	Locking Layers
	Renaming Layers
	Changing Layer Color
	Viewing a Layer
	ViewLyr Menu Options

	Deleting Layers and Their Contents
	Selecting Layers Without Using Layer Names
	Searching for Layers
	More About Searching for Layers

	Saving and Loading Layers
	More About Naming a Layer File


	Using the Layer Manager
	Accessing Layer Manager
	Changing a Layer’s Number
	Sorting the Layers
	Changing Layer Settings
	On/Off
	Lock/Unlock
	Color
	Name

	Using Other Layer Functions
	Add New Layer
	Erase Entities from a Layer
	Delete a Layer

	Changing an Incorrect Layer Setting
	Revert to Previous Settings in the Layer Manager
	Cancel
	Undo

	Exiting from the Layer Manager

	Customizing Drawing Settings
	Setting a Password
	Setting Scale and Angle Types
	ScaleTyp Menu Options
	AngleTyp Menu Options

	Editing Scale, Angle, and Distance Lists
	More About Architectural Scales
	More About Engineering Scales
	More About Metric Scales

	Setting Cursor Accuracy
	Setting Display Options
	Setting the Panning Distance
	Automatically Saving Your Drawing
	Synchronizing the Distance Display

	Customizing Display
	Customizing Colors


	Drawing Walls, Windows, & Doors
	Drawing Walls
	More About Setting the Width of Walls
	More About Setting Wall Attributes
	More About Finishing Walls

	Using Wall Styles
	Cutting Walls

	Drawing Doors
	More About Door Styles
	More About Door Jambs
	More About Door Angles
	More About Door Swing
	More About Other Door Settings

	Removing a Door

	Drawing Windows
	More About Window Jambs
	More About Sill and Glass Settings
	More About Other Window Settings

	Removing a Window
	Drawing Linear Bays of Windows
	Linear Window Bay Options

	Drawing Curved Bays of Windows
	Curved Window Bay Options



	Drawing Other Geometry
	Drawing Polygons
	Polygon Menu Options
	Drawing Rectangles

	Drawing Curves
	Drawing 2-Point Arcs
	Drawing 3-Point Arcs
	Drawing Arcs By Center Angle
	Drawing Arcs By Arc Length
	Drawing Arcs By Chord Length
	Drawing Arcs By Radius
	Drawing Arcs By Included Angle
	Drawing Arcs Using a Tangent Line
	Drawing Tangent Arcs
	Drawing Circles By Radius
	Drawing Circles By Diameter
	Drawing Circles By Points
	Drawing Ellipses
	Drawing Curves Using Control Points
	Drawing Curves Using Surveyor’s Data
	CurvData Menu Options


	Drawing Polylines
	Contour Search
	Editing Polylines
	Converting Polylines
	Editing Polyline Vertices
	Editing Polyline Arcs
	Editing Polyline Edges
	Converting Edges and Arcs
	Editing Polyline Corners

	Measuring Polylines
	Voids in Polylines

	Drawing Stairs
	Stair Railing Options
	Stair Well Options
	Section Line Options


	Drawing Columns
	Drawing a Single Column
	Drawing Rectangular Grids of Columns
	Rectangular Grid Options

	Drawing Radial Grids of Columns
	Radial Grid Options


	Drawing Elevators
	Elevator Cab Options
	Elevator Shaft Wall Options
	Elevator Door Options



	Other Ways to Draw
	Copying Entities
	Copying Entities a Specified Distance and Angle
	Copying Entites by Dragging
	Copying Entities at the Perpendicular
	Copying to Another Layer
	Copying Using Arrays
	More About Using Z Elevations in Rectangular Arrays
	More About CircArry Menu Options


	Mirroring Entities
	Sketching Your Plan

	Drawing Tools
	Setting Reference Points
	More About Setting Reference Points

	Object Snapping
	ObjSnap Menu Options
	More About Snapping Points
	More About Using Your Mouse for Snapping
	More About Increasing Snapping Speed

	Snapping to the Nearest Point
	Snapping to Dividing Points
	Snapping to End Points
	Snapping to the Midpoint of a Line
	Snapping to Arc and Circle Centers
	Snapping to Quadrant Points
	Snapping to Intersections
	Snapping to a Perpendicular
	Snapping to Tangents
	Using Super Snap

	Identifying Entities
	More About Entity Attributes

	Measuring Entities
	Measuring Lengths and Angles
	Measuring the Total Length of Lines
	Measuring Areas, Perimeters, and Volumes
	More About Tracing Polylines


	Working with Entities
	Dividing Entities
	Marking Line Intersections
	Matching the Snap Grid to an Entity

	Layer Utility
	More About Layer Utility


	Editing Drawings
	Trimming, Welding, and Cleaning
	Trimming Corners
	Trimming Entities
	Welding Lines and Walls
	Cleaning Wall Intersections

	Changing Entities
	Changing Entity Attributes
	Changing Text Attributes
	Editing Entity Information
	Converting Lines to Walls
	More About Converting Lines to Walls


	Moving Entities
	Moving Entities to Absolute Zero
	Moving Entities by Specific Distance and Angle
	Moving Entities by Dragging
	Moving Entities to Another Layer

	Rotating Entities
	More About Setting an Angle of Rotation

	Stretching Entities
	Enlarging Entities
	Erasing Entities
	Editing Multiple Entities
	Linking Entities
	Working with Selection Sets
	More About Selection Sets
	Clearing Selection Sets
	Naming Selection Sets
	Automatically Adding to Selection Sets


	Clipping and Cropping

	Text, Notes, and Labels
	Drawing Text
	Justifying Text
	Fitting Text into Defined Areas
	Importing and Exporting Text
	Using Text Styles
	Drawing Text Arrows

	Using TrueType Fonts Instead of .CHR Fonts
	Drawing Labels
	Drawing Room Labels
	Drawing Door Labels
	Drawing Window Labels


	Dimensions
	Drawing Linear Dimensions
	Text Style Options for Linear Dimensions
	Line Style Options for Linear Dimensions
	Arrow Style Options for Linear Dimensions
	Automatic Dimension Style Options for Linear Dimensions

	Editing Linear Dimensions
	Exploding Linear Dimensions

	Drawing Dimensions for Angles and Curves
	Text Style Options for Angle and Curve Dimensions
	Line Style Options for Angle and Curve Dimensions
	Arrow Style Options for Angle and Curve Dimensions



	Hatch
	Drawing Hatch Patterns
	Drawing Standard Hatch
	Using SPB Fills Instead of Standard Hatch Patterns
	Drawing Associative Hatch


	Symbols, Images, and Objects
	Inserting Symbols in Your Drawing
	More About Templates and Symbols
	Inserting Plumbing Symbols
	Handicapped Stall Options
	Standard Stall Options
	Urinal Options
	Sink Options

	Drawing Electrical Symbols and Ceiling Grids
	Boundary Menu Settings
	Grids Menu Settings
	Fixtures Menu Settings

	Inserting Stamps
	Inserting o2c Objects
	Importing BMP and JPEG Images
	Calibrating Enlargements
	Drawing Arrows

	Creating and Editing Templates
	More About Creating Templates
	More About Naming Templates

	Editing Templates

	Creating and Editing Symbols
	More About Naming Symbols
	Editing Symbols
	Editing Information Fields
	Replacing Symbols in Your Drawing
	Deleting Symbols
	More About Erasing Symbols



	Borders and Title Blocks
	Drawing Borders and Title Blocks

	Elevations and Sections
	Drawing Exterior Elevations
	Drawing Door Elevations
	Door Styles for Elevations

	Drawing Window Elevations
	Window Styles for Elevations

	Drawing Cabinet Elevations
	Cabinet Styles for Elevations

	Drawing Sections
	Cabinet Styles for Sections


	Printing Your Drawing
	Printing Basics
	More About Previewing Your Plot

	Printing a Check Plot
	Using Pen Tables
	More About Using Pen Tables
	Saving and Using Pen Table Settings

	Laying Out Your Drawing
	Using Quick Layout
	Using Multi-Scale Layout
	More About Editing Details and Sheets


	Batch Plotting

	Modeling Basics
	Z-Base and Z-Height
	The Zero Plane
	More About Positioning the Zero Plane


	Changing 3D Settings
	3D Settings Toggles
	Setting Primary and Secondary Divisions
	Setting Z-Elevations

	Drawing 3D Lines
	All about 3D Snapping
	More About 3D Snapping
	Using Markers


	Modeling with 3D Polygons, Slabs, and Blocks
	Drawing Rectangular 3D Polygons and Slabs
	Drawing Horizontal 3D Polygons and Slabs
	Drawing Vertical 3D Polygons and Slabs
	Drawing Inclined 3D Polygons and Slabs
	Adding Voids to Polygons and Slabs
	Editing 3D Polygons and Slabs
	Drawing Blocks

	Drawing Single-Curved Entities
	Drawing 3D Arcs
	Drawing Vertical Cylinders
	Drawing Horizontal Cylinders
	Drawing Cones and Truncated Cones

	Drawing Double-Curved Entities
	Drawing Spheres and Domes
	Drawing Tori
	Drawing Surfaces of Revolution
	Drawing Mesh Surfaces

	Site Modeling
	Site Modeling with Drop Mesh
	Drawing Topographical Maps with Contours

	Editing 3D Entities
	Rules for Editing 3D Entities
	Moving 3D Entities
	Copying 3D Entities
	Rectangular Arrays

	Rotating 3D Entities
	Mirroring 3D Entities
	Stretching 3D Entities
	Enlarging 3D Entities
	Exploding 3D Entities
	Changing 3D Entities

	Viewing Your Model
	Creating Parallel Views
	More About Rotation Angles in 3D Views
	More About Changing the View Center
	More About Changing the Eye Point for a View

	Creating an Isometric View
	Creating Elevations
	More About the New Elevation Indicator Cursor


	Creating Perspective Views
	Establishing Perspective Settings
	Creating a One-Point Perspective
	Creating a Two-Point Perspective
	Creating a Three-Point Perspective
	Perspective Navigation Controls

	Creating Oblique Views
	Establishing Oblique Settings
	Creating an Elevation Oblique View
	Creating a Plan Oblique View

	Creating a Hidden Line Removal
	Tips on Maximizing Performance
	Saving the Hide Image
	Increasing Hide Speed
	Hide Options
	Editing Hidden Line Removal Images
	Deleting Double Lines
	Drawing Hidden Lines
	Disregarding Back Faces
	Hidden Line Colors
	Hidden Linetypes
	Hidden Line Spacing
	Closing 2D Arcs
	Closing 2D Ellipses
	Displaying Outlines Only
	2D Arc Divisions

	Automatic Hidden Line Removals

	Creating a Shaded Image
	More About Polygon Normals
	Saving and Using Shader Settings
	Saving Your Shaded Image

	Using the OpenGL Shader
	Viewing Selected Entities in Your Model
	Saving a View
	GotoView
	Linking to a View

	Walking Through Your Model
	Perspective Navigation Controls
	Walking
	Turning
	Stepping
	Looking
	Saving a View


	Using the o2c-based Object Viewer
	Color Mapping

	Framing Your Model
	Framing Floors
	Sill Plate, Joist, and Subfloor Settings

	Framing Walls
	Wall Height, Plate, and Stud Settings

	Framing Roofs
	Settings
	Defining the Roof Boundary
	Rectangular Roofs
	Polygonal Roofs

	Joining Roofs
	Settings Options

	Saving and Using Framing Settings

	Modeling Windows and Doors
	Modeling Windows
	Cutting Walls
	Window Files
	Window Forms
	Saving Windows as Symbols
	Window Height and Wall Thickness
	Window Types
	Window Casings
	Window Trim
	Window Headers
	Window Jambs
	Window Sills
	Window Sashes
	Muntins
	Glass


	Modeling Doors
	Cutting Walls
	Door File
	Door Forms
	Saving 3D Doors as Symbols
	Door Heights and Wall Thickness
	Door Types
	Door Casings
	Door Trim
	Door Headers
	Door Jambs
	Door Sills
	Door Stops
	Door Options
	Door Knobs



	Modeling Concrete Forms
	Drawing Columns
	Drawing Inverted, Single and Double Tee Forms
	Drawing Standard Beam Forms
	Drawing I-Beam Forms

	Modeling Stairs
	Drawing 3D Stairs
	More About Drawing Single-Run Stairs

	Customizing Stair Settings
	Base Elevation
	Treads
	Radius of Curved Stairs
	Clockwise
	Chases
	Landings
	Risers
	Treads
	Stringers
	Handrails
	Balusters
	Newel Posts

	Stair Form
	Saving and Using Stair Settings


	Appendix
	DWG/DXF Translation Tables
	Importing
	Exporting

	Creating Custom Toolbars
	Action Codes
	Menu Level String
	Bitmap Filenames
	Action
	DataCAD Internal Menu Function Numbers

	Message
	Creating a New Key File
	Creating New Icons

	Editing Toolbars
	Editing a Key File


	Creating Linetypes
	Standard Linetypes

	Standard Hatch Patterns
	Creating Keyboard Shortcuts
	Defining Shortcuts
	Standard Keyboard Shortcuts

	Standard Fonts
	Extended characters

	Glossary
	Index

